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1. What's New? 

New Features - Lyric v5.0 
 Backup & Restore:  Provides a convenient way to backup assets associated with a Browser or 

Directory and move these to another system.  Backup collects assets (bitmaps, messages, 
TrueType® Fonts, etc.) into user-specified folders.  Restore allows specification of folder locations 
for each asset type. Accessed from the Lyric File menu. 

 Soft Masks (Duet LE/LEX/PCI/PCI+ Only):  Accessed from the context (right-click) menu for the 
object in the Scene Graph or Canvas. 

 Center of Rotation can now be displayed on an object.  Accessed from the context (right-click) menu 
for the object in the Scene Graph or Canvas. 

 3D Canvas Scene Views  (XY, YZ, XZ,  Perspective):  In addition to the normal Lyric Front view, 
the Canvas now has Top, Perspective, Left and Multi views available.  Two related preferences:  
Show Viewport Labels in CG Preferences, and Lock Viewport Sizes in Windows Preferences.  
Preferences are accessed from the Lyric Config menu.  A Multi View on/off toggle is also available 
from the View menu. 

 New internal clip player hardware supports multi-channel clip playout.  Clear Output button has 
been added to the Clip Control Panel.  Also, pressing Ctrl + Alt + Q (PC keyboard) or Alt + Erase 
(Duet keyboard) can clear the current clip player channel and frame buffer output.  The following 
should be noted: 

o The minimum offset of a clip on the Timeline is 3 frames.  Anything less than 3 frames is 
ignored, and treated as if set to 0 frames. 

o The minimum number of frames that can be looped to from the end of a clip is 15.  Output is 
unpredictable if the loop frame is set to less than 15 frames from the end of the clip. 

o Default Operation Selection:  The first frame of a clip is not displayed in output when a 
message containing a clip is loaded.  When the message is played, the clip starts playing and 
is then visible on output. 

 To change default behavior so that the first frame of the clip is displayed on output 
when the message is read, navigate to folder in which Lyric is installed.  Double-
click on the file DisableMatroxSourceSwitcher.reg.  Displaying the first frame of the 
clip was the default behavior of messages read in versions of Lyric predating Lyric 
v5.0.  Note that clips contained in messages created in these earlier versions 
behave according to the current default setting in Lyric v5.0 when read.  Note that if 
Lyric is running at the time that DisableMatroxSourceSwitcher.reg is run, the Lyric 
Canvas must then be cleared (erased) in order for the new behavior to take effect. 

 To revert back to the default behavior for Lyric v5.0, navigate to folder in which 
Lyric is installed, and then double-click on the file 
EnableMatroxSourceSwitcher.reg.  Note that if Lyric is running at the time that 
EnableMatroxSourceSwitcher.reg is run, the Lyric Canvas must then be cleared 
(erased) in order for the new behavior to take effect. 

Refer to What's New in Lyric v4.14? and What's New in Lyric v4.15? for additional information on 
clip player enhancements.   Refer also to Internal Clip Control Player and Clip Control Panel for 
detailed information on clip operation.  Note that the content in these two sections is superceded by 
the enhancements in the release notes. 

 New Advanced Image Effects have been added:  Assemble/Disassemble; Flipboard; Crumble; 
Detonate; Flag; Bulge (Duet LEX/PCI+ only); and Globe (Duet LEX/PCI+ only). 
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 Motion Path:  A Motion Path can be displayed for any 2D bitmap, 3D character or 3D object that 
contains more than one keyframe.  The Motion Path is accessed from the context (right-click) menu 
for the object in the Scene Graph or Canvas. 

 Rendering performance has been improved on Duet LEX/PCI+ systems. 

 Movie Objects (Duet LE/LEX/PCI/PCI+ Only):  Adds the ability to import AVI or Quicktime movie 
files (RGB only) into the scene as animatable objects.  Image Effects can be applied to Movie 
object. 

 Scene Graph:  Objects in the Scene Graph can now be color-coded.  The text/highlight color in the 
Scene Graph for an object can be changed from the context (right-click) menu for the object in the 
Scene Graph or Canvas. 

 Animation Rate:  Can now maintain the animation rate (i.e., the number of characters displayed per 
second) by automatically modifying the animation in a Type On, Roll, or Crawl window.  This feature 
is accessed from the Animation tab of the Properties window, and is made active by enabling the 
Speed or Rate buttons. 

 Keyframe All Objects and Keyframe Selected Objects on the Edit menu now include all applicable 
attributes for each object. 

 The Font Sample chip in the Font Properties and 2D Font FX Properties tabs and on the 2D Text 
Template dialog box is now red-slashed if the TrueType Font is not available. 

 Playlist:  New features have been added to the Playlist: 

 The Playlist Configuration dialog has been expanded to include GPI triggers for Line Up 
and Line Down. 

 Default Playlist Attributes. 

 Scroll Offset. 

 Preview Options. 

 Cue Clip.  Cue Clip was moved from the Control column of the Playlist. 

 Read Next mode is now maintained per frame buffer.  That is, changing to a different frame buffer no 
longer clears the Read Next status of the inactive frame buffer.  Read Next is still in force when the 
original frame buffer is reactivated. 

 Advanced Image Effects now keeps the object on screen based on the duration of the object on the 
Timeline, not the duration of the effect. 

 GPI Pauses are now supported for nonstop Flipbook animations on Duet LE/LEX/PCI/PCI+ 
systems. 

 Enhancements to Selective Recording (Ctrl + Record): 

 Record a Template Data Message from within Lyric:  Multiple Template Data Messages 
can reference the same Template Description Message and therefore the format of all 
Template Data Messages can be changed by simply modifying the underlying Template 
Description Message. 

 Preview Frame:  Specify which frame should be shown in VGA (Canvas) preview if this 
preference is enabled. 

 Embedded Macro:  Embed a macro in a message.  The macro auto-executes when the 
message is read. 

 Ctrl + Alt + Record:  New accelerator key combination added to selectively record (Ctrl + 
Record) to the same message number as that loaded in Canvas. 
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 The Load, Quick Load, Load Saved, Save, Stop and Play icons have been removed from the Duet 
LE/LEX/PCI/PCI+ Tools toolbar.  Load (Alt + L), Quick Load (Alt + Q), Stop (Esc) and Play (Alt + 
Y) functionality are still available from the accelerator keys as noted above.  The Save and Load 
Saved functions have been removed. 

 Changes to display priority via drag-and-drop in the Scene Graph view are now possible even if a 
group is present.  Drag-and-drop within a group is also now supported.  To facilitate these changes, a 
group added to a new message will now dictate display priority of all its members of equal Z value.  
This is enabled/disabled via Use Group Priority, accessed from the context (right-click) menu for the 
object in the Scene Graph or Canvas, and then selecting Internal Properties. 

 Texture compression is now supported for Flipbooks and 2D Bitmaps. An nVIDIA® GeForce FX or 
better board is required.  Duet LE/LEX/PCI/PCI+ systems will be able to create and record messages 
which have compressed Flipbooks/2D bitmaps.  Duet SD systems will be able to read messages 
with compressed Flipbooks but will uncompress them before playback.  Using compressed textures 
will speed up message Read and Record. 

 Advanced Text Effects:  Duration of an Advanced Text Effect will now automatically increase when 
necessary so that effect can be completed on all applicable elements of the 2D Text Window.   This 
adjustment is applied only when configuring the effect. 

 Clocks/Timers: 

 Support new clock/timer format specifier –0 which will strip the leading zero off of such 
formats as h:mm, causing timer to display :59 instead of 0:59. 

 Allow clocks/timers to support justification to prevent digits from moving to the left when the 
new format above is used. 

 Message Record and Delete information on the Status Bar is now more prominently displayed with 
a green background. 

 A particular surface on a 3D object can now be selected with the mouse.   Reflective, Masked or 
neither can now be set in Properties > Surface for each individual surface. 

 Graphic Import: 

 Import Graphic now supports the import of 32-bit Photoshop, PNG and LZW files. 

 The Import Graphic dialog now has a Merge Layers checkbox for Photoshop files.  If not 
selected (checked), each layer in the Photoshop file is imported as a separate image, and is 
displayed as such in the Scene Graph. 

 An animation on a Duet LE/PCI system now plays out to scene Duration instead of the length of the 
Camera Timeline. 

 Paste Unicode Text now immediately adjusts to existing Row Tabs. 

 A variety of Internal Properties can now be set per object or per message.  Internal Object 
Properties can be accessed from the 2D Text Window, 2D object, 3D character and 3D object 
context (right-click) menus.  Internal Message Properties can be accessed from the Light, Global 
Light and Camera context (right-click) menus.  Internal Message Properties can also be accessed 
from Tools Menu > Set Message Properties.  

 The Config Menu > Duet Hardware > Setup Board Configuration tab has been reformatted.  The 
Video Insert/Video Only controls are no longer present; Video Insert is always set.  If you wish to 
disable the graphics layer, you should instead erase the frame buffer.  NOTE: Certain configuration 
settings have been deprecated in the registry.  Therefore, if you attempt to go back to a previous 
version of Lyric after using this version, you may need to reset the Video Standard, Genlock, and 
Video Insert settings for each board in the system. 
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 Chinese, Japanese, and Korean 2D and 3D text input to the Canvas is now supported.  Also 
support Template Update and Spline Edit Window for these languages.  Note that Unicode Only 
must be selected (checked) in the CG Preferences to enable Asian language support.  CG 
Preferences is accessed from Config Menu > Preferences. 

 Analog Lantern 64 PCI cards are now supported.  Configuration of Analog cards is subject to certain 
limitations:  Video In layer cannot be turned off; Video Out cannot be delayed horizontally or 
vertically; and Ancillary Data settings cannot be modified. 

 When reading a Template Data Message (Intelligent Interface W file), the Template Description 
Message will now be read from the same directory (i.e., the Intelligent Interface directory, if read by 
Intelligent Interface).  This directory is also the Default Message Directory, which is set from 
Config Menu > Preferences > Default Paths.  The Intelligent Interface Message Directory path 
can also be viewed from Config Menu > Intelligent Interface. 

 Ctrl + Tab in 2D Text Windows is now supported in pasting and DBLink. 

 New compositing (i.e., blend) modes are now supported in the Animation Settings Preferences: 

 Fast:  Produces fastest rendering times, but sacrifices quality on overlapping transparent 
pixels. 

 Normal:  Accurate compositing of transparent overlapping pixels, but slower render times 
than Fast.  Also requires GeForce FX or better VGA card. 

 Depth (2 Pass):  Accurate compositing of intersecting transparent objects, but yields slowest 
rendering times. 

 Fast/Fix Key:  Fast rendering plus improved alpha blending for overlapping transparent 
pixels and Key signal. 

 Macros/LEIF Additions and Modifications:  

 Font on Text object is now settable, i.e., the default font for a 2D Text Template can be 
changed from a macro/plugin. 

 Calling the Update method on a Font object will now apply changes to selected characters 
as well as update active font. 

 Calling the Load method on an Image object with an empty string for the filename will cause 
the Graphic Import dialog to pop up. 

 A new method IICommand on Lyric object will accept and process an Intelligent Interface 
command. 

 New Surface object for 3D characters/objects allows get/set color and texture filename. 

 Enhanced Row object to support retrieval of text, font, character position, etc. 

 Added method NextTemplate on Template object to return the next template in numerical 
sequence. 

 Added Move method to Image and Template objects. 

 Added method Message to Scene object to return the message number of the current 
scene.  This will be accurate on read and record, while Lyric.Message is not. 

 Added MessagePath property to Lyric object to get/set the preferred message path. 
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Bug Fixes - Lyric v5.0 
 Resolved problem where a Template field was auto-erased erroneously when reading a Template 

Data Message (W file) which contained fewer updates than were Templates available. 

 Resolved issue when the font edge was changed from a file-based texture to a gradated texture. 

 Clocks/Timers: 

o Synchronized Clock/Timer display with Lyric objects on transfer to Duet LEX/PCI+ output. 

o All Clocks/Timers on Duet SD output are now stopped if an animation error occurs with any 
one of them. 

 The Duet LEX/PCI+ Video setting is now maintained upon exit from Lyric.  Corrected Duet LEX/PCI+ 
video settings for Video Key enable not being stored/restored from registry correctly. 

 Resolved problem where an Advanced Image Effect would not execute once the image was 
updated through DBLink. 

 Resolved issues related to soft Type On for Duet SD and Duet LE/LEX/PCI/PCI+. 

 If 2D Frames On is selected from the selected 2D Text Window context (right-click) menu, all frames 
of selected text windows are toggled on/off.  Previously, only the last-selected 2D Text Window was 
toggled. 

 Resolved incorrect sort order in message entries generated by a Browser Search. 

 Intelligent Interface: 

o An animation read up via a Y command on a Duet LE/PCI system can now be played to the 
active output frame buffer with a subsequent Y or V command. 

o Diagnostics section in Intelligent Interface dialog box (accessed from Config Menu > 
Intelligent Interface) will now update if connected over Telnet. 

o Telnet and Recall Keys options are now prevented from being selected simultaneously in 
the Intelligent Interface dialog box (accessed from Config Menu > Intelligent Interface). 

o The Recall Keypad display will now report Invalid Message if a Read or Read Next fails to 
load a message.  This problem existed on Duet LE/PCI only. 

 Masks: 

o Resolved intermittent issue with surface transparency of 2D Text Windows if they render 
after a Mask object. 

o Resolved blending problems with other characters in a 2D Text Window in which a Mask 
Character was present. 

 Resolved scaling issue with the first character in an animated 2D Text Template if it was located 
near the 2D Text Template boundary 

 Playlist and keyframe pauses for GPI now function correctly when RS-422 Serial I/O & GPI/O Board 
was installed in a Duet LE/PCI system. 

 Resolved flash on Duet SD output if mixer was reset to default when either Output Layer was set for 
mix 

 Resolved intermittent problem where text would not appear on Duet SD output if the containing 2D 
Text Template had a background. 

 Resolved problem where characters would be missing from a 2D Text Window after an extended 
period of constant updating. 
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 Corrected Timeline length of group members when Apply All was executed from Animation 
Properties. 

 Resolved problem with iNFiNiT! batch export on Duet LE/PCI, where missing Message Numbers 
within the specified range were still exported.  They contained content from last available message. 

 Corrected Auto Standards Conversion bug, where 16:9 message was not properly scaled when 
read into a 4:3 Canvas. 

 Resolved problem where an iNFiNiT! character was replaced via Sync TrueType Fonts if it had been 
imported into a 2D Text Window in which a Browser font was active. 

 Corrected screen position of 2D Text Windows that had Xscale/Yscale/Zscale keyframes. 

 Ensured the availability of font assets in the Browser is updated when read from the database file.  
Previously, only those font assets visible in the Font Browser Window were checked.  As a result, 
Sync TrueType Fonts could update characters to a non-existent font. 

 Resolved problem where Key Input and Shape settings for the SD Mixer were not being saved for a 
Timeline mix if offline. 

 Reload of image data during message read (e.g., for non-embedded, interfaced or DBLinked 
images) will no longer make the image visible if it is not. 

 Resolved crash occurring if a larger font was applied to a 2D Text Template with Word Wrap 
enabled 

 Corrected operation of Aprisa VCS if Use Channel B was selected. 

 Corrected problem in reading some pop-on messages, where characters would be missing. 

 Template data messages read through Intelligent Interface will now use the Intelligent Interface 
message directory 

 Internal Clip Player: 

o An internal clip will no longer start prematurely on Duet LE/PCI systems if the animation is 
paused at frame 0. 

o Resolved problem where internal clip added after audio clip would not have visible video. 

o Resolved problem where a clip would not play if read up twice while another looping clip was 
playing on output. 

o Resolved problems with using clips from two channels in same frame buffer 

 GPIO on Duet LE/PCI systems 

o Resolved problem where a GPI used to release a pause could not be used for any other 
purpose (i.e. as a global GPI) without restarting Lyric. 

o All available GPIs are now automatically allocated when Lyric starts up. 

o Corrected board and pin designations listed in Duet Hardware for second and subsequent 
VGBs. 

o Existing GPI assignments will no longer be overwritten when Global GPIs are configured 
unless the global GPI is enabled. 

 Wipe Image Effect now supports a softness of 0 (none) 

 Corrected scaling of graphics imported into 16 x 9 SD canvas when 1:1 aspect is disabled. 

 Corrected Save As cropping with Duet HD. 
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 Macros/LEIF Corrections/Modifications: 

o Get/SetBackgroundVisible on Scene object now properly handles solid or gradated color 
background. 

o MajorVersion and MinorVersion methods on Version object now return correct values. 

o Rect method on Template object now returns correct values if Canvas is scaled and/or 16:9. 

o Reversed operation of flag for SizeToFit method on Template object, which had been 
counter-intuitive 

o Resolved problem where saving an individual macro twice to the same file would delete the 
file. 

o Simultaneously executing and recording macros is now prevented.  This conflict can occur 
when an Intelligent Interface E macro execution command is sent while a macro record is in 
progress. 

o The maximum length of an auto-recorded macro statement has been increased from 256 
bytes to 2K. 

 Resolved kerning issues with a clock/timer on a 16 x 9 canvas on Duet LE/PCI systems. 

 Resolved problem where F2 would not delete remainder of row if preceded by Ctrl + Home. 

 Resolved problem where Ctrl + Click selection of group members in Scene Graph would select 
objects outside of the group. 

 Corrected processing of characters typed with two keystrokes such as accented characters. 

 Disabled ability to move 4:3 reference safe-title using the mouse. 

 Corrected Alpha of exported QuickTime movies. 

 Import of an image into a 2D Text Window will not wrap to the next line if Word Wrap is not enabled. 

 Fixed problem with the cursor not moving if 2D Frames On are off. 

 When in Preview Mode, if you try to add another object, you'll snap out of Preview Mode and the 
new Timeline node will start at frame 0. 

 If an image file is not found on load (e.g., during DBLink), the error is now posted to the Lyric status 
bar instead of in a message box. 

 Resolved crash when a second Lyric process exits on Duet LEX/PCI+ systems. 
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Known Issues - Lyric v5.0 
 PCI-Squeezeback boards do not support Clocks/Timers. 

 A Clip with a Start Time of 0, 1 or 2 frames always starts at Frame 0 when the animation is 
executed.  A Clip with a Start Time of 3 or higher executes at the specified frame. 

 Clip Control Panel:  The minimum number of frames that can be looped to from the end of a clip is 
15.  Output is unpredictable if the loop frame is set to less than 15 frames from the end of the clip. 
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2. Getting Started 

Getting Started 
 If you are already familiar with Lyric and Duet, refer to What's New - New Features to find out about 

the new features in this version of Lyric. 

 If you are completely new to Lyric, also refer to Creating a Simple Lyric Composition, which 
features a simple tutorial for creating a Lyric message. 

 For information about navigating the Lyric interface, please refer to Navigating and Entering 
Information in Lyric. 

About Lyric and Duet 
Lyric® is a powerful character generator/graphics application boasting feature-packed 2D and 3D static and 
animated graphics creation tools, and real-time playback to air.  Lyric runs on the Chyron® Duet® platform for 
online production and real-time playback, as well as on PCs running Windows NT® and Windows® 2000 
operating systems for offline composition.  Content may be created on a conventional PC, saved in a variety 
of static/animation formats as well as proprietary Chyron formats, and then played back as broadcast-quality 
graphics and animations on Chyron systems in a variety of video formats.  Advanced from the hugely 
successful Chyron iNFiNiT!® family, all Duet systems can import files from and export files to iNFiNiT! family 
systems.  There are six Duet systems:  Duet SD, Duet HD, Duet LE, Duet PCI, Duet LEX and Duet PCI+. 

NOTES 
 Duet SD and Duet HD differ in output and other aspects of operation, but use the 

same version of Lyric.  

 Duet SD and Duet HD differ more substantially from Duet LE/LEX/PCI/PCI+ 
systems, which use a different version of Lyric. 

 Lyric for offline use is also a separate version of Lyric designed for content 
creation on PCs only.  Lyric compositions created on a PC can be played back on 
Duet systems. 

 Lyric Online Help and printed documentation contain information about Lyric 
operation on all Duet systems, as well as offline PCs.  Unless otherwise noted, 
the information provided applies to all systems.  Features and operations 
pertaining to or excluding specific systems are explicitly called out.  Be sure that 
the documentation you are referencing is appropriate to your hardware. 

 Message Format Compatibility:  Messages composed in earlier versions of Lyric 
can be played back using the current version of Lyric, but should be carefully 
checked for stable reproduction.  The same caution should be taken when 
playing a message composed on one type of Duet system and playing it back on 
another. 

 Closing and Restarting Lyric:  Whenever Lyric has been closed, wait at least 10 
seconds in order to allow Lyric to completely shut down before restarting.  If 
animations are still visible on the screen, wait for them to play out as well. 

 Among the functions that differ markedly between Duet SD/HD and Duet 
LE/LEX/PCI/PCI+:  Masks, Default Effect, Playlist Effect Setup, Video Capture and 
Squeezeback (Duet SD)/Squeezeback Panel (Duet LE/LEX/PCI/PCI+). 

 Multi FX, which transitions a message out using one effect, while simultaneously 
transition in another message using another effect, are not available to Duet 
LE/LEX/PCI/PCI+.  A similar result can be achieved on a Duet LE/LEX/PCI/PCI+ 
system by linking boards and applying Message Effects, accessed from Default 
Effect setup in the Config menu. 
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Lyric Font Support and Font Creation 
Lyric supports TrueType®, OpenType® and iNFiNiT!® fonts, as well as Windows® 2000 Unicode (Chinese, 
Japanese, Cyrillic, etc.).  Lyric does not support PostScript® fonts.  For information on creating fonts for use in 
Lyric compositions, refer to the chapter on Creating and Using Fonts in Lyric. 

About Optional  Internal and External Hardware 
Duet is a multi-purpose media-processing system that brings out Lyric's most advanced capabilities.  An open 
platform scalable for digital television, Duet is a video system that incorporates a CPU and Windows 
operating system with powerful Duet hardware.  Features include internal keying/compositing of graphics and 
video, with three real-time layers: background, video, and animated foreground graphics all in a single 
channel. Consult the Duet Hardware Reference Guide (Chyron Publication No. 2a02105)  for complete 
technical information about the Duet platform.  A wide variety of optional internal and external optional 
hardware can augment the scope and flexibility of Duet systems.  These include: 

 Duet Keyboard - All Systems:  While a PC keyboard can run Lyric on a Duet system, the Duet 
keyboard provides dedicated keys for quickly executing Duet operations.  Refer to the chapter on 
Optional Duet Hardware for in-depth information. 

 Internal Clip Player - Duet SD/LE/LEX/PCI/PCI+:  The Internal Clip Player enables the recording 
and playback of video/audio clips in Lyric compositions.  Refer to the chapter on the Internal Clip 
Player for in-depth information. 

 Squeezeback Board - Duet SD:  The internal Squeezeback board enables the creation of regions 
which display input video in a Lyric composition.  Refer to the chapter on Video Regions and 
Squeezeback Objects for in-depth information. 

 PCI-Squeezeback Board - Duet LE/LEX/PCI/PCI+:  The internal PCI-Squeezeback board adds 
cutting-edge animated video effect creation capability, including resizeable, animatable video regions 
which display input video.  Refer to the chapter on Video Squeezeback for in-depth information. 

 RS-422 Serial I/O & GPIO Board (All Duet Systems - Configuration and use differs among 
systems.):  The internal RS-422 Serial I/O & GPIO board provides GPI capability to Duet SD and 
HD systems, and RS-422 interface capability with all Duet systems.  RS-422 capability enables for 
control of external devices such as VTRs.  Note that Duet LE/LEX/PCI/PCI+ Video Processing 
Boards (VPBs) have built-in GPI capability, although PCI-Squeezeback boards do not.  Refer to the 
chapter on the RS-422 Serial I/O & GPIO Board for in-depth information. 

 Video Capture Board (All Duet Systems - Boards differ among systems.):  The internal Video 
Capture board allows the Duet to capture a frame of video, display it as a background on the Duet 
output and save it to a graphics file in one of the supported graphics formats.  Refer to the chapter on 
Video Capture for in-depth information. 

 Video Mixer - Duet SD:  The internal Video Mixer board enables the mixing of video on a Duet SD 
system.  Refer to the chapter on Video Mixing for in-depth information. 

 HD Mixer - Duet HD:  The internal HD Mixer board enables the mixing of video on a Duet HD 
system.  Refer to the chapter on Video Mixing for in-depth information. 

 CMix - Duet SD/LE/LEX/PCI/PCI+:  The external CMix unit enables the mixing of video.  While it can 
be used for mixing video on a Duet SD, it is generally used for Duet LE/LEX/PCI/PCI+ systems.  
Refer to the chapter on Video Mixing for in-depth information. 

 KwiKeys GPI/O Trigger Device - All Systems:  KwiKeys provides an easy method of executing 
GPI-triggered events.  Refer to the chapter on the Triggering Internal and External Events:  GPIs, 
RS-422 and RS-232 Serial Protocols for in-depth information. 

 ReCall Keys:  ReCall Keys provides a means for the Lyric operator to quickly call up Lyric 
messages, play animations and manipulate Duets program outputs.  ReCall Keys can be connected 
to a Duet system or a PC running Lyric, and communicates with the system via the RS-232 protocol.  
Refer to the chapter on the Triggering Internal and External Events:  GPIs, RS-422 and RS-232 
Serial Protocols for in-depth information. 
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Lyric and External Systems 
Lyric can transfer files to and from Chyron® iNFiNiT!®, Chyron Aprisa and Quantel® systems.  This enables 
access to existing files on these systems, modification in Lyric, and transfer back to the external systems in 
their native formats.  Refer to the chapters on these systems for in-depth information. 

Using Lyric 
In Lyric, graphics are composed by arranging any combination of 2D text, 3D characters, 3D objects, 2D 
bitmap graphics and light sources in an area called the Canvas.  Collectively, items placed on a Lyric Canvas 
are called objects or elements.  The use of the term Object or Element in this documentation can sometimes 
differ depending on the function being described.  Once placed on the Canvas, any object may be individually 
manipulated.  Except in 2D Text Windows, there are no row/column constraints, allowing complete freedom 
of object placement. 

In addition to the standard Windows methods for saving and opening files (Ctrl + S and Ctrl + O), Lyric 
messages may be recorded and recalled using Record and Read commands entered on the numeric keypad 
of a standard PC keyboard or the shortcuts to these commands on the Address Keypad of the Duet 
Keyboard, in conjunction with the Message Number display.  In addition, Lyric offers Read Next, Read 
Previous and Playlists to display message sequences.  Messages, fonts and graphics can also be easily 
imported to the Canvas and exported to a variety of destinations via Lyric's Browser.  

Lyric provides setup parameters which drive Lyric operations.  Most setup functions are found in the Config 
Menu and in Preferences, which are accessed from the Config menu.  Such parameters include interface 
appearance, hardware configuration, communication with external systems, animation settings, etc.  Refer to 
the chapters on the Config Menu and Preferences for in-depth information. 

Lyric also provides setup parameters that apply to individual tools and operations.  These settings are found 
in tool- or operation-specific dialog boxes and panels. 

Animation in Lyric 
Lyric can animate objects placed on the Canvas, including all types of 2D Windows, 3D Text, 3D Objects, 
Bitmaps, Light Sources and specialized objects created by Lyric from Advanced Image Effects, 
Advanced Text Effects, etc.  Backgrounds that are added to the Canvas as a whole are unlike other Lyric 
objects in most respects and cannot be animated. 

Lyric animations are based on frames, much like the frames in a film, with each frame representing a point in 
time and space.  Changes in position and other attributes are made at user-defined points in the animation 
known as Keyframes.  Each Lyric animation by default has two points which define it, the Start Keyframe 
and the End Keyframe. 

It is not necessary to set up a Keyframe for every frame of an animation.  For a simple move, such as sliding 
an object from the upper left corner of the screen to the lower right corner of the Canvas, only the Start 
Keyframe (an object's position at the beginning of the animation), and the End Keyframe (the object's 
position at the end of the animation) must be defined.  Lyric automatically interpolates the in-between frames, 
and the duration of an effect has no bearing on the number of assigned Keyframes necessary to perform the 
effect.  Refer to Animation Overview for information on creating animations. 

Compatibility with iNFiNiT! Files and Fonts 
Lyric can import and export iNFiNiT! fonts and static messages.  Refer to Browser:  iNFiNiT! Font Assets, 
File Menu:  Import from iNFiNiT!, File Menu:  Export from iNFiNiT! and Custom Font Editor for 
information. 
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License Code 
Config Menu > License Code 
Lyric includes a Licensing Manager. A license code number is required if you are installing Lyric for the first 
time on a particular Duet or PC. If you are updating to a new version of Lyric and installing the software to the 
same directory as the previous version, the license code number will not be required. 

Enter the license code number that is printed on the accompanying End-User License Agreement. The Lyric 
application will open. You will not need to enter the code again to use this installation.  

 

License Code Configuration 

If you have acquired Lyric for trial use, you will be supplied with a special license code number that unlocks 
the application for an evaluation period that will last 30 days in most cases. Enter your trial license code as 
prompted. The Lyric application will be unlocked, with all features functional. At the end of the evaluation 
period, subsequent attempts to launch the Lyric application will cause your system to display an error 
message. 

For additional information on licensing, refer to the chapter on Support. 
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The Lyric Interface 
When the Lyric application is first launched, the Canvas , which is where all graphics composition occurs, is 
displayed on the Lyric interface.  As typically configured, the Properties Window appears at the right side of 
the screen, and the Browser and Scene Graph appear to the left. 

The appearance of the interface may differ from that shown in the figure below, depending on the active 
function, the display of other windows and the position of the various tools.  The Menu Bar and various menu 
items can also change depending on which function or window is active.  Most elements that make up the 
Lyric interface can be moved and resized to suit personal preferences. 

For information about navigating the Lyric interface, refer to Navigating and Entering Information in Lyric. 

 

Typical Lyric Interface - Duet LEX 

Many of the functions described in the following sections can be activated with special dedicated keys or key 
combinations, called hotkeys, on the Duet keyboard.  Refer to the Duet Keyboard and Keyboard/Mouse 
Shortcuts for additional information. 

Title Bar 
The Title Bar is located along the top of a window or dialog box.  On the Canvas, it displays the name of the 
program and the currently active file. 

 

Title Bar - Canvas  
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Clicking on the program or menu icon in a maximized or restored window, or clicking on the Title Bar of a 
minimized window,  accesses a menu which provides window functions.  The program or menu icon is 
located directly to the left of the window title.  In the figure of the Lyric Canvas Title Bar at left below, it 
appears as the Lyric icon.  The figure to the right shows the menu accessed from a minimized window. 

 

Windows Title Bar Menus 

A Title Bar may contain the program and/or file name, function name and other information.  On the Canvas, 
the Title Bar also provides buffer and output information.  Refer to VGE Tally later in this section for 
additional information.  It also provides the following window functions through the Title Bar icons, menu, 
keystrokes and mouse. 

Icon, Menu Item, 
Keystroke or 
Mouse Action 

Description 

 

Menu:  Maximize 

Maximize:  Maximizes the window to full screen. 

 

Menu:  Minimize 

Minimize:  Minimizes the window. 

 

Menu:  Restore 

Restore:  Restores window to previously set size. 

 

Menu:  Close 

Ctrl + F4 

Close:  Closes window. 

Menu:  Next 

Ctrl + F6 

Next:  Moves focus to the next window. 

Menu:  Move 

Drag using 
the Mouse 

Move:  Repositions the window.  When accessed from 
the Title Bar menu, select Move, press the cursor 
keys  to reposition, and then press Enter.  
For a fine adjustment, press Ctrl + .  Note that 
when Move is selected from the menu, moving the 
mouse cursor without clicking also moves the window.  
Double-click to set. 

A Window can also be dragged to a new location.  
Click-and-drag the Title Bar to reposition the window.  
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Icon, Menu Item, 
Keystroke or 
Mouse Action 

Description 

Menu:  Size 

Drag using 
the Mouse 

Size:  Resizes the window.  When accessed from the 
Title Bar menu, select Size, press the cursor keys 
 to resize, and then press Enter.  For a fine 
adjustment, press CRT + .  Note that when 
Size is selected from the menu, moving the mouse 
cursor without clicking also resizes the window.  
Double-click to set. 

A Window can also be also be resized using just the 
mouse.  Click-and-drag the edges and/or the corners 
to resize the window.  

Menu Bar 
The standard Windows menu bar includes familiar File, Edit, View, Window and Help pull-down menus as 
well as Lyric-specific Tools, Browser (visible when the Browser is active) and Clip (visible when the Clip 
Control Panel is active) menus.  Note that the Tools menu is also accessible by right-clicking on the Canvas 
or the Scene Graph. 

For the sake of clarity, Tools/Canvas Context/Scene Graph Context menu functions in the Lyric User Guide 
will be referred to as accessible from the Tools menu.  It should be understood that in most instances, the 
same functions are also accessible from the Canvas and Scene Graph context menus.  Any differences are 
noted where appropriate. 

Canvas 
File Menu > New > Canvas; Windows Toolbar >  
View Menu > Canvases 
Lyric's Canvas is the 3-dimensional space in which all composition and animation takes place. Text and 
objects, including Individual Light sources and the Camera, can hold fixed positions or move within three 
dimensions.    Note that a new Canvas can be created by accessing File > New > Canvas or by clicking the 

 button on the Chyron Toolbar. 

If the Canvas is not visible: 
 Pull down the View menu, and then select Canvases. 

If the Canvas is still not visible, it is necessary to open a new Canvas. 
 Pull down the File menu, and then select New > Canvas or click the New Canvas icon . 

Scroll bars on the right side and bottom of the Canvas enables you to adjust your view of objects on the 
Canvas, and enables you to compose animations where the objects start outside of the normal display area 
of the Canvas. The Reset Scroll Position icon quickly recenters the Canvas. 

 

Canvas Reset Scroll Position Icon - Centered and Uncentered 

If the Canvas Reset Scroll Position icon and Canvas View icons (described later in this section) are not 
displayed: 

 Pull down the View menu, select Toolbars, and then select Reset Scroll/View Position.  

Above left, the icon is seen in the centered state, when the Canvas view is centered. At right, the icon is seen 
in its uncentered state, when the Canvas view is off-center. 

The Canvases for both active and inactive frame buffers can be displayed, as shown in the Lyric interface 
above.  The setting can be enabled/disabled via Config Menu > Preferences > Windows > Display All 
Frame Buffers..  
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To quickly change the focus in the Lyric interface to the Canvas displaying the active Frame Buffer: 
 Click the Canvas or press F6. 

The Canvas context menu is virtually the same as the Tools menu and the Scene Graph context menu.  To 
display the Canvas context menu: 

 Right-click on an empty area of the Canvas, i.e., not on an object. 

A Lyric composition on the Canvas can be viewed in variety of ways.  A view can be selected by clicking one 
of the View icons that is located directly to the right of the Reset Scroll Position icon.  To view the different 
orientation: 

 Click on a Canvas View icon.  Note that the leftmost icon is the Reset Scroll Position icon. 

 

Canvas View Toolbar 

If the Canvas View icons and Canvas Reset Scroll Position icon are not displayed: 
 Pull down the View menu, select Toolbars, and then select Reset Scroll/View Position.  



 Getting Started 

 2-9 

The following figure shows a 3D object (soccer ball) a 2D object (flare), 3D text (the word "soccer" in 3D 
characters) and a 2D Text Window (the word "soccer" in 2D text).  The view is identified in the top left corner 
of the Canvas.  The visible axes are shown at the bottom left of the Canvas. 

All four types of objects are visible in Front view.  

 

Canvas - Front View 
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The 3D object and the tops of the 3D characters are visible in the Top view.  The top edge of the 2D Text 
Window, although it has no thickness and is in the XY plane only, is indicated by a blue line.  The 2D object, 
having no thickness and being in the XY plane only, is not visible.  If the 2D object or the 2D Text Window 
are rotated in 3D space, they would be visible. 

 

Canvas - Top View 
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All four types of objects are visible in Perspective view. 

 

Canvas - Perspective View 
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The 3D object and the tops of the 3D characters are visible in the Top view.  The left edge of the 2D Text 
Window, although it has no thickness and is in the XY plane only, is indicated by a blue line.  The 2D object, 
having no thickness and being in the XY plane only, is not visible.  If the 2D object or the 2D Text Window 
are rotated in 3D space, they would be visible. 

 

Canvas - Left View 
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The following figure simultaneously shows all four views. 

 

Canvas - View All 
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The following figure shows all of the elements rotated in 3D space.  Not that the 2D Text Window is now 
visible in the Top and Left views, and the 2D Object is now visible in the Top view.  It would also be visible in 
the Left view, but is hidden by the soccer ball. 

 

Canvas Views - Objects Rotated in 3D Space 

To quickly toggle the multi-view display on and off: 
 Pull down the View menu, and then select Multi-View. 

Additional scene viewing tools are also available: 
 Spin the mouse wheel up/down to zoom into/out from the Canvas. 

 Hold the Shift key down.  Spin the mouse wheel up/down to zoom into/out from the Canvas more 
quickly. 

 Hold the Shift key down and the mouse wheel down.  Spin the mouse wheel up/down to zoom 
into/out from the Canvas more slowly. 

 Hold the mouse wheel down.  Move the mouse around the Canvas to look around the scene. 

 Hold the Shift key down and the mouse wheel down.  Move the mouse around the Canvas to rotate 
the scene. 

 Click the Canvas Reset Scroll Position icon to reset the view. 
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The following elements may be placed on a Canvas:  

Object  Description 

2D Text 2D Text Windows including Roll, Crawl and Type On 
windows. 

3D Characters  3D extruded text derived from Lyric's TrueType® fonts. 

2D Objects 2D graphics in a wide variety of file formats. 

3D Objects 3D objects in the .3ds, .prj  or .obj formats. 

Flipbooks Flipbooks, which are self-contained animations composed of 
sequences of 2D bitmap graphics that can be executed as a 
Flipbook, as well as animated as a single objects on the 
Canvas. 

Backgrounds A solid color, ramped color or bitmap graphic that can act as a 
Background for a 2D Text Window, a 2D Text Template, or 
the entire Canvas.  Backgrounds cannot be animated in 3D 
space, but their Transparencies can change during an 
animation. 

Global Light  A light source which provides light from all directions, with color 
and intensity set on the Properties > Lighting.  This light 
source is always present in the Canvas, and cannot be 
animated in 3D space or deleted. 

Individual 
Lights  

Up to six individual Light Sources which can be placed in a 
Canvas.  Color, Style (Spot or Flood) and Intensity of these 
lights are set in Properties > Lighting.  Individual Lights can 
be animated in 3D space. 

Camera  Establishes a viewer frame of reference.  The Camera can be 
animated, and its focal length can be adjusted. 

The Camera feature comes in handy when, for example, it is 
necessary to slightly shift the view of every object on the 
Canvas.  Rather than repositioning each object and struggling 
to maintain the proper perspective, the Camera can simply be 
repositioned.  The effect is the same as slightly moving the 
position of the viewer. 

There are also other elements that are generated by Lyric and added to the Canvas when using Advanced 
Image Effects, Advanced Text Effects, etc.  

It is necessary at times to select the Canvas as a whole, for example, when applying a Background to the 
Canvas.  Choose one of the following methods to select the Canvas: 

 Click in an empty area of the Canvas.  The Global Light listing in the Scene Graph should become 
highlighted. 

 Click on the Global Light or Camera listing in the Scene Graph. 

When Lyric is running on a Duet system, Frame Buffer status and the output to which it is routed is displayed 
on the Canvas Title Bar. 

 

Canvas Title Bar 
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In the figure above: 
 Msg indicates Message Name.  In this instance, it is Untitled. 

 The directory path indicates the Default Message Directory as set in Config Menu > Preferences 
Default Paths.  Note that when a message is read from another directory, the path to that message 
is briefly displayed, and then reverts to the Default Message Directory.  In this instance, it is 
\\Emerald\Lyric\Messages. 

 FB1 indicates the Frame Buffer in which the message has been read.  In this instance, it is Frame 
Buffer 1.  Note that a display of FB0 indicates that there are no VGEs assigned to Lyric in the 
Configure Board Use (Duet LE/LEX/PCI/PCI+)dialog box, or that Lyric is running on a PC.  Refer to 
Duet Hardware for details on board assignment. 

 Out 1 indicates the Output Channel for the Frame Buffer.  In this instance, it is Channel 1. 

Canvas Resolution 
Config Menu > Canvas Resolution 
Canvas Resolution settings configure the Canvas to properly reflect the graphics that are output from the 
Duet system, as well as control how 2D bitmaps are imported to the Canvas. 

NOTE 
Scaling the Canvas using the mouse will not preserve the aspect ratio of the Canvas. 

 

Canvas Resolution Dialog Box 

Broadcast Standard Presets 

Seven presets are provided, matching the most common television standards, along with a setting for high-
definition video for film production (HDTV 1080 24P). The User Defined option allows the operator to enter 
specific width, height, frame rate, and pixel aspect ratio settings.  
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Use 1:1 Pixel Aspect for Graphics Import 

This option compensates for the 
difference between the square-shaped 
pixels used by Windows graphics 
applications and the rectangular pixels 
used by the Lyric application.  

In the top illustration, the Use 1:1 Pixel 
Aspect for Graphics Import option is 
active, and the original appearance of the 
imported object has been preserved. 

 

1:1 Pixel Aspect ON vs. 1:1 Pixel Aspect OFF 

In the bottom illustration, the option is not 
active, and the proportions of the imported 
object are distorted. 

Enable Auto Standards Conversion 

When this function is enabled, 4:3 SD messages can be imported into a 16:9 HD Canvas and vice versa, 
while aspect ratio and size are maintained. 
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For example, a 
page is created 
in Lyric with the 
Canvas set to 
D1 525 (4:3 - 
720 X 486). 

 

The Canvas 
Resolution is 
then changed to 
16:9 525; the 
pixels are still at 
720 X 486.  If 
the same page 
is read to the 
16:9 Canvas 
without the 
Auto 
Conversion 
enabled, it 
would appear 
horizontally 
stretched. 

 

With Auto 
Conversion 
enabled, the 
page created 
with the Canvas 
set to D1 525 
would now 
retain the proper 
aspect ratio 
when read to 
the 16:9 
canvas.  There 
is no need for 
rescaling.  The 
only area with 
which to be to 
be careful is that 
background 
clips are 
stretched to fill 
the entire 
screen when 
converting to 
from 4:3 to 
16:9. 
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When Auto Standards Conversion is used in the inverse situation, pages created in 16:9 HD format display 
with the correct aspect ratio when read into a 4:3 Canvas.  Note however, that the left and right edges of 
graphics created to fit a 16:9 Safe Title area are clipped when reading into the 4:3 Canvas.  The interior 
outline above shows the 4:3 Safe Title area. 

To enable Auto Standards Conversion: 
1. From the Config menu, select Canvas Resolution.  The Canvas Resolution dialog box is displayed. 

2. Click the Enable Auto Standards Conversion checkbox and click OK. 

Safe Title Adjust 
Config Menu > Safe Title Adjust 

The Safe Title Area is generally used to delineate the area on the Canvas where it is "safe" to place objects 
so that will be seen on most televisions.  Lyric has built-in default settings for each Canvas Resolution, so 
that the user can be fairly certain that if the graphics are placed within the Safe Title Area, they are unlikely to 
be cropped by a viewer's television. 

 

Safe Title 
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Lyric's Safe Title Area display can be adjusted to any size, proportion and position on the Canvas.  A resized 
Safe Title Area can also be used to crop Flipbook animations when they are saved. 

To adjust Safe Title Area settings: 
 Select Safe Title Adjust from the Config menu.  The Safe Title Adjust dialog box is displayed.  If no 

modifications have been made, it displays the default settings for current Canvas Resolution, as set 
in Config Menu > Canvas Resolution.  

 

Safe Title Adjust 

Set the following parameters, and then click OK to set, or Cancel to cancel. 

Parameter Description 

XY Dimensions and Position:  Unlike object position as displayed in the Status Bar 
and Properties > XYZ, where XY coordinates (0,0) specify the center of the Canvas, 
Safe Title XY coordinates (0,0) specify the upper left corner of the Canvas.  There are 
no negative coordinates for Safe Title. 

X Horizontal coordinate of the upper left corner of the Safe Title 
Area. 

Y Vertical coordinate of the upper left corner of the Safe Title 
Area. 

Width Width of the Safe Title Area.  A change to the Width results in 
an adjustment to the right border of the Safe Title Area.  A 
change to the Width is reflected in the Width %. 

Height Height of the Safe Title Area.  A change to the Height results 
in an adjustment to the right border of the Safe Title Area.  A 
change to the Height is reflected in the Height %. 

Width % Specifies the percentage of the width of the Canvas to which 
the Safe Title should be set.  A change to the Width % is 
reflected in the Width. 

Height % Specifies the percentage of the height of the Canvas to which 
the Safe Title should be set.  A change to the Height % is 
reflected in the Height. 
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Parameter Description 

Save A Safe Title setting can be saved and recalled for future 
use.  To save a Safe Title setting: 

1. After settings are final, click Save.  The Save Safe Title 
dialog box is displayed.  Note that the default location 
for the Safe Title file is the Default Message Directory 
as set in the Config Menu > Preferences > Default 
Paths, although the file can be saved elsewhere.  Note 
also that the file type is called Safe Title File (*.saf). 

2. Enter a file name, and then select Save.  The file has 
now been saved for future use. 

Recall To recall a saved Safe Title file: 

1. Select Recall.  The Recall Safe Title dialog box is 
displayed. 

2. Navigate to the desired .saf file, and then select 
Open.  The Safe Title Area is now displayed with the 
recalled settings applied. 

Reset Select Reset to reset the Safe Title Area to the default settings 
for the current Canvas Resolution as set in Config Menu > 
Canvas Resolution. 

 
Transport Controls 
The Transport Controls provide easy navigation and playback control of the current animation.  They are 
usually located at the bottom edge of the Canvas, and are organized as familiar Play, Stop, Rewind and 
Fast Forward buttons.  Intermediate buttons advance or reverse the animation by one frame or one second 
of video, or to the next/previous keyframe. The buttons at each end advance or reverse animation to the end 
or beginning of the sequence. 

 

 

Transport Controls 

Changes made with the Transport Controls buttons are reflected by the Frame Counter display, and by the 
Current Frame indicator on the Timeline and on the Keyframe Graph. 

Additionally, the speed of an animation can be changed during execution: 
 Press the up cursor key  to speed up the animation, or the down cursor key  to slow down the 

animation. 
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Frame Counter 
The Frame Counter display shows the elapsed time in a given animation in hours, minutes, seconds and 
frames.  Keyframes can also be set by entering figures directly into these windows or using the display's up 

and down arrows  to increase or decrease the time value displayed in the active Hour, Minute, Second or 
Frame field. 

 

Frame Counter 

Message Number 
Traditional Chyron systems such as the iNFiNiT!® are able to save newly-created files as messages, which 
are assigned a number of up to eight digits.  Lyric includes this feature as well.  Message ID is displayed in 
the Message Number display for faster storage and recall of messages than would be possible opening files 
in the typical Windows manner. 

A Message ID Number can be entered for Read, Read Next, Read Previous or Record operations by using 
the numeric keypad, which is the set of number keys to the right of the Duet or PC keyboard. 

 

Message Number 

Each time a Lyric file is recorded or read, the Message Number increments.  Additionally, the Message 
Number of the currently displayed file is displayed in the Title Bar of the Canvas. 

Refer to Recording/Reading Messages for further information. 

Note that there are many different file operations in Lyric.  Refer to the section(s) covering the function or 
feature for details on reading (recalling) and recording (saving) specific types of files.  

Browser 
Browsers enable you to quickly catalog and store objects and assets such as font styles, and quickly recall 
them into your current project. Browsers act both as a database for Lyric assets, and as a visual storage, 
search, and retrieval system for those assets. 

Scene Graph 
The Scene Graph lists all of the elements in the current Canvas, including text, graphic objects, Lyric-created 
objects and light sources.  Each element can be selected using the mouse and highlighted for adjustment. 

Font and Justification Tools 
Font Tools display current font settings and can set font style, size and color.  These attributes can be also 
set in the more detailed Font Properties dialog box, which is part of the Properties window.  Font Tools 
also include standard Windows buttons for bold/italic/underline and for left/center/right justification and vertical 
centering.  
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Windows (Standard) Toolbar 
The Windows toolbar includes standard Windows icons for creating a new file, opening existing files and 
saving files.  There are also Cut, Copy, Paste and Delete icons, as well as Undo/Redo icons and the 
context-sensitive Help cursor. 

Timeline 
The Timeline is a visual representation of the elements present on the Canvas and their progress through an 
animation's duration.  Each element and many of its attributes has its own Timeline, which is displayed in the 
main Timeline window.  Keyframes can easily be set by clicking and dragging each element from a starting 
point to an end point. 

Properties 
The Properties dialog box controls many attributes of the Canvas and its objects, such as font style, light 
intensity, positioning of objects, etc.  The top of the Properties dialog box contains tabs from which you can 
quickly select a Property to set or change. 

Chyron Toolbar 
Chyron Tools access functions unique to Lyric.  Various icons may be grayed out, depending on the 
currently active function and type of Duet system.  Included in the Chyron Toolbar are the Transform and 
Alignment Toolbars. 

 

Chyron Tools 

Tool Description 

2D Windows:  Click the tool icon to introduce the 2D Window to the Canvas.  2D 
Text and RGB Fonts can be entered into these windows. 

 Opens a 2D Text Window on the Canvas. 

 
Opens a 2D Roll Window on the Canvas for composing Roll animations. 

 
Opens a 2D Crawl Window for composing Crawl displays. 

 
Opens a special 2D Type On Window for composing Type On/Slow Reveal 
displays. 

 
Opens a 2D Clock Window for creating time-of-day Clock displays.  

 
Opens a 2D Timer Window for creating count-up and count-down Timer 
displays. 

 
Opens a Spline Window in which 2D text or RGB Font characters may be 
mapped to a curved baseline for animation along that baseline. 

Importation and Template Creation:  Click the tool icon to set up importation of a 
2D or 3D object or background; or to create a 2D or 3D Template. 

 Imports 3D Objects (.3ds, .prj or .obj formats) into the Canvas. 

 Imports 2D Bitmap graphics into the Canvas.  Lyric can import more than 20 
graphics file types.  Imported graphics are treated as independent, fully 
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Tool Description 

animatable objects in Lyric compositions. 

 Imports Background images or textures. Backgrounds imported in this manner 
may be set within the Canvas as a whole, or within individual 2D text windows. 

 Creates a 2D Text Template when the cursor is inside of a 2D Text, Roll, 
Crawl or Type On Window; or a 3D Text Template when the mouse is clicked 
outside of any window, directly on the Canvas.  

Grouping:  Allows grouping and ungrouping of objects. 

 With multiple objects selected, the Group icon enables the operator to 
manipulate those objects simultaneously. 

 Ungroups grouped objects, restoring individual control over the objects. 

Display:  Click to set various display options. 

 Erase offers a variety of options for erasing entire scenes or certain categories 
of scene elements.  Be sure to familiarize yourself with the use of this control, 
because Undo functionality is limited as regards Clear Scene operations. 

 
Set Default Background Color enables the operator to select a gray or black 
background color to use as a backdrop while creating a Lyric composition.  This 
background color is not seen on output.  Aids visibility in situations where 
elements in the composition are difficult to see because of unusual textures and 
colors. This function is different from the function that adds a Background to 
the entire composition, a 2D Text Window or a 2D Text Template! 

 

 

Turn On/Off Text Window Frames eliminates/restores visibility of all 2D 
Window and 2D Text Template borders to facilitate composition, reducing the 
necessity of reviewing composition on a Duet output.  Note that is it always 
recommended that the final Lyric composition be reviewed on output to ensure 
correct execution of animations. 

 Turns on/off all windows except those designated as Basic Windows in the 
Preferences menu.  

Mask - Duet SD Only 

 Activates the Mask Scene function, which is available only on Duet SD. 

Transform Tools 

 
Edit Position cursor for repositioning all types of objects on the Canvas. 

 
Edit Rotation cursor for rotating all types of objects on the Canvas. 

 
Edit Scale cursor for scaling all types of objects on the Canvas. 

 
Edit Center of Rotation cursor for adjusting the Center of Rotation for all 
types of objects on the Canvas. 
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Tool Description 

Alignment Tools 

 
Left-aligns multiple 2D Text Templates or Timelines. 

 
Right-aligns multiple 2D Text Templates or Timelines. 

 
Top-aligns multiple 2D Text Templates or Timelines. 

 
Bottom-aligns multiple 2D Text Templates or Timelines. 

 
Makes multiple 2D Text Templates or Timelines the same width. 
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Duet SD/HD Tools and Duet LE/LEX/PCI/PCI+ Tools 
Duet Tools and Duet LE/LEX/PCI/PCI+ Tools control playback and display of Lyric messages.  There are 
operations common to both Duet SD/HD Tools and  Duet LE/LEX/PCI/PCI+ Tools, but there are functional 
differences as well.  Duet LE/LEX/PCI/PCI+ Tools also provides additional animation playback tools.  Duet 
Tools are available only when Lyric is running on a Duet system.  They are grayed out in an offline 
environment.  Additionally, a grayed out FB icon, as shown below, indicates an unavailable or uninstalled 
VPB (all systems) or PCI-Squeezeback board (Duet LE/LEX/PCI/PCI+ only).  For additional information on 
Duet Tools, refer to Duet SD/HD Tools or Duet LE/LEX/PCI/PCI+ Tools. 

 

Duet SD/HD Tools 

 

Duet LE/LEX/PCI/PCI+ Tools 

NOTE 

As of Lyric v5.0, the Load , Quick Load , Stop  and Play  icons have 
been removed from the Duet LE/LEX/PCI/PCI+ Toolbar.  Their functions are still 

accessible using keystroke combinations.  Additionally, the Save  and Load Save 

 functions have been removed from Lyric. 

The following table provides brief descriptions of the various Duet Tools.  

Tool Description 

Duet Tools (All systems):  These tools are available to all Duet systems.  The 
icons have a slightly different appearance on Duet SD/HD systems as opposed 
to Duet LE/LEX/PCI/PCI+ systems.  Unless otherwise noted in this table, when 
pairs of icons are shown, the Duet SD/HD version is shown on the left, and the 
Duet LE/LEX/PCI/PCI+ version is shown on the right. 

 

 

The   icon activates Duet's Render Mode.  In this 
mode, any text or objects placed on the active Canvas are 
rendered on Duet's video output(s) in real time.  Compositions 
displayed on the video output can thus be edited in real time. 

 When Render Mode is not active (i.e. the   icon is 
not selected), Canvas compositions can be transferred to the Duet 

hardware by clicking the   (Transfer) icon. Once a 
composition has been transferred to the video output, it can no 
longer be modified in real time.  Additional changes must be made 
on the Canvas, and then rendered to the video output by clicking 
the Duet icon. 

 The Swap Output Channels icon toggles between 
the Canvases on channels 1 and 2 for editing or composition on 
Duets VGA monitor. Note that this icon also executes a 
transition between Duets two video outputs!  The video output 
channel designated as active displays the transition.  The type of 
transition is designated by the Default Effect setting.  The inactive 
video output channel will simply switch one image for the other. 

 Note that on the Duet SD/HD the active buffer swaps as 
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Tool Description 

well, and the user now edits in the newly current buffer.  
On the Duet LE/LEX/PCI/PCI+, the active buffer remains 
the same, even though the contents have been swapped. 

 On a Duet LE/LEX/PCI/PCI+ system, a dialog allowing the 
user to choose the buffer with which to swap is displayed 
when Swap is clicked.  This dialog is not displayed on a 
Duet SD/HD, as the swap destination is already set in the 
mixer. 

Change 
(Change Key) 

No icon.  Changes active frame buffer to next available frame 
buffer. 

Duet SD/HD: 

 

Duet 
LE/LEX/PCI/PCI+: 

 

The Frame Buffer    icons select 
a VGE or MPx output for composition/editing and so displays its 
signal on the VGA monitor. 

A Frame Buffer icon that is green indicates the presence of 
a PCI-Squeezeback board, an optional feature for Duet 
LE/LEX/PCI/PCI+ systems only. 

 An additional FB icon is present on the interface for each 
Frame Buffer available on your Duet system, unless it is 
assigned to an upstream linked board on a Duet 
LE/LEX/PCI/PCI+, in which event it would be inaccessible 
for direct editing.  Additionally, If Lyric is running on a PC, 
all FB icons are inactive. 

 An FB icon, as explained above, appears on the Lyric 
interface to represent each Video Graphics Engine (or 
combination of VGEs being used for Multi-VGE 
Rendering) that is available to Lyric. A grayed-out icon in 
one of these positions represents a VGE that is 
unavailable to Lyric. 

Duet LE/LEX/PCI/PCI+ Tools:  The following tools, some of which have no icons, 
are available only to Duet LE/LEX/PCI/PCI+ systems.  Refer to Duet 
LE/LEX/PCI/PCI+ Tools for more detailed descriptions. 

Load (Alt + L) Loads an animation for field-based playback. 

Quick Load 
(Alt + Q) 

Loads an animation for frame-based playback.  Results in quicker 
rendering, but possibly less smooth animation.  

 
Clears memory of loaded animation. 

Stop (Esc) Stops playback during a loop. 

Play 
(Refer to Duet 

LE/LEX/PCI/PCI+ 
Tools.) 

Plays the animation to the currently active VPB or PCI-
Squeezeback board. 



Lyric User Guide 

 2-28 

VGE Tally 
The VGE Tally indicates which frame buffer is active and on to which output it is routed.  The VGE Tally is 
displayed in the Title Bar of the Canvas displaying the active frame buffer.  In the following figure, Frame 
Buffer 1 is active, as indicated by the active FB1 icon in Duet Tools.  The VGE Tally indicates that Frame 
Buffer 1 is routed to Output 1 of the Duet. 

 

VGE Tally 

The Title Bar of the Canvas displaying the inactive frame buffer indicates only the frame buffer number, not 
the output to which it is routed. 

A VGE Tally can indicate if the frame buffer is routed to a Mixer.  The following indicates that Frame Buffer 2 
is routed to Output 1 and Output 2. 

FB2 Msg:  Untitled on Out 1 + Out 2 

The following indicates that Frame Buffer 3 is routed to through the Video Mixer to Output 1. 
FB3 Msg:  Untitled on Out 1 (Mix) 
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Status Bar 
The Status Bar is located at the bottom of the Lyric interface.  It provides information about active objects 
and functions.  It is illustrated here in three segments, with the leftmost segment at the top; the middle at the 
middle, and the rightmost at the bottom of this figure. 

 

Status Bar 

Trigger prompts such as Paused for Keypress, Wait for Keystroke, Paused for Delay (from 
Delays/Timeouts) and Waiting for Timecode are displayed in red in the Status Bar at the bottom of the 
screen.  The following illustration shows a Wait for Keypress generated by a Wait for Key set in the Control 
field of a Playlist. 

 

Waiting for Keypress 

Status information such as Record confirmation, Delete confirmation, Read Next Loaded, and VGA Preview 
are displayed in green in the Status Bar.  The following illustration shows a Record confirmation. 

 

Record Confirmation 

The Status Bar can be displayed or hidden. 
 Toggle the display on and off by clicking on the Status Bar item in the View menu. 

The Status Bar is divided into panes as follows: 

Pane Description 

Currently 
Selected 
Object or 
Function 

At far left, the Status Bar displays a description of each Toolbar 
icon as the mouse moves over it, or displays the name of the 
currently selected object.  In the figure above, it shows that Object 
'2D Text 1', which is a 2D Text Window, is currently selected. 

Copyright 
Information 

To the left of the middle of the Status Bar is a pane that displays 
copyright information. 

Edit/Mask 
Scene 
Status 

Directly to the right of it is a pane that usually indicates the status 
Edit Scene.  On a Duet SD system only, it changes to Edit Mask 
when a Scene Mask has been created, and Tools Menu > Mask 
Scene > Edit Mask has been selected. 

M The following pane to the right displays the letter M.  It turns red 
during a Macro Record operation. 

Mouse 
Position 

The next pane to the right displays the X and Y coordinates of the 
mouse cursor on the Canvas.  X = 0, Y = 0 are the coordinates for 
the center of the Canvas. 
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Pane Description 

Name of 
Object 

The XY coordinates are followed by the name of the currently 
selected object. 

 In the case of a 2D or 3D object or character, it displays the 
name of the object, matching the name at the very left of the 
Status Bar. 

 In the case of a 2D Text Window, it displays the Row 
Number and the name of the character.  In the example 
above, it is the letter E.  A Unicode character is identified by 
its Unicode number, e.g. U+9788.  An RGB Font character 
is identified by the key combination that produces it. 

To the right side of the Status Bar is a group of panes that displays the active/inactive 
status of various functions.  When the function is active, the pane displays black 
lettering.  When the function is inactive, the pane is grayed out. 

II-1, II-2, II-D 
or II-T 

Intelligent Interface: 

 II-1 indicates that Intelligent Interface is enabled for 
transmission on Serial Port 1. 

 II-2 indicates that Intelligent Interface is enabled for 
transmission on Serial Port 2. 

 II-D indicates that Intelligent Interface is enabled for 
transmission on both Serial Ports 1 and 2. 

 II-T indicates that Intelligent Interface is enabled for 
transmission  via Telnet. 

TRNS Translation Mode:  Allows typing of Alt characters. 

 Press Ctrl plus  - (minus) sign to type multiple Alt 
characters. 

 Press Ctrl plus = (equal sign) to type a single Alt character. 

COL Tab Column Mode:  Allows typing in columns. 

Press Alt + M or select Tab Column Mode from the Edit menu to 
toggle on and off. 

LOCK Lock Mode:  Allows locking of 2D text rows so that they shift as one 
group. 

Press Ctrl + L or select Row Shift Locked from the Edit menu to 
toggle on and off. 

CAP Caps Lock Mode:  When active, all characters are typed as upper 
case.  Equivalent to a typewriter Caps Lock key.  To toggle Caps 
Lock Mode on and off: 

 Press the Caps Lock key. 
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Pane Description 

NUM Num Lock Mode: 

 When active, the numeric keypad at the right of the 
keyboard types numbers. 

 When inactive, pressing the numeric keypad keys shifts 
cursor position, activates/inactivates Insert Mode, or 
deletes the selected 2D text character. 

To toggle Num Lock Mode on and off: 

 Press Fn + Num Lock (same keycap as Ctrl on the numeric 
keypad) on the Duet keyboard, or press the Num Lock key 
on the PC keyboard. 

OVR Overwrite/Insert Mode: 

 When active, a newly-typed character replaces the existing 
character. 

 When inactive, the newly-typed character is inserted at the 
cursor position without replacing a character. 

Choose one of the following methods to toggle between Overwrite 
and Insert Mode: 

 Press Fn + Insert (same keycap as Delete Row) on the 
Duet keyboard, or the Insert key located directly above the 
Delete key on the PC keyboard. 

 With Num Lock Mode inactive, press the Ins (0) key on the 
numeric keypad. 

Clip Control Panel 
Optional single or dual Internal Clip Players provide the ability to play back video and/or audio clips either 
independently or as part of a Lyric animation.  A video clip plays behind Lyric graphics on output, and is not 
visible on the Canvas during clip editing, preview or playback.  The Internal Clip Player also enables input 
video or audio to be recorded to *.avi or *.wav files, respectively.  Refer to the chapter on the Internal Clip 
Player and Clip Control Panel for detailed information. 
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Save/Load User Profile 
Save User Profile:  Config Menu > Save User Profile 
Load User Profile:  Config Menu > Load User Profile 

NOTE 

Lyric Version 4.1 and later running on Windows NT®, Windows® 2000 or Windows XP® 
creates User Profile (*.reg) files that are compatible with Lyric Versions 4.0 and later 
running on Windows NT.  The *.lup format is still supported, and limited-access users 
still cannot read *.lup files. 

Lyric operators can store their preferences for window position, Canvas resolution and all Preferences 
settings.  When all adjustments to the Lyric interface are to your liking, you may create and save a Lyric User 
Preference file (.reg). 

1. From the Config menu, select Save User Profile.  The Store Configuration To dialog box is 
displayed. 

 

Saving User Profile 

2. Select a name and storage location for your settings, and then click Save. 

Lyric now records User Profile information in the .reg file format. For backward compatibility, you may still use 
User Profiles stored in the old .lup format. 
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To load a User Profile: 
1. From the Config menu, select Load User Profile.  The Store Configuration To dialog box is 

displayed. 

 

Loading User Profile 

2. Select a User Profile, and then click Open.  The User Profile settings are loaded. 

NOTES 

When loading a User Profile, it may take a moment for the interface to take on the correct 
configuration!  This is normal behavior. 

When a new User Profile is loaded, the Intelligent Interface Message Directory updates as 
well, and is reflected in the Intelligent Interface dialog box, accessed from Config Menu > 
Intelligent Interface.  The Intelligent Interface directory is the same as the Default 
Message Directory as set in Preferences > Default Paths.  

The last loaded User Profile remains in effect until a new User Profile is loaded. 
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Creating a Simple Lyric Composition 
In case you've found an answer to every early question except the one above, here is an exercise in creating 
a simple Lyric composition, using three basic types of Lyric objects:  2D text, an imported bitmap image and a 
3D Lyric-generated character. 

1. Launch Lyric from the Start menu or a desktop shortcut. 

 

Launching Lyric 
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The Lyric interface opens. 

 

The Lyric Interface 

2. First, we're going to create a brief message in 2D text.  Look closely at the upper left corner of the 
Canvas. It probably looks something like this: 

 

2D Text Window Margins 

What you are looking at are the margins of a 2D Text Window. 

3. Move your pointer to the corner until it becomes a Position cursor. 

 

Position Cursor 
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4. Click and drag down and to the right. You'll see the text window's Title Bar. 

 

Making the 2D Text Window Visible 

This text window is a Lyric object that can be manipulated in various ways, but for the moment, you're 
just going to.... 

5. ....create some text.  Take note of the cursor that should have been in the text window's upper left 
corner all this time. Type some text. 

 

Typing Text into the 2D Text Window 

Now might be a good time to look around the interface and take note of a couple of things: 

 Notice that a baseline immediately appeared when you started typing. 

 Look for the Scene Graph; it's probably somewhere at the left of the screen. In the Scene 
Graph, take note that an entry called 2D Text 1 has appeared. 

 

Scene Graph Showing 2D Text Window 

Just hold these observations in mind, for the time being.  Let's continue with another Lyric basic skill.  
You've got to get that 2D text window down to a manageable size so you can place other objects on 
the Canvas without getting confused. 
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6. Move your pointer just to the lower edge of the text window's title bar.  The pointer becomes a Resize 

arrow. 

 

Resize Arrow 

7. Click and drag downward. Since this is a Resize arrow (and not a Move arrow), you're shrinking the 
area of the text window, not moving the window downward. 

8. Now, if you put a Move cursor over the title bar as in Step 4, and drag the text window up, you've got 
a decent chance of finding the window's bottom edge, whereas you might not have been able to see it 
at first. 

 

Finding the Bottom Edge of the 2D Text Window 

9. Move the text window back toward the top of the Safe Title area, and repeat these moving and 
resizing actions on the sides of the window, until there's some room on the Canvas for other objects. 

 

Moving the 2D Text Window Back into the Safe Title Area 
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10. Now, it's time to import a bitmap image into the composition.  Locate the  button on the Lyric 
Toolbar, and click it. The dialog pictured below appears, allowing navigation for any available 
directory from which you wish to import the image.  By default, the dialog first looks at the directory 
where Lyric is installed, so let's work with one of the images included with the installation. 

 

Select a Graphic File 

11. Before going any further, click the Preview checkbox in the upper-right of the dialog. It'll come in 
handy, as you'll see in a minute. 

12. Now, double click the Lyric folder seen above. Here's what you'll see inside the Lyric directory: 

 

Inside the Lyric Directory 
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13. Single-click rgba.bmp. We know you probably know that you could double-click it to expedite the 
process, but bear with us, because we want you to see the Preview while you're here. 

 

Selecting a Bitmap 

14. Press Open.  The bitmap is added to the composition. 

 

Bitmap Added to Composition 

Notice that the Scene Graph has a new entry, representing the image as an object in the 
composition. 
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15. Lastly, we'll add a 3D character to the composition. Click anywhere on the Canvas that isn't inside the 
2D Text window and isn't touching the imported bitmap.  When you click in the Canvas's workspace, 
look over to the right and note that the Mode control on the Properties page has switched to "3D".  
This indicates that when not specifically dealing with 2D text, Lyric is ready for work with 3D 
characters and objects. 

 

Specifying  3D Character Mode 

16. Type a letter; for now, just one. 

 

Typing a 3D Character 

Notice, too, that the Scene Graph now has a new element. 
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17. Next, we'll manipulate the 3D character in space a bit.  Locate the button on the Lyric Toolbar.  
Place it over the 3D letter you typed, and move it however you please. You'll see that the character 
behaves quite three-dimensionally! 

 

Manipulating the 3D Character 

Note that imported 3D objects can be manipulated in the same manner as 3D characters. 
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Navigating and Entering Information in Lyric 

Accessing Lyric Functions 
The Lyric main interface is composed of a number of areas from which 2D and 3D effects and animations can 
be set up and executed.  Various buttons and drop-down menus provide access to additional functions such 
as Video Squeezeback, Roll, Crawl, and so on.  Pausing the mouse over a button or other Lyric component 
displays a Tool Tip describing the function of the item. 

A grayed-out button, menu item, tab or dialog box indicates that it is either not available to the specific Duet 
system or the PC, or it is not active in the current mode.  For example, the Group button does not become 
accessible until there are multiple objects selected on the Canvas.  An opaque gray button with no graphic 
signifies that the function is not available to the specific system/PC. 

Drop-down menus and associated submenus are accessible from the Menu Bar, as shown in the figure 
below. 

 

Lyric Menu Bar 

If the Browser window is active, a Browser item is also on the Menu Bar, situated between Tools and 
Window. 

A context-specific menu can be displayed and hidden by right-clicking while on a particular Lyric window, 
menu bar or toolbar.  For example, as shown below, right-clicking on an alphanumeric font in the Browser 
displays a Browser Alphanumeric Font-specific menu. 

 

Right-Click to Access Context-Specific Menus 

Refer to Object Name and Type later in this section for additional information on object context menus. 
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About Mouse Selection 
Even after a mouse button is clicked on an icon, object, etc., and is still in the down position, you are not 
committed to selecting the item until the mouse button is released.  If you wish not to proceed with the 
selected item, move the pointer away from the item, and then release the mouse button. 

Entering Information in Lyric 
Entering parameter values and making selections generally follow Microsoft® Windows® conventions. In a 
number of instances, there can be more than one choice with which to enter the same parameter value.  If so, 
the value entered using one method updates the other.  For example, changing the value in a Spin Control 
Box would update its associated slider. 

About Keyboard Shortcuts 
Keyboard shortcuts can be used to quickly enter instructions to Lyric.  References to keyboard shortcuts can 
be found throughout Lyric documentation and are specified as follows: 

 If a keystroke combination contains a +, it indicates that the key specified to the left of the + should be 
pressed, and then held, while the key to the right is pressed.  For example, Ctrl + N indicates that the 
Ctrl key should be pressed, and then held, while the N key is pressed.  Ctrl + Alt +  indicates that 
the Ctrl and the Alt key should be pressed and held while pressing the  key as many times as 
necessary to shift the page on the Canvas. 

 If the keystroke combination does not contain a +, then press, but do not hold the keys, in the order in 
which they are indicated.  For example, to record a message at a specific Message Number, 
<Message Number> Record indicates that the Message Number should be entered on the numeric 
keypad, and then Record is pressed.  No keys are held while others are pressed. 

 If the + key is used as a keystroke instead of used to specify a held key, it is indicated as such. 

Refer to Keyboard/Mouse Shortcuts Overview for a complete list. 

Text Entry Field 
Text entry fields appear as white rectangles.  Place the cursor in the field, and then type the appropriate 
information. 

Spin Control Box/Jog Wheel 
A Spin Control Box is sometimes accompanied by a Jog Wheel.  When both are present, adjusting the 
value in one updates the other. 

 

Spin Control Box and Jog Wheel 

To adjust the value in a Jog Wheel: 
 Use the click-and-drag the mouse pointer to “spin” the Jog Wheel to the appropriate setting.  

To set a value in a Spin Control Box: 
 Highlight the Spin Control Box field, and then type the desired value into the entry field.  Use the 

alphanumeric keys along the top of the keyboard, not the Numeric Keypad keys at the right to enter 
values, as the Numeric Keypad keys change Message ID number and do not update data fields. 

OR 

 Click on the arrows in the Spin Control Box to adjust the value. 
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Adjusting the Increment/Decrement of a Spin Control Box 
The size of the increment/decrement of each Spin Control Box can be individually adjusted.  They cannot be 
adjusted globally, as units vary among Spin Control Box applications in Lyric.  To adjust the increment of an 
individual Spin Control Box: 

1. Right-click on the Spin Control Box, and then select Properties from the context menu.  The 
Chyron SpinEdit Control Properties dialog box is displayed. 

 

Accessing the SpinEdit Control Properties Dialog Box 

2. Enter a new value in the Line field.  The value in this field specifies the number of units that the Spin 
Control Box increments or decrements when an arrow is clicked. 

3. Enter a new value in the Page (CTRL key) field.  The value in this field is the amount that the Spin 
Control Box increments or decrements when the Ctrl + an arrow is clicked.  This value is generally 
set to a larger value than the Line value, giving the user the option of incrementing/decrementing by 
larger intervals. 

4. Select Apply to apply the adjustment, and then click the Close (x) icon at the top right corner of the 
dialog box to exit. 

OR 

Select OK to apply the adjustment and exit the dialog box. 

OR 

Select Cancel to cancel the adjustment and exit the dialog box. 

The context menu shown above also features editing functions that simplify copying values from one field to 
another.  To activate these functions on the menu, highlight a value in a Spin Control Box field. 

 

Spin Control Box Context Menu 
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Function Description 

Undo Undoes the change in the Spin Control Box 
field. 

Cut Cuts the selected value in the Spin Control 
Box field. 

Copy Copies the selected value in the Spin 
Control Box field. 

Paste Pastes the selected value to the Spin 
Control Box field in which the cursor is 
located. 

Select All Selects the entire value in the Spin Control 
Box field. 

Properties Described above. 

Slider 
Drag the slide box to the desired value.  Note that some sliders may differ in appearance (e.g. have a 
moveable pointer), but still operate in the same manner. 

 

Slider 

Checkbox 
Click on a checkbox to toggle it on/off or activate/deactivate. 

 

Checkbox, Unchecked (Left) and Checked 

Radio Button 
Click on a radio button to activate it. Generally, only one button in a radio button group can be activated at 
any time. Selecting a different button in a radio button groups usually deactivates the previously active radio 
button. 

 

Radio Buttons 
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Frame Counter 
A Frame Counter field indicates time in Hours/Minutes/Seconds/Frames.  Some Frame Counters have 
adjustment arrows; other do not.  NTSC video counts 30 (actually 29.97, non-drop-frame, in Lyric) frames per 
second; PAL video counts 25 frames per second. 

 

Frame Counter 

A Frame Counter can be set using one of the following methods: 
 Place on the cursor on the Hours, Minutes, Seconds or Frame field or press  or  to cursor to 

the field, and then click on the up or down arrow to adjust that field.  A field reaching the end of its 
range will change the adjacent field to continue the adjustment.  For example, clicking the up arrow 
while the Frame Counter reads 00:00:00:29, will advance the Frame Counter to 00:00:01:00. 

 Place on the cursor on the Hours, Minutes, Seconds or Frame field or press  or  to cursor to 
the field, and then enter a new value. 

Other Buttons 
Depending on the function of the particular button, clicking on it may simply activate the function, or perform 
an operation. 

Tabs 
To organize a large number of settings in a dialog box, it is sometimes split into tabs.  Clicking on a tab opens 
a dialog box in which board-specific or function-specific settings can be entered.  For example, the 
Properties dialog box, is split into a tabs addressing Font, 2D Font, Lighting, Clock/Timer and so on. 

 

Tabs 

Typing Text in Lyric - Standard and Translation Modes 
Standard vs. Translation Mode 
For the most part, typing 2D or 3D text on the Canvas is performed in the same manner as typing text to 
paper on a typewriter or to a word processor on a PC.  Most characters are typed in Standard Mode.  Alt 
characters, however, produced by key combinations that include the Alt key, must be typed in what is known 
as Translation Mode.  This is because pressing the Alt key in combination with alphanumeric keys in Lyric, 
activates functions such as font and menu selection, rather than typing characters. 

There are two Translation modes: 
 Locked Translation Mode:  This mode activates Translation Mode until turned off.  Toggle on and off 

by pressing Ctrl + (plus key). 

 Single-Stroke Translation Mode:  This mode activates Translation Mode for typing one character 
only.  Toggle on and off by pressing Ctrl - (hyphen key). 
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Note that once Translation Mode is activated, do not press the Alt key to type the Alt character.  Simply 
press the key that makes up the remainder of the Alt keystroke combination. 

 

Key Showing the Four Possible Keystroke Combinations 

As shown in the figure, there are four possible key combinations that can be produced by the keycap A: 
 A:  Sends Code 97 to the system.  To type A, the system cannot be in Translation Mode. 

 Shift + A:  Send Code 65 to the system.  To type Shift + A, the system cannot be in Translation 
Mode. 

 Alt + A:  Sends Code 150 to the system.  To type Alt + A, activate Translation Mode, and then type 
A. 

 Alt + Shift + A:  Sends Code 149 to the system.  To type Alt + Shift + A, activate Translation 
Mode, and then type Shift + A. 

The Translation mode also offers a convenient way to use all four of the ASCII codes that Lyric assigns to 
each key of a PC or Duet keyboard.  While helpful for access to non-standard characters, this feature is 
especially useful with the RGB Font function.  Some production situations, such as sporting events, may 
require quick recall of a large number of bitmaps linked to keystrokes.  The Translation Mode allows the use 
of the Alt keystroke combinations to access RGB Font characters. 

When Translation Mode is active, TRNS on the Lyric Status Bar is not grayed out. 

 

Status Bar Showing Translation Mode Active 

Typing Characters Using Alt + ASCII Codes 
Note that characters with ASCII codes through 255 can be typed on the Canvas by pressing and holding the 
Alt key while entering the ASCII code padded out to four digits.  The numbers must be entered on the 
numeric keypad, not the alphanumeric keys located along the top of the keyboard.  This method works for 
both TrueType® and RGB Fonts.  For example, to type the character ®, which is ASCII code 174 in the Arial 
font: 

 Press Alt + 0174 on the numeric keypad. 

Refer to Duet Keyboard for a map of the ASCII values assigned by Lyric to the keyboard. 

Selecting and Grouping Objects 
Selecting Objects 
When repositioning, rotating, applying other attributes to an object or objects, it is necessary to select the 
object(s) first.  Objects may selected directly on the Canvas, or from the Scene Graph. 

The methods used for selecting 2D text are different from those used for selecting other objects.  Refer to 
Selecting and Modifying 2D Text for details.  The following selection procedures apply to objects except 2D 
text. 

In addition, refer to Enable Bounding Box for details on selecting a 2D object using a Bounding Box. 

The following selection procedures apply to objects except 2D text. 

To select an object on the Canvas: 
 Click the object with the mouse.  As the object is selected, it is highlighted in the Scene Graph.  

To select an object on the Scene Graph: 
 Click the object name on the Scene Graph. 
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Refer to Animation:  Scene Graph for additional information. 

To select multiple objects: 
 Hold the Ctrl key while clicking each object.  As each object is selected, it is highlighted in the Scene 

Graph.  

It can, at times, be difficult to select an overlapped object on the Canvas. To do so: 
1. Hold Alt while clicking on the Canvas.  Watch the Scene Graph.  Each time the mouse is clicked, a 

different item in the Scene Graph is highlighted.  When the desired item is highlighted, it has been 
selected. 

2. Release the Alt key.  The object can now be clicked, and repositioned, rotated, etc. 

This technique can also be used to select a keyframe from a Motion Path where the frames are overlapping. 
1. Click (select) a frame on a Motion Path that is behind the keyframe. 

2. Hold the Alt key down, and then click the keyframe as many times as necessary to advance to the 
keyframe. 

As described in the following section, objects can also be grouped.  This enables the application of attributes 
to the entire group of objects. 

Grouping/Ungrouping Objects 
When multiple objects are selected, they may be grouped, so that changes to attributes simultaneously affect 
all member objects of the group. 

To group selected objects, click the Group icon or select Group from the Tools menu: 

 

Group Icon 

The grouped objects are labeled with a group name, and then listed on the Scene Graph as indicated by the 
topmost item: 

 

Scene Graph Showing Grouped Objects 

 

To expand a group on the Scene Graph to its constituent objects, click the plus sign + to the left of the group 
name.  To reduce an expanded group, click the minus sign - to the left of the group name. 
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Note that when using the mouse in conjunction with Transform Tools to move, rotate, scale or change the 
center of rotation of a grouped set of objects, the user can manipulate the group as one unit, even if only one 
object of the group is selected.  Holding down the Shift key in conjunction with using these tools allows 
manipulation of an individual object within the group. 

To ungroup selected objects, select any object in the group, and then click the Ungroup button or select 
Ungroup from the Tools menu: 
 

 

Ungroup Icon 

The Group object disappears from the Scene Graph, and the individual objects are listed separately. 

Refer to Internal Properties - Use Group Priority for additional information on group behavior. 

Object Name and Type 
Object Context (Right-Click) Menu > First Item 

Many functions and tools related specifically to an object can be accessed by right-clicking on the object itself 
on the Canvas, or by right-clicking the object's listing in the Scene Graph.  This displays the object's context 
menu.  The first item in an object's Context menu identifies the name and type of the object. 

If necessary at any time, the object can easily be renamed. 
1. Right-click on the object on the Canvas, or on its name in the Scene Graph. 

2. Select the first item in the context menu. This item specifies the name and type of the object.  The 
New name for selected object: dialog box opens. 

 

Changing an Object Name 

3. Enter a new name, and then click OK.  The new object name is reflected in the Scene Graph, the 
Keyframe Graph, the Timeline and the object's context menu. 

Scroll Bars 
Scroll Bars are located at the right side and bottom of the Canvas and move the view of the 3D workspace 
up, down, right or left.  Scroll bars are present in other Lyric Windows as well. 

NOTE 
It is important to reset the Canvas scroll bars before recording a new Lyric message, in 
order to make sure that text and/or objects are properly positioned for display upon 
recall. Refer to Getting Started:  Canvas for additional information. 

About Transparency Settings 
The Transparency setting is technically an Opacity setting, in that a setting of 0 is completely transparent, 
and a setting of 100 is completely opaque.  It is common throughout the industry, however, to use the terms 
Transparency and Opacity interchangeably when referring to level settings. 
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Edit Menu 
The Edit menu accesses editing functions common to most objects, 2D Text Window and Template editing 
functions, as well as selected position and animation editing functions.  Unless specifically noted, references 
to 2D Text Windows includes also 2D Roll, 2D Crawl and 2D Type On (also known as Slow Reveal) 
Windows.  Many of these functions are also accessible from the Chyron Toolbar, keystroke combinations or 
by other means.  All menu items in the menu shown below are shown as active, although during Duet/Lyric 
operation, various items are active or grayed out depending upon the Duet/offline system, optional hardware 
installed and current function in use. 

 For information on editing functions common to most objects, refer to the following section. 

 For information on the 2D text editing functions, refer to the chapter on 2D Text. 

 For information on Template, DBLink and (Intelligent) Interface functions, refer to the chapter on 
2D Text Templates. 

 For information on Keyframe  All Objects, Keyframe Selected Objects and Copy/Paste 
Animation State, refer to the chapter on Animation. 

  

Edit Menu 
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Common Editing Functions 
The following edit functions are common to most objects. 

Undo/Redo 
To view: 
View Menu > Undo 
View Menu > Redo 
To execute: 

Undo:  Edit Menu > Undo;  Windows Toolbar  ;  Ctrl + Z 

Redo:  Edit Menu > Redo;  Windows Toolbar  ;  Ctrl + Y 
Use this command to reverse the last editing action. Lyric keeps track of previous editing steps, so that Undo 
can be used repeatedly to reverse recent actions. 

 If Undo is unavailable on the Edit menu, the last action cannot be reversed.  

 After one or more Undo operation(s), you may select Redo repeatedly to redo your editing steps. 

Please note that the number of preserved edits is limited by available memory. This memory is automatically 
allocated so that the maximum number of edits are preserved. 

Undo/Redo Lists 
The lists of the most recent undone and redone edits can be viewed by accessing View Menu > Undo List 
and View Menu > Redo List respectively.  Additionally, a range of edits can be undone from these lists.  The 
Undo and Redo Lists show a chronological list of Canvas editing steps, arranged from earliest to most 
recent. 

Undo List 
To view the Undo List, select the Undo List item from the View menu. If the Undo List item is checked, the 
normal Undo command (Ctrl + Z) also displays the Undo List: 

 

Undo List 
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 To undo the most recent edit, scroll to the bottom of the list, and then select the last step and click the 
Undo To button.  Lyric cannot undo a single step in the middle of the Undo List, however you may 
undo a range of edits. 

 To undo a range of edits, select the step you wish to undo, and then click the Undo To button.  The 
selected edit, and all subsequent edits, are undone. 

Redo List 
Undone edits appear on the Redo List, which is also available from the View menu.  

 To redo the most recent undone edit, select the first item on the Redo List, and then click the Redo 
To button.  

 To redo a range of undone edits, select the step you to wish to redo, and then click Redo To. The 
selected step, and all more recently undone edits, will be redone. 

Cut, Copy, Paste 

Cut:  Edit Menu > Cut:  Windows Toolbar  ;  Ctrl + X 

Copy:  Edit Menu > Copy:  Windows Toolbar  ;  Ctrl + C 

Paste:    Edit Menu > Paste;  Windows Toolbar  ;  Ctrl + V 
 The Cut command deletes the currently selected object or text and places it on the clipboard. 

 The Copy command copies the currently selected object or text and places it on the clipboard. 

 The Paste command inserts the current contents of the clipboard into the currently active window at 
the cursor location. 

The following figure shows how different types of elements are selected. 

 

Selecting a 3D Character 

 

Selecting a 2D Text Window 
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Selecting 2D Text 

Paste in Place 
Edit Menu > Paste in Place;  Ctrl + I 
Paste in Place pastes previously cut 2D text from one Lyric composition into the same exact position in the 
same or a new composition. 

Delete 

Edit Menu > Delete;  Windows Toolbar ;  Delete Key (for 2D Text only); Ctrl + Delete (Objects) 
The Delete command deletes the currently selected object or text without placing it on the clipboard. 

Select All 
Edit Menu > Select All;  Ctrl + A 

Select All selects all text in the active 2D Text window.  To perform a Select All operation: 
 Select a 2D Text window, and then select Select All from the Edit menu, or press Ctrl + A.  A 

bounding box appears around all of the text in the 2D Text window.  Changes to font attributes, 
justification, etc., are now applied to all of the text in the 2D Text window. 

 

Select All 

To remove the bounding box: 
 Click anywhere outside of the bounding box. 
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View Menu and Toolbars 

The View Menu 
The View menu provides control of the display of the various windows and toolbars that comprise the Lyric 
interface, allowing customization of the workspace. 

 

View Menu 

Displaying Toolbars 
Use the View menu command to display and hide Lyric's various Toolbars, which include buttons for some of 
the most common commands in Lyric, such as File Open.  A check mark appears next to the menu item 
when the Toolbar is displayed.  When the checkmark is not displayed, the toolbar is hidden. 
Note that HTML Tools is not currently supported. 

Moving/Docking/Floating/Hiding a Toolbar 
Toolbars can be easily repositioned by clicking and dragging the toolbar to a new location.  Toolbars can be 
either docked or floating. 

Docked:  The toolbar can be attached horizontally to the top or bottom edge of a window, or vertically to the 
left or right edge of a window. 

Floating:  The toolbar is positioned away from the edges of the window. 

To reposition a toolbar as a docked toolbar: 
 Click a point on the toolbar that is not on an icon, and then drag the toolbar to a new location at the 

edge of the program window (interface). 

 

Repositioning a Toolbar to a Docked Position 
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To reposition a toolbar as a docked toolbar: 
 Click a point on the toolbar that is not on an icon, and then drag the toolbar to a new location away 

from the edge of the program window (interface). 

 

Repositioning a Toolbar to a Floating Position 

 

Floating Toolbars 

A floating toolbar can repositioned by clicking and dragging.  It can also be repositioned as follows: 

1. Left-click on the title bar of the floating toolbar.  From the context menu, select Move. 

 

Toolbar Context Menu 

2. Use the cursor keys to reposition the toolbar, and then press Enter. 

To automatically convert a floating toolbar to a docking toolbar: 
 Double-click on a point on the toolbar that is not an icon.  The toolbar docks to its usual position. 

A floating toolbar can be hidden by right-clicking on a point that is not on an icon, and then selecting Hide.  
The toolbar can be redisplayed by selecting the toolbar name in the View menu, as described above. 

 

Toolbar Context Menu 



Lyric User Guide 

 2-56 

Help Menu - Using Lyric's Online Help System 
Help Menu 

NOTE 
Lyric Help is updated periodically and can easily be downloaded into the Lyric installation 
directory for direct access from Lyric, or to any system for offline access.  Updates to Lyric 
Help and a PDF of the Lyric User Guide are available at 
http://www.chyron.com/support/docs/duet.html. 

Lyric's Online Help system offers comprehensive information on Lyric and Duet operation.  To access Help 
features: 

 Click on the Help menu. 

 

Help Menu 

Help Topics 
Clicking the Help Topics menu item opens the Help interface; by default, the left-most pane of this screen 
displays the Index. 

 

 Lyric Help Window 
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You may also click on the Contents tab for a selection of "Books" containing the same content that is offered 
by the Index, or click on the Search tab and enter a subject name to look for topics containing the information 
about the specific subject. 

 

Lyric Help Table of Contents and Index 

Browse Sequences 
Along the top of the Help window is a Browse Sequence display.  It displays an ordered set of topics that 
take the user through a subject. 

 Click on the topics to open them, and use the arrows to the left and right of the display to navigate 
forward and back through the sequence. 

 A choice of Browse Sequences on selected subjects is available from the dropdown list box to the 
left of the Browse Sequence display. 

 

Help Browse Sequence 

Printing Help Topics 
Print and Print Preview functionalities for printing images of Lyric compositions are not implemented at this 
time.  If, however, the Duet system or PC is connected to a printer, Online Help topics can be printed.  From 
within the Online Help window: 

 Right-click, and then select Print... from the menu, and then proceed as usual from the Print dialog 
box. 
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OR 

 Click on the Print icon in the Online Help toolbar, and then proceed as usual from the Print dialog 
box. 

 

Print Icon in Online Help 

Context-Sensitive Help 

Context-sensitive help, i.e. help that is tailored to a selected function is available by clicking the  icon, and 
then clicking a window, icon, window, etc. on the Lyric interface.  The appropriate help is displayed. 

More Info 
Clicking the More Info menu item opens the screen pictured below. It contains information and links for 
Chyron Sales and Support. 

 

More Info Window 
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About Lyric 
Clicking the About menu item opens the screen pictured below. It contains Version and Build Numbers, as 
well as buttons that give information about any Lyric plug-ins (LEIFlets) that are installed in your system.  It 
also displays the executing directory for Lyric. 

 Press the  button to expand the dialog box for plug-ins information, and in the 

expanded menu, press the button(s) for information on the individual plug-ins, shown at right. 

 

About Lyric 
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Window Menu 

 

Window Menu 

The Cascade and Tile selections (below, left and right respectively) have the same effect as in other 
Windows applications.  

 

You may use the User Profile selection in the Config menu to reset the windows. 

Other selections in the Window menu represent each open window on the interface. You may use these 
selections to change the active window. 
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Tools and Canvas/Scene Graph Context Menu 
Menu Bar > Tools;  Right-Click Empty Area of Canvas;  Right-Click Empty Area of Scene Graph 
The Tools menu and the Canvas/Scene Graph context (right-click) menu access many of Lyric's special 
features.  The menu is shown below with all functions active.  During Duet/Lyric operation, various items are 
active or grayed out depending upon the Duet/offline system, optional hardware installed and current function 
in use.  Additionally, depending on the installed plugins, there may be items at the end of the menu which do 
not appear here. 

NOTE 
For the sake of clarity, Tools/Canvas Context/Scene Graph Context menu functions in the 
manual are referred to as accessible from the Tools menu.  It should be understood that 
in most instances, the same functions are also accessible from the Canvas and Scene 
Graph context menus.  Differences are noted where appropriate. 
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This menu is accessed by selecting Tools from the Lyric menu bar, or by right-clicking on an empty area (not 
on an object or object listing) of the Canvas or the Scene Graph. 

 

Tools and Canvas/Scene Graph Context Menus 

The following list provides a brief description of each of the items on this menu. 
 3D Object:  3D Object places a 3D object on the Canvas.  3D objects are covered in depth in the 

chapter on 3D Characters and Objects. 

 Background:  Background adds a background to the entire Canvas, a 2D Text Window or a 2D 
Text Template.  Backgrounds are covered in depth in the chapter on Color, Transparency, 
Background, Lighting and Texture. 
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 Flipbook;  A Lyric Flipbook animation is a series of targa (*.tga), *.tif or *.bmp files, preloaded into 
memory and played out in sequence, much like the old-time paper flipbooks.  In a Flipbook 
animation, each bitmap image appears for 1 frame of video.  Flipbook animations can be created on 
the Duet platform, or on off-line PCs, typically using third-party animation applications such as 
SoftImage or 3D Studio.  Flipbook animations can also be created within Lyric itself.  Flipbooks are 
covered in depth in the chapter on 2D Objects. 

 Movie - Duet LE/LEX/PCI/PCI+:  An *.avi or *.mov object can be imported into the Lyric composition.  
The Movie object can be repositioned, scaled and rotated as part of a Lyric animation. 

 Graphic:  Graphic places a 2D object on the Canvas.  3D characters are covered in depth in the 
chapter on 3D Characters and Objects. 

 Squeezeback Object (Duet SD Only):  Squeezeback (Duet SD only) enables the creation of 
regions in a Lyric composition that can be displayed up to full-screen, with no loss of video quality.  
Squeezeback effects are created on the optional Squeezeback Board.  Because Squeezeback 
effects are processed on its own board, manipulation of Squeezeback video has fewer effects on the 
behavior of other elements in a Lyric composition than similar Video Region effects created on the 
Duet's VGEs.  Squeezeback Object and Video Region are covered in depth in the chapter on Video 
Region and Squeezeback Object - Duet SD. 

 Video Region (Duet SD Only):  Video Regions are areas of the Canvas that display video from 
external sources or the Duet Internal Clip Player.  Video Regions may be incorporated into Lyric 
compositions and animated or manipulated like any other object on the Canvas.  Video Regions 
may be scaled with or without locked aspect ratio, but the video playing back may not be cropped.  
Apparent size may also be altered by increasing distance from the Camera along the Z-axis.  Video 
Region is covered in depth in the chapter on Video Region and Squeezeback Object - Duet SD. 

 Clock:  Clock places a Clock on the Canvas.  The Clock, composed of 2D text, can be displayed in 
a TrueType® or RGB Fonts, in a variety of hour-minute-second formats.  Clocks are covered in depth 
in the chapter on Clocks and Timers. 

 Crawl:  Crawl opens a specialized 2D Text Window in which one or more rows of text can be set to 
travel horizontally across the screen.  Crawl setup is covered in the chapter on 2D Text Animation. 

 Font Editor:  RGB Fonts, which are fonts composed from bitmap images, as opposed to standard 
font characters, can be created using the Custom Font Editor.  RGB Fonts are useful for quickly 
typing frequently-used graphics such as sports team logos.  Typing graphics is considerably faster 
than importing them. 

The Custom Font Editor can also import and export iNFiNiT! fonts for use in Lyric or imported 
iNFiNiT! messages.  iNFiNiT! fonts and message operations are covered in depth in Browser:  
iNFiNiT! Font Assets, Import from iNFiNiT!, Export to iNFiNiT!, Custom Font Editor and FTP - 
Transferring Files to/from an iNFiNiT! System. 

 Roll:  Roll opens a specialized 2D Text Window in which one or more rows of text can be set to 
travel vertically over the screen.  Roll setup is covered in the chapter on 2D Text Animation. 

 Spell Check (F7):  Lyric provides a Spell Check feature, which examines all 2D text on the Canvas, 
including text in 2D Text, Roll, Crawl and Type On Windows and in 2D Text Templates, and 
compares them to words in a standard dictionary, as well as those in a User Dictionary.  The User 
Dictionary, as well as other spelling parameters, can be set in Spelling Preferences.  Spell Check 
is covered in the chapter on 2D Text and the chapter on Preferences. 

 Spline Window (Type-on-a-Curve):  Lyric's Spline Window tool enables 2D text to be mapped and 
animated to a curved baseline.  Double-byte characters from languages such as Korean, Chinese 
and Japanese are supported.  Spline Window setup is covered in depth in the chapter on 2D Text 
Animation. 

 Text Window:  Text Window places a new 2D Text Window on the Canvas.  2D Text and 2D Text 
Windows are covered in depth in the chapter on 2D Text. 
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 Template:  The Template function creates a template which enables update of text contained within 
it.  When the Template function is executed, the following occurs: 

o If the cursor is in a 2D Text Window, a 2D Text Template is placed at the cursor position. 
o If 2D text is highlighted, a Template is created which encloses the highlighted text. 
o If the cursor is outside of a 2D Text Window, a 3D Character Template is created. 

Note that 2D objects automatically have templates applied.  Refer to the section on Updating Lyric 
Messages and to the sections on 2D Text Templates, 2D Object Templates and 3D Character 
Templates for additional information. 

 Template Update (Alt +T):  Template Update enables the text in 2D Text Templates and 3D 
Character Templates to be updated with new text.    Refer to the section on Updating Lyric 
Messages and to the sections on 2D Text Templates and 3D Character Templates for additional 
information.  

 Timer:  Timer places a Timer on the Canvas.  The Timer, composed of 2D text, can be displayed in 
a TrueType® or RGB Fonts, in a variety of hour-minute-second formats.  The Timer can count either 
up or down.  Clocks are covered in depth in the chapter on Clocks and Timers.  

 Type On (Slow Reveal):  Type On opens a specialized 2D Text Window in which one or more rows 
of text can be set appear on screen one character at a time, simulating typing.  Characters can also 
be set to appear randomly.  Type On setup is covered in the chapter on 2D Text Animation. 

 Group/Ungroup:  When multiple objects are selected, they may be grouped, so that changes to 
attributes simultaneously affect all member objects of the group.  Group is covered in depth in the 
chapter on Getting Started:  Navigating and Entering Information in Lyric. 

 Reverse Animation:  Reverse Animation reverses the direction of the animation currently on the 
Canvas, causing the animation to run in reverse.  Reverse Animation is covered in depth in the 
chapter on Animation. 

 Clip Control Panel (Duet SD/LE/LEX/PCI/PCI+):  The Clip Control Panel provides the ability to 
play back video and/or audio clips either independently or as part of a Lyric animation.  Lyric Clip 
(*.ccf) files are created which mark In and Out points of the clip.  Clip files can be created from 
sources such as a  VTR or DDR (Digital Disk Recorder), Chyron Aprisa DDR, Duet’s Internal Clip 
Player or Audio files processed through integrated audio hardware in Duet.  Lyric does not perform 
actual edits on the recorded content of the source material.  The Clip File contains the In and Out 
point information that defines the duration of the clip.  In order to play back the video/audio, the 
original material and the playback device must be available.  Clips functionality is not available to 
Duet HD systems.  The Clip Control Panel is covered in depth in the chapter on the Internal Clip 
Player. 

 Mask Scene (Duet SD Only):  Mask Scene provides the ability to animate "cut-out" objects inside an 
arbitrarily shaped window.  The Mask created by the "cut-outs" can reveal background, video input or 
other Lyric images.  Mask Scene is covered in depth in the chapter on the Masks. 

 Multi FX (Duet SD Only):  Lyric's Multi FX capability allows Duet SD's frame buffers to perform 
transitions between Lyric messages using Advanced Image Effects.  Multi FX include Curtain, 
Explosion, Focus, Leaf, Matrix, PageRoll, PageTurn, Ripple, Slide, Venetian, Zoom and Wipe.  
For optimal Multi FX execution, the Duet SD should be equipped with at least two VGEs and a Video 
Mixer.  Multi FX are covered in depth in the chapter on Transition Effects. 

 Playlist:  The Playlist feature allows multiple Lyric messages to be compiled into an automated list 
and played out sequentially using preset transition effects.  For example, this feature might be used to 
automatically play a dissolving sequence of graphics displaying sports statistics of players or teams.  
Playlists are covered in depth in the chapter on Playout to Output. 

 Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only):  The PCI-Squeezeback board adds cutting-
edge animated video effect creation capability to the Duet LE/LEX/PCI/PCI+ system. The Lyric 
interface provides a set of easy-to-use setup controls for the PCI-Squeezeback board.  The PCI-
Squeezeback board features four independent video layers, two of which can be resized and 
positioned in real time to create dynamic effects such as compression of a full-screen video image to 
allow for display of additional graphics in the lower third.  Note that the PCI Squeezeback Board for 
Duet LE/LEX/PCI/PCI+ is a completely different piece of hardware from Duet SD's Squeezeback 
Board.  The Squeezeback Panel and the PCI-Squeezeback board are covered in depth in the 
chapter on Video Squeezeback - Duet LE/LEX/PCI/PCI+. 
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 Video Capture:  Lyric's optional Video Capture tool allows the Duet to capture a frame of video, 
display it as a background on the Duet output and save it to a graphics file in one of the supported 
graphics formats (e.g. TIFF, TGA, BMP, JPG, etc.).  The hardware and procedures are different 
depending on whether the system is a Duet SD, Duet HD or Duet LE/LEX/PCI/PCI+.  Video Capture 
is covered in depth in the chapter on Video Capture. 

 CMix:  CMix is a 1RU-rack mount device providing two output channels, each displaying an 
independent mix of up to 4 video/key input layers over an optional Program video input layer, which 
mix to one video/key output.  CMix is connected to a host machine via the Universal Serial Bus 
(USB).  Originally designed for use with  Duet LE/LEX/PCI/PCI+, CMix can also be used to expand 
the mixing capabilities of Duet SD systems, or with conventional PCs equipped with broadcast-quality 
video sources for use as a standalone router/switcher.  The system contains two independent sets of 
mixing logic controlling two video/key outputs.  The mixers share the same inputs, but the inputs can 
be assigned to different layers in each mixer.  CMix is covered in the chapter on Video Mixing. 

 Video Mixer (Duet SD/HD Only):  The optional internal mixer board allows precise routing and 
layering of video to output.  The boards and setup procedures are different for the Video Mixer - Duet 
SD and the Video Mixer - Duet HD.  Video Mixer is covered in depth in the chapter on Video Mixing. 

 Set Message Properties:  Refer to Internal Properties at the end of this section. 

 Set Message Preload Time (Duet LEX/PCI+ Only):  The Duet LEX/PCI+ automatically calculates a 
preload for Streaming Animations.  If, however, the animation does not execute properly because of 
a short preload, a higher preload value can be stored with the specific message.  The advantage of 
customizing a Message Preload Value is that if a message requires a longer preload, the larger 
required system resources will be dedicated only for playout of the individual message, and would not 
be tied up when other functions are performed.  Set Message Preload Time is covered in depth in 
the chapter on Duet Tools:  Streaming Animation - Duet LEX/PCI+ Only. 

 Insert TV Object:  Insert TV Object inserts a TV Object, which is a place-holder that designates the 
location of a “squeezed-back” (not to be confused with Lyric/Duet Squeezeback operations) TV 
picture in an interactive television composition, when activated on the viewer’s set-top box.  Lyric for 
iTV composition requires a special license and this tool may be unavailable in your version of the 
software.  Insert TV Object is covered in depth in the chapter on iTV. 

 Harvester Lite:  The Harvester Lite plugin enables a Lyric 2D Text Template to be linked to a text 
field at a remote URL for dynamic update via the Internet.  Harvester Lite is covered in depth in the 
chapter on Plugins. 

 Harvester Properties:  Update parameters for Harvester Lite are set via Harvester Properties.  
Note that this item does not appear in the Tools menu, but does appear in the Canvas, Scene 
Graph and 2D Text/Template context menus.  Harvester Lite is covered in depth in the chapter on 
Plugins. 

 Paint, BizGraph, Harvester Pro and Quarterback:  These are a few examples of a variety of optional 
plugins available for use with Lyric.  If these plugins are not installed on the system, the 
corresponding items do not appear on the Tools menu.  Liberty Twister, a paint plugin, is a product of 
Video Design Software. Please access Liberty Twister online Help for operational information or visit 
the Video Design Software web site at http://www.videodesignsoftware.com.  BizGraph, an animated 
graph display plugin; Harvester Pro, a data harvesting plugin; and Quarterback an enhanced directory 
access plugin, are from Patrick Graphics Systems.  Please access the plugin's online Help for 
operational information or contact PGS at inforequest@patrickgraphicssystems.com. Web Site:  
http://www.patrickgraphicssystems.com. 

 Internal Properties:  Properties of an object or a message can be tailored to a specific composition 
or playback situation.  The Internal Properties accessed from this menu are applied to the current 
message.  They include Legacy Mask, Preview Frame, Rendering Mode, Use Group Priority and 
onRead Macro.  Note that Internal Properties does not appear on the Tools menu. 
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Chyron Tools 
View Menu > Toolbars > Chyron Tools 

The Chyron toolbar accesses Lyric-specific functions, such as Text Window, Roll, Crawl, Type On/Slow 
Reveal, Clock, Timer, Type On A Curve, Import 3D Object, Import Graphic, Background, Template 
Field, Group/Ungroup, Erase, Set Default Background Color, Turn On/Off Text Window Frames, Show 
Basic Windows and Use Mask.  A number of these tools are also available from the Tools Menu. 

 

Chyron Tools 

Erase 
The Erase function erases a variety of objects from the current Canvas.  Text, elements from the scene or 
frame buffers can be erased.  2D Text Template backgrounds, however, cannot be erased using this tool.  
Refer to the sections on 2D Text Templates and Background for information on erasing a Template 
Background.  To perform an erase: 

1. Click  on the Chyron Toolbar.  The Erase dialog box is displayed: 

 

Erase Dialog Box 

2. Only the 2D Text or the Scene area is active at any one time, depending on which radio button is 
selected.  Set Erase parameters as described below. 

Item Description 

This Window When multiple 2D Text Windows are open, the active 2D Text 
Window is the only one erased. 

All Windows  Applies the Erase operation to all 2D Text windows (includes Roll, 
Crawl and Type On). 

2D Text 

 

May be left unchecked to leave 2D text intact in the selected 
window(s) during other erase operations. 

2D Text 
Background 

May be left unchecked to leave 2D Text Window(s) Background 
intact. 
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Item Description 

Scene Selects the entire composition, as opposed to individual 2D Text 
Windows. 

Objects Objects in a scene include 2D Text Windows (both the windows 
themselves and their contents), imported bitmaps, 3D characters 
and 3D objects, etc. 

Persistent  

Timers 

If Persistent Timers are specified for erasure, they will be cleared 
from the Canvas, regardless of the Make Persistent setting in the 
Properties > Clock/Timer tab.  

Background This Erase Background option affects the Canvas, as opposed to 
a single window.   An Erase of this type does not erase 2D Text 
Window Backgrounds, only the Background of the Canvas.  
Note that this type of Erase operation cannot be undone!  Even if 

Undo is available after a Scene Background erase 
operation, the available Undo(s) are applicable to other steps in 
the composition, but not to the Background erase. 

Frame Buffers Erases the contents of all Duet frame buffers.  This operation does 
affect the signal going to the Program and Preview outputs, so 
use with caution. 

3. After selecting the item(s) to be erased, click OK to execute the Erase, or Cancel to cancel the Erase 
operation. 

Set Default Background Color 
When creating a Lyric composition that does not contain a colored background as set using the Background 
tool, it may be advantageous at times to view the composition on a gray, instead of a black Default 
Background (e.g. when working with Mask Objects).  The color of the Default Background has no bearing 
on Duet output. 

To toggle the Default Background between black and gray: 

 Click the  button. 

Turn On/Off Text Window Frames 
Toggling (clicking) the Turn On/Off Text Window Frames icon turns on/of the display of all 2D Text Window 
and 2D Text Template frame on the Canvas, facilitating preview of the composition.  Note that this function is 
also available from the 2D Frames On/Off item in a 2D Text Window context menu. 

    

Turn On/Off Text Window Frames Icons 

Refer to the indicated sections for information on the following Chyron Tools: 

 2D Text for information on 2D Text Window, Roll, Crawl, Type On/Slow Reveal, and Type on a 
Curve (Spline Window). 

 Clocks and Timers for information on Clocks and Timers. 

 Tools Menu for information on Import 3D Object, Import Graphic, Background and 
Group/Ungroup. 

 Templates for information on Template Field. 

 Preferences, in the section on Windows, for information on Show Basic Windows. 

 Masks for information on Use Mask. 
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Properties 
View Menu > Properties 

Properties define the attributes of various functions and objects used in Lyric. 

Attributes are the individual components describing how an object appears, such as its X,Y, Z Position, 
Rotation, Scale (size), Font and Edge Style, Transparency, Color, etc.   Each object type (3D Objects, 
Camera, 2D Text, etc.) has its own set of applicable attributes.  For example, an Intensity attribute is 
meaningful for a Light Source, but meaningless for a 3D Object. 

Properties are set in the Properties Window, which is usually automatically displayed when Lyric is opened.  
If the Properties Window is not visible: 

 From the View menu, select Properties.  The Properties Window should appear. 

 

Properties Window 

The Properties Window first displays the Font tab.  To select a tab, use one of the following methods: 

 If necessary, click the  controls to scroll among the tabs to access those that are not visible.  
Click the desired tab. 

 Right-click in the Properties Window, but not in a data entry field, and then select the desired 
Property from the context menu. 
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The expanded figure below shows the Properties that can be accessed. 

 

Properties Tabs 

The Properties window provides access to the following selections: 

Property Description 

Font  Sets Font Face, Font Size, Font Style, 2D/3D Mode, Aspect 
Ratio, Kerning, Space Width, Leading, Shear, Rotation and 
Filters for characters used in 2D text composition. 

Sets Font Face and Font Style for characters used in 3D text 
composition. 

Also includes ability to launch TrueType® Font Preview. 

Font Face and Font Style can also be set using Font Tools. 

Refer to Creating and Using Fonts in Lyric for additional 
information. 

2D Font FX  Sets effects for 2D characters, including Edge Type, Edge Size, 
Face/Edge Color, Transparency, and Softness.  Multiple Edge 
styles may also be set. 

Refer to Creating and Using Fonts in Lyric for additional 
information. 

3D Font FX  Sets/changes 3D font effects, including Character Depth, Bevel 
Depth, Bevel Mode, Bevel Type and Smoothness. 

Refer to Creating and Using Fonts in Lyric for additional 
information. 

XYZ  Sets/changes Position, Rotation, Scale and Center of Rotation 
of the selected characters/objects in the X, Y, and Z planes. 

Refer to the chapter on Position, Rotation, Scale and 
Orientation for further information. 

Lighting  Sets/changes characteristics of the light sources that affect 3D 
elements.  Parameters include color and intensity for global 
lighting, and position, color and Intensity up to six individual light 
sources. 

Refer to the chapter on Color, Transparency, Background, 
Lighting and Texture for further information. 

Surface Sets/changes Surface parameters for the selected Object(s). 
These parameters describe how colors and/or bitmap textures are 
applied to 3D objects. 

Refer to the chapter on Color, Transparency, Background, 
Lighting and Texture for further information. 
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Property Description 

Camera  Sets/changes Camera perspective and zoom. These factors 
determine how 2D and 3D object(s) appears within the Canvas 
frame. 

Refer to the chapter on Position, Rotation, Scale and 
Orientation for further information. 

Loops/Pauses  Controls start/end points (and number of loop iterations) for 
animation displays. 

Refer to the chapter on Animation for further information. 

Animation  Adjusts playback speed for Rolls, Crawls and other animations. 
When multiple objects are animated on the Canvas, this window 
offers control over each object’s duration in the overall scene. 

Refer to the chapter on Animation for further information. 

Clocks/Timers  Opens Clock or Timer windows on the Canvas. Clicking the Clock 
or Timer buttons on the Chyron Toolbar simultaneously selects the 
Clock/Timer Properties tab and opens the appropriate type of 
window on the Canvas. 

Refer to the chapter on Clocks and Timers for further information. 
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Recording/Reading Lyric Messages 
Lyric messages, which can be static or animated compositions, or just specific groups of settings, can be 
recorded and read (recalled) at a later time.  These operations can be performed using File Menu > Save, 
File Menu > Save As and File Menu > Open.  Lyric, however, provides an easy shortcut that makes it simple 
to record a series of messages, and to read them quickly for on-air use.  Lyric Messages can also be read to 
the Canvas from the Browser and automatically recorded to a file when saved to a Browser database.  
Refer to Browser:  Message Asset Operations for additional information. 

About the Address Keypad 
The Record and Read functions, as well as Read Next and Read Previous, are performed in a similar 
manner: 

1. Using the Address Keypad (also known as the numeric keypad) located to the right of the 
alphanumeric keypad on a Duet or PC keyboard, enter the Message ID of the message file.  The 
Message ID can be up to eight digits long, and it is not necessary to enter leading zeroes.  The 
Address Keypad for a Duet keyboard is shown in the following figure.  Message ID entry works the 
same way on a numeric keypad on a PC keyboard. 

 

Duet Numeric Keypad 

2. Press the key that performs the desired operation, i.e. Read, Read Next, etc.  Note that the Record 
button is not part of the Address Keypad.  Lyric provides PC keyboard equivalents for these 
operations, as detailed in later in this section. 

When using the Address Keypad to enter a Message ID for a Read or Record operation, the Lyric message 
is saved to or recalled (read) from the Default Message Directory as set in Config Menu > Preferences > 
Default Paths.  This eliminates the need to enter a directory path each time a Read or Record operation is 
performed.  Refer to the section on Preferences:  Default Paths for additional information. 
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Record and Read Operations 
The following table outlines the various message operations.  Both Duet and PC keyboard key combinations 
are provided.  Remember that the + symbol does not specify a keystroke, but instead indicates that the 
preceding key must be held while the next key is pressed. 

 Regarding the Duet Keyboard:  All Message ID numbers must be entered using the Address 
Keypad, not the alphanumeric keys.  In addition, Num Lock must be On in order for the operations 
to work. 

 Regarding the PC Keyboard:  All Message ID numbers and other keystrokes (including Enter), 
except for Ctrl and Alt, must be entered using the Address Keypad, not the alphanumeric keys.  In 
addition, Num Lock must be On in order for the operations to work. 

Duet 
Keyboard 

PC 
Keyboard 

Description 

Clear Del Resets the Message Number to 0. 

Record Minus 
key (-) on 
the 
numeric 
keypad 

Saves (records) the current Lyric composition at the 
Message ID shown in the Message Number display.  
Along with the message, Lyric saves the active 
window (and cursor position, if appropriate), so that 
these attributes are preserved when the message is 
read. 

After the message is recorded, the Message Number 
display increments up by 1. 

Alt + 
Record 

Alt + 
Minus 
key (-) on 
the 
numeric 
keypad 

Saves the current Lyric composition to the same 
Message ID from where it was read, without 
prompting for an overwrite confirmation.  After the 
message is recorded, the Message Number display 
does not increment. 

If the message was not originally read from an 
existing message, then the composition is saved at 
the current Message ID.  If a message with that 
Message ID already exists, then the overwrite prompt 
is displayed. 

If the file does not have a Message Number, but 
instead has a name, then Alt + Record records to the 
same name. 

Ctrl + 
Record 

Ctrl + 
Minus 
key (-) on 
the 
numeric 
keypad 

Opens the Record Only: dialog box, which allows 
selective recording of specific sets of attributes, such 
as Clocks/Timers, Clips, Macros, etc.  Selective 
recording is covered later in this section. 
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Duet 
Keyboard 

PC 
Keyboard 

Description 

Ctrl + Alt 
+ Record 

Ctrl + Alt 
+ Minus 
key (-) on 
the 
numeric 
keypad 

Selectively records (Record Only) to the same 
Message ID from where it was read or previously 
recorded, without prompting for an overwrite 
confirmation.  After the message is recorded, the 
Message Number display does not increment. 

If the message was not originally read from an 
existing message, then the composition is saved at 
the current Message ID.  If a message with that 
Message ID already exists, then the overwrite prompt 
is displayed. 

Read Enter Reads the Lyric Message at the currently displayed 
Message Number. 

Read 
Next 

Ctrl + 
Enter 

Read Next recalls a sequence of messages with 
ascending Message Numbers, allowing the operator 
to prebuild and instantly display messages. 

Executing Read Next reads the message saved at the 
currently displayed Message Number, and then 
builds it without displaying it. 

The next time Read Next is executed, the prebuilt 
message is displayed on the Duet output, while 
simultaneously reading and prebuilding the message 
saved at the next highest assigned ID number. 

Read Next status is maintained per frame buffer.  For 
example, if a Read Next sequence is taking place in 
Frame Buffer 1, then changing to a different frame 
buffer does not move the Read Next sequence to the 
newly active buffer.  When Frame Buffer 1 is 
reactivated, the Read Next sequence can be 
continued from where it left off.  

Read Next can be especially useful for displaying 
pages of credits, day-by-day weather forecasts, sports 
scores, etc. 

Read 
Previous 

Alt + 
Enter 

Operates similarly to Read Next, but the Message 
Number decrements instead of incrementing.  There 
is one exception:  Reading a Message Effects .lyr 
message created on the Duet LE/LEX/PCI/PCI+ 
always causes the Message Number to increment, 
regardless of how the message was read (Read, 
Read Next or Read Previous).  
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The following should be noted regarding Read Next and Read Previous operations: 
 The search range for the next or previous message searched is determined by the Read Next Range 

setting in the Config > Preferences > CG tab.  The default value is 10.  This specifies that Lyric 
checks through the next 10 or previous 10 Message IDs for a valid message before displaying the 
prompt Message Not Found. 

 Read Next/Previous works properly only when the button is active.  The message display is 
not sent to the Duet output, but is previewed on the VGA.  When Read Next/Previous is executed 
again, the message is sent to output, and the following/previous message is loaded and can be 
viewed on the VGA monitor.  This also allows modification of the composition in the Read 
Next/Previous buffer before being sent to output. 

 The message recalled by a Read Next or Read Previous operation can be sent to output as soon as 
it appears on the system's VGA monitor. 

 Animations are automatically loaded during a Read Next/Previous operation, so that when Read 
Next/Previous is executed for output to air, the loaded animation executes immediately.  When the 
animation is finished, the next message is read. 

Selective Recording 
Record to Currently Displayed Message Number:  Ctrl + Record (Duet keyboard);  Ctrl + numeric 
keypad Minus (-) key (PC keyboard) 
Record to Message Number of Loaded Message (Overwrite):  Ctrl + Alt + Record (Duet keyboard); 
Ctrl + Alt + numeric keypad Minus (-) key (PC keyboard) 
Overview 
When a Lyric composition is saved, text, graphics, animation information, Template information, 
Backgrounds and much more are saved to the Lyric message.  It is also possible, however, to save specific 
elements from the Lyric composition, so that they can be easily read into other Lyric compositions. 

In some instances it is possible to do this from the individual tool's interface (e.g. Clip Control Panel or the 
Multi FX Control dialog box), which involves opening a Save or Save As dialog box and entering a File 
Name.  An alternative, quicker method is to record the file from the Record Only: dialog box.  Messages 
recorded in this manner are saved to the currently displayed Message Number in one of the Default 
Directories.  Refer to Preferences - Default Paths for information on Default Directories.  To open the 
Record Only: dialog box: 

 If recording to the currently displayed Message Number, then press Ctrl + Record on a Duet 
system, or Ctrl + the numeric keypad Minus sign (-) on a PC. 

 If recording to the currently loaded Message Number (i.e., to perform an overwrite), then press Ctrl + 
Alt + Record on a Duet system, or Ctrl + Alt + the numeric keypad Minus sign (-) on a PC. 
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The Record Only: dialog box is displayed.  The Title Bar displays the Message ID Number to which the 
message is to be recorded. 

 

Record Only Dialog Box 
The selective record procedure can be executed quickly using Hotkey combinations. 

1. Press Ctrl + Record (Duet keyboard) or Ctrl + Minus key on the numeric keypad (PC) to record to 
the currently displayed Message Number, or press Ctrl + Alt Record (Duet keyboard) or Ctrl + Alt + 
Minus key on the numeric keypad (PC) to record to the currently loaded Message Number 
(overwrite).  Release the keys. 

2. Press the key indicated for the file type.  It is indicated by an underline in the Record Only: dialog 
box. 

3. Press Enter.  The file is recorded. 

For example, using a Duet keyboard: 
 To quickly record a Clip file to the current Message Number, press Ctrl + Record C Enter.  Hotkey 

combinations are specified for each file type below. 
 To quickly overwrite the currently loaded message and record a Clip file to the same Message 

Number, press Ctrl + Alt + Record C Enter. 

For example, using a PC keyboard: 
 To quickly record a Clip file to the current Message Number, press Ctrl + Minus key on the 

numeric keypad C Enter.  Hotkey combinations are specified for each file type below. 
 To quickly overwrite the currently loaded message and record a Clip file to the same Message 

Number, press Ctrl + Alt +Minus key on the numeric keypad C Enter. 

Hotkey combinations are specified for each of the following file types where appropriate.  For sake of clarity, 
only the Duet keyboard versions that record to the currently displayed Message Number are specified.  The 
Ctrl + Alt + Record combination can be substituted for any of the Ctrl + Record operations, and the Minus 
key on the numeric keypad can be used to substitute for the Record key when using a PC keyboard.   

Additionally: 
 If the file has a Message Number, but was not read from the Default Message Directory, Ctrl + Alt 

+ Record records to the Message Number in the directory from which it was read. 
 If the file does not have a Message Number, but instead has a name, Alt + Record records to the 

same name in the directory from which it was read. 
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Text 
The first three Text items record a specific element of a single, active 2D Text Window (includes 2D Roll, 2D 
Crawl and 2D Type On Windows) to what is known as a  as a Pop-On message.  Once recorded, the 
element can be recalled into a different 2D Text Window for easy update.  All Text types are recorded as in 
the *.lyr format.  The default setting is All Text. 

 All Text (Hotkey:  Ctrl + Record T Enter):  Records all text in selected 2D Text Window.  Empty 
lines on a Pop-On message are ignored.  For example, if a three-line Pop-On is recorded, and the 
middle line is empty, the Pop-On is read back as a two-line Pop-On, and replaces (or adds) two 
consecutive rows of text. 

 Cursor to End (Hotkey:  Ctrl + Record E Enter):  Records all text from the beginning of the row on 
which the cursor is positioned, to the end of the text in the window.  As described above, empty lines 
on a Pop-On message are ignored. 

 Current Row (Hotkey:  Ctrl + Record R Enter):  Records only the text on the current row. 

Recording All Text, Cursor to End or Current Row Messages from the Record Only: dialog box saves the 
file to the Default Message Directory.  Refer to Pop-On Messages for details on recording and using these 
types of messages. 

The following Text item appears similar in function to a Pop-On Message record, but is actually a duplication 
of the Intelligent Interface "W" command (Create Data Message), which can replace both text and 
graphics. 

 Template Data Message (Hotkey:  Ctrl + Record D Enter):  Records a Template Data Message 
based on the currently displayed Template Description Message.  Text entered in a 2D Text 
Template(s), and a graphic(s) that is dragged-and-dropped from the Browser to an existing 2D 
Object Template on the Canvas can replace the existing text and graphic(s), respectively. 
Note that the graphic used to replace the graphic in the Template Description Message must be 
dragged-and-dropped from the Lyric Browser, and not imported from the Import Graphic tool on the 
Chyron Toolbar or from Tools Menu > Graphic.  Additionally, the 2D Object Template (i.e., the 
graphic) that is to be replaced in the Template Description Message must be enabled for II Update. 

Recording a Template Data Message from the Record Only: dialog box saves the file to the Default 
Message Directory. 

Refer to About Template Description and Template Data Messages for in-depth coverage of Template 
Data Messages and Template Description Messages, and 2D Object Templates for information on 2D 
Object Templates.  Refer also to Intelligent Interface W Command - Create Data Message and Graphic 
Update for details on creating a Template Description Message via Intelligent Interface. 

Plugin 
A Plugin selection records plugin-specific files. 

 If the plugin is active, and selective recording is enabled in the plugin application, the name of the 
plugin appears in the Plugin list, and is available for selection. 

 If the plugin is active, and selective recording is not enabled in the plugin application, the name of the 
plugin appears in the Plugin list, but is not available for selection. 

Refer to plugin documentation for details. 

Timeline 
A Timeline selection records Keyframe information as follows: 

 Scene (.efx) (Hotkey:  Ctrl + Record S Enter):  Selecting Scene records the Keyframe information 
for all objects on the Canvas in the .efx format to the Default Effects Directory, where it becomes 
available for use by the Read Effects tool.  The file format is the same as that recorded from File > 
Save As, where Lyric Effect (*.efx) is selected as the file format.  Refer to Read Effects - Duet 
SD/HD or Read Effects - Duet LE/LEX/PCI/PCI+ for additional information. 

 Object (.kyf) (Hotkey:  Ctrl + Record O Enter):  Selecting Object records all of the Keyframe 
information for a selected object on the Canvas in the .kyf format to the Default Effects Directory.    
The file format is the same as that recorded from Right-Click Object Timeline > Save Keyframe 
File.  Refer to Animation:  Timelines and Read Effects - Duet SD/HD or Read Effects - Duet 
LE/LEX/PCI/PCI+ for additional information. 
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Panel 
A Panel selection records tool-specific files as follows. 

 Clip (Hotkey:  Ctrl + Record C Enter):  Selecting Clip records only Clip information in the .ccf 
format to the Default Clip File Directory.  The file format is the same as that recorded from Clip 
Control Panel > Save.  Refer to Tools Menu:  Clip Control Panel for additional information. 

 Clocks/Timers (Hotkey:  Ctrl + Record K Enter):  Selecting Clocks/Timers records only Clock and 
Timer information in the .lyr format to the Default Message Directory.  All Clocks and Timers in the 
composition are recorded.  The file format is the same as that recorded from Properties > 
Clocks/Timers > Save.  Refer to Properties:  Clocks/Timers for additional information. 

 Macros (Hotkey:  Ctrl + Record M Enter):  Selecting Macros records only Macro information in the 
.lyr format to the Default Message Directory.  The file format is the same as that recorded from 
Macros >  > Save, when the Macro is saved in the .lyr format.  Refer to Macros for additional 
information. 

 Multi FX (Duet SD Only) (Hotkey:  Ctrl + Record F Enter):  Selecting Multi FX records only Multi 
FX information in the .lyr format to the Default Message Directory.  The file format is the same as 
that recorded from Tools Menu > Multi FX > Save.  Refer to Tools Menu:  Multi FX for additional 
information. 

 Playlist (Hotkey:  Ctrl + Record P Enter):  Selecting Playlist records only the Playlist information in 
the .ply format to the Default Playlist Directory.  The file format is the same as that recorded from 
File Menu > Save As, where Playlist Files (*.ply) is selected as the file format.  Refer to Tools 
Menu:  Playlist for additional information. 

 Squeezeback (Duet SD Only) (Hotkey:  Ctrl + Record Q Enter):  Not implemented at this time. 

 Video Mixer (Duet SD Only) (Hotkey:  Ctrl + Record X Enter):  Selecting Video Mixer records only 
Video Mixer information in the .lyr format to the Default Message Directory.  The file format is the 
same as that recorded from Tools Menu > Video Mixer > Save.  Refer to Tools Menu:  Video 
Mixer for additional information. 

Message, with Options 
Preview Frame:  Many Lyric animations begin or end with a blank frame, and therefore, producing a blank 
screen when read to the Canvas, as well as creating a blank thumbnail when saved to the Browser.  To 
make it easier to quickly determine the nature of an animation, a Preview Frame can be set. 

In order to display the Preview Frame when a message is read to the Canvas, Show Preview Frame must 
be selected (checked) in the Animation Settings Preferences, accessed from Config Menu > Preferences 
> Animation Settings.  Once the Preview Frame is displayed, the message should be saved to or updated 
in the Browser to display the Preview Frame as the thumbnail. 

 End Frame:  The last frame of the animation is displayed as the Browser thumbnail. 

 Specific Frame:  The frame set in the Frame Counter is displayed as the Browser thumbnail. 

Note that this operation is not the same as running an animation, stopping it at some point, and then saving it 
to the Browser database.  This creates a thumbnail at the point that the animation was stopped, but does not 
set a Preview Frame in the message itself. 

The Preview Frame can also be set in the Internal Properties dialog box for the message.  Refer to Internal 
Properties for additional information. 

Embedded Macro 
A macro can be embedded with a Lyric file and automatically executed when the file is read.  It can be saved 
either as a full macro or as a Macro Name only.  In addition, the macro can be edited or created from scratch 
before saving. 

When saving the Macro Name Only, a Macro of the same name must be loaded in the Macros dialog box in 
order for it to execute when the message is read.  To save the Macro Name Only: 

1. Enter a message number, and then press Ctrl + Record (Duet keyboard) or Ctrl + Minus sign (-) on 
the numeric Address Keypad.  The Record Only dialog box is displayed. 

2. In the Embed Macro area, select (check) the Embedded Macro checkbox. 
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3. Enter a name into the Macro Select field drop-down list box (unlabeled), and then select (check) the 
Save Name Only checkbox.  Macro setup is complete. 

 

Record Only Macro Name 

4. Click Record.  The Macro Name is saved with the Lyric message. 

When a message recorded with an embedded Macro, and Save Name Only is selected (checked), the 
Macro executes immediately if a Macro of the same name as the Macro Name saved with the message is 
loaded in the Macros dialog box.  If the Macro is not loaded in the Macros dialog box, the following is 
displayed when the message is read, indicating that the specified Macro is not loaded in the Macros dialog 
box: 

 

Embedded Macro Failed 

To save an embedded macro script: 
1. If entering a macro directly in the Record Only dialog box, skip to Step 2.  Otherwise, load an 

existing macro in the Macros dialog box. 

2. Enter a message number, and then press Ctrl + Record (Duet keyboard) or Ctrl + Minus sign (-) on 
the numeric Address Keypad.  The Record Only dialog box is displayed. 

3. In the Embed Macro area, select (check) the Embedded Macro checkbox. 
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4. Either enter a script directly in the Script window, or select a Macro from the Macro Select drop-
down list box.  The Macro script is displayed in the script window (unlabeled).  Optional:  Edit the 
script.    Macro setup is complete. 

 

Record Only Embedded Macro 

5. Click Record.  The Macro is saved with the Lyric message. 

When a message recorded with an embedded Macro, and Save Name Only is not selected (checked), the 
Macro executes immediately.  Note that because the Macro is embedded, it is not loaded in the Macros 
dialog box.  It can be viewed and edited, however, by pressing Ctrl + Record (Duet keyboard) or Ctrl + 
Minus sign (-) on the numeric Address Keypad to access the Record Only dialog box. 

A Macro Name can also associated with a message from the Internal Properties dialog box.  Refer to 
Internal Properties - onRead Macro for additional details. 

About Other File Saving Methods 
The distinctions between Lyrics various Save methods and resulting file destinations should be clearly 
understood.  In all cases, messages are saved to destination folders on a local/remote drive or removable 
media.  The Browser stores only the reference, or "bookmark" that contains identification and location 
information for each Message Asset stored in its database.  Refer to Browser Overview for additional 
information the Browser. 

Save Method Description 

File > Save 

command and  
icon  on Windows 
Toolbar 

 Saves with an alphabetical, numerical or 
combination filename, within Windows conventions.  
Attaches extension .lyr.  Opens dialog box 
prompting to name the file first time it is saved. 

 After saving, File Name is displayed in the Canvas 
Title Bar. 

 Always saves with the name displayed in the 
Canvas Title Bar. 

 Saves to current filepath as determined by the last 
file saved. 

 Confirms overwrite unless feature is disabled in the 
Confirm on Overwrite checkbox in the CG 
Preferences tab of the Preferences dialog box.  

 Simultaneously saves to current Browser database 
if File Save Adds to Browser is enabled (checked) 
in Browser tab in the Preferences dialog box.  File 
Name displayed in Browser is also displayed in the 
Canvas Title Bar. 
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Save Method Description 

Save As  Used to save a copy or modified version of the file 
without overwriting the original. 

 Used to store message to a destination folder other 
than the Default Path. 

 If File Save Adds to Browser is enabled, causes 
the same icon (thumbnail) to be added to the 
Browser each time a new version of the file is 
saved.  This may be useful to remind the operator 
that there are multiple version of the message.  
When duplicate Message Assets are displayed in 
the Browser, the Text View or Icon with Text 
View can be checked to verify the location of each 
copy. 

Message Number, 
followed by 
pressing Record 
on a Duet 
keyboard, or - 
(Minus sign) on the 
numeric keypad. 

 

 Num Lock must be on to use this option. 

 Performing a Save using this method records the 
file to the Default Message Directory as specified 
in Config Menu > Preferences > Default Paths. 

 If this is the first time the message has been saved, 
it is assigned a numeric File Name in the Default 
Message Directory.  

 If Auto Increment on Read/Record is enabled in 
the CG Preferences, the displayed Message 
Number advances after a Record operation so that 
the subsequent file that is saved is assigned the 
next number. 

 The Message Number displayed in the Message 
Number display determines the Message Number 
under which a file is to be saved.  Instead of 
assigning a sequential Message Number, a 
number can be entered manually using The 
numeric keypad.  When a Record is performed, the 
file is saved under the new Message Number. 

Save to Database 
button on the Lyric 
Browser 

 
Used for Messages 
and Fonts  

 Always saves file with a Message Number, as 
determined by the Message Number display.  This 
hold true even if the file has been previously named 
and saved using Save or Save As. 

 The Message Number assigned to the file in this 
operation also becomes the File Name in the 
Default Message Directory.  This can result in 
duplicate copies of the message in the default 
filepath; one with the original name, and the other 
determined by the Message Number display. 



 Getting Started 

 2-81 

Graphic Display and Animation Playout Overview 
Lyric provides a variety of methods for displaying graphics on air, and for previewing and playing animations.  
The different types of Duet systems have common, as well as system-specific features and procedures. 

This section provides an overview of the playout and frame buffer operations, with references to more 
detailed descriptions of each. 

Read 
The Read function reads the message saved (recorded) at the Message Number displayed on the Lyric 
interface.  If the Live button is active, the message also appears on the output. 

Read Next 
Read Next recalls a sequence of messages with ascending Message Numbers, allowing the operator to 
prebuild and instantly display messages.  Executing Read Next reads the message saved at the currently 
displayed Message Number, and then builds it without displaying it.  The next time Read Next is executed, 
the prebuilt message is displayed on the Duet output, simultaneously while reading and prebuilding the 
message saved at the next highest assigned ID number.  The transition from one message to the next is 
determined by the Default Effect, set in the Config menu.  Additionally, Message Effects messages (Duet 
LE/LEX/PCI/PCI+ only) can be placed in a Read Next sequence to control the transition of groups of 

messages within a Read Next sequence.  The  button must be active when executing a Read Next 
sequence.  Read Next can be especially useful for displaying pages of credits, day-by-day weather forecasts, 
sports scores, etc. 

Read Previous 
Read Previous recalls a sequence of messages with descending Message Numbers, allowing the operator 
to prebuild and instantly display messages.  Executing Read Previous reads the message saved at the 
currently displayed Message Number, and then builds it without displaying it.  The next time Read Previous 
is executed, the prebuilt message is displayed on the Duet output, simultaneously while reading and 

prebuilding the message saved at the next lowest assigned ID number.  The  button must be active 
when executing a Read Previous sequence.  Note that a Message Effects (.lyr) message should not be 
placed in a Read Previous sequence, as it will automatically cause the Message Numbers to ascend. 

Transport Controls 
Transport Controls provide easy navigation and playback control of the current animation: 

 

Transport Controls 

Changes made with the Transport Controls buttons are reflected in the Frame Counter display, and by the 
Current Time pointer movement on the Timeline and on the Keyframe Graph. 
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Playlists 
While Read Next and Read Previous execute sequences of messages that are stored at Message 
Numbers that are in ascending or descending order, a Playlist can execute a sequence of messages stored 
as numbered or named files.  Additionally, a number of parameters can be applied that control the transition 
into the next message, how the message is triggered, and to which channel it is sent.  Refer to the section on 
Playlists for details. 

Transfer Mode - Duet LE/LEX/PCI/PCI+ Only 
Transfer Mode allows animations to be played on multiple video processor boards simultaneously.  When 
operating in Transfer Mode, the VPBs and PCI Squeezeback boards take on all the work of reproducing a 
message, which can include Rolls, Crawls, Flipbooks and Clocks/Timers.  There is no use of system 
memory, and the duration of effects displayed by this method is limited only by the memory on the Video 
Processor Board.  

Refer to the section on Duet LE/LEX/PCI/PCI+ Tools for details. 

Load-and-Play Mode - Duet LE/LEX/PCI/PCI+ Only 
In this mode of operation, the Lyric software loads a graphic composition, frame-by-frame, into system 
memory, as opposed to the memory on the system's VPBs or PCI-Squeezeback boards.  Any type of 
animation may be played back in this fashion, but on a Duet LE/PCI, animations are limited to six seconds in 
duration. 

This playout mode can only be used on one VPB per system at a time.  Refer to Duet LE/LEX/PCI/PCI+ 
Tools for details. 

Streaming Animation Mode - Duet LEX/PCI+ Only 
In Load-and-Play Mode, an animation must be loaded and built before playout can begin.  The hardware’s 
resources limit the duration of such animations to six seconds. 

The Duet LEX/PCI+’s larger memory and greater speed allow playout to occur while an animation is still 
loading, hence the term Streaming Animation.  Depending upon the complexity of the animation, some 
preloading may be required in Streaming Mode. Refer to the section on Streaming Animation for details. 
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Updating Messages in Lyric 
Lyric provides a variety of means to update information displayed in a message.  2D Text, 2D Object or 3D 
Text Templates can be updated from internal or external sources, and 2D text not contained in 2D Text 
Templates can be updated by reading specially recorded 2D text messages. 

NOTE 
The update procedures described below are not to be confused with the Update 
functions found in the Browser environment.  Messages that are updated using the 
procedures described below, however, can be subsequently updated in the Browser.  
Refer to the sections covering Browser operations for details. 

Templates 
Lyric Templates allow the isolation of various elements on the Canvas so that they can be updated locally 
and/or remotely from a variety of sources.  There are three types of Templates: 

2D Text Templates 
2D Text Templates are always created within a 2D Text Window.  Each 2D Text Template can have is own 
set of Font, Color, Justification and other characteristics.  2D Text Templates can also be updated using 
the following methods: 

 Template Update (Internal from Lyric):  Template Update is an internal method of quickly updating 
the text in 2D and 3D Text Templates.  Template Update is accessed by pressing Alt + T, or by 
selecting Template Update from the Tools menu.  Text entered in the Template Update dialog box 
fields replaces (updates) the text in the 2D or 3D Text Template fields.  

 DB Link (From Database):  2D Text and 2D Object Templates can be updated by databases in a 
number of formats such as Lyric's own Browser, Microsoft® Excel®, and dBase®.  DB Link is set up 
in the 2D Text or 2D Template dialog boxes.  Refer to DB Link for details. 

 Intelligent Interface (From a Remote Host or Telnet):  Intelligent Interface sends commands from a 
remote host to update 2D Text Template and 2D Object Template data, making it an especially 
powerful tool for live events such as sports and election coverage. 

 Harvester and Harvester Pro (External from the Internet):  The Harvester plugin enables a Lyric 
2D Text Template to be linked to a text field at a remote URL for dynamic update via the Internet.  
The Harvester Pro plugin enables a user to precisely capture, process and direct the output of text 
data from almost any web page to Lyric 2D Text Templates. 

2D Object Templates 
2D Object Templates are always created outside of a 2D Text Window.  A 2D Object Template can be 
updated using the following methods: 

 DB Link (From Database):  2D Object and 2DText Templates can be updated by databases in a 
number of formats such as Lyric's own Browser, Microsoft® Excel®, and dBase®.  DB Link is set up 
in the 2D Object or 2D Text Template dialog boxes.  Refer to DB Link for details. 

 Intelligent Interface (From a Remote Host or Telnet):  Intelligent Interface sends commands from a 
remote host to update 2D Text Template and 2D Object Template data, making it an especially 
powerful tool for live events such as sports and election coverage. 
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3D Text Templates 
3D Text Templates are always created outside of a 2D Text Window.  A 3D Text Template can be updated 
as follows: 

 Template Update (Internal from Lyric):  Template Update is an internal method of quickly updating 
the text in 3D and 2D Text Templates.  Template Update is accessed by pressing Alt + T, or by 
selecting Template Update from the Tools menu.  Text entered in the Template Update dialog box 
fields replaces (updates) the text in the 3D or 2D Text Template fields. 

Pop-On Text 
Rows of text in a 2D Text Window can be updated by replacing them with text that has been recorded as a 
Pop-On message.  By doing this, only the row(s) that changes must be recorded.  When read back, the Pop-
On message replaces the new text at the current cursor position in the 2D Text Window. 
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Internal Properties 

Overview 
Internal Properties sets specific properties for an object or a message, which can override default values as 
set in Preferences or elsewhere. 

There are two general groups of Internal Properties: 
 Internal Properties that are applied to a specific object. 

 Internal Properties that are applied to a specific message. 

To apply Internal Properties settings and not close the Internal Properties dialog box: 
 Click Apply. 

To apply Internal Properties settings and close the Internal Properties dialog box: 
 Click OK. 

To close the Internal Properties dialog box without saving modifications to the settings: 
 Click Cancel. 

Internal Properties settings are retained with the message when the message is saved. 

NOTE 
Internal Properties are currently not implemented for Movie objects, Flipbooks, 
Advanced Text Effects objects, Advanced Image Effects Objects, Group Objects 
(although behavior of groups can be controlled from a message standpoint), Audio Clip 
objects, Video Clip objects, Mix objects and other specialized objects that are generated 
by Lyric. 

Internal Properties Applied to an Object 
Object Context (Right-Click) Menu > Internal Properties 
Internal Properties can be set for 2D Text Windows (except Spline), 2D bitmap objects, 3D characters and 
3D objects.  These objects all share a similar set of Internal Properties, as well having Internal Properties 
that are specific to the object type and/or playout system.  The following figure is a composite of all of the 
Internal Properties that are available to these object types. 
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To access the Internal Properties settings for an object: 
 Select the object on the Canvas or the Scene Graph, and then right-click.  The Internal Properties 

are displayed. 

 

Internal Properties - Object 

Alpha Trim (2D Objects Only, Duet LE/LEX/PCI/PCI+ Only) 
Alpha Trim removes unwanted transparent portions of a Mask Object.  The threshold at which a pixel is 
deemed transparent enough to remove is determined by its Alpha Trim setting.  The default Alpha Trim 
value is 0.05.  Raising this value results in the additional removal of less transparent pixels.  Alpha Trim must 
be enabled from the context menu of the object in order to apply this setting. 

  

Alpha Trim Applied to Mask Objects 

Note that when Alpha Trim is applied, full pixels are removed, sometimes creating an undesirable stair-
stepping effect.  If this occurs, applying a Soft Mask instead may yield better results.  

Refer to Mask Objects - Duet LE/LEX/PCI/PCI+ for additional information on Mask Objects and Alpha 
Trim. 
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Depth Test/Depth Write (Duet LE/LEX/PCI/PCI+ Only) 
The Depth Test setting determines if an object can be covered by another object when the objects intersect 
in Z-Space.  Normally, even if they are rotated in Z-Space, and points on each object share the same Z-
Position, 2D objects simply lie one on top of the other, without intersecting. 

 If Depth Test is enabled, then another object can cover the object. 

 If Depth Test is disabled, then another object cannot cover the object. 

The Default Depth Test settings are as follows: 
 The Default setting for Depth Test is normally disabled for 2D Text Windows and 2D bitmap 

objects. 

 The Default setting for Depth Test is normally enabled for 3D characters and 3D objects. 

The Depth Write setting determines if an object can cover up another object when it intersects with another 
object in Z-Space.. 

 If Depth Write is enabled, the object is allowed to cover another object. 

 If Depth Write is disabled, the object cannot cover another object, even if Depth Test is enabled on 
the other object. 

The Default Depth Write settings are as follows: 
 The Default setting for Depth Write is normally disabled for 2D Text Windows and 2D bitmap 

objects. 

 The Default setting for Depth Write is normally enabled for 3D characters and 3D objects. 

For objects to intersect and order properly, both Depth Test and Depth Write should be enabled.  If an object 
has an alpha component (e.g. 2D Text Windows), however, enabling Depth Write may unintentionally not 
allow objects behind the alpha object to show through.  In this instance, disable Depth Write.  Note that doing 
so may require that the animation requires adjustment, as the object will no longer be able to overwrite other 
objects. 

When working with 2D Text Windows that intersect with other objects, Use Scene Camera and Modified 
Space, both accessed from the 2D Text Window context menu, should be enabled to allow manipulation of 
the 2D Text Window in 3D space. 
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When Depth Write and Depth Test are disabled for the two rotated 2D bitmaps, as shown in the following 
figure, there is no intersection between each of them and any other object. 

 

Depth Write and Depth Test Disabled 
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When Depth Write and Depth Test are enabled for the two rotated 2D bitmaps, they intersect with each 
other and the 3D cube. 

 

Depth Write and Depth Test Enabled 

There may be an occasion where it may be desirable to set Depth Test Enabled and Depth Write Disabled 
for an object, depending on how objects are to interact. 

Lighting (Duet LE/LEX/PCI/PCI+ Only) 
The Lighting property determines if the global and individual lights are enabled for the object.  The default 
setting is Enabled.  The Lighting setting affects the appearance of only 3D characters and 3D objects.  The 
appearance of 2D text and 2D bitmap objects is not affected. 
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When lighting is disabled, an object displays no reflected light from the Global light or the Individual lights. 

 

Lighting Disabled 

When Lighting is enabled, the object reflect light as set for Global and Individual lights. 

 

Lighting Enabled 
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Note that when lighting is enabled for an object, and the first (not necessarily Light 1) selected individual light 
is specified in Lighting Properties as a Spotlight, it appears that the lighting for the object appears to be 
disabled, even if it is enabled and the Global Light is set at a high Intensity.  The Global Light is still 
affecting the appearance of the object, but the object appears flat.  This is due to the Spotlight Angle setting 
being set to 0.  Once the Spotlight Angle is set to a value higher than 0, the object resumes its 3D 
appearance. 

Refer to the chapter on Color/Transparency/Background/Lighting/Texture: Lighting Properties for 
additional information on setting lights. 

Pixel Aspect (2D Bitmap Objects Only) 
The Pixel Aspect setting determines the Pixel Aspect at which a 2D bitmap object is imported.  The default 
setting is determined by the Use 1:1 Pixel Aspect for Graphics Import setting in Canvas Resolution 
configuration, accessed from the Config menu. 

 If enabled in Canvas Resolution, Pixel Aspect is set at 1:1. 

 If disabled in Canvas Resolution, Pixel Aspect is set at .9. 

The Pixel Aspect setting in Internal Properties can be changed for an individual bitmap either to correct 
Pixel Aspect or to change it for effect.  The figure below shows a bitmap imported with Use 1:1 Pixel Aspect 
for Graphics Import enabled.  This specifies that the Pixel Aspect 1.0.  The appearance of the same 
graphic is corrected by setting the Pixel Aspect in Internal Properties to .9. 

 

Pixel Aspect Settings 

Wireframe (3D Characters and Objects Only, Duet LE/LEX/PCI/PCI+ Only) 
Enabling Wireframe displays a 3D character or object as a 3D wireframe.  The current colors, textures, 
shininess and/or transparencies of the surfaces are picked up in the wireframe. 

 If Wireframe is set to False, the object is displayed as solid. 

 If Wireframe is set to True, the object is displayed as a wireframe. 
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Wireframe - False and True 
The following shows a wireframe of the 3D character O, with the face made completely transparent. 

 
Wireframe with Transparent Face 

Internal Properties Applied to a Message 
Light, Global Light or Camera Context (Right-Click) Menu > Internal Properties 
Tools and Canvas/Scene Graph Context Menus > Message Properties 

The Internal Properties for a message can be set by accessing the context (right-click) menu for Light, 
Global Light or Camera, or from Tools Menu > Message Properties.  To access the Internal Properties 
settings for an object, use one of the following methods: 

 Select a Light on the Canvas or Scene Graph, and then right-click. 

 Select Global Light or Camera on the Scene Graph, and then right-click. 

 From the Tools menu, select Message Properties. 
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  The Internal Properties are displayed. 

 

Internal Properties - Message 

Legacy Mask (Duet LE/LEX/PCI/PCI+ Only) 
Mask Objects in Lyric v4.1 up to, but not including, Lyric v5.0, are rendered differently than Mask Objects 
rendered in Lyric v5.0 and later.  To properly render a message created using pre-Lyric v5.0, a Legacy Mask 
option is provided.  The default setting is Disabled. 

 To properly render a message containing Mask Objects, that was created using a version of Lyric up 
to, but not including, Lyric v5.0, set Legacy Mask to Enabled. 

 To properly render a message containing Mask Objects, that was created using Lyric v5.0 or later, 
set Legacy Mask to Disabled. 

Refer to Mask Objects - Duet LE/LEX/PCI/PCI+ for additional information on Mask Objects. 

Preview Frame 
The Preview Frame is the frame of an animation which displays when the animation message is read.  This 
value can be set in the Record Only dialog box, accessed by pressing Ctrl + Record or Ctrl + Alt + Record, 
or by setting in the Internal Properties dialog box.  For the Preview Frame setting to be applied, the Show 
Preview Frame setting in Config Menu > Preferences > Animation Settings must be enabled (checked). 

The Preview Frame setting in the Internal Properties dialog box reflects the Preview Frame set from the 
Record Only dialog box.  

The default setting for Preview Frame is -1, which specifies that no Preview Frame is set. 
 If Show Preview Frame is enabled, the last frame of the animation is displayed. 

 If Show Preview Frame is disabled, the first frame of the animation is displayed. 

If the Preview Frame is set to 0 or higher: 
 If Show Preview Frame is enabled, the specified Preview Frame of the animation is displayed. 

 If Show Preview Frame is disabled, the first frame of the animation is displayed. 

Refer to Reading and Recording Messages - Selective Recording - Preview Frame -  for additional 
information.  
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Rendering Mode 
The type and complexity of an animation may require that it be rendered in a specific manner in order to play 
back correctly.  In addition, depending on the system and the graphic boards, one Rendering Mode may be 
more suitable than another for playback.  Rendering Mode can be set for an individual message.  This 
setting for the message does not change the default Rendering Mode setting as set in Config Menu > 
Preferences > Animation Settings.  The Rendering Modes are the same as those in the Animation 
Settings. 

 Fast Rendering allows some animations that may not play back properly in real time to play back 
smoothly.  There may be an infrequent trade-off when Fast Rendering is enabled, in that the 
compositing of overlapped transparent pixels and the antialiasing of characters may not display 
properly.  Preview the animation before sending to air. 

 Normal Rendering plays back animations using Duet's normal rendering process.  

 Depth (2 Pass) corrects the rendering of 2D objects, that have transparency, and that either intersect 
in 3D space or that overlap.  While rendering in this mode is slightly slower, it usually unnoticeable, 
due to the high rendering speed of current graphics cards. 

 Fast/Fix Key (Duet LE/LEX/PCI/PCI+ Only) corrects the rendering of the Key Out signal.  
Rendering in this mode is necessary only if the rendered Key signal is to be used downstream of the 
Duet system.  While rendering in this mode is slightly slower, it usually unnoticeable, due to the high 
rendering speed of current graphics cards.  Using this mode also requires the presence of specific 
graphics cards.  Contact Chyron Customer Service (631-845-2132) for additional information.  Note 
that on Duet SD/HD systems, using this mode is not necessary, as the Key signal is rendered 
properly. 

Use Group Priority 
Prior to Lyric v5.0, when a group was created, any object added to the group would retain its display priority 
with regard to the ungrouped objects, even though the Scene Graph indicated that the priority of the objects 
had moved up.  This would also occur with automated grouping of animated objects (e.g. created using 
Animate Elements or Advanced Text Effects).  

The following figure shows five ungrouped, overlapping 3D characters. 

 

Ungrouped Overlapping Characters 
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When a group is created in Lyric, a new Group object is added to the top of the Scene Graph.  As shown in 
the following figure, the Scene Graph indicates that objects 4 and 2 should overlap objects 5, 3 and 1.  
Object 4 still overlaps object 3, but does not overlap object 5.  Object 2 still overlaps object 1, but does not 
overlap object 3. 

 

Grouped Objects Not Displaying Actual Priority 

Enabling the Group Priority setting results in the objects in the group displaying at their actual priority.  
Objects 2 and 4 now cover objects 1, 3 and 5. 

 

Grouped Objects Displaying Actual Priority 

Priority behavior is determined as follows: 
 When Group Priority is set to 0, the Canvas does not reflect the actual priority of grouped and 

ungrouped objects as indicated by the Scene Graph.  A group created using Animate Elements or 
Advanced Text Effects is always added to the top of the Scene Graph. 

 When Group Priority is set to 1, the Canvas does reflects the actual priority of grouped and 
ungrouped objects as indicated by the Scene Graph.  A group created using Animate Elements or 
Advanced Text Effects is always added to directly above its associated 2D Text Window listing in 
the Scene Graph. 

The default Group Priority value is determined as follows: 
 Group Priority is set to 0 (False) for messages created using pre-Lyric v5.0. 

 Group Priority is set to 1 (True) for messages created using Lyric v5.0 and later. 
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In Lyric v5.0 and later, priority can be further fine-tuned by dragging-and-dropping the group, or dragging-and-
dropping objects within, into and out of groups on the Scene Graph.  Non-grouped objects can also be 
inserted between grouped objects by adjusting the Z-Position(s) of the grouped and/or non-grouped 
object(s). 

onRead Macro 
Enabling onRead Macro allows a macro that is recorded with a message to execute when the message is 
read.  The default setting for onRead Macro is blank, specifying that there is no macro associated with the 
message. 

To associate a macro with the message and test execution: 
1. While the Lyric composition is displayed, create or read a macro.  Test the macro to make sure that it 

executes properly. 

2. In the Internal Properties dialog box onRead Macro field, enter the name of the macro.  Click OK to 
close the Internal Properties dialog box. 

3. Save the message. 

4. Read the message.  The macro should execute. 

A message can also be set to execute a macro when the message is read by saving it from the Record Only 
dialog box.  Refer to Reading and Recording Messages - Selective Recording - Embedded Macros -  for 
additional information.  
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Lyric Control of Internal and External Devices and Events 
Lyric can control and/or be controlled by a wide range of internal and external devices, using a variety of 
methods. 

 Squeezeback (Duet LE/LEX/PCI/PCI+) and Playlist Effects can be executed via Chyron KwiKeys 
or other external devices such as Master Control Switchers via GPI (General Purpose Interface) 
control.  Refer to the sections on Squeezeback Panel, Playlists, and Duet Hardware:  KwiKeys 
respectively for details. 

 Lyric can trigger Transport Controls (e.g. Play, Stop, etc.) on VTRs and DDRs using the BVW-75 
protocol via the RS-422 Serial Digital Interface. 

 The Aprisa DDR can be controlled via an Ethernet connection. 

 Intelligent Interface commands can be sent to Lyric via RS-232 Serial Protocol or Telnet. 

 GPIs can be used to start Lyric Clocks and Timers, release a Pause and perform many other 
triggering functions. 

 Lyric can use GPI output to trigger external devices such as keyers and tally lights. 

 A user can send Read, Read Next, Xfer and other related commands to Lyric using Chyron's ReCall 
Keys via the RS-232 Serial Protocol. 
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Lyric File Formats 
Lyric can import and export many common graphic, animation and other formats that can be used in outside 
applications.  Lyric also creates and uses a variety of proprietary and non-proprietary formats. 

File 
Extension 

Description 

Lyric Compositions 

*.lyr This is the most commonly used Lyric file format.  It is used to save 
complete Lyric compositions as well as specific groups of settings. 

Text Messages 

*.lyr All Text File:  Records all text in the selected 2D Text Window.  
Recorded from within the Record Only: dialog box. 

*.lyr Cursor to End File:  Records all text from cursor position to the end 
of the row in the selected 2D Text Window.  Recorded from within the 
Record Only: dialog box. 

*.lyr Current Row File:  Records all text on current row in the selected 2D 
Text Window.  Recorded from within the Record Only: dialog box. 

Properties 

*.lyr Clock/Timer File:  Records all Clock/Timer settings in the Lyric 
composition and is recorded from within the Clock/Timer Properties 
tab or from within the Record Only: dialog box. 

Animations 

*.efx Scene Effects/ Read Effects File:  Records Keyframe information 
from all objects on the Canvas.  Recorded from File Menu > Save 
As, then select Save as Type:  Lyric Effects File (*.efx) or the 
Record Only: dialog box. 

*.kyf Object File:  Records Keyframe information of the selected object on 
the Canvas.  Recorded from Timeline > Save Keyframe File or the 
Record Only: dialog box. 

*.tfx Text Effect File:  Records Advanced Text Effect settings of the 
active 2D Text Window.  Recorded from Advanced Text Effects > 
Save. 

User Profiles 

*.reg Lyric User Profile:  A standard Windows® registry file format that 
saves User Preferences  and other Lyric settings and allows access 
for all Windows users.  Also used in Chyron MOS operations.  A User 
Profile is set via Config Menu > Save User Profile.  It is loaded via 
Config Menu > Load User Profile. 

*.lup Lyric User Profile:  A Lyric format that saves User Preferences  and 
other Lyric settings.  Limited access users cannot load *.lup files.  A 
User Profile is set via Config Menu > Save User Profile.  It is 
loaded via Config Menu > Load User Profile. 
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File 
Extension 

Description 

Palettes 

*.reg Palette File:  A standard Windows® registry file format that is used to 
store a Palette settings.  Recorded from the Color Select dialog box. 

Playlists 

*.ply Playlist File:  Records Playlist information from within the Playlist or 
the Record Only: dialog box. 

Macros 

*.lyr Macro File:  Records Macros scripts from within the Macros dialog 
box or the Record Only: dialog box.  Because it is saved as a Lyric 
message, it can be read by entering a Message Number, and then 
pressing Read or Read Next.  It can also be set to autoexecute on 
opening and can be programmed into a Playlist. 

*.lmx Macro File:  A standard Windows® Macros script format that is 
recorded from within the Macros dialog box.  Can be edited from 
within Lyric as well as in a text editor.  Can only be opened from File 

Menu > Open or Windows Toolbar > Open icon .  Cannot be 
set to autoexecute on opening or be programmed into a Playlist. 

Control Panels 

*.lyr Multi FX File (Duet SD Only):  Records Multi FX settings from within 
the Multi FX Control dialog box or the Record Only: dialog box. 

*.lyr Video Mixer File (Duet SD Only):  Records Video Mixer settings 
from within the Video Mixer dialog box or the Record Only: dialog 
box. 

*.ccf Clip File:  Records a Clip file from within the Clip Control Panel or 
the Record Only: dialog box. 

Browser Databases 

*.mdb Microsoft® Database File:  Microsoft® Access database file format 
used to record Browser database files.  Recorded from Config Menu 
> Preferences > Browser > Create Data Source or from Browser 
Window > Select Database > Create Data Source. 

Backup 

*.lbu Lyric Backup File:  Backup file of Browser database, Browser 
assets, Windows directory or sets of files.  The backup file can be 
used to restore files in the same or a different location.  Backup is 
performed from File Menu > Backup.  Restore is performed from 
File Menu > Restore. 
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File 
Extension 

Description 

External Systems - Chyron iNFiNiT!® 

*.fnt iNFiNiT! Font File:  An iNFiNiT!  font file recorded from within the 
Browser's iNFiNiT! Browser Assets Window > Save to Database, 
Custom Font Editor > File Menu > Save or Custom Font Editor > 
File Menu > Save As > Save as Infinit font. 

*.rgb Chyron iNFiNiT! RGBA File:  An iNFiNiT! graphic file format.  

Imported via Tools Menu > Graphic or Import Graphic icon  
on the Chyron Toolbar.  Lyric can also save to this format via File 
Menu > Save As, then select Save as Type:  iNFiNiT! RGBA (*rgb). 

External Systems - Non-Chyron 

*.vpb Quantel® Graphics File:  a Quantel graphics file format.  Recorded 
from within Browser Window > Quantel Assets > Save to 
Database. 
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Using Audio in Lyric 
An audio (*wav) file can be incorporated into a Lyric composition in the following manners: 

 As an audio clip which is added to the scene via the Clip Control Panel. 

 As a component of a video clip that is recorded from the Clip Control Panel. 

Refer to Clip Control Panel, Audio and the Internal Clip Player and Recording Video/Audio to Video 
and Audio Files for in-depth coverage. 
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3. Duet SD Hardware Configuration 

Duet Hardware Configuration 
Config Menu > Duet Hardware Configuration 
Duet Hardware Configuration is the setup facility for Duet systems.  It encompasses functions such as GPI, 
Video Standard, Timecode, and much more.  When Duet Hardware Configuration is selected from the 
Config menu, a set of configuration tabs is displayed for the system on which Lyric is installed.  The following 
sections cover configuration for each type of Duet system. 

Duet SD Video I/O Board 

Overview 
The SD Video I/O board performs video processing services for Duet, providing SDI (Serial Digital Interface) 
inputs and outputs, plus various sync gen timing services including a Genlock input and time code inputs.  
This board provides no analog video outputs. 

The two video paths each include a 10-bit 4:2:2 keyer for compositing the Duet graphics input over the 
program video input using Key1.  When the keyer mix is enabled, the resulting key output is 100% opaque.  
When the keyer mix is disabled the video output can be either shaped by Key or unshaped under user 
control. 

The Input Processor has 10-bit resolution. RGB1 is optionally unshaped via an integer divider, and Key1 is 
decimated, then RGB1 is converted into YCrCb 4:2:2.  Y1 and Key1 are fed to a luminance mixer along with 
program Y. CrCb1 and decimated Key1 are fed to the chrominance mixer along with program CrCb.  

The Keyer Luminance Mixer has 10-bit resolution.  A two-channel mixer, uses shaped Y1 input for mix with 
program video, shaped or unshaped otherwise. The Y1 mixer coefficient is 100%; the program Y mixer 
coefficient is equal to (1 - Key1). 

The Keyer Chrominance Mixer also has 10 bit resolution. CrCb1 and program CrCb are multiplexed, and 
use shaped CrCb1 input for mix with PGM video (shaped or unshaped otherwise).  The CrCb1 mixer 
coefficient is 100%; the program CrCb mixer coefficient is equal to (1 - Decimated Key1). 
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Setup 

 

Accessing Standard Definition Video I/O Settings from Control Panel 
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Remember that Duet's output video standard can be changed only in this Windows control panel, and not 
from Lyric. All of the other settings can be changed in this control panel or from Duet Hardware in Lyric's 
Configuration menu. 

 

Video Configuration Settings 

1. In the Video Standard area, select your facility’s standard by clicking a radio button. 

2. In the Reference Select area, select one of the following: 

 Analog Sync In (to use your facility’s black burst signal) 

 SDI Video In 

 Free Run (Duet supplies its own internal sync) 

3. The Video In area determines processing of video inputs to Duet; click: 

 Enable Key Input when a Key Input signal is applied to Duet.  Otherwise, a 100% matte 
signal is associated with Program In. 

 Enable Video Shaping to attenuate input video to the key signal level, so that color 
components do not exceed the key level. 

4. The Ancillary Data checkbox causes Duet to pass all data in the incoming signal’s blanking interval 
to the outputs. 

5. In the Output area, the Keyed checkbox enables the Duet's keyer and causes the signal appearing 
at the SDI video input to be passed to the Duet output with Duet video keyed over it. 

6. After all your selections are made, press Apply. 
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Output Processor, 10 bit resolution 
YCrCb and Key are range limited, filtered, and have sync added.  Ancillary data, delayed from the program 
video input, is optionally added prior to conversion to SDI. 

Channel 2 Output (without Keyer) 
The Channel 2 Input/Output Processor has 10-bit resolution.  RGB2 is optionally unshaped via an integer 
divider. RGB2 and Key2 are converted to YCrCbK 4:2:2:4, then are range limited, filtered, and have sync 
added.  Ancillary data, delayed from PGM video input, is optionally added as well, before conversion to SDI. 

Program Video Inputs 
For the Program Video inputs, SDI Video and Key are deserialized, and then Y and CrCb are demultiplexed 
for the keyer inputs. YCrCbK is then converted to RGBK for the program video output.  This board subsection 
includes a programmable delay for horizontal positioning.  A separate delay path is provided for ancillary data 
pass through to the SDI video outputs. 

Sync-Gen 
In the Sync Gen section of the Video I/O board, Genlock is selectable from either the SDI Video input or from 
the analog reference input. Scanline timing (525/625 timing) is software-selectable.  Separate video timing 
channels are provided for each backplane slot, with individually programmed (software-controllable) delays. 
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Duet Hardware Configuration 
Config Menu > Duet Hardware 
Duet Hardware configuration sets video specifications, parameters for external device control via the BVW-
75 protocol and GPIs, as well as Timecode setup.  Note that Device Control, GPI, Timecode and MPx 
configuration procedures are the same for Duet SD and Duet HD.  Timecode and Device Control setup are 
the same for all systems.  Hardware requirements for accepting external Timecode differ between systems. 

 

Duet Hardware Configuration Dialog Box - Duet SD 

 

Duet Hardware Configuration Dialog Box - Duet HD 
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There are five tabs which contain configuration settings: 
 Video (Duet SD)  or HD Video:  Specifies parameters such as Video Output Standard, Genlock, 

etc. for the selected board. 

 Device Control:  Specifies the configuration information for the optional RS-422 Serial I/O Board & 
GPI/O board, which enables serial control of external devices using the BVW-75 protocol, as well as 
in- and out-bound GPI triggering. 

 GPI:  Specifies how the GPI assignments are set up. 

 Timecode:  Specifies Timecode source and other parameters. 

 MPx:  Specifies the allocation of VGEs in Duet SD and HD.  For example, in multi-VGE systems, two 
VGEs may be paired for enhanced processing power in rendering complex animations.  

Note that if the optional RS-422 Serial I/O Board & GPI/O and its driver are not installed in the system, the 
Device  and GPI tabs are not accessible, and are grayed out.  For information on Device configuration, refer 
to Duet Hardware Configuration - Device Control. 
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Video 
Config Menu > Duet Hardware > Video 

The Video tab provides control of Duet basic video setup, except for the video output standard, directly 
from Lyric. 

 

 Video Configuration Tab 

Setting Description 

Video 
Standard 

Specifies Video Standard [525 Line (NTSC for Standard Definition 
Duet systems), 625 (PAL for Standard Definition Duet systems), 
1080i (High-Definition Duet systems), 1080/24p (High Definition 
Duet, outputting 24 frames per second for film production) or 720p 
(High Definition Duet systems)].  This must be set in the High 
Definition Video I/O Settings dialog box, accessed from Control 
Panel > Duet Hardware. 

This area of the window is only an indicator of the configuration 
which is set in the Duet Hardware control panel. This control panel is 
accessible completely independent of Lyric through Windows.  

Reference 
Select 

Selects one of three Genlock sources: Analog (Composite 
Sync/Black Burst, SDI (SD Duet Only), or Free Run (internal 
reference source only). 

Video In Select Enable Video Shaping to attenuate Input Video to the Key 
signal, so that color components do not exceed the key level. Select 
Enable Key Input to use Duet’s internal keyer. Otherwise, the signal 
is passed at full value. 

Horizontal 
Delay 

Sets/changes the Horizontal delay of Duet video with respect to 
incoming video reference. 
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Setting Description 

Vertical 
Delay 

Sets/changes the Vertical delay of Duet video with respect to 
incoming video reference. 

Note: Horizontal and Vertical Delay settings are maintenance-type adjustments that 
should be made only at the time of system setup, and left unchanged if possible. 
However, these controls are active in Lyric’s “Duet Hardware Configuration” menus, 
which are described in the following sections. Any changes to these controls should 
made only by a qualified technician. 

Output 1 

Output 2 

Use the radio buttons to enable or disable the Keyer signal for each 
of the Video I/O board's two outputs. 

Ancillary 
Data 

The Ancillary Data checkbox causes Duet to pass all data in the 
incoming signal’s blanking interval to the outputs.  When enabled, all 
ancillary data, including Closed Captioning, will pass through the 
Keyer unaffected.  This means that no Duet video is inserted into the 
first displayed scanline of each field, in order to preserve the Closed 
Captioning information.  The Blank Line, or Vertical Reset, is 
normally Line 10, but a different line can be selected for non-
standard video formats.  The ancillary data appears on the same line 
in the output signal. 

Save/Recall 

 

Saves the current Video settings in a file with the familiar .lyr suffix. 
You may open such a file to restore previously-saved settings. 

 

Save/Record Lyric Video Settings 

Output Use these radio buttons to select which of Duet's output channels 
will appear on the Video I/O board's single analog output.  Select 
Keyer Off or Keyer On for the selected output. 

OK/Cancel  To exit and save changes, click OK. To exit without changing the 
current Duet video settings, click Cancel. 
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Configuration for Display of Video Source 
Duet SD:  Config Menu > Duet Hardware > Video 
Video from a variety of sources can be incorporated as part of a Lyric composition.  Lyric provides creative 
tools for displaying video, including Masks, Video Regions, Squeezeback Objects and application of video 
to 3D surfaces. 

Video can be displayed as a continuous live or prerecorded source.  In this situation, the video is not a 
component of the Lyric composition itself, in that it is not an object that can be manipulated through Lyric.  It is 
a straight video display, with no set beginning or end controlled through Lyric. 

Video can also be displayed as a clip, where playback parameters are controlled either directly from Lyric's 
Clip Control Panel, or where the playback parameters are set up from the Clip Control Panel, but the clip 
itself is an object in a Lyric animation and is played back as part of the Lyric animation.  The Clip Control 
Panel provides the ability to play back video or audio clips files (*.ccf).  Lyric does not perform actual edits on 
the recorded content of the source material.  The Clip File contains the In and Out point information that 
defines the duration of the clip for playback, however, the source video/audio remains unchanged.  In order to 
play back the video/audio, the original material and the playback device must be available.  Clip files can be 
created from sources such as an External VTR or DDR (Digital Disk Recorder), a Chyron Aprisa DDR, 
Duet’s Internal Clip Player, or Audio files processed through audio hardware in Duet. 

Playback from a video source is routed through Duet’s internal keyer.  The video is not visible on the Lyric 
Canvas as seen on Duet's SVGA monitor.  Rather, the clip is keyed behind the Lyric composition and is 
visible on the output monitor.  To enable Duet’s internal keyer: 

1. From the Config menu, select Duet Hardware. 

2. Select the Video tab, click Keyer On for either or both channels, and then click OK.  The figure below 
shows Keyer On for Output 1, and Keyer Off for Output 2. 

 

Video Settings for Display of Video 
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Device Control 
Config Menu > Duet Hardware Configuration > Device Control 
Lyric can control or be controlled by external devices such as videotape tape recorders (VTRs), digital disk 
recorders (DDRs) and switchers by using GPIs (General Purpose Interface triggers) or by the BVW-75 
Serial Digital Protocol via the RS-422 Serial Digital Interface. 

Such control inputs to Duet from external sources can start and stop Clocks and Timers, execute an 
individual step within a Lyric Playlist or release a programmed Pause.  GPI control outputs from Duet can be 
used to trigger external devices such as keyers and tally lights.  Refer to GPIs - Overview for comprehensive 
information on GPI setup. 

The most common use of the BVW-75 protocol/RS-422 connection is for cueing and playback of video from 
the Clip Control Panel.  In addition, segments of existing video on external playback devices can be defined, 
saved and played back as Clips either on their own, or as components of a Lyric message. 

NOTE 
To enable BVW-75 via RS-422 (all systems) capability or GPI (Duet SD/HD) capability, the 
Chyron's optional RS-422 Serial I/O & GPI/O Board and must be installed in the Duet 
SD/HD system.  This board is not necessary for GPI function on Duet LE/LEX/PCI/PCI+, 
but is necessary for BVW-75/RS-422 communication.  Call Chyron Customer Service at 
845-2132 for information about this product.  Refer to RS-422 Serial I/O & GPI/O Board for 
details on installation and setup. 

 While each type of system displays its own set of system-specific tabs in Duet 
Configuration, the Device tab on all systems is the same. 

 If this board is not present in a Duet SD/HD system, the Device and GPI tabs are 
grayed out. 
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The following example shows configuration on a Duet SD of serial device control of a Sierra DDR, using the 
BVW-75 protocol.  

1. Be sure that the external DDR or VTR is properly connected to the Duet system.  For additional 
information on connection, refer to the Duet Hardware Reference Manual. 

2. From the Config menu, select Duet Hardware.  The Duet Hardware Configuration tabs are 
displayed.  Click the Device Control tab to display the Device Control settings. 

 

Duet Configuration - Sony® BVW-75 Protocol 

3. From the Port drop-down list box, select the number (1 - 4) of the port on the Chyron RS-422 Serial 
I/O & GPI/O Board that is to be connected to the external device. 

4. In the Description field, enter a description of the device.  When the external device is selected in the 
Clip Control Panel Playback Device drop-down list box, this description is reflected in the Playback 
Device field.  Refer to Clip Control Panel for additional information on clip operations. 

5. Select (check) the Port Allocated checkbox.  If this checkbox is not enabled, the device is not 
recognized by the Clip Control Panel, and therefore cannot be accessed for clip creation. 

6. The Protocol drop-down list box defaults to the BVW-75 protocol, using an RS-422 connection.  
BVW-75 is the currently the only protocol supported by Lyric.  Lyric detects connected machines that 
use BVW-75 protocol, and then automatically sets the Port Configuration values for Baud Rate, 
Data Bits, Stop Bits and Parity.  The Master radio button is always selected.  The Slave function is 
not implemented at this time.  

7. Enter a Pre-Roll Time, in frames, for the VTR that is connected.  Pre-Roll for a DDR is 0.  
Remember that this adjustment is in Frames. 

8. Click OK.  Device Control is now set up for the DDR. 
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GPI 
Config Menu > Duet Hardware > GPI 
Overview 
Lyric can control or be controlled by external devices such as tape machines, digital disk recorders (DDRs) 
and switchers by using GPIs (General Purpose Interface triggers) or by the BVW Serial Digital Protocol 
via the RS-422 Serial Digital Interface.  Such control inputs to Duet from external sources can start and stop 
Clocks and Timers, execute an individual step within a Lyric Playlist or release a programmed Pause.  In 
addition, GPI control outputs from Duet can be used to trigger external devices such as keyers and tally lights. 

NOTE 
To enable GPI and/or RS-422 capability, the Chyron's optional RS-422 Serial I/O & GPI/O 
Board must be installed in the Duet SD/HD system.  Call Chyron Customer Service at 
845-2132 for information about this product.  Refer to RS-422 Serial I/O & GPI/O Board for 
details on installation and setup.  If this board is not present in the system, the GPI and 
Device tabs are grayed out. 

Setup 
To access GPI setup: 

 From the Config menu, select Duet Hardware, and then click the GPI tab.  The following two figures 
show sample GPI INPUT and GPI OUTPUT settings. 

 

Duet Configuration - Setting GPI INPUT 
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Setting GPI OUTPUT 

The following parameters should be set to enable GPI capability: 

Item  Description 

GPI  GPI designates which is assigned to a specific event.  The number 
of GPIs available depends on the number of RS-422 Serial I/O & 
GPI/O Boards installed in the system.  In the GPI dropdown list 
box, default GPIs 1 - 8 for the first installed RS-422 Serial I/O & 
GPI/O Board; 9 - 16 for the second board; 17 - 24 for the third 
board, and 25 - 32 for the fourth board.  Click on the up or down 
arrow spin control box to set. 

If multiple RS-422 Serial I/O & GPI/O boards are installed in the 
system, then the DIP switches must be correctly set in order to 
ensure availability of all GPIs. 

Description  A descriptive name can be assigned to the GPI in the Description 
field to make it easier to identify. 

GPI 
Allocated  

The GPI Allocated checkbox must be checked to enable GPI 
control. 

Direction  The Direction setting determines whether the designated port is to 
receive the incoming pulse (INPUT) or send an outgoing pulse 
(OUTPUT). 

Active 
Level  

The Active Level setting determines whether a voltage change in 
the GPI signal low to high (HIGH) or from high to low (LOW) is to be 
recognized as the trigger. 

Pulse 
Width  

Pulse Width defines the minimum duration of the GPI pulse in 
milliseconds.  This should be set to ignore a short accidental contact 
with a physical GPI button or a slight signal anomaly which could 
unintentionally trigger the GPI. 
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NOTE 
When a GPI assigned to a specific event, such as to trigger a Playlist step or trigger a 
Squeezeback Effect, make sure that the same GPI is not also assigned as a Global GPI, 
as there may be a conflict when the GPI or Global GPI is triggered.  Refer to GPIs and 
Global GPIs for additional information.  Refer to Chapter 6 - GPIs and Global GPIs for 
additional information. 

Test Messages 

 

Cannot Test for Input - GPI Not Enabled 

 

GPI Enabled and Assigned 

 

GPI Enabled - Waiting for Input 
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Timecode 
Config Menu > Duet Hardware > Timecode 

Timecode parameters can now be set for all Duet systems in the Config Menu > Duet Hardware > 
Timecode tab, as shown below. 

 

Time Code Configuration 

System Timecode is set either internally or via an externally generated signal. 
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Internal:   Internal Timecode is synchronized with the Windows time clock.  To update the synchronization 
between Duet's Timecode facility and the Duet's PC system clock, click Sync. 

External:  Externally generated timecode is fed to the Duet system.  The timecode can be either Drop Frame 
or Non-Drop Frame.  Check the Drop Frame checkbox to enable Drop Frame timecode; uncheck the Drop 
Frame checkbox to use Non-Drop Frame timecode.  Duet SD/HD and Duet LE/LEX/PCI/PCI+ systems have 
different external timecode connections. 

 Duet SD/HD:  Connect the external timecode generator to the LTC IN (Longitudinal Timecode In) 9-
pin jack on the Video I/O board. 

 Duet LE/LEX/PCI/PCI+:  An optional PCI-LTC board from Adrienne Electronics must be installed to 
enable external timecode sync.  Connect the external timecode generator to the LTC IN three-pin 
mini-XLR jack on the PCI-LTC board.  Contact Chyron Customer Service at 1-631-845-2000 for 
information on obtaining the PCI-LTC board. 
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MPx 
Config Menu > Duet Hardware > MPx 
This panel controls the allocation of VGEs in Duet SD and HD.  In multi-VGE systems, two VGEs may be 
paired for enhanced processing power in rendering complex animations on one of the system's outputs.  

These controls also allow the operator to assign a specific VGE to the incidence of Lyric in which this panel is 
opened. (VGEs may be assigned to other copies of the Lyric program currently running or to other 
applications such as CAL.)  

If a VGE board is Locked, Lyric has use of the frame buffer(s) on that board, excluding other applications 
such as CAL. An error will be generated by the CAL server if the client application tries to connect to that 
channel. If a VGE board is In Use, another application (e. g. CAL client) has connected to that board and has 
locked it for exclusive use. The Frame Buffer’s settings are written to the registry on exit from Lyric. 

In Figure 1 below, VGE 1 is assigned to the current incidence of Lyric (this was accomplished by clicking the 
Locked checkbox). VGE 2 is being used by another application, as shown by the In Use status indicator. No 
additional VGEs are installed, as shown by the Not Installed status indicators. 

 

Duet VGEs Allocated on the MPx Tab 
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To group 2 VGEs together for enhanced animation processing power:  
1. Uses the standard Windows Shift + Click method to select them both. Click the Locked checkbox, as 

shown, and then click the Group button on the right. 

 

Selecting Two VGEs to Group Together 

2. Press OK to make the change effective. The change will take a moment, during which time you may 

see a  Wait  cursor. When Duet has completed the operation, one of the Frame Buffer 

 buttons will disappear (leaving something like  on the Duet toolbar). The 
remaining button symbolizes the two VGEs grouped together as a single Frame Buffer. Two VGEs 
grouped together look like this on the MPx panel: 

 

Two VGEs Grouped Together 



 Duet SD Hardware Configuration 

 3-19 

To ungroup VGEs: 
1. Select one of the VGEs on the menu, as seen below. 

 

Ungrouping VGEs 

2. Press Ungroup. Note that this action also un-assigns both VGEs from Lyric; when VGE #2's 
checkbox becomes visible again, both checkboxes will be "unchecked". Therefore... 

3. ...You must re-assign the VGE (or VGEs) that you wish to use with Lyric by clicking the Locked 
checkbox(es). 

4. Click OK to put the changes into effect. 
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4. Duet HD Hardware Configuration 

High Definition Video I/O Settings and Hardware Overview 
Start > Settings > Control Panel > Duet Hardware > Video I/O Driver 

Overview 
Basic Configuration and Connections 

 

View of HD Video I/O Board Back Panel 
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HD Duet Basic Configuration 
High Definition Video I/O Board Connections 

Reference In Tri-level reference input. 

Video 1 Out  SMPTE 292 SDI (Serial Digital Interface) Video Output. 

Key 1 Out  SMPTE 292 SDI (Serial Digital Interface) Key Output. 

Video 2 Out  SMPTE 292 SDI (Serial Digital Interface) Video Output. 

Key 2 Out  SMPTE 292 SDI (Serial Digital Interface) Key Output. 

Video In SMPTE 292 SDI (Serial Digital Interface) Program Video.  May 
contain ancillary data that will be passed to the output. 

Key In SMPTE 292 SDI (Serial Digital Interface) Key/Alpha associated 
with Program Video Input.  Used for Alpha blending. 

(LTC) Timecode 
In 

Currently not implemented. 

Board Position 
The Video I/O board is always in Slot 1 and the Mixer/Switcher board is always in Slot 2.  Standard system 
setup is one VGE in Slot 5 and a second VGE in Slot 7.  The VGE in Slot 5 is routed to the mixer through 
Compositor 1 and the VGE in slot 7 is routed to the mixer through Compositor 2. 

The optional third VGE should go in Slot 6.  On the Lyric Duet Hardware Configuration MPx menu, VGE2 
and VGE3 should be grouped into a single frame buffer, which is buffer 1.  The optional HD Capture board 
should always go in slot 3. 

Note that: 
 Lyric numbers the VGEs from the Video I/O Board out. 

 Lyric number the Frame Buffers from the CPU out. 

Video 1 and Video 2 can each key the internal Duet HD graphics over Program Video in. 
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The following is a recommended setup: 

 

Duet HD Board Setup 

NOTE 
The recommended location of boards in Duet may change with software and hardware 
refinements and new options!  Carefully read the installation instructions that 
accompany any field update you purchase, and when in doubt, call Chyron Customer 
Service for assistance at 888-4-CHYRON. 

In conformance to SMPTE 292M specifications, the HD Video I/O board provides 1.485 GB/sec serial digital 
1080i and 720P display formats. Prior to Lyric Version 1.2 and Duet Driver Version 2.5, the video standard 
was determined by the DIP switches on the board. In Lyric Versions 1.2 and later, and Duet Driver Versions 
2.5 and later, the video standard is set by the drivers that are loaded when the system starts.  A single 
reference input is provided for analog tri-level sync.  The design of the HD Video I/O hardware is essentially 
standards-independent among the various HD formats. Different oscillators are available on board for the 
different required standards.  

RGB to SMPTE292M Conversion 
Inputs for Channel 1 are received on four channel links, giving an input bandwidth of 4 components (RGBK) 
at 74M pixels/sec. The parallel streams from the channel links are converted and synchronized to the internal 
clock, and re-multiplexed to RGBK streams of 8 bits at 74MHz. The RGBK streams are then passed to filters 
in order to reduce fast (0-1) edges, so that these edges do not ring later analog or digital filters. The RGB 
signals are then passed through a color space converter to get to YUV 10 bit, and then the U & V signals are 
passed through a down sampler. This down sampler implements a 29 point symmetric filter for half bandwidth 
reduction and decimation, and both the U & V channels can pass through a single LF3320. Delay 
compensation for the luminance signal and key signals are made. The key signal is level shifted to 
SMPTE292M levels for output, and to a 0-512 level for key processing.  
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Program Video In 
Parallel Y and C data from the program input has its timing information extracted and passed to the Genlock 
area. The Y and C data are passed through a short synchronizer to synchronize to board clock phase. The C 
data is demultiplexed, and up-sampled through a 5-7 point filter. Color space conversion to RGB is 
accomplished, after which the data is demultiplexed and passed to channel link transmitters to go to the VGE 
board. Timing information can also be put on the channel links. 

Genlock 
The reference input BNC connector is intended for a tri-level sync source that will synchronize HD Duet with 
your facility’s master timing. The oscillators are VCXOs, and 4 positions are provided for different standards. 
Automatic detection of frame rate is incorporated (including differentiation of 59.94Hz & 60Hz). Only one 
oscillator will be active at any one time in normal mode to prevent cross-talk. The timing generator provides 
clocks and timing signals both for on board use, and for the channel links to drive the rest of Duet. 

Mixer and Output Matrix 
The HD Mixer board will enable routing and mixing of up to four VGE boards in a single Duet chassis. Support 
is provided for two separate graphic “layers”, with each layer consisting of two VGE boards. The mixer can 
also perform dissolves and simple cuts between layers. 

Available choices for Output 1 or Output 2 include: Layer 1, Layer 2 or Layers 1 and 2. 

Setup 
Before using the Duet HD, the High Definition Video I/O parameters must be set.  To access 

1. Open the Windows Start menu, select Settings > Control Panel > Duet Hardware.  The Duet 
Hardware Configuration list opens. 

2. Click on the + next to Duet Hardware, then click on the + next to Video I/O Driver to view the driver 
name for the HD video I/O driver. 

3. Highlight VIDIO0: HD Video I/O Board, then click the settings button at the bottom of the Duet 
Hardware Configuration list.  The High Definition Video I/O Settings dialog box is displayed. 

Note that the HD Video tab of the Duet HD Configuration menu's Duet Hardware Configuration dialog box 
in Lyric has many settings in common with the High Definition Video I/O Settings.  Settings common to both 
can be set in either dialog box, except for Video Standard, which must be set in the High Definition Video 
I/O Settings dialog box below.  This setting is then reflected in the Lyric Duet Hardware Configuration>HD 
Video tab. 

IMPORTANT! 
The High Definition Video I/O Settings determine the configuration of the Duet HD on 
power-up of the Duet system.  The settings in the HD Video tab accessed in Lyric from 
the Configuration menu, however, are user name-specific.  When Lyric is exited, the 
settings in the HD Video tab are stored in the registry.  When Lyric is reopened using the 
same login (user) name, the stored settings for that user name are applied.  If a user logs 
into Windows under a different name, the settings previously stored in the registry under 
the different login name are applied.  The only settings that are always controlled by the 
High Definition Video I/O Settings are the Video Standard and the Field Dominance. 



 Duet HD Hardware Configuration 

 4-5 

 

Duet Hardware Devices:  High Definition Video I/O Settings 
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Set parameters as described in the following table: 

Parameter Description 

Video 
Standard 

Specifies Video Standard for the facility.  Select from the scrollable list: 

 720P / 59.94 Hz 

 1035i / 59.94 Hz * 

 1080i / 59.94 Hz 

 1080sf / 23.98 Hz 

 720P /60  Hz 

 1035i / 60Hz * 

 1080i / 60Hz 

 1080sf / 24 Hz 

 1080i / 50Hz ** 

 

* The 1035i/ standards set the Video I/O board to display the proper 
number of scanlines for that format, but Lyric will continue to work as if 
the system were 1080i/.  About the only visual impact of this is that the 
center page operation may not vertically center the graphics correctly. 

** 1080i / 50 Hz sets the Video I/O board to Genlock and generate the 
1080i / 50 Hz video standard.  As of April 2003, the changes to Lyric 
required to support animations at this frame rate have not been 
implemented. 

Analog 
Output 

Specifies type of analog video applied to the MON 1 and MON 2 outputs. 

Enable Sync:  Select to adds a sync signal to the color outputs. 

 RGB:  Sends RGB output to monitor(s). 

 YUV:  YUV output to monitor(s). 

 MON 1 is the analog monitor output of Duet HD from Video 1.  
MON 2 is the analog monitor output of Duet HD from Video 2. 

These are analog video outputs that allow you to monitor the digital 
video output from Video 1 and Video 2.  They can be connected directly 
to any SVGA monitor that is capable of supporting the required video 
standard.  They can also be connected to an analog HD monitor with a 
standard 15-pin SVGA-to-BNC breakout cable.  

 In general, when using these connections with an HD monitor, 
the selection should be set for YUV with Sync Enabled on the 
video outputs. 

 When used with an SVGA monitor, the selection should be set 
for RGB with sync disabled from the analog outputs.  Most 
SVGA monitors work using the external horizontal and vertical 
sync supplied on the SVGA connector. 
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Parameter Description 

Field 
Dominanc
e 

This setting, which can also be applied to frames, affects only Duet HD 
systems set to an interlace standard of either 1080i (interlaced) or 
1080sf (segmented frame), and which use grouped VGEs to produce 
animations such as Rolls, Crawls, etc.  It specifies which field or frame 
is to be treated as Field/Frame 1 when rendering animations. 

If the appearance of an animation is jagged or has vertical serration, 
switch the Field/Frame Dominance.  This setting has no bearing on 
operation when the Standard is 720p/. 

 If the Standard is 1080i/ or 1035i/, select either Field 1 or Field 
2 from the scrollable list. 

 If the  Standard is 1080sf/, select either Frame 1 or Frame 2 
from the scrollable list. 

Reference 
Select 

Specifies a sync reference.  Select appropriate radio button:  

Locked:  References a tri-level sync source applied to the REF IN BNC 
connector. 

Free Run:  Select if a reference is either unavailable or unnecessary. 

Output 1 In the Output 1 area, select the output of the HD Mixer Board that you 
wish routed to Output 1.  Select Incoming Video if you wish that signal 
routed to Output 1.  If no HD Mixer is installed, the output of VGE 1 or 
VGE 2 may be selected. 

Output 2 In the Output 2 area, select the output of the HD Mixer Board that you 
wish routed to Output 2.  Select Incoming Video if you wish that signal 
routed to Output 2.  If no HD Mixer is installed, the output of VGE 1 or 
VGE 2 may be selected. 

Slot 
Delays 

Slot Delays have no bearing on Duet HD operation. 

Horizontal 
Delay 

The Horizontal Delay control moves the horizontal position of output 
video as much as one-half a scanline earlier or later than incoming 
reference.  Nominal delay of video in to video out is 5 microseconds if 
the reference input is in time with the video input. 

 Click the slide box to display current value.  Click and hold to 
drag slide box to new value.  

 

HD Horizontal Delay 
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Parameter Description 

Vertical 
Delay 

The Vertical Delay control sets the vertical position of output syncs with 
respect to incoming sync sources; the range is -4 scan lines to +3 
scanlines. 

 Click the slide box to display current value.  Click and hold to 
drag slide box to new value.  

 

HD Vertical Delay 

The normal Vertical Delay setting is 4, which corresponds to a 0 
scanline offset, as shown in the following table. 

Value 0 1 2 3 4 5 6 7 

Offset -4 -3 -2 -1 0 1 2 3 
 

Advanced Currently not implemented. 

OK Click OK to accept the settings and close the dialog box. 

Cancel Click Cancel to revert to the settings that were in effect when the dialog 
box was opened.  The dialog box then closes. 
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Duet Hardware Configuration 
Config Menu > Duet Hardware 

Duet Hardware configuration sets video specifications, parameters for external device control via the BVW-
75 protocol and GPIs, as well as Timecode setup.  Note that Device Control, GPI, Timecode and MPx 
configuration procedures are the same for Duet SD and Duet HD.  Timecode and Device Control setup are 
the same for all systems.  Hardware requirements for accepting external Timecode differ between systems. 

 

Duet Hardware Configuration Dialog Box - Duet SD 
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Duet Hardware Configuration Dialog Box - Duet HD 

There are five tabs which contain configuration settings: 
 Video (Duet SD)  or HD Video:  Specifies parameters such as Video Output Standard, Genlock, 

etc. for the selected board. 

 Device Control:  Specifies the configuration information for the optional RS-422 Serial I/O Board & 
GPI/O board, which enables serial control of external devices using the BVW-75 protocol, as well as 
in- and out-bound GPI triggering. 

 GPI:  Specifies how the GPI assignments are set up. 

 Timecode:  Specifies Timecode source and other parameters. 

 MPx:  Specifies the allocation of VGEs in Duet SD and HD.  For example, in multi-VGE systems, two 
VGEs may be paired for enhanced processing power in rendering complex animations.  

Note that if the optional RS-422 Serial I/O Board & GPI/O and its driver are not installed in the system, the 
Device  and GPI tabs are not accessible, and are grayed out.  For information on Device configuration, refer 
to Duet Hardware Configuration - Device Control. 
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HD Video 
Config Menu > Duet Hardware > HD Video 

The HD Video tab of the Duet Hardware Configuration dialog box has many settings in common with the 
High Definition Video I/O Settings set in Control Panel>Duet Hardware.  Settings common to both can be 
set in either dialog box, except for Video Standard, which must be set in the High Definition Video I/O 
Settings dialog box.  This setting is then reflected in the HD Video tab. 

IMPORTANT! 
The High Definition Video I/O Settings set in the Control Panel determine the 
configuration of the Duet HD on power-up of the Duet system.  The settings in the HD 
Video tab accessed in Lyric from the Configuration menu, however, are user name-
specific.  When Lyric is exited, the settings in the HD Video tab are stored in the registry.  
When Lyric is reopened using the same login (user) name, the stored settings for that 
user name are applied.  If a user logs into Windows under a different name, the settings 
previously stored in the registry under the different login name are applied.  The only 
settings that are always controlled by the High Definition Video I/O Settings are the Video 
Standard and the Field Dominance. 

 

Duet Hardware Configuration - HD Video 
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Parameter Description 

Video 
Standard 

Specifies Video Standard.  This must be set in the High Definition 
Video I/O Settings dialog box, accessed from Control Panel > Duet 
Hardware. 

 720P / 59.94 Hz 

 1035i / 59.94 Hz * 

 1080i / 59.94 Hz 

 1080sf / 23.98 Hz 

 720P /60  Hz 

 1035i / 60Hz * 

 1080i / 60Hz 

 1080sf / 24 Hz 

 1080i / 50Hz ** 

 

* The 1035i/ standards set the Video I/O board to display the proper 
number of scanlines for that format, but Lyric will continue to work as if 
the system were 1080i/.  About the only visual impact of this is that the 
center page operation may not vertically center the graphics correctly. 

** 1080i / 50 Hz sets the Video I/O board to Genlock and generate the 
1080i / 50 Hz video standard.  As of April 2003, the changes to Lyric 
required to support animations at this frame rate have not been 
implemented. 

Analog 
Output 

Specifies type of analog video applied to the MON 1 and MON 2 outputs. 

Enable Sync:  Select to adds a sync signal to the color outputs. 

 RGB:  Sends RGB output to monitor(s). 

 YUV:  YUV output to monitor(s). 

 MON 1 is the analog monitor output of Duet HD from Video 1.  
MON 2 is the analog monitor output of Duet HD from Video 2. 

These are analog video outputs that allow you to monitor the digital 
video output from Video 1 and Video 2.  They can be connected directly 
to any SVGA monitor that is capable of supporting the required video 
standard.  They can also be connected to an analog HD monitor with a 
standard 15-pin SVGA-to-BNC breakout cable.  

 In general, when using these connections with an HD monitor, 
the selection should be set for YUV with Sync Enabled on the 
video outputs. 

 When used with an SVGA monitor, the selection should be set 
for RGB with sync disabled from the analog outputs.  Most 
SVGA monitors work using the external horizontal and vertical 
sync supplied on the SVGA connector. 

Reference 
Select 

Specifies a sync reference.  Select appropriate radio button:  

Locked:  References a tri-level sync source applied to the REF IN BNC 
connector. 

Free Run:  Select if a reference is either unavailable or unnecessary. 
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Parameter Description 

Output 1 In the Output 1 area, select the output of the HD Mixer Board that you 
wish routed to Output 1.  Select Incoming Video if you wish that signal 
routed to Output 1.  If no HD Mixer is installed, the output of VGE 1 or 
VGE 2 may be selected. 

Output 2 In the Output 2 area, select the output of the HD Mixer Board that you 
wish routed to Output 2.  Select Incoming Video if you wish that signal 
routed to Output 2.  If no HD Mixer is installed, the output of VGE 1 or 
VGE 2 may be selected. 

Horizontal 
Delay 

The Horizontal Delay control moves the horizontal position of output 
video as much as one-half a scanline earlier or later than incoming 
reference.  Nominal delay of video in to video out is 5 microseconds if 
the reference input is in time with the video input. 

 Click the slide box to display current value.  Click and hold to 
drag slide box to new value.  

 

HD Horizontal Delay 

Vertical 
Delay 

The Vertical Delay control sets the vertical position of output syncs with 
respect to incoming sync sources; the range is -4 scan lines to +3 
scanlines. 

 Click the slide box to display current value.  Click and hold to 
drag slide box to new value. 

 

HD Vertical Delay 

The normal Vertical Delay setting is 4, which corresponds to a 0 
scanline offset, as shown in the following table. 

Value 0 1 2 3 4 5 6 7 

Offset -4 -3 -2 -1 0 1 2 3 
 

OK Click OK to accept the settings and close the dialog box. 

Cancel Click Cancel to revert to the settings that were in effect when the dialog 
box was opened.  The dialog box then closes. 
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Configuration for Display of Video Source 
Duet HD:  Config Menu > Duet Hardware > HD Video 
Video from a variety of sources can be incorporated as part of a Lyric composition.  Lyric provides creative 
tools for displaying video, including Masks and application of video to 3D surfaces. 

Video can be displayed as a continuous live or prerecorded source.  In this situation, the video is not a 
component of the Lyric composition itself, in that it is not an object that can be manipulated through Lyric.  It is 
a straight video display, with no set beginning or end controlled through Lyric. 

Playback from a video source is routed through Duet’s internal keyer.  The video is not visible on the Lyric 
Canvas as seen on Duet's SVGA monitor.  Rather, the clip is keyed behind the Lyric composition and is 
visible on the output monitor.  To enable Duet’s internal keyer: 

1. From the Config menu, select Duet Hardware. 

2. Select the HD Video tab, click Keyed for either or both channels, and then click OK.  The figure 
below shows Keyed disabled for Video 1 Out, and Keyed enabled for Video 2 Out. 

 

HD Video Settings for Display of Video 
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Device Control 
Config Menu > Duet Hardware Configuration > Device Control 
Lyric can control or be controlled by external devices such as videotape tape recorders (VTRs), digital disk 
recorders (DDRs) and switchers by using GPIs (General Purpose Interface triggers) or by the BVW-75 
Serial Digital Protocol via the RS-422 Serial Digital Interface. 

Such control inputs to Duet from external sources can start and stop Clocks and Timers, execute an 
individual step within a Lyric Playlist or release a programmed Pause.  GPI control outputs from Duet can be 
used to trigger external devices such as keyers and tally lights.  Refer to GPIs - Overview for comprehensive 
information on GPI setup. 

The most common use of the BVW-75 protocol/RS-422 connection is for cueing and playback of video from 
the Clip Control Panel.  In addition, segments of existing video on external playback devices can be defined, 
saved and played back as Clips either on their own, or as components of a Lyric message. 

NOTE 
To enable BVW-75 via RS-422 (all systems) capability or GPI (Duet SD/HD) capability, the 
Chyron's optional RS-422 Serial I/O & GPI/O Board and must be installed in the Duet 
SD/HD system.  This board is not necessary for GPI function on Duet LE/LEX/PCI/PCI+, 
but is necessary for BVW-75/RS-422 communication.  Call Chyron Customer Service at 
845-2132 for information about this product.  Refer to RS-422 Serial I/O & GPI/O Board for 
details on installation and setup. 

 While each type of system displays its own set of system-specific tabs in Duet 
Configuration, the Device tab on all systems is the same. 

 If this board is not present in a Duet SD/HD system, the Device and GPI tabs are 
grayed out. 
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The following example shows configuration on a Duet SD of serial device control of a Sierra DDR, using the 
BVW-75 protocol.  

1. Be sure that the external DDR or VTR is properly connected to the Duet system.  For additional 
information on connection, refer to the Duet Hardware Reference Manual. 

2. From the Config menu, select Duet Hardware.  The Duet Hardware Configuration tabs are 
displayed.  Click the Device Control tab to display the Device Control settings. 

 

Duet Configuration - Sony® BVW-75 Protocol 

3. From the Port drop-down list box, select the number (1 - 4) of the port on the Chyron RS-422 Serial 
I/O & GPI/O Board that is to be connected to the external device. 

4. In the Description field, enter a description of the device.  When the external device is selected in the 
Clip Control Panel Playback Device drop-down list box, this description is reflected in the Playback 
Device field.  Refer to Clip Control Panel for additional information on clip operations. 

5. Select (check) the Port Allocated checkbox.  If this checkbox is not enabled, the device is not 
recognized by the Clip Control Panel, and therefore cannot be accessed for clip creation. 

6. The Protocol drop-down list box defaults to the BVW-75 protocol, using an RS-422 connection.  
BVW-75 is the currently the only protocol supported by Lyric.  Lyric detects connected machines that 
use BVW-75 protocol, and then automatically sets the Port Configuration values for Baud Rate, 
Data Bits, Stop Bits and Parity.  The Master radio button is always selected.  The Slave function is 
not implemented at this time.  

7. Enter a Pre-Roll Time, in frames, for the VTR that is connected.  Pre-Roll for a DDR is 0.  
Remember that this adjustment is in Frames. 

8. Click OK.  Device Control is now set up for the DDR. 
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GPI 
Config Menu > Duet Hardware > GPI 
Overview 
Lyric can control or be controlled by external devices such as tape machines, digital disk recorders (DDRs) 
and switchers by using GPIs (General Purpose Interface triggers) or by the BVW Serial Digital Protocol 
via the RS-422 Serial Digital Interface.  Such control inputs to Duet from external sources can start and stop 
Clocks and Timers, execute an individual step within a Lyric Playlist or release a programmed Pause.  In 
addition, GPI control outputs from Duet can be used to trigger external devices such as keyers and tally lights. 

NOTE 
To enable GPI and/or RS-422 capability, the Chyron's optional RS-422 Serial I/O & GPI/O 
Board must be installed in the Duet SD/HD system.  Call Chyron Customer Service at 
845-2132 for information about this product.  Refer to RS-422 Serial I/O & GPI/O Board for 
details on installation and setup.  If this board is not present in the system, the GPI and 
Device tabs are grayed out. 

Setup 
To access GPI setup: 

 From the Config menu, select Duet Hardware, then click the GPI tab.  The following two figures 
show sample GPI INPUT and GPI OUTPUT settings. 

 

Duet Configuration - Setting GPI INPUT 
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Setting GPI OUTPUT 

The following parameters should be set to enable GPI capability: 

Item  Description 

GPI  GPI designates which is assigned to a specific event.  The number 
of GPIs available depends on the number of RS-422 Serial I/O & 
GPI/O Boards installed in the system.  In the GPI dropdown list 
box, default GPIs 1 - 8 for the first installed RS-422 Serial I/O & 
GPI/O Board; 9 - 16 for the second board; 17 - 24 for the third 
board, and 25 - 32 for the fourth board.  Click on the up or down 
arrow spin control box to set. 

If multiple RS-422 Serial I/O & GPI/O boards are installed in the 
system, then the DIP switches must be correctly set in order to 
ensure availability of all GPIs. 

Description  A descriptive name can be assigned to the GPI in the Description 
field to make it easier to identify. 

GPI 
Allocated  

The GPI Allocated checkbox must be checked to enable GPI 
control. 

Direction  The Direction setting determines whether the designated port is to 
receive the incoming pulse (INPUT) or send an outgoing pulse 
(OUTPUT). 

Active 
Level  

The Active Level setting determines whether a voltage change in 
the GPI signal low to high (HIGH) or from high to low (LOW) is to be 
recognized as the trigger. 

Pulse 
Width  

Pulse Width defines the minimum duration of the GPI pulse in 
milliseconds.  This should be set to ignore a short accidental contact 
with a physical GPI button or a slight signal anomaly which could 
unintentionally trigger the GPI. 
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NOTE 
When a GPI assigned to a specific event, such as to trigger a Playlist step or trigger a 
Squeezeback Effect, make sure that the same GPI is not also assigned as a Global GPI, 
as there may be a conflict when the GPI or Global GPI is triggered.  Refer to GPIs and 
Global GPIs for additional information.  Refer to Chapter 6 - GPIs and Global GPIs for 
additional information. 

Test Messages 

 

Cannot Test for Input - GPI Not Enabled 

 

GPI Enabled and Assigned 

 

GPI Enabled - Waiting for Input 
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Timecode 
Config Menu > Duet Hardware > Timecode 

Timecode parameters can now be set for all Duet systems in the Config Menu > Duet Hardware > 
Timecode tab, as shown below. 

 

Time Code Configuration 
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System Timecode is set either internally or via an externally generated signal. 

Internal:   Internal Timecode is synchronized with the Windows time clock.  To update the synchronization 
between Duet's Timecode facility and the Duet's PC system clock, click Sync. 

External:  Externally generated timecode is fed to the Duet system.  The timecode can be either Drop Frame 
or Non-Drop Frame.  Check the Drop Frame checkbox to enable Drop Frame timecode; uncheck the Drop 
Frame checkbox to use Non-Drop Frame timecode.  Duet SD/HD and Duet LE/LEX/PCI/PCI+ systems have 
different external timecode connections. 

 Duet SD/HD:  Connect the external timecode generator to the LTC IN (Longitudinal Timecode In) 9-
pin jack on the Video I/O board. 

 Duet LE/LEX/PCI/PCI+:  An optional PCI-LTC board from Adrienne Electronics must be installed to 
enable external timecode sync.  Connect the external timecode generator to the LTC IN three-pin 
mini-XLR jack on the PCI-LTC board.  Contact Chyron Customer Service at 1-631-845-2000 for 
information on obtaining the PCI-LTC board. 



Lyric User Guide 

 4-22 

MPx 
Config Menu > Duet Hardware > MPx 
This panel controls the allocation of VGEs in Duet SD and HD.  In multi-VGE systems, two VGEs may be 
paired for enhanced processing power in rendering complex animations on one of the system's outputs.  

These controls also allow the operator to assign a specific VGE to the incidence of Lyric in which this panel is 
opened. (VGEs may be assigned to other copies of the Lyric program currently running or to other 
applications such as CAL.)  

If a VGE board is Locked, Lyric has use of the frame buffer(s) on that board, excluding other applications 
such as CAL. An error will be generated by the CAL server if the client application tries to connect to that 
channel. If a VGE board is In Use, another application (e. g. CAL client) has connected to that board and has 
locked it for exclusive use. The Frame Buffer’s settings are written to the registry on exit from Lyric. 

In Figure 1 below, VGE 1 is assigned to the current incidence of Lyric (this was accomplished by clicking the 
Locked checkbox). VGE 2 is being used by another application, as shown by the In Use status indicator. No 
additional VGEs are installed, as shown by the Not Installed status indicators. 

 

Duet VGEs Allocated on the MPx Tab 



 Duet HD Hardware Configuration 

 4-23 

To group 2 VGEs together for enhanced animation processing power:  
1. Uses the standard Windows Shift + Click method to select them both. Click the Locked checkbox, as 

shown, and then click the Group button on the right. 

 

Selecting Two VGEs to Group Together 

2. Press OK to make the change effective. The change will take a moment, during which time you may 

see a  Wait  cursor. When Duet has completed the operation, one of the Frame Buffer 

 buttons will disappear (leaving something like  on the Duet toolbar). The 
remaining button symbolizes the two VGEs grouped together as a single Frame Buffer. Two VGEs 
grouped together look like this on the MPx panel: 

 

Two VGEs Grouped Together 
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To ungroup VGEs: 
1. Select one of the VGEs on the menu, as seen below. 

 

Ungrouping VGEs 

2. Press Ungroup. Note that this action also un-assigns both VGEs from Lyric; when VGE #2's 
checkbox becomes visible again, both checkboxes will be "unchecked". Therefore... 

3. ...You must re-assign the VGE (or VGEs) that you wish to use with Lyric by clicking the Locked 
checkbox(es). 

4. Click OK to put the changes into effect. 
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Duet HD Dual Board Operations 
Duet’s Dual-Channel option allows the dedication of one Video Graphics Engine (VGE) to each of two output 
channels.  The Duet HD Mixer can mix the outputs of two VGEs simultaneously to a single Mixer output. 

Complete information on installation and software setup for Lyric control of multiple VGE boards can be found 
in the Duet Hardware Reference Guide.  To set up the Dual-Channel option: 

1. Select Duet Hardware from the Config menu. 

2. The Duet Configuration dialog box opens.  The HD Video tab should be displayed.  Is it is not, click 
the HD Video tab. 

 

Duet Hardware Configuration - HD Video 

3. Set the controls appropriately for your facility’s needs.  Refer to the section on HD Video for details 
on setup. 

 The Video Standard area automatically displays Duet’s current output format. See Section 5 
in the Duet Hardware Reference Guide for more information on setting the output video 
standard. 

 Reference Select: The only valid external reference for Duet HD is an appropriate tri-level 
sync source applied to the REF IN BNC connector. If such a reference source is unavailable 
or not needed, set the radio button to Free Run. 

 Analog Output: Use these radio buttons to select the type of output you wish to send to your 
system’s SVGA monitor(s). The Enable Sync button adds a sync signal to the color outputs. 
MON 1 is the analog monitor output of the Duet HD video being applied to the Video 1 output. 
MON 2 is the analog monitor output of the Duet HD video being applied to the Video 2 output. 

These are analog video outputs that allow the operator to monitor the Digital Video outputs from Video 1 and 
Video 2. They can be connected directly to any SVGA monitor that is capable of supporting the required video 
standard. They can also be connected to an analog HD monitor with a standard 15-pin SVGO to BNC 
breakout cable. 

In general, when using these connections with an HD monitor, the selection should be set for YUV with sync 
enabled on the video outputs. When used with an SVGA monitor, the selection should be set for RGB with 
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sync disabled from the analog outputs. Most SVGA monitors do not work with tri-level sync and work better 
using the external horizontal and vertical sync supplied on the SVGA connector. 

 Horizontal Output Position: The nominal delay of video in to video out is 5 microseconds if the 
reference input is in time with the video input. This control moves the horizontal position of 
output sync as much as ½ scan line earlier or later than incoming reference. 

 Vertical Output Position: Sets the vertical position of output syncs with respect to incoming 
sync sources; the range is -4 scan lines to +3 scanlines. 
  

2. Click on the MPx tab (see the illustration below). Confirm that Lyric is detecting all installed VGE 
boards; you should be able to click their Locked checkboxes. 

The In Use buttons are status indicators. 

 

Duet VGEs Allocated on the MPx Tab 

The Not Installed column indicates the status of the remaining slot positions. 
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5. Duet LE/LEX/PCI/PCI+ Hardware Configuration 

Cabling Options - Duet LE/LEX/PCI/PCI+ 

Introduction 
Different effects can be produced by connecting Duet LE/LEX/PCI/PCI+’s Video Processor and Squeezeback 
Boards in different orders.  

Three different cabling configurations are presented, each resulting in a different set of visual display 
priorities. 
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VPB and Internal Clip Player 
This configuration can reproduce character generator text over a keyed clip background. In this configuration, 
the Duet LE/LEX/PCI/PCI+ system is placed upstream of the switcher. There is no Program In; Video Out and 
Key Out are fed to the switcher. An analog Genlock signal is fed to the Internal Clip Player's gray color-coded 
Ref In connector. The Genlock signal is then looped from the Internal Clip Player's black color-coded Ref 
Loop Out connector on the VPB. 
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Duet LE/LEX/PCI/PCI+ - VPB and Internal Clip Player 
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VPB, PCI-Squeezeback and Internal Clip Player - Clip as Background Video 
This configuration can place Program video and a video clip in two separate, “squeezable” windows, over full-
screen CG text and a Background. In this configuration, the Duet LE/LEX/PCI/PCI+ system is placed 
downstream of the switcher. An analog Genlock signal is fed to the Internal Clip Player's gray color-coded Ref 
In connector. The Genlock signal is then looped from the Internal Clip Player's black color-coded Ref Loop 
Out connector to the Ref In connector on the VPB. This configuration also requires that the 3 x 2 box header 
on top of the VPB be connected by an internal analog sync jumper cable to the 3 x 2 box header on top of the 
PCI Squeezeback Board. 
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Duet LE/LEX/PCI/PCI+ - VPB, PCI-Squeezeback and Internal Clip Player - Clip as 
Background Video 
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VPB, PCI-Squeezeback and Internal Clip Player - Clip in Squeezeback Window 
This configuration can place CG text over Squeezeback-treated Program video, and both over a full-screen 
clip Background. In this configuration, the Duet LE/LEX/PCI/PCI+ system is placed downstream of the 
switcher. An analog Genlock signal is fed to the Internal Clip Player's gray color-coded Ref In connector. The 
Genlock signal is then looped from the Internal Clip Player black color-coded Ref Loop Out connector to the 
Ref In connector on the VPB. This configuration also requires that the 3 x 2 box header on top of the VPB be 
connected by an internal analog sync jumper cable to the 3 x 2 box header on top of the PCI Squeezeback 
Board. 
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Duet LE/LEX/PCI/PCI+ - VPB, PCI-Squeezeback and Internal Clip Player - 
Clip in Squeezeback Window 



Lyric User Guide 

 5-8 

Duet LE/LEX/PCI/PCI+ Hardware Configuration 
Config Menu > Duet Hardware 

Duet Hardware Configuration is the setup facility for Duet systems.  It encompasses functions such as 
VPB/PCI+ Squeezeback board allocations, GPI, Video Standard, Timecode, and much more.  When Duet 
Hardware Configuration is selected from the Config menu, a set of configuration tabs is displayed for the 
system on which Lyric is installed. 

To access these settings: 
 Select Duet Hardware from the Config menu.  The Duet Hardware Configuration dialog box is 

displayed. 

 

Duet Hardware Configuration Dialog Box 

There are four tabs, plus one optional tab, which contain configuration settings: 
 Configure Board Use:  Specifies how boards are used. 

 Setup Board Configuration:  Specifies parameters such as Video Output Standard, Genlock, etc. 
for the selected board. 

 Setup GPI:  Specifies how the GPI assignments are set up. 

 Timecode:  Specifies Timecode source and other parameters. 

 Device Control:  If the optional RS-422 Serial I/O Board and its driver are installed in the system, a 
Device Control tab, specifying the configuration of the board, is displayed as well.  The RS-422 
Serial I/O Board enables serial control of external devices using the BVW-75 protocol. 
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Configure Board Use 
Config Menu > Duet Hardware > Configure Board Use 

The Configure Board Use tab controls the routing of the Duet LE/LEX/PCI/PCI+ VPBs and PCI-
Squeezeback boards.  To access these settings: 

 Select Duet Hardware from the Config menu.  The Duet Hardware Configuration > Configure 
Board Use tab (shown below) is displayed.  It indicates that there are three boards in the system. 

 

Duet Hardware Configuration Dialog Box 
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Each of the boards in the systems can be assigned as Unused, to Air, to Preview or Linked. 

Parameter Description 

Unused NOTE 
For this version of Lyric, if the system contains 
one or more PCI-Squeezeback boards, do not set 
any of the boards in the system to Unused. All 
VPBs and PCI-Squeezeback boards should be 
active. 

The Unused radio button inactivates the board for use by Lyric. 

Air Channel Air Channel designates the board as the main output to the facility’s 
Master Control or production switcher.  Where multiple VPBs and/or 
PCI-Squeezeback boards are installed in Duet LE/LEX/PCI/PCI+, 
any or all of the boards may be designated as Air Channel. 

Each board has only one broadcast-quality digital output, and if 
more than one board is present, these outputs function 
independently.  They can, however, be Genlocked. See Analog 
and Digital Genlock for Genlock information. 

Preview 
Channel 

Preview Channel holds the message that is next in line in a Read 
Next or Read Previous operation.  For additional information, refer 
to Read Next/Read Previous operations. 

Link Link provides the ability to link multiple boards for linked operation.  
This requires that the Video output, and if available, the Key output 
of one VPB or PCI-Squeezeback board are connected via BNC 
cables to the Video input, and if available, the Key input of the next 
board, and so on until all boards are connected. The last board in 
the linkage provides the Video Out and Key Out.  Linking boards 
allows the execution of complex, simultaneous, multi-layered effects 
that would not be not be possible using a single board. 
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Setup Board Configuration 
Config Menu > Duet Hardware > Setup Board Configuration 

Overview 
In the Setup Board Configuration tab (see below), each board can be independently set for a variety of 
parameters such as Genlock source and Key/Video signal characteristics.  Depending on the type of board 
that is selected, some parameters may be unavailable (grayed out). 

NOTE 
As of Lyric v5.0, the Video setting has been removed.  Video Insert is now always active.  
To "disable" the VPB graphics from output, simply clear the frame buffer. 

 

Setup Board Configuration 
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Setup Board Configuration Parameters 
Parameters and Board Types 
The following table provides a breakdown of the parameters that are available to each type of board. 

Parameter Lantern 32/64 Lantern 64-A PCI-Squeezeback 

Selected Board Yes Yes Yes 

Video Output 
Standard 

Yes Yes Yes 

     NTSC Yes Yes Yes 

     PAL Yes Yes Yes 

Genlock See Below See Below See Below 

     Ref In (Analog) Yes Yes Yes 

     Video In (Digital) Yes No Yes 

     Video In (Analog) No Yes No 

     Free Run No Yes No 

     Auto No Yes No 

Video In Layer Yes No No 

Shape Video In Yes Yes No 

Key Input Yes Yes No 

Ancillary Data 
Pass Thru 

Yes No Yes 

Ancillary Reset Line Yes No Yes 

Vertical Video Adjust Yes No Yes 

Horizontal Video 
Adjust 

Yes No Yes 

Background Line Yes Yes No 

Color Phase No Yes No 

Invert (PAL) - 
PAL Systems Only 

No  Yes No 

Selected Board 
Available on All Boards 
The Selected Board area lists the available boards by Type and Version.  L64 indicates a Lantern 64 digital 
board; L64-A indicates a Lantern 64 analog board, L32 (not shown) indicates a Lantern 32 digital board, and 
SQZ indicates a PCI-Squeezeback digital board.  The Version refers to the version of the *.out file, which is 
the real-time operating system that runs on the board.  This file is found in the Lyric installation directory, and 
can have a name such as DuetLE64.out, DuetLE64A.out, DuetLE.out or pcCODISqzLE.out. 

When the radio button for a board is selected, the parameters for the selected board are displayed and can 
be modified. 
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Video Output Standard 
Available on All Boards 
From the Video Output Standard drop-down list box, NTSC or PAL can be selected.  A system cannot 
contain a board(s) set to NTSC, and another board(s) set to PAL.  Selecting a Video Output Standard 
applies the selection to all boards in the system. 

Genlock, Auto 
Available on All Boards 

Ref In, Video In or Free Run Genlock can be set as follows:  
 Ref In (Analog) - Lantern 32/64, PCI-Squeezeback:  Genlock is supplied by an external analog 

Genlock reference. 

 Ref In (Analog) - Lantern 64-A:  Genlock is supplied by an external analog Genlock reference.  If 
Auto is enabled (checked), and then the external reference is removed, the board automatically 
switches to an internally generated Free Run Genlock only if Auto is enabled (checked). 

 Video In (Digital) - Lantern 32/64, PCI-Squeezeback:  Genlock is supplied from a digital video 
input.  Note that on a PCI-Squeezeback board, the digital video signal to be used as the Genlock 
signal is fed through the BACKGROUND IN connector.  See Genlocking PCI-Squeezeback Boards 
for additional information. 

 Video In (Analog) - Lantern 64-A:  Genlock is supplied by an analog video input. If Auto is enabled, 
and then the external reference is removed, the board automatically switches to an internally 
generated Free Run Genlock only if Auto is enabled (checked). 

 Free Run - Lantern 64-A:  Genlock is internally generated. 

Video In Layer 
Available on Lantern 32/64, Lantern 64-A*, PCI-Squeezeback 

In the Video Layer radio button group: 
 Select On to keep the program Video Layer on. 

 Select Off to generate a black background. 

NOTE 
On a PCI-Squeezeback board, Video layer display ON/OFF and display priority are 
controllable from the Squeezeback Panel dialog boxes (ON and A Over B, B Over A) or 
the Squeezeback Designer (START/END) dialog box (Video A/B Mixer). The Configuration 
Video Layer In setting is ignored by the PCI-Squeezeback board settings. 

Note that if Video In Layer is set to Off on a PCI-Squeezeback board, and then turned On 
in the Squeezeback Panel, the Video In Layer retains its Off setting in operations outside 
of the current Squeezeback message, and vice versa.  

*Duet LEX/PCI+ Systems Only:  The Video In layer cannot be turned off on a Lantern 64-A board. 

Shape Video In 
Available on Lantern 32/64, Lantern 64-A 

In the Shape Video In radio button group: 
 Select On to attenuate Input Video to the Key signal, so that color components do not exceed the 

key level. 

 Select Off to leave the signal unattenuated. 
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Key Input 
Available on Lantern 32/64, Lantern 64-A 

In the Key In radio button group: 
 Select On to enable the board to use the video input’s accompanying alpha signal when Key In is 

supplied from a cable connected to the board.  Key In must be set to On when the board is used in 
conjunction with a CMix SD/HD. 

 Select Off to set the board to ignore the alpha information. Note that if a signal is present and Key In 
turned off, the system behaves as if a full white background is present at the Key Input. 

Ancillary Data Pass Thru, Ancillary Reset Line 
Available on Lantern 32/64, Lantern 64-A**, PCI-Squeezeback 

When Ancillary Data Pass Thru is enabled, all ancillary data, including Closed Captioning, passes through 
the Keyer unaffected.  This means that no Duet video is inserted into the first displayed scanline of each field, 
in order to preserve the Closed Captioning or other ancillary data.  The Ancillary Reset Line, also known 
as the Blank Line or Vertical Reset, is normally Line 10 or NTSC, and Line 6 for PAL.  A different line, 
however, can be selected for non-standard video formats. 

In the Ancillary Data radio button group: 
 Select On to pass through ancillary data carried on the Video In blanking interval and insert it into the 

Video Out blanking interval. 

 Select Off to ignore ancillary data.  Additionally, select Off if Ancillary Data is not in the video 
stream. 

Ancillary Reset Line Range:  6 - 12 

**Duet LEX/PCI+ Systems Only:  Ancillary Data settings do not apply to a Lantern 64-A board. 

Vertical Video Adjust, Horizontal Video Adjust 
Available on Lantern 32/64, Lantern 64-A***, PCI-Squeezeback 

Vertical Video Adjust and Horizontal Video Adjust set the Vertical and Horizontal delays with respect to 
an incoming video reference in order to synchronize the outputs of multiple VPBs and PCI-Squeezeback 
boards.  

 To set Vertical Video Adjust and Horizontal Video Adjust settings, click the up or down arrow in 
the respective spin control box. 

Vertical Video Adjust Range:  0 - 7 

Horizontal Video Adjust Range:  -511 - +511 

***Duet LEX/PCI+ Systems Only:  Vertical and Horizontal Video settings cannot be delayed on a Lantern 
64-A board.  
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Background Line 
Available on Lantern 32/64, Lantern 64-A 

NOTE 
Background Scanline Control is not available on a PCI-Squeezeback board, as there is no 
Background graphic layer in the board. 

The Background Scanline Control is used to align the graphic layers present in each LE/LEX/PCI/PCI+ 
VPB. Normally, this control is set at 23 for PAL systems, and 20 for NTSC systems. The Background 
Scanline can be set using one of the following methods: 

 Click on the up or down arrow in the spin control box to display the desired setting. 

OR 

 Click the Wizard button to open the Background Scanline Adjustment Wizard dialog box 
(see below). Click the up or down arrow in the spin control box to adjust the value until the red line is 
hidden by the white line on the system’s video output, AND then click OK to close the dialog box. 

 

Background Scanline Adjustment Wizard 

Background Line Range:  0 - 63 

Color Phase 
Available on Lantern 64-A 
Subcarrier (S/C-PHASE) or color phase adjustment is required to match the color phase of the Lantern 64-A 
signal to that of the incoming video signal.  As viewed on a vector scope, adjusting the subcarrier phase 
rotates the encoded Lantern-64 color vectors about a 360° circle so that the color vectors match the color 
phase of the video input signal. 

Color Phase Range:  0 - 255 (corresponds to HSB/HSV values) 

Invert (PAL) 
Available on Lantern 64-A 
PAL Systems Only:   If the color is 180° out of phase, select (check) Invert (PAL) to correct the color.  To 
make a finer color adjustment, modify the Color Phase setting.  Note that it may be necessary to reselect 
Invert (PAL) each time the system is restarted. 
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Configuration for Display of Video Source 
Duet LE/LEX/PCI/PCI+:  Config Menu > Duet Hardware > Setup Board Configuration 
Video from a variety of sources can be incorporated as part of a Lyric composition.  Lyric provides creative 
tools for displaying video, including Masks, Video Squeezeback (LE/LEX/PCI/PCI+) and application of video 
to 3D surfaces. 

Video can be displayed as a continuous live or prerecorded source.  In this situation, the video is not a 
component of the Lyric composition itself, in that it is not an object that can be manipulated through Lyric.  It is 
a straight video display, with no set beginning or end controlled through Lyric. 

Video can also be displayed as a clip, where playback parameters are controlled either directly from Lyric's 
Clip Control Panel, or where the playback parameters are set up from the Clip Control Panel, but the clip 
itself is an object in a Lyric animation and is played back as part of the Lyric animation.  The Clip Control 
Panel provides the ability to play back video or audio clips files (*.ccf).  Lyric does not perform actual edits on 
the recorded content of the source material.  The Clip File contains the In and Out point information that 
defines the duration of the clip for playback, however, the source video/audio remains unchanged.  In order to 
play back the video/audio, the original material and the playback device must be available.  Clip files can be 
created from sources such as an External VTR or DDR (Digital Disk Recorder), a Chyron Aprisa DDR, 
Duet’s Internal Clip Player, or Audio files processed through audio hardware in Duet. 

Playback from a video source is routed through Duet’s internal keyer.  The video is not visible on the Lyric 
Canvas as seen on Duet's SVGA monitor.  Rather, the clip is keyed behind the Lyric composition and is 
visible on the output monitor. 

Previous to Lyric v5.0, it was necessary to select Video Insert in the Video setting in the Setup Board 
Configuration dialog box in order to display a video source.  As of Lyric v5.0, the Video setting has been 
removed.  Video Insert is now always active.  As a result, special configuration is no longer required for 
display of a video source. 
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Setup GPI 
Config Menu > Duet Hardware > Setup GPI 

Lyric can control or be controlled by external devices such as tape machines, digital disk recorders (DDRs) 
and switchers by using GPIs (General Purpose Interface triggers) or by the BVW Serial Digital Protocol 
via the RS-422 Serial Digital Interface.  Such control inputs to Duet from external sources can start and stop 
Clocks and Timers, execute an individual step within a Lyric Playlist or release a programmed Pause.  In 
addition, GPI control outputs from Duet can be used to trigger external devices such as keyers and tally lights. 
Each Duet LE/LEX/PCI/PCI+ VPB includes a facility for 16 GPI (General Purpose Interface) connections per 
video channel.  

NOTES 
The Setup GPI facility in the Duet LE/LEX/PCI/PCI+ is not available to PCI-Squeezeback 
boards, however, GPIs set up from other boards can be used to trigger Squeezeback 
effects.  Additionally, the SQZ Kwik Tool must be enabled in order that the GPIs trigger 
Squeezeback effects.  Refer the section on Squeezeback Panel for information. 

After parameters are set, Lyric must be closed and relaunched in order to apply GPI 
settings. 

To perform GPI setup: 
 From the Configuration menu, select Duet Hardware, then click the Setup GPI tab. 

 

Setup GPI 
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The following parameters should be set to enable GPI capability: 

Parameter Description 

GPI GPI designates which is assigned to a specific event.  The 
number of available GPIs depends on the number of VPBs 
installed in the system.  In the GPI dropdown list box, default 
GPIs 1 - 16 represent those available from Board #1, 17 - 32 
from Board #2, and so on.  Click on the up or down arrow spin 
control box to set. 

Description A descriptive name must be entered in the Description field for 
the GPI to function. 

GPI Allocated The GPI Allocated checkbox must be checked to enable GPI 
control. 

Direction The Direction setting determines whether the designated port is 
to receive the incoming pulse (INPUT) or send an outgoing pulse 
(OUTPUT). 

Active Level The Active Level setting determines whether a voltage change 
in the GPI signal low to high (HIGH) or from high to low (LOW) is 
to be recognized as the trigger. 

Pulse Width 
(ms) 

Pulse Width defines the minimum duration of the GPI pulse in 
milliseconds.  This should be set to ignore a short accidental 
contact with a physical GPI button or a slight signal anomaly 
which could unintentionally trigger the GPI. 

From Board From Board specifies which Duet LE/LEX/PCI/PCI+ board 
originates or receives the GPI pulse.  Click on the up or down 
arrow in the From Board spin control box to set. 

GPIO Number GPIO Number specifies the pin combination to be used on the 
Duet LE/LEX/PCI/PCI+ board’s GPI/O “D” connector.  The valid 
range for this value is 1 - 16. Click on the up or down arrow in the 
GPIO Number spin control box to set.  

After setting GPI parameters, click OK, then exit and relaunch Lyric. 

NOTE 
When a GPI assigned to a specific event, such as to trigger a Playlist step or trigger a 
Squeezeback Effect, make sure that the same GPI is not also assigned as a Global GPI, 
as there may be a conflict when the GPI or Global GPI is triggered.  Refer to GPIs and 
Global GPIs for additional information.  Refer to Chapter 6 - GPIs and Global GPIs for 
additional information. 
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Timecode 
Config Menu > Duet Hardware > Timecode 

Timecode parameters can now be set for all Duet systems in the Config Menu > Duet Hardware > 
Timecode tab, as shown below. 

 

Time Code Configuration 
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System Timecode is set either internally or via an externally generated signal. 

Internal:   Internal Timecode is synchronized with the Windows time clock.  To update the synchronization 
between Duet's Timecode facility and the Duet's PC system clock, click Sync. 

External:  Externally generated timecode is fed to the Duet system.  The timecode can be either Drop Frame 
or Non-Drop Frame.  Check the Drop Frame checkbox to enable Drop Frame timecode; uncheck the Drop 
Frame checkbox to use Non-Drop Frame timecode.  Duet SD/HD and Duet LE/LEX/PCI/PCI+ systems have 
different external timecode connections. 

 Duet SD/HD:  Connect the external timecode generator to the LTC IN (Longitudinal Timecode In) 9-
pin jack on the Video I/O board. 

 Duet LE/LEX/PCI/PCI+:  An optional PCI-LTC board from Adrienne Electronics must be installed to 
enable external timecode sync.  Connect the external timecode generator to the LTC IN three-pin 
mini-XLR jack on the PCI-LTC board.  Contact Chyron Customer Service at 1-631-845-2000 for 
information on obtaining the PCI-LTC board. 
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Device Control 
Config Menu > Duet Hardware Configuration > Device Control 
Lyric can control or be controlled by external devices such as videotape tape recorders (VTRs), digital disk 
recorders (DDRs) and switchers by using GPIs (General Purpose Interface triggers) or by the BVW-75 
Serial Digital Protocol via the RS-422 Serial Digital Interface. 

Such control inputs to Duet from external sources can start and stop Clocks and Timers, execute an 
individual step within a Lyric Playlist or release a programmed Pause.  GPI control outputs from Duet can be 
used to trigger external devices such as keyers and tally lights.  Refer to GPIs - Overview for comprehensive 
information on GPI setup. 

The most common use of the BVW-75 protocol/RS-422 connection is for cueing and playback of video from 
the Clip Control Panel.  In addition, segments of existing video on external playback devices can be defined, 
saved and played back as Clips either on their own, or as components of a Lyric message. 

NOTE 
To enable BVW-75 via RS-422 (all systems) capability or GPI (Duet SD/HD) capability, the 
Chyron's optional RS-422 Serial I/O & GPI/O Board and must be installed in the Duet 
SD/HD system.  This board is not necessary for GPI function on Duet LE/LEX/PCI/PCI+, 
but is necessary for BVW-75/RS-422 communication.  Call Chyron Customer Service at 
845-2132 for information about this product.  Refer to RS-422 Serial I/O & GPI/O Board for 
details on installation and setup. 

 While each type of system displays its own set of system-specific tabs in Duet 
Configuration, the Device tab on all systems is the same. 

 If this board is not present in a Duet SD/HD system, the Device and GPI tabs are 
grayed out. 
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The following example shows configuration on a Duet SD of serial device control of a Sierra DDR, using the 
BVW-75 protocol.  

1. Be sure that the external DDR or VTR is properly connected to the Duet system.  For additional 
information on connection, refer to the Duet Hardware Reference Manual. 

2. From the Config menu, select Duet Hardware.  The Duet Hardware Configuration tabs are 
displayed.  Click the Device Control tab to display the Device Control settings. 

 

Duet Configuration - Sony® BVW-75 Protocol 

3. From the Port drop-down list box, select the number (1 - 4) of the port on the Chyron RS-422 Serial 
I/O & GPI/O Board that is to be connected to the external device. 

4. In the Description field, enter a description of the device.  When the external device is selected in the 
Clip Control Panel Playback Device drop-down list box, this description is reflected in the Playback 
Device field.  Refer to Clip Control Panel for additional information on clip operations. 

5. Select (check) the Port Allocated checkbox.  If this checkbox is not enabled, the device is not 
recognized by the Clip Control Panel, and therefore cannot be accessed for clip creation. 

6. The Protocol drop-down list box defaults to the BVW-75 protocol, using an RS-422 connection.  
BVW-75 is the currently the only protocol supported by Lyric.  Lyric detects connected machines that 
use BVW-75 protocol, and then automatically sets the Port Configuration values for Baud Rate, 
Data Bits, Stop Bits and Parity.  The Master radio button is always selected.  The Slave function is 
not implemented at this time.  

7. Enter a Pre-Roll Time, in frames, for the VTR that is connected.  Pre-Roll for a DDR is 0.  
Remember that this adjustment is in Frames. 

8. Click OK.  Device Control is now set up for the DDR. 
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Common Board Configurations - Duet LE/LEX/PCI/PCI+ 
Config Menu > Configure Board Use 

A Duet LE/LEX/PCI/PCI+ system can be set up in a variety of configurations depending on the requirements 
of the facility and the production.  Four common configurations are described in this section: 

 Single Board Configuration 

 Dual Board Air/Air Configuration 

 Dual Board Air/Preview Configuration 

 Dual Board Link Mode Configuration 

Single Board Configuration 
The base hardware configuration for both Duet LE/LEX/PCI/PCI+ is one VPB.  A single VPB can perform any 
of Duet LE/LEX/PCI/PCI+’s transition effects.  In this mode of operation, the only available preview of an 
upcoming message is the Duet LE/LEX/PCI/PCI+’s VGA monitor.  If you wish to use only one board in a 
system with more than one installed, be sure to designate the boards that are not to be used as Unused.  
Refer to Duet Hardware (LE/LEX/PCI/PCI+) - Configure Board Use for details about this setting. 

Here is a simple exercise in one-VPB operation. 
1. Compose a message with on-screen content that clearly identifies the message itself. 

 

Creating Message 7000 

2. Save the message by pressing the Record (Duet keyboard) or the minus (-) key on the numeric 
keyboard.  Don’t forget that the message number display at lower right advances after a messages is 
saved, and the title bar of the Canvas reflects the ID of the saved message. 

3. Leave the Canvas as it is for a moment and pull down the Tools menu to select Duet 
LE/LEX/PCI/PCI+ Message FX. 
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4. The Duet LE/LEX/PCI/PCI+ Message FX dialog box opens.  Select Split for both the OUT and IN 
effects.  Be sure to set these effects to a slow enough speed, i.e. higher Frames setting, that you will 
be able to observe them working 

 

Setting up a Message Effect Message 

5. Save these effects settings as message #7001. 

6. Compose and record another readily-identifiable message as #7002. 

 

Creating Message 7002 
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7. Record a different set of effects as message #7003.  Again, make sure they are set to run slowly 
enough for you to see them clearly. 

 

8. Compose and save another two messages at ID numbers 7004 and 7006, and another, different 
Effects message at #7005. 
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9. Now, clear the Canvas. 

10. Make sure the LE/LEX/PCI/PCI+  button is not clicked on the Lyric interface. 

11. On the numeric keypad, type 7000, then press Read (Duet keyboard) or the Enter key on the 
numeric keypad.  This is the Lyric Read command. 

12. Message 7000 displays on the Canvas using the IN effect specified in Step 4. 

13. Press Read Next (Duet keyboard) or the + (“plus”) key on the numeric keypad.  This is the Lyric 
Read Next command.  Notice that the Message Number display advances two message numbers, 
not one as you may be accustomed to on other Chyron equipment.  This is a function of Lyric 
automatically reading an Effects message and skipping ahead to the next composition message  to 
prepare it for output. 

Dual Board Air/Air Configuration 

 

Air/Air Configuration 

With both VPBs designated as Air, each board is set up to function independently.  It is important to note that 
with two Air channels, the Read Next command only performs transitions between messages on the channel 

selected with the VPB  or  buttons. 

When using Duet LE/LEX/PCI/PCI+’s two outputs as separate Air channels, take special note that the Read 
Next function continues to advance the message number if you switch between outputs!  In other words, 
using the Swap function between Read Next operations may cause an unexpected message to appear on the 

channel on which you are working.  Remember that the  and  buttons dictate which output channel 
you are controlling with the Lyric interface. 

Be especially aware that the Swap button simply switches the image on each VPB to the other VPB.  
This operation does include an effects transition if programmed, but does not perform a Read Next operation. 
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Dual Board Air/Preview Configuration 

 

Air/Preview Configuration 

The Air/Preview configuration specifies that the output of the Preview board is always next in line in a Read 
Next operation.  The Preview setting affects the display of the video only within the Duet environment.  The 
video output from the designated Preview board can also be fed to Master Control, a switcher or other 
device. 

The following exercise simulates a control room situation where each Canvas message and each effects 
message is previewed on the Preview channel before transfer to the Air channel.  Remember that the even-
numbered messages you have created for these exercises are the composition messages;  odd-numbered 
messages are Effects messages. 

1. Click the  and VPB  buttons on the Lyric interface. 

2. Enter 7000 on the numeric keypad, then press Enter.  The message appears on Video Output #2, 
which is the Preview channel. 

3. Press the key combination Alt + Xfer (Duet keyboard) or Alt + / (the backslash or ‘division’ symbol on 
the numeric keypad).  The system performs a transition that displays message 7000 on the Air 
channel, using the effects programmed in message 7000. 

4. Press the Read (Duet keyboard) or Enter key on the numeric keypad to Read message 7002 into the 
Preview channel. 

5. Press  Alt + Xfer (Duet keyboard) or Alt + / again to transfer message 7002 to the Air channel. 

6. Press Read or Enter again to preview message 7004 and the effects that were saved in message 
7003. 

Remember that  is Duet LE/LEX/PCI/PCI+’s interactive mode.  Changes made on the Canvas appear 

in real time on the selected video output, which in this instance, was selected by clicking the  button.  
With a new message on the Preview channel, changes can be made before transferring the message to the 
Air output. 
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Dual Board Link Mode Configuration 
Duet LE/LEX/PCI/PCI+’s VPBs are capable of only one transition effect at a time, even though they can 
perform the effects in very quick succession.  When two simultaneous effects are desired, the VPBs may be 
linked together. 

For Linked operation, identify the VPB which is to provide the bottom layer of graphics.  This board will be first 
in the signal path.  In the following example, use VPB 2. 

1. Use BNC cables to connect VPB 2’s Video Out to VPB 1’s Video In and VPB 2’s Key Out to VPB 1’s 
Key In. 

2. Next, set up the Duet LE/LEX/PCI/PCI+ Configuration menus as shown in the two following 
illustrations. 

  

VPB Assignment For Linked Operation 
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Configuration For Linking VPBs 1 and 2 

The Horizontal Video and Vertical Video settings shown for Boards 1 and 2 are commonly used for this 
type of setup.  Depending upon the setup of the specific system, however, they may need adjustment. 

In Linked operation, when IN and OUT effects are set up in the Duet LE/LEX/PCI/PCI+ Message Effects 
dialog box (accessed from the Tools drop-down menu), the OUT effect is assigned to VPB 2 and the IN effect 
to VPB 1. With each effect using a discreet VPB, the effects can overlap in time, instead of being limited to 
executing sequentially when only one board is used. 
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To simplify the following exercise, it is suggested that you create a series of Canvas messages with 
sequential ID numbers.  Omit the Effects messages at alternate ID numbers. 

Set up one combination of effects in the Duet LE/LEX/PCI/PCI+ Message Effects dialog, and don’t perform a 
Save.  This combination of effects will be applied to each transition. 

1. Press the  button. 

2. Enter the ID number of the first message and press Read (Duet keyboard) or Enter.  The message 
appears. 

3. Press Read (Duet keyboard) or Enter again and the second message appears, using the IN effect 
while the first message disappears, using the OUT effect. 

You may also use the Read command and the backslash key (the keypad equivalent of Xfer) in combination. 
1. Set up the same combination of effects in the Duet LE/LEX/PCI/PCI+ Message Effects dialog, and 

again, don’t perform a Save. 

2. Enter the ID number of the first message, then press Read (Duet keyboard) or Enter. 

3. Press Xfer (Duet keyboard) or the backslash key (\) on the numeric keypad to transfer the message 
to the Duet LE/LEX/PCI/PCI+ output.  Remember that even though you’re using both VPBs, there’s 
only one output.  The first message displays on the output using the IN effect. 

4. Press Read or Enter again to open the next message on the Canvas. 

5. Press Xfer or backslash (\) on the numeric keypad again, and the first message disappears while the 
second message is displayed using both effects simultaneously. 

 





 

 6-1 

6. Optional Duet Hardware 

Overview 
A wide variety of optional internal and external optional hardware can augment the scope and flexibility of 
Duet systems.  These include: 

 Duet Keyboard - All Systems:  While a PC keyboard can run Lyric on a Duet system, the Duet 
keyboard provides dedicated keys for quickly executing Duet operations.  The Duet keyboard is 
covered later in this chapter. 

 Internal Clip Player - Duet SD/LE/LEX/PCI/PCI+:  The Internal Clip Player enables the recording 
and playback of video/audio clips in Lyric compositions.  Refer to the chapter on the Internal Clip 
Player for in-depth information. 

 Squeezeback Board - Duet SD:  The internal Squeezeback board enables the creation of regions 
which display input video in a Lyric composition.  Refer to the chapter on Video Regions and 
Squeezeback Objects for in-depth information. 

 PCI-Squeezeback Board - Duet LE/LEX/PCI/PCI+:  The internal PCI-Squeezeback board adds 
cutting-edge animated video effect creation capability, including resizeable, animatable video regions 
which display input video.  Refer to the chapter on Video Squeezeback for in-depth information. 

 RS-422 Serial I/O & GPIO Board (All Duet Systems - Configuration and use differs among 
systems.):  The internal RS-422 Serial I/O & GPIO board provides GPI capability to Duet SD and 
HD systems, and RS-422 interface capability with all Duet systems.  Note that Duet LE/LEX/PCI/PCI+ 
Video Processing Boards (VPBs) have built-in GPI capability, although PCI-Squeezeback boards do 
not.  Refer to the chapter on the RS-422 Serial I/O & GPIO Board for in-depth information. 

 Video Capture Board (All Duet Systems - Boards differ among systems.):  The internal Video 
Capture board allows the Duet to capture a frame of video, display it as a background on the Duet 
output and save it to a graphics file in one of the supported graphics formats.  Refer to the chapter on 
Video Capture for in-depth information. 

 Video Mixer - Duet SD:  The internal Video Mixer board enables the mixing of video on a Duet SD 
system.  Refer to the chapter on Video Mixing for in-depth information. 

 HD Mixer - Duet HD:  The internal HD Mixer board enables the mixing of video on a Duet HD 
system.  Refer to the chapter on Video Mixing for in-depth information. 

 CMix - Duet SD/LE/LEX/PCI/PCI+:  The external CMix unit enables the mixing of video.  While it can 
be used for mixing video on a Duet SD, it is generally used for Duet LE/LEX/PCI/PCI+ systems.  
Refer to the chapter on Video Mixing for in-depth information. 

 KwiKeys GPI/O Trigger Device - All Systems:  KwiKeys provides an easy method of executing 
GPI-triggered events.  Refer to the chapter on the Duet Optional Hardware for in-depth information. 

 ReCall Keys:  ReCall Keys provides a means for the Lyric operator to quickly call up Lyric 
messages, play animations and manipulate Duet’s program outputs.  ReCall Keys can be connected 
to a Duet system or a PC running Lyric, and communicates with the system via the RS-232 protocol.  
Refer to the chapter on the Duet Optional Hardware for in-depth information. 
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Duet Keyboard 
The Duet keyboard is custom-designed for use with Duet systems running Lyric software.  It is not necessary 
to have a Duet keyboard in order to run Lyric on a Duet system.  A PC keyboard can be used as well.  Refer 
to the chapter on Keyboard/Mouse Shortcuts for a comprehensive list of equivalent keystrokes. 

The Duet keyboard may be located up to six feet from the Duet chassis using the supplied cables.  For longer 
connections, Chyron recommends the use of a Keyboard/Video/Mouse Extender, which also facilitates 
placement of a monitor at the remote keyboard location.  Contact Chyron Customer Service to purchase the 
recommended Keyboard/Video/Mouse Extender, Chyron Part No. 5A01298 for 110-volt systems, or 5A11298 
for 220-volt systems. 

Keyboard Layout 
The Duet keyboard goes beyond PC keyboards in easy definition and use of hotkeys.  These hotkeys, labeled 
F1 - F10, double as conventional PC function keys, but are grouped together at the left side of the keyboard 
for quick access.  The large number of hotkeys and other special keys reduces the need to use the mouse.  
The layout of the Duet keyboard is similar to that of the familiar iNFiNiT!® keyboard.  

There are also standard Windows functions and a few Lyric functions that are accessed by meta-enabled 
keys.  Such functions are executed by pressing and holding the Fn key, located directly to the right of the ? 
key, while then pressing the key that is labeled with the function name.  For example, to execute a Print 
Screen, press Fn + Print Screen.  Print Screen is printed in red on the front of the Erase keycap.  All 
functions that require pressing the Fn key are printed on the fronts of the keycaps in red.  There is a list of 
meta-enabled keys below. 
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Some hotkey positions replace commonly used Windows keys, to make standard PC functions easily 
available.  These standard Windows functions are printed on the front of the key. For example, keys that 
generate the same scan code have their standard function printed in GREEN on the front of the key.  Keys 
that generate different scan codes have their standard function printed in BLUE on the front of the key. To 
generate standard PC keyboard codes, press the Chyron Fn key. The Chyron Fn key has its function printed 
in BLUE on the front of the key. 

Occasionally, the system interprets keys as being engaged when they are not.  To release the keys: 
 From the Config menu, select Reset Duet Keyboard. 

The Numeric Keypad on the Duet Keyboard 

 

Duet Numeric Keypad 
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A number of the Numeric Keypad keys perform the same operations available on a PC keyboard Address 
Keys.  The fronts of these keys are labeled with the names of these functions. 

Keycap Front of 
Key 

How to Access Function 

Ctrl Num Lock Fn + Ctrl 

Xfer / Outside of Lyric, this key functions as a 
division key. 

Change * Outside of Lyric, this key functions as a 
multiplication key. 

Swap - Outside of Lyric, this key functions as a 
minus key. 

Read 
Next 

+ Fn + Read Next 

Read Enter Fn + Read 

Clear Del Outside of Lyric, this key functions as a 
Del key. 

Reset Duet Keyboard 
Config Menu > Reset Duet Keyboard 
Reset Duet Keyboard releases any keys that the system interprets as being engaged. 

Keyboard Map 
The Duet Keyboard Map shows the ASCII codes for the key combinations for each keycap on the Duet 
keyboard.  For example, the codes for the keycap A are as follows: 

a = 97     A = 65     a = 97     •  = 149     – = 150 
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Duet Keyboard Map 
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7. Triggering Events: GPIs, RS-422/232 Serial Protocols 

GPI Overview 
Duet SD/HD:  Config Menu > Duet Hardware > GPI 
Duet LE/LEX/PCI/PCI+:  Config Menu > Duet Setup GPI 
A GPI, or General Purpose Interface, provides Lyric with the ability to transmit and receive triggers for 
internal and external events.  GPI triggers can be executed from Duet to Lyric, from Duet to external devices, 
or from external devices such as Chyron KwiKeys or Master Control Switchers, to Duet.  

A GPI can have a wide variety of uses, among them: 

 Triggering a Playlist event. 

 Triggering a Squeezeback Effect. 

 Turning on and off a tally light. 

 Releasing a Pause. 

 Stopping/starting a Clock or Timer. 

A Global GPI can also be set to allow an incoming GPI pulse to read any type Lyric file using the extension 
*.lyr.  Message types saved with this extension include conventional Lyric files, as well as specialized Lyric 
messages such as SD Mixer messages, CMix messages and Macro messages, etc. 

NOTE 
When a GPI assigned to a specific event, such as to trigger a Playlist step or trigger a 
Squeezeback Effect, make sure that the same GPI is not also assigned as a Global GPI, 
as there may be a conflict when the GPI or Global GPI is triggered.  Refer to Chapter 6 - 
Global GPIs for additional information. 

GPI capability is built-in on Duet LE/LEX/PCI/PCI+ systems, and can be added to Duet SD/HD systems with 
the installation of Chyron's optional RS-422 Serial I/O & GPI/O Board. 

Refer to GPI Configuration - Duet SD/HD or GPI Configuration - Duet LE/LEX/PCI/PCI+ for GPI 
configuration details. 
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RS-422 Serial I/O & GPI/O Board 

Overview 
Duet systems have the ability to control external devices or receive triggers from external sources.  With the 
installation Chyron's optional RS-422 Serial I/O & GPI/O Board, a Duet, for example, could control playback 
on a VTR or DDR, as well as have events triggered by an external Chyron® KwiKeys unit, a production 
switcher, a master control system and/or other external device(s).  On Duet SD/HD systems, Timecode 
functionality is also provided.  Incoming and outgoing triggers and commands are received and sent via 
GPI/O, or RS-422 using the BVW-75 or other protocols. 

 GPI/Os can trigger events on the Duet system, such as messages in a Playlist, Squeezeback 
effects (Duet LE/LEX/PCI/PCI+) and resuming an animation after a Pause.  GPI/O can also send 
triggers to external devices. 

 RS-422 enables control of external BVW-75-protocol and other devices such as a VTR, the Chyron 
Aprisa 200/250 DDR or other DDRs. 

System Differences 
For all systems, the RS-422 Serial I/O & GPI/O Board must be installed to enable RS-422 functionality.  There 
are, however, differences between systems regarding requirements for GPI/O and Timecode functionality. 

Duet SD/HD 
Duet SD/HD can accommodate up to four RS-422 Serial I/O & GPI/O Boards, and each individual board can 
control four RS-422 serial ports and eight GPI/O inputs and/or outputs. 

The RS-422 Serial I/O & GPI/O Board is accompanied by a GPI/O Extension Bracket that provides GPI/O and 
a Timecode Reader that synchronizes outgoing commands with LTC (Longitudinal Timecode) supplied 
from an external source.  GPI/O ports are DB-25 connectors mounted on the GPI/O Extension Bracket.  The 
GPI/O Extension Bracket should be installed directly adjacent to the RS-422 Serial I/O & GPI/O Board.  
Installation procedure follows Dip Switch Settings for Multiple RS-422 Serial I/O & GPI/O Board 
Installation later in this section. 

The GPI/O pins are of the Open Collector type, allowing the use of whatever voltage is appropriate in your 
facility.  The required voltage must be supplied to Pin #10 or Pin #11 of the 25-pin cable.  The pull-up resistor 
on the RS-422 Serial I/O & GPI/O Board is 4.7k ohms.  If, however, 5 volts is appropriate, this voltage is 
already available on Pins #12 and #13 of the cable. 

Duet LE/LEX/PCI/PCI+ 
The RS-422 Serial I/O Board is installed on its own without the GPI/O component.  Duet LE/LEX/PCI/PCI+ 
can accommodate up to four RS-422 Serial I/O Boards, and each individual board can control four RS-422 
serial ports.  GPI/O capability is built into a Duet LE/LEX/PCI/PCI+, therefore an RS-422 Serial I/O Board & 
GPI/O Board is not necessary to enable this function.  If installing in a Duet LE/LEX/PCI/PCI+, disregard 
references to GPI/O installation.  To provide Timecode function, an optional Timecode input panel is 
available.  Please contact Chyron Customer Service for information on ordering. 

Installation Order 
All hardware and software installation is covered in this section.  It is recommended that the order of 
installation is as follows: 

1. If installing multiple RS-422 Serial I/O & GPI/O Boards, set the DIP switches on the boards.  
Otherwise, this step is unnecessary.  The procedure is described below. 

2. Install the RS-422 Serial I/O & GPI/O Board, then its GPI/O Extension Bracket, then, if applicable, 
the second RS-422 Serial I/O & GPI/O Board then its GPI/O Extension Bracket, and so on until all 
boards are installed.    The procedure is described below. 

3. Install the GPI/O Driver.  This is a software installation.  The procedure is described below. 

4. Configure the Device Control (all systems) and GPI (Duet SD/HD) tabs in the Duet Hardware dialog 
box, accessible from the Config menu.  Refer to the chapter on Duet Hardware Configuration:  
Device Control for details on setup. 
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Installing the RS-422 Serial I/O & GPI/O Board 
IMPORTANT!!! 

If more than one RS-422 Serial I/O & GPI/O Board is to be installed in the Duet system, it 
is strongly advised, that for ease of access and electrical safety, the DIP switches on the 
boards be set before installation.  Refer to Dip Switch Settings for Multiple RS-422 Serial 
I/O & GPI/O Board Installation later in this section for details. 

For information on the pinouts and cabling associated with the GPIO Board and the GPI Extension Bracket 
see Figure 6-3 in Chapter 6 of the Duet Hardware Reference Guide. 

Two PCI slots are needed for installation of the RS-422 Serial I/O & GPI/O Board.  Each RS-422 Serial I/O & 
GPI/O Board is installed in one of Duet’s eight PCI slots.  The extension bracket holding the GPI/O ports and 
LTC connection should occupy an additional PCI slot next to the RS-422 Serial I/O & GPI/O Board to which it 
is connected. 

IMPORTANT!!! 
It is strongly recommended that measures be taken to dissipate any static electrical 
charge before touching the RS-422 Serial I/O & GPI/O Board.  When using an anti-static 
wrist strap, the grounding cord must contain a 1-meg ohm to-10 meg ohm series 
isolation resistor. 

Additionally, POWER DOWN THE DUET SYSTEM before starting installation!!! 

To install the RS-422 Serial I/O & GPI/O Board: 
1. Using an appropriate screwdriver, remove the rear panel cover plate for the PCI slot where the new 

board will be installed.  When viewed from the rear panel, each cover plate is slightly to the left of its 
matching board slot.  Retain the screw for installation of new PCI boards, and retain the cover plate 
for possible future use. 

2. Remove the RS-422 Serial I/O & GPI/O Board from its anti-static packing material. 

3. Remove the nut from the BNC connector that projects from the board’s rear panel. 

NOTE 
Remember that the first (or only) RS-422 Serial I/O & GPI/O Board to be installed in the 
system must be installed in PCI Slot #8, which is to the extreme right (when looking at 
the front of the Duet). 
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Installing the RS-422 Serial I/O & GPI/O Board 

4. The BNC connector projecting from the rear of the RS-422 Serial I/O & GPI/O Board prohibits 
pressing the board straight down into the H-connector in the chassis.  Lower the rear of the board into 
Duet’s PCI area first and then move the board toward the openings at the back of Duet. 

5. Insert the board into the board slot.  Carefully press down on the board’s upper edge using firm 
pressure, until the board is seated securely into the slot. 

6. Reinstall the nut that you removed from the BNC connector, tightening it against the brackets 
supporting the GPIO board. 

7. Secure the GPIO board’s rear panel to the chassis by aligning the metal retaining bracket with the 
screw hole in the top edge of the Duet chassis. Then, secure the bracket to the chassis using the 
original screw that secured the Rear Panel Cover Plate. 
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Dip Switch Settings for Multiple RS-422 Serial I/O & GPI/O Board Installation 
IMPORTANT!!! 

The following image is taken from a legend silk-screened on the RS-422 Serial I/O & 
GPI/O Board itself.  Note that when the board is installed, the legend is obscured by the 
system’s DRAM modules.   For ease of access and electrical safety, each board’s DIP 
switches should be set before the board is installed in Duet. 

Each RS-422 Serial I/O & GPI/O Board is shipped with its S1 DIP (Dual In-Line Package) switches set to 
identify that board as RS-422 Serial I/O & GPI/O Board #1 in the Duet system.  Each additional RS-422 
Serial I/O & GPI/O Board’s DIP switches must be set to identify the board as #2, #3 or #4 within Duet.  The 
following illustration shows the appropriate settings.  Note that only switches S1.1 and S1.2 are used; the 
others are set to OFF.  This is the factory default, and these switches should be left undisturbed. 

The first (or only) board’s GPI/Os are numbered 1 - 8.  Remember that each can be designated as an input or 
output.  Each additional RS-422 Serial I/O & GPI/O Board's GPI/Os are numbered successively.  A second 
RS-422 Serial I/O & GPI/O Board’s ports appear to Duet as GPI/Os 9 - 16; a third board’s GPI/Os would be 
numbered 17 - 24; and a fourth board’s GPI/Os would be numbered 25 - 32. 

 

Dip Switch Settings for Multiple RS-422 Serial I/O & GPI/O Boards 

Installing the GPI/O Extension Bracket - Duet SD/HD Only 
IMPORTANT!!! 

It is strongly recommended that measures be taken to dissipate any static electrical 
charge before touching the RS-422 Serial I/O & GPI/O Board.  When using an anti-static 
wrist strap, the grounding cord must contain a 1-meg ohm to-10 meg ohm series 
isolation resistor. 

Additionally, POWER DOWN THE DUET SYSTEM before starting installation!!! 

The GPI/O Extension Bracket consists of the LTC connector (DB-9) and the GPI/O connector (DB-25) 
mounted on a simple PCI panel.  The bracket is shipped with ribbon cables for LTC and GPI/O signals 
already connected to their respective DB-9 and DB-25 connectors, respectively.  If there is no need to use the 
GPI/Os or LTC, it is not necessary to install this bracket.  To install the GPI/O Extension Bracket, follow these 
steps:  

1. Remove the rear panel cover plate where the GPI/O Extension Bracket will be installed, preferably 
the slot next to the RS-422 Serial I/O & GPI/O Board to which it is connected.  Retain the plate and 
the screw that held it in place.  Take note of the way that the lower end of the rear panel cover plate is 
inserted into the groove that runs across all the PCI slots. 

2. Connect the large ribbon cable from the extension bracket’s GPI/O connector to the 26-pin connector 
at JP-5 header on the RS-422 Serial I/O & GPI/O Board.  The extra pin on this connector is not used 
for GPI/O or BVW-75 function. 
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Installing the GPI/O Extension Bracket 

3. Connect the smaller cable from the extension bracket’s LTC connector to the 10-pin connector at JP-
9 (see above). 
  

IMPORTANT!!! 
Be careful to connect the smaller ribbon cable to the connector at JP-9, just below the 
Debug port.  Do not connect this cable to the shrouded connector at JP-7! 

4. Make sure that Pin #1 (indicated by the red wire in the ribbon cable) is at the top of the connector.  
The red wire in the ribbon should run parallel to the top of the board as it leaves the connector, even 
though you will have to twist both cables to get the GPI/O Extension Bracket situated properly. 

5. Note the similarity between the GPI/O Extension Bracket and the rear panel cover plate that you 
removed in the first step.  Mount the extension bracket just as the original rear panel cover plate was 
mounted, sliding the lower end of the bracket into the groove that runs across the PCI slots. 

6. Secure the bracket to the chassis by aligning the metal retaining bracket with the screw hole in the 
top edge of the Duet chassis, then secure the bracket to the chassis using the original screw that 
secured the rear panel cover plate. 

7. Replace Duet’s top cover before turning on the unit. 

If multiple external systems are to be connected, connect the GPI cable to an appropriate breakout box. 

RS-422 Serial I/O & GPI/O Board Driver Installation 
After installing the RS-422 Serial I/O & GPI/O Board, the driver must be installed to enable Lyric to 
communicate with the board. 

1. In Duet’s Windows Control Panel, use the Add/Remove function to uninstall Duet System Files. 

2. Load the current Duet/Lyric CD. 
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3. In the very first screen that appears, select Install Drivers. 

4. The Welcome screen appears next.  Review it, then click OK. 

5. Click the GPIO checkbox in the next screen if you have installed the RS-422 Serial I/O & GPI/O 
Board. 

 

Select Duet Hardware Options 

6. Follow the on-screen prompts to complete the remainder of the driver installation procedure. 

7. Reboot the system before running Lyric.  The RS-422 Serial I/O & GPI/O Board is now ready to use. 

Establishing and Testing Connections 
When establishing GPI or RS-422 connections, it is strongly recommended that you power down both Duet 
and external devices before connecting them.  Consult the documentation for the external device to determine 
the proper signal level and duration, and configure Duet appropriately through the Lyric software described 
above. 

 Connect an appropriate male DB-25 connector to the port labeled GPIO on the GPI Extension 
Bracket.  

 Connect the GPI cable to the piece of equipment that will be sending or receiving GPIs to or from 
Duet. If multiple external systems will be connected, connect the GPI cable to an appropriate break-
out box. 
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The example given below assumes connection of a Sony Betacam VTR. The Transport Controls, however, 
operate in the same manner for digital disk recorders (DDRs).  

1. Power down both Duet and the VTR. Connect one of Duet’s serial ports to the VTR’s DB-9 REMOTE 
connector. Restore power to both machines and launch Lyric. 

2. From the Lyric Tools menu, select Clip Control Panel. The Clip Control Panel is displayed.  

 

Clip Control Panel 

3. In the Device Playback drop-down list box, select the playback device. 

4. Load a tape with recorded content, and that has space on which content can be recorded. 

5. Test the Transport Controls:  Rewind, Previous Frame, Stop, Play, Next Frame and Fast 
Forward. 

6. Try the Scrub slide box immediately beneath the Transport Controls. The slide box is equivalent to 
the Jog/Shuttle knob on the playback device itself. 
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To create a clip from a segment of recorded material on the external machine: 
1. Use the transport controls to cue the tape or disk to the beginning of the desired content. 

2. In the In Point area, click the Mark button. Note that the current timecode appears in the timecode 
window. 

3. Use the transport controls to cue the tape or disk to the end of the desired content.  

4. In the Out Point area, click the Mark button. Note that the current timecode appears in the timecode 
window. 

5. To program the clip to play to the end then stop, select Play to End.  To program the clip to loop until 
stopped externally, select Loop. 

6. Give the clip you are creating a Clip Number. 

7. Click the Save button and then click OK. 

To record: 
1. Click the red dot to the right of the topmost timecode display. The button will change to a darker red, 

signifying that the VTR is in 'standby' mode.  

2. Press the Play button, and a record command will be sent to the device.  During recording, the red 
button will flash on and off. Press the Stop button to stop the recording.  Note: If the Record button is 
pressed while the device is playing, recording will start immediately. 

Refer to the chapter on the Internal Clip Player and the Clip Control Panel for additional information. 
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Device Control 
Config Menu > Duet Hardware Configuration > Device Control 
Lyric can control or be controlled by external devices such as videotape tape recorders (VTRs), digital disk 
recorders (DDRs) and switchers by using GPIs (General Purpose Interface triggers) or by the BVW-75 
Serial Digital Protocol via the RS-422 Serial Digital Interface. 

Such control inputs to Duet from external sources can start and stop Clocks and Timers, execute an 
individual step within a Lyric Playlist or release a programmed Pause.  GPI control outputs from Duet can be 
used to trigger external devices such as keyers and tally lights.  Refer to GPIs - Overview for comprehensive 
information on GPI setup. 

The most common use of the BVW-75 protocol/RS-422 connection is for cueing and playback of video from 
the Clip Control Panel.  In addition, segments of existing video on external playback devices can be defined, 
saved and played back as Clips either on their own, or as components of a Lyric message. 

NOTE 
To enable BVW-75 via RS-422 (all systems) capability or GPI (Duet SD/HD) capability, the 
Chyron's optional RS-422 Serial I/O & GPI/O Board and must be installed in the Duet 
SD/HD system.  This board is not necessary for GPI function on Duet LE/LEX/PCI/PCI+, 
but is necessary for BVW-75/RS-422 communication.  Call Chyron Customer Service at 
845-2132 for information about this product.  Refer to RS-422 Serial I/O & GPI/O Board for 
details on installation and setup. 

 While each type of system displays its own set of system-specific tabs in Duet 
Configuration, the Device tab on all systems is the same. 

 If this board is not present in a Duet SD/HD system, the Device and GPI tabs are 
grayed out. 
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The following example shows configuration on a Duet SD of serial device control of a Sierra DDR, using the 
BVW-75 protocol.  

1. Be sure that the external DDR or VTR is properly connected to the Duet system.  For additional 
information on connection, refer to the Duet Hardware Reference Manual. 

2. From the Config menu, select Duet Hardware.  The Duet Hardware Configuration tabs are 
displayed.  Click the Device Control tab to display the Device Control settings. 

 

Duet Configuration - Sony® BVW-75 Protocol 

3. From the Port drop-down list box, select the number (1 - 4) of the port on the Chyron RS-422 Serial 
I/O & GPI/O Board that is to be connected to the external device. 

4. In the Description field, enter a description of the device.  When the external device is selected in the 
Clip Control Panel Playback Device drop-down list box, this description is reflected in the Playback 
Device field.  Refer to Clip Control Panel for additional information on clip operations. 

5. Select (check) the Port Allocated checkbox.  If this checkbox is not enabled, the device is not 
recognized by the Clip Control Panel, and therefore cannot be accessed for clip creation. 

6. The Protocol drop-down list box defaults to the BVW-75 protocol, using an RS-422 connection.  
BVW-75 is the currently the only protocol supported by Lyric.  Lyric detects connected machines that 
use BVW-75 protocol, and then automatically sets the Port Configuration values for Baud Rate, 
Data Bits, Stop Bits and Parity.  The Master radio button is always selected.  The Slave function is 
not implemented at this time.  

7. Enter a Pre-Roll Time, in frames, for the VTR that is connected.  Pre-Roll for a DDR is 0.  
Remember that this adjustment is in Frames. 

8. Click OK.  Device Control is now set up for the DDR. 
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Global GPIs 
Config Menu > Global GPIs 
This facility allows an incoming GPI pulse to read any type Lyric file using the extension *.lyr.  Message types 
saved with this extension include conventional Lyric files, as well as specialized Lyric messages such as SD 
Mixer messages, CMix messages and Macro messages. 

NOTE 
After parameters are set, Lyric must be closed and relaunched in order to apply GPI 
settings. 

1. From Lyric’s Config menu, select Duet Hardware, then click on the GPI tab (Duet SD/HD systems) 
or the Setup GPI tab (Duet LE/LEX/PCI/PCI+ systems). 

2. Set up and allocate one of the available GPIs. Make sure that the GPI Allocated checkbox is 
selected (checked).  If you wish, enter a Description.  Make sure that the GPI that is assigned as a 
Global GPI is not already assigned to be used in another capacity (for example, in a Playlist or to 
trigger a Squeezeback effect), as there may be a conflict when the GPI or Global GPI is triggered.  
Refer to the chapter on Duet Hardware Configuration for detailed GPI setup information. 

3. Click OK. The tab closes. 

4. Return to the Config menu and select Global GPIs to open the Configure Global GPIs dialog 

.   

Configure Global GPIs Dialog Box 
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5. Double-click the entry for the GPI that you allocated in Step 2. The Select File To Assign To GPI 1 
dialog opens. 

 
Selecting a File to Assign to GPI 1 

Select the file that is to be opened by the incoming GPI pulse. 

 

GPI 1 Set as Global GPI 

The Configure Global GPIs dialog reappears as shown above.  Note that the GPI assignment is 
labeled with the Description entered in Step 2.  This user-defined description on the left is not to be 
confused with the actual filepath on the right-hand side of the entry. 

6. Click OK.  The selected *.lyr file will now open when the GPI is triggered. 

7. If the Lyric file read by the GPI contains an animation, it is necessary to set playback parameters.  
From the Config menu, select Preferences, then the Animation Settings tab. 

8. To play the animation immediately when read, select (check) AutoPlay On Read and deselect 
(uncheck) Prompt to Play on Duet.  The animation plays when read, without Lyric generating a 
prompt confirming playback.  To manually trigger playback, deselect (uncheck) AutoPlay On Read. 

9. Click OK to close Preferences. 

10. Exit Lyric, then relaunch Lyric to apply the Global GPI settings.   
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KwiKeys GPI/O Trigger Device 
Chyron’s KwiKeys GPI/O trigger device can send GPI triggers to the Duet system to execute Playlist events, 
Squeezeback Effects, resume animations after Pauses, etc.   KwiKeys consists of sixteen illuminated keys 
and connects, via an adapter (see below), to the GPI/O interface connector on the RS-422 Serial I/O & GPI/O 
Board in a Duet SD, or directly to the GPI/O interface connector on a VPB in a Duet LE/LEX/PCI/PCI+.  It 
does not connect to a PCI-Squeezeback board, but, when properly configured, can trigger Squeezeback 
Effects.  Refer to GPI Setup - Duet LE/LEX/PCI/PCI+ and Effect Activation Button - GPI Control/SQZ 
Kwik Tool for details on Squeezeback Effect execution. 

KwiKeys triggers only in an outbound direction to Duet; it does not receive triggers from Duet.  Buttons 1 - 8 
can connect to the eight GPIs that can be set up on one 422 Serial I/O & GPI/O Board in a Duet SD/HD.  
Buttons 1 - 16 can connect to the sixteen GPIs that can be set up on the VPB of a Duet LE/LEX/PCI/PCI+. 

 

KwiKeys 

IMPORTANT - DUET SD/HD!!! 
Do not connect KwiKeys directly to GPI/O interface connector on the 422 Serial I/O & 
GPI/O Board.  Although their connectors fit together, the pinouts do not match.  To 
assemble the appropriate adapter, consult appendix C of the handbook for Chyron’s 
digital pcCodi, Chyron Publication No. 2a02137, Revision B.  This publication is available 
on the Chyron web site at http://www.chyron.com.  To purchase an appropriate adapter, 
please contact Chyron Customer Service.  Refer to Chapter 6 in the Duet Hardware 
Reference Guide, Chyron Publication No. 2a02105, Revision B for complete hardware 
information on the GPI/O board. 
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ReCall Keys 

Overview 
Chyron's ReCall Keys provides a means for the Lyric operator to quickly call up Lyric messages, play 
animations and manipulate Duet’s program outputs.  The ReCall Keys can be connected to a Duet system or 
a PC running Lyric. 

The ReCall Keys can be connected to either the COM 1 or COM 2 serial port of a Duet or a PC, and 
communicates with the system via the RS-232 protocol.  The ReCall Keys (shown below) consists of an LCD 
(Liquid Crystal Display) and a keypad.  Installation and Communications Setup (both for Windows® 2000 
and Windows NT®) is described following the ReCall Keys Functions section. 

 

Chyron ReCall Keys 
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ReCall Keys Functions 
This photograph of the ReCall Keys has been modified so that the LCD appears more clearly. 

The controls, starting at the upper left corner of the keypad, and going clockwise around the number keys, are 
as follows: 

Function Description 

Menu Menu functions are not currently implemented for use with Duet. 

 The  key is used with the Menu function.  Menu functions are not 
currently implemented for use with Duet. 

Xfer Performs the same function as the Xfer button on the Lyric interface, 
sending the contents of the active Frame Buffer to Air. 

 The  key is used with the Menu function.  Menu functions are not 
currently implemented for use with Duet. 

Chng Selects the next available Frame Buffer as the active Frame Buffer 
for editing or transfer to output.  Order of availability is as follows:  1, 
2, 3, 4, 1, 2 etc. 

Do Issues the Play command to Duet when a Lyric message containing 
an animation is loaded. 

Erase Clears the Canvas. 

Read Prev Prebuilds the message with the next lowest Message ID in a 
numeric sequence of messages. 

Read Next Prebuilds the message with the next highest Message ID in a 
numeric sequence of messages. 

Read Reads the message stored at the numerical address most recently 
entered on the keypad. 

Insert Performs the same function as the Live button on the Lyric interface, 
sending the contents of the active Frame Buffer to the Air output. 

Clear Deletes any keypad entry from the Recall Keyboard’s display. 

Installation 
NOTES  

 The maximum distance for a remote connection of the Recall Keyboard is 10 
meters (approximately 32 feet). If it is necessary to exceed this maximum 
distance, a suitable RS-232 to RS-422 converter must be used. 

 The Power and Data cables are clamped together prior to shipment. This is done 
in order to avoid accidental removal of the power connector during operation. If 
the Power and Data cables are not clamped together, tie them together as shown 
in Figure 2 using a suitable cable tie. Cut and discard excess length of cable tie. 
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ReCall Keys Components 

To connect the ReCall Keys to a Duet or PC’s COM2 port: 
1. Make sure that power is not connected to the Duet or PC. 

2. Connect the female end of the Data Cable to the appropriate COM2 serial connector of the Duet or 
PC.  Hand-tighten the connector. 

3. Connect the Power Cable to the power receptacle on the ReCall Keys. 

4. Connect the male end of the Data Cable to the corresponding connector on the Recall Keyboard.  
Hand-tighten the connector. 

5. Connect the ReCall Keys power supply to a suitable AC power source. 

6. After the ReCall Keys is connected, configure the Communications Setup.  Procedures for 
Windows® 2000 and Windows NT® follow. 
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Communications Setup - Windows 2000, XP 
1. After the installation of the ReCall Keys, access Windows Start > Settings > Control Panel > 

System > Hardware > Device Manager > Ports (COM & LPT). 

2. Expand the Ports (COM & LPT) listing, then select Communications Port (Com 1) or 
Communications Port (Com 2).  This example shows COM 2.  The Communications Port (COM2) 
Properties dialog box is displayed. 

3. Select the Port Settings tab to display the settings. 

 

COM2 Setup - Windows 2000 

4. Enter the following settings:  Baud Rate = 19200; Data Bits = 8; Parity = None; Stop Bits = 1; Flow 
Control = None. 
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5. Move to the Lyric interface.  From the Config menu, select Intelligent Interface.  The Intelligent 
Interface dialog box is displayed. 

 

ReCall Keys Setup - Windows® 2000 

6. In the Serial Port Enable area (unlabeled), select either Enable Serial Port 2 (or Enable Serial Port 
1 if using Port 1) or Enable Both Ports. 

7. In the Recall Keys area, select (check) the Enable Recall Keys checkbox, and select the Com 2 (or 
Com 1 if using Com 1) radio button. 

8. Click OK.  ReCall Keys setup is now complete. 

Communications Setup - Windows NT 
1. After the installation of the ReCall Keys, access Windows Start > Settings > Control Panel > 

Ports.   The Ports dialog box is displayed.  Select Com 1 or Com 2.  This example shows Com 2. 

 

ReCall Keys - Selecting a COM Port 
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2.   Click Settings.  The Settings for COM2 (or COM1 if using COM1) dialog box is displayed. 

 

Recall Keys - Settings for COM2 

3. Perform the following settings:  Baud Rate = 19200; Data Bits = 8; Parity = None; Stop Bits = 1; 
Flow Control = None. 

4. Move to the Lyric interface.  From the Config menu, select Intelligent Interface.  The Intelligent 
Interface dialog box is displayed. 

 

Recall Keys Setup - Windows NT® 

5. In the Serial Port Enable area (unlabeled), select either Enable Serial Port 2 (or Enable Serial Port 
1 if using Port 1) or Enable Both Ports. 

6. In the Recall Keys area, select (check) the Enable Recall Keys checkbox, and select the Com 2 (or 
Com 1 if using Com 1) radio button. 

7. Click OK.  ReCall Keys setup is now complete. 
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8. Preferences 

Preferences 
Config Menu > Preferences 
Lyric provides a host of options for customizing Lyric to a user's requirements.  Many of these options are set 
in the Preferences window, in which can be found settings for interface display, animation, Browser, etc. 

 Once Preferences have been set, they can be applied by selecting OK in the Preferences window. 

Preference settings can also be saved to User Profile files for later recall.  This eliminates the need to reset 
Preferences each time after they have been changed, and enables the storage of multiple User Profiles 
which can be tailored to specific users and/or production situations.  Refer to Save/Load User Profile for 
additional information. 

To access these settings: 
 Select Preferences from the Config menu.  The Preferences window is displayed. 

 

Preferences Window 

There are seven tabs which contain configuration settings: 

 CG Preferences:  The settings in CG Preferences determine how the Canvas appears, how the 
Message Number updates when messages are recorded or read, and how Shift Page, Xfer and 
Tab operations execute. 

 Spelling:  The User Dictionary against which spelling is checked is specified in Spelling tab. 

 Default Paths:  The Default Paths settings determine the default directories which Lyric 
automatically accesses for reading/recording messages, fonts, and other Lyric assets. 

 Animation Settings:  Default length, execution, memory allocation, and other parameters with 
regard to animations set in Animation Settings. 

 Browser:  Default Font and Default Message data sources, data source Import or Create, and 
other Browser-related defaults are set in the Browser settings. 
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 Alignment:  The Alignment function allows the operator to superimpose a customized grid on the 
Canvas, and to force alignment of objects to the nearest grid line(s).  The Alignment Grid is useful 
for precise positioning of text, templates and other objects within the composition. 

 Windows:  Display options for the Lyric windows and the Canvas are set in the Windows tab. 

All Preferences are covered in this chapter, except for the following: 
 Browser Preferences, which are covered in the chapter on Browsers. 

 Animation Settings Preferences, which are covered in the chapter on Animation. 
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CG Preferences 
Config Menu > Preferences > CG Preferences 
The settings in CG Preferences determine how the Canvas appears, how the Message Number updates 
when messages are recorded or read, and how Shift Page, Xfer and Tab operations execute. 

 

CG Preferences 

Cursor Shape 
The shape of the cursor can be set to suit user preference.  Select either an I-Beam- or Box-shaped cursor: 

 

Cursor Shapes 
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Show 
The Show parameters determine which informational graphics are displayed on the Canvas.  These graphics 
are to aid in graphic composition only, and do not appear on the output. 

Safe Title 
The Safe Title Area on the Canvas, by default, encompasses what is generally considered to be the safe 
area in which significant text elements and graphics should be placed.  Outside of the Safe Title Area, there 
is a risk of cutoff due to the differences in the physical frame in which a TV is mounted. 

 When Safe Title is enabled (checked), the Safe Title Box, which encloses the Safe Title Area, is 
displayed. 

 When Safe Title is disabled (unchecked), the Safe Title Box is not displayed. 

The Safe Title Box is adjustable via Config Menu > Safe Title Adjust, and can also be used to crop 
graphics or Flipbooks when they are saved. 

 

Safe Title 
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Viewport Labels 
Viewport Labels specify which Canvas View is active.  The Viewport Labels consist of a text label and a 
representation of the axes of the Lyric composition which are currently displayed. 

 When Viewport Labels is enabled (checked), the Viewport Labels are displayed. 

 When Viewport Labels is disabled (unchecked), the Viewport Labels are not displayed. 

 

Viewport Labels 
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4:3 Title in 16:9 
When Lyric's Canvas Resolution has been set for a 16:9 aspect ratio, a movable 4:3 Safe Title can be 
displayed within the 16:9 Safe Title display.  By default, the 4:3 display initially appears centered within the 
16:9 display. 

4:3 Title in 16:9 can be useful for planning compositions that will appear in both 4:3 and 16:9 formats.  This 
setting is available only when a 16:9 resolution has been set. 

 When 4:3 Title in 16:9 is disabled (unchecked), only the 16:9 Safe Title Box is displayed. 

 When 4:3 Title in 16:9 is enabled (checked), a 4:3 Safe Title Box is displayed in addition to the 16:9 
Safe Title Box. 

 

4:3 and 16:9 Safe Title Boxes in 16:9 Canvas Resolution 

The size, proportions and position of the Safe Title Area itself can be adjusted to aspect ratios other than 4:3 
and 16:9. Refer to Safe Title for additional information on adjusting Safe Title. 

Initial Edit Mode 
When opening a new Canvas, it can open as completely blank or containing a full-screen 2D Text Window. 

 Full Screen:  On opening a new Canvas, opens a full-screen-sized 2D Text Window.  The blue 
boundaries of the 2D Text Window are visible at the edges of the Canvas, to allow the ability to grab 
with it the mouse. 

 Windowed:  The Canvas is opens as completely blank.  To place a 2D Text Window on the 

Canvas, click  in the Chyron Toolbar. 
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Confirm 
When deleting a message (Delete key or Alt + F5) or overwriting a message, Lyric can display a message 
asking for confirmation.  This lessens the possibility of accidentally deleting a message. 

 On Delete Msg:  If On Delete Message is enabled (checked), Lyric displays a message asking for 
confirmation.  OK must be clicked before the delete operation is executed. 

 

Delete Confirmation 

If On Delete Msg is disabled (unchecked), Lyric proceeds with the deletion without confirmation. 

 If On Overwrite is enabled (checked),  Lyric displays a message asking for confirmation.  OK must 
be clicked before the overwrite operation is executed.  If On Overwrite is disabled (unchecked), Lyric 
proceeds with the overwrite without confirmation. 

This functionality is duplicated and extended in the Browser when On Delete Msg is enabled.  Selecting 
Delete from the Browser right-click menu Browser causes the system not only to confirm the deletion as a 
Browser entry, but also displays an additional confirmation for deleting the file.  Clicking Yes in the first dialog 
displays the second dialog. 

 

Deleting a File from the Browser 
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Similarly, enabling On Delete Msg causes the system to display a prompt to confirm that the new message 
should overwrite the existing message. 

 

Overwriting a File on a Browser 

   
This prompt appears whether you begin overwriting a message via the keypad or by using the Browser's 
Save to Database button, shown circled above.  Refer to Browser Overview for additional information.  

Save/Recall Options 
The following options determine how information is saved for reuse during while composing a Lyric message:  

Disable Undo 

Specific to Undo operations (the  button or Ctrl + Z) in 2D text composition. In any case, the operator can 
always Undo operations in other activities such as 3D composition or the use of bitmaps. 

Auto-Increment on Read/Record 
The displayed message number can be set to advance so that the next file saved is assigned the next 
number in ascending order.  Auto-Increment on Read/Record was formerly known as Auto-Increment on 
Save. 

 When Auto-Increment is enabled, the displayed message number is set to advance every time a 
Lyric message is read or recorded and saved with a numeric file name.  This is helpful when 
recording a series of messages, as it aids in preventing accidental overwrite of the previously saved 
message.  It also eliminates the need to enter a new Message Number when recording or reading 
each message. 

 When Auto-Increment is not enabled, the displayed Message Number does not advance after a 
read or record. 

Remember that regardless of the Auto-Increment setting, a Message Number can entered on the numeric 
keypad to read or record an out-of-sequence message. 
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Track Message Number Per FB (Duet Systems Only - Not Offline) 
The operator may now select whether the Message Number display changes with the Frame Buffer 
selected for editing.  When this option disabled (unchecked), the Message Number display reflects the 
Message Number most recently read or recorded. 

Read Next Range 
Specifies the number of numerically-named messages through which Lyric will search during Read Next and 
Read Previous.  The default setting is 10. 

Shift Page 
Shift Page operations (Ctrl + Alt + ) can either affect just the selected objects on the Scene Graph 
or Timeline, or all objects on the Canvas. 

 If Selected Objects is enabled, only the objects selected on the Scene Graph or Timeline are 
shifted when a Shift Page operation is executed. 

 In All Objects is enabled, all objects on the Canvas are shifted when a Shift Page operation is 
executed, whether or not they are selected. 

Xfer Mode 
The Xfer Mode setting determines how an Xfer operation is executed. 

 Basic:  Once a composition has been transferred to the video output, it can no longer be modified in 
real time. Further changes must be made on the Canvas, and then rendered to the video output by 

executing Xfer again, or by clicking the button. 

 Swap VGE with VGA:  This option allows the Xfer operation to be used repeatedly to switch the 
composition on the Canvas on the VGA monitor with the signal on the VGE output.  This action may 
be used as another method of Air/Preview operation. 

Tab Width 
A Tab space may be added (press Ctrl + Tab) between characters in a 2D Text, Roll, Crawl or Type On 
Window.  The size of the Tab space, specified in pixels, can be set in the Tab Width field.  100 pixels is the 
default setting.  For sake of clarity, references to 2D Text Windows include 2D Roll, 2D Crawl and 2D Type 
On Windows.  

 When a Tab Width is set, the Tabs are set at fixed positions in the 2D Text Windows.  Be mindful 
that if the first character in a line is between Tab positions, it results in a shorter spacing before the 
next Tab.  With columns created in this manner, it will appear as if the first column is too close to the 
second.  To avoid this, make the 2D Text Window wide enough that the first character of the first 
column can be typed immediately following a Tab. 

 A change in the Tab Width value updates all Tabs currently on the Canvas. 

 Be aware that when a new Tab Width is set, if the text overlaps the updated Tabs or vice versa, the 
results could be unexpected.  Typing new Tabs into text created with Tabs at a different Tab Width 
can also produce unexpected results. 

 If the Tab Width has been changed, and then a message created with a different Tab Width is read, 
the original Tab Width is preserved in the read message.  If a Tab is then typed into a 2D Text 
Window of the read message, the Tabs in the 2D Text Window update to the new Tab Width.  
Other 2D Text Windows are unaffected.  Note that as mentioned above, a change made to the Tab 
Width while a recorded message is displayed results in an update to all Tabs currently on the 
Canvas. 

Unicode Only 
The Unicode Only setting determines the use of Unicode fonts in Lyric. 

 If Unicode Only is enabled (checked),  all 2D/3D text entry and editing in the Canvas uses the 
Unicode character set and is designed to work with Unicode fonts.  Although this is not the default 
mode, it is required if any Asian language (Korean, Chinese or Japanese) is selected. 
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 Unicode Only should be disabled (unchecked) if the Duet SD/HD or offline PC is running the 
Windows NT® operating system, or if it is necessary to maintain compatibility with older, non-Unicode 
fonts (e.g., double-byte or ASCII).  Note that Windows NT is not supported on Duet 
LE/LEX/PCI/PCI+. 
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Spelling Preferences 
Config Menu > Preferences > Spelling 
Lyric’s Spell Check operates in the same manner as standard word processing Spell Check applications.  
Spell Check is launched by pressing F7 or by selecting Spelling from the Tools menu.  When Spell Check 
runs, the program compares all 2D text on-screen to a standard English dictionary and a User Dictionary 
simultaneously.  As with word processors, the operator may add specialized terms to the User Dictionary. 

 

Spelling Preferences 
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It may be desirable to have User Dictionaries to be used for specific purposes, such as particular types of 
sports or news.  The current User Dictionary is displayed in the Current User Dictionary field.  The User 
Dictionary used can be changed using one of the following methods: 

 Enter the absolute path of the User Dictionary in the User Dictionary field. 

 Select Change Dictionary.  The Open menu is displayed.  Navigate to the User Dictionary file, then 
click Open.  The new User Dictionary is loaded, and the name is reflected in the Current User 
Dictionary field.  A User Dictionary always has the extension .u. 

   

Open New User Dictionary 
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Default Paths Preferences 
Config Menu > Preferences > Default Paths 
Default Paths enables the operator to set default (predetermined) file paths for storage and recall of 
messages, images, Playlists, effects, Clip files and 3D objects.  This makes it easier for different file types 
associated with a project to be automatically saved to and easily accessed from an organized set of 
directories.  The Default Paths settings can then be saved as part of a saved User Profile, which can be 
recalled for future use. 

Setting Default Paths does not prevent the use of non-default file paths.  Save As or Open (Ctrl + O), 
accessed from the File menu, can be used to save or open, respectively, files which are to be stored to or 
read from non-default directories.  Additionally, non-default file types can be stored in default directories. For 
example, it may be advantageous to store a Macro file in a Default Messages directory for a particular 
project.  

To view the Default Paths, click on the Default Paths tab in the Preferences dialog box.  The Default Paths 
tab is displayed. 

 

Default Paths Preferences 
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If previous changes have not been made, the original Default Paths that were set in Lyric on installation are 
displayed.  There are six Default Paths listed: 

Directory Name Description 

Messages The default directory for saving and reading Lyric messages 
(.lyr).  This directory also determines the Intelligent Interface 
directory, i.e. the directory to which Intelligent Interface-
generated messages are written.  

Images Contains 2D bitmap images.  Lyric supports many bitmap 
formats. 

Playlists Contains Playlists (.ply). 

Effects Contains effects messages (.efx), such as those created using 
Read Effects.  

Clip Files Contains Clip files (.ccf). 

3D Objects Contains 3D objects.  Lyric supports .3ds, .prj and .obj formats. 

Note that file such as Macros (.lmx, .lyr) and User Profiles (.reg, .lup), unless otherwise set in a Save dialog 
box, automatically save to the directory in which Lyric is installed.  

There are two methods which can be used to change Default Paths: 
 Change an individual Default Path. 

 Change the Default Paths as a group. 
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To change an individual Default Path: 
1. Double-click on the directory name in the list of Default Paths.  In this example, Playlists is selected.  

A directory-type-specific dialog box is displayed.  In this instance, it is Choose a new directory for 
Playlists. 

 

Changing an Individual Default Directory 

2. Navigate to the new directory.  If necessary, a new directory can be created using the Create New 
Folder Tool, located in the upper right corner of the dialog box. 

 

Create New Folder Tool 

3. Select the new directory.  The directory name appears in the Dir. field. 

4. Click OK.  The name of the new directory is now reflected in the Default Paths list. 
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Lyric has a convenient facility that enables the creation of grouped directories and subdirectories for each of 
Lyric’s file types and other assets. 

1. In the Default Paths dialog box, click Create Project Hierarchy.  The Select Root Directory dialog 
box opens. 

2. Use the New Folder tool to create a new directory.  In this example, it will be called 
LyricResourcesII.  

3. You will be prompted to create a subdirectory for each file type.  Click Yes for each. 

 

Creating a Group of Default Directory Paths 
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4. After confirming the creation of the 3D Objects directory, the Select Root Directory dialog box 
should appear as follows: 

 

Root Directory with Updated Default Directories 

The Default Paths list in the in the Default Paths dialog box will also reflect the new settings. 
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Alignment Preferences 
Config Menu > Preferences > Alignment 
The Alignment function allows the operator to superimpose a customized grid on the Canvas, and to force 
alignment of objects to the nearest grid line(s).  The Alignment Grid is useful for precise positioning of text, 
templates and other objects within the composition.  

 

Canvas Grid Settings 

Set the following parameters, the click Apply to apply the settings and check the appearance of the grid lines 
on the Canvas, or OK to apply the settings and exit Preferences. 

Parameter Description 

Grid Spacing The distance between the grid’s horizontal lines (Y axis) and 
vertical lines (X axis) can be independently adjusted by 
entering values directly or using the up/down arrows (Grid 
Spacing).   Units are in pixels for X, and scanlines for Y. 

Snap to Grid The Snap to Grid function causes an object to “settle” at the 
nearest horizontal and/or vertical grid lines as specified in 
Alignment Preferences, when it is newly created or imported 
or moved from one place on the Canvas to another. 

 To enable/disable horizontal Snap to Grid, 
check/uncheck the Snap to Grid X checkbox. 

 To enable/disable vertical Snap to Grid, 
check/uncheck the Snap to Grid Y checkbox. 

Show Grid The Show Grid function displays or hides the horizontal and/or 
vertical grid lines as specified in Alignment Preferences. 

 To enable/disable display of horizontal grid lines, 
check/uncheck the Show Grid X checkbox. 

 To enable/disable display of vertical grid lines, 
check/uncheck the Show Grid Y checkbox. 
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Windows Preferences 
Config Menu > Preferences > Windows 
Display options for the Lyric windows and the Canvas are set in the Windows tab. 

Basic Windows 
The user may specify any combination of on the Lyric interface as Basic Windows.  There are two Windows 
display choices accessible on the from the Chyron Tools on the Lyric interface: 

 Basic Windows On:  When Basic Windows is turned on ,only the Canvas and the windows 
specified in Preferences > Windows are displayed.  Any other open windows are hidden from view. 

 Basic Windows Off:  When Basic Windows is turned off , all open windows are displayed. 

Note that the Basic Windows button was formerly known as the Canvas Only button. 

The Basic Windows, as well as Canvas display preferences, are set in the Windows tab. 

 

Windows Preferences 

To set the Basic Windows: 

 In the Basic Windows area, select (check) the checkboxes next to the names of the windows that 
are to be displayed when Basic Windows is turned on. 

Canvas 
Display All Frame Buffers 
Lyric provides the option of displaying all available frame buffers. 

 When Display All Frame Buffers is enabled (checked), each frame buffer that is currently not active 
is displayed on its own miniature Canvas, allowing preview of the inactive Frame Buffers.  The figure 
below shows Frame Buffer 2 displayed in the lower right corner of the interface.  It cannot be edited 
until it becomes an active frame buffer through a Swap operation. 

 When Display All Frame Buffers in disabled (unchecked), only the active Frame Buffer is 
displayed. 
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Lyric Interface Showing All Available Frame Buffers   

Lock Canvas Size and Position 
Lock Canvas Size and Position allows the user to lock the size and position of the Canvas in the Lyric 
interface, in order to prevent accidental resizing or repositioning.  To enable/disable: 

 Select (check) or deselect (uncheck) the Lock Canvas Size and Position checkbox. 

Lock Viewport Sizes 
When the Multi Canvas View is displayed, the individual Canvas Views in the Multi View can be resized.  
The displayed sizes can be locked to prevent unintentional resizing, or they can be unlocked to allow resizing.  
To toggle between locked and unlocked: 

 Select (check) or deselect (uncheck) the Lock Viewport Sizes checkbox. 

Refer to the section on the Canvas for additional information regarding Canvas Views. 
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9. File Menu 

File Menu 
From the File menu, familiar Windows file operations such as Open, Save, Save As and Close can be 
performed.  The File menu also contains Lyric-specific file Import and Export functions. 

Certain File Open, Save and Save As operations can be performed using Lyric's Read and Record 
functions, as well as via the Lyric Browser.  Refer Recording and Reading Messages and to Browser:  
Message Asset Operations for additional information. 

 

File Menu 

All File menu items are covered in this chapter except the following: 
 Import from iNFiNiT! and Export to iNFiNiT! are covered in depth in the chapter on iNFiNiT! 

Family Systems and Lyric. 

 Import from Aprisa and Export to Aprisa are covered in depth in the chapter on Aprisa Systems 
and Lyric. 

 Import from Quantel and Export to Quantel are covered in depth in the chapter on Quantel 
Systems and Lyric. 

 Export to iTV is covered in depth in the chapter on iTV. 
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New 
File Menu > New;  Windows Toolbar ;  Ctrl + N 

 

Creating New Canvas, Browser, or Playlist 

Use the New command to create a new Canvas, Browser, or Playlist in Lyric. 

Open  

File Menu > Open;  Windows Toolbar ;  Ctrl + O 
Use this command to open an existing Lyric messages, Playlists or any of the other file types shown below.  

 

Opening a Playlist File 

Take note, however, that the presence of the All Files option does not allow opening bitmap files in a Lyric 
composition. These files must be imported into a composition using the Graphic Import command. 
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Close 
File Menu > Close 

The familiar Windows button is never available on the Canvas itself.  This is a safety measure.  If you wish 
to close a composition when the Canvas is the active window: 

 Select File > Close. 

File > Close can be used to close the currently active Canvas, Browser, or Playlist.  If a file such as a 
Canvas or Playlist has unsaved changes, Lyric displays a Save prompt. 

 

Canvas 
 

Playlist 

   

Clicking Yes opens the Save As dialog box , in which File Name, File Type and other associated information 
can be entered. 

Selecting Exit on the File menu or selecting the  button on the Lyric interface also closes the current 
composition.  If the composition has unsaved changes, Lyric displays one of the prompts seen above. 

 

Windows Close Button 
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Save 

File Menu > Save; Windows Toolbar  ;  Ctrl + S 

Save saves, or records, a file.  The type of file depends on the current focus, or cursor location, in the Lyric 
interface.  The Save function is accessed as follows: 

1. In the Windows Toolbar, click the Save icon , press Ctrl + S or select Save from the File menu.  
A prompt is displayed asking for overwrite permission.  If the file has not yet been named, it is 
assumed by Lyric that the name is Untitled. 

 

Overwrite Confirm 

2. Click OK to save, or Cancel to cancel the save. 

The different files types are described in the following sections. 

Saving a Lyric Message 
If the focus is on any part of the Lyric interface other than a Playlist or the Macros dialog box, Save saves 
the Lyric message (*.lyr) using the file name currently displayed on the Canvas Title Bar.  If the file has not 
previously been saved, it is saved under the name Untitled, to the Default Message Directory.  The file is 
saved to the Default Message Directory as set in Config Menu > Preferences > Default Paths. 
The message file is also saved to the Browser database if File Save Adds to Browser is selected (checked) 
in Config Menu > Preferences > Browser.  Name in file name displayed in the Browser is the same as that 
displayed in the Canvas Title Bar. 

Saving a Playlist 
If the focus is on the Playlist, the Save As dialog box is displayed. and Playlist Files ( *.ply) is automatically 
displayed in the Save as Type field.  Refer to the chapter on Playlists for additional information. 

Saving a Macro 
If the focus is on the Macros dialog box, the Save Macros To dialog box is displayed, and Lyric Macro Files 
(*.lmx)is automatically displayed in the Save as Type field.  Refer to the chapter on Macros for additional 
information. 

Additional Save Methods and File Types 
There are many saving options in Lyric.  Refer to the section on the particular type of file or feature.  For 
example, there are Clock/Timer files, two types of Macros files, etc. 
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Save As 
File Menu > Save As 
Save As can be used to store a modified version of the file without overwriting the original, store a Lyric 
message or other type of file to a destination or name other than the default path or a numeric message 
number, or store the file as a different type of file.  For example, a Lyric animation can be stored as an *.avi 
animation.. 

If Save As is used to store duplicate versions of the same message to different locations, it can cause the 
same thumbnail to appear twice in a Browser Window.  This may be useful to remind the operator that a 
message is stored in two different locations.  When duplicate assets appear in the Browser, the Text Only 
view or Icons and Text view can be checked to verify the location of each copy. 

The following example demonstrates how to save an animation. 
1. From the File menu, Select Save As.  The Save Animation dialog box opens. 

 

Save Animation Dialog Box 

Take note of the option checkboxes in the upper-left corner of the dialog. Remember that the availability of 
these options will vary with the file-format you're saving in. 
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Also note that when a Playlist is the active window on the interface, the Save As dialog defaults to the Playlist 
format. 

 

Saving File as a Playlist 

To save changes to a file without altering its name or format, use the Save command. 
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Print/Print Preview 

Print:  File Menu > Print;  Windows Toolbar ;  Ctrl + P 
Print Preview:  File Menu > Print Preview 

Printing a Lyric Composition 
Print and Print Preview functionalities for printing images of Lyric compositions are not implemented at this 
time.  An image of the entire Lyric interface can, however, be captured, pasted into a paint or other graphics 
program, and then printed. 

To perform a screen grab and paste: 

1. From a Duet keyboard:  Press Fn + Erase/Print Screen.  The Fn key is located directly to the left of 
the right Shift key.  The top of the keycap is blank; the front is labeled "Fn."  The Erase/Print Screen 
key is at the top right of the keyboard. 

From a PC keyboard:  Press Print Screen. 

2. Launch a paint or graphics program; open a new file; then paste the captured image into the blank 
Canvas.  The image can now be saved and printed. 

Printing Online Help 
If the Duet system or PC is connected to a printer, Online Help topics can be printed. 

From within the Online Help window: 

 Right-click, then select Print... from the context menu, then proceed as usual from the Print dialog 
box. 

OR 

 Click on the Print icon in the Online Help toolbar, then proceed as usual from the Print dialog box. 

 

Print Icon in Online Help 

Print Setup 
File Menu > Print Setup 
Printing parameters such as printer choice and connection are set from Print Setup.  Note that while Lyric 
does not currently support printing, a printer can still be set up for use outside of Lyric.  Consult Windows and 
printer-specific documentation for complete details on printer setup. 

To access Print Setup: 

 Select Print Setup from the File menu. 
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Backup Utility 
File Menu > Backup 

Lyric provides a Backup Utility for the various types of files used by Lyric, as well as Browser databases.  
The Backup Utility can be used to back up files created in older versions of Lyric, and then convert the files 
into Lyric 5.0-compatible files.  It is also useful for backing up specified sets of Message Assets, Files 
Types, and/or Browser Assets.  For example, a different show may just need a set of fonts that are stored in 
a particular Browser database.  The fonts alone can be backed up and then restored to another system.  
Files and Browser databases are restored using Lyric's Restore Utility.  To access the Backup Utility: 

 From the File menu, select Backup.  The Lyric Backup Utility dialog box opens. 

 

Lyric Backup Utility 
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The Lyric Backup Utility dialog box is comprised the following areas: 
 From:  Files can be backed up from either a directory or a Lyric Browser. 

o When Browser is selected, the dropdown list box in the From area displays a list of Lyric 
Browsers from which a backup can be generated.  The File Types area at the left of the 
dialog box is grayed out.  When the backup is generated, it includes the selected Message 
Assets and Browser Assets, as well as the Browser database itself.  Where applicable, 
images that are part of RGB Fonts are included as well. 

o When Directory is selected, the drop-down list box becomes a field into which a directory 

path can be entered.  A navigation button  appears next to the field.  A directory can also 
be selected by clicking the navigation button, and then navigating to a directory in the 
Browser for Folder dialog box.  The Browser Assets area at the left of the dialog box is 
grayed out.  When the backup is generated, it includes the selected Message Assets and 
File Types, as well as any fonts that are necessary for restoring backed-up messages.  Note 
that files in subdirectories of the selected directory are not backed up. 

 

Browse for Folder 
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 To:  The destination file for the backup is entered in the To field.  A file can also be selected by 

clicking the navigation button , and then navigating to a directory in the Save As dialog box and 
entering a file name.  Note that the file is saved with the extension *.lbu, which is a Lyric Backup File 
format. 

 

Save As 

 Options - Convert Messages to 4.3 Format:  If selected, any backed up messages are converted to 
Lyric 5.0 format.  If not selected (unchecked), backed up messages are saved in their original format. 

 Status:  Displays the status of the backup as it is in progress. 

 Message Assets:  A list of message asset types from which can be selected any or all for backup.  
Message Assets are the assets that belong to a message.  For example, a message can contain 
TrueType fonts, bitmap images, and a data source as its message assets.  Selecting (checking) an 
asset type includes all files of that asset type from the selected Browser/directory in the backup.  
Message Assets include: 

o Bitmaps:  2D images in supported formats. 

o Flipbooks:  Lyric Flipbooks. 

o Video Clips:  Animations in supported formats. 

o Audio Clips:  Sound files in supported formats. 

o TrueType Fonts:  Fonts on which Lyric fonts are built.  Note that RGB Fonts are 
automatically backed up with the message, even if Bitmaps is not selected. 

o Data Sources:  Data sources such as Microsoft Excel spreadsheets which are referenced by 
Lyric messages for update. 

 File Types:  A list of file types from which can be selected any or all for backup.  Selecting (checking) 
a file type includes all files of that file type from the selected directory in the backup.  File Types 
include Messages, Playlists and Macros.  File Types are not available to Browser backup. 

 Browser Assets:  A list of Browser assets from which can be selected any or all for backup.  
Selecting (checking) a Browser asset includes all files of that Browser asset type from the selected 
directory in the backup.  Browser Assets include Messages, Bitmaps and Fonts.  Browser assets 
are not available to directory backup. 

 Start:  Starts the backup process. 

 Stop:  Stops the backup process. 

 Close:  Closes the Lyric Backup Utility dialog box. 
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To perform a backup: 
1. In the From area, select either Directory or Browser. 

2. In the To area, enter the backup file name.  The File as Type field is always set to *.lbu for this 
operation. 

3. In the Message Assets and the Browser Assets (for Browser backup) or File Types (for Directory 
backup) areas, select the appropriate file types for backup. 

4. Optional:  In the Options area, select (check) Convert Message to 5.0 Format. 

5. Click Start. 

 If Convert Message to 5.0 Format is selected, the following message is displayed.  Click 
Yes to continue, or No to stop backup execution. 

 

Conversion Warning 

 If the file name entered in the To area File field is the same as the name of a file already in 
the same directory, the following message is displayed.  Click Yes to continue, or No to stop 
execution. 

  

Overwrite Confirm 
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6. The backup process proceeds, and files are recorded to a Lyric *.lbu file.  The Status window 
displays the progress of the backup as the information is simultaneously recorded to a log file with the 
same name as the backup file. 

 

Browser Backup Execute 

The Status window may indicate that elements such as images are missing from a message.  When 
the backup is complete, the following is displayed, specifying the number of files that have been 
archived.  Click OK, and then click Close to exit the Backup Utility window. 

 

Backup Results 

Both the backup and log files are saved to the directory specified in the File field.  The backup file (*.lbu) is 
accessed by Lyric's Restore Utility to restore Lyric files.  The log file (<backup file name>_lbu_backup.log) 
can be viewed by double-clicking on its listing or icon in its directory.  It can also be opened in a text editor. 

It is good practice to review the log file each time a Backup is performed.  The log file lists the files that were 
backed up, as well as files that are referenced, but are missing. 
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Restore Utility 
File Menu > Restore 
Lyric's Restore Utility provides the ability to restore files and Browser databases that have been backed up 
using Lyric's Backup Utility. 

  To access the Restore Utility: 
 From the File menu, select Restore.  The Lyric Restore Utility dialog box opens. 

 

Restore Utility 
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The Lyric Restore Utility dialog box is comprised the following areas: 
 Restore From:  The source file for the restore operation is entered in the From field.  This file has 

the *.lbu extension. 

 Restore To:  Files can be backed up to either a specified root drive or to a specified path for each 
type of asset or file type. 

o When Specify New Root Drive is selected, the dropdown list box in the Restore To area 
displays a list of available drives to which the files can be restored.  The filepath fields are 
grayed out. 

When a restore is executed to the same drive as the backed-up files, the files are restored to 
their original locations. 

When a restore is executed to a different drive from the original, the assets specified for 
restoration, the Browser database (if specified) and the directory structure containing the 
specified assets are copied to the new drive. 

Regardless of the destination of the restored Browser and its assets, all TrueType® fonts 
associated with the Browser are restored to a RestoredFonts directory that Lyric creates in 
the Lyric installation directory on the system.  Note that this may be different from the drive 
specified as the destination.  If these fonts are not resident in the Windows Fonts directory, 
they must be copied into the directory to ensure that the restored Lyric messages display 
properly. 

o When Specify New Path is selected, the filepath fields become active, and separate 
filepaths can be entered for each file or asset type.  When a Restore is executed, the 
selected groups of files are restored to the specified directories.  If a file type is selected 
(checked), but no path is entered, the files of that type are copied to the same location as the 
backup file from which the restoration is generated.  As previously described, the TrueType 
fonts must be copied from the RestoredFonts directory to the Windows Fonts directory.  
Note that Bitmap Fonts are the same as Lyric RGB Fonts and Data Sources are data files 
such as Microsoft Excel spread sheets which are references by Lyric messages.  They are 
not to be confused with Browser databases. 

 

Specify New Path 
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To perform a Restore: 
1. Enter the name of a Backup File. 

2. Select either Specify New Root Drive or Specify New Path. 

3. If Specify New Root Drive is selected, skip to the next step.  If Specify New Path was selected, 
select the file types to restore, and then enter their file paths. 

4. Click Start.  The Restore operation proceeds, and progress is displayed in the Status window. 

 

Restore in Progress 
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5. If the Restore operation encounters a file with the same name in the destination directory as a file it is 
about to restore to the directory, an overwrite prompt is displayed.  Click Yes to overwrite the file; Yes 
to All to overwrite all files with duplicate file names; No to prevent overwrite of the file, or No to All to 
prevent overwrite of all files with duplicate file names. 

 

Overwrite Confirmation 

Note that even if No or No to All is selected, the Restore operation still decompresses all of the files, 
although it does not overwrite the indicated files.  Additionally, TrueType® fonts that are components 
of the backup file are always written to the RestoredFonts directory (see Step 8), regardless of 
whether or not No or No to All has been selected. 

6. The Status window indicates when the Restore is complete.  If a directory has been backed up, skip 
to the next step.  If a Browser has been backed up, the New Browser Name window is displayed.  
Enter the name of the new Browser, then click OK. 

 

New Browser Name 

7. The BackupRestore prompt is displayed, indicating how many files were restored from the archive.  
Click OK. 

 

Number of Files Restored from Archive 
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8. If a TrueType font(s) was a component(s) of any message in the backup file, the following is 
displayed when the messages are restored.  Fonts that are not already in the destination system's 
Windows Fonts folder must be copied to the folder in order that the restored messages display 
properly.  Click OK. 

 

Font Copy Prompt 

9. If necessary, copy the fonts from the RestoredFonts directory to the Windows Fonts directory.  The 
messages are now ready to display. 
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Summary Info 
File Menu > Summary Info 
Summary Info is not implemented at this time. 

Recently Used File List 
File Menu > File Listing Directly above Exit Menu Item 
Lyric lists up to eight of the most recently accessed files in the File menu as shown below.  Any listed file can 
easily be opened by clicking on the file listing. 

 

List of Recently Used Files 

Exit 
File Menu > Exit 

Selecting Exit on the File menu or selecting the  button on the Lyric interface closes the application.  If the 
current composition has unsaved changes, Lyric shows one of the prompts seen above. 

 

Exit Button 
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10. Browsers 

Overview 
View Menu > Browsers 
File Menu > New > Browser 

Introduction 
The Browser is a powerful Lyric tool that enables the user to create catalogs of Lyric font, image, message 
and clip assets tailored to specific projects (news, baseball, features, etc.).  These catalogs are databases, 
also called Data Sources, that contain identifying information about each asset, but not the asset itself. 

This allows the asset to be included in multiple databases without the necessity of copying the asset to each 
location where the database resides.  It is an important concept to understand, as an entry for an asset can 
be added to and deleted from the database without disturbing the original asset. 

Databases can be quickly recalled for use as a sources for Lyric compositions or Lyric Playlists.  Major 
features are as follows: 

 Multiple Browser displays may be opened to list various asset types simultaneously. 

 Asset entries can be displayed as just icons, just text or a combination of icons and text.  Icons can 
be small, medium or large. 

 Asset entries can be sorted in alphabetical or reverse alphabetical order. 

 A database can be searched using a variety of criteria, making it easier to locate a specific asset.  

The Browser also provides the ease of inbound and outbound drag-and-drop capability: 
 Bitmap, Lyric Message, Aprisa and Quantel assets from the Browser window to the Lyric Canvas 

or into a 2D Text Window in the Canvas. 

 Bitmap and Aprisa 100 (Still) assets from the Browser Window to Texture Chip in Properties > 
Surface. 

 Lyric Message Assets from the Browser window to the File Name field in the Playlist. 

 Assets from one Browser window to another Browser window. 

 Font Assets from the Browser window into Properties > Fonts or Properties > 2D Font FX. 

 Lyric messages and graphics from Windows® Explorer®-type windows into Lyric Browser Message 
Asset and Bitmap Asset Browser windows, respectively. 

 Alt + drag-and-drop a Bitmap Asset or Aprisa 100 (Still) asset to create a background for a 
Canvas, 2D Text Window or 2D Text Template. 

Browser databases are files separate from font, message graphics and clip files.  They conform to the 
Microsoft® Access database format, and can be registered as ODBC data sources for use by Chyron's 
CAMIO and MOS Media Solutions.  Refer to Browser Preferences > Advanced for additional information on 
ODBC registration. 

NOTE 
The terms "database" and "data source" are used interchangeably throughout Lyric 
documentation. 

The Browser Window and Browser Menu 
The figure below shows a Browser menu and a Browser window.  If at least one Browser window is not 
visible on the Lyric interface, choose one of the following methods to display a Browser: 

 Pull down the View menu, then, select Browsers. 

 Pull down the File menu, then select New > Browser. 

Click on the Browser window to make it active.  The Title Bar should turn blue.  Whenever a Browser 
window is active, a Browser menu heading appears on the Menu Bar of the Lyric interface.  Pull down the 
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Browser menu.  As shown in the figure below, each item on the menu corresponds to a Browser icon in the 
Browser window.  Note that the Browser window/Browser menu items Show Aprisa Stills, Show Aprisa 
clips and Show Quantel Images are grayed out if the specified systems are not networked to the Duet. 

Default Lyric Fonts and Lyric Messages assets are set in Config Menu > Preferences > Browsers, so that 
when a new Browser is opened, it is automatically loaded with user-defined sets of fonts and messages.  

When Lyric is opened, the Browser(s) that was opened in the previous session of Lyric are displayed.  When 
a new Browser window is opened, it displays the Font Assets catalogued in the last opened database from 
Select Database.  If no database was opened, then it displays the default database set in Config Menu > 
Preferences > Browsers > Set Font Source. 

 

Browser Menu and Browser Window (Showing Font Assets) 

If the following warning is displayed on opening Lyric and/or on attempting to open a Browser window, the 
database(s) which it is attempting to access has either been moved, deleted or renamed. 

 

Cannot Create Browser Window Warning 
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Either select a different data source(s) via the Config Menu > Preferences > Browser, or move and/or 
rename the data sources to the proper path(s). 

Troubleshooting Browser Database Display 
If there are problems displaying a particular database, where the database and the assets are in the correct 
locations: 

 Select a different database to display in the Browser in order to close the affected database, then 
perform the Repair procedure from the Configure function in the ODBC Data Source 
Administrator.  Refer to Registering an ODBC Database for information on accessing the ODBC 
Data Source Administrator, and Windows® documentation for details on the Repair function.  For 
instructions on selecting a different database to display in the Browser, refer to Browser:  
Creating/Selecting/Importing/Deleting a Database or Browser Preferences. 

The following prompts indicate that a database has been moved or deleted: 

 

DSN Not Valid 

 

Cannot Find Database 

If a database has been moved, one of the following methods can be used to restore the database: 
 The database can be moved to the proper location. 

 The Browser database can be backed up and restored to the proper location using the Backup 
Utility and then the Restore Utility, both available from Lyric's File menu. 

If a Browser asset is unavailable (moved or deleted), a red slash is displayed across the icon (thumbnail) for 
the asset. 

For Font assets, if the Browser is set to the Text Only view (no icons), a red line is displayed across the text.  
The following shows an unavailable TrueType® font asset as seen in a Icons and Text view. 

 

TrueType® Font Asset Unavailable 
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The following shows an unavailable Message asset. 

 

Message Asset Unavailable 

If assets an have been moved, one of the following methods can be used to restore the assets to the 
Browser: 

 The assets can be moved to the proper location. 

 The assets can be re-added to the Browser database.  The red-slashed assets can be deleted. 

 The Browser assets can be backed up and restored to the proper location using the Backup Utility 
and then the Restore Utility, both available from Lyric's File menu. 

If a Browser database and its assets have been moved: 
 They can be restored to the proper location using the Backup Utility and then the Restore Utility, 

both available from Lyric's File menu. 

Navigating the Browser Window 
To quickly switch the focus in Lyric to the topmost Browser Window: 

 Press F4. 

The keyboard can be used to navigate the Browser Window: 
 Press the cursor keys  to move from item to item in the Browser Window. 

 Press Home to select the first item in the Browser Window. 

 Press End to select the last item in the Browser Window. 

 When a Browser item is highlighted, press either Enter key to open the selected item.  Double-
clicking the item also opens the item. 

 Typing any character key finds the next Browser entry with a title that starts with that character.  For 
example, in a Browser Window containing images titled Red, Rose and Yellow, typing r selects 
Red and scrolls it into view.  Typing r again selects Rose, and typing y selects Yellow. 

 In the Font Browser, typing a character selects and scrolls to the image mapped to that character.  
Refer to RGB Font Asset Operations for additional information. 

Browser Assets 
View Menu > Toolbars > Browser Commands 

There is a set of icons which form the Browser Asset Toolbar, usually found across the top of the Browser 
window.  Like other toolbars, it can be moved and reoriented.  If a Browser window is open, but the Browser 
Asset Toolbar does not appear: 

 Pull down the View menu, select Toolbars, the select Browser Assets.  The toolbar should now be 
displayed. 
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Selecting (clicking) an icon, or selecting the corresponding Browser menu item displays the available assets 
of that type from the current data source.  The Title Bar of the Browser window displays the name of the 
Data Source for the selected set of assets.  In the previous example, it is simply called Browser. 

Browser 
Icon 

Browser 
Menu Item 

Description 

 
Show Font 
Assets 

Displays the available TrueType®-based and RGB 
(bitmap-based) fonts that can be used to create 
Lyric messages. Note that the two red lines at the 
left of the upper/lower case characters in the font 
icon represent the span of 50 scanlines in height.  
The example below shows the icon for a 150-
scanline font. 

 

150-Scanline Font 

Font assets can also be dragged-and-dropped into 
Properties > Fonts and Properties > 2D Font FX.  
Refer to Browser Font Operations and RGB 
Fonts for details on Browser font operations.  Font 
Assets are covered in depth in the chapter on 
Creating and Using Fonts in Lyric. 

 
Show 
Message 
Assets 

Displays the available Lyric messages that can be 
imported into the Canvas, or added to a Playlist.  
Refer to Message Asset Operations for details. 

 
Show Bitmap 
Assets 

Displays the available 2D graphics, in graphic 
formats supported by Lyric, that can be imported 
into the Lyric Canvas.  Bitmap Assets are covered 
in depth in the chapter on 2D Objects. 

 
Show Aprisa 
Stills 

Displays the available images (stills) from the 
database of a networked Chyron Aprisa 100/250 
system.  This icon/item is grayed out if an Aprisa 
100/250 is not networked to the Duet  Aprisa Still 
Assets are covered in depth in the chapter on 
Aprisa Systems and Lyric. 

 
Show Aprisa 
Clips 

Clips from the database of a networked Chyron 
Aprisa 200/250 system.  This icon/item is grayed 
out if an Aprisa 200/250 is not networked to the 
Duet.  Aprisa Clip Assets are covered in depth in 
the chapter on Aprisa Systems and Lyric. 

 
Show 
iNFiNiT! 
Fonts 

Displays available Fonts from a networked Chyron 
iNFiNiT!®, MAX!>® or MAXINE!® system.  
iNFiNiT!® Font Assets are covered in depth in the 
chapter on iNFiNiT!® Family Systems and Lyric. 
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Browser 
Icon 

Browser 
Menu Item 

Description 

 
Show 
Quantel 
Images 

Images from a networked Quantel® system.  This 
icon/item is grayed out if a Quantel system is not 
networked to the Duet.  Quantel Assets are 
covered in depth in the chapter on Quantel® 
Systems and Lyric. 
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The following figures show sample data sources of Lyric Message and Bitmap assets: 

 

Lyric Message Assets 
 

Bitmap Assets 

About Data Sources 
All assets displayed in the Browser are catalogued in various databases.  The Title Bar of the Browser 
Window displays the name of the data source from which the assets are displayed.  For example, in the 
Browser Windows shown in this section, the Title Bars show that the Font Asset database is Browser, 
which is Lyric's default Font source.  The Message data source, from which the Bitmap Assets are 
automatically drawn, is also Browser, which is Lyric's default Message source.  Note that the Font and 
Message sources displayed in a Browser window can be different from each other.  Refer to 
Creating/Selecting/Importing/Deleting a Database for additional information on data sources. 

 When Font Assets are displayed, the Browser Title Bar displays the name of the data source set in 
the Set Font Source field in the Select Data Source dialog box or Browser Preferences tab.  Refer 
to Creating/Selecting/Importing/Deleting a Database or Browser Preferences for information on 
selecting a data source. 

 When Message Assets are displayed, the Browser Title Bar displays the name of the data source 
set in the Set Message Source field in the Select Data Source dialog box or Browser Preferences 
tab.  Refer to Creating/Selecting/Importing/Deleting a Database or Browser Preferences for 
information on selecting a data source. 

 When Bitmap Assets are displayed, the Browser Title Bar displays the name of the data source set 
in the Set Message Source field in the Select Data Source dialog box or Browser Preferences tab.  
Bitmap Assets are always drawn from the same data source as the Message Assets.  Refer to 
Creating/Selecting/Importing/Deleting a Database or Browser Preferences for information on 
selecting a data source. 
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 When Aprisa 100 (Still) Assets are displayed, the Browser Title Bar displays the name Aprisa 
Stills.  There is only one Stills database on each Aprisa Still system.  Note that if the system 
accommodates both Stills and Clips, the system has one Still database and one Clips database.  

 When Aprisa 200 (Clip) Assets are displayed, the Browser Title Bar displays the name Aprisa 
Clips.  There is only one Clips database on each Aprisa Clips system.  Note that if the system 
accommodates both Stills and Clips, the system has one Still database and one Clips database. 

 When iNFiNiT! Font Assets are displayed, the Browser Title Bar displays the name iNFiNiT!.  
There is only one Machine Font database on each iNFiNiT! system. 

 When Quantel Assets are displayed, the Browser Title Bar displays the name Quantel.  The 
Quantel database is selected from within the Quantel Import dialog box, accessed from File Menu > 
Import from Quantel.  Refer to File Menu:  Import from Quantel for additional information. 
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Browser Commands 
View Menu > Toolbars > Browser Commands 

A set of icons, which form the Browser Commands Toolbar, is usually found along the left side of the 
Browser window.  Like other toolbars, it can be moved and reoriented.  If the Browser Commands Toolbar 
does not appear when a Browser window is open:  

 Pull down the View menu, select Toolbars, the select Browser Commands.  The Browser 
Commands Toolbar should now be displayed. 

Browser 
Icon 

Browser 
Menu 
Item 

Description 

 
Search 
Browser 

Accesses a search function that searches the current database 
using a variety of user-selected criteria.  This function is 
covered in detail later in this section. 

There are three groups of display options:  Icon(Thumbnail)/Text Display; Sort Order; and 
Icon (Thumbnail) Size.  Selecting (clicking) a display option icon, or selecting the 
corresponding Browser menu item sets the display. 

NOTE 
When a message is recorded to a database, a thumbnail is created to help 
identify the message.  If the message is modified, the thumbnail does not 
automatically update, even if the message is resaved, unless File Save 
Adds to Browser is enabled in Browser Preferences. 

If File Save Adds to Browser is not enabled, then the thumbnail can be 
updated as follows: 

 In the Browser Window, highlight the message.  Right-click to 
display the context menu.  Select Update.  The thumbnail and the 
Browser update. 

 
Text 
View 

Shows text information only about an asset.  The figure below 
shows a Browser window displaying the Text View of Lyric 
Message Assets. 

 

Text View 

 
Icon 
View 

Displays an icon view of the asset.  The Browsers shown 
preceding this table show Icon Views. 
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Browser 
Icon 

Browser 
Menu 
Item 

Description 

 
Icon/Text 
View 

Displays both an icon and text information.  The figure below 
shows a Browser window displaying the Text/Icon View of 
Lyric Message Assets. 

 

Text/Icon View 

 
Sort 
from A 
to Z 

Sorts asset entries from A to Z, based on file and/or font name.  
Assets are sorted first by name, and then by number. 

 
Sort 
from Z to 
A 

Sorts asset entries from Z to A, based on file and/or font name.  
Assets are sorted in reverse order first by number, and then by 
name. 

 
Show 
Small 
Icons 

Shows small-sized icons. 

 
Show 
Medium 
Icons 

Shows medium-sized icons. 

 
Show 
Large 
Icons 

Shows large-sized icons. 



 Browsers 

 10-11 

Browser 
Icon 

Browser 
Menu 
Item 

Description 

Browser Commands 

 
Save to 
Database 

Saves to the current database as follows: 

 Saves current message to the current Lyric Message 
database.  If the message is an animation, the 
thumbnail reflects the frame of the animation that was 
displayed at the time that the message was saved to or 
updated in the Browser.  Note that this does not affect 
a Preview Frame which may have been set for the 
message.  Refer to Selective Recording - Message 
with Options and Animation Settings Preferences 
for additional information on Preview Frames. 

 Saves currently active font to the current Font 
database. 

 Saves currently selected graphic to the current Bitmap 
database. 

 
Load from 
Database 

Loads the currently selected asset to the Lyric Canvas. 

 
Select 
Database 

Accesses the Select Database function, which enables 
selection of a new database for display in a Browser window.  
Databases can also be created, imported, deleted and 
registered as ODBC databases.  Once a database is selected, 
the name of the database is displayed in the Title Bar of the 
Browser window.  Refer to 
Creating/Selecting/Importing/Deleting a Database for 
details. 

 
Refresh 
Database 

Refreshes Browser display after changes have been made. 

NOTE 
A Refresh Database should always be 
performed: 

 On switching to a different set of 
assets in the Browser (e.g. from Aprisa 
Still to Aprisa Clip Assets). 

 After any change to or search of a 
database. 

Deleting a Browser Asset 
The procedure is similar for deleting various types of assets from a Browser: 

1. Right-click the asset, then select Delete from the context menu. 

OR 

Select (click) the asset in the Browser, then press Delete on a PC keyboard or Delete Character on 
the Duet keyboard. 

2. Respond to the confirmation prompt(s). 

For Delete procedures specific to a particular type of asset, refer to the section on that asset. 

WARNING!  There is no undo for the Delete operation. 



Lyric User Guide 

 10-12 

Updating a Browser Asset 
The procedure is similar for updating (modifying) various types of assets from a Browser: 

 Right-click the asset, then select Update from the context menu. 

For Update procedures specific to a particular type of asset, refer to the section on that asset. 

WARNING!  There is no undo for the Update operation. 

Editing a Browser Asset 
Information about an asset, referred to as metadata, can be edited. 

To edit Message or TrueType® font information: 
1. Right-click the asset, then select Edit from the context menu. 

2. Edit the fields in the Message/Font Information dialog box, then click OK or press Enter. 

To edit RGB Font information: 
1. Right-click the asset, then select Font Browser from the context menu. 

2. Edit the fields in the Font Browser, then click OK or press Enter. 

For Edit details specific to a particular type of asset, refer to the section on that asset. 

Searching Browser Assets 
TrueType®/RGB Font, Message, Bitmap and Aprisa Still and Clip Assets in a Browser database can be 
searched based on a variety of criteria including Keywords, Comments, Date Modified, etc.  These Search 
operations are covered in Searching the Browser.  Refer to iNFiNiT!® Font Asset Operations and 
Quantel® Asset Operations for information on searching these types of assets.  

Aspect Ratio and Graphic Import 
A graphic created in a resolution different from the current Canvas Resolution may result in a stretched or 
squashed appearance when imported.   If this occurs, correct the Use 1:1 Pixel Aspect for Graphics Import 
setting and reimport the graphic.  Refer to Getting Started - Canvas Resolution for details on setting these 
parameters. 
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Browser Message Asset Operations 

Browser > ;  Browser Menu > Show Message Assets 
The Message Asset Browser enables quick import of Lyric messages to the Canvas, additions of Lyric 
messages to the Browser database and cataloging of Message Assets.  The Message Asset Browser 
supports drag-and-drop of Lyric messages to the Canvas or Playlist, from one Browser window to another 
Browser window, and from Windows® Explorer®-type windows into the Browser. 

Lyric also provides the ability to edit the Message Asset information (metadata), delete the Message Asset 
from the database, and update the Message Asset when changes are made to the message.  Browser 
Message Asset entries contain information such as Author, Title, Comments, Keywords and Date 
Modified. 

Adding (Saving) a Lyric Message to the Browser Database 
When a Lyric message is added to the database, what is stored in the database is not the message itself, but 
rather the information about the message.  This includes searchable metadata and the path information to the 
message.  It does not, however, include the message itself.  The Browser simply references the message.  
This makes it possible for the same message to be referenced by virtually an unlimited number of Browser 
databases. 

Adding a Message to the Browser from the Canvas 
To add a Lyric message to a Browser from the Canvas: 

1. In Lyric, create, then save the message. 

2. Click  or select Save to Database from the Browser menu.  The icon/text listing for the 
message is added to the Browser window.  The message is assigned the currently displayed 
Message Number.  The number name can be changed using the Browser Message Asset Edit 
function, which is described later in this section.   

Adding a Message to the Browser from Another Browser 
To add a Lyric message to a Browser window from another Browser window: 

 Drag-and-drop the message from the originating Browser window to the destination Browser 
window. 

Adding a Message to the Browser from a Windows® Explorer®-Type Window 
To add a Lyric message from a Windows® Explorer®-type windows into the Browser window: 

 Drag-and-drop the message or a group of messages from the Windows® Explorer®-type window to 
the Browser window.  The files are assigned their file names, as opposed to a Message Number. 

Adding a Message to the Browser Automatically When a Message is Saved 
A message can automatically be added to the Browser when it is saved as a file.  To enable operation: 

1. From the Config menu, select Preferences, then the Browser tab.. 

2. Select (check) the File Save adds to browser checkbox, then click OK. 

Whenever a message is saved using the Record function, File > Save or File > Save As, the message is 
added to the Browser database with its assigned name. 

To disable this function: 
1. From the Config menu, select Preferences, then the Browser tab.. 

2. Deselect (uncheck) the File Save adds to browser checkbox, then click OK.  When a file is saved, it 
is no longer automatically added to the Browser database. 
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Loading a Lyric Message from the Browser to the Canvas/Playlist 
To load a Message Asset from the Browser to the Canvas, make the Canvas active, then choose one of 
the following methods: 

 Double-click the icon/text listing for the message. 

 Select (click or by cursor) the Message Asset, then click  or select Load from Database from 
the Browser menu. 

 Drag-and-drop the Message Asset to the Canvas. 

The Message Asset loads to the Canvas.  If the message has a numeric file name, the Message Number 
Display usually found at the bottom of the Canvas increments to the following number. 

To load a Message Asset from the Browser to a Playlist: 
 Drag-and-drop the Message Asset into the File Name field of the step to which the message is to be 

added. 

The Message Asset Context Menu 
Information (metadata) about the Message Asset can be edited via the Message Asset context menu.  A 
Message Asset can also be updated or deleted.  To access this menu: 

 Right-click on the Message Asset. 

 

Message Asset Context Menu 
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Edit 
A Message Asset consists of the metadata, which is information about the message, as well as a path to the 
message.  The user-defined metadata enables easier access to the message by providing the means to 
easily search as well as identify the function of the message. 

 

Message Asset with Message Information Dialog Box 

Contents of the Message Information fields are reflected in the Browser Text View and Icon/Text View 
displays. 

 

Browser Showing Message Information 
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There are both user-defined and non-editable parameters in the Message Information dialog box.  The non-
editable parameters are determined on creation/modification of the font. 

Parameter Description 

Author Identifies the author of the message. 

Title Identifies the title of the message.  By default, it reflects the file 
name, but can be edited.  The file name does not reflect any 
change to the Title. 

Comments Reflects the text displayed in 2D Text windows in the message 
(see arrow above).  Additional information can also be typed in 
the Comments field to further define use or provide other 
information.  Text typed into the Comments field does not 
change the contents of the 2D Text windows on the Canvas.  
The text from the 2D Text windows can also be edited without 
changing the contents of  the 2D Text window on the Canvas. 

The Comments field can accommodate 255 characters.    
Pressing Enter performs the same function as clicking OK, so it 
cannot be used to start a new line.  To insert a carriage return in 
the field: 

 Press Ctrl + Enter. 

Keywords Keywords that can be used for Browser Search purposes. 

Subject Identifies the subject of the message, e.g. news. sports, 
weather, etc. 

Last Modified Indicates date that the message was last modified.  Information 
field only - not editable from within this dialog box. 

Path and File Identifies the path to the file. 

OK or press 
Enter 

Applies the parameter settings to the Message Asset.  

Cancel Cancels the application of the settings to the Message Asset. 
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Delete 
The Delete function enables deletion of a Message Asset from the database.  Deleting a Message Asset 
from a Browser database does not delete the message itself, only the reference to the message. 

To delete an individual message from a Browser database: 
1. Right-click on the Message Asset icon/text listing, then select Delete from the context menu. 

OR 

Select (click) the Message Asset, then press Delete on the PC keyboard or Delete Character on the 
Duet keyboard. 

The following prompt is displayed. 

 

Delete Message Asset Prompt 

2. Click Yes to confirm the deletion of he message from the Browser database.  The following prompt is 
displayed: 

 

Delete Message File Prompt 

3. Click Yes to delete the message file from disk, or No to preserve the message file. 

IMPORTANT! 
Selecting Yes permanently deletes the original message file.  Before deleting the file from 
disk, make sure that it is not referenced by other Browser databases or Playlists!  There 
is no Undo for this operation! 

To delete a group of messages from the database: 
1. In the Browser, use one of the following methods to select the messages to be deleted: 

 Selecting a Contiguous Range of Messages:  Click the first or last message in the range, 
then press and hold the Shift key while clicking the last or first message in the range. 

 Selecting Non-Contiguous Messages:  Press and hold the Ctrl key while clicking each 
message that is to be deleted. 

2. Press Delete.  The messages are deleted from the Browser.  Note that they are not deleted from 
disk. 
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Update 
The Update function applies the contents of the Lyric Canvas to a Message Asset in the Browser.  To 
perform an update: 

 Right-click the Message Asset to which the update should be applied, then select Update.  The 
contents of the Lyric Canvas replaces the message that was right-clicked.  All metadata (except for 
Last Modified Date) and path information remain unchanged. 

CAUTION! 
Make sure that the Message Asset Icon/Text listing that is right-clicked is the intended 
target for the update.  For example, if Message Number 1003 is active (i.e. its listing has a 
red border in the Browser and it is displayed on the Canvas), then right-clicking Message 
1008, then selecting Update, will replace the graphics in Message 1008 with the graphics 
displayed on the Canvas, i.e., Message 1003.  Note that the Message Number displayed 
usually at the bottom of the Canvas does not increment after an Update is performed. 

The Update procedure overwrites the original message specified in the filepath.  There is 
no Undo for this operation! 

Comments, Keywords 
These items are informational only.  To edit, select Edit in this menu. 

Searching Message Assets 
To narrow down the assets in a Browser database, Message Assets can be searched, based on a search 
strings (Author, Title, Comments, Subject, etc.), Modification Date, etc.  Refer to Searching the Browser 
for details on the Search tool. 
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Browser Preferences 
Config Menu > Preferences > Browser 
The Browser is a database designed to catalog Lyric messages, fonts and graphics and assets available 
from remote systems.  The database files that the Browser opens have the extension .mdb.  Newly created 
or imported database files can be custom-named by the user.  Refer to Browsers for an introduction to 
Browser use. 

NOTE 
It is important to remember that creating or deleting database entries that represent 
assets available to Lyric is not the same as saving or deleting the files themselves.  
Browser Preferences provides the option, however, of adding a font, graphic or message 
to the Browser database whenever one of these assets is saved as a file. 

The Browser dialog box accessed from Preferences is similar in many ways to the Select Data Source 
dialog box accessed from the Browser.  As such, the description for many of the operations performed in 
Browser Preferences are described in detail in Selecting/Creating/Importing/Deleting a Database. 

The difference between setting Font/Message Sources in Browser Preferences and setting Font/Message 
Sources in the Select Data Source dialog box, is that Browser Preferences define default Font/Message 
Sources that are in place when Lyric is opened.  The Font/Message Sources settings can then be changed 
in the Select Data Source dialog box as necessary, without disturbing the default settings set in Browser 
Preferences.  Modifications to settings in the Select Data Source dialog box are not reflected in Browser 
Preferences, and vice versa. 

It is important to remember that the path shown under File Name specifies the location of the .mdb database 
file itself.  Assets such as messages, fonts and graphics including those from remote networked system such 
as the Aprisa 100, are stored separately.   The .mdb file contains only information on asset locations, so that 
Lyric can retrieve and open the appropriate file.  The Set Font Source and Set Message Source buttons 
allow fonts and messages to originate from different databases.  Message Source databases also dictate 
where the Browser looks for graphics assets.  

 

Browser Preferences 
Note that any change made to Browser Preferences is not applied to open Browsers.  It is, however, 
applied to the next Browser that is opened. 
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Name, File Name 
The Browser tab displays two pieces of information to identify the data source: 

 Name:  Displays the name which can be different from the File Name, of the data source. 

 File Name:  Displays the absolute path of the file.  

Set Font Source 
Set Font Source sets the default Browser Font Source.  Refer to Selecting/Creating/Importing/Deleting a 
Database for details on the Set Font Source procedure.  After selection, the default Font Source appears in 
the field to the right of the Set Font Source button.  The thumbnails for the fonts from this source appear in 
the Browser whenever the Lyric Fonts icon is selected. 

Set Message Source 
Set Message Source sets the default Browser Message Source.  Refer to 
Selecting/Creating/Importing/Deleting a Database for details on the Set Message Source procedure.  
After selection, the default Message Source appears in the field to the right of the Set Message Source 
button.  The thumbnails for the messages from this source appear in the Browser whenever the Lyric 
Messages icon is selected. 

Create New 
The Create New function creates a new Browser data source, which can then be selected as a default data 
source.  Refer to Selecting/Creating/Importing/Deleting a Database for details on the Create New 
procedure.  Note that upon creation, the data source is automatically ODBC-registered in order to enable 
accessibility by other applications.  Refer to Registering an ODBC Data Source for details. 

Import 
The Import function enables importation of a Browser data source, which can then be selected as a default 
data source.  Refer to Selecting/Creating/Importing/Deleting a Database for details on the Import 
procedure.  Note that upon importation, the data source is automatically ODBC-registered in order to enable 
accessibility by other applications.  Refer to Registering an ODBC Data Source for details. 

Delete 
The Delete function enables deletion of a Browser data source.  Refer to 
Selecting/Creating/Importing/Deleting a Database for details on the Delete procedure. 

Advanced 
When a Lyric Browser data source is created or imported, it is automatically registered as an ODBC (Open 
Database Connectivity) database. making it accessible to software that supports ODBC, including Chyron's 
CAMIO and MOS Media Solutions applications.  Under normal circumstances, it is not necessary to 
reregister Lyric Browser data sources. 

For advanced database configuration, the Advanced function accesses the ODBC Data Source 
Administrator.  Note that data sources other than .mdb can be registered from the Advanced function in 
Browser Preferences.  They just cannot be used as Browser databases.  Refer to 
Selecting/Creating/Importing/Deleting a Database for details on ODBC registration.  

File Save Adds to Browser 
When enabled, File Save Adds To Browser directs Lyric to automatically add a Browser entry to the current 
Browser databases for every message, font or graphic created or imported, then saved. 

Sync TrueType Fonts on Load 
When a message containing Indexed Fonts is read, this feature causes Lyric to automatically update 
characters rendered in those fonts, if the Browser in which the Indexed Fonts was created has itself been 
updated.  Refer to Sync Fonts on Load for details. 
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Creating/Selecting/Importing/Deleting/Repairing a Database 

Browser > ;  Browser Menu > Select Database 

About Data Sources 
All assets displayed in the Browser are catalogued in various databases.  A default Browser database file 
exists in the folder in which Lyric is installed.  This file, identified by its .mdb extension, instructs Lyric where  
to find internal or external font, message, graphic and animation assets. 

Users may create and configure custom databases.  All user-created databases, as well as the default 
database, can reside in the same folder or in different directories, distinguished from each other by user-
assigned names.  Any database can contain any of the asset types available to the Browser.  The Browser 
interface keeps the assets properly sorted, only showing one type at a time.  More than one Browser can be 
opened at once, allowing the user to simultaneously view available fonts, messages, graphics and 
animations. 

The Title Bar of the Browser Window displays the name of the data source from which the assets are 
displayed. 

 When Font Assets are displayed, the Browser Title Bar displays the name of the data source set in 
the Set Font Source field in the Select Data Source dialog box or Browser Preferences tab. 

 When Message Assets are displayed, the Browser Title Bar displays the name of the data source 
set in the Set Message Source field in the Select Data Source dialog box or Browser Preferences 
tab. 

 When Bitmap Assets are displayed, the Browser Title Bar displays the name of the data source set 
in the Set Message Source field in the Select Data Source dialog box or Browser Preferences tab.  
Bitmap Assets are always drawn from the same active data source as the Message Assets. 

 When Aprisa 100 (Still) Assets are displayed, the Browser Title Bar displays the name Aprisa 
Stills.  There is only one Stills database on each Aprisa Still system.  Note that if the system 
accommodates both Stills and Clips, the system has one Still database and one Clips database.  

 When Aprisa 200 (Clip) Assets are displayed, the Browser Title Bar displays the name Aprisa 
Clips.  There is only one Clips database on each Aprisa Clips system.  Note that if the system 
accommodates both Stills and Clips, the system has one Stills database and one Clips database. 

 When iNFiNiT! Font Assets are displayed, the Browser Title Bar displays the name iNFiNiT!.  
There is only one Machine Font database on each iNFiNiT! system. 

 When Quantel Assets are displayed, the Browser Title Bar displays the name Quantel.  The 
Quantel database is selected from within the Quantel Import dialog box, accessed from File Menu > 
Import from Quantel.  Refer to Import from Quantel for additional information. 

Creating a Data Source 
The data sources that can be created in Lyric are the Font and Message databases.  Bitmap Assets are 
also automatically accessed from the active Message database.  Aprisa Still, Aprisa Clips, iNFiNiT!® 
Fonts and Quantel® graphics are accessed from databases that are resident on their respective systems.  
New databases cannot be created on these systems from Lyric, although depending on the external system, 
assets can be added, deleted and modified.  

Upon creation in Lyric, the Font or Message data source is automatically ODBC-registered  in order to 
enable accessibility by other applications.  Refer to Registering an ODBC Data Source for details. 
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Databases can be created and tailored to productions, users, etc.  To create a new database: 

1. In the Browser, click the Select Database icon.  The Select Data Source dialog box is 
displayed: 

 

Select Data Source Dialog Box 

2. Next, click the  button in the lower left corner of the window.  The Create Data Source 
dialog box is displayed: 

 

Create Data Source Dialog Box 
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3. Enter the name of the new database in the Name field, then click the Browse button.  The Select 
Root Directory dialog box is displayed. 

 

Select Root Directory Dialog Box 

4. You may choose to store database files (.mdb format) at the root or create a new folder for them with 
the using the New Folder tool.  Select the desired drive and folder in which to store the database, 
then click OK.  

5. The Create Data Source dialog returns to confirm your settings. Click OK. 

 

Create Data Source Dialog Box 
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6. The path you have set appears in the Select Data Source dialog box. Click OK. 

 

Select Data Source Dialog Box with New Data Source Added 

Selecting A Database 
Now that more than one database exists, it is possible to demonstrate switching among them. 

1. Click the Select Database button. The Select Data Source dialog box opens. 

2. Highlight the name of the Browser to which you wish to switch and click .  As 
shown in the figure below, the name of the selected Browser appears in the field to the right of the 
button. 

 

Setting Font and Message Sources 

3. Repeat for the  button.  The Font Source and Message Source can each access 
a different database.  Note that the Message Source also serves as the Bitmap Source. 
  



 Browsers 

 10-25 

4. Click OK.  Once a database is selected, the name of the database is displayed in the Title Bar of the 
Browser window, as shown in the following figure. 

 

Title Bar Showing Data Source Name 

The Select Data Source dialog box is similar in many ways to the Browser Preferences tab, accessed from 
Config Menu > Preferences > Browser.  The difference between setting Font/Message Sources in 
Browser Preferences and setting Font/Message Sources in the Select Data Source dialog box, is that 
Browser Preferences define default Font/Message Sources that are in place when Lyric is opened.  The 
Font/Message Sources settings can then be changed in the Select Data Source dialog box as necessary, 
without disturbing the default settings set in Browser Preferences.  Modifications to settings in the Select 
Data Source dialog box are not reflected in Browser Preferences, and vice versa. 

Importing a Database 
The Import Database function enables the user to add existing databases to the Select Data Source dialog 
box.  Note that upon import, the data source is automatically ODBC-registered in order to enable accessibility 
by other applications.  Refer to Registering an ODBC Data Source for details. 

NOTE 
Making a database available to the Browser is different from the files themselves being 
accessible.  For example, an imported database may display thumbnails for assets on a 
network to which your computer does not have access.  Make sure that the user and the 
system on which Lyric is operating have access to the necessary files. 

To import a database: 

1. Click the Select Database icon.  The Select Data Source dialog box opens. 
  

2. Click the  button.  The Import Data Source dialog box opens (see figure below). 
  

3. Enter the filepath, if known, of the database you wish to import.  If not, use the Browse button  to find 
the location of the desired database (.mdb) file. 
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4. Enter a name in the Name field and click OK. The name and filepath of the imported database 
appear in the Select Data Source dialog box. This database can now be accessed by Lyric. 

 

Import Data Source Dialog Box 

Advanced 
When a Lyric Browser data source is created or imported, it is automatically registered as an ODBC (Open 
Database Connectivity) database. making it accessible to software that supports ODBC, including Chyron's 
CAMIO and MOS Media Solutions applications.  Under normal circumstances, it is not necessary to 
reregister Lyric Browser data sources. 

For advanced database configuration, the Advanced function accesses the ODBC Data Source 
Administrator.  Note that data sources other than .mdb can be registered from the Advanced function in 
Browser Preferences.  They just cannot be used as Browser databases.  Refer to Registering an ODBC 
Data Source for details. 

Deleting a Database 
To delete a database as a Browser data source: 

1. Select the data source in the Select Data Source list, then click .  The Confirm Delete 
prompt is displayed. 

 

Confirm Delete Prompt 

2. Click Yes to delete; No or Cancel to cancel the Delete. 



 Browsers 

 10-27 

Repairing a Damaged Database 
During Lyric launch or Browser operations, the following may be displayed:   

 

Error Retrieving Record 

Click OK, then the following is displayed: 

 

File Saved But Not Added to Browser 

This sequence of messages may indicate that the Browser database is corrupted and needs repair.  To 
repair a database: 

1. Make sure that the Browser(s) accessing the database are closed. 

2. There is a Repair function in the ODBC Data Source Administrator.  It is accessible from the 
following locations: 

 Windows Start Menu > Settings > Control Panel > Administrative Tools > Data Sources 
(ODBC) 

 Lyric Config Menu > Preferences > Browser > Click Advanced 

 Lyric Browser >  > Click Advanced 

 Lyric Browser Menu > Select Database > Click Advanced 

3. In the ODBC Data Source Administrator dialog box, there is a list of databases.  Double-click on 
the name of the database that may be corrupted.  The ODBC Microsoft Access Setup dialog box 
opens. 

4. Click Repair.  The Repair Database dialog box opens. 

5. Make sure that the proper database is selected, then click OK.  A message confirms that the 
database has been successfully repaired. 
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Searching the Browser 

Browser > ;  Browser Menu > Search Browser 
In a Lyric Browser, Font, Message, Bitmap, Aprisa and Quantel Assets can be searched using the Search 
tool.  Search is not currently implemented for iNFiNiT! assets. 

Searching Font, Message Bitmap and Aprisa Assets 

To display the Search or Aprisa Search dialog box, display the Font , Message , Bitmap    , 

Aprisa Still or Aprisa Clip Asset database in the Browser, then click the Search Database icon  
or select Search Browser from the Browser menu. 

Font Asset Search Dialog Box 
The following dialog box is displayed for a TrueType® or RGB Font Asset search: 

 

Font Asset Search Dialog Box 

A Font Asset can be searched by Style Name (corresponds to Name field in RGB Font Browser dialog 
box), Type Face, Comments, Keywords, Height (in scanlines) and Edge Type.  Type Face, Height and 
Edge Type do not apply to RGB Font Asset searches.  A condition, Can Contain, Must Contain or Must 
Not Contain, can be applied to each search field.  The date Last Modified can also be searched.  Setting the 
search field and Last Modified conditions are described in the following paragraphs. 



 Browsers 

 10-29 

Message or Bitmap Asset Search Dialog Box 
The following dialog box is displayed for a Lyric Message or Bitmap Asset search: 

 

Message/Bitmap Asset Search Dialog Box 

A Message or Bitmap Asset can be searched by Author, Title, Comments, Keywords, and Subject.  A 
condition, Can Contain, Must Contain or Must Not Contain, can be applied to each search field.  The date 
Last Modified can also be searched.  Setting the search field and Last Modified conditions are described 
below. 
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Aprisa Still/Clip Asset Search Dialog Box 
The following dialog box is displayed for an Aprisa Still or Clip Asset search.  This figure shows parameters 
entered for a search of an Aprisa Stills database. 

 

Aprisa Search Dialog Box 

Searching Stills:  The Aprisa stills database can be searched by Still ID, Description and information 
contained in Fields 1 through 8.  A condition, Can Contain, Must Contain or Must Not Contain, can be 
applied to each search field.  The date Last Modified can also be searched.  Setting the search field and 
Last Modified conditions are described below. 

Searching Clips:  The Aprisa clips database can be searched by Description only.  A condition, Can 
Contain, Must Contain or Must Not Contain, can be applied to the search. 

Last Modified Date Conditions 
A search can retrieve assets Last Modified before or after a specified date, or between two specified dates.  
If Between is specified, a second date field is displayed. 

 

Searching Between Last Modified Dates 

The entered date(s) is included in a search.  The date(2) should be formatted as follows:  mm/dd/yyyy 
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Can, Must, Must Not Contain Conditions 
There are three conditions that can be applied individually to each search field (except Last Modified). 

 Can Contain:  Entering text or leaving it blank both produce all Font, Message or Bitmap Assets in 
the search results. 

 Must Contain:  This restricts the search results to only those Font, Message or Bitmap Assets that 
contain the specified search string in the specified field. 

 Must Not Contain:   This restricts the search results to only those Font, Message or Bitmap Assets 
that do not contain the specified search string in the specified field. 

Performing a Search 
To perform a search: 

1. Use the procedure described above to display the Search dialog box. 

2. Optional:  Enter the search strings in the appropriate fields.  Also optional:  Apply a condition other 
than Can Contain to each field. 

3. Optional:  Set a Last Modified date(s). 

4. Click Search.  A  search is performed, based on parameters entered in the Search dialog box.  The 
search results are displayed in the Browser. 

Refining a Search 
If the search results produce too many assets, an additional search can be performed on the current search 
results. 

1. Optional:  Enter the search strings in the appropriate fields.  Also optional:  Apply a condition other 
than Can Contain to each field. 

2. Optional  Set a Last Modified date(s). 

3. Click Refine Search.  A  search is performed on the current search results based on the new 
parameters entered in the Search dialog box.  The search results, which is a subset of the previous 
search results, are displayed in the Browser. 

This function can be performed as many times as necessary to narrow down the search results. 

Resetting the Search Dialog Box 
The parameters in the Search dialog box can be returned to the default state. 

 Click Reset Search.  Text and date fields are cleared; Last Modified is reset to Before; and 
conditions are all set to Can Contain.  Note that this does not clear the existing search results from 
the Browser. 

Resetting the Database 
To undo all searches on the database and display the entire contents of the database: 

 Click Reset Search, then click Search or Refine Search. 
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Searching Quantel Assets 
The Search function for Quantel assets can be accessed from two locations.  Use one of the following 
methods to display the Search By dialog box: 

 Display the Quantel® Asset database in the Browser, then click the Search Database icon 

 or select Search Browser from the Browser menu. 

 From the Lyric File menu, select Import from Quantel.  In the Quantel Import dialog box, connect to 
a system, then display a set of files.  In the Options area, click Search. 

 

Search by Dialog Box 

To execute a search: 
1. A Quantel Asset can be searched by Author, Title, Category, and Date.  Specify all or part of an 

Author, Title and or Category in their respective fields. 

2. The Date field reflects the current date.  A different date can be selected from the drop-down 
calendar as shown above. To disable the Date as a search condition, deselect (uncheck) the 
checkbox located within the Date field. 

3. Click OK.  The Search By dialog box closes.  If in the Browser, the results of the search are 
displayed in the Browser.  If in the Quantel Import dialog box, proceed to the next step. 

4. Click List Next Set.  The results of the search are displayed in the FID List. 

To clear the search fields in the Search By dialog box: 
 Click Clear. 

To cancel the search: 
 Click Cancel in the Search By dialog box. 

 



 

 11-1 

11. Creating and Using Fonts in Lyric 

Creating and Using Fonts in Lyric 
Lyric provides maximum creative flexibility with its support of TrueType®, OpenType® and iNFiNiT!® fonts, as 
well as Windows® 2000 Unicode (Chinese, Japanese, Cyrillic, etc.).  Lyric does not support PostScript® 
fonts. 

RGB Fonts, which are fonts composed from bitmap images, as opposed to standard font characters, can be 
created using the Custom Font Editor.  RGB Fonts are useful for quickly typing frequently-used graphics 
such as sports team logos.  Typing graphics is considerably faster than importing them. 

The Custom Font Editor can also import and export iNFiNiT! fonts for use in Lyric or imported iNFiNiT! 
messages.  iNFiNiT! fonts and message operations are covered in depth in Browser:  iNFiNiT! Font Assets, 
Import from iNFiNiT!, Export to iNFiNiT!, Custom Font Editor and FTP - Transferring Files to/from an 
iNFiNiT! System. 

A wide variety of parameters can be applied to build customized fonts which can be saved and used in 
multiple Lyric compositions. 

 Basic font parameters such as Font Face, Font Size (2D text only), Font Style and Face/Edge 
Color (2D text) and Face/Side Color (3D characters) can be set using Lyric's Font Tools.  Setting 
color is covered in depth in the chapter on Setting and Applying Color, Transparency, Lighting 
and Texture. 

 The same characteristics, as well as more advanced parameters such as 2D/3D Mode, Aspect 
Ratio, Kerning, Space Width, Leading, Shear, Rotation and Filters can be set for 2D font 
characters in the Font Properties tab. 

 Font Face and Font Style for characters used in 3D text composition can also be set in the Font 
Properties tab. 

 TrueType® Font Preview, accessed from the Font Properties tab, enables the user to quickly 
review the available characters in a font, change the current font, or select a character (including 
Unicode) to add to the Canvas at the current cursor position.  TrueType Font Preview can be used 
with both 2D and 3D characters.  

 More advanced effects for 2D characters, including Edge Type, Edge Size, Face/Edge Color, 
Transparency, Softness and multiple Edge styles are set in the 2D Font FX Properties tab. 

 3D font effects, including Character Depth, Bevel Depth, Bevel Mode, Bevel Type and 
Smoothness. are set in the 3D Font FX Properties tab.  3D character Color, Transparency and 
Texture is applied from the Surface Properties tab.  Refer to the chapter on Setting and Applying 
Color, Transparency, Lighting and Texture for details. 

All fonts supported by or created in Lyric can be easily loaded into a Browser Window, making them instantly 
accessible use in a Lyric composition. 

The following sections cover the use of Font Tools, Font Properties, 2D Font FX Properties, 3D Font FX 
Properties. and the Custom Font Editor. 
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Font Tools 
View Menu > Toolbars > Font Tools 

 

Font Tools 

The Font Toolbar provides parameters that define the appearance of 2D and 3D characters.  If these tools 
are not visible, select Toolbars > Font Tools from the View Menu to display them. 

These settings are applied to either selected 2D text or 3D text or 2D or 3D characters typed after the 
parameters are set.  Where noted, certain parameters cannot be applied to 3D text. 

Parameter Description 

Face Color Selects the color of a 2D or 3D character's face.  The dropdown 
list offers the colors currently preset in Lyric's Palette, but the 

last selection in the dropdown , opens the main Color 
Select dialog box, from which the Palette  is set.  Using the 

 option allows quick selection of colors not currently 
set in the Palette.  Note that ramped colors cannot be applied 
to 3D characters. 

Edge Color  Edge Color selection is performed in the same manner as 
Face Color selection. 

 When multiple edges are present on a 2D character, 
the Edge Color is applied only the first Edge type, as 
determined by the settings in Properties > 2D Font FX.  
Color selection for additional edges must be applied 
from Properties > 2D Font FX. 

 

Edge Selection in Properties > 2D Font Effects 

 When a Bevel is applied to a 3D character via 
Properties > 3D Font FX, the Edge Color is applied 
only to the Sides, and not to the Bevels.  Color 
selection for the Bevels must be applied from 
Properties > Surface. 

  Note that ramped colors cannot be applied to 3D characters. 

Font Face 
Name 

Sets the Font typeface for the 2D or 3D text. 
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Parameter Description 

Font Size Set the Font Size, in scanlines for 2D text. 

Font Size cannot be applied to 3D characters.  3D character 
size is changed either by using the Transform Toolbar Edit 
Scale  tool; or via Properties > XYZ > Scale or Z-Position 
settings. 

Bold 

Italic 

Underline  

Bold, italic and Underline operate in the same manner as in 
conventional word processing software.  Bold and italic may be 
applied to 3D text, but 3D text cannot be underlined. 

Justification Justification determines how the text aligns to the frame of the 
2D Text Window. 

 Left Justify:  Justifies text to the left border of the 2D 
Text Window. 

 Center Justify:  Centers text horizontally in the 2D 
Text Window. 

 Right Justify:  Justifies text to the left border of the 2D 
Text Window. 

 Vertical Centering:  Centers text vertically and 
horizontally in the 2D Text Window.  Left and Right 
Justify can be subsequently applied without losing 
vertical centering.  
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Font Properties 
Properties > Font 

Font Properties 
Click on the Font tab of the Properties window to view/change Font properties: 

 

Font Properties 
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Property Description 

Font 
Selection 

This area displays the currently selected Font for 2D and 3D text, 
and lists all Fonts available to the system. 

Font 
Variation  

Use this area to select Font Variation from the available variations 
for the selected Font: Regular, Bold, Italic, etc.  

Please note that Font variations are specific to the fonts 
themselves. Thus, one font may be available in Regular, Bold, Italic 
and Underline, while another may offer only some of these options. 

Both TrueType® and OpenType® fonts are supported by Lyric.  
Lyric does not support PostScript® fonts. 

Mode These radio buttons reflect the position of the cursor on the 
Canvas. 

 If the cursor is inside of a 2D Text Window, the 2D radio 
button is active. 

 If the cursor is outside of a 2D Text Window, the 3D radio 
button is active. 

The radio buttons can also be selected (clicked) to change the 
focus within the Canvas: 

 If the 2D radio button is selected (clicked), the focus 
changes to the 2D Text Window (including Roll, Crawl 
and Type On) with the lowest priority on the Scene Graph, 
regardless of actual Z-position of the 2D Text Window. 

 If the 3D radio button is selected (clicked), the focus 
changes to the Global Light on the Scene Graph. 

 
TrueType® Font Preview enables the user to quickly review the 
available characters in a font, change the current font, or select a 
character (including Unicode) to add to the Canvas at the current 
cursor position.  Refer to TrueType® Font Preview later in this 
section for details. 

Size  The Size slider sets the current Font Size (in Scanlines). Also, you 
may use the up/down arrows to change the Font Size, or enter a 
size directly. Size settings are reflected in real time in the Font 
Sample area. 

Aspect  Adjusts Aspect Ratio (Width:Height) for the selected text. (Range: 
0.001 to 10.00 units.) The Font Sample area reflects changes in 
Aspect Ratio in real time. 

 

Sample Aspect Ratios 

Kerning  Adjusts the horizontal spacing of the selected characters in pixels. 
(Range: -25 to 25 pixels.) 
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Property Description 

Space Width Adjusts the length of the selected Font’s Space Character Width. 
(Range: 0 to 50 pixels). 

Leading Adjusts inter-line spacing (leading). (Range: -75 to +75 scanlines). 

Shear (Horizontal and Vertical) Adjust Shear along the Horizontal, 
Vertical, or both axes (range: -5.00 to +5.00). The Font Sample 
area reflects changes in Shear in real time. 

 
Sample Shears 

Rotate  Circular Slider (also known as Spin Control Box or Jog Wheel) that 
adjusts rotation of characters on the display. The Font Sample 
area reflects rotation in real time 

Filter  (Horizontal and Vertical) These filters are provided to enhance the 
quality of text display during Roll animations in HD or PAL 
operation. 
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Property Description 

Font Sample 
Area 

Displays sample characters for the selected Font, with Font and 
2D Font FX Properties applied.  The sample that is displayed in 
the Font Sample area does not reflect the actual size of the font.  
Rather, the two red lines to the left of the upper/lowercase 
characters span what represents a 50-scanline height.  The icons 
below show the positioning of the red lines for a 50-scanline font, 
where they span the full height, and a 150-scanline font, where they 
span one-third of the height. 

 

Font Sample - 50 
Scanlines 

 

Font Sample - 150 
Scanlines 

Note that if the TrueType® font on which a Lyric font is based is not 
available a red slash is displayed across the Font Sample.  

 

TrueType® Font Unavailable 
Apply  Click Apply to apply the font settings/changes to the selected 

character(s). 
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TrueType Font Preview 
TrueType® Font Preview enables the user to quickly review the available characters in a font, change the 
current font, or select a character (including Unicode) to add to the Canvas at the current cursor position.  
TrueType Font Preview can be used with both 2D and 3D characters.  

To access TrueType® Font Preview: 

 Click the  button in the Font Properties tab.  The TrueType® Font Preview dialog box is 
displayed. 

 

TrueType® Font Preview 

In the Sample Area, the entire character set for the current font is displayed.  Notice that the currently 
selected 2D or 3D character on the Canvas is highlighted in the Sample Area.  To the right of the Sample 
Area is the Font list.  The current font is highlighted. 

About ASCII and Unicode Characters 
There are two sets of characters that can be displayed in the Font Sample Area:  ASCII and Unicode. 

 The ASCII set of characters is the standard set of characters with which most are familiar.  Visible 
characters in an ASCII font set are coded from 32 to 255.  There are other specialized, non-visible 
characters coded from 0 to 31.  The ASCII Code and the character name of the currently selected 
are displayed above the top right of the Sample Area of the TrueType® Font Preview dialog box. 

 The Unicode set of characters is an extended set of characters that includes the ASCII set. 

To display the ASCII set: 
 Leave the Unicode checkbox unchecked. 

To display the Unicode set: 
 Select (check) the Unicode checkbox. 
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The Min Char ID and Max Char ID determine the range of codes from which a character can be selected for 
placement on the Canvas.  The most common setting for Min Char ID is 32; for Max Char it is 255.  Note 
that this setting does not have an affect on the availability of characters once the dialog box is exited.  

If the Max Char ID is changed to a higher number, the following occurs depending on whether ASCII or 
Unicode is active: 

 If ASCII is active (Unicode unchecked), duplicate ASCII sets appear in the Sample Area in intervals 
of 256.  For example, if the Max Char ID is set to 1000, the character A would appear at 65, 321, 
577and 833.  Any one of the A characters can be placed on the Canvas. 

 If Unicode is active (Unicode selected), the Unicode character set is displayed. 

A number of the character slots display rectangles instead of characters.  In the case of Unicode characters, 
there may be characters assigned to those slots which are not rendered to the Sample Area.  If this appears 
to be the case, use the Windows Character Map to locate these characters and paste them to the Canvas.  
Refer to Paste Unicode Text for details. 

Setting and/or Applying a Font 
To set a new current font: 

 Open the TrueType Font Preview dialog box, then select a font from the Font list. 

 Click Apply to apply the selected font and remain in the dialog box, or OK to apply the selected font 
and exit the dialog box.  The new font also becomes the new current font.  Note that it retains the 
other font attributes (Edge, Size, color, etc.) set in the Font Tools, Font Properties and 2D Font FX 
Properties.  

Its ASCII Code or Unicode, followed by the character is displayed directly above the Sample Area. 

To apply a new font to selected characters: 
1. Select the 2D or 3D characters to which to apply the new font. 

2. Open the TrueType Font Preview dialog box, then select a font from the Font list. 

3. Click Apply to apply the selected font to the selected characters and remain in the dialog box, or OK 
to apply the selected font and exit the dialog box.  The new font also becomes the new current font.  
Note that it retains the other font attributes (Edge, Size, color, etc.) set in the Font Tools, Font 
Properties and 2D Font FX Properties.  

Adding a Character to the Canvas 
To add a 2D or 3D character to the Canvas: 

1. Place the cursor at the point on the Canvas where the character is to be inserted. 

 If the cursor is inside of a 2D Text Window, a 2D character will be inserted at the cursor 
location. 

 If the cursor is outside of a 2D Text Window, a 3D character will be placed on the Canvas at 
the cursor location. 

2. Open the TrueType Font Preview dialog box, then in the Sample area, select (click) the character 
that is to be placed on the Canvas. 

3. Click Add.  The selected character is placed at the cursor location with the current font applied.  
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2D Font FX Properties 
Properties > 2D Font FX 

Click on the 2D Font FX tab of the Properties window to view or change 2D Font FX Properties: 

 

2D Font FX Properties 
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Property  Description 

Components  Determines the character's face and or edge for the application of Offset, Shadow and 
Border effects. The Cut, Paste and Copy buttons remove, restore and duplicate entries 
in the Components window. 

Effects Determines one or more of four Edge Effect styles: 

 

Offset 

 

Shadow 

 

Border 

 

None 

Lyric supports multiple edges on 2D text characters, via the Add button (in the 
Components area). To add a new (or additional) edge style, click the Add button, then 
select the desired Effect. 

Direction Selects Direction for the selected Edge component in degrees; you may enter a value 
numerically, click the up/down arrows to increase/decrease the value, or use the Circular 
Slider, also known as a Spin Control Box, to dial in the desired value. 

Edge Size Selects the Edge Size for the selected Edge Component. 

Transparency Sets Transparency for the selected Component (character Face or Edges). This field 
sets the Transparency percentage with respect to video, on a scale from 0 (opaque) to 
100 (transparent). 

Softness Softness is a variable reduction in the sharpness of the selected edge style, ranging 
from 0 (sharpest) to 15 (softest). Softness applies to Drop Shadow, Offset and Border 
styles. 

Fill Area Sets/changes the Fill for the selected Component (Face or Edges). Fill may be a solid 
or ramp color, or a texture (bitmap). 
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Property  Description 

Font 
Sample Area 

Displays sample characters for the selected Font, with Font and 2D Font FX Properties 
applied.  The sample that is displayed in the Font Sample area does not reflect the 
actual size of the font.  Rather, the two red lines to the left of the upper/lowercase 
characters span what represents a 50-scanline height.  The icons below show the 
positioning of the red lines for a 50-scanline font, where they span the full height, and a 
150-scanline font, where they span one-third of the height. 

 

Font Sample - 50 Scanlines 
 

Font Sample - 150 Scanlines 

Note that if the TrueType® font on which a Lyric font is based is not available a red slash 
is displayed across the Font Sample.  

 

TrueType® Font Unavailable 

Apply Applies the current 2D Font FX settings to the selected 2D character(s) on the Canvas. 
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3D Font FX Properties 
Properties > 3D Font FX 

3D characters in Lyric are extruded from 2D characters.  3D characters have the expected characteristics of 
3D objects.  They can be rotated in 3D space to show all sides and textures can be applied to their surfaces.  
A 3D character is comprised of three types of Surface elements: 

 Faces:  The Front and Back faces represent the 2D character from which the 3D character is built. 

 Sides:  The sides determine the depth of the 3D character. 

 Bevels:  The Bevels determine the transition between the faces and the Sides. 

 

3D Character 
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Depth and Bevel attributes are set in the 3D Properties tab.  Refer to Properties:  Surface for information 
on applying colors and textures.  To access 3D Font FX Properties, select the 3D Font FX tab in the 
Properties window. 

 

3D Font FX Properties 

A change in any of the following parameters is immediately applied to all currently selected 3D characters. 
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Character Depth 
Character Depth sets the depth of the selected 3D character(s). 

 

Character Depth 

To set Character Depth: 
 Adjust the Spin Control Box or the slider. 

The Character Depth setting is not available when Square Bevel Style is selected.  To create a Square 
Bevel character that has Character Depth: 

1. Create a character with a Bevel other than Square. 

2. Set a Character Depth. 

3. Select the Square Bevel Style.  The character converts to a Square Bevel Style while retaining the 
set Character Depth. 

Bevel Mode 
The Bevel Mode applies Bevel to the Front, Back or Both faces of a 3D character.  The following figure 
shows the application of a 45-Degree Bevel to the Front, Back and Both Front and Back faces 
respectively, of a 3D character.. 

 

Bevel Modes 

To apply a Bevel Mode: 

 Select the appropriate radio button. 
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Bevel Depth 
Bevel Depth sets the depth of the Bevel effect. 

 

Bevel Depth 

Bevel Types 
There are six Bevel Types.  Examples of the different Bevels are shown below.  Figure (below) and button 
(above) positions correspond to each other. 

 

Square 
 

45° Angle 
 

Outer Rounded 

 

Inner Rounded 
 

Step Down 
 

Step Up 

To apply a Bevel Type: 
1. Select the 3D characters to which to apply the Bevel. 

2. Click on the Bevel button.  The Bevel is applied to the text. 

Smoothness 
The Smoothness setting adjusts the Smoothness of the selected Bevel.  For best results, experiment with 
this setting, especially when using very large or very small 3D characters.  The range of the settings is from 1 
(least smooth) through 10 (smoothest). 
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Lyric Font Asset Overview 

Browser > Click ;  Browser Menu > Show Font Assets 

Three types of fonts used in Lyric operations: 
 TrueType®-Based Fonts:  Fonts created in Lyric that are based on TrueType font sets.  An 

introduction to TrueType font operations is covered in this section and continued in TrueType® Font 
Context Menu. 

 RGB Fonts:  Fonts created in Lyric that map bitmap graphics to keys, instead of TrueType® font 
characters.  RGB Font operations are covered in briefly in this section and in RGB Fonts.  

 iNFiNiT!® Fonts:  Fonts created on a Chyron iNFiNiT! Family system.  These fonts are accessed via 

the  icon or by selecting Show iNFiNiT! Fonts from the Browser menu.  iNFiNiT! Fonts are 
covered in iNFiNiT Assets. 

Indexed Fonts 
Each Lyric Font Asset, i.e., TrueType® or RGB Font, can be assigned to a hotkey combination which can 
easily activate the font for use from a PC or Duet keyboard.  Available hotkeys are as follows: 

 Alt + 0 through Alt + 9 

 Alt + Shift + 0 through Alt + Shift + 9 

Except for Alt + 0, Alt + 9, Alt + Shift + 0 and Alt + Shift + 9, each hotkey assignment also corresponds to a 
Font Key on the Duet keyboard. 

Hotkey Alt + 0 Alt 
+ 1 

Alt 
+ 2 

Alt 
+ 3 

Alt 
+ 4 

Alt 
+ 5 

Alt 
+ 6 

Alt 
+ 7 

Alt + 
8 

Alt + 9 

Duet 
Keyboard 

None - 
Use 

Hotkey 

1 2 3 4 5 6 7 8 None - 
Use 

Hotkey 

Hotkey Alt + Shift + 
0 

Alt + 
Shift + 1 

Alt + 
Shift + 2 

Alt + 
Shift + 3 

Alt + 
Shift + 4 

Alt + 
Shift + 5 

Alt + 
Shift + 6 

Alt + 
Shift + 7 

Alt + 
Shift 
+ 8 

Alt + 
Shift + 

9 

Duet 
Keyboard 

None - Use 
Hotkey 

Shift + 1 Shift + 2 Shift + 3 Shift + 4 Shift + 5 Shift + 6 Shift + 7 Shift 
+ 8 

None - 
Use 

Hotkey 

Refer to TrueType® Font Context Menu and RGB Fonts for information on setting font hotkeys. 

The Font Asset Context Menus 
Three context menus are available from within the Font Assets Browser, depending on the cursor position 
when accessed: 

 Font Asset Context Menu:  Accessed by right-clicking on a blank area of the Browser.  Custom 
Font Editor and Create RGB Font are available from this menu.  All other items are grayed out.  
Refer to Custom Font Editor for information on using this tool.  Create RGB Font is covered later in 
his section, as well as in RGB Fonts. 

 TrueType Font Context Menu:  Accessed by right-clicking on a TrueType Font Asset in the 
Browser. 

 RGB Font Context Menu:  Accessed by clicking and RGB Font Asset in the Browser. 
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Sync Fonts on Load 
TrueType® Fonts 
TrueType® fonts can be set in the Browser Preferences to update automatically when a message is read. 

 If Sync TrueType® Fonts on Load is enabled in the Browser Preferences, any update to a Font 
Asset in the Browser is automatically reflected in a message when it is read. 

 If Sync TrueType® Fonts on Load is not enabled in the Browser Preferences, any update to a 
Font Asset in the Browser is not reflected in a message when it is read. 

Refer to Browser Preferences for details. 

RGB Fonts 
Any change to an RGB Font is always reflected in a message when it is read. 

Creating a TrueType® Font and Adding It to the Database 
Cataloging and recalling fonts are among the simplest types of Browser operations.  In the following 
procedure, a TrueType®-based font will be created, and then added to the current database. 

1. If the Font Assets are currently not displayed in the Browser, click the  icon or select Show 
Font Assets from the Browser menu. 

2. In the Properties window, click the Font tab, then select a Font, or select a font from the Font 
Toolbar.  
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3. Set up the font as desired by setting parameters in the Font and 2D Font FX tabs.  Note that the 
changes appear in the Font Sample area in the lower left hand corner of the Properties > Font  and 
Properties > 2D Font FX tabs. 

 

Font and 2D Font FX Properties Showing Font Sample Area 

NOTE 
The Font Sample displayed in the Properties > Font and 2D Font FX tabs, as well as in 
the Browser Icon and Icon/Text Views represents the characters mapped to the Shift + A 
and "a" key combinations.  If a character is not mapped to this keycap, then the 
character mapped to the next occupied key combination in the ASCII set is displayed 
(Shift + B and "b", then Shift + C and "c", etc.). 



Lyric User Guide 

 11-20 

4. When the font is set, click the Save to Database  icon in the Browser. 

 

New Font Added to Browser 

NOTE 
The Browser examples above and following deal with Icon (Thumbnail) Views.  Font 
Load operations work equally well when the display is Text View or Icon/Text View. 

The resulting icon, or thumbnail, that is displayed in the Browser, does not reflect the actual size of the font.  
Rather, the two red lines to the left of the upper/lowercase characters span what represents a 50-scanline 
height.  The icons below show the positioning of the red lines for a 50-scanline font, where they span the full 
height, and a 150-scanline font, where they span one-third of the height. 

 

50-Scanline Font 
 

150-Scanline Font 
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Loading a TrueType or RGB Font 
To use a font that is cataloged in the Browser: 

1. Erase the Canvas. 

2. Click the  icon, or select Text Window from the Tools menu to open a 2D Text Window. 

3. In the Font tab in the Properties window, or from the Font Toolbar, select a different font from the 
one added to the Browser in the previous operation.  Click Apply after the font parameters are set.  
Type a few characters on the Canvas. 

4. In the Browser window, double-click the font icon, or click the icon for the font that was created and 

added to the Browser, then click the Load from Database icon. 

5. Continue typing.  The new characters display the properties of the font selected from the Browser. 

To apply a font using a bounding box: 
 Draw a bounding box around a character(s) on the Canvas, then click the Load from Database icon. 

To apply a font using drag-and-drop: 
 Drag-and-drop a font icon from the Browser directly to the Font Sample area in the Properties 

window Font or 2D Font FX tab.  Once the font is displayed in the Font Sample area, it is now 
loaded for use. 

 

Drag-and-Drop Font from Browser to Properties 

Searching Font Assets 
To narrow down the assets in a Browser database, Font Assets can be searched, based on a search strings 
(Style Name, Comments, Subject, etc.), Modification Date, etc.  Refer to Searching the Browser for 
details on the Search tool. 
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TrueType® Font Context Menu 
Browser > Right-Click TrueType® Font Asset 

A TrueType-based font in a Browser can be customized to suit the requirements of a production.  A name 
and keywords can be assigned, and comments can be added.  In addition, an RGB Font can be created or 
imported.  To access these operations: 

 Right-click on a font icon/text.  The Font Asset context menu is displayed. 

 

Browser Font Context Menu 

The menu is divided into three sections:  Editing; RGB Font operations and descriptive information. 

NOTE 
The context menu for an RGB Font is different than that of a TrueType® font (shown 
above).  RGB Fonts are covered in detail in the section on RGB Fonts. 
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Edit 
A Font Asset consists of the physical information describing the font itself (Type Face, Height, Edge Type) 
as well as accompanying metadata, which is information about the font, but which has no direct bearing on 
the appearance of the font.  The user-defined metadata enables easier access to the font by providing the 
means to easily search as well as identify the function of the font.  

 

Font Information Dialog Box 

There are both user-defined and non-editable parameters in the Font Information dialog box.  The non-
editable parameters are determined on creation/modification of the font. 

Parameter Description 

Style Name Can identify the function of the font, e.g., Weather Promo. 

Type Face Identifies Type Face, also known as Font Facename, Font 
Face, etc., of the selected font.  Information field only - not 
editable from within this dialog box.   

Comments Comments that could further define use or provide other 
information.  The Comments field can accommodate 255 
characters.    Pressing Enter performs the same function as 
clicking OK, so it cannot be used to start a new line.  To insert a 
carriage return in the field: 

 Press Ctrl + Enter. 

Keywords Keywords that can be used for Browser Search purposes. 

Height Indicates height, in scanlines, of the selected font.  Information 
field only - not editable from within this dialog box.   

Edge Type Indicates edge type(s) of selected font.  Information field only - 
not editable from within this dialog box.   
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Parameter Description 

Last Modified Indicates date that the font was last modified.  Information field 
only - not editable from within this dialog box.   

Hotkey Defines the Hotkey combination that can be used to quickly load 
the font.  Twenty hotkeys are available.  The following Hotkeys 
can be set: 

 Alt + 0 through Alt + 9; Alt + Shift + 0 through Alt + 
Shift + 9. 

To set a Hotkey: 
 Just select from the drop-down list box. 

To load a font associated with a Hotkey: 
1. Activate the Browser which is displaying the font, then 

make the Canvas active. 
2. Press the Hotkey combination.  Note that only the 

alphanumeric number keys, not the numeric keypad 
keys, can be used in a Hotkey combination. 

OK or press Enter Applies the parameter settings to the Font Asset.  

Cancel Cancels the application of the settings to the Font Asset. 
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The figure below shows an example of a Font Information dialog containing information, and how the 
icon/text would look in the Browser in an Icon/Text View. 

 

Font Information Edited 

Deleting a Font from the Browser 
A font can be deleted form a Browser as follows: 

1. From the Font Asset context menu, select Delete. 

OR 

Select (click) the Font Asset, then press Delete on the PC keyboard or Delete Character on the 
Duet keyboard. 

The following prompt asks for confirmation of the deletion of the specific font. 

 

Font Delete Prompt 
2. Click Yes to confirm deletion, or No to Cancel. 

WARNING!  There is no Undo for this operation! 
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Updating a Font 
The physical attributes of a font can be modified and the update applied to the Font Asset: 

1. While the font is active, modify attributes from the Font Toolbar and/or the Properties > Font/2D 
Font FX tabs. 

2. From the Font Asset context menu, select Update.  The information updates in the Font 
Information dialog box, as well as Font Icon and/or Text View.  Not also that on the Canvas, 
characters created from the font are also updated to reflect the new characteristics. 

WARNING!  There is no Undo for this operation! 

Create RGB Font 
The RGB Font feature, familiar to iNFiNiT! operators, provides fast access to bitmap graphics in Lyric.  An 
RGB Font is a set of characters that are based on bitmap graphics, instead of what is generally known as 
font characters.  Each bitmap graphic in the font is mapped to a unique key or key combination, enabling 
quick typing of graphics onto the Canvas.  A common use of RGB Fonts is for display of sports logos.  Each 
logo is mapped to a key, and can easily be placed onto the Canvas by pressing a key or key combination, 
without the necessity of using the Graphic Import function.  Refer to RGB Fonts for details on creation and 
other RGB Font operations. 

Import RGB Font 
Import RGB Font is not available from the context menu of a TrueType® font.  The item is grayed out on this 
menu. 

Style, Typeface, Comments and Keywords 
These items are informational only.  To edit, select Edit in this menu. 
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Sync TrueType® Fonts on Load 
Config Menu > Preferences > Browser 

When the attributes of a TrueType® font stored in the Browser are updated, all text written using the original 
font's attributes can be changed to a new font automatically.  To enable this feature: 

 In the Config Menu > Preferences > Browser tab, enable (check) Sync TrueType Fonts On Load 
checkbox. 

 

Preferences:  Sync TrueType® Fonts on Load 

To demonstrate how this works: 

1. Create a new, customized font and save it  to the Browser.  Creating a new font is suggested 
here, as it will be overwritten during this procedure.  

2. Right-click on the new asset in the Browser, select Edit to open the Font Information dialog box, 
then enter the name Demo Font 3 in the Style Name field. 
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3. Create a multi-row 2D Text message, using the new font on one of the rows. 

 

Message Using New Font 

4. Save the message, take note of its Message Number, then erase the Canvas. 

5. Double-click the font that is to be changed, or drag-and-drop it to the Font Sample area in the 
Properties > Font or Properties 2D Font FX tab.  The font becomes active in the Font and 2D Font 
FX tabs of the Properties menu.  The illustration of the Properties > Font tab has been shortened 
for easier viewing in this example. 

 

Activating a Font in the Browser - 
Reflected in Font and 2D Font FX Properties 
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6. In the Font and 2D Font FX tabs, modify this font, then click Apply.  The Font Sample in the 
Properties Font and 2D Font FX tabs change accordingly. 

 

Properties:  Changing Font Characteristics 

7. In the Browser, right-click on the font that is to be changed, i.e., Demo Font 3.  Select Update in the 
context menu.  For information about the Update function, refer to the section on the TrueType® 
Font Context Menu. 

 

Browser Menu:  Update 
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The Thumbnail of the font in the Browser is updated appropriately. 

 

Browser Thumbnail Updated with New Font 

8. Recall (read) the message created in Step 3. 

 

Recalling Message:  Updated Font 

The text composed using the font Demo Font 3 has changed to reflect the update just performed on 
the font in the Browser.  

Additionally, any other messages containing Demo Font 3 will display the updated version of the font. 
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RGB Font Asset Operations 

Browser > ;  Browser Menu > Show Font Assets 
The RGB Font feature, familiar to iNFiNiT! operators, provides fast access to bitmap graphics in Lyric.  An 
RGB Font is a set of characters that are based on bitmap graphics, instead of what is generally known as 
font characters.  Each bitmap graphic in the font is mapped to a unique key or key combination, enabling 
quick typing of graphics onto the Canvas.  A common use of RGB Fonts is for display of sports logos.  Each 
logo is mapped to a key, and can easily be placed onto the Canvas by pressing a key or key combination, 
without the necessity of using the Graphic Import function. 

Bitmap graphics from an RGB Font can be added to the Canvas as animatable bitmap objects or as 2D row-
based elements if typed in a 2D Text Window. 

Create RGB Font 
To create an RGB Font: 

1. If Font Assets are not already displayed in a Browser, open a Browser window, then click  or 
select Show Font Assets from the Browser menu. 

2. Right-click in the area of the Browser where the Font Assets are displayed, then select Create RGB 
Font from the Font Asset, TrueType or RGB Font context menu.  Refer to Browser Font 
Operations for brief descriptions of each of these menus. 

 

Create RGB Font Dialog Box 

3. Enter a Name for the font (e.g. Sports Logos), then select a Hotkey from the Hot Key drop-down list 
box.  As described above, the Hotkey choices are Alt + 0 through Alt + 9; and Alt + Shift + 0 
through Alt + Shift + 9. 

4. Click OK.  The Create RGB Font dialog box closes.  A new Font Asset now appears in the 
Browser.  Lyric assigns a default bitmap graphic (shown below) to uppercase A (Shift + A).  The 
graphic as well as the assigned Name and Hotkey is displayed as the icon.  When a new bitmap is 
assigned to uppercase A, a representation of that graphic will take the place of the default RGB Font 
icon. 

 

Default RGB Font Graphic 

RGB Fonts can also be created using the Custom Font Editor, accessible from the context (right-click) 
menu of the blank area of the Browser or the context menu of an RGB Font Asset. 
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The RGB Font context menu accesses RGB Font operations.  To display the menu, right-click on an RGB 
Font icon/text. 

 

RGB Font Context Menu 

The menu items, except for Create RGB Font (already described above), are described in the following 
paragraphs. 
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Font Browser 
The Font Browser provides the ability to view the bitmaps in the RGB Font, as well as add, delete and 
modify RGB Font characters. 

 To open the Font Browser, select Font Browser from the RGB Font context menu.  The figures 
below show Font Browser displaying a new RGB Font, and a Font Browser displaying an RGB 
Font containing multiple characters. 

 

Font Browser  - New Font 
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Font Browser - Populated 

To quickly select a character in the Font Browser: 
 Press the key combination for that character.  For example to select the RGB Font character that is 

assigned to Shift + C, press Shift + C. 



 Creating and Using Fonts in Lyric 

 11-35 

The following parameters customize the font for easy recognition, as well as providing information aids when 
using the Browser Search function.  Right-clicking the Name, Comments and Keywords displays a context 
menu that provides text editing functions Undo, Cut, Copy, Paste, Delete and Select All. 

Parameter Description 

Name Can identify the function of the font, e.g., Sports Logos. 

Hot Key Defines the Hotkey combination that can be used to quickly load 
the font.  Twenty hotkeys are available.  The following Hotkeys 
can be set: 

 Alt + 0 through Alt + 9; Alt + Shift + 0 through Alt + 
Shift + 9. 

To set a Hotkey: 

 Just select from the drop-down list box. 

To load a font associated with a Hotkey: 

1. Activate the Browser which is displaying the font, then 
make the Canvas active. 

2. Press the Hotkey combination.  Note that only the 
alphanumeric number keys, not the numeric keypad 
keys, can be used in a Hotkey combination. 

Comments Comments that could further define use or provide other 
information.  The Comments field can accommodate 255 
characters.    Pressing Enter performs the same function as 
clicking OK, so it cannot be used to start a new line.  To insert a 
carriage return in the field: 

 Press Ctrl + Enter. 

Key Words Keywords that can be used for Browser Search purposes. 

Key Assignment Displays each graphic that is mapped to the key or key 
combination.  RGB Font characters can be added, deleted or 
modified from the Key Assignment window.  These operations 
are described directly following this table. 

OK or press Enter Applies the parameter settings to the Font Asset. 

Cancel Cancels the application of the settings to the Font Asset. 

The Key Assignment window has a context menu, accessible by right-clicking on a font character listing or a 
blank area in the window.  the figure below shows the context menu as accessed by right-clicking on the font 
character mapped to uppercase A. 

 

Key Assignment Context Menu 
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The menu items are described in reverse order. 

Add Character 
A bitmap graphic can be mapped to each key combination available to Lyric: 

In the Key Assignment window, right-click on either an existing RGB Font character listing or the blank area.  
If a blank area is right-clicked, an unpopulated Add/Modify RGB Character dialog box is displayed.    

 

Add/Modify RGB Character Dialog Box - Blank Area Right-Clicked 

If an existing RGB Font character listing is right-clicked, the dialog box is populated with the information 
about the character. 

 

Add/Modify RGB Character Dialog Box - Existing RGB Character Right-Clicked 

Set the following parameters.  Note that if an existing listing has been right-clicked, new Key information 
should be entered, or the existing key will be modified.  The modification procedure is described below. 

Parameter Description 

Key Specifies the key to which the bitmap is to be mapped (assigned).  
The Key can correspond to any of the alphanumeric keys 
available on the PC or Duet keyboard, and includes Shift + key 
combinations.  Alt + key combinations, described below, are also 
available. 

Value Corresponds to the ASCII Code  for the key or key combination.  
The Value field automatically populates when Key or Alt is set. 

It is possible to enter a Value first, but only the Key field reflects 
the setting.  Because the Alt field does not, it could becomes 
difficult to tell which key combination will produce the RGB 
character when out of the range of common alphanumeric 
characters. 
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Parameter Description 

ALT Enables the assignment of RGB Font characters to Alt + or Alt + 
Shift + key combinations.  For example, to assign an RGB Font 
character to Alt + D (which is Alt + Shift + D): 

 Enter Shift + D in the Alt field.  Do not enter a setting 
into the Key field.  It automatically displays a bar to 
indicate an Alt setting. 

Path Specifies the path to the graphic assigned as the RGB Font 
character. 

Browse Enables browsing for graphic assigned as the RGB Font 
character.  Once a graphic is selected, the path automatically 
populates the Path field. 

OK Adds the new RGB Font character to the RGB Font.  The new 
character now appears on the Font Browser. 

Cancel Cancels the addition of the new RGB Font character. 

After parameters are set: 

 Click OK to add the new RGB Font character or Cancel to cancel. 

Once a graphic is assigned to a key or key combination, pressing that key or key combination imports the 
graphic to the Canvas. 

Modify Character 
The Modify Character function enables the modification of any RGB Font character.  This function is 
available to all RGB Font characters.  It is not available when a blank area of the Font Browser is right-
clicked. 

If the RGB Font character assigned to uppercase A key is right-clicked, the following is displayed: 

 

Add/Modify RGB Character Dialog Box - Character A Right-Clicked 

This is the same dialog box used for adding a new character.  Refer to the parameter table above for 
information on the settings.  Note that: 

 When the character uppercase A is selected for modification, only the Path, i.e. the graphic assigned 
to the key. can be modified.  The Key value itself cannot be modified. 

 If an RGB Font character not assigned to uppercase A is right-clicked, the Key, Value and ALT 
fields become available for modification. 
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Delete 
The Delete function enables the deletion of an RGB Font character from an RGB Font.  The Delete function 
is available to any RGB Font character except that assigned to uppercase A.  It is also not available when 
clicked on a blank area of the Font Browser. 

1. From the Key Assignment context menu, select Delete.  The following prompt asks for confirmation 
of the deletion of the specific font. 

 

RGB Font Character Delete Prompt 

2. Click OK to execute the Delete, or Cancel to cancel. 

WARNING!  There is no Undo for this operation! 

Custom Font Editor 
The Custom Font Editor provides the ability to create RGB Fonts which can then be imported into other 
Browser windows either locally or remotely.  Refer to Custom Font Editor for information on using this tool. 

Delete 
The Delete function enables the deletion of an RGB Font from a Browser database. 

1. From the RGB Font context menu, select Delete. 

OR 

Select (click) the RGB Font Asset, then press Delete on the PC keyboard or Delete Character on 
the Duet keyboard. 

The following prompt asks for confirmation of the deletion of the specific font. 

 

Font Delete Prompt 

2. Click Yes to execute the Delete, or No to cancel. 

WARNING!  There is no Undo for this operation! 
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Update 
This function replaces the selected font in the Browser with the currently active font.  To perform an update: 

1. Create a new font or activate an existing font.  It can be either a TrueType® or RGB Font  It is not 
necessary for the replacement font to be resident in the Browser. 

2. In the Browser, right-click the font to be replaced, then select Update from the context menu.  The 
following prompt is displayed: 

 

Update Font Prompt 

3. Click Yes to replace.  The active font replaces the selected font. 

WARNING!  There is no Undo for this operation! 

NOTE 
When an RGB Font character is updated via sync-RGB-fonts, the new character assumes 
the size of the original. 

Add/Modify Character 
The Add/Modify function enables the addition or modification of an RGB Font character without the 
necessity of entering the Font Browser.  To add or modify an RGB Font character: 

1. In the Browser, right-click on the RGB Font listing, then select Add/Modify Character from the 
context menu.  A blank Add/Modify RGB Character dialog box is displayed. 

 

Add/Modify Dialog Box 

2. Set the Key assignment.  Note that if the key already has a graphic assigned, the path is not shown 
in the Path field.  Be cautious when working in this manner with RGB Fonts that already have 
graphics assigned to keys.  It is recommended that in this instance, modifications and additions be 
performed from the Font Browser as previously described. 

3. Click OK.  The changes to the RGB Font are applied. 
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Import RGB Font 
A set of graphics can be imported as an RGB Font to the Browser.  The graphics must adhere to the 
following conditions: 

 All graphics to be assigned to the font must reside in the same directory. 

 All graphics assigned to the font must be in .tga format. 

 The filenames must correspond to the ASCII code numbers.  For example, the graphic that 
corresponds to Shift + A must be named 0065.tga; the graphic that corresponds to Shift + B must be 
named 0065.tga; etc. 

To perform an RGB Font import: 
1. Create a new RGB Font, but do not modify or add any characters.  

2. Left-click on its icon/text in the Browser, then select Import RGB Font from the context menu.  The 
Browse for Folder dialog box is displayed. 

 

Browse for Folder Dialog Box 

3. Navigate to the folder that contains the graphics files. 

4. Click OK.  The graphics files are loaded into the new RGB Font in the Browser.  Their Key 
Assignments are determined by their filenames. 

Refer to Custom Font Editor for additional information regarding RGB Font creation. 
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Custom Font Editor 
Browser > Select, then right-Click RGB Font or Right-Click Blank Area in Browser > Custom Font 
Editor 
Tools Menu > Font Editor 
Lyric Directory > Open CFE.exe 
Before working with the Custom Font Editor, it is important to understand RGB Fonts.  RGB Fonts are sets 
of bitmaps, wherein each bitmap is assigned a to unique key or key combination.  When the key or key 
combination is typed, the assigned graphic is imported to the Canvas.  Refer to RGB Fonts for detailed 
information RGB Font characteristics and operations. 

Custom Font Editor features include: 
 Conversion of Lyric RGB Fonts to iNFiNiT!!® RGB Fonts and conversion of iNFiNiT!! RGB Fonts to 

Lyric RGB Fonts. 

 Drag-and-drop character assignment within the Custom Font Editor, or from one open Custom 
Font Editor to another. 

 Independent Logo Clipboard. 

The Custom Font Editor also performs the same functions as Lyrics Font Browser while offering different 
methods of adding, modifying and cataloging characters in an RGB Font.  Refer to RGB Fonts for 
information on the Font Browser. 

Launching the Custom Font Editor 
The Custom Font Editor can be launched from within Lyric or independently from outside of Lyric: 

 From the Lyric Browser, display the Font Assets.  Select, then right-click an RGB Font, or right-click 
a blank area in the Browser. From the context menu, select Custom Font Editor. 

 From the Lyric Tools menu, select Font Editor. 

 In the directory in which Lyric is installed, locate, and then double-click CFE.exe. 

 

Custom Font Editor Icon 

Multiple instances of the Custom Font Editor can be open at the same time.  
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File Menu 
Overview 
The File menu includes commands familiar to Windows® users, as well as those specific to the Custom 
Font Editor. 

 

File Menu - Expanded 
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New 

The New Font Editor Window command opens a new Font Editor.  Note that unlike creating an RGB 
Font from the Lyric Browser, there is no default graphic assigned to the uppercase A (Shift + A) key 
combination.  

 

Custom Font Editor - Newly Opened 

Open 
The Open s Font File command displays a dialog box for opening a font which has the same format (Lyric 
or iNFiNiT!) as the last font loaded in the Custom Font Editor.  The procedure for opening each type of font 
is described in the following section. 

Open iNFiNiT! Font   
The Open iNFiNiT! Font command opens an iNFiNiT! font that is stored on the PC or Duets local drive or on 
a networked iNFiNiT! Family system or other drive.  An iNFiNiT! font can also be opened from the drop-down 
menu accessed from the Open icon located on the Custom Font Editor toolbar.  

 

Open iNFiNiT! Font 
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When Open iNFiNiT! Font is selected, the Open a Machine Font dialog box opens.  Navigation to a file is 
the same as in the Windows environment.  iNFiNiT! fonts are all formatted .xxxxxxxx.fnt, where the x's are 
always numerals.  Leading zeroes are not displayed in the file name.  Note that Machine Fonts in this 
environment also refer to RGB Fonts.  Additionally, Machine Font characters and RGB Font characters can 
be mixed within one font. 

 

Open a Machine Font Dialog Box Showing RGB Font Characters 

 

Open a Machine Font Dialog Box Showing Machine Font  and 
RGB/Special Characters 

The information area below the file selection area displays the File Header Name, the Font Type, the File 
Size and the Status of the font load. 

The right area of the Open a Machine Font dialog box displays the Font Preview pane, in which the graphic 
assigned to the font are displayed on a grid representing the Key assignments.  The top left cell of the grid 
represents ASCII Code 0.  The cells are numbered from left-to-right, top-to-bottom.  The character A is at 
ASCII Code 65, which in this grid, is located in the sixth row, at the sixth cell. 
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After navigating to the iNFiNiT! font file: 
 Click Open.  The Open a Machine Font dialog box closes, and the iNFiNiT! font is loaded into the 

Custom Font Editor. 

Note that the Open operation is different from importing an iNFiNiT! file from the File menu in Lyric. 

Open Lyric Font 
The Open Lyric Font command opens a Lyric font that is stored on the PC or Duets local drive or on a 
networked drive.  A Lyric font can also be opened from the drop-down accessed from the Open button 
located on the Custom Font Editor toolbar.  

 

Open Lyric Font 

When Open Lyric Font is selected, the Open Lyric Font dialog box opens: 

 

Open Lyric Font Dialog Box 

The Open Lyric Font dialog box is composed of the following elements: 

Element Description 

Available Fonts:  Lists the available RGB Fonts in the selected data source 
(database).  This window contains five fields for each listed font. 

Font Number 
(Reserved1) 

Assigns a number to the RGB Font, in order of its creation in 
the database.  Number 1 is reserved for use by the Custom 
Font Editor. 

StyleName The name assigned to the font. 

Height Default Height always at 50 for RGB Fonts.  The Height setting 
has no effect on the size of each graphic in the font. 

Edge Default Edge always at None for RGB Fonts.  The Edge 
setting has no effect on the appearance of each graphic in the 
font. 

LastModified Displays date and time of last modification to the RGB Font. 
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Element Description 

Preview:  Determines which graphic is displayed as the identifying icon 
(thumbnail) in the Browser.  The default is the graphic assigned to uppercase A, 
which is ASCII Code 65.  The Preview Icon can be set to another graphic, as 
shown in the previous figure. 

Preview Icon 
Assignment 

This field displays the ASCII Code for the Preview Icon.  In the 
figure above, it is 137, which corresponds to uppercase   It can 
be changed by selecting a new ASCII Code from the drop-down 
list box. 

Preview Icon 
Graphic 

Displays the graphic associated with the Preview Icon 
Assignment. 

Preview Icon 
Path 

Displays the path to the Preview Icon graphic. 

Other Functions 

Delete Font Deletes the font on which the cursor is positioned. 
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Element Description 

Select Data 
Source 

Enables selection of new data source.  When clicked, the 
following Data Link Properties dialog box opens: 

 

Data Link Properties Dialog Box 

Navigate to the database, then click OK.  For information on 
setting other parameters in this dialog box, refer to Microsoft® 
Windows® documentation. 

Open Loads the selected font into the Custom Font Editor. 

Cancel Cancels the font load and closes the Open Lyric Font dialog 
box. 
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To load a Lyric font: 
 Place the cursor on the row that lists the font, then double-click the row or click Open.  The Open 

Lyric Font dialog box closes, and the Lyric font is loaded into the Custom Font Editor.  The Title 
Bar of the Custom Font Editor displays the name of the data source, as well as the Font Number 
as displayed in the Open Lyric Font dialog box. 

 

Custom Font Editor - Lyric Font Loaded 

Save 
Save  saves the font in its current format, with the most recent changes.  

Save As 
Save As provides the operator the opportunity to specify a new name or a different format for the font being 
saved.  A copy of the file may also be created and saved with these changes without affecting the original. 

 

Save As iNFiNiT! or Lyric Font Icon and Drop-Down 

Print 
Print allows the contents of an RGB Font to be printed out as a keyboard map for reference.  Refer to 
Printing Font Sets later in this section for details.  
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Print Setup 
Accesses the Print Setup facility for the specific printer.  Refer to the printer documentation for information on 
setting up the printer.  

Close 
Close Editor exits the Custom Font Editor..  

Close All Unmodified Editors 
Close All Unmodified Editors only closes Custom Font Editors to which no changes have been made.  

Close All Editors 
Close All Editors closes all Custom Font Editors, whether or not they have been modified, but does 
request confirmation. 

 

Confirm Save Changes to Browser 

Selecting Characters 
One or multiple characters can be selected.  Delete and Toggle Marker operations affect all currently 
selected characters. 

To select a character: 
 Click on the character. 

To select a range of characters: 
1. Click the character in the range. 

2. Hold the Shift key down while clicking the last character in the range. 

To select non-contiguous characters: 
 Hold the Ctrl key down while clicking the characters. 
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Logo Clipboard 
The Logo Clipboard can store images which are available to any of the fonts that are currently displayed in 
open Custom Font Editors.  Images may be added to the Logo Clipboard directly from directories 
accessible to the system.  An image can then be drag-and-dropped from the Logo Clipboard to any font 
displayed in an open Custom Font Editor.  An image on the Logo Clipboard may also be added to a font 
through the Add Picture function in the Custom Font Editor.  To open the Logo Clipboard: 

 Click the View Logo Clipboard icon on the Custom Font Editor toolbar, or select View Logo 
Clipboard from the Window menu. 

 

Logo Clipboard 

Logo Clipboard functions are available from both Logo Clipboard toolbar, as shown in the previous figure, 
the Logo Clipboard context menu, as well as from shortcut keys.  To display this menu: 

 Right-click the Logo Clipboard.  Note that certain functions require that a selected graphic is right-
clicked. 

 

Logo Clipboard Context Menu 
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To add a graphic to the Logo Clipboard: 

1. Click the Add icon , press Insert or select Add Picture from the Logo Clipboard context 
menu.  The Open a Picture File dialog box opens. 

 

Open a Picture File 

2. Navigate to the desired image file. 

3. The following Alpha parameters can be set, depending on the type of image file: 

 Track Alpha File:  Available to RGB Only image files. 

 Invert Alpha:  Available to only RGB + Alpha image files. 

 Neither Track Alpha File nor Invert Alpha are available to RGB + Associated Alpha image 
files. 

4. Click Open.  The image is added to the Logo Clipboard. 

To add RGB font characters from an iNFiNiT! Machine Font: 
1. Select Add Pictures from Machine Font from the Logo Clipboard Context menu.  The Open a 

Machine Font dialog box opens. 

2. Select a Machine Font, then click Open.  All RGB characters from the Machine Font are added to 
the Logo Clipboard, following any existing graphics on the Logo Clipboard. 

To delete a graphic from the Logo Clipboard: 

 Select the graphic that is to be removed, and then click the Delete icon , press Delete or 
select Remove Selected Picture from the Logo Clipboard context menu. 

To clear all graphics from the Logo Clipboard: 

 Click the Clear icon  or select Clear Clipboard from the Logo Clipboard context menu. 
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To save a Logo Clipboard graphic to an image file: 

1. Click the Save icon , press Ctrl + S, or select Save Picture from the Logo Clipboard 
context menu.  The Save As dialog box opens. 

 

Save As Dialog Box 

2. Navigate to the directory in which the file is to be saved, enter a name in the File Name field, select a 
file type in the Save as Type field, and then click Save. 

Graphics can be cut and copied to the Windows® Clipboard and pasted from the Windows® Clipboard.  
Note that Paste operations do not overwrite graphics already on the Logo Clipboard.  Pasted graphics are 
always added to the Logo Clipboard. 

 To cut a graphic to the Windows Clipboard:  Select the graphic, and then press Ctrl + X select 
Cut to Windows Clipboard from the Logo Clipboard context menu.  The graphic is removed from 
the Logo Clipboard and pasted to the Windows Clipboard. 

 To copy a graphic to the Windows Clipboard:  Select the graphic, and then press Ctrl + C select 
Copy to Windows Clipboard from the Logo Clipboard context menu.  The graphic is remains on 
the Logo Clipboard and is copied to the Windows Clipboard. 

 To paste a graphic from the Windows Clipboard:  Press Ctrl + V select Paste from Windows 
Clipboard from the Logo Clipboard context menu.  The graphic is pasted from the Windows 
Clipboard to the Logo Clipboard.  The graphic remains available on the Windows Clipboard until it 
is overwritten by another Cut or Copy operation.  Note that a graphic pasted to the Windows 
Clipboard can originate from an external program such as Adobe® Photoshop®.  

The size of the Logo Clipboard thumbnails can be set to Small, Medium, Large or Extra Large. 

 

Thumbnail Sizes:  Small, Medium, Large, Extra Large 
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To change thumbnail size: 
 Click the S, M, L or XL icon to display characters as Small, Medium, Large or Extra Large, 

respectively. 

OR 

 Press S for Small; M for Medium; L for Large; or X for Extra Large. 

OR 

 Select Picture Size from the Logo Clipboard context menu, then select Small, Medium, Large or 
Extra Large from the Picture Size menu. 

 

Picture Size Menu 

To change the order in which the graphics are displayed: 
1. Select Arrange Pictures from the Logo Clipboard context menu.  The Arrange Pictures menu is 

displayed. 

 

Arrange Pictures Menu 

The menu is divided into two sections: 

 Parameter:  The specific parameters associated a graphic on which ordering can be based. 

o TimeStamp:  The time at which the graphic was added to the Logo Clipboard. 

o Description:  The Description as set in the Logo Clipboard. 

o Size:  The area of the graphic as calculated by multiplying Width X Height. 

o Width:  The Width of a graphic, in pixels. 

o Height:  The Height of a graphic, in scanlines. 

o Aspect Ratio:  The Aspect Ratio of the graphic, as calculated by dividing Width 
divided by Height. 

 Order Direction:  The direction of ordering. 

o Reverse Order:  Reverse order of the currently set ordering. 

2. Select one choice from the Parameter section.  The menu closes.  The Logo Clipboard reorders the 
graphics based on the specified Parameter. 
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3. Reopen the menu, and then select one or both orders from the Order Direction section.  The Logo 
Clipboard reorders the graphics based on the specified Order Direction(s). 

The Logo Clipboard can be set to display on top of the open Custom Font Editors when they overlap, or to 
display behind the active Custom Font Editor when they overlap. 

 To display the Logo Clipboard in front of all open Custom Font Editors when they overlap, select 
(check) Stay on Top from the Logo Clipboard context menu. 

 To display the Logo Clipboard behind the active Custom Font Editor when they overlap, deselect 
(uncheck) Stay on Top from the Logo Clipboard context menu. 

To edit the description of the graphic: 

Edit Description:  Each image in the Logo Clipboard can have a description.  To set the Description: 
1. Select Edit Description from the Logo Clipboard context menu.  The Edit Description dialog box 

opens. 

 

Edit Description Dialog Box 

2. Enter a description in the New Description field, and then click OK. 
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Assigning an Image to a Key Combination 
Add Picture From File 

 

Add Picture From File 

This button provides a quick method for adding images to the Font Editor from local or mapped network 
drives or the Logo Clipboard. 

 Logo Clipboard allows the operator to paste a selected element on the clipboard directly to a 
selected cell on the Font Editor. 

 File in Local Drive allows the operator to navigate directly to the location of a desired file and save 
the file into the Font Editor. 

 

Open a Picture File 

This function may also be invoked by pressing the Insert key with any thumbnail cell (empty or already 
assigned to another image) on the Font Editor selected. 

An image already assigned to a character that is displayed in an open Custom Font Editor, can be dragged-
and-dropped to another position in the same or another open Custom Font Editor.  Note that the original 
character assignment remains the same.  The image is copied to the new position. 
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Character Attributes 
To display basic character attributes, as well as change display parameters: 

 Double-click a character.  The Character Attributes and Display Parameter dialog box is displayed: 

 

Character Attributes and Display Parameter Dialog Box - 
iNFiNiT! Machine Font Character 

 

Character Attributes and Display Parameter Dialog Box - 
Lyric/iNFiNiT! RGB Font Character 
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The Title Bar displays the Key assignment for the character, as well as the size of the character.  There are 
two display parameters which can be set.  Note that they affect the display only within the Character 
Attributes and Display Parameter dialog box, not in the grid display in the Font Editor. 

Chess:  When Chess is enabled (selected), any transparent areas in the character display as a chessboard 
pattern similar to that used in Adobe® Photoshop®.  In the previous two figures, Chess is enabled.  When 
Chess is disabled (deselected), the chess pattern is not displayed.  The default setting is Enabled.  To 
enable/disable Chess: 

 Click the Chess button. 

The following figure shows Chess disabled. 

 

Chess Disabled 
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Show Alpha:  When Show Alpha is enabled (selected), the Alpha information for the character is displayed.  
When Alpha is disabled (deselected), the Alpha information is not displayed.  In the previous three figures, 
Alpha is disabled.  The default setting is Disabled.  To enable/disable Alpha: 

 Click the Alpha button. 

The following figure shows Alpha enabled. 

 

Alpha Enabled 

To display the previous character in the font: 
 Click the < Back button. 

To display the next character in the font: 
 Click the Next > button. 

To close the Character Attributes and Display Parameter dialog box: 
 Click the Close button. 
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Character Context Menu 
A variety of operations can be applied to each character from its context menu.  To display this menu: 

 Right-click the character. 

 

Character Context Menu 

Delete (Ctrl + Delete) 
Delete removes the selected character or characters from the font.  To execute a Delete: 

 Select Delete from the Character context menu or press Ctrl + Delete.  The character is removed 
from the font without confirmation.  Note that the image file is not deleted from its original location.  
This operation is also available from the Edit menu. 

Toggle Marker (Space Bar) 
Toggle Marker applies a marker  to the currently selected characters.  Multiple characters that are marked 
can be batch-processed for operations such as Delete.  Unlike selecting characters by clicking, Shift-clicking 
or Ctrl-clicking, this type of marker applied to characters is not lost when characters outside of the selection 
are clicked.  To mark a character or characters: 

 Select the character or characters to be marked, then select Toggle Marker from the Character 
context menu or press the Space Bar.  This operation is also available from the Edit menu. 

To remove the marker from a character or characters: 
 Select the marked character or characters from which to remove the mark, then select Toggle 

Marker from the Character context menu or press the Space Bar.  This operation is also available 
from the Edit menu. 
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Toggle Mix Mode (iNFiNiT! Fonts Only) 
An RGB character within an iNFiNiT! font can be designated as an iNFiNiT! Mask Character by enabling Mix 
Mode for that character.  When a character has Mix Mode enabled, a small red  icon is displayed in the 
upper right corner of the character in the Custom Font Editor.  Note that iNFiNiT! Mask Characters are not 
supported by Lyric! 

 

iNFiNiT! RGB Character - Mix Mode Enabled 

To enable/disable Mix Mode: 
 Select the RGB character or characters for which to enable/disable Mix Mode, then select Toggle 

Mix Mode from the Character context menu.  This operation is also available from the Current 
Character context menu, as described in the following paragraphs. 

Current Character 
Current Character accesses additional functions that apply to only the currently selected character.  To 
access these functions: 

 Select Current Char from the Character context menu.  The Current Char(acter) context menu is 
displayed. 

 

Current Character Context Menu 

Delete removes the selected character or characters from the font.  To execute a Delete: 
 Select Delete from the Current Char context menu or press Ctrl + Delete.  The character is removed 

from the font without confirmation.  Note that the image file is not deleted from its original location.  
This operation is also available from the Edit menu. 

Edit Marker enables a marker to be applied, toggled or removed.  To edit a marker: 
 Select Edit Marker from the Current Char context menu.  The Edit Marker context menu is 

displayed: 

 
Edit Marker 

o Select Set or press S to set a character as marked. 

o Select Clear or press C to clear the marker from the character. 

o Select Toggle or press T to toggle from marked to unmarked, or unmarked to marked. 
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Edit Mix Mode (iNFiNiT! fonts only) enables an iNFiNiT! RGB character to be designated an iNFiNiT! Mask 
Character.  This feature is covered earlier in the section on Toggle Mix Mode.  To enable/disable/toggle Mix 
Mode: 

 Select Edit Mix Mode from the Current Char context menu.  The Edit ix Mode context menu is 
displayed: 

 

Edit Mix Mode 

o Select Enable Mix or press E to set the character as an iNFiNiT! Mask Character. 

o Select Disable Mix or press D to revert the character to normal. 

o Select Toggle or press T to toggle from iNFiNiT! Mask Character to normal character or 
from normal character to iNFiNiT! Mask Character. 

An image can be assigned as a font character using the Add Picture From function.   

 

Add Picture From 

Edit Menu 
The Edit menu provides editing tools that make it easy to move, cut-and-paste and copy graphics among Key 
assignments. 

 

Edit Menu 

Cut 
 The Cut command deletes the image associated with the highlighted thumbnail and places it on the 

Windows Clipboard. 
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Copy 
 The Copy command copies the image associated with the highlighted thumbnail and places it on 

the Windows Clipboard. 

Paste 
 The Paste command pastes the image from the Windows Clipboard into the thumbnail cell that is 

selected on the Font Editor interface. 

Delete (Ctrl + Delete) 
Delete removes the selected character or characters from the font.  To execute a Delete: 

 Select Delete from the Edit menu or press Ctrl + Delete.  Note that the image file is not deleted from 
its original location.  The character is removed from the font without confirmation.  This operation is 
also available from the Character context menu. 

Select All 
 Select All highlights all thumbnails for use with the other editing functions. 

Toggle Marker (Space Bar) 
Toggle Marker applies a marker  to one or more characters.  Multiple characters that are marked can be 
batch-processed for operations such as Delete.  Unlike selecting characters by clicking, Shift-clicking or 
Ctrl-clicking, this type of marker applied to characters is not lost when characters outside of the selection are 
clicked.  To mark a character or characters: 

 Select the character or characters to be marked, then select Toggle Marker from the Edit menu or 
press the Space Bar.  This operation is also available from the Character context menu. 

To remove the marker from a character or characters: 
 Select the marked character or characters from which to remove the mark, then select Toggle 

Marker from the Edit menu or press the Space Bar.  This operation is also available from the 
Character context menu. 

Tools Menu 

 

Tools Menu 

Different menu items are available depending on which type of font is loaded, and whether or not characters 
in a font a marked . 

 All menu items are available when an iNFiNiT! font is loaded. 

 Edit Font Name, Edit Palette, Initialize to Only RGB Characters and Initialize to Only Special 
Characters are not available when a Lyric font is loaded.  
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Edit Font Name (iNFiNiT! Font Only) 
An iNFiNiT! Font can be assigned a name to make identification easier when selecting a font to open. 

1. From the Tools menu, select Edit Font Name.  The Edit Font Name dialog box is displayed. 

 

Edit Font Name 

 The File Header Name appears in the Open a Machine Font dialog box information area. It 
also appears in the Name 1 field of the Browse for iNFiNiT! Fonts dialog box, accessed 
from the Lyric Browser iNFiNiT! Assets context menu. 

 The Effect Name appears in the Open a Machine Font dialog box information area. It also 
appears in the Name 2 field of the Browse for iNFiNiT! Fonts dialog box, accessed from the 
Lyric Browser iNFiNiT! Assets context menu. 

 The Font Header Name is displayed in the Title Bar of the loaded font in the Font Editor. 

2. Enter a name in the File Header Name field.  Note that if the Link icon at the right of the data fields is 
active, the same name is reflected in the Font Header Name field.  If the Link icon is not active, a 
different name can be entered in the Font Header Name field. 

 

 

Link Icon Active Link Icon Inactive 

3. If desired, enter an Effect Name. 

4. Click OK to apply. 
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Edit Lyric Settings 
The Edit Lyric Settings command allows the operator to set the destination to which embedded RGBA 
graphics from within an iNFiNiT!! font will be exported as discrete graphics files when an iNFiNiT!! font is 
saved as a Lyric font. The images degree of compression in storage may also be set.  Get Default in all 
instances sets the default value for that field. 

 

Lyric Settings Dialog Box 

Folder Format String:  The default string specifies the default location to which new Lyric fonts are saved.  
The string %.4d specifies that the directory name that is generated is a four-digit numeric name.  Each time a 
new font is saved to the default location, the directory name increments by 1.  For example, the font created 
after the font saved in G:\Pic\0003 would be G\Pic\0004. 

Note that the files that are saved in this directory are named based on the Key Number to which they are 
assigned.  For example, the graphic assigned to Key Number 65, which is Shift + A, is named .065.tga 
when saved to the directory. 

Pictures Format:  There are a variety of formats in which the images can be saved. 

Picture Quality:  Range is 0 to 100.where 0 specifies no compression and 100 specifies maximum 
compression. 

Save Only RGB Characters:  When selected (checked), saves only RGB characters. When not selected 
(unchecked), saves all characters. 

Edit Palette (iNFiNiT! Fonts Only) 
Refer to Palette Designer later in this section for details. 
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Initialize Font 
The Initialize Font command clears the loaded font of certain types of files, or clears the font completely. 

 Initialize to Only RGB Characters (iNFiNiT! Fonts Only):  Clears all but RGB Font characters.  
Note that all RGB Font characters are also Special characters. 

 Initialize to Only Marked Characters:  Clears all but marked  characters. 

 Initialize to Only Special Characters (iNFiNiT! Fonts Only):  Clears all but Special characters.  A 
Special character a character that has been added to a Machine Font, but that is not based on a 
Master Font.  For example, a logo can be assigned to a Key combination in a Machine Font.  The 
logo would be both a Special character as well as an RGB Font character.  Note that all RGB Font 
characters are Special characters, even when part of an RGB Font. 

 Initialize to Blank Font:  Clears entire font. 

Window Menu 

 

Window Menu:  View Logo Clipboard 

 The View Logo Clipboard command allows the operator to see the all of the images that have 
been placed on the Font Editors clipboard, which exists separately of the systems Windows 
clipboard. To add a graphic file to the Logo Clipboard or to any selected character cell in the Font 
Editor, press the Ins key or use the appropriate menu. 

 

Logo Clipboard 

Images may be added to the clipboard directly from other directories in the system. Individual items may be 
deleted or the entire clipboard may be cleared at once. The size of the thumbnails may be varied with the S, 
M, L and XL controls. 

 The lower half of the Window menu allows the operator to switch among all open Font Editors. 

Other Buttons On The Toolbar 
 Merge Graphics from is a means for quickly adding an existing RGB Font, in its entirety, to the Font 

Editor.  

NOTE: This action may overwrite the contents of an existing RGB font!  
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It is possible that key assignments in your existing font leave may leave "spaces" in the keyboard map that 
match the key assignments in the iNFiNiT! RGB font being imported. If this is the case, nothing in your 
existing RGB font will be overwritten by this Merge command.  The safest course of action is opening a new 
file on the Custom Font Editor before using the "Merge Graphics from" command. 

1. Make the menu selections shown here. 

 

Merge Graphics From 

2. The Open a Machine Font window opens, as shown in the following figure. Navigate to, and select 
an iNFiNiT! Machine Font that has been previously imported onto a local or networked Windows 
drive. Simply single-clicking a source loads the preview pane at the right side of the window as seen 
below. 

 

Open a Machine Font 
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3. Once the preview is fully loaded, click the Open button. The thumbnail positions in the new RGB Font 
are populated as seen below, and the system displays a dialog confirming that the operation was 
successful. 

 

Thumbnails Populate Custom Font Editor 

4. Click OK. 
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Save Picture or File, Save Font as File or Suite of Pictures 
There are a number of methods for saving images from the Font Editor to local or mapped network drives.  

 (Save) Picture at cursor as File in Local Drive allows the operator to save a copy of the highlighted 
image in the Font Editor as a standard file type (.bmp, .jpg, .tif, .tga, .psd) anywhere in the system or 
network.  A green border surrounding the image indicates that is selected. 

 

Save As File in Local Drive 

 (Save) Font as File in Local Drive saves a copy of the current font with a new number in the 
database.  

 

Save Picture to File:  Font as File in Local Drive 
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 (Save) Font as Suite of Picture Files in Local Drive saves a copy of each image in a font to your 
system or a network. The options for saving these images are shown below. 

 

Save Font as Pictures 

You may browse for the folder where the new images will be stored, and create a new folder within that 
location. The Root File Name option allows the operator to create a prefix contained in the name of each 
image file created. 

 

Root File Name Option 
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Creating an iNFiNiT! Machine Font from a Lyric RGB Font 
1. If not already present either on the system running Lyric or on a network, create a Windows-formatted 

directory for storing iNFiNiT! messages, and another Windows-formatted directory for storing 
Machine Fonts.  The following example shows directories created in C:\iNFiNiT on the system on 
which Lyric is running. 

  

Creating Directories for Storing iNFiNiT! Messages and Machine Fonts 

2. From the Custom Font Editor, open the Lyric RGB Font to be used on the iNFiNiT! Family system. 

3. From the Custom Font Editor File menu, select Save As > Save as iNFiNiT! Font....  The Save 
Machine Font As dialog box opens. 

   

Save Machine Font As Dialog Box 

4. Enter a File Name in the format .xxxxxxxx, where x represents any numeral.  Not that any leading 
zeroes can be omitted from the File Name.  iNFiNiT! Machine Font File Names always begin with a 
decimal, are always numeric, and are never more than eight digits.  Examples:  .0001, .12345678, 
.86940. 

5. Click Save.  The Lyric RGB Font has now been saved as an iNFiNiT! Machine Font. 

The Machine Font can then be sent via FTP to an iNFiNiT! Family system.  Refer to FTP - Transferring 
Files to/from an iNFiNiT! System for information. 
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Using an iNFiNiT! RGB Font in Lyric 
An iNFiNiT! RGB Machine Font can be used in Lyric.  First, it must be transferred via FTP from the iNFiNiT! 
system to a local or networked Windows-formatted directory.  For information on this procedure, refer to FTP - 
Transferring Files to/from an iNFiNiT! System. 

Palette Designer 
The palette for iNFiNiT! Machine Font characters can be set by the user.  Note that any application of a 
Color set is applied to all of the Machine Font characters in the font.  RGB Font and Special characters are 
not affected by Palette changes or application of Color. 

 

Palette Designer 
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There are eight color sets for Body, Edge and Background of the font.  To edit a color for the Body, Edge or 
Background of a font: 

1. Double-click the color chip, or highlight the row, then click the Edit Body, Edit Edge or Edit Bkgnd 
button.  The Color dialog box opens. 

 

Color Dialog Box 

2. Set color as described in the section on Color Selection for Light Sources and 3D Characters 
Objects.   

3. When color is set, click OK to apply the color.  The Color dialog box closes. 

Activating Drag Colors allows a color to be dragged-and-dropped from one color chip to another.  To 
activate/deactivate Drag Colors: 

 Select (check)/deselect (uncheck) the Drag Colors checkbox. 

A color can also be copy-and-pasted from a Body, Edge or Bkgnd to another Body, Edge or Bkgnd: 
1. Highlight the row which displays the Body, Edge or Bkgnd color that is to be copied. 

2. Click the Copy Body, Copy Edge or Copy Bkgnd button. 

3. Highlight the row that contains the Body, Edge or Bkgnd color that is to be replaced. 

4. Click the Paste Body, Paste Edge or Paste Bkgnd button.  The copied color is pasted to the 
selected color chip. 

The Subpalette corresponds to the iNFiNiT! Subpalette, and can also be edited.  The Subpalette is 
composed of 29 separate segments, each which can have its color individually set.  The default setting is a 
gradation that coordinates with the currently selected Palette.  The Subpalette segments are identified as 
follows:  Bkgnd, Name 4 - 31.  When editing a Subpalette segment, they is further identified as follows:  
Name:  Bkgnd corresponds to Sub(palette):  Bkgnd; Names:  4 - 31 correspond to Sub(palettes):  2 - 29. 

To edit the color of a segment: 
1. Double-click the color chip, or highlight the segment, then click the Edit button.  The Color dialog box 

opens. 

2. Set color as described in the section on Color Selection for Light Sources and 3D Characters 
Objects. 

3. When color is set, click OK to apply the color.  The Color dialog box closes. 
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Activating Drag in the Name or the Color column allows a color to be dragged-and-dropped from one 
segment to another.  When Drag is inactive, dragging through the Subpalette selects a range of segments.  
To activate/deactivate Drag: 

 Select (check)/deselect (uncheck) the Drag checkbox. 

A range of segments can also be selected as follows: 
1. Click the first segment in the range. 

2. Hold the Shift key down while clicking the last segment in the range. 

In the following figure, the Subpalette on the left shows the color at Name 10, which is Sub(palette) Position 
8, dragged to Name 29, which is Sub(palette) 27.  The Subpalette on the right shows the range selected 
from Name 10 through Name 29, which corresponds to Sub 8 through Sub 27. 

 

Dragging Color vs. Dragging to Select Range 

To select the entire range of segments in the Subpalette: 
 Click the Select All button. 

To select non-contiguous segments in the Subpalette: 
 Hold the Ctrl key down while clicking the segments. 

A color can also be copy-and-pasted from one segment to another segment, selected segments or a range of 
segments: 

1. Highlight the segment which displays the color that is to be copied. 

2. Click the Copy Color button. 

3. Highlight the segment, select non-contiguous segments or select the range of segments in which the 
color is to be replaced. 

4. Click the Paste Color button.  The copied color is pasted to the selected segments. 
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A gradation can be applied to a range of contiguous or non-contiguous segments.  The gradation is applied 
from the topmost selected segment color to the bottom-most selected segment color. 

1. Apply a color to the top segment of the gradation, and then apply a color to the bottom segment of the 
gradation. 

 

Top and Bottom Colors Applied 
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2. To apply the gradation to a range of segments, select the range so that it starts with the top color that 
was just set, and ends with the bottom color that was just set.  To apply the gradation to non-
contiguous segments, select the segments, making sure that the top and bottom segments to which 
the colors were applied are selected. 

 

Setting Up a Contiguous and a Non-Contiguous Gradation  
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3. Click the Gradate button.  The gradation is applied to the selected segments.  Note that in the 
instance of non-contiguous segments, the gradation is not applied to segments positioned between 
selected segments. 

 

Gradation Applied to Contiguous and Non-Contiguous Segments 
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Printing Font Sets 
Browser (Font Assets) > Click RGB Font > Custom Font Editor 
Tools Menu > Font Editor 

Print  allows the contents of an RGB Font to be printed out as a keyboard map for reference as seen 
below.    

   

Print Browser 
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The viewing area can be zoomed  to show keys of particular interest. Use the Zoom 
control in the lower-right corner of the interface and the scroll bars. 

 

Zooming In on the Print Browser 

The printout can include user-created text headers and footers and can include filepath information on 
the source images assigned to each key. The keyboard map can be laid out in various ways with the 
controls at the right side of this options interface. 



 

 12-1 

12. 2D Text 

Overview 

About 2D Text 
2D Text is composed of 2D characters created from Font Faces, also known as Font Styles, to which a set 
of characteristics such as Font Size, Font Color, etc. can be applied.  2D Text is introduced to the Canvas 
simply by typing into one of the following types of 2D Windows.  Refer to Getting Started in Lyric for details 
on introducing these windows to the Canvas.  Each type of 2D Window exhibits a characteristic behavior 
when an animation is executed: 

 2D Text Window:  Text remains static. 

 2D Roll Window:  Text rolls in a vertical direction.  Refer to Roll for details on setup and execution. 

 2D Crawl Window:  Text crawls in a horizontal direction.  Refer to Crawl for details on setup and 
execution. 

 2D Type On Window:  Text appears on the screen as if it is being typed live.  Type On is also known 
as Slow Reveal.  Refer to Type On/Slow Reveal for details on setup and execution. 

Text in these windows can be edited in a similar manner and can be updated in real time from a variety of 
sources. 
There also a special type of 2D text font, known as an RGB Font, which can be typed into all types of 2D 
Windows, but which is not created from a Font Face.  It is, instead, created from bitmap graphics mapped to 
keys, so that typing produces images instead of characters.  This is an especially versatile tool for quickly 
displaying sports logos and other frequently used graphics.  Unlike Font Face-based fonts, however, 
attributes such as size and color are not adjustable in the same manner.  Changes to the image must be 
made using other techniques.  Refer to RGB Fonts for more comprehensive information on creation and 
modification. 

Unicode text entry is supported.  2D text entry (including the Spline Window) and Template Update is also 
supported for Chinese, Japanese and Korean.  Unicode Only must selected in CG Preferences in order to 
accommodate Asian language text entry.  Refer to the section on CG Preferences for information regarding 
the Unicode Only setting. 

2D Text is also used in three other types of 2D Windows: 
 Spline Window:  2D Text animates along a preset baseline, allowing it to travel across the Canvas in 

ellipses, curlicues, spirals, etc.  RGB Font characters can also be used in Spline Windows.  Refer to 
Spline Window for details on setup and execution. 

 Clock and Timer Windows:  A running Clock(s) and or Timer(s), populated with 2D Text or RGB 
Font characters, can be displayed. 

2D Text already in a 2D Text Window can be converted into animated or image states: 
 Animate Elements enables the individual animation of 2D Text and RGB Font characters. 

 Advanced Text Effects is a special case of Animate Elements, where prescripted animations are 
applied to the 2D Text  and RGB Font characters. 

 Advanced Image Effects enables the contents of an entire 2D Window to be converted into a 
bitmap, to which an effect such an Explosion, Matrix or Wipe can be applied. 

While in one of these states, the 2D Text and RGB Font characters cannot be edited.  Lyric does provide the 
ability to switch out of the state to allow editing of 2D Text and RGB Font characters that originated from a 
2D Text Window. 

Initial Edit Mode, Placing a 2D Text Window on the Canvas 
The default setting of Lyric's Initial Edit Mode, accessed from Config Menu > Preferences > CG 
Preferences, determines if a full-screen 2D Text window is created with each new Canvas. If a full screen 
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2D Text window is present, it is indicated by a blue border just inside the perimeter of the Canvas (and by a 
"2D Text" entry in the Scene Graph).  To create a smaller, "windowed" 2D Text window: 

 Click the 2D Text toolbar button on the Chyron Toolbar or select Text Window from the Tools 
menu. 

 

2D Text Tool 

A 2D Text window appears on the display: 

 

2D Text Window 

Setting Text Attributes: Before typing, you may quickly set Font, Font Size, Face and Edge Color via the 
Font Toolbar (below), or via the Font and 2D Font FX tabs on the Properties menu.  

 

Font Tools 

Entering Text:  Left-click in the 2D Text window to establish the position of the first character to be typed. 
When the first character is typed, a green baseline appears. Once typed, text may be selected for further 
editing, and changes to font style, size, and other attributes may be applied.  Insert/Overwrite Mode can be 
set to either append new text to existing text, or to overwrite existing text with new text.  Insert/Overwrite 
Mode is covered later in this chapter. 

Pasting Text from Other Applications:  Lyric supports the Windows® Clipboard, so that text from any 
Windows application can be cut or copied and then pasted into 2D Text windows. 

Editing Text:  2D text editing functions are available from the Edit Menu, as well as from the 2D Text 
Context Menu.  Editing 2D text is covered later in this chapter. 

Resizing/Repositioning the Window: To resize a 2D Text window, click/drag the window corners to achieve 
the desired size. To reposition the 2D Text window, drag the window's Title Bar or any of its corners (a cross-
hair cursor will appear when your mouse is properly positioned on the title bar or in the window to perform the 
move). 

Preferences: The Preferences item on the Config menu enables customization of the behavior of 2D Text 
windows.  
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Setting 2D Font Attributes 
Font Face/Style 
Font Face or Font Style can be selected from either the Font Tools > Font Facename drop-down list box or 
the Properties > Font > Font Facename drop-down list box.  Refer to the chapter on Creating and Using 
Fonts in Lyric. 

Style 
Style can be set from can be selected by clicking the Font Tools  > Bold, Italic and/or Underline icons, or 
by selecting the Style (unlabeled) drop-down list box in Properties > Font setting.  Refer to the chapter on 
Creating and Using Fonts in Lyric. 

Size, Aspect Ratio, Scale, Kerning and Other Characteristics 
Size can be set in the Font Tools > Font Size field or via the Properties > Font > Size setting.  Size and 
other characteristics such as Rotation, Aspect Ratio and Kerning can be set as well.  Refer to the chapter 
on Creating and Using Fonts in Lyric. 

Edges 
2D characters can be given depth by adding one or more Edges.  Edge characteristics can be set in the 
Properties > 2D Font FX tab.  Refer to the chapter on Creating and Using Fonts in Lyric for in-depth 
information. 

Color, Texture and Surface Properties 
Solid or ramped color can be applied to the Face and Edges of 2D characters via Font Tools and Properties 
> 2D Font FX.  Solid color and Transparency can be applied to Face and Edges of 2D characters via 
Properties > Surface.  Bitmaps can be applied to the Face and Edges of 2D characters via Font Tools and 
Properties > 2D Font FX.  Refer to the chapter on Creating and Using Fonts in Lyric. 

TrueType® Font Preview 
TrueType® Font Preview enables the user to quickly review the available characters in a font, change the 
current font, or select a character (including Unicode) to add to the Canvas at the current cursor position.  
TrueType Font Preview can be used with both 2D and 3D characters.  TrueType® Font Preview is accessed 
from the Font Properties tab.  Refer to the chapter on Creating and Using Fonts in Lyric for in-depth 
information. 

Enable Word Wrap 
Edit Menu > Enable Word Wrap 

When text is typed past the end of a row in a 2D Text Window, it can be set either to continue past the 
border of the 2D Text Window (e.g. for setting up a Crawl), or to wrap to the next line so that all text displays 
within the borders of the 2D Text Window (e.g. for setting up a Roll). 

 The default setting for Enable Word Wrap is disabled. 

 The Enable Word Wrap setting is applied to all 2D Text Windows (including 2D Roll, 2D Crawl and 
2D Type On Windows) on the Canvas. 

 Changing the Enable Word Wrap setting affects only text that is typed after the change; it does not 
affect previously typed text.  This allows one 2D Text Window to be set up while the Enable Word 
Wrap setting is enabled, and another to be set up while it is disabled. 

 The Enable Word Wrap setting is not affected by and has no bearing on the Word Wrap setting 
applied to a 2D Text Template.  They are independent of each other.  Refer to Templates - 2D Text 
for additional information. 
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When Word Wrap is disabled, text types beyond the border of the 2D Text Window. 

 

Word Wrap Disabled 

When Word Wrap is enabled, text wraps to the next line when typing reaches the end of the row. 

 

Word Wrap Enabled 

To enable/disable Word Wrap: 
 Pull down the Edit menu, then select/ deselect Enable Word Wrap.  When Enable Word Wrap is 

enabled, a checkmark appears next to the Enable Word Wrap menu item.  When Word Wrap is 
disabled, there is no checkmark. 

Insert/Overwrite Mode for 2D Text 
Insert Key 
The Insert/Overwrite setting determines whether newly typed characters are inserted into an existing line of 
2D text, or if the existing characters are replaced by newly-typed characters. 

To enable/disable Insert/Overwrite: 

 Press the Insert key on the keyboard.  Each keypress inserts a new character at the cursor position, 
moving the following characters one character to the right. 

Current mode is indicated on the far right end of the Status Bar, as shown in the figure below.  

 

Insert/Overwrite Mode Status Bar Indicator - OVR Active 

 When Insert is selected, newly-typed characters are inserted into 2D text, changing the position of 
the existing text.  The Status Bar shows that OVR is grayed out. 

 When Overwrite is selected, each newly-typed character overwrites the existing character at the 
same cursor position.  The Status Bar shows that OVR is active (see figure above). 
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Row Shift Locked/Unlocked 
Edit Menu > Row Shift Locked;  Ctrl + L 
When a row of text is shifted using the keyboard (Alt +  or Shift + Alt + ), only the row selected shifts.  
This is known as Unlocked Mode.  The rows beneath the shifted row are not affected. 

Locked Mode allows the shifted row to shift the rows below, so that the rows shift as a block.  To activate 
Locked mode: 

 Select Row Shift Lock from the Edit Menu, or press Ctrl + L.  All Row Shift operations now shift the 
selected row, as well as the rows beneath it.  Note that the Edit menu now displays a checkmark next 
to Row Shift Locked, and the Status Bar now shows that Lyric is in Locked Mode. 

 

Status Bar Showing Row Shift Locked 

To return to Unlocked Mode: 
 Select Row Shift Lock from the Edit Menu, or press Ctrl + L.  All Row Shift operations now shift the 

selected row, as well as the rows beneath it.  Note that the Edit menu no longer displays a 
checkmark next to Row Shift Locked, and the Status Bar now shows that Lyric is in Unlocked 
Mode (LOCK is grayed out). 

 

Status Bar Showing Row Shift Unlocked 

Normal/Modified Space 
Normal Space:  2D Text/Template Context (Right-Click) Menu > Normal Space 
Modified Space:  2D Text/Template Context (Right-Click) Menu > Modified Space 
A 2D Text window has two possible display modes:  Normal Space or Modified Space.  In Normal Space, 
text inside the 2D Text Window can be added or edited.  In Modified Space, the contents of the 2D Text 
Window are subject to manipulation in scale and rotation, via the XYZ pane of the Properties menu. 

While switching between Normal Space and Modified Space is mainly transparent to the operator, the active 
mode is also displayed in the 2D Text/Template context (right-click) menu. 

Normal Space 
When set to Normal Space, the text appears without rotation, scaling, and applied positioning attributes. You 
may edit 2D text while in Normal Mode. 

Modified Space 
When set to Modified Space, the text in the 2D Text window can be rotated on the X, Y, and Z axes, plus the 
window itself may be scaled using the settings on the XYZ tab of the Properties window. You may only edit 
text in Modified Space if the text is not rotated; Lyric cannot edit rotated text! 
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Title Bar Color and Normal/Modified Mode 
The selected 2D Text window's Title Bar appears in one of three colors, depending on the active 
Normal/Modified Mode, and whether or not any transformation (rotation, scaling, etc.) has been applied. 

 

Normal/Modified Space Title Bar Colors 

Title Bar 
Color 

Description 

Gray Modified Space, with no rotation.  Text can be edited. 

Red Modified Space, with rotation.  To edit text, reset the 2D Text 
window to Normal Space using one of the following methods: 

 Right-click inside the 2D Text window, then select Normal 
Space. 

 Start typing in the 2D Text window.  The 2D Text window 
automatically converts back to Normal Space. 

Important! To return the display to Modified Space (and to preserve 
the former Rotation/Scale settings), right-click within the 2D Text 
window, then select Modified Space. 

Yellow  Normal Space, with no rotation.  Text can be edited. 
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Use Scene Camera 
2D Text/Template Context (Right-Click) Menu > Use Scene Camera 

Lyric's Scene Camera can be applied to a 2D Text Window (including 2D Roll, 2D Crawl and 2D Type On 
Windows) in order to provide a perspective view.  Use Scene Camera can be enabled or disabled for 
individual 2D Text Windows.  The Camera setting in Camera Properties has no bearing on the settings of 
individual 2D Text Windows although it can affect the juxtaposition of 2D Text Windows in relation to the 
entire composition. 

To enable or disable Use Scene Camera: 
 Right-click on the 2D Text Window or 2D Text Template, then select Use Scene Camera from the 

context menu. 

An unrotated 2D Text Window appears as follows: 

 

Unrotated 2D Text 

When 2D text is rotated and Use Scene Camera is disabled: 

 The Scene Camera is in Orthographic Mode, and a rotated 2D Text Window does not show 
perspective.  The 2D characters that are "further away" from the viewer appear to be the same size 
as the 2D characters that are "closer" to the viewer. 

 When 2D text is rotated, scaled, etc., the text changes orientation within the 2D Text Window, but 
the 2D Text Window itself does not change orientation. 
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 The Title Bar of the 2D Text Window turns red, indicating that the window is in Modified Space 
mode.  When the user types into the 2D Text Window, it returns to Normal Space.  The Title Bar 
turns yellow until Modified Space is selected from the 2D Text/Template context menu. 

  

Rotated 2D Text - Use Scene Camera Disabled 

When 2D text is rotated and Use Scene Camera is enabled: 
 The Scene Camera is switched to Perspective Mode, and a rotated 2D Text Window shows 

perspective.  The 2D characters that are "further away" from the viewer appear to be more in the 
distance compared to the 2D characters that are "closer" to the viewer. 

 The Title Bar of the 2D Text Window turns red, indicating that the window is in Modified Space 
mode.  The user can type into the 2D Text Window without it switching to Normal Space mode. 

 

 

Rotated 2D Text - Use Scene Camera Enabled 
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Updating 2D Text - 2D Text Templates and Pop-On Messages 
Lyric provides a number of methods for quickly updating text. 

 2D text can be placed in user-formatted 2D Text Templates, which can be updated via Lyric's DB 
Link, Intelligent Interface® or Template Update functions.  Refer to the section on DB Link, the 
chapter in Intelligent Interface and the section on Template Update for in-depth information on 
these functions. 

 A 2D Text Only message, also known as a Pop-On message, can be recorded, and then read back 
into a 2D Text Window to replace existing text.  Refer to the section on Pop-On Messages for 
additional information. 

Selecting and Editing 2D Text 
Lyric provides a wide variety of text manipulation and editing tools, enhanced by the ability to perform many of 
these functions using keyboard shortcuts. 

Selecting Text 
There are two ways to select text: 

 Move the cursor to just outside the upper-left corner of the 2D Text to be selected. Click/hold the left 
mouse button, dragging the cursor down and to the right.  A dotted box appears around the text; keep 
dragging until the 2D character(s) are entirely inside this box.  Release the mouse button. A 
Bounding Box appears surrounding the item. 

OR 

 Place the cursor at the left or right end of the text that is to be selected.  Hold the Shift key while 
using the  or  keys to extend the Bounding Box around the text. 

 

Selecting 2D Text 

The Bounding Box is the area around the highlighted 2D Text.  When text is selected (in a Bounding Box), 
you can quickly apply changes in font style, attributes, etc. via the Font and 2D Font FX tabs on the 
Properties menu. You can also make fast changes to selected 2D Text by using the tool bar. 

To select all 2D Text in a window: 
 Select the Select All item in the Edit menu, or press Ctrl + A. 

Resizing Selected Text 
The corner handles of a Bounding Box resize the selected text proportionately; the top, bottom, and side 
handles resize along their respective axes only. To adjust the size of any selected object(s). Left-click/drag a 
handle in the desired direction.  Release the mouse button when you’re done 

 When a character or word is selected for resizing and the top handle is dragged, the characters 
enlarge above the baseline of the row, leaving the baseline of the row unchanged. If the bottom 
handle is dragged, the text grows and moves the baseline of the row down to accommodate the text's 
new size, moving the rest of the text on the row with it. 

 When Template (Row-Based) text is selected, no handles appear. Use the Toolbar and the Font and 
2D Font FX tabs on the Properties menu to change the attributes of the selected text.  
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Resizing Text via Keyboard Shortcuts 
Keyboard shortcuts are available as an alternative to using the mouse.  Refer to Keyboard/Mouse Shortcuts 
- 2D/3D Text, Text Templates and Row Tabs for a comprehensive list of 2D text-related keyboard shortcuts. 

Function  Description 

Change 
Width  

The  key is the equivalent of dragging the right Bounding Box handle 
towards the right (increases width); The  key drags the right Bounding 
Box handle to the left, decreasing width. 

Change 
Height  

The   key is the equivalent of dragging the top Bounding Box handle 
upwards, increasing the height of the selected text.  key is the 
equivalent of dragging the top Bounding Box handle downwards, 
decreasing the height of the selected text. 

Increase 
Size  

Pressing B increases the size of the selected text or template by dragging 
the upper-right Bounding Box handle (size increases proportionately). 

Pressing Shift + B increases the size by increments of 5 units instead of 
increments of 1 (default). 

Decrease 
Size  

Pressing S decreases the size of the selected text or template 
(proportionately) by dragging the upper-right Bounding Box handle down 
and to the left. 

Pressing Shift + S makes the change by increments of 5 instead of 
increments of 1 (default). 

Change 
Resize 
Incremen
t 

To change the increment by which text is resized: 

1. Press Ctrl + Alt + I.  The following is displayed: 

 

Enter Scaling Increment Dialog Box 

2. Enter a new value or use the spin box to set a new value for the 
increment, and click OK. 

For example, if the Scaling Increment is changed to 10, the increments 
by which text will be resized will be 10, instead of the default value of 1.  
Additionally, pressing Shift + S or Shift + B would resize the text in 
increments of 10 + 5 = 15. 

End  Removes the Bounding Box from the selected text, and leaves the 
cursor in place. 
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Using Tab Spaces within 2D Text 
To insert a Tab space between 2D Text characters, press Ctrl + Tab.  The width of the Tab space, in pixels, 
may be set through Lyric's CG Preferences: 

1. From the Config menu, select Preferences, and then the CG Preferences tab. 

2. Enter a value in the Tab Width field. 

Refer to the chapter on Preferences for in-depth information on CG Preferences settings. 

Repositioning Selected Text 
To reposition selected text, place the cursor inside the Bounding Box, and then click/hold the left mouse 
button.  While holding the left mouse button, move the text to a new location.  Release the mouse button 
when the text is in the correct position. 

The text "snaps" to the baseline of the row nearest the point where the mouse is released.  Hold down the 
Control (Ctrl) key while moving selected text to allow it to be positioned between row baselines. 

Shift Character 
Click on a character, then press Ctrl plus the  keys as desired to shift the selected character 
horizontally one pixel at a time, or vertically one scanline at a time. If shifting characters horizontally, the 
characters to the right of the selected character are also shifted. 

Shift Row 
Click on a character within the desired row, then use Alt plus the  keys as desired to shift the 
selected row horizontally one pixel at a time, or vertically (along with all lower rows) one scanline at a time.  
Note that to move just one row, select it using a Bounding Box, and then drag the Bounding Box to the 
desired location. 

Super Shift 
Hold the Shift key while performing a character or row shift to move the item(s) 10 pixels/scanlines at a time 
instead of by single pixels/scanlines. 

2D Text Editing Tips 
 Remember that typing the first character in a 2D text window establishes the first row and its 

baseline. 

 When pressing the Enter key on the keyboard from an existing row the text cursor will move to the 
beginning of the next row. If no next row exists one will be created and the Properties and Tabs from 
the current row will be copied to the new row created. 

 Holding the Shift key while pressing Enter will cause a row split; all characters to the right of  
the cursor will be moved to the beginning of the next row (but only if the next row has been previously 
established). 

 Row Swap is available for rows of pre-existing 2D text. Right-click anywhere in the text area and 
select Swap Row Up or Swap Row Down in the contextual menu. Equivalent keyboard commands 
are Ctrl + B to swap up and Ctrl + F to swap down. 

 Rows may be shifted via the keyboard (Alt + Up/Down and Shift + Alt + Up/Down - see 2D Text 
Keyboard/Mouse Shortcuts) in Locked mode or Unlocked Mode. When a row is being shifted, all 
the rows beneath it may be Locked to shift at the same time. In the Unlocked mode, only the 
selected row is shifted. Ctrl + L toggles Locked/Unlocked mode. This setting can also be made from 
the Edit menu. The word LOCK will appear on the status line when the Lock feature is activated. 

 When text is selected on a row it may be moved by dragging. Lyric will try to snap the text to the 
baseline of the row nearest destination defined by release of the cross-hair "move" cursor. If no 
baseline snap is desired hold down the Ctrl key before releasing the mouse button and the text will 
be positioned where the mouse button is released; the text will still be attached to the same row. 

 As in a conventional word processor, rows can be selected by holding down the Shift key and 
pressing the Down/Up arrow keys. Text can be selected from the Cursor position to the End or 
Beginning of the row by pressing Shift followed by the End or Home key. Press the End key to clear 
the selection rectangle. 
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 The Shift/Delete combination will cut rows that have been selected in a bounding box. The rows 
below will move up to occupy the position of the deleted row(s). Rows can be then pasted by pressing 
Ctrl + V. Pasted rows will be inserted before the current row. 

 Importing text via Paste from Word or similar documents will preserve tabs from the original text, 
aligning them with Lyric's Row Tabs. 

 The text cursor will try to position itself at the baseline of the nearest row when the mouse is clicked 
at a blank area on the screen. If no rows are found the cursor will remain at the mouse position and 
text can be typed there. The criterion is the height of the font currently selected. 

 Row Priorities can be changed by selecting text on two free form rows . Then enter Alt + P or select 
Swap Row Priorities from the Edit menu. The Priorities of the two rows will be swapped. If text is 
selected on more than two rows the first two rows in the selection will be used. 

 The text cursor can be moved from Row Tab to Row Tab by pressing ALT + > to move to the next 
Row Tab and ALT + < to move to the previous Row Tab. To use the mouse, click on the Row Tab 
Marker. The selected Row Tab will turn RED when selected. 

 When more than one row with Row Tabs is present on the Canvas, Tab Column Mode may be 
activated by pressing Alt + M on the keyboard. 

 Note that in Tab Column Mode, deleting a Row Tab will also delete all row tabs below. 

Additional Editing Functions 
Refer to Keyboard/Mouse Shortcuts - 2D/3D Text, Text Templates and Row Tabs for information on 
additional 2D text editing functions. 

Squeeze/Expand 
2D Text Window Right-Click Menu > Squeeze/Expand 
Squeeze Word:  Ctrl + 4 on Numeric Keypad 
Expand Word:  Ctrl + 6 on Numeric Keypad 
Squeeze Row:  Ctrl + 8 on Numeric Keypad 
Expand Row:  Ctrl + 2 on Numeric Keypad 
Squeeze/Expand provides a quick method of adjusting space between 2D characters or rows in a 2D Text 
window or 2D Text Template.  The scale of the characters does not change when Squeeze/Expand is 
performed. 

NOTE 
A Squeeze/Expand operation can be executed using the numeric keypad number keys 2, 
4, 6 and 8, as described below.  In order for this to work properly, Num Lock must be 
active, or the text will just be moved in the direction of the arrow printed on the number 
key, instead of being squeezed or expanded.  To activate/deactivate Num Lock: 

 Press the Num Lock key located at the top left of the numeric keypad.  When 
active, the Num Lock light on the keyboard is lit. 

Num Lock should be active for most Lyric operations, and must be active for numeric 
message Reads. 

To squeeze/expand the space between characters: 

1. Make sure that Num Lock is active. 

2. In a 2D Text window, highlight the text that is to be squeezed/expanded.  The text can be on multiple 
rows.  If no text is selected, the word on which the cursor is positioned is squeezed or expanded.  In 
this instance, the cursor must be positioned in the word, not before the first character. 

For a Template, place the cursor in the Template on the appropriate row.  Note that in a Template, 
spaces between characters can be squeezed/expanded only one row at a time.  Additionally, all 
characters on the selected row of the Template are squeezed/expanded. 

The leftmost character stays in position as the text squeezes/expands from the right/to the right. 
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3. Use one of the two following methods to squeeze/expand the space between the characters in the 
highlighted text or  Template. 

a. Right-click the 2D Text window, then select Squeeze/Expand.  The 
Squeeze/Expand dialog box is displayed. 

   

Squeeze/Expand Dialog Box 

Click the Word left or right arrow to squeeze/expand the text. 

b. Press Ctrl + 4 on the numeric keypad to squeeze the text; or Ctrl + 6 on the numeric 
keypad to expand the text. 

 To squeeze/expand the space between rows: 

1. Make sure that Num Lock is active. 

2. In a 2D Text window, highlight the rows that are to be squeezed/expanded.  If the space between all 
rows is to be expanded, place the cursor anywhere in the 2D Text window. 

For a Template, place the cursor in the Template.  Note that all rows in the Template are 
squeezed/expanded. 

The topmost row stays in position as the rows squeeze/expand up/down. 

3. Use one of the two following methods to squeeze/expand the space between the characters in the 
highlighted text or  Template. 

a. Right-click the Template, then select Squeeze/Expand.  The Squeeze/Expand 
dialog box is displayed. 

   

Squeeze/Expand Dialog Box 

Click the Row up or down arrow to squeeze/expand spaces between the rows. 

b. Press Ctrl + 8 on the numeric keypad to squeeze the rows; or Ctrl + 2 on the 
numeric keypad to expand the rows. 
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Paste Unicode Text 
Edit Menu > Paste Unicode Text;  Ctrl + Alt + V; 
Windows Character Map > Select, then Copy, then Lyric Edit Menu > Paste or Ctrl + V 
Occasionally, a Lyric composition will require non-standard characters or characters not commonly occurring 
in the user's native language.  Lyrics Paste Unicode Text option may be used to copy these characters from 
other applications, such as word processors.  Note that Paste Unicode Text can be applied only to 2D text, 
not 3D characters.  Lyric supports double-byte characters if the Windows® operating system supports double-
byte characters.  Examples include Chinese, Japanese and Korean Windows. 

NOTE 
It is possible that the Unicode character from the source document is not available in the 
font set selected in Lyric.  Although the most widely used font sets contain a standard 
set of Unicode characters, it is recommended that the font used in Lyric either matches 
the font from the source document or that it is confirmed that the Lyric font contains the 
Unicode characters.  This is especially important when a Template is updated with 
Unicode characters.  The Template must also have the correct font assigned in order to 
correctly display the Unicode characters.  The font can be set either from the Font 
Toolbar, or the Properties > Font tab. 

To copy a Unicode character to a Lyric composition: 

1. Open the document containing the Unicode text. 

 

Source Containing Unicode Character to Copy to Lyric 

2. Highlight the Unicode character in the document, then copy the character from the application. 

 

Highlighting the Unicode Character 

3. In the Lyric composition, place the cursor at the point where the Unicode character is to be inserted, 
then select Paste Unicode Text from the Edit menu or press Ctrl + Alt + V.  The character is pasted 
at the cursor location. 

 

Unicode Character Pasted into Lyric Composition 
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You may also copy and paste special characters directly from the Windows Character Map. 
1. Access the Windows Character Map.  It can oftentimes be found in Start > Programs > 

Accessories, but may be located elsewhere on the system. 

 

Copying a Unicode Character from the Windows Character Map 

2. Click on the character, then click Select.  The character appears in the Characters to Copy field. 

3. Click Copy. 

4. In the Lyric composition, place the cursor at the point where the Unicode character is to be inserted, 
then select Paste from the Edit menu or press Ctrl + V.  The character is pasted at the cursor 
location. 
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Find/Replace 
Edit Menu > Find/Replace;  Ctrl + H 

1. Find/Replace is used to locate a text string in a 2D Text window (including Roll, Crawl, etc.), and if 
desired, replace it with another text string.  To set up the Find/Replace operation: 

2. Select Find/Replace from the Edit menu or press Ctrl + H.  The Find/Replace dialog box is 
displayed (see figure below). 

3. Enter the text string for which you will search (the "search string") into the Find what field.  There are 
two parameters which can narrow the search: 

 If activated (checked), Match Whole Word Only searches only for the string as a whole 
word, not as part of another string.  For example, a search for the string "some" will find the 
string "some" but not the string "something".  

 If activated (checked), Match Case searches only for matching strings which also match 
upper/lower case spelling.  For example, a search for the string "Cat" will find the string "Cat" 
but not the string "cat". 

4. If only the Find is to be executed, skip to the next step.  Otherwise, enter the text string that is to 
replace the search string in the Replace with field. 

5. In the 2D Text window on the Lyric Canvas, place the cursor at the point at which the search should 
begin.  Click Find Next to find the next occurrence of the search string.  There are three execution 
options: 

 Find:  Click Find Next to find the next occurrence of the search string.  Repeat as many 
times as necessary to find additional occurrences. 

 Find/Replace:  Click Find Next to find the next occurrence of the search string.  If you want 
to replace the found search string with the text string entered in the Replace with field, click 
Replace.  If you don't want to replace a particular occurrence but would like to continue 
searching, don't press Replace; press Find Next.  Repeat Find/Next/Replace as necessary. 

 Find/Replace All:  Click Replace All to replace all occurrences of the search string with the 
replacement string.  Before executing a Replace All, make absolutely sure that you want to 
have all occurrences replaced. 
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Find/Replace Operation 

Insert Row/Delete Row 
Edit Menu > Insert Row;  Alt + Insert;  2D Text Window Right-Click Menu > Insert Row 
Insert Row creates a new row at the cursor location, or inserts a row into the current Template at the cursor 
location (2D text only). 

Edit Menu > Delete Row;  Alt + Delete;    2D Text Window Right-Click Menu > Delete Row 
Deletes the row at the current cursor location. (2D text only). If in a Template, this function deletes a 
Template row. 

Swap Row Up/Down 
2D Text/Template Context Menu > Swap Row Up/Down 
The row on which the cursor currently is situated is made to change places with the row above (Swap Row 
Up) or below (Swap Row Down) it respectively.   If Swap Row Up is attempted on the top row in a window, 
there is no effect. Likewise, if Swap Row Down is attempted on the bottom row in a window, there is no 
effect. 
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Swap Row Priorities Up/Down 
Swap Row Priorities Up:  Edit Menu > Swap Row Priorities Up;  2D Text Window/Template  Right-
Click Menu > Swap Row Priorities Up;  Alt + P 
Swap Row Priorities Down:  Edit Menu > Swap Row Priorities Down;  2D Text Window/Template 
Right-Click Menu > Swap Row Priorities Down;  Alt + N 

The display priority of 2D text rows on the Z-axis may be adjusted in compositions where rows overlap.  The 
Swap Priority Up/Down operations are similar to Bring Forward and Send to Back operations found in 
graphics programs such as Adobe® Photoshop®. 

 

Swap Row Priority Examples 

Refer to the illustration above.  Both Swap Priority operations are applied to the top set of three rows. 
 The top set of three rows shows normal priority when rows are typed in Lyric.  Each new row displays 

behind the previously-typed row.  Row 1 displays on top of Row 2, which displays on top of Row 3. 

 In the second set of rows, Swap Row Priority Up has been applied to Row 3.  Row 3 now displays in 
front of Row 2, and behind Row 1. 

 In the third set of rows, Swap Row Priority Down has been applied to Row 1.  Row 1 displays 
behind Row 2, and in front of Row 3. 

To apply a priority change: 
1. Click on the left or right handle of one of the two rows that are to be swapped. 

 

Row Handle 

2. If the row is to be moved forward,  i.e. "closer" to the viewer, use one of the following methods to 
execute the swap: 

 Select Swap Priority Up from the Edit menu. 

 Press Alt + P. 

 Right-click on the 2D Text window or its entry in the Scene Graph, then select Swap Up. 

If the row is to be moved back,  i.e. "further away" from the viewer, use one of the following methods 
to execute the swap: 

 Select Swap Priority Down from the Edit menu. 

 Press Alt + N. 

 Right-click on the 2D Text window or its entry in the Scene Graph, then select Swap Down. 
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Color/Font Functions 
Pick Up Color/Font:  2D Text Right-Click Menu > Pick Up Color/Font;  Alt + F12 
Set Current Color/Font:  2D Text Right-Click Menu > Set Current Color/Font;  After pressing Alt + F12, 
type text in new Color/Font 

Font characteristics from 2D text can be easily "picked up" and applied to other 2D text.  Pick Up Color/Font 
and Set Current Color/Font work similarly to the Color/Font key, familiar to iNFiNiT!® operators. 

1. Type a few rows of text, using a variety of colors and fonts.  Note that the last style, color, edge styles 
and other attributes used are reflected in the sample characters displayed in the Font Sample Area 
of both the Font Properties tab and 2D Font FX Properties tabs. 

 

Typing 2D Text 

2. Place the cursor in the text whose attributes you wish to apply to other text. 

3. Right-click on the 2D Text window to display the 2D Text/Template Context menu. 

4. Select Pick Up Color/Font from the 2D Text/Template Context menu. Note that the attributes of the 
text at the cursor position appear in the Font Sample Area. 

 

Picking Up Color/Font 
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5. Next, draw a bounding box around the text to which you wish to apply the properties you just 
transferred to the Properties > Font tab. Be careful not to place the cursor in the new text; click 
outside of the target text to begin drawing the bounding box. 

 

Selecting Text to Be Changed 

6. Right-click inside the bounding box, then, as shown in the figure above, select Set Current 
Color/Font from the 2D Text/Template context menu.  The attributes of the "picked-up" font is 
applied to the text in the bounding box. 

 

"Picked-Up" Color/Font Attributes Applied to Selected Text 

"Picked-up" color/font attributes can be applied to text that is about to be typed by skipping the text selection 
step.  Simply place the cursor at the position at which the new text is to be typed, then select Set Current 
Color/Font from the 2D Text/Template Context menu.  Color/Font characteristics can also be quickly  
"picked up" and applied to text about to be typed as follows: 

1. Place the cursor in the text from which the Color/Font is to be picked up. 

2. Press Alt + F12. 

3. Place the cursor at the position at which the new text is to be typed.  Type new text.  New text reflects 
the attributes of the "picked-up" color/font. 
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Spell Check 
Tools Menu > Spell Check;  F7 

Lyric 2D Text provides a Spell Check feature, which examines all 2D text on the Canvas (including text in 
Roll, Crawl and Type On windows and in Templates), and compares them to words in a standard dictionary, 
as well as those in a User Dictionary.  The User Dictionary, as well as other spelling parameters, can be set 
in Spelling Preferences.  To initiate Spell Check: 

 Select Spell Check from the Tools menu, or press the function key F7. 

When activated, Spell Check opens a window (shown below) and begins checking spelling of the first 2D 
Text window.  Other 2D Text boxes on the Canvas are checked in order.  Any words not appearing in the 
current Dictionary are flagged as shown: 

 

Spell Check - Correcting a Word 

The Spell Check dialog box provides the following functions: 

Button  Description 

Ignore  Ignores the flagged word, continues checking. 

Change  Changes the flagged word to the version appearing in the Word 
List.  Please note that you may type a new word into the top of 
the Word List, then change the flagged word to the new 
spelling. 

Ignore All Ignores all subsequent instances of words with this spelling. 

Change All  Changes all subsequent instances of words to the spelling 
you've selected or entered. 

Add to User 
Dict 

Adds the word to the User Dictionary. 

Exit  Exits from Spell Check. 
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2D Text/Template Context Menu 
Right-clicking on 2D text either inside or outside of a Template displays a Context menu, also known as a 
right-click menu, which makes available a variety of functions related to 2D text operations.  Note that all 
items in the menu are displayed as active.  During Lyric operation, various items may be grayed out 
depending on active function, whether or not the cursor is positioned inside or outside of a Template, and the 
system on which Lyric is installed. 

 

2D Text Context Menu 

 Object Name and Type:  The first item in an object's context menu displays the object's name and 
type.  Refer to Navigating and Entering Information in Lyric:  Object Name and Type for details 
on renaming objects. 
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 Normal Space/Modified Space:  A 2D Text window has two possible display modes – Normal 
Space or Modified Space.  In Normal Space, you may add, or edit the text content inside the 
window.  In Modified Space, the contents of the 2D Text Window are subject to manipulation in 
scale and rotation, via the XYZ pane of the Properties menu. 

 Use Scene Camera:  Lyric's Scene Camera can be applied to a 2D Text Window (including 2D 
Roll, 2D Crawl and 2D Type On Windows) in order to provide a perspective view.  Use Scene 
Camera can be enabled or disabled for individual 2D Text Windows.  The Camera setting in 
Camera Properties has no bearing on the settings of individual 2D Text Windows although it can 
affect the juxtaposition of 2D Text Windows in relation to the entire composition.  Use Scene 
Camera is covered in depth in this chapter. 

 Make Full Screen:  Make Full Screen enlarges the active 2D Text window to the dimensions of the 
Canvas.  The Title Bar is no longer visible when in Full Screen.  To grab a border of a full-screen 2D 
Text window, use the Canvas scroll bars to bring the border into view.  Don't forget to reset the 
Canvas scroll bar when finished. 

o Click Make Full Screen to enable (check) or disable (uncheck). 

 2D Frames On:  2D Frame On turns on/of the display of all 2D Text Window and 2D Text Template 
frame on the Canvas, facilitating preview of the composition.   

o Click 2D Frames On to enable (check) or disable (uncheck). 

Note that this function is also available by clicking the Turn On/Off/Text Window frames icons 

 , available from the Chyron Toolbar. 

 Squeeze/Expand:  Squeeze/Expand provides a quick method of adjusting space between 2D 
characters or rows in a 2D Text window or 2D Text Template.  The scale of the characters does not 
change when Squeeze/Expand is performed. 

 Insert Row/Delete Row:   Insert Row creates a new row at the cursor location, or inserts a row into 
the current Template at the cursor location (2D text only).  Delete Row deletes the row at the current 
cursor location. (2D text only). If in a Template, this function deletes a Template row.  Both are also 
available from the Edit menu. 

 Swap Row Up/Swap Row Down:  The row on which the cursor currently is situated is made to 
change places with the row above (Swap Row Up) or below (Swap Row Down) it respectively.   If 
Swap Row Up is attempted on the top row in a window, there is no effect. Likewise, if Swap Row 
Down is attempted on the bottom row in a window, there is no effect. 

 Swap Row Priorities Up/Down:  The display priority of 2D text rows on the Z-axis may be adjusted 
in compositions where rows overlap.  The Swap Priority Up/Down operations are similar to Bring 
Forward and Send to Back operations found in graphics programs such as Adobe® Photoshop®. 

 Delete Pause:  Delete Pause as accessed from this menu is not implemented at this time.  A Pause, 
however, can be deleted directly from the Timeline, and all Pauses in an animation can be deleted 
as a group from the Scene Graph. 

 Pause Properties:  Pause Properties as accessed from this menu is not implemented at this time.  
Pause properties can be set or modified directly from the Properties > Loops/Pauses tab. 

 Show Effect Progress:  Show Effect Progress is not implemented at this time. 

 Pick Up Color/Font, Set Current Color/Font:  Font characteristics from 2D text can be easily 
"picked up" and applied to other 2D text.  Pick Up Color/Font and Set Current Color/Font work 
similarly to the Color/Font key, familiar to iNFiNiT!® operators. 
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 Mask Character:  An RGB font character typed in a 2D Text Window can act as a Mask Character 
on a Duet SD/HD/Offline system, masking any elements, including the background, that are rendered 
below it.  Note that a 2D bitmap that is placed in a 2D Text Window using a method other than typing 
cannot act as a Mask Character.  Mask Characters are not supported on Duet LE/LEX/PCI/PCI+.  
Mask Characters are covered in depth in the chapter on Masks:  Mask Characters. 

 Template Properties:  Template Properties accesses the 2D Text Template dialog box, in which 
2D Text Template properties are set.  2D Text Templates are covered in depth in the chapter on 2D 
Text Templates. 

 Row/Tab Properties:  The properties of rows and Row Tabs, also known as Tab Stops or just 
Tabs, can be specified.  This function is also available from the Edit menu. 

 Animate Elements:  Individual 2D text characters can be converted into independently animatable 
objects that can be repositioned, rotated, scaled, etc.  Animating 2D characters is covered in depth in 
the chapter on 2D Text Animation:  Animating 2D Characters. 

 Advanced Text Effects:  Advanced Text Effects provides a fast and convenient way to apply pre-
scripted, keyframe-based animations to rows and/or 2D Text Templates in a 2D Text Window.  
Advanced Text Effects is an extension of the Animated Elements feature, which enables the 
conversion of 2D text into individually animatable objects.  Effects include Horizontal/Vertical Blur, 
Drop Down, Push Up, Slide Left/Right, and Kern Left/Right.  Custom effects can also be designed 
using the Advanced Text Effects Custom parameter settings.  Advanced Text Effects can be 
saved and recalled for playback.  Advanced Text Effects are covered in depth in the chapter on 2D 
Text Animation:  Animating 2D Characters. 

 Modify Spline:  The Spline Window tool enables text to be typed and animated on a curved 
baseline.  Once a Spline curve has been set up, it can then be modified.  Spline Window setup, 
execution and modification are covered in depth in the chapter on 2D Text Animation:  Spline 
Window. 

 Advanced Image Effects:    Lyric's Advanced Image Effects capability allows sophisticated effects 
to be applied to imported bitmaps or entire 2D Text windows.  Advanced Image Effects include 
Curtain, Explosion, Focus, Leaf, Matrix, PageRoll, PageTurn, Ripple, Slide, Venetian, Zoom and 
Wipe and more.  Note that on Duet SD systems, Advanced Image Effects, which apply an effect to 
an entire page, are available via Multi FX.  Refer to the chapter on Advanced Image Effects for 
additional information. 

 Position Lock On:  The Position Lock On setting specifies whether or not an object (2D Text 
Window, 2D or 3D object, etc.) can be moved on its X, Y or Z axes, as well as rotated, scaled or 
have its center of rotation changed.  Refer to the chapter on Position, Rotation, Scale and 
Orientation for additional information. 

 Copy/Paste Animation State:    Copy/Paste Animation State enables animation attributes such as 
Position, Rotation, Scaling, etc., to be copied from one object and pasted to another.  Refer to the 
chapter on Animation for additional information. 

 Mask-To Layer, Mask Inside - Duet LE/LEX/PCI/PCI+ Only:  Mask-To Layer and Mask Inside are 
advanced Mask functions available to Duet LE/LEX/PCI/PCI+ systems.  Refer to the chapter on 
Masks:  Mask Objects - Duet LE/LEX/PCI/PCI+ for additional information. 

 Harvester Properties:  The Harvester Lite plugin enables a Lyric 2D Text Template to be linked to 
a text field at a remote URL for dynamic update via the Internet.  Harvester Lite is covered in depth 
in the chapter on Plugins. 

 Internal Properties:  Properties of an object or a message can be tailored to a specific composition 
or playback situation.  The Internal Properties accessed from this menu are applied to the selected 
object.  They include Depth Test, Depth Write and Lighting. 
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Row Tab Functions 
Insert Tab:  Edit Menu > Insert Tab;  Ctrl + T 
Tab Column Mode:  Edit Menu > Tab Column Mode;  Alt + M 
Select Next Tab:  Edit Menu > Select Next Tab;  Alt + J, Alt > or Alt < 
Row/Tab Properties:  Edit Menu > Row/Tab Properties;  2D Text Window Right-Click Menu > Row/Tab 
Properties 

Setting up a Row Tab 
Row Tabs are used to produce columns in 2D Text windows and Roll, Crawl and Type On (Slow Reveal) 
windows, and are similar to ordinary tabs in a traditional word processor.  The term Row Tabs is used to 
distinguish this function from Template Fields (in the context of Intelligent Interface and External Update) 
and the use of Tab keys in keyboard shortcuts. 

Row Tabs may be used simply for convenience when inputting text, same as when using tab stops in a word 
processor.  Each Row Tab's attributes may be individually set.  To set attributes, a Row Tab must be 
established in a 2D Text window on the Canvas. 

1. For this example, open a full-screen 2D Text window.  If you are not in Full Screen mode, right-click 
on the text window's Title Bar or within the window itself. In the menu that appears, select Make Full 
Screen.  Note that 2D Text windows can be either full- or not full-screen when using Row Tabs.  

2. Pull down Lyric's Edit menu or right-click on the 2D Text window context menu, then select Insert 
Row to create the Canvas's first row without typing text. 

3. Click anywhere on the baseline of the first row and press Ctrl + T to set a tab stop.  A red Row Tab 
Marker appears (see figure below).  Note that you may click and drag Row Tabs to adjust their 
locations on the row's baseline.  Whenever a Row Tab is selected, it turns red.  When it is not 
selected, it is green.  When its properties are being set, it turns purple (see next step). 

 

Row Tab Added to Canvas 
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4. Right-click on the marker to display the context menu, then select Row Tab Properties.  The Row 
Tabs Properties dialog box is displayed.  The Row Tab marker now turns purple. 

 

Row Tabs Properties Dialog Box 

5. Select the Justification Properties: 

None:  Text appears where typed. 

Center:  Text centered on Row Tab marker. 

Left:  Left end of text stays at Row Tab marker. 

Right:  Right end of text stays at Row Tab marker. 

Numeric:  Right end of number stays at Row Tab marker.  Use with whole (non-decimal) numbers.  
Two examples are shown below. 

Decimal:  Decimal point stays at marker. 

 

Justification Examples 
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Auto Erase:  When Auto Erase is enabled, text is automatically erased when new text is typed.  You 
must use one of the following methods to access the Row Tab in order for this to work.  Just typing in 
the column does not erase the existing text. 

o Press Alt + J, Alt > or Alt <. 

o Select Select Next Tab from the Edit Menu. 

o Click the Row Tab marker with the mouse before typing 

X Position:  Reflects X Position of the Row Tab relative to the left border of the 2D Text window.  
This value can be changed in this field. 

Tab Column:  Reflects the column number.  The Row Tab columns are automatically numbered in 
order of their creation, starting at 0.  This value cannot be changed. 

6. Click OK. 

Note the following about Row Tabs: 
 Each Row Tab's properties may be set individually, but may affect other Row Tabs if working in Tab 

Column Mode (see "Working with Tab Columns," below). 

 Note that Templates attached to a Row Tab have their own justification for text within the Template 
borders, but their placement on the row is set by Row/Tab Properties. 

In the preceding example, a Row Tab was created without first inputting text.  To create a Row Tab in 
existing text: 

 Position the cursor where the Row Tab is to be inserted, then click the Ctrl + T key combination or 
the pull down the Edit menu and select Insert Tab. 

NOTE 
When a Row Tab is established, text is "attached" to it.  All text attached to a Row Tab 
remains so until the text or Row Tab is deleted, or the text is selected and repositioned 
using the mouse. 

Tab Columns 
Row Tabs can be used to create columns in Lyric, making alignment of text columns easy. 

1. Select Tab Column Mode from the Edit Menu or press Alt + M.  This puts Lyric into Tab Column 
Mode.  The Edit Menu displays a checkmark next to Tab Column Mode. 

2. Open a full-screen 2D Text window.  Next, pull down the Edit menu and select Insert Row to create 
the a row on the Canvas. 

3. Click at a second location on the baseline of the row, then and press Ctrl + T to set a second tab 
stop.  A second Row Tab marker appears. 

 

Adding a Second Row Tab 

4. Press Enter, and a second row is created, containing the same tab stops.  Optional:  Press Enter to 
create additional rows containing the same Row Tabs.  The columns are numbered in the order of 
their creation.  Tab column numbers cannot be changed. 

5. Click at the Row Tab marker for the first column on the first row and begin inputting text.  If you press 
Enter, the cursor will move to the beginning of the same column on the next row.  Remember that 
pressing Enter when the cursor is in the last row on the Canvas adds a new row(s). 
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Note the following about adjusting Row Tabs Properties while in Tab Column Mode: 
 Setting the Row Tab Properties of one Row Tab in any row affects the properties of all Row Tabs in 

the same column. 

 Selecting a Row Tab and repositioning it moves all Row Tabs in the same column in the following 
rows. 

 Selecting a Row Tab and sliding it past another previously repositioned Row Tab(s) in the same 
column and below it "picks up" the repositioned Row Tab and brings it into alignment with the moving 
Row Tab above. 

To exit Tab Column Mode: 
 Select Tab Column Mode from the Edit Menu or press Alt + M.  Tab Column Mode is now 

disabled, and the Edit Menu no longer displays a checkmark next to Tab Column Mode. 

Row Tab Navigation, Selection and Deletion 
Select Next Tab 
To move among the tab stops on a single row: 

 Select Select Next Tab from the Edit menu, or press Alt + J, Alt > or Alt <. 

Navigating Among Row Tabs 
To move left-to-right/top-to-bottom or vice-versa among Row Tabs on different rows: 

 Press Alt plus the < or > keys. 

Selecting Row Tabs  
The Row Tab can be selected from the keyboard by entering Alt + T.  Alt + T only selects to the right, but 
wraps around on the row.  Use the  or  to select a Row Tab on another row. 

Moving Row Tabs 
To move all the Row Tabs to the right of a Row Tab: 

 Press the Alt key while clicking and dragging a Row Tab. 

Deleting a Row Tab 
To delete a Row Tab: 

 Select the Row Tab marker, then press the Delete key; or left-click on the Row Tab marker, then 
hold down the left mouse button and press Delete. 



 2D Text 

 12-29 

Row/Tab Properties 
Edit Menu > Row/Tab Properties;  2D Text Window Right-Click Menu > Row/Tab Properties 

The properties of rows and Row Tabs, also known as Tab Stops or just Tabs, can be specified. 

Setting Row Properties 
The justification of a row can be set as follows: 

1. Select the left or right row handle of a row, then select Row/Tab Properties from the Edit menu or 
from the 2D Text window right-click menu.  The  Row Properties dialog box is displayed. 

 

Setting Row Properties 

2. Select the Justification Properties: 

NONE:  Text appears where typed. 

Center:  Text is centered on row. 

Left:  Text is typed from left end of row. 

Right:  Text is typed from right end of row. 

3. Click OK. 

In the above example, the last row shows a cursor at the center, indicating that the row justification is set to 
Center. 

Note that Templates on a row can each have their own justification setting for text within the Template's 
borders, but the Templates' placement on the row is set by Row/Tab Properties. 

Setting Tab Properties 
Refer to Row Tab Functions for information on setting the Row Tab properties.  As noted above, Templates 
on a row can each have their own justification setting for text within the Template's borders, but the 
Templates' placement on the row is set by Row/Tab Properties. 
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Pop-On Messages - Recording 2D Text-Only Messages 
All Text:  Ctrl + Record > Select All Text;  Ctrl + Record T 
Cursor to End of Text:  Ctrl + Record > Cursor to End;  Ctrl + Record E 
Current Row of Text:  Ctrl + Record > Current Row;  Ctrl + Record + R 

Rows of text in a 2D Text Window can be updated by replacing them with text that has been recorded as a 
Pop-On message.  By doing this, only the row(s) that changes must be recorded.  When read back, the Pop-
On message replaces the new text at the current cursor position in the 2D Text Window.  Note that if a Pop-
On message is read into a 2D Text Template, the Pop-On text overwrites the 2D Text Template. 

1. Create a simple three-line message.  Place the cursor in the second line.  Record the message, then 
erase the Canvas. 

 

Creating and Recording a Text Message 
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2. Create a one-line message. 

 

Creating a Pop-On Message 

3. Press Ctrl + Record.  The Record Only dialog box is displayed. 

 

Record Only Dialog Box 
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4. The Record Only dialog box the following recording choices which can be used as Pop-On 
messages: 

 All Text in Window:  Records all text in selected 2D Text Window.  Empty lines on a Pop-
On message are ignored.  For example, if a three-line Pop-On is recorded, and the middle 
line is empty, the Pop-On is read back as a two-line Pop-On, and replaces (or adds) two 
consecutive rows of text. 

 Cursor to End:  Records all text from the beginning of the row on which the cursor is 
positioned, to the end of the text in the window.  As described above, empty lines on a Pop-
On message are ignored. 

 Current Row:  Records only the text on the current row. 

Note that although Template Data Message is in the Text area of the Record Only dialog box, it is 
not a Pop-On format.  For this example, select the All Text in Window radio button, then click 
Record.  All of the text in this window is recorded. 

5. Recall (read) the original message recorded in Step 1. 

6. While the original message is displayed, recall the message that was recorded in Step 3.  The one-
line text from the second message replaces the second row of text from the first message. 

 

Text Message after Reading a Pop-On Message 

Note the following regarding the location of the Pop-On message and multi-line Pop-On messages.  

 The location of the Pop-On text that is read into another message is determined by the current cursor 
location on the Canvas.  Cursor location within the row has no bearing on the location of the 
replacement text, as it replaces the entire row.  

 A Pop-On message containing multiple lines adds the lines to a shorter message. 

 A Pop-On message can be read only into a 2D Text Window (including Roll, Crawl and Type-On 
(Slow Reveal)). 

 A Pop-On message is row-based, resulting in the replacement of the entire row, regardless of 
whether or not there are 2D Text Templates in the text message or the Pop-On message. 
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Try this example of a multi-line Pop-On message. 
1. Record a three-line message with the third line empty.  Position the cursor in the fourth line, then 

record the message.  Erase the Canvas. 

 

Text Message with Cursor on Fourth Line 

2. Clear the image and record four lines of text in a new Pop-On message.  Erase the Canvas. 

 

Multi-Line Pop-On Message 
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3. Read the three-line message again, then read the Pop-On message over it.  The Pop-On text is 
placed starting at the line on which the cursor was positioned when the text message was recorded, 
resulting in six lines of text.  In this example, the window is too small to display all of the lines.  Ensure 
that the window is large enough to display all lines when reading back a multi-line Pop-On message. 

 

Multi-Line Text with Multi-Line Pop-On 

A Pop-On message can also be used to replace specific consecutive lines in another message.  For 
example, Lines 2 and 3 can be replaced by a two-line Pop-On message.  Just make sure that the cursor is 
on the first of the lines to be replaced when the message is recorded. 
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13. 2D Text Templates 

2D Text Templates 

Tools Menu > Template;  Lyric Toolbar  

Select Text, then:  Tools Menu > Template; or Chyron Toolbar >  
Refer to the chapter on 3D Characters and Objects for information on 3D Character Templates. 

Refer to the chapter on 2D Objects for information on 2D Object Templates. 

Overview 
2D Text Templates are rectangular regions, created within 2D Text Windows, that can be formatted for 
default font, color, alignment, update and other attributes.  2D Text Templates also provide a means for fast 
text updates on-screen with the use of Intelligent Interface, DBLink and Template Update.  Updated 
information is displayed using the attributes set for the Template. 

In addition to the above update methods, Lyric provides quick 2D text update capability, regardless of whether 
or not the text is in a 2D Text Template.  Refer to Pop-On Messages for details. 

Creating a Template 

Select Text, then:  Tools Menu > Template; or Chyron Toolbar >  
A 2D Text Template can be created empty, or can enclose existing text. 

To create an empty 2D Text Template: 
1. Place the cursor at the position in a 2D Text Window where a 2D Text Template should be placed. 

2. Click the Template icon  on the Chyron Toolbar, or select Template from the Tools menu.  A 
2D Text Template appears in the 2D Text Window: 

 

2D Text Template 

Text can then be typed in the Template using the currently selected font.  The Template can be 
expanded to a multi-line Template by pressing the Enter key. 

To create a 2D Text Window that encloses existing 2D text: 
1. In the 2D Text Window, select the desired 2D text. 

2. Click the Template icon  on the Chyron Toolbar, or select Template from the Tools menu.  
Important:  To ensure proper Template height, be sure to include a space character in the selected 
text.  Multiple lines can be selected to create a multi-line Template.  A 2D Text Template encloses 
the selected 2D text. 

Inter-row spacing is maintained, but any deviation in inter-character spacing is not.  The Default 
Template Font (see Template Properties following this section) is taken from the leftmost character 
in the selection rectangle (usually the first character on the line). 
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Once the cursor is inside a 2D Text Template, all subsequently typed text is typed until the cursor is moved 
outside of the Template.  To move the cursor out of a 2D Text Template: 

 Click outside of the Template or press the Esc key.  When the Esc key is pressed, the cursor is 
moved to a position directly outside of the Template. 

To navigate among 2D Text Templates: 
 Press Tab to move forward in numerical order, or press Shift + Tab to move in reverse numerical 

order. 
Template numbering is covered later in this section. 

Editing Templates 
About Keyboard/Mouse Shortcuts 
Lyric provides numerous text and Template editing functions.  Refer to the chapter on Keyboard/Mouse 
Shortcuts:  2D/3D Text/Text Templates/Row Tabs for in-depth information. 

Delete Templates/Leave Text 
Edit Menu > Delete Template/Leave Text 

The Templates in a 2D Text Window (including Roll, Crawl and Type On) can be deleted, leaving the text 
intact: 

 Select Delete Templates/Leave Text from the Edit menu.  All Templates are deleted from the 
currently active 2D Text Window. 

Setting Template Properties 
Once a 2D Text Template is created, the attributes of the Template can be set.  Each Template in a Lyric 
composition can have a distinct set of attributes that are different from other Templates in the same 
composition, as well as from other, non-Template text.  To access the 2D Text Template dialog box: 

 Right-click inside the Template, then select Template Properties from the context menu.  The 2D 
Text Properties dialog box is displayed. 

 

2D Text Template Dialog Box - Left Side 

 

2D Text Template Dialog Box - Right Side 

The 2D Text Template dialog box displays the attributes of the current 2D Text Template.  To display the 
attributes of other 2D Text Templates in the composition, scroll through the 2D Text Templates by clicking 
the Prev/Next icons.  The following Template attributes can be set: 
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Name 
Name enables a 2D Text Template to be named for easy recognition. 

 Enter a name in the Name field. 

DB Link 
DB Link allows a 2D Text Template or 2D Object Template to be automatically populated and updated from 
a database.  To enable/disable DB Link: 

 Click the DB Link checkbox to select/deselect.  When the DB Link checkbox is selected (checked), 
the DB Link dialog box opens.  Refer to DB Link for setup procedure. 

DB Link parameters can be set or modified whether or not DB Link is enabled.  To do so: 
 Click the DB Link button.  The DB Link dialog box opens.  Refer to DB Link for setup procedure. 

NOTE 
Be careful about enabling DB Link fields in Template Data messages in which Intelligent 
Interface Updates are to be executed.  See II Update later in this section for additional 
information. 

Update DB Link Fields 
Edit Menu > Update DB Link Fields 

To update all DBLink fields with the latest data from the data source without having to save and re-read the 
message: 

 Select Update DBLink Fields from the Edit menu. 

Disable DB Link Fields 
Edit Menu > Disable DB Link Fields 

When DBLink Update capability has been set up in a Lyric message, selecting Disable DBLink Fields turns 
off the DBLink attribute for all Templates in the message, although the database links remain as set.  
Templates do not update from a database when the message is read or Update DBLink Fields is selected.  
To execute: 

1. Select Disable DBLinks from the Edit menu.  The following prompt is displayed. 

 

Disable DB Link Popup 

2. Select Yes to Disable DB Link for the message, or No to cancel. 

To re-enable DB Link: 
1. Select a Template in the message, then right-click on the Template.  The 2D Text Template dialog 

box is displayed.  Note that the DB Link Checkbox is not enabled (checked) for the selected 
Template. 

2. Click the DB Link checkbox to re-enable DB Link capability.  Use the Prev/Next buttons to cycle 
through the other Templates in the message, and for each, click the DB Link checkbox to reactivate 
DB Link capability. 



Lyric User Guide 

 13-4 

Number 
Templates are numbered in the order in which they are created, regardless of the 2D Text Window in which 
they are placed.  Numbering starts at 0.  Note that a Template Number must be unique within a Lyric 
composition, as accurate update of Template text requires that the correct Template be addressed. 

 When the Tab key is pressed, the focus moves from Template to Template in ascending Number 
order. 

 When Shift + Tab is pressed, the focus moves from Template to Template in descending Number 
order. 

The Template Number can be changed to make a more convenient or logical order: 
 Enter a number or click the arrows to set the Number.  Remember not to set more than one 

Template to the same Number, as updates may not be performed properly. 

To skip a Template when tabbing through Templates: 
 Set the Number to –1.  Note that when set to -1, the Template cannot be updated via DB Link or 

Intelligent Interface.  It can still be updated using the Template Update function. 

Renumbering Templates 
Edit Menu > Renumber Templates 

If Templates are created in a haphazard order, it may be advantageous to renumber the Templates so that 
content management and navigation among Templates is easier.  To renumber all Templates in a 2D Text 
Window in ascending order, starting from 0: 

 Select Renumber Templates. 

Starting with the bottom-most 2D Text Window as listed on the Scene Graph, Templates are renumbered 
from left-to-right; top-to bottom.  Numbering continues with Templates in next highest 2D Text Windows in 
the same manner. 

Priority 
Priority sets the layering of 2D Text Templates.  Priority 1 is front-most in Z-space.  Higher-numbered 
Templates are displayed behind lower-numbered Templates.  To set Priority for the Template: 

 Enter a number or click the arrows. 

Text Lines 
Text Lines determines the number of Text Lines in the 2D Text Template.  A new line can also be added to 
the 2D Text Template by placing the cursor at the end of a line, then pressing Enter.  To set Text Lines: 

 Enter a number or click the arrows. 

Default Content  
Default Content sets a 2D Text Template to display fixed text.  When the message is read, the Default 
Content is displayed in the 2D Text Template.  Setting Default Content in a Template is a two-part 
procedure. 

1. Define the Default Content. 

2. Assign a Default Content item to a row in the 2D Text Template. 

To define Default Content: 
 Enter the content into the Default Content field, then click Add.  The content is added to the Default 

Content list, located directly below the Default Content field. 

This process can be repeated to add multiple Default Content items to the Default Content list.  The order in 
which they are entered has no bearing on assignment to a 2D Text Template row. 
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To assign Default Content to a 2D Text Template row: 
1. Place the cursor on the desired row in the 2D Text Template. 

2. Double-click on the desired item in the Default Content list.  The Default Content item now appears 
in the 2D Text Template, positioned from the start of the row. 

This process can be repeated to add text to other rows of the 2D Text Template or to modify existing Default 
Content. 

Note the following: 
 Existing text in the row is overwritten by Default Content. 

 Default Content is overwritten if the Template is updated via DB Link, Intelligent Interface or 
Template Update. 

 If Size to Fit is disabled (unchecked), display of Default Content that extends beyond the bounds of 
the 2D Text Template is truncated after the last character that is at the edge of the 2D Text 
Template.  If Size to Fit is enabled (checked), Default Content that extends beyond the bounds of 
the 2D Text Template is squeezed to fit within the 2D Text Template.  As this my produce 
undesirable results, it is recommended that 2D Text Template be extended to accommodate the 
Default Content.  Refer to Keyboard/Mouse Shortcuts - 2D/3D Text/Text Templates/Row Tabs 
for details on resizing a 2D Text Template. 

To delete Default Content choices from the list of Default Content text: 
 Click on the text in the Default Content list, then click the Del button.  The text is removed from the 

list. 

To remove Default Content from a Template: 
 Delete the text directly from the Template. 

Auto Erase 
When enabled, Auto Erase sets the 2D Text Template to automatically erase its contents when new text is 
typed in the Template.  To enable/disable Auto Erase: 

 Select (check)/deselect (uncheck) the Auto Erase checkbox. 

Note that when a Template is updated via DB Link, Intelligent Interface or Template Update, the contents 
of the Template are always completely replaced by the new contents, regardless of the Auto Erase setting. 

Word Wrap 
When text is typed or entered via update past the end of a row in a 2D Text Template, it can be set either to 
continue past the border of the 2D Text Template, or to wrap to the next line so that all text displays within 
the borders of the 2D Text Template. 

Note that the Word Wrap setting is not affected by and has no bearing on the Enable Word Wrap setting 
applied to a 2D Text Window.  They are independent of each other.  Refer to 2D Text Overview for 
additional information. 

 When Word Wrap is disabled, text types beyond the border of the 2D Text Template. 

 When Word Wrap is enabled, text wraps to the next line when typing reaches the end of the row. 

To enable/disable Word Wrap: 
 Select (check)/deselect (uncheck) the Word Wrap checkbox. 
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Numeric 
The Numeric setting determines how numbers are justified in a Template. 

 When Numeric is not enabled, numbers are not monospaced, so they do not properly align if the 
numbers are of different widths. 

 Numeric is best used when Right Justification is selected, although it can also be used when 
Center or Page Center Justification is selected.  If Numeric is enabled, only numbers typed on the 
alphanumeric keyboard, the dollar sign ($), the comma (,), and the period (.) characters can be typed 
in the Template.  Numbers are monospaced instead of kerned so that multi-row numbers vertically 
align.  Note that while only certain characters can be typed when Numeric is enabled, a Template in 
which Numeric is enabled can be updated with any type of text. 

o When Right Justification is set, the numbers justify to the right.  To ensure vertical 
alignment of the numbers, make sure that each number in the Template contains the same 
number of digits following the decimal point. 

o When Center or Center Page Justification is set, the numbers justify horizontally to the 
center.  In addition, with Center Page Justification, the rows vertically to the center.  To 
ensure vertical alignment, use this setting only if all of the numbers in the Template contain 
the same number of digits preceding and following the decimal point. 

To enable/disable Numeric: 
 Select (check)/deselect (uncheck) the Numeric checkbox. 

Size to Fit 
The Size to Fit setting determines whether or not text that is too long to fit on one row of the Template is 
squeezed to fit on the row. 

 If Size to Fit is disabled, text that is too long to fit on a row types beyond the border of the Template, 
or, if Word Wrap is enabled, wraps to the next line. 

 If Size to Fit is enabled, text that is too long to fit on a row is squeezed to fit on the row of the 
Template.  This can sometimes result in an unsatisfactory appearance.  If so, extend the length of 
the Template. 

To enable/disable Size to Fit: 
 Select (check)/deselect (uncheck) the Size to Fit checkbox. 

II Update 
The II Update setting does not affect Intelligent Interface update of 2D Text Templates.  It can, therefore, 
be selected (checked) or deselected (unchecked).  It does, however, enable/disable Intelligent Interface 
update of 2D Object Templates.  Refer to the chapter on 2D Objects for additional information. 

NOTES 
When receiving W commands to update Templates, be careful about mixing Template 
fields enabled for DB Link with Template fields marked for Intelligent Interface Update.  If 
DB Link is enabled for a particular Template(s) when the Template Data message is read, 
the Template(s) will update as per the Intelligent Interface command, but then 
immediately update again using data from the linked database.  This occurs even if the 
Template is marked for Intelligent Interface Update, i.e., the DB Link data overrides the 
Intelligent Interface data. 

This is also the case for the U command that updates the data in a single Template in a 
Template Data Message.  The DB Link Enable setting, however, does not affect the 
execution of the U\* command which updates a specified Template without reloading the 
Template Data Message. 

Refer to Intelligent Interface for in-depth information on these commands.  
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Ext. Update 
When a Lyric message is containing a Template(s) marked for External Update is read, the system running 
Lyric sends an X command requesting Intelligent Interface Update to the host system.  Additionally, the 
following prompt is displayed: 

 

Waiting for Update Prompt 

The host computer then sends an R command to update the marked Template(s). 

To enable/disable Ext. Update: 
 Select (check)/deselect (uncheck) the Ext. Update checkbox. 

Note that when Ext. Update is enabled, II Update is automatically enabled as well.  

Refer to the section on Intelligent Interface for additional details. 

Disable Interface Fields 
Edit Menu > Disable Interface Fields;  Alt + U 
Disable Interface Fields disables Intelligent Interface® External Update of all 2D Text Templates and 2D 
Object Templates in the entire Lyric composition.  When a Lyric message is containing a Template(s) 
marked for External Update is read, the system running Lyric does not send an X command requesting 
Intelligent Interface Update to the host system.  Disabling Interface Fields does not affect, however, the 
ability of 2D Text Templates to be updated via other Intelligent Interface commands.  It does, however, 
disable the ability of 2D Object Templates to be updated via other Intelligent Interface commands. 

To execute: 
1. Select Disable Interface Fields from the Edit menu, or press Alt + U.  The following prompt is 

displayed. 

 

Disable Intelligent Interface Fields Prompt 

2. Click Yes to disable or No to cancel. 

All Caps 
The All Caps enables typing of all characters to be in upper case, regardless of whether or not Caps Lock is 
enabled or the Shift key is pressed.  To enable or disable All Caps: 

 Select (check)/deselect (uncheck) the All Caps checkbox. 
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Justification 
Justification determines how the text aligns in the Template.  To set Justification, select (click) one of the 
following radio buttons: 

 NONE:  The text is does not justify, and is positioned as typed. 

 Center:  The text justifies horizontally to the center.  Vertical position is as typed. 

 Left:  The text justifies horizontally to the left.  Vertical position is as typed. 

 Page Center:  The text justifies horizontally and vertically to the center. 

 Right:  The text justifies horizontally to the right.  Vertical position is as typed. 

To set justification to center vertically, but also to the left or right horizontally: 
1. Type all of the text that is to be placed in the Template. 

2. Set Justification to Page Center.  The text centers both horizontally and vertically. 

3. Now set Justification to Left or Right.  The text centers horizontally to the left or the right, leaving 
the vertical centering intact. 

Font 
A 2D Text Template can have only one Default Font set, although more than one font can be used in a 
particular Template.  Note, however, that any update to the Template results in all of the text in the Template 
changing to the Default Font. 

The Font Sample Area shows a sample of the current Default Font for the Template. 

 

Font Sample 

To change the Default Font for the Template: 
1. Modify the font using Font Tools,  Font Properties and/or 2D Font FX Properties. 

2. After the font is modified, click the Set button in the 2D Text Template dialog box.  All existing text 
and subsequently typed text in the Template has the attributes of the newly set font. 

When a cursor is first placed in a 2D Text Template in a 2D Text Window, Font Tools, Font Properties and 
2D Font FX Properties display the attributes of that 2D Text Template even if the cursor is moved to other 
Templates within the 2D Text Window.  To display the font attributes of another Template within the same 
2D Text Window: 

 Place the cursor within the Template, then click Pickup.  The picked-up font attributes are now 
displayed. 

These attributes can also be applied to another Template within the same 2D Text Window using the Set 
procedure just described. 
Note that if the TrueType® font on which a Lyric font is based is not available a red slash is displayed across 
the Font Sample.  

 

TrueType® Font Unavailable 
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Background 
A solid color, ramped color or graphic Background can be applied to a 2D Text Template.  A sample of the 
currently set Background is displayed in the Background Sample Area. 

To set a Background: 
1. Click the Set Bkg button, then select Solid/Ramp Color or Graphic File from the displayed menu. 

2. Set a color or ramped color or select a file to use as the Background. 

Refer to the chapter on Color, Transparency, Background Lighting and Texture for in-depth information 
on applying a Background to a Template. 

To delete a Background from a Template, use one of the following methods: 
 Click the Clear button. 

 Click the Set Bkg button, and then select Delete from the displayed menu.  
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Alignment Toolbar 
View Menu > Toolbars > Alignment Toolbar 

 

Alignment Tools 

The Alignment Tools are used both for aligning 2D Text Templates and Timeline elements.  For 
information on aligning Timeline elements, refer to Adjusting and Aligning a Timeline. 

The following figures show how the Alignment Tools are used to align 2D Text Templates.  There are five 
alignment tools, as shown in the following figure: 

 

Alignment Tools on the Lyric Interface 



 2D Text Templates  

 13-11 

Use Ctrl + Click to select multiple 2D Text Templates, which places the 2D Text Templates in a Bounding 
Box.  Do not click and drag to enclose the 2D Text Templates in a Bounding Box. 

 

Templates Selected in a Bounding Box 
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The last 2D Text Template selected using Ctrl + Click, becomes the Anchor 2D Text Template.  When an 
Align is performed, the other 2D Text Templates align to the Anchor 2D Text Template. 

 

Right Alignment 

Lyric does not automatically prohibit the Align function from doing something awkward, as shown below, so 
be aware of the potential results of an alignment. 

 

Bottom Alignment 
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Make Same Width resizes the selected 2D Text Templates to match the width of the selected Anchor 2D 
Text Template. 

 

Make Same Width 
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Template Update 
Tools Menu > Template Update;  Alt + T 

All 2D Text Templates and 3D Text Templates in your composition may not be visible on the Canvas 
simultaneously, and tabbing to each 2D Text Template or selecting each 3D Text Template that you wish to 
modify can be time-consuming.  The Template Update feature offers a convenient way to view and update or 
edit text within templates.  The example below shows a set of 2D Text Templates.  There can, however, be a 
mix of 2D Text Templates and 3D Text Templates on a Canvas. 

1. Press Alt + T or pull down the Tools menu and select Template Update. The dialog box pictured 
below right appears: 

 

Canvas and Template Update 

When the dialog box is first opened, up to six template fields are displayed, sorted by template 
number and showing the text content of each template. If there are more than six templates in your 
composition, the dialog box will include a scroll bar for access to the rest of the fields displaying 
template text. 

 Pressing the Page Up, Page Down and Tab keys moves the cursor through the fields 

 Pressing Shift + Tab moves the cursor back to the previous template. 
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2. Delete the current text in the Template field (if necessary), and then enter updated text in any field or 
fields. 

3. Click on one of the following buttons: 

 Apply:  Applies the change and keeps the Template Update dialog box open.  Any changes 
you have made will be reflected in the text template(s) on the Canvas. 

 OK:  Applies the change and closes the Template Update dialog box.  Any changes to 
Template text are reflected in the Text Template(s) on the Canvas. 

 Cancel:  Cancels any changes and closes the Template Update dialog box. 

If a 2D Text Template or 3D Text Template contains more than one line, then the separate lines can be 
updated from the Template Update dialog box. 

1. In the Template Update dialog box, select a 2D Text Template or 3D Text Template as previously 
described. 

2. Delete the current text in the Template field (if necessary), and then enter the text for the first line of 
the Template, and then press Shift + Enter. 

3. Enter the text for the second line of the Template, and then press Shift + Enter.  Note that no special 
character or space indicates where Shift + Enter was typed.  The text will appear to run together in 
the field. 

4. Repeat the text entry - Shift + Enter sequence for each subsequent row. 

5. Press Apply or OK to apply the change. 

The following occurs if an attempt is made to add a new line to a Template: 
 Pressing Shift + Enter does not add an extra line to a 2D Text Template on the Canvas.  If there is 

no new line available in the 2D Text Template, text typed after a Shift + Enter is appended to the 
text already on the 2D Text Template line. 

 Pressing Shift + Enter does add an extra line to a 3D Text Template on the Canvas.  If, however, 
the first row does not begin at the left edge of the Canvas, the rows will be out of alignment.  It is 
recommended that each row of 3D characters be typed in its own 3D Text Template to make row 
alignment easier. 
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Database Link (DB Link) 
2D Text Template:  Create Template > Select, then Right-Click Template > Select Template Properties 
2D Object Template:  Right-Click 2D Object or Scene Graph Listing > Select Show 2D Object 
Properties 
2D Text Templates and 2D Object Templates can draw text and 2D objects (bitmap graphics), respectively, 
from any ODBC-accessible database that is available to the system on which Lyric is running.  Each time a 
message (including a Pop-On message) containing linked Templates is read, Lyric checks the database, so 
that any changes in the linked 2D Text Templates or linked 2D Object Templates update the Canvas.  Text 
and graphic updates can be performed from the same database in real time for up-to-the-minute news, 
election, sports and other live coverage. 

In addition to DB Link, Lyric provides a wide variety of methods to update information displayed in a Lyric 
message.  For an overview, refer to Updating Messages in Lyric.  

Using DB Link to Replace Text 
To try out this feature, you will need access to a database established by an application such as Microsoft 
Access. The database’s fields should correspond to Lyric’s own Browser fields, such as Comment, 
Keyword and Subject. 

1. Compose a Lyric message with a 2D Text Window containing both conventional text and a 2D Text 
Template. 

2. Select (click on) a Template; right-click the Template; then select Template Properties to display 
the 2D Text Template dialog box. 
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3. In the 2D Text Template dialog box, click in the DB Link checkbox, and then click the DB Link 
button.  The DB Link dialog box opens. 

 

Accessing the DB Link Dialog Box 

4. In the Data Source field, enter the name that has been given to the database you will be accessing. 
Note that this dropdown menu can be used to select any registered database. 
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5. Designate the database Table and Field from which you wish DB Link to draw its text (see figure 
below).  You may designate any field of the database’s records with the drop-down menu. 

 

DB Link Database Setup 

6. Designate the number of the Record in the database that you wish to access. Database programs 
can vary in the ways they determine the numbering scheme for their entries, so some 
experimentation may be needed. 

7. Be sure to check the Enable checkbox, and then click OK.  Note that a Disable command is 
available on the Edit menu, as seen below left. 

 

Disable DB Link Fields 

Selecting this command causes the system to request confirmation before completing the action, 
above right. 

8. The DB link information has become part of the Lyric message, so now enter a Message ID 
Number, and then record the message, even though nothing has yet changed on the Canvas. 

OR 

If the message has been previously stored in Lyric’s Browser, right-click on the message’s thumbnail 
and select Update. 
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9. In the database program, change the text of the Comments field in Record #1. Press Shift + Enter 
to save this change to the database. Remember that the database program you use on-air may work 
differently than the one pictured in this exercise.  In a real-world situation, the database fields will be 
updated automatically through an external application, such as a newsroom automation program. 

 

Microsoft® Access® Database 

10. Next, return to Lyric and call up the same message by entering its Message ID Number, then 
pressing Read. 

 

Reading a Message Updated by DBLink 

The text in the Template has changed along with the text in the updated database "Comments" field. 
Also note that an Update command is available on Lyric's Edit menu, as seen below. This facility 
allows the operator to update DB Link-displayed information without having to save and re-read the 
message. 

 

Update DB Link Fields 
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Using the Database Link Feature with a Microsoft® Excel Document 
Create a spreadsheet in Excel (these procedures are documented for use with Excel 97); add a heading and 
define a name for each column to be linked.  The name and corresponding heading should be different. 

 

DBLink:  Microsoft® Excel Spread Sheet Setup 

Each name defines an ODBC table and the column heading defines an ODBC field. 

Note: Mixing alphabetical and numeric data in the same column may cause problems in the Lyric display, so 
in a situation similar to this example, you might wish to title the "Player" and "Average" columns as Lyric text 
in the finished display, as opposed to taking the displayed column heading from the Excel spreadsheet. The 
Lyric text templates pictured in the Template Setup figure further below reflect this. 

 

Defining Column Names 
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Once the spreadsheet is complete, register it as a Data Source through your Duet or PC's ODBC Data 
Sources Windows control panel. [ Note: Depending on the Excel driver in your system, this control panel may 
appear with the name Data Sources (ODBC) ] 

Linking with the Spreadsheet from Lyric 
After completing the steps outlined above, your spreadsheet should appear as a Data Source in the Database 
Link dialog box, along with the tables (names) and fields (columns) that have been defined.  

 

ODBC Data Source Administrator - New Database Added 

Note: If the spreadsheet is still open in Excel, you may need to share the workbook (use Excel's Tools 
menu) so that Lyric can access the spreadsheet. 

Next, open a Lyric canvas containing a 2D text window large enough to accommodate all of the cells in your 
table. Create an individual template for each piece of information you wish to display. You might try it this 
way: 

1. Create a text row for every row in your table (with the text window open, press Alt + Insert for each 
row you wish to create).  

2. Place the cursor on the first row and open a template with the Template button on the Chyron 
Toolbar. 

3. Keep the cursor on or near the first row, and position it where you wish to begin a second column. 
Press the Template button again (Lyric should "snap" the template vertically to the first row). 

4. Click and drag around the two templates to select them in a bounding box. 

 

Selecting Two Templates 

5. Copy (Ctrl + C) the templates. 
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6. Place the cursor on the next row and use the Paste In Place command (Ctrl + I). The Paste In Place 
function will place the new templates directly beneath the original ones, correctly aligned. Repeat this 
procedure for each row of the table, until you have created a template corresponding to each cell in 
the original spreadsheet. 

 

Template Setup 

Note that the templates only accommodate the players' names and averages; the column 
headings "Player" and "Average" will be created as non-template text or in a different graphic 
element. 

7. Next, each template must be associated with a cell in the spreadsheet. Click in the first Lyric 
template, and press the DB Link button on the Template Dialog Box. Use the dropdown boxes to 
select: 

 Data Source (the user-assigned name in the 'Data Source Name' field in the 'ODBC 
Microsoft Excel Setup' dialog box)  

 Table (the column name in the Excel spreadsheet) 

 Record (the number of which is one less than the row number in the Excel spreadsheet) 
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8. Don’t forget to check the Enable box. 

 

DBLink Dialog Box Setup 

9. Repeat this procedure for each Lyric template. Note that there will be no visible change in the Canvas 
for the moment; all you will see is the empty templates. 

10. When you are finished, record the Canvas as a Lyric message with a numerical name. Next, recall 
the same message, and the contents of the Excel spreadsheet are displayed in Lyric's templates. If 
the spreadsheet is altered and saved under the same name, the Lyric display will update each time 
the message is read. 
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Controlling the number of decimal places shown in a display driven by Microsoft Excel 
The display of decimal places may be controlled to force the display of trailing zeroes that are mathematically 
unnecessary but desirable in many situations as a matter of style. In the batting averages pictured in this 
topic, the "unnecessary" trailing zeroes really must be included in the display. You'll probably agree that the 
display on the left is more like what you're accustomed to seeing. 

 

Controlling Decimal Placement 

By clicking the Numeric checkbox and specifying the desired number of decimal places, the data can be 
configured to display correctly. 

Using DB Link to Replace Graphics 
Text and graphic updates can be mixed in the same database.  To specify a graphic update: 

1. Right-click on the 2D graphic that is to be updated, or on its listing in the Scene Graph. The 2D 
Object Template dialog box is displayed. 

 

2D Object Template Dialog Box 

2. Set up DB Link in the same manner as with 2D Text Templates, but instead of entering replacement 
text in the database, enter the full filepath of the 2D graphic that is to replace the existing graphic.  
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Note that the replacement graphic will automatically have the same dimensions as the graphic from 
which the 2D Object Template was set.  If the Aspect Ratio of the replacement graphic does not 
match the Aspect Ratio of the graphic it is replacing, the replacement graphic will appear distorted.  
To avoid distortion, make sure that the Aspect Ratios of all replacement graphics match that of the 
graphic they are replacing. 
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Registering an ODBC Data Source 
Start > Settings > Control Panel > Administrative Tools > Data Sources (ODBC) 
Config Menu > Preferences > Browser > Advanced 
Browser > Select Database > Advanced 

Databases are available in a wide variety of flavors, from complex Microsoft Access table structures to simple 
Comma Separated Value files.  Registering databases via the ODBC (Open Database Connectivity) facility 
provided in Windows, enables Chyron and non-Chyron software which must access multiple database 
formats to read and work with these databases. 

A number of Chyron applications require the use of ODBC-registered databases: 
 Lyric's DB Link update of 2D Text Templates and 2D Object Templates is performed by drawing 

data from ODBC-registered databases. 

 Chyron's CAMIO and MOS applications access Lyric assets cataloged in ODBC-registered Lyric 
Browser data sources. 

Lyric Browser Databases and ODBC Registration 
Lyric Browser data sources are automatically ODBC-registered on creation or importation.  Under normal 
circumstances, it is not necessary to reregister Browser sources. As this automatic registration of Browser 
data sources was implemented in more recent versions of Lyric, Browser data sources that were created in 
earlier versions of Lyric my not show up in the list of registered data sources displayed in the User DSN tab of 
the ODBC Data Source Administrator (see below).  If this is the case, simply import the database using the 
Import function available from either Config Menu > Preferences > Browser or Browser > Select 
Database. 

Registering a Database 
The following example illustrates the registration of a Microsoft® Excel (.xls) database from Windows 
Administrative Tools.  Some of the dialog boxes shown in the procedure are specific to Excel, but the 
general procedure is similar for other data formats. 

Note that databases of all supported formats can also be registered from Config Menu > Preferences > 
Browser > Advanced or Browser > Select Database > Advanced.  Only .mdb databases, however can 
actually be used by the Browser. 

To register an Excel database: 
1. Access Start > Settings > Control Panel, then double-click Administrative Tools. 

 

Accessing Administrative Tools from the Control Panel 
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2. From the Administrative Tools list, double-click  Data Sources (ODBC). 

 

Selecting Data Sources (ODBC) 

3.   The User DSN  tab of the ODBC Data Source Administrator is displayed.  Click Add. 

.   

ODBC Data Source Administrator 
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4. Click the Add button.  The Create New Data Source dialog box is displayed. 

 

Create New Data Source Dialog Box 

5. Highlight the entry for Microsoft Excel Driver (*.xls) (you may have to scroll to locate it), then click 
the Finish button. The ODBC Microsoft Excel Setup dialog box is displayed. 

 

ODBC Microsoft Excel Setup 
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6. If necessary, select a different version of Excel from the Version drop-down list box, then click Select 
Workbook.  The Select Workbook dialog box is displayed:  

 

Select Workbook Dialog Box 

7. Select an Excel file (in this example, Yankees.xls), and make sure that Read Only is disabled 
(unchecked), then click OK.  The Select Dialog box closes, and the dialog box is displayed.  The 
Workbook field displays the name of the selected Excel file.  Enter a name and description for the 
database in the Data Source Name and Description fields, respectively.  It is important to note that 
the Data Source Name is used by Lyric to access the Excel file. 

 

ODBC Microsoft Excel Setup - File Selected 
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8. Options can be accessed by clicking the Options button.  The dialog box expands. 

 

ODBC Microsoft Excel Setup Options 

 Rows to Scan specifies the number of rows, from 1 to 16, which ODBC Microsoft Excel 
Setup or the driver will scan when setting the columns and column data types.  Make sure 
that the number of Rows to Scan includes all of the heading rows plus at least one data row. 

 The Read Only setting reflects Read Only setting in the Select Workbook dialog box, but 
can be changed from this dialog box as well. 

9. Click OK.  The ODBC Microsoft Excel Setup dialog box closes. 

10. Click OK in the ODBC Data Source Administrator dialog box, which then closes.  Close the 
Windows Control Panels window.  The file is now registered as an ODBC database, and can be 
accessed by Lyric DB Link and other applications. 
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Creating Templates from Existing 2D Text 

Select Text, then:  Tools Menu > Template; or Chyron Toolbar >  
Some designers prefer to place their text elements into Lyric first, then create Templates containing those 2D 
text elements.  To create a Template from existing 2D text: 

1. Select the desired 2D text.  Important:  To ensure proper Template height, be sure to include a 
space character in the selected text.  Multiple lines can be selected to create a multi-line Template.  

2. Click the Template  button or select Template from the Tools menu.. 

Lyric creates a Template over the selected 2D text.  The 2D text is transferred into the Template.  
Inter-row spacing is maintained, but any deviation in inter-character spacing is not.  The Default 
Template Font is taken from the leftmost character in the selection rectangle (usually the first 
character on the line). 

Once a Template is created in this manner, Template attributes can be set/modified as usual. 
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14. 2D Text Animation 

Roll 

Tools Menu > Roll;  Chyron Toolbar >  

Crawls, in which one or more rows of 2D text travel vertically over the screen, can easily be created in Lyric.  
Creating a Crawl is a three-step process. 

1. To create a 2D text Roll window, pull down the Tools menu and select Roll, or press the Roll  
button on the Chyron Toolbar. 

2. Next, enter text into the 2D Text Roll window exactly as you wish it to appear on the output, using 
whatever fonts, styles and sizes you desire. Click inside the Roll Window and type the desired text. 
Please note that lines wrap around automatically based on line length only, and could incorrectly split 
words. You may also create Templates  within Roll windows, which afford greater control over line-
wrapping.  

 

Roll Window 

To resize the Roll window, you may drag the window's edges and corners. To reposition the entire 
window, move your pointer near the Title Bar until it becomes a "Move" cursor as seen at upper right 
in the illustration. Use the Scroll Bars to scroll up and down within the Roll's text. 

3. Position and size the window as desired. 
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4. In the Properties menu, use the  arrows to locate the Animation tab. (Or right-click anywhere 
on any Properties tab to open a context menu from which you may select the Animation tab. 

 

Roll Animation Properties 

5. Make sure that the 2D Roll element is selected in the Object drop-down. 

6. Using the available parameters (Start and End Frame, Duration, Speed and Rate (Scanlines/Field), 
set the duration or speed of the Roll. See Animation for more detail on using these controls. 
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7. Click the Play  button on the Transport Controls. If you are working on a PC or on a Duet without 

the Duet "render"  button activated, the animation will play out on your VGA monitor. On a Duet 

with the  button activated, the system will request confirmation that you wish to play the 
animation on the video output. 

 

Animation Ready Prompt 

The following should be noted about Rolls: 

 Lyric is capable of simultaneously animating multiple 2D Rolls and Crawls along with other animated 
objects. 

 Since a 2D Roll window is a regular Lyric Object, you may animate and change its position attributes 
while it is rolling text! 

 Text copied from any Windows application can be pasted into a Roll window (or any of Lyric's 2D Text 
windows, including Crawls, Type-On/Slow Reveals and Spline Windows). 

To delete a Roll Window: 
 Click on its title bar, then press Ctrl + Delete; or select the proper 2D Roll item in the Scene Graph 

then press Delete. 
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Crawl 

Tools Menu > Crawl;  Chyron Toolbar >  

Crawls, in which one or more rows of 2D text travel horizontally across the screen, can easily be created in 
Lyric.  Creating a Crawl is a three-step process. 

1. Pull down the Tools menu and select Crawl OR press the  button on the Lyric interface. A Crawl 
window appears. When first opened on the Canvas for composition, Crawl windows look exactly like 
regular 2D text windows except for the title bar.  

 

Crawl and 2D Text Windows 

2. Enter text into the 2D Text Crawl window exactly as you wish it to appear on the output, using 
whatever fonts/styles/sizes you desire. 
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3. In the Properties menu, use the  arrows to locate the Animation tab, or right-click anywhere on 
any Properties tab and then select the Animation tab. 

 

Crawl Animation Properties 

Refer to the section on the Animation Controls Properties page for information on programming Crawls and 
other animations using the attribute controls seen above. 
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Let's walk through the creation of a Crawl that lasts five seconds.  
1. Create a 2D Crawl Window by clicking on the Crawl button:    

 

Crawl Button 

A Crawl window appears: 

 

Crawl Window 

2. Position and size the 2D Crawl window as desired. 

3. Enter text into the Crawl Window:   

 

Text Entered in Crawl Window 

4. Select the Animation tab on the Properties menu. In the Object field, select the 2D Crawl item from 
the dropdown, if it is not already selected: 

 

Properties:  Animation - Crawl Object Selected 

5. Of the available parameters (Start and End Frame, Duration, Speed and Rate (Pixels/Field), select 
Duration, and set the value to five seconds (00:00:05:00).  Click Apply. 
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6. On the Transport Controls, click the Play  button. If you are working on a PC or on a Duet without 

the Duet "render"  button activated, the animation will play out on your VGA monitor. On a Duet 

with the  button activated, the system will request confirmation that you wish to play the 
animation on the video output. 

 

Animation Execution Prompt 

The following should be noted about Crawls: 

 Lyric is capable of simultaneously animating multiple 2D Crawls and Rolls along with other animated 
objects. 

 Since a 2D Crawl window is a regular Lyric Object, you may animate and change its position 
attributes while it is crawling text! 

 Text copied from any Windows application can be pasted into a Crawl window (or any of Lyric's 2D 
Text windows, including Rolls, Type-On/Slow Reveals and Spline Windows). 

To resize the Crawl Window, you may drag the window's edges and corners. To reposition the entire Crawl 
window, move your pointer near the Title Bar until it becomes a "Move" cursor as seen at upper right in the 
illustration. Use the Scroll Bars to scroll left and right within the Crawl's text. 

 

Resizing the Crawl Window 

To delete a Crawl Window, click on its title bar, then press Ctrl + Delete. Or, select the proper 2D Crawl item 
in the Scene Graph then press Delete. 



Lyric User Guide 

 14-8 

Type On/Slow Reveal 

Tools Menu > Type On; Chyron Toolbar > ;  Canvas/Scene Graph Right-Click Menu > Type On 
Type On (also known as Slow Reveal) produces an animation that mimics the look of a typewriter "typing" 
text on the screen.  To set up a simple Type On animation: 

1. Erase the Canvas, set the Timeline at 00:00:00:00, and open the Animation tab of the Properties 
window. 

2. Select Type On from the Tools menu, or click the  icon.  A 2D Type On window appears on the 
Canvas. 

 

Type On Window 

3. Enter your text. 

4. Press Play on Lyric's Transport Controls. The text you've typed now appears, one character at a 
time. By default, the Type On animation's duration is the same as the default animation length set in 
the Preferences > Animation Settings tab. 
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Remember that the Type On function automates the work of producing a complete animation.  Therefore, 
Lyric automatically assumes the Type On animation's start point to be whatever the current time is on the 
Timeline.  If the Timeline is at a point other than 00:00:00:00 when you enter Type On text, the Type On 
region will "begin to exist" at that point, for a duration the same as Lyric's default animation length. This will 
cause the Type On region to extend beyond the end of the other elements on the Timeline, increasing the 
total length of the animation.  Note however, that such crucial elements as Camera and Global Lighting are 
not automatically extended by such an action.  

This type of adjustment is made on the Properties > Animation tab, using the Start/End Frame, Duration, 
Speed Number and Rate controls.  Clicking the Apply button imposes these Timeline values on the Type 
On region on which you are working (or any Canvas object selected in the Object dropdown list box).  
Pressing the Apply All button imposes the same Start/End Frame and Duration values on every object on 
the Timeline, including Camera, Global Light and individual Light Sources. 

Refer to Animation Properties for details on the Properties > Animation settings. 

Several execution parameters can be set using the Type On feature.  

 

Type On Options 

 Click the Soft checkbox if you wish the characters to fade in. 

 Click the Random checkbox if you wish the characters to appear in random order, instead of 
appearing first letter to last. 

 If Underline is a font attribute and Random is active, the underline for the entire character string 
appears at a random point in the Type On execution.  If Underline is a font attribute and Random is 
not active, the underline for the entire character string appears first when the Type On animation is 
executed, followed by the remainder of the characters. 

 Don't forget to click Apply or Apply All. The Soft and Random options may be used on the same 
text. 
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A Pause can be programmed into Type On execution. 
1. Click the Pause checkbox.  The Pause button becomes active. Click the Pause button.  The Pause 

Options dialog box is displayed.  Available Pause At settings are specific to each Pause For 
selection. 

 

Type On Pause Options 

2. There are three Pause options for triggering Type On animation: 

 Select Keystroke if the Type On animation is to be triggered by an operator at the Lyric 
keyboard.  There is only one choice for Pause At, which is Row.  When the Type On 
animation  triggered by clicking the Play button on the Transport Controls, a Paused for 
Keypress prompt is displayed in the Status Bar before each row is displayed on the screen.  
The user presses any key on the keyboard (except Esc) to execute the display of each row. 

 Click Timeout to instruct Lyric to program a delay.  Clicking the Timeout radio button 
activates the Timeout Frame Counter, where a delay time can be entered.    There is only 
one choice for Pause At, which is Row.  When the Type On animation is triggered by 
clicking the Play button on the Transport Controls, the execution of each row is delayed by 
the amount of time set in the Timeout Frame Counter.  A Paused for Delay prompt is 
displayed in the Status Bar before each row is displayed on the screen. 
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 If the Duet has GPI connections, the GPI radio button also becomes available.  Click the GPI 
radio button.  From the dropdown list box, select the GPI input that is to trigger the Type On 
animation.  There is only one choice for Pause At, which is Row.  When the Type On 
animation is triggered by clicking the Play button on the Transport Controls, the execution 
of each row is delayed by the amount of time set in the Timeout Frame Counter.  A Paused 
for GPI prompt is displayed in the Status Bar before each row is displayed on the screen. 

 The Replay radio button should not be selected for Type On execution.  It is for use with 
Multi FX execution. 
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Spline Window 

Tools Menu > Spline Window; Chyron Toolbar   

Setting Up a Spline Animation 
Lyric's Spline Window tool allows 2D text to be mapped and animated to a curved baseline.  Note that 
double-byte characters from languages such as Korean, Chinese and Japanese are supported. 

1. Select Spline Window from the Tools menu or click .  The Spline Editor window is displayed. 

 

Spline Editor Window 

2. Before continuing, locate the Fade In and Fade Out controls in the lower left corner of the dialog, and 
slide them all the way to the left.  We'll get back to these controls shortly. 

 

Fade In/Fade Out Sliders 
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3. First, we'll practice creating static text on a curved path.  By default, Lyric assumes that you wish to 
create animated text on a curve.  So, to create static text, you'll simply designate a point in the default 
animation.  In the Options area of the dialog, make sure Show Text At button is selected. 

 

Options Area  

4. Enter a value in the Frame Counter window which specifies the point in the animation at which the 
text will appear in the Canvas.  Given that Lyric's default animation length is most likely set to 5:00 (5 
seconds), use a value of 2:00. 

5. Next, input some sample text, as shown here. 

 

Entering Sample Text 

6. Now, right-click in the Spline Editor window, and for this exercise, select Insert. 

 

Spline Editor - Insert Selected 
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A Spline Control Point appears. 

 

Spline Control 

7. Click on the square in middle of the arrow and move it to any position to establish one end of the path 
onto which the text will be mapped. When you click on the arrow, it turns from its initial blue to yellow, 
signifying that it is active for editing. 

8. Next, right-click on the Canvas and select Insert again, to add a Spline Control Point. 

 

Spline Editor 
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9. Note the white line connecting the arrows.  To start placing each end of a curved path, try moving the 
arrows around the Canvas by dragging them as desired.  The line connecting the arrows remains 
more or less straight for the moment. 

10. Now, click on each arrow's head and tail to lengthen or shorten the front or rear section of the arrow, 
or to change the arrow's direction. Note the effects of these actions on the path connecting the 
arrows. This may take a little getting used to, but you'll soon get accustomed to defining curved paths 
this way. 

 

Adjusting the Spline Control Point 
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Note that you may add as many arrows as necessary to define the path by smoothing out the curve 
as needed. 

 

Spline Editor Window - Smoothing the Spline Curve 
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11. When you're finished defining the path, click OK.  The Canvas appears with the text placed on the 
curve. 

 

Canvas Showing Text on a Spline Curve 

Note that in preview, the path itself is displayed, along with the text. The path won't appear when the text is 
displayed for air.  
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If you get something that looks like this, however, don't panic: 

 

Text on a Spline Curve - Out of Bounds 

All you need to do is drag the borders of the Spline Curve region on the Canvas until the entire composition 
is visible.  

 

Adjusting the Spline Control Window Size 

Note that the borders of the region do determine what's visible when the completed text is displayed, either 
statically or in an animation, not just in preview. 

Again, remember that the time value you defined above is a point in the progress of an actual animation, so 
you need to be mindful of the effect it will have on the appearance of text you'll be showing as static in a 
finished composition. 
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Below, the text is shown as it would appear at 2 seconds into a five-second animation. 

 

Animation at Two Seconds 
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Here's how it would look at 3 seconds, 25 frames. 

 

Animation at 3 Seconds, 25 Frames 
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From here, let's move on to actually animating text on a curved path. 

1. Open a new Canvas and a new Spline Editor window.  This time, select the Animate option.  The 
Show Text At Frame Counter becomes unavailable, because you are now creating an animation 
whose duration will be determined by Lyric's default animation length unless otherwise modified. 

2. Also, for the moment, move the Fade In and Fade Out sliders all the way to the left again. 

3. Enter some sample text again, and create a curved path using multiple arrows, as you did earlier. 

 

Creating a Spline Curve 

By the way, this time, take note of the order in which you created the arrows. The order of the arrows' 
creation determines the starting point of the animated text. 
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4. Click OK on the Spline Editor window, and the Canvas appears, displaying the path which you have 
defined.  Note that in this situation, the text won't appear until the animation is running. 

 

Spline Window Animation About to Execute 

5. Click Play on the Lyric Transport Controls, and the text moves along the curve from the beginning of 
the path (established by the first arrow you placed on the Spline Editor dialog window) to the end. 
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After you've got the hang of animating text on a curved path, try adjusting other parameters: 
 Experiment with the Fade In and Fade Out controls; these sliders cause the text to gradually appear 

and disappear at the beginning and end of the path.  
 Use Reverse Path causes the animation to begin at the point originally established as the end of the 

path, moving to the point originally established as the beginning. 
 The Baseline Offset adjustment varies the distance between text and the established path. 
 Right-click in the Spline Editor window and select Insert Ellipse to define a circular path. 

 
Circular Path 

As seen above, the default shape is a perfect circle, but you may click on any of the corner handles to 
drag the circle into an ellipse of any proportions. 

 
Elliptical Path 

Click on the square in the center of the circle/ellipse to drag it to a new location in the Spline Editor 
window. 

Any curved path arrow, or an elliptical path may be removed from the Spline Editor window by right-
clicking and selecting Delete.  The object you wish to delete must be active in the window 
(highlighted in yellow). 
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Modifying a Spline Animation 
2D Text Window Right-Click Menu > Modify Spline 
Once a Spline curve has been set up, it can be modified. 

1. Place the cursor in a Spline Window on the Canvas. 

2. Right-click, then select Modify Spline from the menu.  The Spline Editor Window is displayed. 

3. Adjust the curve as described in the section on Spline Window. 

Modify Spline is available only when a Spline Window is active on the Canvas. 
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2D Character Animation 
2D Text Right-Click Menu > Animate Elements 

Individual 2D text characters can be converted into independently animatable objects that can be 
repositioned, rotated, scaled, etc.   

1. Type some text in a 2D Text window. 

2. Right-click anywhere within a 2D Text window and the context menu pictured opens. 

3. Select Animate Elements.  When  you do, keep an eye on the Scene Graph, below left.  The entry 
2D Text 1.Animated appears.  Note that the entry includes the  symbol, meaning that it can be 
expanded to show its constituent elements (The expanded entry is shown here.).  Note also that the 
2D Text window itself remains as a separate entity on the Canvas. 

 

2D Text:  Animate Elements and Scene Graph 

4. Individual 2D text characters can be animated exactly the same way as other objects, independently 
of the text box that originally contained them. You may drag the characters to new locations on the 
Canvas or use the Properties > XYZ controls, and alter their time values with the Timeline, 
Animation Control dialog box or Scene Graph. 
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The characters themselves, however, cannot be edited.  In other words, a spelling mistake cannot be 
fixed while in the Animate Elements mode.  To edit the text, it is necessary to right-click on the 2D 
text, then select Animate Elements to disable (uncheck) it. 

Note that unchecking Animate Elements on the right-click menu turns off the entire feature for the 
current message, even if you have saved the message. However, the animated 2D character 
information is saved with the message, and can be used if the feature is turned back on. 

Advanced Text Effects 
2D Text/Template Context Menu > Advanced Text Effects 

Introduction 
Advanced Text Effects provides a fast and convenient way to apply pre-scripted, keyframe-based 
animations to rows and/or 2D Text Templates in a 2D Text Window.  Advanced Text Effects is an 
extension of the Animated Elements feature, which enables the conversion of 2D text into individually 
animatable objects.  Effects include Horizontal/Vertical Blur, Drop Down, Push Up, Slide Left/Right, and 
Kern Left/Right.  Custom effects can also be designed using the Advanced Text Effects Custom 
parameter settings.  Advanced Text Effects can be saved and recalled for playback. 

To access the Advanced Text Effect dialog box: 
1. Read or create a Lyric message which includes 2D text in a 2D Text Window. 

2. Place the cursor on the row in the 2D Text Window to which the Advanced Text Effect is to be 
applied.  If applying the Advanced Text Effect to all rows, the cursor can be placed anywhere in the 
2D Text Window. 
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3. Right-click to open the 2D Text/Template context menu, then select Advanced Text Effects.  The 
Advanced Text Effects dialog box is displayed. 

 

Advanced Text Effects Dialog Box 

The position of the cursor (on a template or a row) in the 2D Text Window determines the initial Apply To: 
setting.  The initial Duration reflects the length of the Timeline of the 2D Text Window. 

Note that each time that an effect is applied to an additional 2D Text Window, the start point of the new effect 
is automatically placed at the start of the new 2D Text Window's Timeline.  You may need to adjust its 
Timeline to coordinate the execution of the effects. 

NOTE 
If applying both an Advanced Text Effect and Advanced Image Effect to a 2D Text 
Window, the two resulting animations are not combined with each other and applied to 
one object.  Each of the effects creates a separate object that is rendered and executed 
separately.  Execution of the two effects can, however, be simultaneous.  
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Basic Advanced Text Effects Setup 
NOTE 

Make sure that before setting up an Advanced Text Effect, the length of the 2D Text 
Window's Timeline accommodates the sum of the In Effect duration and Out Effect 
duration. 

To set up a basic Advanced Text Effect: 
1. In the Effect list box, select an effect from the following choices: Horizontal or Vertical Blur, Drop 

Down, Push Up, Slide Left or Right, or Kern Left or Right. 

2. Effects can be set up, executed, saved and recalled in pairs.  One effect acts as the In Effect, and 
the other as a separately triggered Out Effect.  Each effect in the pair is set up separately.  The total 
duration is displayed in the Duration of Entire Effect frame counter. 

Click Effect In or Effect Out to specify which effect to set up. 

NOTES 
 Kern Right and Kern Left reverse the Anchor points for the Out Effect.  For 

example, Kern Left kerns from the right to a left Anchor when executing 
as an In effect, and kerns from the right from a right Anchor when 
executing as an Out effect.  Note that this does not occur when setting 
Dynamic Kern as a custom effect.  See Creating a Custom Advanced Text 
Effect below for details. 

 Horizontal and Vertical Blur produce the same type of effects as set in 
Properties > Font > Filter.  Horizontal and Vertical Blur execute from 
focused to blurred as In Effects, and from blurred to focused as Out 
Effects. 

 Drop Down, Push Up, Slide Left and Slide Right execute in their same 
respective directions for both In and Out Effects. 

3. The effect can be applied to a row, a 2D Text Template or all rows and 2D Text Templates. In the 
Apply To: area, use one of the following methods to apply an effect: 

 Apply the effect to a row by clicking the Current Row radio button, or if necessary, scrolling 
through the rows by clicking the Prev/Next buttons.  The current row is identified by the red 
end markers on the baseline.  If necessary, deactivate the All Elements radio button. 

 Apply the effect to a 2D Text Template by clicking the Current Template radio button, and if 
necessary, scrolling through the 2D Text Template by clicking the Prev/Next buttons.  The 
current 2D Text Template is identified by the green end markers on the baseline(s). 

 Click the All Elements radio button to apply the effect to all rows and 2D Text Templates. 

4. Optional:  Modify the Duration of the Entire Effect.  This frame counter displays the durations of the 
In and Out effects. 

5. The application of the effect to each subsequent character in the row or 2D Text Template can be 
delayed by a fixed period.  Set this delay in the Character Delay counter. 

If the application of the Character Delay causes the total duration of the effect to exceed the duration 
of the 2D Text Window object on the Timeline, the Timeline for the 2D Text Window and the 
Advanced Text Effect object associated with the 2D Text Window adjusts to accommodate the 
effect.  The Duration of the Entire Effect frame counter reflects the adjustment.  Additionally, if 
necessary, the Timeline of the entire Lyric animation adjusts as well. 

6. The application of the effect to each subsequent row(s) or 2D Text Template(s) can be delayed by a 
fixed period. Set this delay by selecting (checking) Row Offset and entering a value in the Row 
Delay counter.  Note that when setting Row Delay, the Duration of Entire Effect frame counter 
changes to show the Duration of Each Row. 
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If the application of the Row Delay causes the total duration of the effect to exceed the duration of 
the 2D Text Window object on the Timeline, the Timeline for the 2D Text Window and the 
Advanced Text Effect object associated with the 2D Text Window adjusts to accommodate the 
effect.  The Duration of the Entire Effect frame counter reflects the adjustment.  Additionally, if 
necessary, the Timeline of the entire Lyric animation adjusts as well. 

7. Offset shifts the start point of each character for In Effect, and the end point of each character for the 
Out Effect.  The Offset is calculated relative to the original position of each character.  For example, 
the default Offset of 35 produces the following offset. 

Change in the Start Position of an In Effect Start Position or an Out Effect 
End Position = (35)/10 = 3.5 

The offset is reflected in the Keyframe Graph XPosition or YPosition and the Properties > XYZ X 
or Y position of each of the elements in the Advanced Text Effect.  The In Effect start position or 
Out Effect end position before an offset is applied is X = 0; Y = 0.  For example, if an Offset of 35 is 
set to a Top-to-Bottom effect, the new Y start point for each element will be 3.5.  Since this is a 
vertical effect, X Position remains unchanged. 

 Increased/decreased Offset moves starting point of Right-to-Left effect further right/left 
respectively. 

 Increased/decreased Offset moves starting point of Left-to-Right effect further left/right 
respectively. 

 Increased/decreased Offset moves starting point of Top-to-Bottom effect further up/down 
respectively. 

 Increased/decreased Offset moves starting point of Bottom-to-Top effect further down/up 
respectively. 

 If Offset is not selected, the start point is not offset. 

To set the default Offset of 35, select (check) the Offset checkbox.  For information on setting a 
custom Offset, refer to Creating a Custom Advanced Text Effect later in this section. 

8. The entire procedure starting from Step 1 can be repeated to set up Effect In and/or Effect Out for 
any number of rows and/or 2D Text Templates in the 2D Text Window. 

Advanced Text Effect settings can be recorded as part of the current message.  When the message is read 
back, the effect(s) is executed as a normal animation(s). 

Previewing/Executing/Stopping an Advanced Text Effect 
To preview or execute the effect(s): 

 Click . The effect executes from the In Effect, regardless of whether Effect In or Effect Out is 
active. 

If an Effect Out has been set, the Effect In executes, then the message "Pausing; Press any key to 
continue" appears in the Status Bar to prompt for a keystroke to execute the Effect Out.  Once the Effect 
Out has been executed, the Status Bar displays the message "Pause Released". 

Advanced Text Effects can also be executed as a normal animation after the Advanced Text Effects dialog 
box has been closed. 

To stop effect execution: 

 Click . 

Advanced Text Effects can also be stopped in the same manner as a normal animation after the Advanced 
Text Effects dialog box has been closed. 
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What Happens When an Advanced Text Effect is Applied? 
When an Advanced Text Effect is applied to a 2D Text window, and the Advanced Text Effect dialog box 
has been exited, the following occurs: 

 The 2D Text window is now in Animate Elements mode.  This is indicated by the checkmark next to 
the Animate Elements item in the 2D Text/Template context (right-click) menu.  The characters 
have been converted into animatable objects.  As shown below, the baselines in the 2D Text 
Window are no longer visible and the characters within the window can no longer be edited as 2D 
text. 

NOTE 
The entire 2D Text Window is in Animate Elements mode even if an Advanced Text 
Effect has been applied to only one row/template of a multi-row/template 2D Text 
window. 

 A new element has been added to the Scene Graph and the Timeline.  As shown below, 2D 
Text1.Animated identifies the group of animated elements created from the 2D Text Window that is 
in Animate Elements mode.  This newly-created group behaves in the same manner as other 
grouped elements with regard to characteristics and operations.  In the figure below, 2D 
Text1.Animated is expanded to show its component elements.  Note that the original 2D Text 1 
element, which identifies the 2D Text window, is still present.  The Status Bar (shown under the 
Scene Graph) indicates that 2D Text1.Animated is active. 

 

Advanced Text Effect Applied - Changes to Canvas, Timeline, Scene Graph 
and Status Bar 
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The Keyframe Graphs of each of the elements can be viewed and edited as well.  These edits are 
preserved on message recall.  Keep in mind, however, that settings made to properties that can be 
adjusted from within the Advanced Text Effects dialog box override outside alterations of the same 
properties if: 

o Additional work is done within the Advanced Text Effects dialog box. 

o A 2D Text Template content update was initiated by Intelligent Interface, DBLink, the 
Template Update dialog box, etc. 

o The user toggles out of and back into the Animate Elements mode.  Note that the current 
Advanced Text Effects settings are reapplied each time that the Animate Elements mode 
is activated. 

For example, if the X, Y, Z and Z rotation parameters are changed from the Properties > XYZ tab, 
only the change to the Z position would be preserved, as the X and Y positions as well as the Z 
rotation are controlled by Advanced Text Effects.  Animations of 2D Text Windows in the same 
message that do not have Advanced Text Effects applied are not affected, nor are other objects. 

Removing/Clearing an Advanced Text Effect 
To remove an effect from a row or 2D Text Template once an effect has been applied: 

1. Make the 2D Text Window active. 

2. Open the Advanced Text Effects dialog box. 

3. Click the Current Row or Current Template Prev or Next button in the Apply To: area to select the 
row from which to remove the effect. 

4. Select None from the Effect list box. 

5. Click OK.  The effect no longer executes on the selected row or 2D Text Template. 

To clear all effect settings from the Advanced Text Effect dialog box: 
 Click Clear, then click OK when prompted by the Lyric pop-up.  The effect settings are cleared from 

the dialog box.  The 2D Text Window remains in Animate Elements mode, unless Close is clicked 
immediately after this operation. 

As mentioned earlier, after an effect is applied, the 2D Text Window is in Animate Elements mode.  The text 
within the 2D Text Window cannot be edited unless it is converted from functioning as animated objects back 
to 2D text.  To restore 2D text functionality: 

 Right-click on the 2D Text window to display the 2D Text/Template context menu, then deselect 
(uncheck) Animate Elements.  The text can now be edited.  Note that settings in the Advanced Text 
Effects dialog box are not affected by this operation.  If the row count remains the same, this allows 
adjustment of the text without having to rebuild the Advanced Text Effects.  Adding or deleting a 
row(s) may require adjustment of the Advanced Text Effects settings. 

Advanced Text Effects set in other 2D Text Windows are not affected by these operations. 

Preserving/Not Preserving Advanced Text Effect Settings 
Effect settings are preserved on exiting the Advanced Text Effects dialog box when one of the four following 
operations has been performed: 

 is clicked after parameters are set and just before clicking OK or Close to exit.  

 Either of the Prev/Next spinners are clicked after parameters are set and just before clicking OK or 
Close to exit. 

 Either Effect In or Effect Out is clicked after parameters are set and just before clicking OK or Close 
to exit. 

 OK is clicked. 



Lyric User Guide 

 14-32 

To return to the Canvas without preserving effect settings: 
 Click Close without having performed any of the above operations. 

Saving/Recalling an Advanced Text Effects Message 
Advanced Text Effect settings can be recorded as part of the Lyric message that is on the Canvas.  When 
the message is read back, the effect(s) is executed as a normal animation(s).  In addition, the Advanced 
Text Effects In Effect and Out Effect settings themselves can be saved and recalled to apply to other 2D 
Text Windows. 

To save the Advanced Text Effects message: 
 Click Save, enter a File Name, then click OK.  The In Effect and Out Effect settings are saved to a 

Text Effect File (.tfx) format. 

To recall and apply an Advanced Text Effects message: 
1. Create or read a message into a 2D Text Window. 

2. Right-click on the 2D Text Window, then select Advanced Text Effects to open the Advanced Text 
Effects dialog box. 

3. Click Recall, select an effect message, and then click OK.  The recalled In Effect and Out Effect 
settings are loaded into the Advanced Text Effects dialog box and are ready for execution. 

Creating a Custom Advanced Text Effect 
The effects available in the Advanced Text Effects dialog box can be modified to create custom effects, or 
new ones can be designed using only the parameters available in the custom effects area of the dialog box.  
To create a custom effect: 

1. Read or create a Lyric message which includes 2D text in a 2D Text Window.  2D Text Templates 
can be included.  Make the 2D Text Window active. 

2. Place the cursor on the row or 2D Text Template in the 2D Text Window to which the Advanced 
Text Effect is to be applied.  If applying the Advanced Text Effect to All Elements, the cursor can 
be placed anywhere in the 2D Text Window. 

3. Right-click to open the 2D Text/Template context menu, then select Advanced Text Effects.  The 
Advanced Text Effects dialog box is displayed. 
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4. Click .  The Advanced Text Effects dialog box expands to enable access to custom 
settings.  If the dialog box is expanded to show custom settings, and an effect has already been 
applied to the Current Row, Current Template or All Elements, that effect is still selected and 
displayed in the dialog box.  Likewise, effects that had already been set up for other rows or 2D Text 
Templates in the same 2D Text Window remain in effect, and can be viewed by clicking the 
Prev/Next buttons.  The Apply To: setting is automatically set to Current Template or Current Row, 
depending on which set of Prev/Next buttons is used. 

 

Advanced Text Effects Dialog Box - Expanded 

5. An existing effect can be modified or a new one can be built from scratch. 

 To build from an existing effect, select an effect in the Effect list box.  The default settings for 
the effect are loaded. 

 To build from scratch, select None in the Effect list box. 

6. Set Effect In/Out, Apply To, Duration, Character Delay, and Row Delay parameters as described 
above in basic Advanced Text Effects setup. 
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7. Set Effect Direction and Offset (in the Offset field in the Effect Direction area, not the Offset 
checkbox used for basic setup). 

Effect Direction can be set to Left-to-Right, Right-to-Left, Top-to-Bottom, Bottom-to-Top or 
Static. 

Offset shifts the start point of each character for In Effect, and the end point of each character for the 
Out Effect.  Offset range is from 0 - 100, and is calculated relative to the original position of the 
character.  The Offset position of the character is calculated as follows: 

Change in the Start Position of an In Effect Start Position or an Out Effect 
End Position = (Offset)/10 

The offset is reflected in the Keyframe Graph XPosition or YPosition and the Properties > XYZ X 
or Y position of each of the elements in the Advanced Text Effect.  The In Effect start position or 
Out Effect end position before an offset is applied is X = 0; Y = 0.  For example, if an Offset of 8 is 
set to a Top-to-Bottom effect, the new Y start point for each element will be .8.  Since this is a 
vertical effect, X Position remains unchanged. 

 Increased/decreased Offset moves starting point of Right-to-Left effect further right/left 
respectively. 

 Increased/decreased Offset moves starting point of Left-to-Right effect further left/right 
respectively. 

 Increased/decreased Offset moves starting point of Top-to-Bottom effect further up/down 
respectively. 

 Increased/decreased Offset moves starting point of Bottom-to-Top effect further down/up 
respectively. 

 If Static is selected, the Offset setting is ignored, and the start point is not offset.  This would 
be the same as setting the Offset to 0.  There would be no positioning associated with this 
setting. 

NOTE 
Effect Direction/Offset and Kern Rate (see Step 12) are independently implemented 
effect parameters.  Even if a Static Effect Direction is selected or Offset is set to 0, 
setting a Kern Rate other than 0 will produce an effect where the positions of the 
characters change as the effect executes. 

8. Set Scaling. Choose to scale Vertical, Horizontal, both Vertical and Horizontal dimensions or 
None, then set the magnitude of the scaling in the Scale spin box. Scale range is 0 - 100, with values 
between 0 and 1 reducing size. 

 Select Scale To to change size from the original dimensions to the scale set in the Scale 
spin box. 

 Select Scale From to change size from the dimensions set in the Scale spin box to the 
original size. 

 If None is selected, other Scaling settings are ignored. 

NOTE 
When applying the same Scaling effect as In and Out effects, the Out effect will not 
appear to change the dimension(s).  This is because scaling is based on the original 
dimensions.  So, for example, if the In Effect doubles the horizontal dimension by 
scaling to 2.00, an Out Effect set at 2.00 will not change the size.  To double the 
horizontal dimension again on the Out Effect, Scaling must be set to 4.00. 
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9. Set Horizontal and/or Vertical Blur. Range for both Horizontal and Vertical Blur is 0 (completely 
focused) - 50 (most blurred).  These settings produce the same type of Blur as those set in 
Properties > Font > Filter. 

 Effect In:  Objects transform from focused to blurred. 

 Effect Out:  Objects transform from blurred to focused. 

10. Set Fade Rate.  Fade Rate specifies over what percentage of the duration the Fade executes. Range 
is from 0 - 100.  When executing an Effect In, the image fades up from black; when executing an 
Effect Out, the image fades to black.  The examples below demonstrate Fade execution. 

 Effect In:  In a 4-second (120-frame) effect, a Fade Rate of 25 executes the effect from black 
to full video over the span of the first second (30 frames), which is 25% of the total effect 
duration. 

 Effect Out:  In a 2-second (60-frame) effect, a Fade Rate of 75 executes the effect from full 
video to black over the span of the first 1.5 seconds (45 frames). 

11. Set Dynamic Kern > Anchor Point.  Selecting Left, Right or Center causes 
leftmost/rightmost/center character respectively to act as the Anchor.  If Anchor Point is set to 
Center, and there are an even number of characters on a line, the character directly to the right of the 
center line becomes the Anchor character. 

When Dynamic Kern effect is executed, the other characters in the row or 2D Text template kern to 
the Anchor character from the right/left/both sides respectively when an In Effect is executed, and 
kern to the left/right/both sides from the Anchor character when an Out Effect is executed. 

12. Set Dynamic Kern > Kern Rate. The higher the Kern Rate, the farther apart the characters are 
positioned at the start of the In Effect or the end of the Out Effect.  Range is from 1 - 50.  The Kern 
Rate is calculated as follows: 

The X coordinate of each of the characters relative to their In Effect start points and Out Effect end 
points (not taking into account an offset) is 0.  This is demonstrated on the XPosition Keyframe 
Graph and in the Properties > XYZ X Position setting for each character.  When a Kern Rate is 
applied, it moves the In Effect start point or the Out Effect end point of the character to: 

X Position = (Position Number)(Kern Rate)/10 

Position Number indicates where the character is positioned in relation to the Anchor character, 
with the Anchor character occupying Position Number = 0.  Characters to the right of an Anchor 
character will have positive position numbers; characters to the left of an Anchor character will have 
negative position numbers. 

See Kern Rate Example directly after this exercise for a simple example of how Kern Rate affects 
an Advanced Text Effect. 

NOTE 
As described in Step 7, Offset affects the start position of an In Effect and the end 
position of an Out Effect.  Offset adds a positive value to the X position of a character if 
Effect Direction is Right-to-Left, and a negative value if Effect Direction is Left-to-Right.  
Offset values for Top-to-Bottom and Bottom-to-Top do not affect X-position. 

13. Set Character Rotate.  The characters in the row can be rotated about the X, Y or Z axis. Units are in 
degrees.  Click the radio button for selected axis, then set a value in the spin box. 

 A positive Character Rotate value set for the In Effect causes the character to rotate 
clockwise; a negative Character Rotate value set for the In Effect causes the character to 
rotate counter-clockwise. 

 A positive Character Rotate value set for the Out Effect causes the character to rotate 
counter-clockwise; a negative Character Rotate value set for the Out Effect causes the 
character to rotate clockwise. 
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14. After setting just one custom parameter, the new effect is assigned to a Custom Effect in the Effect 

list as soon as one of the following buttons is clicked:  , the Prev or Next buttons, Effect In, 
Effect Out or OK.  The effect is named by default Custom Effect <x>.  A name of the user's choice 
can be entered into edit box at the top of the Effect list.  Like the default effects, it can be applied to a 
row, 2D Text Template or to All Elements (All rows and 2D Text Templates), and can also be 
modified, saved and recalled. 

The custom effect is now ready to execute.  The setup procedure can be repeated to set up Effect In 
and/or Effect Out for any number of rows and/or 2D Text Templates in the 2D Text Window. 

To close the custom settings area of the dialog box: 

 Click the Custom   button. 

Kern Rate Example 
Here is a simple example to demonstrate how Kern Rate affects an Advanced Text Effect: 

1. Type the characters ABC in a 2D Text window, then open the Advanced Text Effect dialog box.  
Without modifying any settings, click OK to close the dialog box and return to the Canvas. 

2. Expand 2D Text 1.Animated on the Scene Graph to show the separate elements.  Highlight the A 
element, then examine its X Position in the Keyframe Graph and in the Properties > XYZ X 
Position setting.  Do the same for the B and C elements. They should all specify 0 at the start time. 

3. Activate the 2D Text window and return to the Advanced Text Effects dialog box. Click  
to open the custom settings.  Set the Kern Rate to 7; Anchor to Left; then click OK to close the 
dialog box and return to the Canvas. 

4. Expand 2D Text 1.Animated on the Scene Graph to show the separate elements. The X Position in 
the Keyframe Graph and in the Properties > XYZ X Position start settings should indicate the 
following: 

X Position of A = (0)(7)/10 = 0 

X Position of B = (1)(7)/10 = .7 

X Position of C = (2)(7)/10 = 1.4 

A, being the anchor, has not changed start position; B's start position is 
offset by .7; and C's start position is offset by 1.4. 
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15. Clocks and Timers 

Clocks, Timers and Clock/Timer Properties 

Clock:  Tools Menu > Clock;  Chyron Toolbar >  

Timer:  Tools Menu > Timer;  Chyron Toolbar >  
Properties > Clock/Timer 

NOTE 
Multiple Clocks or multiple Timers can be simultaneously displayed on output.  A Clock 
and Timer, however, cannot be simultaneously displayed.  

Clock/Timer Setup 
On-screen Clock and count-up or count-down Timers can be created and run in specialized 2D Text 
Windows in Lyric.  Clocks and Timers can be composed of Lyric TrueType® fonts or RGB Fonts, and can 
display a variety of hour-minute-second formats.  Clock/Timer Formats are covered in depth later in this 
chapter. To place a Clock or Timer on the Canvas: 

 Select Clock or Timer from the Tools menu, or click the  or  icon.  Depending on which 
tool is selected, a Clock or Timer Window is placed on the Canvas.  Additionally, the Clock/Timer 
Properties tab, in which Clock/Timer parameters are set, is displayed.  
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Open a clock on the Canvas.  

The following illustration shows setup of a time-of-day clock with a bitmap background in the clock window.  
As with conventional text in 2D Text Window, fonts can be set and modified in the Font and 2D Font FX 
Properties windows. 

 

Clock and Clock Properties Tab 
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1. Enter a name for the clock that we will set up in this example.  Use the drop-down Name menu; use 
the drop-down Type menu to determine whether you will be setting up a Clock, an Up Timer or a 
Down Timer. It is strongly recommended that you use only names from the drop-down menu to the 
right of Name. You may enter any name you wish; the resulting clock or timer will use that name on 
the Scene Graph, Timeline and the clock's title bar on the Canvas. However, when multiple clocks 
and timers are being used, clocks or timers added with the buttons in the toolbar will pick up the 
program's automatic numbering scheme from the last time it was used. In the illustration below, the 
clock that was user-named "Local" was the fourth one created. However, the next clock added was 
automatically named "Clock 4" by the program.  

 

Multiple Clocks and Scene Graph 

2. Use the Add button to open new clock or timer windows from within the Clocks/Timers Properties 
tab. The Add button is disabled until a new name is input by hand. 

3. Next, specify the Clock’s Format. Some frequently-used formats have been configured and may be 
chosen from the drop-down menu at the Format edit box. The user can, however, enter any format 
that uses the system's specifiers properly. A common format is hh:mm:ss, which displays hours, 
minutes and seconds in 'leading zero' fashion when the values are less than ten (02:09:07), and the 
"hh" specified is preceded by a "0".  To strip leading zeroes from a Clock or Timer display, add -0 at 
the beginning of the format specification.  Clock/Timer Formats are covered in depth later in this 
chapter. 

The Make Persistent check-box causes the specified Clock or Timer (remember, more than one can be 
open at a time), to remain in the scene even if the Canvas is cleared or a new Lyric message is read. 

The Set Font and Set Background buttons work in familiar ways. Click the Set Font button and set the 
appearance of clock characters with the controls on the Font Toolbar, or return to the Font and 2D Font FX 
tabs in the Properties tab.  Use the Background button to open a dialog box for selection of bitmaps to use 
as a background image in the Clock or Timer window. Note that the user may not change a font while a clock 
or timer is running. 
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The Specify Timeline area allows the operator to set up each of the two separate animations used for 
moving a Clock or Timer on and off the screen. Select Anim In. Use the Timeline to determine time values 
in bringing the Clock or Timer on-screen, and use the Properties > XYZ menu or drag the clock on the 
Canvas (as you would a 2D Text Window) to determine its spatial movement. Click the Anim Out button to 
set the movement of the clock or timer off the Canvas. 

It is not necessary to control the movement of Clocks and Timers separately from other animations. If the 
entire scene is played with the Canvas' transport controls, Clocks and Timers will animate along with the 
other elements. This option can replace use of the Anim In and Out controls. 

When the Xfer or  button is clicked, any Clock or Timer in the scene will become visible on the video 
output. It should be noted that Clocks and Timers do not run on the  monitor screen of your Duet or PC. 
They will only function on the VGE output of Duet via the XFER or Duet tools buttons on the Lyric interface. 

(Remember that other actions such as playing an animation are equivalent to pressing the  button). 

The manual Show and Hide controls may also be used. Clocks transferred to the video output via the Xfer or 

 buttons immediately begin updating. However, Timers must be started manually. 
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In the Operate Clock/Timer area, the three large buttons are assignable; the Toggle Start, Toggle Show 
and Reset functions shown are simply the buttons' defaults. Any of the other functions may be selected from 
the pull-down menu and invoked with the Execute button. 

 

Timer Key/GPI Assignment and Clock/Timer Setting 
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A Countdown Timer running on a Duet SD/HD can be set to trigger a GPI OUTPUT when execution is 
completed. 

 

Timer Down Options 
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Note that the selected GPI appears in the Action as Timer Expires field. 

 

Action as Timer Expires 

To reassign the large buttons to functions other than their defaults, select Set Key/GPI and press Execute. 
The Timer Key/GPI Assignment dialog box opens. The Action pull-down at the top of this dialog box 
presents the same list of functions as the pull-down at the bottom of the Clock/Timer Properties tab. Select 
one and locate the large button in the Assign Function area to which you wish to assign the function. Click the 
button and it takes on the label of the function you have selected. Repeat this procedure with the two 
remaining buttons and click OK. The large buttons in the Clock/Timer tab take on these functions. See below 
for a complete list of these functions. 

Duet SD/HD systems can specify a GPI Out trigger when a countdown Timer had completed execution. 
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Clock and Timer Functions 

Function Description 

Start Starts updating the clock or timer. If the clock or timer is off the Canvas 
or otherwise hidden, the Start command does not display it. 

Stop Stops updating the clock or timer. If the clock or timer is shown, the Stop 
command does not hide it. 

Toggle 
Start 

Cycles between Start and Stop. 

Split 
(Lap) 

Continue updating the clock or timer, but if visible, maintain display of the 
time value at the moment the Split was invoked. 

Toggle 
Split 

Cycle between Start and Split. 

Reset Reset clock to the current time or the timer to a previously defined reset 
value. 

Show Makes the clock or timer visible. If the clock or timer is stopped, the 
Show command will not start it. Note: The SHOW command will erase 
the Frame Buffer on HD Duet systems. Hence, Lyric compositions 
combining clocks with other graphic elements are not usable on-air. 
Clocks or timers appearing alone on the Lyric Canvas may be used for 
keying over other video sources. 

Hide Makes the clock or timer invisible. If the clock or timer is running, the 
Hide command will not stop it. 

Toggle 
Show 

Cycles between Show and Hide.  

Anim In Executes any defined animation to bring the clock or timer on-screen.  
Anim In is not supported on Duet LE/LEX/PCI/PCI+. 

Anim 
Out 

Executes any defined animation to send the clock or timer off-screen. 

Toggle 
Anim 

Cycles between Anim In and Anim Out. 
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Any appropriate action for the clock or timer may be executed in one of three ways: 
 Selecting the desired action from the Operate Clock/Timer pull-down menu, and then pressing 

Execute. 

 Typing a Hotkey combination that has been previously defined. 

 Issuing any GPI event that has been previously set up to trigger the action.  

Once all clocks and timers have been set up, you may press the Save button to save all clock/timer formatting 
information as a Lyric Timer message. This message will contain only clock/timer formatting information, and 
will not represent all elements that were on the Scene Graph corresponding to the original composition in 
which the clock or timer appeared. 

Clock/Timer settings are also saved with a Lyric message when it is recorded.  

Any previous Lyric Timer messages may be recalled by pressing the Recall button in the Clock/Timer dialog 
box, by pressing the Read key or selecting Open on the File menu. This will cause the saved clocks/timers to 
be imported into the current scene without erasing any existing scene elements from the Canvas. If a 
standard Lyric message containing clocks is read, however, then the entire Canvas will be erased prior to 
reading the new message. Existing persistent clocks and timers will not be erased upon message read. 
Persistent Clocks and Timers can only be deleted from the Canvas with the Persistent Timers option in the 
Erase dialog box. 

However, DO NOT read a new Lyric message containing a clock while an existing clock is running and 
"shown" on the video output. Visible picture degradation on the video output will result. This limitation may be 
circumvented by hiding the clock or timer, or stopping it while keeping it visible, prior to reading a second 
Clock/Timer message. This assumes that Duet's video output is not on-air at the time! 

A quick method for recording a Clock/Timer file is as follows: 
1. Press Ctrl + Record.  The Record Only: dialog box opens. 

2. Select Clocks/Timers. 

3. Click Record.  The Clock/Timer settings are saved to the current Message Number in the Default 
Message Directory. 

A Hotkey combination can also be used to record the Click/Timer settings: 

 Press Ctrl + Record K Enter.  The Clocks/Timer settings are saved to the current Message 
Number in the Default Message Directory. 

Using the Timer Up function differs from a clock only insofar as the count begins at a zero value (typically 
hours, minutes, seconds and tenths of a second) instead from the current time of day. 

To use Timer Down, enter a value from which Lyric will count down, into the Reset Time edit box. 

You can enter a file name of a .wav file in the Sound Effect field which is played automatically when the a 
countdown Timer reaches 00:00:00.  Note that this function is not supported on Duet LE/LEX./PCI/PCI+ 
systems. 

 Click the Sound Effect checkbox to enable, then enter the name of the .wav file. 

See also Clock and Timer Formats. 

Unsupported Clock/Timer Functions - Duet LE/LEX/PCI/PCI+   
 The SS.FS Timer formats are not supported on Duet LE/LEX/PCI/PCI+ systems. 

 Anim In, Anim Out and the Operate Clock/Timer Select Action list box are not supported on Duet 
LE/LEX/PCI/PCI+ systems. 

 Sound Effect is not supported on Duet LE/LEX/PCI/PCI+ systems.  
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Clock/Timer Formats 

Clock Formats 
The format field for Clocks consists of a string of characters from the following set: 

Format Description 

WW Full current weekday (for example, Friday) 

W Abbreviated weekday (Fri) 

MM Full current month (August) 

M Abbreviated month (Aug) 

DD Current day of month (1-31; if this field is preceded by a ‘0’, then the day 
will be displayed with a leading zero) 

YY Full current year (1999) 

Y Abbreviated 2-digit year (99) 

Hh Current hour in 12-hour format; if this field is preceded by a ‘0’, then the 
hour will be displayed with a leading zero 

HH Current hour in 24-hour format; if this field is preceded by a ‘0’, then the 
hour will be displayed with a leading zero.  

Mm Current minute (0-59; if this field is preceded by a ‘0’, or a previously 
specified ‘hh’, then the minute will be displayed with a leading zero) 

Ss Current second (0-59; if this field is preceded by a ‘0’, or a previously 
specified ‘mm’, then the second will be displayed with a leading zero) 

N Meridian specifier (AM/PM) for 12-hour clocks 

+hh:mm Optional time zone offset which will be added to current time before 
display (for example +5 , +11) 

-hh:mm Optional time zone offset which will be subtracted from current time before 
display (for example -2 ,-12, -5 ) 
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Rules for Clock Use: 
 Except for literal fields (those enclosed in quotation marks), each format specifier may be used only 

once. 

 A leading zero may only be applied to the first specified time field (hh, mm or ss). 

 To strip leading zeroes from a Clock display, add -0 at the beginning of the format specification. 

 Meridian specifiers are invalid for 24-hour formats. 

 With the exception of the space quotation characters, formats cannot end with a field delimiter 
character. 

Timer Formats 
The format field for Timers consists of a string of contiguous characters from the following set: 

Format Description 

h Total hours (0-9). If this field is preceded by a ' 0 ', then the hours will be 
displayed with a leading zero. 

hh Total hours (0-99). If this field is preceded by a ' 0 ', then the hours will be 
displayed with a leading zero. 

hhh Total hours (0-999). If this field is preceded by a ' 0 ', then the hours will 
be displayed with a leading zero. 

m Total minutes (0-9). If this field is preceded by a ' 0 ', then the minutes will 
be displayed with a leading zero. If an hour field has been added, this 
format is invalid. 

mm Total minutes (0-99). If an hour field has been specified, then the minutes 
in the hour (0-59) will be displayed. Otherwise, if this field is preceded by 
a ' 0 ', then the minutes will be displayed with a leading zero. 

mmm Total minutes (0-999). If this field is preceded by a ' 0 ', then the minutes 
will be displayed with a leading zero. 

s Total seconds (0-9). If this field is preceded by a ' 0 ', then the seconds 
will be displayed with a leading zero. If a minute field has been specified, 
this format is invalid. 

ss Total seconds (0-99). If a minute field has bee specified, then the 
seconds in the minute (0-59) will be displayed with a leading zero. 
Otherwise, if this field is preceded by a ' 0 ', then the hours will be 
displayed with a leading zero. 

sss Total seconds (0-999). If this field is preceded by a ' 0 ', then the seconds 
will be displayed with a leading zero. 

f Fractional tenths of a second (0-9). This field is always displayed with a 
leading zero. 

ff Fractional hundredths of a second (0-99). This field is always displayed 
with a leading zero. 
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Rules for Timer Use: 
 Except for user-typed text, each format specifier may be used only once. 

 A leading zero may only be applied to the first specified time field. 

 To strip leading zeroes from a Clock display, add -0 at the beginning of the format specification. 

 Only the first specified time field may have 3-digit precision (hhh, mmm or sss). 

 With the exception of the space and quotation characters, formats cannot end with a field delimiter 
character. 

Flexible Display Formatting for Clocks and Timers 
To facilitate international display of time and date, clock and timer fields may be specified in any order and 
separated by any of the following delimiter characters: space, period (" . "), comma (" , "), semicolon (" ; "), 
colon (" : ") or forward slash (" / "). 

Also, user-typed characters may be added to the clock or timer display’s automatically generated characters. 
These characters must be input by the user in quotation marks and will appears exactly as input.  For 
example, a clock might be modified hh:mm:ss "EDT". A timer display could be formatted hh:mm:ss "Quartz-
Precise Timing". 

 



 

 16-1 

16. 2D Objects 

2D Objects 

Tools Menu > Graphic;  Chyron Toolbar > ;  File Menu > Open;  Browser > Bitmap Assets 

Supported Graphic Formats 
2D graphics, also known as bitmaps, are widely used in Lyric compositions.  They can act as objects in 3D 
space, placed in 2D Text Windows as 2D font characters, applied to 2D text Faces/Edges and 3D character 
and object surfaces, and used as Backgrounds for the entire Canvas, a 2D Text Window, or a 2D Text 
Template.  Lyric can import over 30 distinct 2D file types.  The following 2D graphics formats can be imported 
onto the Lyric Canvas. 

 

Select a Graphic Dialog Box Showing Supported Graphic Formats 
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 CHY (*.chy) is no longer supported. 

 The Apply to Background setting in the Select a Graphic dialog box is not currently implemented.  
For information on importing a 2D bitmap as a Background for a 2D Text Template, 2D Text 
Window or the Canvas, refer to the chapter on Color, Transparency, Background, Lighting and 
Texture:  Backgrounds. 

 For information on applying a 2D bitmap to a 2D font, refer to the chapter on Creating and Using 
Fonts in Lyric:  2D Font FX Properties. 

 For information on applying a 2D bitmap to a 3D character or object surface, refer to the chapter on 
Color, Transparency, Background, Lighting and Texture:  Surface Properties. 

Importing a 2D Bitmap Graphic 
2D graphics can be imported in a variety of manners: 

 From the Tools menu. 

 From the Import Graphic icon in the Chyron Toolbar. 

 From the Browser Bitmap Assets Window, double-click an image in the Browser, or drag-and-drop 
it from the Browser to the Canvas.  Refer to the section on Browser:  Bitmap Asset Operations for 
additional information. 

To import a 2D graphic: 

1. Click on the  icon in the Chyron Toolbar, or from the Tools menu, select Graphic.  The Select 
a Graphic File dialog box is displayed. 

 

Selecting a Graphic File 

2. Navigate to the desired file, and then enter the file name in the File Name field.  If the directory 
contains files of multiple formats, select the desired format in the Files of Type field.  Only files of the 
selected format are displayed.  When a graphic is selected, the image's Width, Height, and bit depth 
appear at the lower right corner of the dialog box.  If Preview is selected (checked), a bitmap 
preview, if available, is displayed. 
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3. If the selected file is any format but Adobe® Photoshop® PSD (*.psd), skip this step.  A Photoshop file 
can be imported as a single graphic with all layers merged, or as separate 2D graphic objects.  To 
merge to a single layer on import, select (check) the Merge Layers checkbox.  To import separate 
layers as individual objects, deselect (uncheck) Merge Layers. 

4. Click Open.  The image is imported to the Canvas.  When imported, the Scene Graph shows the file 
name of the object.  If Photoshop layers are imported, the layers all share the same object name, 
followed by layer numbers. 

 

Scene Graph Showing Graphic Import of Photoshop Layers 

The cursor position on the Canvas determines how the 2D graphic is treated in the composition. 

 If the cursor is in 3D space when the 2D object is imported, i.e. not in a 2D Text Window, it is treated 
as an independently animatable object.  Right-clicking on the object accesses the 2D object context 
menu, in which various tools available.  Of particular importance is the 2D Object Template dialog 
box, in which the 2D object properties are displayed, and in which Intelligent Interface and DBLink 
parameters can be set.  This 2D object context menu is covered later in this chapter.  

 If the cursor is in a 2D Text Window when the 2D object is imported, it becomes locked to a baseline 
and is treated as a 2D text character in how it can be animated. 

The Backspace  key can be used to delete only the most recently imported object.  To delete a different 
object: 

 Select the object, then click , press Ctrl + Delete or select Delete from the Edit menu. 

About Imported Graphics 
On a Lyric Canvas, imported graphics appear as though printed on a sheet of paper. As such, graphics may 
be freely positioned, scaled and rotated.  

A graphic created in a resolution different from the current Canvas Resolution may result in a stretched or 
squashed appearance when imported.   If this occurs, correct the Use 1:1 Pixel Aspect for Graphics Import 
setting and reimport the graphic.  Refer to Getting Started - Canvas Resolution for details on setting these 
parameters. 
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Enable Bounding Box - Selecting 2D Graphics 
2D Object Context (Right-Click) Menu > Enable Bounding Box 
Flipbook Object Context (Right-Click) Menu > Enable Bounding Box 
Selecting an Object Using a Bounding Box 
Enable Bounding Box allows for the selection of a 2D bitmap object, including a Flipbook frame.  A 
Flipbook is a collection of bitmap images that play back as an animation.  Once selected, the object can be 
scaled, rotated and moved forward in backward along Z-axis. 

To enclose a bitmap object or Flipbook image in a bounding box: 
1. Click on the object in the Canvas, or highlight its listing in the Scene Graph. 

2. Select Enable Bounding Box from the context menu.  A box appears around the object, and a check 
mark appears next to the Enable Bounding Box item in the menu.  Note that if a Flipbook is 
selected, the Bounding Box is defined by the boundaries of the Canvas, even if Clip to Safe Title is 
selected when the Flipbook is saved.  Refer to Tools Menu:  Flipbook for additional details on 
saving options. 

 

Bounding Box Around a 2D Bitmap Object 

3. Use one of the following methods to transform the object or objects (see below). 

 Select a Transform Tool from the Transform Toolbar, then click-and-drag any of the blue 
handles to move, scale, rotate or change the center of rotation of the object. 

 Change the settings in Properties > XYZ. 

When an object that has a Bounding Box is deselected, the Bounding Box disappears, but remains 
enabled.  It reappears when the object is reselected. 

Selecting Multiple Objects Using Bounding Boxes 
Multiple objects can be transformed at the same time. 

1. Enable the Bounding Box on each of the objects. 

2. Use one of the following methods to select the objects: 

 Press and hold Ctrl, then on the Canvas, click on each object that is to be transformed. 

 In the Scene Graph, press and hold Shift, then click on each object that is to be 
transformed.  Note that these objects must be consecutively listed. 

3. Apply a transform as described above. 

 If the objects are not grouped using the Group Tool  or Tools > Group, they will 
transform independently.  For example, if three objects are selected and a rotation is applied, 
they will rotate around their own axes. 

 If the objects are grouped using the Group Tool  or Tools > Group, they will transform 
as one entity.  For example, if three objects are selected and a rotation is applied, they will 
rotate as one object around one axis. 
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Disabling a Bounding Box 
  To disable a Bounding Box: 

1. Click on the object in the Canvas, or highlight its listing in the Scene Graph. 

2. Select Enable Bounding Box from the context menu.  The Bounding Box disappears from around 
the object, and the check mark disappears from next to the Enable Bounding Box item in the menu. 

Saving a 2D Bitmap Graphics File 
The currently displayed composition on the Canvas can be saved in a variety of supported graphics formats.  
To save a graphic file: 

1. From the File menu, select Save As.  The Save Animation dialog box opens.  Note that although it 
is possible to save the file as an animation, that in this example, only one frame will be saved as a 
static graphic. 

 

Saving a 2D Object 

2. Select a file format from the Save as Type drop-down list box.  In the preceding figure, the Adobe® 
Photoshop® *.psd format is selected. 

3. In the Start Frame and End Frame fields, make sure that the values match, as only one frame is 
saved. 

4. Optional:  Adjust values for Image Width and Image Height. 

5. Field Render is currently not implemented and not applicable to static graphics. 

6. Optional:  Select (check) Clip to Safe Title.  If Clip to Safe Title is not selected, the contents of the 
entire Canvas is recorded as the graphic.  If Clip to Safe Title is selected, only the contents within 
the Safe Title Area are recorded as the graphic.  The Safe Title Area can be adjusted in the Safe 
Title Adjust dialog box, accessed from Config Menu > Safe Title Adjust.  
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7. Save RGB is always active.  RGB information is always saved. 

8. Optional:  Select (check) Save Alpha.  This is available for those file formats where the Alpha 
(transparency) information can be saved as part of the graphics file (such as Adobe® Photoshop® 
*.psd).  If Save Alpha is not selected, the Alpha information is not saved with the file.  If Save Alpha 
is selected, the Alpha information is saved with the file.  See example immediately following this 
operation. 

9. Enter a File Name. 

10. Click Save.  The graphic is saved to the selected file format. 

When the Alpha information is saved, it can be displayed and modified in a program such as Adobe® 
Photoshop® when the file is opened. 

 

Alpha Channel Displayed in Adobe® Photoshop® 
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Bitmap Asset Operations 

Browser > Click ;  Browser Menu > Show Bitmap Assets 
The Bitmap Asset Browser enables quick import of Lyric-supported graphics to the Canvas, additions of 
graphics to the Browser database and cataloging of Bitmap Assets.  The Bitmap Asset Browser supports 
drag-and-drop of graphics to the Canvas or a 2D Text Window in the Canvas, from one Browser window to 
another Browser window, and from Windows® Explorer®-type windows into the Browser.  The Bitmap 
Asset Browser also supports drag-and-drop of graphics into the background of the Canvas, a 2D Text 
Window or a 2D Text Template. 

Lyric also provides the ability to edit the Bitmap Asset information (metadata), delete the Bitmap Asset from 
the database, and update the Bitmap Asset when changes are made to the graphic.  Browser Bitmap 
Asset entries contain information such as Author, Title, Comments, Keywords and Date Modified. 

The use of the term bitmap in this context refers to all graphic formats supported by Lyric, and is used 
interchangeably with the terms graphic and bitmap graphic. 

Adding a Lyric Bitmap to the Browser Database 
When a bitmap is added to the database, what is stored in the database is not the bitmap itself, but rather the 
information about the bitmap.  This includes searchable metadata and the path information to the bitmap.  It 
does not, however, include the graphic itself.  The Browser simply references the graphic.  This makes it 
possible for the same bitmap to be referenced by virtually an unlimited number of Browser databases. 

Adding a Bitmap to the Browser from the Canvas 
To add a bitmap to a Browser from the Canvas: 

1. Select the graphic from either the Canvas or the Scene Graph.  The name of the graphic should be 
highlighted on the Scene Graph. 

2. Click  or select Save to Database from the Browser menu.  The icon/text listing for the graphic 
is added to the Browser window. 

Adding a Bitmap to the Browser from Another Browser 
To add a bitmap to a Browser window from another Browser window: 

 Drag-and-drop the graphic from the originating Browser window to the destination Browser window. 

Adding a Bitmap to the Browser from a Windows® Explorer®-Type Window 
To add a bitmap from a Windows® Explorer®-type windows into the Browser window: 

 Drag-and-drop the graphic or a group of graphics from the Windows® Explorer®-type window to the 
Browser window. 

Loading a Bitmap Graphic from the Browser 
Loading a Bitmap from the Browser to the Canvas or 2D Text Window 
To load a Bitmap Asset from the Browser to the Canvas or a 2D Text Window, make the Canvas or 2D 
Text Window in the Canvas active, then choose one of the following methods: 

 Double-click the icon/text listing for the graphic. 

 Select (click or by cursor) the Bitmap Asset, then click  or select Load from Database from the 
Browser menu. 

 Select (click or by cursor) the Bitmap Asset, then press Enter. 

 Drag-and-drop the Bitmap Asset to the Canvas or into the 2D Text Window. 

The Bitmap Asset loads to the Canvas. 



Lyric User Guide 

 16-8 

Loading a Bitmap as a Background 
To use a Bitmap Asset as a background for the Canvas, a 2D Text Window or 2D Text Template: 

1. Hold the Alt key while dragging-and-dropping a Bitmap Asset into the Canvas, a 2D Text Window 
or 2D Text Template.  The following menu is displayed. 

 

Background Menu 

2. Select one of the two options from the Background menu. 

 Select Stretch to Fit to stretch the graphic to fill the Canvas, 2D Text Window or 2D Text 
Template.  Note that the aspect ratio of the graphic may change, distorting its appearance.  

 Select Center to place the graphic in center of the background of the Canvas, 2D Text 
Window or 2D Text Template.  The size and aspect ratio of the graphic remain unchanged. 

For additional information on backgrounds, refer to the section on Background. 

Applying a Bitmap Asset as a Texture for a 3D Character or 3D Object 
To apply a Bitmap asset as a Texture for a 3D character or 3D object: 

 Drag-and-drop the Bitmap asset to the Texture Chip in the Properties > Surface tab.  Refer to 
Surface Properties for additional details. 

 

Dragging-and-Dropping a Texture from the Browser 
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The Bitmap Asset Context Menu 
Information (metadata) about the Bitmap Asset can be edited via the Bitmap Asset context menu.  A 
Bitmap Asset can also be updated or deleted.  To access this menu: 

 Right-click on the Bitmap Asset. 

 

Bitmap Asset Context Menu 

Edit 
A Bitmap Asset consists of the metadata, which is information about the bitmap, as well as a path to the 
bitmap.  The user-defined metadata enables easier access to the bitmap by providing the means to easily 
search as well as identify the function of the bitmap. 

 

Graphic File Information Dialog Box 
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Contents of the Graphic File Information fields are reflected in the Browser Text View and Icon/Text View 
displays. 

 

Browser Showing Bitmap Information 

There are both user-defined and non-editable parameters in the Graphic File Information dialog box.  The 
non-editable parameters are determined on creation/modification of the font. 

Parameter Description 

Author Identifies the author of the graphic. 

Title Identifies the title of the graphic.  By default, it reflects the file 
name, but can be edited.  The file name does not reflect any 
change to the Title. 

Comments Information can be typed in the Comments field to further define 
use or provide other details. 

The Comments field can accommodate 255 characters.    
Pressing Enter performs the same function as clicking OK, so it 
cannot be used to start a new line.  To insert a carriage return in 
the field: 

 Press Ctrl + Enter. 

Keywords Keywords that can be used for Browser Search purposes. 

Subject Identifies the subject of the graphic, e.g. news. sports, weather, 
etc. 

Last Modified Indicates date that the graphic was last modified.  Information 
field only - not editable from within this dialog box. 

Path and File Identifies the path to the file. 

OK or press Enter Applies the parameter settings to the Bitmap Asset.  

Cancel Cancels the application of the settings to the Bitmap Asset. 
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Delete 
The Delete function enables deletion of a Bitmap Asset from the database.  Deleting a Bitmap Asset from a 
Browser database does not delete the graphic itself, only the reference to the graphic. 

To delete a graphic from a Browser database: 
1. Right-click on the Bitmap Asset icon/text listing, then select Delete from the context menu. 

OR 

Select (click) the Bitmap Asset, then press Delete on the PC keyboard or Delete Character on the 
Duet keyboard. 

The following prompt is displayed. 

 

Delete Bitmap Asset Prompt 

2. Click Yes to confirm the deletion of he graphic from the Browser database.  The following prompt is 
displayed: 

 

Delete Bitmap File Prompt 

3. Click Yes to delete the graphic file from disk, or No to preserve the graphic file. 

IMPORTANT! 
Selecting Yes permanently deletes the original graphic file.  Before deleting the file from 
disk, make sure that it is not referenced by other Browser databases!  There is no Undo 
for this operation! 

Update 
The Update function for Bitmap Assets is not currently implemented. 

Comments, Keywords 
These items are informational only.  To edit, select Edit in this menu. 

Searching Bitmap Assets 
To narrow down the assets in a Browser database, Bitmap Assets can be searched, based on a search 
strings (Author, Title, Comments, Subject, etc.), Modification Date, etc.  Refer to Searching the Browser 
for details on the Search tool. 
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2D Object Templates 
2D Object Context (Right-Click) Menu > 2D Object Properties 
Also is displayed when bitmap is imported. 

Overview 
Each 2D object imported into Lyric has a number of attributes that can be set.  To view these attributes: 

 Right-click on a 2D object (bitmap graphic) or its listing in the Scene Graph. For this example, a 
graphic of an arrow (shown below) is used.  Select 2D Object Properties from the context menu.  
The 2D Object Template dialog box is displayed.  For the purposes of illustration, it is split into two 
parts. 

 

2D Object with 2D Object Template Dialog Box 

Setting 2D Object Properties 
Name 
By default, the Template Name is the file name.  The Template Name can be changed.  Note that changing 
the Template Name does not change the file name. 

II Update 
Enabling (checking) II Update allows for the 2D Object Template to be updated by Intelligent Interface 
commands sent from a remote computer.  A common example of this application is to display sports scores, 
using Intelligent Interface to update both the scores (2D Text Templates) and the team logos (2D Object 
Templates).  Refer to the section on Intelligent Interface for additional details. 

To enable/disable II Update: 
 Select (check)/deselect (uncheck) the II Update checkbox. 

Refer to Intelligent Interface for in-depth information on these commands.  

NOTES 
When receiving W commands to update 2D Object Templates, be careful about mixing 
Template fields enabled for DB Link with Template fields marked for Intelligent Interface 
Update.  If DB Link is enabled for a particular Template(s) when the Template Data 
message is read, the Template(s) will update as per the Intelligent Interface command, 
but then immediately update again using data from the linked database.  This occurs 
even if the Template is marked for Intelligent Interface Update, i.e., the DB Link data 
overrides the Intelligent Interface data. 



 2D Objects  

 16-13 

This is also the case for the U command that updates the data in a single Template in a 
Template Data Message.  The DB Link Enable setting, however, does not affect the 
execution of the U\* command which updates a specified Template without reloading the 
Template Data Message. 

Ext. Update 
When a Lyric message is containing a Template(s) marked for External Update is read, the system running 
Lyric sends an X command requesting Intelligent Interface Update to the host system.  Additionally, the 
following prompt is displayed: 

 

Waiting for Update Prompt 

The host computer then sends an R command to update the marked Template(s).  2D Object Properties 
settings are updated after an image is updated via Intelligent Interface. 

To enable/disable Ext. Update: 
 Select (check)/deselect (uncheck) the Ext. Update checkbox. 

Note that when Ext. Update is enabled, II Update is automatically enabled as well.  

Refer to the section on Intelligent Interface for additional details. 

Disable Interface Fields 
Edit Menu > Disable Interface Fields;  Alt + U 
Disable Interface Fields disables Intelligent Interface® External Update of all 2D Text Templates and 2D 
Object Templates in the entire Lyric composition.  When a Lyric message is containing a Template(s) 
marked for External Update is read, the system running Lyric does not send an X command requesting 
Intelligent Interface Update to the host system.  Disabling Interface Fields does not affect, however, the 
ability of 2D Text Templates to be updated via other Intelligent Interface commands.  It does, however, 
disable the ability of 2D Object Templates to be updated via other Intelligent Interface commands. 

To execute: 
1. Select Disable Interface Fields from the Edit menu, or press Alt + U.  The following prompt is 

displayed. 

 

Disable Intelligent Interface Fields Prompt 

2. Click Yes to disable or No to cancel. 
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DB Link 
2D Text Templates and 2D Object Templates can draw text and 2D objects (bitmap graphics), respectively, 
from any ODBC-accessible database that is available to the system on which Lyric is running.  Each time a 
message containing linked Templates is read, Lyric checks the database, so that any change in the linked 2D 
Text Templates or linked 2D objects updates the Canvas.  Text and graphic updates can be performed from 
the same database in real time for up-to-the-minute news, election and sports coverage.  Refer to the chapter 
on 2D Text Templates, in the section on DB Link - Using DB Link to Replace Graphics. 

Update DB Link Fields 
Edit Menu > Update DB Link Fields 

To update all DBLink fields with the latest data from the data source without having to save and re-read the 
message: 

 Select Update DBLink Fields from the Edit menu. 

Disable DB Link Fields 
Edit Menu > Disable DB Link Fields 

When DBLink Update capability has been set up in a Lyric message, selecting Disable DBLink Fields turns 
off the DBLink attribute for all 2D Text Templates and 2D Object Templates in the message, although the 
database links remain as set.  Templates do not update from a database when the message is read or 
Update DBLink Fields is selected.  To execute: 

1. Select Disable DBLinks from the Edit menu.  The following prompt is displayed. 

 

Disable DB Link Popup 

2. Select Yes to Disable DB Link for the message, or No to cancel. 

To re-enable DB Link: 
1. Select the 2D object in the message, then right-click on the object.  The 2D Object Template dialog 

box is displayed. 

2. Click the DB Link button.  Note that the Enable checkbox is not enabled (checked). 

3. Click the Enable checkbox to re-enable DB Link capability.  Repeat the process for other 2D objects 
that are to be enabled for DB Link. 

Refer to the section on 2D Text Templates for information on re-enabling DB Link for 2D Text Templates. 

Object Parameters 
Object parameters describe the actual and scaled height and width of the bitmap.  All Object parameters are 
reflective of settings that are specified outside of the 2D Object Template Dialog Box, and cannot be 
changed from within the 2D Object Template Dialog Box. 

 Actual Height:  Specifies the original height in pixels of the bitmap.  Matches Bitmap Height 
parameter. 

 Actual Width:  Specifies the original width in pixels of the bitmap.  Matches Bitmap Width 
parameter. 

 Scaled Height:  Specifies the scaled height in pixels of the bitmap. 

 Scaled Width:  Specifies the scaled height in pixels of the bitmap. 
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Bitmap Parameters 
The Bitmap parameters provide information about the bitmap.  Except for Embed Image Data, all Bitmap 
parameters are reflective of settings that are specified outside of the 2D Object Template Dialog Box, and 
cannot be changed from within the 2D Object Template Dialog Box. 

 File Name:  Specifies the path to the bitmap. 

 Embed Image Data:  Embed Image Data specifies whether or not complete image data is included 
with a saved Lyric message. 

o When enabled (checked), all image data is saved with the Lyric  message.  This results in 
longer load time, as well as requiring disk space to store the image data each time it is 
embedded in a Lyric message. 

o When disabled, only data about the image, but not the image itself, is stored with the Lyric 
message.  It is instead referenced whenever the Lyric message is read.  This speeds load 
time.  It requires, however, that the image be available at the specified path when the 
message is read. 

 Height:  Specifies the original height in pixels of the bitmap.  Matches Object Original Height 
parameter. 

 Width:  Specifies the original width in pixels of the bitmap.  Matches Object Original Width 
parameter. 

 Type:  Depth of the bitmap in bits.  32-bit indicates the presence of alpha. 
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2D Object Context Menu 
Right-Click the Bitmap Graphic or the Graphic's Listing in the Scene Graph 

Right-clicking on a bitmap displays a Context menu, also known as a right-click menu, which makes available 
a variety of functions related to bitmap operations.  Note that all items in the menu are displayed as active.  
During Lyric operation, various items may be grayed out depending on active function and the system on 
which Lyric is installed. 

 

2D Object Context Menu 

The following provides a brief description of each of the menu items: 
 Object Name and Type:  The first item in an object's context menu displays the object's name and 

type.  Refer to Navigating and Entering Information in Lyric:  Object Name and Type for details 
on renaming objects. 

 Show 2D Object Properties:  Show 2D Object Properties opens the 2D Object Template dialog 
box, in which information about the physical properties are displayed and file path.  Additionally, 
update parameters can be set.  Refer to Show 2D Object Properties later in this chapter for 
additional information. 

 Position Lock On:  The Position Lock On setting specifies whether or not an object (2D Text 
Window, 2D or 3D object, etc.) can be moved on its X, Y or Z axes, as well as rotated, scaled or 
have its center of rotation changed.  Refer to the chapter on Position, Rotation, Scale and 
Orientation for additional information. 
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 Enable Bounding Box:  Enable Bounding Box allows for the selection of a 2D bitmap object, 
including a Flipbook frame.  A Flipbook is a collection of bitmap images that play back as an 
animation.  Once selected, the object can be scaled, rotated and moved forward in backward along Z-
axis.  Enable Bounding Box is covered earlier in this chapter. 

 Squeezeback - Duet SD:  Squeezeback (Duet SD only) enables the creation of regions in a Lyric 
composition that can be displayed up to full-screen, with no loss of video quality.  Squeezeback 
effects are created on the optional Squeezeback Board.  Because Squeezeback effects are 
processed on its own board, manipulation of Squeezeback video has fewer effects on the behavior of 
other elements in a Lyric composition than similar Video Region effects created on the Duet's VGEs.  
Refer to the chapter on Squeezeback - Duet SD for additional information on Squeezeback.  Refer to 
the chapter on the Tools Menu:  Video Region for information on Setting up a Video Region effect. 

 Advanced Image Effects:  Lyric's Advanced Image Effects capability allows sophisticated effects 
to be applied to imported bitmaps or entire 2D Text windows.  Advanced Image Effects include 
Curtain, Explosion, Focus, Leaf, Matrix, PageRoll, PageTurn, Ripple, Slide, Venetian, Zoom and 
Wipe and more.  Note that on Duet SD systems, Advanced Image Effects, which apply an effect to 
an entire page, are available via Multi FX.  Refer to the chapter on Advanced Image Effects for 
additional information. 

 Mask Object:  Mask Objects function somewhat differently on Duet SD/HD/Offline systems versus 
Duet LE/LEX/PCI/PCI+ systems. 

o Duet SD/HD/Off-Line:  An image specified as a Mask Object displays at 100% video, and 
cuts through the elements over which it is positioned and the background.  Built-in 
transparent areas of a Mask Object allow video input to show through.  Refer to the chapter 
on Masks:  Mask Objects - Duet SD. HD and Off-Line for additional information. 

o Duet LE/LEX/PCI/PCI+:  An image specified as a Mask Object displays at the transparency 
set in Properties > Surface combined with built-in transparency, and covers the object over 
which it is positioned.  Mask Layers, Mask Inside and Alpha Trim Mask are supported on 
Duet LE/LEX/PCI/PCI+ systems.  Transparent areas of a Mask Object allow video input to 
show through.  Refer to the chapter on Masks:  Mask Objects - Duet LE/LEX/PCI/PCI+ for 
additional information. 

 Copy/Paste Animation State:  Copy/Paste Animation State enables animation attributes such as 
Position, Rotation, Scaling, etc., to be copied from one object and pasted to another.  Refer to the 
chapter on Animation for additional information. 

 Mask-To Layer, Mask Inside, Alpha Trim Mask, Soft Mask - Duet LE/LEX/PCI/PCI+:  Mask-To 
Layer, Mask Inside, Alpha Trim Mask and Soft Mask are advanced Mask functions available to 
Duet LE/LEX/PCI/PCI+ systems.  Refer to the chapter on Masks:  Mask Objects - Duet 
LE/LEX/PCI/PCI+ for additional information. 

 Show Center of Rotation:  The Center of Rotation for an object can be displayed on the Canvas 
for ease of editing.  Refer to the chapter on Position, Rotation, Scale and Orientation - Transform 
Tools for in-depth information. 

 Motion Path:  The path of an object as it progresses through an animation can be graphically 
displayed on the Canvas.  The Motion Path can be edited, keyframes added and deleted, 
acceleration set and interpolation specified from the Canvas.  Refer to the chapter on Animation - 
Motion Paths for in-depth information. 

 Internal Properties:  Properties of an object or a message can be tailored to a specific composition 
or playback situation.  The Internal Properties accessed from this menu are applied to the selected 
object.  They include Alpha Trim, Depth Test, Depth Write, Lighting and Pixel Aspect. 
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Movie Objects - Duet LE/LEX/PCI/PCI+ 
Tools and Canvas/Scene Graph Context Menu > Movie 
Animation files on Duet LE/LEX/PCI/PCI+ can be imported into a Lyric composition as Movie objects.  As the 
Movie object plays its own animation, it can be moved, scaled and rotated through 3D space.  Unlike clip 
files, which require access to the source files and the system on which to play them (e.g. an Aprisa DDR), 
imported Movie objects are self-contained.  Movie Objects are limited to 250 lines in height. 

To import a Movie object: 

1. From the Tools menu, select Movie.  The Movie Properties dialog box opens. 

 

Movie Properties 

2. Enter a movie file name in the Movie File field, or navigate to and select a 24-bit or higher Movie 
(*.avi, *.mov), AVI (*.avi) or Quicktime (*.mov) file. 

3. Optional:  If the file is to loop (play continuously), select (check) Loop.  The default setting is 
selected.  If Loop is not selected, the animation plays through only one time. 

4. Optional:  To cut rendering time, select (check) Frame Based.  Preview the animation before air, as 
the quality could be compromised if the animation is frame-based instead of field-based.  The default 
setting is deselected. 

5. Optional:  Select (check) Enable Preview to view selected frames of the animation or to scrub 
through the animation.  The default setting is selected.  The Preview area features a non-editable 
FPS (frame per second) field which displays the frame rate of the animation.  The Preview Window 
displays a frame of the animation as specified by the Goto function.  It also previews the animation 
when the scrub slider, located directly beneath the Preview Window, is dragged.  The Frame 
Counter displays the current frame of the animation.  
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6. Enter a frame number in the First Frame frame counter to set the start frame of the animation.  To 
preview the entered frame, click Goto.  If Enable Preview is selected, the frame is displayed in the 
Preview Window.  Click Set to apply the value.  The default First Frame is the first frame of the 
animation file.  Note that setting frame numbers different from the first and last frames of the 
animation file does not modify the source file.  These settings affect only what is imported into Lyric.  
The source file remains unchanged. 

7. Enter a frame number in the Last Frame frame counter to set the end frame of the animation.  To 
preview the entered frame, click Goto.  If Enable Preview is selected, the frame is displayed in the 
Preview Window.  Click Set to apply the value.  The default Last Frame is the last frame of the 
animation file. 

8. Optional:  If Loop is enabled, enter the frame number to which the animation should loop once it 
reaches the end of the animation.  To preview the entered frame, click Goto.  If Enable Preview is 
selected, the frame is displayed in the Preview Window.  Click Set to apply the value.  The default 
Loop-To Frame is the first frame of the animation file.  The following figure shows a movie file about 
to be placed on the Canvas. 

 

Movie Object Selected for Import 

9. Click OK to import the movie file to the Canvas. 
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When a movie file is imported to the Canvas, it becomes a Movie object, and is added to the Scene Graph 
and Timeline as well.  Right-clicking on the Movie object displays its context menu. 

 

Movie Object Context Menu 

The following provides a brief description of each of the menu items: 
 Object Name and Type:  The first item in an object's context menu displays the object's name and 

type.  Refer to Navigating and Entering Information in Lyric:  Object Name and Type for details 
on renaming objects. 

 Show Movie Properties:  Show Movie Properties opens the Movie Properties dialog box, in which 
Movie object parameters can be modified.  

 Position Lock On:  The Position Lock On setting specifies whether or not an object (2D Text 
Window, 2D or 3D object, Movie object, etc.) can be moved on its X, Y or Z axes, as well as rotated, 
scaled or have its center of rotation changed.  Refer to the chapter on Position, Rotation, Scale and 
Orientation for additional information. 

 Enable Bounding Box:  Enable Bounding Box allows for the selection of a 2D bitmap object, 
including a Flipbook frame.  Once selected, the object can be scaled, rotated and moved forward in 
backward along Z-axis.  Enable Bounding Box is not implemented for Movie objects.  Enable 
Bounding Box is covered in the chapter on 2D Objects. 
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 Squeezeback - Duet SD:  Squeezeback (Duet SD only) enables the creation of regions in a Lyric 
composition that can be displayed up to full-screen, with no loss of video quality.  Squeezeback 
effects are created on the optional Squeezeback Board.  Because Squeezeback effects are 
processed on its own board, manipulation of Squeezeback video has fewer effects on the behavior of 
other elements in a Lyric composition than similar Video Region effects created on the Duet's VGEs.  
Squeezeback is not implemented for Movie objects.  Refer to the chapter on Squeezeback - Duet 
SD for additional information on Squeezeback.  Refer to the chapter on the Tools Menu:  Video 
Region for information on Setting up a Video Region effect. 

 Advanced Image Effects:      Lyric's Advanced Image Effects capability allows sophisticated 
effects to be applied to imported bitmaps or entire 2D Text windows.  Advanced Image Effects 
include Curtain, Explosion, Focus, Leaf, Matrix, PageRoll, PageTurn, Ripple, Slide, Venetian, 
Zoom and Wipe and more.  Note that on Duet SD systems, Advanced Image Effects, which apply 
an effect to an entire page, are available via Multi FX.  Refer to the chapter on Advanced Image 
Effects for additional information. 

 Copy/Paste Animation State:  Copy/Paste Animation State enables animation attributes such as 
Position, Rotation, Scaling, etc., to be copied from one object and pasted to another.  Refer to the 
chapter on Animation for additional information. 

 Mask Object (Duet LE/LEX/PCI/PCI+):  An image specified as a Mask Object displays at the 
transparency set in Properties > Surface combined with built-in transparency, and covers the object 
over which it is positioned.  Mask Object, Mask Layers, Mask Inside, Alpha Trim Mask and Soft 
Mask are supported on Duet LE/LEX/PCI/PCI+ systems.  Transparent areas of a Mask Object allow 
video input to show through.  Mask Object, Soft Mask and Alpha Trim Mask are not currently 
implemented for Movie objects.  Refer to the chapter on Masks:  Mask Objects - Duet 
LE/LEX/PCI/PCI+ for additional information. 

 Show Center of Rotation:  The Center of Rotation for an object can be displayed on the Canvas 
for ease of editing.  Refer to the chapter on Position, Rotation, Scale and Orientation - Transform 
Tools for in-depth information. 

 Motion Path:  The path of an object as it progresses through an animation can be graphically 
displayed on the Canvas.  The Motion Path can be edited, keyframes added and deleted, 
acceleration set and interpolation specified from the Canvas.  Refer to the chapter on Animation - 
Motion Paths for in-depth information. 

 Internal Properties:  Properties of an object or a message can be tailored to a specific composition 
or playback situation.  Internal Properties is not available to Movie objects. 
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Flipbook Animation 
To Save:  Create Animation, then File Menu > Save As Targa (*tga) 
To Read to Canvas:  Tools Menu > Flipbook 
A Lyric Flipbook animation is a series of targa (.tga), .tif or .bmp files, pre-loaded into memory and played out 
in sequence, much like the old-time paper flipbooks.  In a Flipbook animation, each bitmap image appears 
for 1 frame of video.  Flipbook animations can be created on the Duet platform, or on off-line PCs, typically 
using third-party animation applications such as SoftImage or 3D Studio.  Flipbook animations can also be 
created within Lyric itself. 

Flipbooks can be created in the .tga, .bmp or .tif format.  It is recommended that the .tga format be used for 
Flipbook creation, as it can carry Alpha (Transparency) information.  If the Flipbook image is rectangular 
with no Transparency, it could be saved in a .bmp format.  Be aware, however, that Alpha information is not 
supported by the .bmp format.  Creating a Flipbook in a .tif format is generally not recommended, due to the 
large size of uncompressed .tif files.  The .tif file format does support Alpha. 

For Duet playback, multiple Flipbook objects can be added to Lyric's Scene Graph, provided there is 
sufficient texture memory on Duet's VGE board(s).  In addition, these objects can be keyframed and animated 
using Lyric Transform Tools (Position, Scale, Rotate, Center of Rotation). 

A Flipbook animation on the Canvas is known as a Flipbook Region.  Flipbook Regions are objects that 
may be manipulated in the same ways as bitmaps and 2D Text/Roll/Crawl windows (Rotation, Position and 
Scale on X, Y and Z axes, etc.). 

Flipbook Regions can also act as Mask Objects (all systems), and on Duet LEX/LEX/PCI/PCI+ systems, be 
assigned to a Mask Layer, and have an Inside Mask and/or Alpha Trim Mask applied. 

In this exercise, we will first create a simple Flipbook animation using Lyric itself to produce a series of Targa 
files.  We will then open a Flipbook region containing this animation, and incorporate that region into another 
composition. 

1. Create a 1-second animation that rotates text in a 2D Text Window, finishing at its original position.  
This animation rotates 360 degrees on all axes over the span of 1 second. 

 

Creating a Flipbook Animation 

2. Create a directory named Flipbook Test.  This is the directory in which the Flipbook files will be 
saved.  This is not a required step, but helps to illustrate how Flipbook files are stored. 
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3. Select Save As from the File menu, and browse to Flipbook Test directory in the Save In dropdown 
list box.  The File Name field shown below will display the name of a new, untitled file in the format of 
the last saved file, most likely Untitled  The expanded Save as Type dropdown list box is closed, and 
displays the file format of the last saved file. 

 

Saving a Flipbook Animation 

4. Remember the number in the End Frame field in the upper left corner of the dialog box.  Note that if 
Flipbook animations have previously been recorded during the current Lyric session, or there is 
already a Flipbook animation in the directory in which the new Flipbook is to be recorded, other 
frame numbers could populate the Start Frame and End Frame.  These cases will be covered below. 

5. Select Targa (*.tga) from the Save As Type dropdown list box, as shown in the above figure.  Enter 
a name in the File Name field, but do not press Save yet.  In this example, the file is named 
Flipbook_Test.tga. 

6. At this point, notice that the value in the End Frame field may have reset to 0.  Re-enter the End 
Frame value displayed and noted in Step 4.  If, however, there are other values in the Start Frame 
and/or End Frame fields, enter 0 in the Start Frame, and 30 in the End Frame field.  This defines an 
animation that runs for the entire 1 second. 
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Note that for this example, the entire animation is saved.  A shorter animation can be saved by 
entering values other than 0 and/or 30 in the Start Frame and End Frame fields, respectively. 

 

Saving a Flipbook Animation - Setting Start and End Frames 

 Image Width and Image Height are set automatically, but can be changed.  Note that 
changing these settings does not clip the graphic, but rather resizes the dimensions - in this 
instance, the entire screen.  To clip an image, use Clip to Safe Title, described below.  
When a Flipbook file is saved, all files in the Flipbook are sized to the Image Width and 
Image Height dimensions. 

 If an animation is saved with Interlaced enabled (checked), the odd and even fields of the 
TGA (or other bitmap format file) are rendered offset in time by 1/60 second (NTSC) or 1/50 
second (PAL) on playback.  Interlaced should be enabled if the animation is to be saved to 
an animation format such as AVI, and then played back through a Matrox clip player.  For 
Flipbook purposes, keep Interlace disabled. 

 Clip to Safe Title clips the image to the size of the Safe Title box before saving the 
Flipbook.  The Safe Title can be resized to clip the image, then enable (check) Clip to Safe 
Title.  If Clip to Safe Title is enables when a Flipbook file is saved, all files in the Flipbook 
are clipped to the size of the Safe Title. 

 Enabling Save Alpha saves the Alpha (Transparency) information with the file.  If Save 
Alpha is not enabled, Transparency is lost in the recorded Flipbook.  The Flipbook Region 
(described below) then appears as a rectangular area, in which the Flipbook animation 
executes.  
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7. Click Save.  It may take a few moments to complete the Save operation, because Lyric creates a 
separate file for each frame of the animation.  Look at the folder where the files are saved to see how 
they are stored and numbered. 

 

Saved Flipbook Files 

8. Return to Lyric and clear the Canvas. 

Next, you will create a Flipbook region for playback as part of a Lyric composition.  Remember that Flipbook 
regions are intended for use with sequences of files created by many types of animation programs.  For the 
purpose of this exercise, however, the most convenient file sequence to use is the one you just created. 

1. If the Flipbook animation starts as just a black field, you may want to set the Default Background 
Color to gray for easier visibility.  To do so, select Set Default Background Color  from the Tools 

menu, or click  on the Chyron Toolbar to change the Canvas to a gray backdrop. 

2. From the Tools menu, select Flipbook. 

3. The Flipbook Region dialog box opens.  Click the Browse button next to the First File field.  Note 
that the Ignore Pauses checkbox appears only on Duet LEX/PCI+ systems.   

 

Flipbook Region 
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4. The Select the First File for Flipbook Animation dialog box is displayed. 

 

Select the First File for Flipbook Animation 

Select the first file that Lyric created in the previous exercise.  Take careful note of the file names, so 
that you select the correct one. Its name will end with the digits 0000. 

Enable (check) Preview if to display a thumbnail of the selected frame directly below the Preview 
checkbox. 

5. Click Open; the file selection box closes and the Flipbook Region dialog box is displayed, with the 
First File and Last File fields filled in.  Note that Lyric selects the highest numbered file that it can 
interpret as the end of a Flipbook sequence.  Both the First File and/or the Last File field, however, 
can be changed to shorten a sequence.  When the First File and  Last File settings are changed, 
only the playback is affected.  The original files remain intact. 

 

Flipbook Region Dialog Box - Setting Files and Execution Parameters 

 To set the Flipbook animation to repeat for the duration of the Lyric animation, select (check) 
the Loop checkbox. 
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Note that enabling the Flipbook's Loop option does not cause the Flipbook animation to 
repeat indefinitely.  The Flipbook loops only for the set duration of the animation.  It does not 
extend beyond the end point of the animation as set on the Timeline. 

 Enabling Embed Image on Save saves the Flipbook image data in the Lyric message.  
Disabling Embed Image on Save allows Flipbook messages to be saved without embedded 
image data, in order to minimize the resulting size of the message.  The Flipbook images, 
however, must be re-read from disk during message Read, which increases recall time. 

 Compress Image Data compresses the file data, resulting in smaller Flipbook files on 
playback.  Preview this type of playback before playing to air. 

 Duet LEX/PCI+ Only:  Enabling Ignore Pauses allows the Flipbook animation to continue 
running through a programmed Pause.  This option does not appear on other systems.  If 
Ignore Pauses is not enabled, or if the system is not a Duet LEX/PCI+, a Flipbook pauses 
at set Pause points during animation execution.  Additionally, the Play to End checkbox 
becomes available.  If Play to End enabled, the Flipbook plays to the end. 

6. Click OK. The Flipbook Region appears on the Canvas as an object, showing the first bitmap file in 
the sequence specified above.  In the illustration below, the boundaries of the Flipbook object are not 
visible, as the Alpha information has been saved.  Other objects passing behind the Flipbook 
Region are visible if there is wherever there is Transparency.  In this example, if the Alpha 
information had not been saved, the Background would not have been visible, as the Flipbook is 
the size of the entire screen. 

 

Flipbook Region - Boundaries Not Visible 
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The following figure shows a smaller Flipbook where the Alpha information has not been saved.  
The Default Canvas Color has been changed to gray to show that the boundaries of the Flipbook 
Region are visible.  Other objects passing behind the Flipbook Region are covered by the Flipbook 
Region. 

 

Flipbook Region - Boundaries Visible 

7. The Flipbook region can be repositioned, rotated, etc., and other objects can be added to create a 
Lyric composition. 

8. Click the Play button on the Transport Controls.  The Flipbook animation runs within the 
Flipbook Region as the Lyric animation plays.  Additionally, the Flipbook Region can be animated 
the same as any other object.  If you have selected "Loop" in the Flipbook Region dialog box, the 
animation continues to repeat for the default animation length as set in the Preferences > Animation 
Settings tab. 
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Once the Flipbook animation has been programmed, you can make changes: 
1. Right-click on the Flipbook region.  The (Context) right-click menu is shown below. 

  

Flipbook Region Context (Right-Click) Menu 

2. Select Modify Flipbook.  The Flipbook Region dialog box described above opens, and the 
parameters can be modified. 

The following provides a brief description of each of the menu items: 
 Object Name and Type:  The first item in an object's context menu displays the object's name and 

type.  Refer to Navigating and Entering Information in Lyric:  Object Name and Type for details 
on renaming objects. 

 Show Flipbook Properties:  Show Flipbook Properties displays the Flipbook Region dialog box, 
described earlier in this section, in which Flipbook parameters can be modified. 

 Position Lock On:  The Position Lock On setting specifies whether or not an object (2D Text 
Window, 2D or 3D object, etc.) can be moved on its X, Y or Z axes, as well as rotated, scaled or 
have its center of rotation changed.  Refer to the chapter on Position, Rotation, Scale and 
Orientation for additional information. 

 Enable Bounding Box:  Enable Bounding Box allows for the selection of a 2D bitmap object, 
including a Flipbook frame.  A Flipbook is a collection of bitmap images that play back as an 
animation.  Once selected, the object can be scaled, rotated and moved forward in backward along Z-
axis.  Enable Bounding Box is covered earlier in this chapter. 

 Squeezeback - Duet SD:  Squeezeback is not available to the Flipbook context menu. 

 Advanced Image Effects:  Advanced Image Effects is not available to the Flipbook context menu. 
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 Mask Object:  Mask Objects function somewhat differently on Duet SD/HD/Offline systems versus 
Duet LE/LEX/PCI/PCI+ systems. 

o Duet SD/HD/Off-Line:  An image specified as a Mask Object displays at 100% video, and 
cuts through the elements over which it is positioned and the background.  Built-in 
transparent areas of a Mask Object allow video input to show through.  Mask Object is not 
implemented for Flipbooks.    Refer to the chapter on Masks:  Mask Objects - Duet SD. HD 
and Off-Line for additional information. 

o Duet LE/LEX/PCI/PCI+:  An image specified as a Mask Object displays at the transparency 
set in Properties > Surface combined with built-in transparency, and covers the object over 
which it is positioned.  Mask Object, Mask Layers, Mask Inside, Alpha Trim Mask and 
Soft Mask are supported on Duet LE/LEX/PCI/PCI+ system.  Transparent areas of a Mask 
Object allow video input to show through.  Mask Object, Alpha Trim Mask and Soft Mask 
are not currently implemented for Flipbooks.  Refer to the chapter on Masks:  Mask 
Objects - Duet LE/LEX/PCI/PCI+ for additional information. 

 Copy/Paste Animation State:  Copy/Paste Animation State enables animation attributes such as 
Position, Rotation, Scaling, etc., to be copied from one object and pasted to another.  Refer to the 
chapter on Animation for additional information. 

 Show Center of Rotation:  The Center of Rotation for an object can be displayed on the Canvas 
for ease of editing.  Refer to the chapter on Position, Rotation, Scale and Orientation - Transform 
Tools for in-depth information. 

 Motion Path:  The path of an object as it progresses through an animation can be graphically 
displayed on the Canvas.  The Motion Path can be edited, keyframes added and deleted, 
acceleration set and interpolation specified from the Canvas.  Refer to the chapter on Animation - 
Motion Paths for in-depth information. 

 Internal Properties:  Properties of an object or a message can be tailored to a specific composition 
or playback situation.  Internal Properties are currently not implemented for Flipbooks. 
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17. 3D Characters and Objects 

3D Characters and Objects 

About 3D Characters 
3D characters are composed of extruded 2D characters created from Font Faces, also known as Font 
Styles, to which a set of characteristics such as Font Size, Font Color, textures, etc. can be applied.  3D 
characters are placed on the Canvas simply by typing anywhere on the Canvas outside of a 2D Text 
Window. 

Unicode text entry is supported.  3D text entry is also supported for Chinese, Japanese and Korean.  
Unicode Only must selected in CG Preferences in order to accommodate Asian language text entry.  Refer 
to the section on CG Preferences for information regarding the Unicode Only setting. 

2D Text vs. 3D Characters 
Whenever there is not a 2D Text Window on the Canvas, the default text entry is 3D characters.  The default 
text entry mode can be set to 2D text or 3D characters as follows: 

1. From the Config menu, select Preferences > CG Preferences. 

2. Select an Initial Edit Mode setting: 

 Windowed to open the Canvas as completely blank.  Default text entry is 3D character 

 Full Screen to open a full-screen-sized 2D Text Window on opening a new Canvas.  Refer 
to Preferences: CG Preferences for additional information. 

The Initial Edit Mode can also be set by selecting (clicking) either the 2D or the 3D radio button 

 on the Properties > Font tab. Refer to Properties:  Font for additional information. 

2D Text Windows contain automatically generated baselines on which the 2D text is typed, and text can 
easily be repositioned on the baseline.  3D characters are typed using the same Y-position as a baseline, but 
cannot be repositioned in the same manner, and do not lock to the baseline when moved. 

Each 3D character is a separate object, as seen on the Scene Graph, and can be separately animated.  3D 
characters can, however, be grouped.  A 3D Text Template can also be created into which 3D Text is 
entered.  The 3D Text Template can then be updated using the Template Update function.  Refer to 
Grouping and Ungrouping Objects, 3D Text Templates and Template Update for additional details.  

Adding 3D Characters to the Canvas 
To enter 3D characters: 

 Place the cursor at the position at the first character should be placed.  Begin typing.  

There is no Word Wrap when typing 3D characters.  The cursor can be moved to a new line by pressing 
Enter, and the 3D typing continued. 

3D characters may also be added to the Canvas using the TrueType Font Preview function, accessed from 
the button in the Properties > Font tab.  Refer to Properties:  Font for additional information. 

The Backspace  key can be used to delete characters as long as the mouse has not been clicked on the 
Canvas, and no other editing has been performed on the Canvas.  To delete a character: 

 Select the character, and then click , press Ctrl + Delete or select Delete from the Edit menu. 

Repositioning 3D Characters 
3D characters can be repositioned by selecting one or more 3D characters, then clicking-and-dragging or 
pressing the  cursor keys. 
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To aid in positioning 3D characters, a grid can be set up, displayed and used as a guide: 
1. From the Config menu, select Preferences, then the Alignment tab. 

2. Set grid parameters, then click Apply to preview, then OK to set.  Refer to Preferences - Alignment 
for additional information. 

To best see the grid, the default Canvas color can be switched to gray: 

 Click .  Refer to Set Default Background Color for additional information.   

 

Canvas Showing Gridline Display 

Setting 3D Font Characteristics 
Font Face/Style 
Font Face or Font Style can be selected from either the Font Tools > Font Facename drop-down list box or 
the Properties > Font > Font Facename drop-down list box.  Refer to Font Tools and Properties:  Font for 
additional information. 

Style 
Style can be set from can be selected by clicking the Font Tools > Bold, Italic and/or Underline icons, or by 
selecting the Style (unlabeled) drop-down list box in Properties > Font setting.  Refer to Font Tools and 
Properties:  Font for additional information. 

Size 
The Font Tools > Size and Properties > Font > Size settings cannot be applied to 3D characters.  Any 
change to 3D character size must be made using the Transform Tools > Edit Position (Z-axis) and/or Edit 
Scale tools, or the Properties > XYZ tab Position (Z-axis)and/or Scale  settings.  Refer to Transform Tools 
and Properties:  XYZ for additional information. 

Bevels 
3D characters can be given depth and a sculpted appearance by adding Bevels.  Bevel characteristics can 
be set in the Properties > 3D Font FX tab.  Refer to Properties:  3D Font FX for additional information. 

Color, Texture and Surface Properties 
Solid color can be applied to the Face and Sides of 3D characters via Font Tools and Properties > 2D Font 
FX.  Texture and solid color can be applied to Face, Sides and Bevels via Properties > Surface.  
Transparency and shininess can also be set.  Ramped color cannot be applied to 3D characters.  Refer to 
Font Tools, Properties:  2D Font FX and Properties:  Surface for additional information. 

TrueType Font Preview 
TrueType® Font Preview enables the user to quickly review the available characters in a font, change the 
current font, or select a character (including Unicode) to add to the Canvas at the current cursor position.  
TrueType Font Preview can be used with both 2D and 3D characters.  TrueType Font Preview is accessed 
from the Font Properties tab.  Refer to Properties:  Font for additional information. 
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About 3D Objects 

Tools Menu > 3D Object;  Chyron Toolbar > ;  File Menu > Open 
Unlike 3D characters, 3D objects are not created within Lyric; rather, they are imported.  3D objects can be 
built from any number of surfaces, each which can have texture and/or solid color applied.  Refer to 
Properties:  Surface for additional information. 

3D objects can be resized using the same methods as for 3D characters.    Refer to Transform Tools and 
Properties:  XYZ for additional information. 

Importing a 3D Object 

Tools Menu > 3D Object;  Chyron Toolbar > ;   Canvas/Scene Graph Right-Click Menu > 3D 
Object 

Lyric can import Wavefront (.obj) files and 3D Studio files (.3ds and .prj) to the Canvas for use in a Lyric 
composition.  To do so: 

1. From the Tools menu, select 3D Object, or click the  icon on the Chyron Toolbar.  The Select 
a 3D Object dialog box opens: 

 

Select a 3D Object 

2. Select a file type from the Files of Type dropdown menu.  The choices are:  All 3D files (*.3ds, *.prj, 
*.obj); 3D Studio files (*.3ds, *.prj); or Wavefront files (*.obj).  Select a file name, then click Open.  
The object is placed at the center of the Canvas. 

The Backspace  key can be used to delete only the most recently imported object.  To delete a different 
object: 

 Select the object, then click , press Ctrl + Delete or select Delete from the Edit menu. 

3D Character/Object Antialiasing 
The edges of 3D objects and 3D characters can sometimes appear jagged (stair-stepped).  Full Scene 
Antialiasing, accessed from Config Menu > Preferences > Animation Settings, can be enabled to smooth 
out the rough edges of these objects. 
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3D Text Templates 
Templates for 3D text can be added to the Lyric scene.  A 3D Character Template can be updated via the 
Template Update dialog box in the same manner as a 2D Template.  To create a 3D Character Template: 

1. When outside of a 2D Text Window, click the mouse at the desired location of the 3D Character 
Template, then choose one of the three following methods to create the template: 

 Click the Template icon  in the Chyron Toolbar. 

 Select Template from the Tools menu. 

 Press Alt O T (do not hold down the Alt key). 

2. Type a few characters to view the position of the 3D Character Template.  Note that unlike 2D 
Templates, there are no boundaries to visually define the 3D Character Template on the Canvas.  
When finished typing the characters that are to be contained in the Template, click on the Canvas.  
Note that it is not necessary to type characters on the Canvas.  The Template is still created and can 
be updated. 

Note that a 3D Text Template can contain more than one line of text, although when Enter is pressed to start 
a new line, the new line begins at the left edge of the Canvas. 

To left-align all rows in a 3D Text Template: 
 Place the cursor at the left edge of the Canvas, and then create the 3D Text Template.  Type the 

rows of text.  If repositioning is necessary, select the 3D Text Template in the Scene Graph, and 
then move the Template to the new position. 

For other types of alignment, however, it is recommended that a separate 3D Text Template be created for 
each row, and then the rows be individually repositioned. 

When a 3D Character Template is created: 
 A 3D Character Template item is added to the Scene Graph.  This item can be expanded to show 

its individual elements, which can be separately selected and animated using the Keyframe Graph.  
Note, however, if the 3D Template is updated (see below), it removes animation information 
regarding individual elements. 

 The 3D Character Template text can be repositioned and animated as a group.  When the 3D 
Character Template item is selected on the Scene Graph, the Group and Ungroup items are 
grayed out. 

To reposition or transform the elements as a group: 
 Select the 3D Character Template item on the Scene Graph.  On the Canvas, use the Transform 

Tools or Properties > XYZ to reposition or transform the 3D Character Template. 

To reposition or transform an individual element: 
 Select the individual element on the Scene Graph.  On the Canvas, press and hold the Shift key 

while using use the Transform Tools  or Properties > XYZ to reposition or transform the element. 
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Template Update 
Tools Menu > Template Update;  Alt + T 

All 2D Text Templates and 3D Text Templates in your composition may not be visible on the Canvas 
simultaneously, and tabbing to each 2D Text Template or selecting each 3D Text Template that you wish to 
modify can be time-consuming.  The Template Update feature offers a convenient way to view and update or 
edit text within templates.  The example below shows a set of 2D Text Templates.  There can, however, be a 
mix of 2D Text Templates and 3D Text Templates on a Canvas. 

1. Press Alt + T or pull down the Tools menu and select Template Update. The dialog box pictured 
below right appears: 

 

Canvas and Template Update 

When the dialog box is first opened, up to six template fields are displayed, sorted by template 
number and showing the text content of each template. If there are more than six templates in your 
composition, the dialog box will include a scroll bar for access to the rest of the fields displaying 
template text. 

 Pressing the Page Up, Page Down and Tab keys moves the cursor through the fields 

 Pressing Shift + Tab moves the cursor back to the previous template. 



Lyric User Guide 

 17-6 

2. Delete the current text in the Template field (if necessary), and then enter updated text in any field or 
fields. 

3. Click on one of the following buttons: 

 Apply:  Applies the change and keeps the Template Update dialog box open.  Any changes 
you have made will be reflected in the text template(s) on the Canvas. 

 OK:  Applies the change and closes the Template Update dialog box.  Any changes to 
Template text are reflected in the Text Template(s) on the Canvas. 

 Cancel:  Cancels any changes and closes the Template Update dialog box. 

If a 2D Text Template or 3D Text Template contains more than one line, then the separate lines can be 
updated from the Template Update dialog box. 

1. In the Template Update dialog box, select a 2D Text Template or 3D Text Template as previously 
described. 

2. Delete the current text in the Template field (if necessary), and then enter the text for the first line of 
the Template, and then press Shift + Enter. 

3. Enter the text for the second line of the Template, and then press Shift + Enter.  Note that no special 
character or space indicates where Shift + Enter was typed.  The text will appear to run together in 
the field. 

4. Repeat the text entry - Shift + Enter sequence for each subsequent row. 

5. Press Apply or OK to apply the change. 

The following occurs if an attempt is made to add a new line to a Template: 
 Pressing Shift + Enter does not add an extra line to a 2D Text Template on the Canvas.  If there is 

no new line available in the 2D Text Template, text typed after a Shift + Enter is appended to the 
text already on the 2D Text Template line. 

 Pressing Shift + Enter does add an extra line to a 3D Text Template on the Canvas.  If, however, 
the first row does not begin at the left edge of the Canvas, the rows will be out of alignment.  It is 
recommended that each row of 3D characters be typed in its own 3D Text Template to make row 
alignment easier. 
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3D Character/Object/Template Context Menu 
Right-Click the 3D Character/Template Object or the Character/Template/Object's Listing in the 
Scene Graph 

Right-clicking on a 3D character or 3D object displays a Context menu, also known as a right-click menu, 
which makes available a variety of functions related to 3D character or 3D object operations.  Note that all 
available items in the menu are displayed as active.   

 

3D Character/Object Context Menu 

The following provides a brief description of each of the menu items: 
 Object Name and Type:  The first item in an object's context menu displays the object's name and 

type.  Refer to Navigating and Entering Information in Lyric:  Object Name and Type for details 
on renaming objects. 

 Position Lock On:  The Position Lock On setting specifies whether or not an object (2D Text 
Window, 2D or 3D object, etc.) can be moved on its X, Y or Z axes, as well as rotated, scaled or 
have its center of rotation changed.  Refer to the chapter on Position, Rotation, Scale and 
Orientation for additional information. 

 Enable Bounding Box:  Enable Bounding Box is not available to the 3D 
Character/Object/Template context menu. 

 Squeezeback - Duet SD:  Squeezeback is not available to the 3D Character/Object/Template 
context menu. 

 Advanced Image Effects:  Advanced Image Effects is not available to the 3D 
Character/Object/Template context menu. 

 Copy/Paste Animation State:  Copy/Paste Animation State enables animation attributes such as 
Position, Rotation, Scaling, etc., to be copied from one object and pasted to another.  Refer to the 
chapter on Animation for additional information. 
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 Mask Object:  Mask Objects function somewhat differently on Duet SD/HD/Offline systems versus 
Duet LE/LEX/PCI/PCI+ systems. 

o Duet SD/HD/Off-Line:  An image specified as a Mask Object displays at 100% video, and 
cuts through the elements over which it is positioned and the background.  Built-in 
transparent areas of a Mask Object allow video input to show through.  Mask Object is not 
implemented for 3D characters or 3D objects.    Refer to the chapter on Masks:  Mask 
Objects - Duet SD. HD and Off-Line for additional information. 

o Duet LE/LEX/PCI/PCI+:  An image specified as a Mask Object displays at the transparency 
set in Properties > Surface combined with built-in transparency, and covers the object over 
which it is positioned.  Mask Object, Mask Layers, Mask Inside, Alpha Trim Mask and 
Soft Mask are supported on Duet LE/LEX/PCI/PCI+ systems.  Transparent areas of a Mask 
Object allow video input to show through.  Mask Object, Soft Mask and Alpha Trim Mask 
are not currently implemented for 3D characters or 3D objects.  Refer to the chapter on 
Masks:  Mask Objects - Duet LE/LEX/PCI/PCI+ for additional information. 

 Show Center of Rotation:  The Center of Rotation for an object can be displayed on the Canvas 
for ease of editing.  Refer to the chapter on Position, Rotation, Scale and Orientation - Transform 
Tools for in-depth information. 

 Motion Path:  The path of an object as it progresses through an animation can be graphically 
displayed on the Canvas.  The Motion Path can be edited, keyframes added and deleted, 
acceleration set and interpolation specified from the Canvas.  Refer to the chapter on Animation - 
Motion Paths for in-depth information. 

 Internal Properties:  Properties of an object or a message can be tailored to a specific composition 
or playback situation.  The Internal Properties accessed from this menu are applied to the selected 
object.  They include Depth Test, Depth Write, Lighting and Wireframe. 
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18. Color/Transparency/Background/Lighting/Texture 

Color, Transparency, Background, Lighting and Texture 
Color, transparency and texture can be applied to all 2D and 3D characters and objects in Lyric.  Color can 
also be set for the Background of the entire Canvas, a 2D Text Window, or a 2D Text Template. 

The Lyric composition can also be lit by an overall light, as well as individual, animatable lights.  All lights can 
be individually colored as well. 

The procedure for applying color and texture differs depending upon the type of object - 2D text, 3D text, 3D 
object, Background, etc.  This chapter covers the various aspects of applying color, transparency, light, 
texture and Background. 

Color Selection for 2D/3D Text and Backgrounds 

2D/3D Text Color:  Properties > 2D Font FX > Fill for Face/Edge;  Font Toolbar , 

then select the Color Select tool  from the drop-down Palette 

Background Color:  Tools Menu > Background > Solid/Ramp Color;  Chyron Toolbar    > 
Solid/Ramp Color;  2D Text Template Context (Right-Click) Menu > Template Properties > Set Bkg 
The color of the face and edges of 2D text, as well as the color of the Background of the Canvas, 2D Text 
Windows or 2D Text Templates, can be set by selecting colors from the Color Window in the Color Select 
dialog box, or by selecting preset colors from the Palette, also accessed from the Color Select dialog box. 

Face and Side color of a 3D character can also be set using this color utility.  However, the Bevel color and 
other 3D character attributes can be set only in the Properties > Surface tab.  Refer to Color Palette for 
Light Sources and 3D Characters/Objects for additional information on setting color for 3D characters. 

The Palette can be thought of as a library of favorite colors.  It is not necessary to use Palette colors to 
create a message, as custom colors can be created on the fly and applied to text or Background without 
storing to a Palette.  Ramped colors, which are colors that blend into each other, can also be applied to 2D 
text and Backgrounds and added to the Palette.  Ramped color cannot be applied to a 3D character. 

Palettes can be saved as .reg files and recalled for future use. 

Quickly Setting Text Color 
The Face color of 2D text or a 3D character(s), the Edge color of 2D text or the Side color of a 3D 
character(s) can be quickly set using preset Palette colors: 

1. Select the 2D text or 3D character(s) as follows: 

 If color is to be applied to selected 2D text, use a Bounding Box to select the text. 

 If the color is to be applied to selected 3D text (Face or one Edge only), Ctrl + clicking the 
characters on the Canvas or in the Scene Graph, or Shift + click a range of characters in 
the Scene Graph. 
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2. To apply color to the Face of the selected 2D Text or 3D characters, click on the Font Face tool.  To 
apply color to the Edge of selected 2D text or Sides of 3D characters, click on the Font Edge tool.  A 
drop-down Palette is displayed.  The colors of the Font Face Color correspond to the colors in 
Palette 1 in the Color Select dialog box; the colors of the Font Edge correspond to the colors in 
Palette 2 in the Color Select dialog box.  Note  that only one Palette can be pulled down at a time.  
Both are shown in the following figure. 

 

Font Face and Edge Color Tool Drop-Down Palettes 

Note that when the scroll bar is at the top of a Font Face or Edge Color tool drop-down (not shown 
in the preceding figure), the first (top) color displayed in the drop-down Palettes indicates the 
currently-selected color.  This may or may not be a Palette color, i.e. a color that is assigned to a 
Palette. 

3. Click a color to apply.  The color is applied to the selected 2D text or 3D characters.  Note that a 
ramped color cannot be applied to a 3D character. 

When a color is applied to 2D text, any 2D text that is typed afterwards has the new color applied.  When a 
color is applied to 3D characters, any 3D characters that are typed afterwards have the new color applied.  
Changes to the colors of 2D text do not affect 3D character color, and changes to 3D character color do not 
affect 2D text color. 

NOTE 
Be aware that if the current color is not assigned to a Palette, selecting a different color 
in the Font Face/Edge Color tool deletes the color from the drop-down and the color 
settings are lost.  If text has already been typed using the lost color, the settings can be 
reloaded by using one of the following methods to apply the Color/Font function. 

 Select the text with the lost color, then press the Color Font key on a Duet 
keyboard, or Alt + 12 on a PC keyboard. 

 Right-click on the 2D Text Window containing the selected text, then select Pick 
Up Color/Font from the context menu. 

The color settings are reloaded, and are applied when typing new text.  The color also 
becomes active in the Color Select dialog box, and can be added to the Palette.  The 
Color Select dialog box is described below, and Adding Color to the Palette is described 
later in this section. 
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Accessing the Color Select Dialog Box and the Palette 
The manner in which the Color Select dialog box and the Palette are accessed determines to which element 
color is applied.  If the dialog box is opened from a Background tool (Canvas, 2D Text Window or 2D Text 
Template), the color will be applied to the Background.  If the dialog box is opened from a Font Face or 
Font Edge Tool or the 2D Font FX Properties tab, the color will be applied to the Face or an Edge of 2D 
characters, or the Face or Sides of a 3D character(s). 

Accessing Color Select Dialog Box for Setting 2D Text Face/Edge or 3D Text Face/Side Color 
From the 2D Font FX Properties tab: 

1. Open the 2D Font FX tab of the Properties window. 

 

2D Font FX Properties Color Sample Chip and Font Sample 

1. In the Face/Edge Components list, select Face or the Edge to which to apply the color.  In the 
preceding figure, the first applied Edge, which is a Border, is selected.  In the case of a 3D 
character(s), any Edge component that is selected results in the color being applied to the Sides of 
the 3D character(s). 

2. In the Fill for Face/Edge area, select (click) the Color radio button. 

3. Click on the Fill for Face/Fill for Edge Color Sample Chip.  The Color Select dialog box opens. 
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From the Font Tools: 
 Click on either the Face or Edge color setting tool on the Font Toolbar, then select the Color Select 

tool  from the color drop-down list.  If the Color Select tool  is selected from the 
Face tool, the Face color of the 2D text or 3D character can be set.  If the Color Select tool 

 is selected from the Edge tool, the first applied Edge color of 2D text or Side color of a 3D 
character(s) can be set.  The Color Select dialog box opens. 

 

Face (Left) and Edge (Right) Font Color Tools 

Accessing Color Select Dialog Box for Setting Background Color 
To open the Color Select dialog box and access the Color Palette for the Background, use one of the 
following methods: 

 Pull down the Tools menu, then select Background, then Solid/Ramp Color. 

 Click  on the Chyron Toolbar, then select Solid/Ramp Color. 

 Right-click on a 2D Text Template, then select Template Properties from the context menu.  Click 
Set Bkg, then select Solid/Ramp Color. 

The Color Select dialog box opens. 

The Color Select Dialog Box 

 

Color Select Dialog Box 
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The Palette area displays one of the seven available subpalettes, also called Palettes, each containing 16 
colors, for a total of 112.  The 16 colors in the active (displayed) subpalette can be selected using a Duet 
keyboard Color Key or a PC Hotkey combination.  For example, if Palette 6 is displayed in the Color Select 
dialog box, the Hotkeys can load the 16 colors from Palette 6.  At the right of the Palette area is a set of 
Up/Down scroll arrows.  Click the arrows to scroll through the subpalettes. 

The Duet Color Keys and Hotkeys are mapped to Palette positions as follows: 

2D/3D TEXT COLOR SELECTION 

Duet/Keystroke(s) PC Keystroke(s) Description 

Color Keys 1 - 8 Ctrl + 1 through 
Ctrl + 8 
  

Selects entries 1 - 8 in pull-down Color 
Palette on the Font Toolbar (2D or 3D 
text) and in the Color Select dialog box. 

No corresponding 
keystrokes. 

Ctrl + 9 
Ctrl + 10 

Selects Palette Positions 9 and 10 
respectively in pull-down Color Palette on 
the Font Toolbar (2D or 3D text) and in the 
Color Select dialog box.  Do not have 
corresponding dedicated Duet keyboard 
keystrokes.  

Color Keys 9 - 14 
(Shift + Color Keys 
1 - 6) 

Note:  Color Keys 
15 and 16 are not 
operational. 

Ctrl + Shift +1 
through Ctrl + 
Shift + 6 

Selects entries 11 - 16 in pull-down Color 
Palette on the Font Toolbar (2D or 3D 
text) and in the Color Select dialog box. 

Applying Color to Background and Text 
Applying an Existing Palette Color 
To apply an existing Palette color: 

1. Depending on which element the color is to be applied, either perform or skip this step: 

 If the color is to be applied to a Background, skip to the next step. 

 If color is to be applied to selected 2D text, use a Bounding Box to select the text. 

 If the color is to be applied to selected 3D text (Face or one Edge only), Ctrl + clicking the 
characters on the Canvas or in the Scene Graph, or Shift + click a range of characters in 
the Scene Graph.. 

2. Open the Color Select dialog box using one of the methods described in Accessing the Color 
Select Dialog Box and the Palette above. 

3. Click a color tile in a subpalette and note that the Color Sample Chip in the Color area of the Color 
Select dialog box displays that color. 
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4. Click Apply. 

 If applying to a Background, the color should appear as the Background of the Canvas, 2D 
Text Window or 2D Text Template, and the procedure is complete. 

 If applying to a 3D character(s), the color should be applied to the Face or Edge, and the 
procedure is complete.  The Font Sample in the Properties > 2D Font FX tab and the Font 
Tool Face or Edge Color also reflects the selected color.  New 3D characters that are typed 
will also have the selected color applied.  The new color is not applied to 2D text. 

 If applying to 2D text, note that the text on the Canvas does not yet assume the selected 
color.  The Font Sample in the Properties > 2D Font FX tab as well as the Font Face or 
Edge Color tool, however, do reflect the selected color.  Continue to the next step. 

5. Click Apply in the Properties > 2D Font FX tab.  The text on the Canvas assumes the selected 
color.  New 2D text characters that are typed will also have the selected color applied.  The new color 
is not applied to 3D characters. 

Setting and Applying a Custom Color 
A color can be custom-set and if desired, added to the Palette.  To set a custom color: 

1. Use the appropriate method open the Color Select dialog box. 

2. Click and drag the + symbol in the Color Window to a color of your choice.  Moving the + across the 
Color Window adjusts the Hue.  This determines the character of the color - red, green, blue, etc.  
Moving the + up and down in the Color Window adjusts the Saturation, which determines the 
strength of the color.  Moving the + down in the Color Window mutes the color.  At the bottom of the 
scale, the color loses all strength and becomes gray.  Moving the + up in the Color Window 
strengthens the color.  At the top of the scale, the color is strongest.  Note that any change is 
reflected in the Color Sample Chip and the Hue/Sat/Lum (HSL) and Red/Green/Blue (RGB) 
settings. 
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3. Click and drag the Luminosity slider to adjust the brightness of the color.  At the bottom of the scale, 
the color is darkest (black).  At the top of the scale, the color is lightest (white).  Note that a change in 
Luminosity is reflected in the Color Sample Chip and the Hue/Sat/Lum (HSL) and 
Red/Green/Blue (RGB) settings.  The purest color in a color family is set by moving the + to the top 
of the Color Window, and the Luminosity slider to exactly the half-way point. 

 

Selecting a Color from the Color Window 

Colors can also be set by entering values in the HSL or RGB fields.  Changes to these settings are 
reflected in the Color Window and Luminosity slider.  Refer to Setting HSL and RGB Color 
Values for details. 

4. Also experiment with the Transparency slider.    The range of Transparency is from 0 (completely 
opaque) to 100 (completely transparent).  Note that a change in Transparency is reflected in the 
Color Sample Chip, but is not reflected in the Hue/Sat/Lum (HSL) and Red/Green/Blue (RGB) 
settings.  Transparency is an attribute distinct from HSL and RGB.  

 

Setting Transparency 

5. When the color is set, repeat Steps 4 and if necessary, 5, from the previous procedure to apply the 
color to the text or Background. 
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Adding a Color to the Palette 
NOTE 

When adding a color to the Palette, it must replace an existing color in the Palette.  Make 
sure that the color that is being replaced is not needed. 

When a color is set, it can be used to type text until another color is selected.  When the new color is 
selected, the color it replaced is lost unless it had been added to the Palette.  To add a color the Palette: 

1. In the Color Select dialog box, set a color. 

2. Select (click) on a color tile in any one of the seven subpalettes. 

 

Selecting a Color to Replace on the Palette 

1. Click Add To Palette.  The set color replaces the color in the Palette, and becomes the new color at 
that Palette position. 

Applying a Ramped/Gradient Color Scheme 
The Ramp/Gradient area of the dialog box consists of a Ramp/Gradient Color Window with a Color 
Anchor, each represented by a small circle, at each corner.  Additional Color Anchors can be added to the 
sides.  Corner Color Anchors cannot be removed or repositioned, whereas side Color Anchors can.  The 
color of a Color Anchor determines the color the adjacent area of the Ramp/Gradient Color Window. 

Ramped color cannot be applied to a 3D character.  Refer to Color Palette for Light Sources and 3D 
Characters/Objects for additional information on setting color for 3D characters. 

Once a color ramp is set, it can be added to a Subpalette in the same manner as a solid color, and applied in 
the same manner as a solid color.  

To set ramped color for text: 
1. Depending on which element the color is to be applied, either perform or skip this step: 

 If the color is to be applied to a Background, skip to the next step. 

 If color is to be applied to selected 2D text, use a Bounding Box to select the text. 

2. Use the appropriate method to open the Color Select dialog box. 

3. In the Mode area, select Ramp.  Click the upper-left Color Anchor.  A black frame appears around 
the Color Anchor. 

 

Selecting a Color Anchor 
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4. Use one of the following methods to set a color for the anchor and the upper left are of the 
Ramp/Gradient window.  Note that any change to the Color Window/Luminosity and 
Transparency sliders, and HSL/RGB settings are immediately reflected in the Color Anchor color.  
Optional:  Also set the Transparency. 

 Select (click) a color from the Palette 

 Use the + slider in the Color Window and the Luminosity slider. 

 Set HSL or RGB settings. 

 

Setting a Color Anchor 

5. Set different colors for each area of the color ramp by clicking each of the other three color anchors 
and repeating the color-setting procedure. 

 

Ramp/Gradient Window 
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6. When the color ramp in the Ramp/Gradient Window is set, click Apply in the Color Select dialog 
box. 

 If applying the ramped color to a Background, the ramped color should appear as the 
Background of the Canvas, 2D Text Window or 2D Text Template, and the procedure is 
complete. 

 If applying the ramped color to 2D text, it is applied to the Fill Color Sample Chip and the 
Font Sample in the Properties > 2D Font FX tab, but not the 2D text.  The figure below 
shows the ramped Font Face with a narrow Border Edge.  Continue to the next step. 

 

Fill Color Sample Chip and Font Sample Showing Gradient (Ramp) 

7. Click Apply on the Properties > 2D Font FX tab.  The color ramp is applied to the face of each 
selected character in the 2D Text Window.  New 2D text characters that are typed will also have the 
selected ramped color applied. 

 

Ramp/Gradient Applied to 2D Text 

A ramped color can be added to a Palette in the same manner as a custom color.  Remember, however, that 
a ramped color cannot be applied to a 3D character. 
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Copying/Pasting a Ramped Color 
A ramped color can be copied and pasted to another Palette position. 

1. In the Mode area, select Ramp. 

2. Right-click the Ramp/Gradient Window.  From the context menu, select Copy ramp. 

 

Copying and Pasting a Ramp 

3. Select (click) a Palette color tile. 

4. Right-click the Ramp/Gradient Window.  From the context menu, select Paste ramp.  The ramp is 
pasted to the new Palette position. 

Color Anchors - Buddies, Copy, Paste, Add/Remove 
Tie Color/Don't Tie Color to Buddy 
Lyric has a convenient function for setting two anchors to the same color.  The Tie color to buddy function 
pairs the top left/right corner anchor with its corresponding top right/left color anchor, or the bottom left/right 
corner anchor with its corresponding bottom right/left color anchor, so that the color of both anchors may be 
set simultaneously.  In the case of an anchor that is not on the corner (see Adding Additional Color 
Anchors later in this section), it can be tied/untied from its opposing top/bottom or left/right anchor. 

1. In the Mode area, select Ramp. 

2. Right-click one of the anchors as shown below.  A context menu is displayed. 

 

Selecting Tie Color to Buddy 
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3. Select Tie color to buddy.  The two opposing top color anchors are marked with horizontal lines.  
Additionally, the color of the new buddy now matches the color of the selected anchor. 

 

Color Anchors Tied to Each Other 

When two anchors are tied, any change in one anchor is reflected in the other anchor.  This allows two 
anchors to be set to the same color simultaneously.  

To "untie" two Color Anchors: 
 Right-click on one of the tied color anchors and select Don't tie color to buddy from the context 

menu.  The colors of the two anchors can now be independently set. 

 

Selecting Don't Tie Color to Buddy 

Copy/Paste Anchor Color 
A color may be copied and  pasted from one Color Anchor to another. 

1. In the Mode area, select Ramp. 

2. Right-click on the anchor from which the color is to be copied, then select Copy anchor color from 
the context menu. 

 

Copying  Anchor Color 

3. Right-click on an anchor to which you wish to apply the copied color, then select Paste anchor color 
from the context menu. 

 

Pasting Anchor Color 

The selected Color Anchor takes on the attributes of the pasted color. 
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Adding/Removing Additional Color Anchors 
An additional two pairs of color anchors can be added each to the top/bottom and left/right sides of the 
Ramp/Gradient Window, for a total of four additional pairs. 

To add a pair of Color Anchors: 
 In the Mode area, select Ramp.  Right-click just outside of the border of the Ramp/Gradient window, 

at the position where one of the Color Anchors is to be inserted.  A Color Anchor appears at that 
position, as well as at the opposing position.  On creation, the anchors are always tied (Tie to buddy) 
to each other. 

 

Adding Additional Color Anchors 

The following choices are available from the context (right-click) menu of a side Color Anchor: 
 Tie color to buddy/Don't tie color to buddy:  A Color Anchor can tied to or untied from the 

opposing Color Anchor. 

 Remove anchor:  Select Remove anchor to remove a Color Anchor and its opposing Color 
Anchor. 

 Copy/Paste anchor color:  A Color Anchor's color can be copied, then pasted to another Color 
Anchor. 

Pairs of side Color Anchors can be added and deleted.  Pairs of opposing Color Anchors can also be 
repositioned along its side of the Ramp/Gradient window, by using the mouse to click-and-drag the anchor. 

The following is an example of a complex ramp pattern created using multiple Color Anchors: 

 

Multiple Color Anchors 
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Picking Up a Color 
Pick Up Color enables a color to be "picked up" and used as the currently selected color. 

1. Click Pick Up Color.  Lyrics cursor takes on the appearance of an eyedropper. 

 

Picking Up a Color 

2. Click on any point on the Canvas or the Ramp/Gradient window.  Note that the hot area of this 
cursor is the bulb of the eye-dropper, not the tip.  When clicked on the Canvas, the Pick Up Color 
function can sample the color of anything visible on the Canvas, whether or not it is an object that will 
appear in Lyric compositions.  The eyedropper can acquire sample non-Lyric objects, such as Title 
Bars or the displayed borders of 2D Text Windows. 

The picked-up color picked up is displayed in the Color Sample Chip. 

To apply this color to 2D/3D text or a Background: 
 Use the Apply function as described earlier in this section. 

This color can be added to the Palette. 
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Performing a Hot Color Test 
The Color Select dialog also includes a Hot Color Test, which tests the color for settings which fall outside 
of NTSC and PAL standards.  Any color selected or custom-set by the user can be tested against NTSC and 
PAL standards before being added to a Palette, or applied to characters or windows.  To run the test: 

1. Click the Hot Color Test checkbox. 

2. Selecting or set a color or ramp 

3. Click Add to Palette or Apply.  If the color falls within NTSC or PAL standards, the color is added to 
the Palette or applied to the text or Background.  If the color tested does not meet NTSC or PAL 
standards, the following warning is displayed: 

 

Hot (Illegal) Color Warning 

4. Select one of the following choices: 

 Click OK to allow Lyric to automatically adjust the color to within legal limits. 

 Click No to leave the color as is. 

 Click Cancel to cancel the procedure. 
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Saving/Recalling a Palette 
Saving a Palette 
A Palette can be saved as a .reg file, which is a Lyric Profile format.  When a Save Palette is executed, all 
seven subpalettes are saved under one File Name.  To save a Palette: 

1. After setting the colors in the Palette, click Save Palette.  The Store Palette To dialog box opens. 

 

Storing a Palette 

2. Only one choice of File Type is available, which is the .reg format.  Enter a File Name, then click 
Save.  The file is saved and can be recalled for future use.  Note that the format is the same as that 
used for saving User Profiles. 

Recalling a Palette 
To recall a saved Palette: 

1. In the Color Select dialog box, click Recall Palette.  The Load Palette From dialog box opens. 

 

Loading a Palette 

2. Only one choice of File Type is available, which is the .reg format.  Enter a File Name, then click 
Open.  All seven subpalettes that comprise the Palette file are loaded in the Color Select Palette 
area. 
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NOTE 
User Profiles also store Palette information, and therefore a Palette can also be loaded by 
opening a User Profile .reg file from the Load Palette From dialog box.  Use caution when 
doing this, however, as other settings in the User Profile may be applied as well.  To 
prevent accidental change to the settings, first save the current settings as a User 
Profile, then load the User Profile which has the desired Palette.  Save the Palette, then 
load the original User Profile.  Open the saved Palette.  The new Palette is loaded without 
disturbing other Lyric settings. 

Resetting a Palette 
Resetting the Palette restores the first eight Palette colors of Palette 1 and the first eight colors of Palette 2 
to default Lyric colors.  Note that the default Palette colors 1 through 8 in Palette 1 and colors 1 through 8 in 
Palette 2 provide pairs of colors that can be used to quickly type fonts with color-coordinated Faces and 
Edges.  The figure below shows the default Palette 1 colors matched with their default Palette 2 colors.  The 
number characters represent the position of the colors within their respective Palettes.  For example, the 
Face color of the character 1 is created from Palette 1, Position 1, and the Edge from Palette 2, Position 1; 
the Face color of the character 2 is created from Palette 1, Position 2, and the Edge from Palette 2, 
Position 2; and so on.  These Palette colors also appear as the first eight Face and Edge colors in the Font 
Face and Font Edge Color tool drop-down Palettes.  The first (top) color displayed in the drop-down 
Palettes indicate the currently-selected color. 

 

Default Lyric Face and Edge Palette Colors 

To reset the Palette: 
 Click Reset. 
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Color Selection for Light Sources and 3D Characters/Objects 
Lighting:  Properties > Lighting 
3D Characters/Objects:  Properties > Surface 
See also Color Palette for 2D Text and Backgrounds. 

The colors of individual lights and surfaces of 3D characters and objects can be set using a color Palette.  
The Palette can be accessed from the Properties > Lighting or Properties > Surface tabs. 

 

Surface and Lighting Properties Tabs 

To access the Palette from the Properties > Lighting tab: 
 If selecting a color for the Global Light, click the Global Light Color Chip.  If selecting a color for an 

Individual Light, select the Individual Light ( 1 - 6), select Flood Light or Spot Light , then click 
the Individual Light Color Chip.  The Color dialog box is displayed.  Refer to Properties:  Lighting 
for additional information on setting Lighting attributes. 

To access the Palette from the Properties > Surface tab: 
1. Select the 3D character or 3D object Surface to which to apply the color. 

2. Click (check) the Color checkbox, then click the Color Chip.  The Color dialog box is displayed.    
Refer to Properties:  Surface for additional information on setting Surface attributes. 
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The Color dialog box contains a Palette of Basic and Custom colors. 

 

Color Dialog Box 

To select a Basic or previously set Custom color: 
 Select (click) a color from one of the predefined Basic Colors, or previously set Custom Colors, 

then click OK.  The color is applied to the select light or surface. 

To set a new user-defined color: 

1. Click-and-drag the  Hue/Saturation cursor  to the desired location on the grid and Click-and-drag 
the  Luminosity slider as desired.   Note that the Hue/Sat/Lum (HSL) and Red/Green/Blue 
(RGB) settings reflect the color set using the sliders.  Colors can also be set by entering values in the 
HSL or RGB fields.  Refer to Setting HSL and RGB Color Values for details. 

2. Optional:  Click the  button to add the user-defined color to the Custom 
Colors Palette. 

3. Press OK.  The color is applied to the select light or surface. 

The Color dialog box is also used for color-coding an object listing in the Scene Graph.  Refer to the chapter 
on Animation - Scene Graph for additional information. 
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Setting HSL and RGB Color Values 
The Palette for 2D Text and Backgrounds and Palette for Light Sources and 3D Objects both feature 
multiple methods for setting color.  A color can be set using sliders, or by entering values in the HSL or RGB 
fields.  The slider and HSL/RGB methods are described in the sections covering the respective Palettes.  
This section describes how HSL and RGB settings are used to set color. 

NOTE 
HSL and RGB settings must be entered using the alphanumeric keys on the keyboard.  
Using the numeric keypad keys changes the Message Number displayed on the Lyric 
interface. 

HSL Settings 
HSL settings break color into three components.  It is an intuitive color-setting system that makes it easy to 
creates families of colors that share the same Hue, but are different shades. 

 Hue defines the property of the color that gives it the appearance of being blue, yellow, green, etc.  
The color of an object is based on the wavelength of light that is reflected from the object.  Range:  0 
(red) - 239 (red).  The colors progress through the range in the following order:  red, orange, yellow, 
green, blue, purple and red. 

 Saturation defines the weakness or strength of the color.  Range:  0 (no saturation) - 240 (complete 
saturation). 

 Luminance, also referred to as brightness, defines the lightness or darkness, also sometimes 
referred to as a shade, of the color.  A setting of 120 defines the point at which the color is neither 
light or dark.  Range:  0 (darkest) - 240 (lightest). 

RGB Settings 
RGB settings also break colors into three components:  Red, Green and Blue.  Different levels of Red, 
Green and Blue are combined, or added, to produce the colors used and/or output by video and computer 
devices.  This type of video is known as Component Video.  There is also an additional Alpha, or 
Transparency component that can be set for 2D Text and Backgrounds within the Palette for 2D Text and 
Backgrounds, and for 3D Characters/Objects within the Properties > Surface tab.  A video/computer 
graphic that contains an Alpha component is referred to as an RGBA graphic. 

The Red, Green and Blue levels each indicate the level of intensity of the component color that combines 
with the other components to produce the resulting color.  Range of Each:  0 (no presence of the component 
color) - 255 (100% presence of the component color). 
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Sample Color Settings 
The following table shows settings for a few sample colors in HSL and RGB, and for graphics that could be 
used for the web, HTML. 

HSL RGB Color 

H S L R G B 

HTML 

Red 0 240 120 255 0 0 #FF0000 

Green 80 240 120 0 255 0 #00FF00 

Blue 160 240 120 0 0 255 #0000FF 

Fuchsia 200 240 120 255 0 255 #FF00FF 

Yellow 40 240 120 255 255 0 #FFFF00 

Aqua 120 240 120 0 255 255 #00FFFF 

Black 0 - 
239 

0 0 0 0 0 #000000 

White 0 - 
239 

0 240 255 255 255 #FFFFFF 

Gray 0 0 120 127 127 127 #7F7F7F 

Pure Red as defined in this table can cause problems when processed as video, and 
is considered to be an illegal color.  A slight adjustment to the HSL/RGB settings 
brings the color within acceptable bounds.  Use the Hot Color Test feature in the 2D 
Text/Background Palette to check and adjust a questionable color. 
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Background 

Tools Menu > Background;  Chyron Toolbar >  
Canvas/Scene Graph (Light, Global Light or Camera Selected) Context (Right-Click) Menu > 
Background 
2D Text Template Dialog Box > Set Bkg 

A Background can be applied either to the Canvas, to an individual 2D Text Window (including Roll, Crawl 
and Type On/Slow Reveal) or an individual 2D Text Template.  A Background is always positioned behind 
the editable elements on the Canvas and cannot itself be edited.  A Background is not available on a PCI-
Squeezeback board (Duet LE/LEX/PCI/PCI+ only).  There are two types of backgrounds: 

 A Solid/Ramp Color Background, which is rendered by Lyric as either a solid color or gradations 
involving more than one color. 

 A Graphic Background that uses an imported bitmap graphic as a Background. 

Different types of Backgrounds are illustrated in the last section of this topic. 

A few points to note regarding Backgrounds: 
 Unless it is transparent, a Background covers anything over which it is positioned, including an 

external video source.  The Background can be cut through using a Mask Object, Squeezeback 
Object (Duet SD), resizeable areas generated by a PCI-Squeezeback board (Duet 
LE/LEX/PCI/PCI+) or Video Regions.  Refer to Mask Introduction, Squeezeback Object, Video 
Squeezeback and Video Region respectively for additional information. 

 The Transparency of a Background can be animated.  

Selecting the Element to Which to Apply the Background 
Before applying a Background, select the Canvas, the 2D Text window or the 2D Text Template to which 
the Background is to be applied. 

To select the Canvas: 
 Click on the Canvas outside of a 2D Text window. 

OR 

 Select any element on the Scene Graph except a 2D Text window (which includes Roll, Crawl and 
Type On - Slow Reveal).  Global Light or Camera is a safe choice. 

To select a 2D Text window: 
 Click on the 2D Text window, but not inside a 2D Text Template. 

OR 

 Select the 2D Text window on the Scene Graph. 

To select a 2D Text Template: 
 Click in the 2D Text Template.  Make sure that the row handles in one of the Template rows are 

visible, indicating that the Template has been selected.  If the row handles are not visible, it indicates 
that the 2D Text Window has been selected, and the Background will be applied to the 2D Text 
Window instead of the 2D Text Template. 

Selecting Background Type 
To select the Background type to apply to the Canvas or selected 2D Text Window or 2D Text Template: 

1. Select Background from the Tools menu or the Canvas/Scene Graph right-click menu, or click the 

 button on the Chyron Toolbar.  The Background submenu opens.  The figure below shows 

the submenu from the  button. 
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Background Tool Drop-Down Menu 

OR 

In the instance of a 2D Text Window only, right-click on the 2D Text Template, then select 
Template Properties from the context menu.  From the 2D Text Template dialog box, click Set Bkg 
in the Background Area. 

 

Background Drop-Down Menu in 2D Text Template Dialog Box 

2. Select one of the following: 

Solid/Ramp to apply a Lyric-rendered solid or gradated color Background.  Continue to "Applying a 
Solid/Ramp Color Background" below. 

OR 

Graphic File to use a bitmap graphic as a Background.  Continue to "Applying a Graphic File 
Background" below (follows "Applying a Solid/Ramp Color Background"). 

The procedures for applying a Solid/Gradient or a Graphic Background differ greatly and are covered 
separately below. 

Applying a Solid/Gradient Background 
After selecting Solid/Ramp Color from the Background submenu, the Color Select dialog box is displayed.  
This dialog box is used as well to set palettes for other functions. 

1. Refer to the section on "Color Palette for 2D Text and Backgrounds" for details on setting and 
applying a Solid or Ramp Color. 

2. When Solid or Ramp Color selection is complete, click Apply, then OK.  The color is applied to the 
Background of the Canvas or the 2D Text window. 
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Applying a Graphic File Background 
After selecting Graphic File from the Background submenu, the Select a Graphic File for the Background 
dialog box is displayed: 

 

Select a Graphic File for the Background 

1. Enable (check) the Preview checkbox to display a thumbnail of the selected graphic at the right side 
of the dialog box. 

2. Select Graphic Files from the Files of Type list box. 

3. Select the file that is to be applied as the Background.  Note that the Width (in pixels), Height (in 
scanlines) and color Depth (in bits)reflect the original size of the selected graphic.  These values 
cannot be changed. 

4. In the Apply to Background area, select Size to Fit to automatically resize the graphic to fill the 
screen, or Center, to center the unresized graphic on the screen.  Note that Size to Fit may change 
the aspect ratio of the graphic. 

5. Select Open to apply the graphic file to the Background.  The graphic is applied to the Background. 

Background Examples 
The figure below illustrates the different types of Backgrounds. 

 The Canvas has a complex Ramp Color Background. 

 The 2D Text 1 has no Background and contains five Templates.  From top to bottom, they have no 
Background; a Solid Color Background, a simple Ramp Color Background, a complex Ramp 
Color Background and a Graphic Background. 

 2D Text 2 has a Solid Color Background. 
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Background Examples 

Deleting a Background 

Edit Menu > Delete Background;  Chyron Toolbar  > Delete;  Chyron Toolbar > Background 
Before deleting a Background, make sure to select the Canvas, 2D Text Window or 2D Text Template 
from which the Background is to be removed. 

Choose one of the following methods to delete a Background: 
 Canvas, 2D Text Window or 2D Text Template:  Select Delete Background from the Edit menu. 

OR 

 Canvas, 2D Text Window or 2D Text Template:  Click the Background icon on the Chyron 
Toolbar, then select Delete from the dropdown menu as shown below. 

 

Background Button with Delete Selected 
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 Canvas:  Click the Erase icon  on the Chyron Toolbar.  The Erase dialog box is displayed.  
Select the Scene radio button, and the Background checkbox. Click OK. 

 

Erase Background from Scene (Canvas) 

 2D Text Window:  Click the Erase icon on the Chyron Toolbar.  The Erase dialog box is displayed.  
Select either the This Window or All Windows radio button, and the Background checkbox.  Click 
OK. 

 

Erase Background from a 2D Text Window 
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 2D Text Template:  Right-click on the 2D Text Template, then select Template Properties from the 
context menu.  In the 2D Text Template dialog box, click Clear in the Set Background area. 

 

2D Text Template - Clear Background 
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Lighting Properties 
Properties > Lighting 
Click on the Lighting tab of the Properties window to view or change Lighting properties. 

The Lyric Canvas always includes one Global Light Source (which cannot be turned off) and up to six (6) 
independent movable Light Sources. 

 

Lighting Properties 
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Property  Description 

Global 
Light  

A Canvas may have one Global light, which is ambient light that 
comes from all directions equally. You may set an Intensity level 
for the Global light, and also you may set/change the light Color. 

Individual 
Light  

A Canvas may have up to six Individual Lights, which may be 
configured and positioned independently. Like any other Lyric 
parameter, lighting changes may be animated. 

Individual Lights may be configured as either Flood (light radiates 
at all angles from light source) or Spot (light is focused in one 
direction). 

 

Setting Intensity: 

 

 

Icon 
Visible  

If Icon Visible is checked, the selected Light Source(s) appears on 
the Canvas, for ease in positioning. 
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A Canvas may have, in addition to one Global light source, up to six Individual light sources. Each Light 
Source may be configured and positioned separately. And, like all Objects in Lyric, Light Sources may be 
animated. 

Control Description 

 

The round buttons turn the Individual Light sources on and off in 
any combination. The numbered square buttons select an Individual 
Light source for editing. 
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Control Description 

 

Each Individual Light may be set up as a Flood Light or a Spot 
Light. Flood Lights radiate in all directions; Spot Lights radiate in 
one direction, with variable angle and attenuation (see below). 

 

 

 Intensity of a selected light is adjustable over a range from 
0 to 100.  

 Click the Color sample to open a color selection dialog. 

 

 

 

 The Attenuation control varies the difference in the light's 
intensity as measured at the source rather than at the 
edges of the cone-shaped area being illuminated. A value 
of Zero (0) Attenuation indicates that there will be no 
decrease in illumination at the edges of the illuminated 
area. Changes in the Attenuation value will only be evident 
in the Spotlight's effect on objects it illuminates. 

 You may vary the Angle between the edges of the cone-
shaped area of illumination. 

 
In this illustration, the blue 
Spotlight at left is set to a 
15˚ angle; the yellow 
Spotlight is set to a 45˚ 
angle. 
 

 
If  this item is checked, the selected Light Source appears on the 
Canvas as shown in the first illustration.  

To reposition an Individual Light source on the Canvas, you may drag it with the mouse, or use the controls 
on the XYZ (Positioning) Window to reposition Light Sources. 
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Surface Properties - Applying Color, Transparency and Texture 
Properties > Surface 
Surface Properties defines how Colors, Transparencies and/or Textures are mapped to the various 
Surfaces on a 3D character or object, as well as Transparency of a 2D object or 2D Text Window.  These 
properties are set in the Surface tab of the Properties window. 

About Objects and Surfaces 
2D Text Windows and 2D Objects 
Transparency can be adjusted for selected 2D Text Windows or 2D objects.  Colors, Textures and other 
settings in the Surface Properties tab do not apply to 2D Text Windows or 2D objects. 

3D Characters 
A 3D character is comprised of three types of Surface elements: 

 Faces:  The Front and Back faces represent the 2D character from which the 3D character is built. 

 Sides:  The sides determine the depth of the 3D character. 

 Bevels:  The Bevels determine the transition between the faces and the Sides. 

 

3D Character 

Color and/or Texture can be applied independently to each of these elements.  Note that Color can also be 
applied to the Face and Sides of a 3D character from the 2D Font FX Properties tab, as well as from Font 
Tools.  Refer to Properties:  2D Font FX and Font Tools for additional information. 

3D Objects 
A 3D object can be comprised of a number of different Surface elements, which are grouped and named by 
the creator of the object.  The example below shows a soccer ball that is composed of two types of Surface 
elements that are named Ball (shown below as the white areas) and Panels (shown below as the black 
areas).  Color and/or Texture can be applied independently to each of these elements. 

 

Soccer Ball Comprised of Two Surface Elements 
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Setting Surface Properties 
To access Surface Properties, select the Surface tab in the Properties window. 

 Click on the Surface tab of the Properties window to view/change Surface Properties: 

The following figure shows Color and Texture applied to a 3D object called SoccerBall, which is comprised 
of two Surfaces, Panels and Ball.  The Properties tab on the left shows that the color black is applied to the 
Panels Surface.  The Properties tab on the right shows that a Chyron® logo graphic is applied, or mapped, 
to the Ball Surface. 

 

Surface Properties Tab 

Note that the Antialiased checkbox does not appear on the Surface Properties tab on a Duet 
LE/LEX/PCI/PCI+ system. 



Lyric User Guide 

 18-34 

The following figure shows examples of Color and Texture mapping.  Color and Texture can be 
simultaneously applied to the same Surface. 

 

No Color/Texture 
Applied to Ball or 

Panels 

 

No Color Applied to 
Ball; 

Color Applied to 
Panels 

 

Texture Applied to 
Ball; 

Color Applied to 
Panels 

 

Color and Texture 
Applied to Ball; 
Color Applied to 

Panels 

 

Color/Texture Applied 
to Ball; 

Texture but No Color 
Applied to Panels 

 

Color and Texture 
Applied to Ball and 

Panels 

Selecting a Surface to Which to Apply Settings 
The Apply To drop-down list box, at the bottom of the Properties tab, displays a list of all available 3D 
character or 3D object Surfaces to which to apply Surface settings.  Note that when a 2D object or 2D Text 
Window is selected, no choices are displayed, as the settings are applied to the entire object.  To select a 
Surface: 

1. Click the arrow to display the list of available Surfaces.  The figure below shows drop-downs for a 3D 
character and a 3D object SoccerBall.  The Default Surface choice is a group of Surfaces set by 
the creator of the object. 

 

Apply To Drop-Down for 3D Character and 3D Object Soccer Ball 

2. Select the desired Surface.  All settings associated with that surface are displayed in the Surface 
tab. 

Additionally, a surface of a 3D object can be selected by clicking on it using the mouse.  The selected surface 
then is displayed in the Apply To drop-down list box, and all settings associated with that surface are 
displayed in the Surface tab.  Note that Lock Selection checkbox must be unchecked in order to select a 
surface using the mouse.  When Lock Selection is enabled, mouse selection of a surface is disabled. 
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Color 
Color for 3D characters and 3D objects can enabled or disabled for a Surface.  A different color can be 
applied to each individual Surface. 

 If Color is enabled or disabled, and Texture is disabled, the color displayed in the Color Chip is 
applied to the selected Surface.  To remove the color, set the Transparency to 0. 

 If Color is enabled and Texture is enabled, the color displayed in the Color Chip is applied to the 
selected Surface. 

 If Color is disabled and Texture is enabled, the color displayed in the Color Chip is not applied to 
the selected Surface. 

Note that the position and intensity of the Global Light and any individual Lights can change the appearance 
of colors applied to 3D characters and objects.  A light positioned further away may make white look grayish.  
Proper intensity and position of lights, however, can enhance the appearance of depth of 3D characters and 
objects.  Refer to Properties > Lighting for additional information. 

Color selection is accessed from the Color Chip. 

 

Color Chip 

To enable/disable the application of a color: 
 Select (check)/deselect (disable) the Color checkbox. 

To select a color to apply: 
 Click the Color Chip.  The Color dialog box opens.  Refer to Color Selection for Light Sources 

and 3D Characters/Objects for information on setting a color in this dialog box.  Note that if the 
applied Color is white, the appearance of a Texture applied to the same Surface may or may not be 
affected.  Experiment with enabling and disabling the color to see which produces the optimal results.  
If the applied Color is black, however, a Texture applied to the same surface will not be visible 
unless Shininess is set towards 0. 
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Transparency and Shininess 
Transparency 
Transparency for a Surface can be set from completely opaque (0) to completely transparent (100).  
Transparency settings applied to selected text in a 2D Text Window affect all text in the 2D Text Window. 

To set Transparency: 
 Enter a value or drag the slider to the desired value.  The figure below shows complete 

Transparency applied to the Ball Surface of the object SoccerBall and to the Faces and Sides of 
the a 3D character.  The same Texture is applied to Panels of SoccerBall and to the Bevels of the 
3D character. 

 

Transparency Applied to Surface Elements of 3D Object and 3D Character 

Note that changing the Transparency property does not change the Transparency of the object itself, in that 
it does not provide alpha information where there was none before, nor does it change the Transparency 
level of existing alpha information of the object.  It does, however, change the video level at which the object 
is displayed.  This distinction is particularly important when setting up Mask Objects (2D bitmap graphics 
only).  The source of the displayed Transparency affects the appearance of the Mask Object depending on 
which system Lyric is running.  Refer to Mask Objects - Duet SD/HD/Offline or Mask Objects - Duet 
LE/LEX/PCI/PCI+ for additional information. 

Shininess 
Shininess determines the reflectivity of the 3D character or 3D object Surface.  The range is from 0 (flat 
matte) to 128 (most reflective).  Note that on entering the Properties tab, Shininess may be set to a default 
value, even though the object appears to be at a different value.  This default Shininess setting does not 
become active until clicked.   



 Color/Transparency/Background/Lighting/Texture  

 18-37 

Texture 
Applying a Texture 
Texture for 3D characters and 3D objects can enabled or disabled for a Surface.  A different Texture can be 
applied to each individual surface.  The source of the Texture can be a 2D graphic file, live video or from a 
2D Text Window.  The Texture can be oriented, rotated and scaled, and can be wrapped, made reflective or 
masked. 

 

Applying a Texture 

 If Texture is enabled, the Texture displayed in the Texture Chip is applied to the selected Surface. 

 If Texture is disabled, the Texture Chip is grayed out and Texture is not applied to the selected 
Surface. 

Note that the position and intensity of the Global Light and any individual Lights can change the appearance 
of Textures applied to 3D characters and objects.  Proper intensity and position of lights can enhance the 
appearance of depth of 3D characters and objects.  Refer to Properties > Lighting for additional information. 

The Texture drop-down list box (grayed out) is currently not implemented. 

Disabling Texture 
To disable the application of a Texture: 

 Select (check)/deselect (disable) the None radio button.  The Texture Chip becomes grayed out. 
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Applying Texture from a Graphics File 
Choose one of the following methods to select a Texture to apply to the 3D character or object: 

 Click the Texture Chip or select (click) the File radio button.  The Select a Texture dialog box 
opens.  Select a file, then click Open. 

 

Select Texture Source Dialog Box 

 Drag-and-drop a graphic from the Browser Bitmap Asset Window or Browser Aprisa 100 (Still) 
Asset Window  to the Texture Chip.  Refer to Browsers:  Bitmap Asset Operations and Browser:  
Aprisa Still Operations for additional details. 

 

Dragging-and-Dropping a Texture from the Browser 
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Once a Texture from a file has been selected: 
 The File radio button is automatically selected. 

 A Texture that does not completely cover the object surface repeats.  

 If the selected Texture contains Alpha information, i.e. built-in Transparency (as opposed to 
Transparency applied from the Surface Properties Transparency setting), the 3D character or 
object will contain transparent areas wherever transparent Texture is applied.  In the following figure, 
the Chyron logo contains areas that are completely transparent. 

 

Applying a Texture with Alpha Information 

 If the selected Texture contains Alpha information and a color is selected but not enabled, the color 
shows wherever there are transparent areas. 

Applying a Texture from Live Video (Duet SD Only) 
Live video can be mapped to the Surface of a 3D character or 3D object if there is a video source input to the 
Frame Buffer.  The default Source is Duet's Video I/O board.  Live Video texture is not supported for Duet 
LE/LEX/PCI/PCI+ and Duet HD.  To apply live video: 

1. Select the Live Video radio button.  The Video Surface Settings dialog box opens. 

 

Video Surface Settings 
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2. Select a video Source.  If a Duet SD system is equipped with a Mixer board, the mixer will also be 
available in the Source drop-down.  If the following error message is displayed, a video source is not 
available to the Frame Buffer. 

 

Live Video Error Message 

3. Set Enable Key Input, Enable Video Shaping, Enable VGE Shaping and Size parameters. 

4. Click OK.  The live video will be applied to the surface. 

Applying a Texture from an Object 
The contents of a 2D Text Window, including its Background, can be mapped to a 3D character or 3D 
object. 

1. Open a 2D Text Window, and create text.  RGB Font characters and bitmaps imported into the 2D 
Text Window can be used.  In the example shown during this procedure, there are three 2D Text 
Windows on the Canvas.  2D Text 1 has no Background.  It will be applied to the object 
SoccerBall. 

2. Select the 3D character or 3D object to which to apply the 2D Text Window. 

3. Select the Surface to which to apply the 2D Text Window. 

4. In the Surface tab, select (click) the Object radio button.  The Select An Object Texture dialog box 
opens.  In this example, three 2D Text Windows are available. 

 

Selecting an Object Texture 



 Color/Transparency/Background/Lighting/Texture  

 18-41 

5. Select (click) a 2D Text Window to use as a Texture Source.  In this example, 2D Text 1 is 
selected. 

 

2D Text 1 Selected 

6. Click OK.  The 2D Text Window is applied to the selected Surface of SoccerBall.  The figure below 
shows the same 2D Text Window mapped to both the Panels and the Ball Surfaces, so that there is 
continuity in the text.  Additionally, the color black was applied to the Ball surface, and the color gray 
was applied to the Panels. 

 

Mapping an Object 

When a 2D Text Window is mapped to a 3D character or object, it is turned off on the Scene Graph.  It can 
be turned back on for editing or display.  Note that to change the 2D text that had been applied to the object, 
the 2D Text Window must be made visible, edited, and then reapplied to the 3D character or object. 

About Orientation (U Offset, V Offset, Rotate and Scale) 
All changes in orientation, i.e. U-Offset, V-Offset, Rotate and Scale are relative to only to the 3D character 
or 3D object.  The orientation of the 3D character or 3D object within the space of the Canvas has no bearing 
on the orientation settings for the Texture. 

A change in the U-Offset, V-Offset, Rotate and Scale settings of a Texture do not affect the XYZ settings of 
a 3D character or 3D object, nor does a change in the XYZ settings of a 3D character or 3D object affect the 
U-Offset, V-Offset, Rotate and Scale settings of a Texture.   
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U Offset, V Offset 
The U Offset and V Offset settings allow horizontal and vertical adjustment of the applied Texture.  The 
range of both settings is from -1.000000 - +1.000000.  0 for both settings centers the Texture map. 

 U Offset:  Negative values move the Texture map left from center; positive values move the Texture 
map right from center. 

 V Offset:  Negative values move the Texture map down from center; positive values move the 
Texture map up from center. 

Note that the Texture may repeat as it is adjusted.  The figure below shows a 0 setting for both U and V; a U 
Offset = 0.170000, a V Offset = 0.150000, and a U and V Offset applied at the same time. 

 

Centered, U Offset, V Offset and Both Offset  

To set U or V Offset: 
 Adjust the Spin Control Box or the slider. 

Rotate 
The Rotate setting allows rotational adjustment of the applied Texture.  Range is from 0.000000° - 
360.000000°. 

 

No Rotation, 30° Rotation, 90° Rotation 

To set Rotation: 
 Adjust the Spin Control Box or the jog wheel. 
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Scale 
The Scale setting specifies how many iterations of the Texture are applied to the 3D character or 3D object.  
Range is from 0.010000 - 10.000000.  Values less than 1.000000 show a fraction of the Texture. 

 

Scale Set to 0.610, 1.00, 3.00, 10.00 

To set Scale: 
 Adjust the Spin Control Box or the slider. 

Wrap 
The Wrap setting specifies whether the selected Texture is applied to only the specified Surface element or 
to all Surface elements.  In the case of 3D characters, Wrap is available only if Face or All is selected.  If 
Wrap is enabled (checked), Texture settings for the other Surface elements are ignored, and the Texture 
applied to the currently selected Surface element is applied to the entire 3D character or object.  The figure 
below shows the same Texture applied to the Face, with Wrap disabled (left) and enabled (right).  

 

Wrap Disabled (Left) and Enabled (Right) 

To enable/disable Wrap: 
 Select (check)/deselect (uncheck) the Wrap checkbox. 
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Reflective 
When Reflective is enabled, the 3D character or 3D object acts like a mirror, with the File, Live Video or 
Object reflecting from the 3D character or 3D object.  Depending on the location of the object surface, 
different areas of the flag are reflected by the surface.  Both Reflective and Wrap can be simultaneously 
active.  Reflective and Masked cannot be simultaneously active.  Each surface of a 3D object (not a 3D 
character) can have Reflective, Masked or neither applied.  When applied to a surface of a 3D character, 
Reflective is applied to all surfaces of the character. 

 

Reflective Texture 

To enable/disable Reflective: 
1. If the system is a Duet LE/LEX/PCI/PCI+, skip to the next step.  If the system is Duet SD/HD, select 

(check) the Antialiased checkbox at the bottom of the Surface tab.  The 3D character or object must 
be antialiased in order for the Reflective texture to be applied. 

2. Select (check)/deselect (uncheck) the Reflective checkbox.  Note that if switching from Masked to 
Reflective, the Reflective checkbox must be clicked two additional times to apply the Reflective 
texture. 
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Masked 
When Masked is enabled, the File, Live Video or Object is mapped to the Canvas, and the 3D object 
reveals it as it passes over it.  If the Texture source does not cover the area of the Canvas, it repeats, or 
tiles, to fill up the Canvas.  Both Masked and Wrap can be simultaneously active.  Reflective and Masked 
cannot be simultaneously active.  Each surface of a 3D object can have Reflective, Masked or neither 
applied.  When applied to a surface of a 3D character, Masked is applied to all surfaces of the character. 

The following figures show the front of a 3D box with an American flag mapped as Masked.  Depending on 
the location of the front of the box, different areas of the flag are revealed by the "cutout" defined by the front 
of the box. 

 

Masked Texture Mapping 

If more than one object and/or different surfaces of the same object have Masked Textures from the same 
source applied, each Texture can be independently controlled.  For example, a Masked Texture applied to 
the front of the box can have a different Scale and Rotation from the Masked Texture on a side of the box.   

To enable/disable Masked: 
1. If the system is a Duet LE/LEX/PCI/PCI+, skip to the next step.  If the system is Duet SD/HD:  If not 

already selected, select (check) the Antialiased checkbox at the bottom of the Surface tab.  The 3D 
character or object must be antialiased in order for the Mask texture to be applied. 

2. Select (check)/deselect (uncheck) the Masked checkbox.  Note that if switching from Reflective to 
Masked, the Masked checkbox must be clicked two additional times to apply the Masked texture. 
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Antialiased – Duet SD Only 
Enabling Antialiased smooths the "stair-stepping" sometimes seen on the edges of a 3D character or object.  
Lyric automatically antialiases all 2D characters and objects.  On a Duet SD/HD system, Antialiased must be 
enabled in order to apply Reflective or Masked texture.  The Antialiased checkbox does not appear on the 
Surface Properties tab on a Duet LE/LEX/PCI/PCI+ system. 

To enable/disable Antialiased: 
 Select (check)/deselect (uncheck) the Antialiased checkbox at the bottom of the Surface tab.  

Tri (Triangles) 
Tri displays the number of triangles generated to create the 3D character or 3D object.  It is a good indicator 
of the complexity of the character or object. 
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19. Position, Rotation, Scale and Orientation 

Object Orientation and Point of View 

Overview 
Most objects on Lyric can be positioned, rotated, scaled, and have their center of rotation set.  These 
orientation attributes can be applied to a static object or can be set to change over time during an animation. 

Quick adjustments to these attributes can be applied using the Transform Tools in the Chyron Toolbar. 

 

Transform Tools 

More precise adjustments can be applied from the XYZ tab in the Properties Window. 

In addition, the point of view can be set, in the Camera tab in the Properties Window, to place the viewer 
closer of father away from the screen.  The projection, that is, how the viewer sees the scene, can be set to 
set to Orthographic or Perspective.  The Camera can be positioned as a static object, or can be animated.  
The Camera settings are part of the Lyric scene, and are applied to the output. 

In addition, there are Canvas view options:  Front, Top, Perspective, Left, or Multi View, which displays all 
views simultaneously.  Output from the Canvas is always from the Front view, regardless of the currently 
selected Canvas view.  Refer to the section on the Canvas for additional information on the Canvas view. 

Position Lock On 
Object Context Menu > Position Lock On 
While working with Lyric, it may be desirable to lock the position and orientation of an object or group of 
objects to prevent unintentional movement.  Position Lock On prevents an object (2D Text window, 2D or 
3D object, etc.) from being moved on its X, Y or Z axes, as well as from being rotated, scaled or changing its 
center of rotation.  When Position Lock On is enabled, the Position settings in the Properties > XYZ tab, as 

well as the Transform Tools , become inactive when the locked 2D Text window is active 
(selected). 

To lock/unlock the position of an object or group of objects: 
 Right-click on the object or group of objects, then select Position Lock On from the menu. 

o If there is no checkmark next to Position Lock On, a checkmark appears next to it when 
selected, indicating that the object's or object group's position is locked. 

o If there is already a checkmark next to Position Lock On, it will disappear when selected, 
indicating that the object's or object group's position is no longer locked. 
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Transform Tools 
View Menu > Chyron Toolbar > Transform Tools 

 

Transform Tools 

Transform Tools provide specialized cursors for repositioning, rotating, scaling and changing the center of 
rotation for almost any object on the Canvas. 

 If the currently selected object is an individual light source, only Position can be adjusted. 

 Transform functions are not available to the Global Light object. 

While Transform Tools provide a quick way to perform these operations, fine-tuning can be accomplished in 
the XYZ tab of the Properties window.  In addition, settings specifying how Transform operations are applied 
are also set in the XYZ tab. 

Transform operations can be applied to a single keyframe of an object's Timeline, or all Keyframes of an 
object's Timeline.  Refer to Properties > XYZ for details. 

NOTE REGARDING GROUPED OBJECTS 
When using the mouse in conjunction with Transform Tools to move, rotate, scale or 
change the center of rotation of a grouped set of objects, the user can manipulate the 
group as one unit, even if only one object of the group is selected.  To manipulate an 
individual object within group, hold down the Shift key while using the mouse to click 
and drag the object to its new Position/Rotation/Center of Rotation.  

Edit Position 

Transform Toolbar > , Transform Toolbar > Ctrl + ;  Also from Properties > XYZ > Position 

To change the XY position of an object on the Canvas: 

 Click , then click-and-drag the selected object to a new XY position. 

To change the Z position of an object on the Canvas: 

 Click , then press and hold Ctrl while clicking-and-dragging the selected object to a new Z 
position.  Moving the cursor up on the Canvas repositions the object forward in Z-space; moving the 
cursor down on the Canvas repositions the object back in Z-space. 

Edit Rotation 

Transform Toolbar > , Transform Toolbar > Ctrl + ;  Also from Properties > XYZ > Rotation 

To change the rotation of an object around the X and/or Y axis on the Canvas: 

 Click , then click-and-drag the selected object to a new XY position.  Moving the cursor to the 
left/right rotates the object around the Y-axis; moving the cursor up/down rotates the object around 
the X-axis.. 

To change the rotation of an object around the Z-axis on the Canvas: 

 Click , then press and hold Ctrl while clicking-and-dragging to rotate the selected object around 
the Z-axis.  Moving the cursor up on the Canvas rotates the object counter-clockwise around the Z-
axis; moving the cursor down on the Canvas rotates the object clockwise around the Z-axis. 
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If 2D text or a 2D bitmap is moved to a position that is 180° relative to the viewer (“edge-on”), it will seem to 
disappear. 

 

Text, Bitmap and 3D Object Rotations 

Edit Scale 

Transform Toolbar > , Transform Toolbar > Ctrl + ;  Also from Properties > XYZ > Scale 
Scaling can be applied in a freeform mode, or with Locked Aspect Ratio.  This attribute is set in Properties 
> XYZ > Rotation. 

To change the XY scale of an object on the Canvas: 

 Click , then click-and-drag the selected object to change its size.  Moving the cursor to the 
top/bottom scales the object taller/shorter respectively; moving the cursor left/right scales the object 
narrower/wider respectively. 

To change the Z scale of a 3D object on the Canvas: 

 Click , then press and hold Ctrl while moving the cursor up to scale the 3D object larger in the Z-
plane, or down to scale the 3D object smaller in the Z-plane.  Note that Z-scaling is implemented only 
for 3D objects. 

Edit Center of Rotation 

Transform Toolbar > , Transform Toolbar > Ctrl + ;  Also from Properties > XYZ > Center of 
Rotation 
The  Center of Rotation determines the point about which an object rotates when a rotation is applied.  Note 
that if adjusting the Z Center of Rotation as well as an XY Center of Rotation, it must be performed before 
the adjustment to the XY Center of Rotation.  Note that the Center of Rotation can be set to be absolute on 
the Canvas, or relative to the position of the object.  This attribute is set in Properties > XYZ > Center of 
Rotation. 
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The Center of Rotation display on the Canvas can be toggled on or off: 
 Select the object and then right-click.  Select Show Center of Rotation. 

 

Center of Rotation 

The Center of Rotation can be repositioned in XYZ space. 

To set the XY Center of Rotation for a selected object on the Canvas: 

 Click , then click the point on the Canvas about which the object should rotate.  If the Center of 
Rotation display is enabled, it moves to follow the cursor. 

 

Center of Rotation Cursor 

To set the Z Center of Rotation for a selected object on the Canvas: 

 Using the Ctrl key +  is not yet implemented.  The Z Center of Rotation should be set in 
Properties > XYZ > Center of Rotation. 

To quickly return the Z Center of Rotation for a selected object on the Canvas to 0.000: 

 Click , then click the Canvas. 
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XYZ Properties 
Properties > XYZ 
The XYZ attributes of an object determine its orientation in the Lyric Canvas' 3D space.  Settings are based 
on the same type of XYZ axes used for mathematics. 

 

XYZ Axes 
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XYZ Properties affect positioning and rotation for all objects in Lyric, including 2D text, 2D bitmaps, 
Flipbooks, 3D characters, 3D objects, the Camera and light sources.  Parameters that are set in XYZ 
Properties  are immediately reflected on the Canvas. 

 

XYZ Properties 
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If the currently selected object is an Individual Light source, Position is the only field in the XYZ window that 
is available. Note that no positioning of the Global Light source is possible. 

Any change to an XYZ Property is applied to all currently selected objects.  Refer to Transform Tools for 
additional information on XYZ attributes. 

Property  Description 

Rotation  The Rotation settings specify how an object rotates about the 
X, Y and Z axes.  Circular Sliders, also known as Jog Wheels, 
and Spin Control Boxes are used to adjust rotation values. 

Position  The Position settings specify the location of the object in XYZ 
space.  The Canvas center is the origin point; i.e., X = 0, Y = 0, 
Z = 0. 

Scale The Scale settings specify how the object is scaled in relation to 
its original size.  Scaling is applied to the X, Y and Z axes.  
Settings can be individually applied to each of the axes, or can 
be evenly applied to the X and Y axes in order to maintain the 
aspect ratio of the object. 

 If Lock Aspect Ratio is not enabled (unchecked), the 
value for each of the axes can be individually set. 

 If Lock Aspect Ratio is enabled (checked), any change 
to the X value is reflected in the Y value, and vice versa. 

Center The Center settings specify the center point about which an 
object rotates and from which it is scaled. 

 If Relative to Position is enabled (checked), the center 
point about which the object rotates or from which it is 
scaled is relative to the individual object. 

 If Relative to Position is disabled (unchecked), the 
object rotates about or is scaled from the center of the 
Canvas. 

The Center of Rotation display on the Canvas can be toggled 
on or off: 

 Select the object and then right-click.  Select Show 
Center of Rotation. 

 

Show Center of Rotation 
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Property  Description 

 

Single 
Keyframe 
Adjust 

 

Global 
Keyframe 
Adjust 

Single/Global Keyframe Adjust determines whether changes 
to the XYZ Properties affect a single Keyframe or all 
Keyframes of a selected object(s) in an animation.  The down 
arrow specifies Single; the horizontal arrows signify Global 
(all). 

When Single (arrow down) is selected, any change to the XYZ 
Properties of an object results in the creation of a new 
Keyframe at the frame (Timeline location) at which the change 
was made.  For example: 

1. Position the Time Indicator on the Timeline at 0. 

2. Place an object at position X = 0.000, Y = 0.000, Z = -
2.0, and all other XYZ settings at default. 

3. Move the Time Indicator to 2 seconds 

4. Move the object to X = 0.500, Y = 0.500, Z = -2.0, and 
all other XYZ settings at default.  A new Keyframe is 
created at 2 seconds. 

When Global is selected, any change in the XYZ Properties of 
a selected object(s) in the animation results in the same change 
applied to all of the Keyframes of the selected object(s) in the 
animation.  For example: 

1. Place an object on the Canvas, and then place a 
second object directly on top of the first object. 

2. Animate both objects on exactly the same path. 

3. Execute the animation and observe the positions of the 
objects. 

4. Select one of the objects, then change its X position by 
+0.500, and its Y position by +0.500. 

5. Execute the animation.  The animation of the selected 
object executes to the upper right of its original path.  
The object that was not selected animates on its original 
path. 

Global Keyframe Adjust is a valuable tool when used in 
conjunction with Motion Paths Copy/Paste Path function.  
Refer to the section on Motion Paths for additional information. 

Reset to 
Default 

Restores all XYZ values for the selected object(s) to default 
settings. 

Rotation:  All 0 
Position:  X = 0.000; Y = 0.000; Z = -2.000 
Scale:  All 1.000 
Center:  All 0.000 
Lock Aspect Ratio:  Off 
Relative to Position:  On 

Single/Global Keyframe Adjust:  Single 

Do not use this function to reset the default values for a Video 
Region (Duet SD), as it resets scale to X = 1.000; Y = 1.000; Z 
= 1.000 instead of X = 1.333; Y = 1.000; Z = 1.000. 
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Camera Properties 
Properties > Camera 

Camera properties, accessed from the Properties > Camera tab, describe how the Canvas is to be viewed 
(Projection) and where the viewer is represented by a Camera (Camera Lens).  Like any other Lyric object, 
the Camera may be adjusted, repositioned and even animated.  The Camera feature is a powerful editing 
tool, enabling you to quickly scale or reposition all objects on a Canvas, simply by changing the viewer's 
perspective. 

  

Properties:  Camera  

Property Description 

Orthographic  Orthographic Projection views the object(s) as if they were placed on a 
drawing plane perpendicular to both the viewer and the lines of projection.  An 
Orthographic camera is fixed in space and renders objects at an absolute size 
on a flat plane.  When Orthographic Projection is selected and rotated 
objects are viewed, they are displayed as Isometric projections.  Camera 
Lens adjustment is not available when Orthographic Projection is selected. 
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Property Description 

Isometric Isometric Projection is a subset of orthographic projection, in which only a 
single plane of projection is used (see above).  In renderings containing 90° 
angles, the lines that form the 90° angles are parallel to three rectangular axes, 
and the planes are parallel to three rectangular planes passing through the 
three axes. 

 
Perspective  Perspective Projection differs from Orthographic Projection in that there is 

always a Vanishing Point, so that objects further away from the camera 
position tend to reduce in size until the Vanishing Point is reached.  Note that 
adjustments in Camera Lens affect the viewer perception of where the 
Vanishing Point is located. 

 
Camera Lens  Camera Lens adjusts the magnification of the Camera and the apparent 

distance between the view and the objects when Perspective Projection is 
selected.  The range of Camera Lens adjustment is from 0 (objects are 
closest) to 180 (objects are furthest away).  Camera Lens adjustment is 
available only when Perspective Projection is selected. 
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20. Animation 

Overview 
Lyric can animate any objects or objects placed on the Canvas, including, but not limited to 2D Text 
Windows, 2D Roll Windows, 2D Crawl Windows, 2D Type On (Slow Reveal) Windows, 2D Spline 
Windows, 3D characters, 3D objects, bitmaps, object groups, Individual Light Sources, the Camera and 
specialized objects such as Flipbooks.  

Lyric uses a Timeline, Keyframe Graph and Properties and Keyframes in creating and editing animations.  
The Timeline and Keyframe Graph provide a comprehensive linear display of every object on the canvas, 
and reflects animation changes over time.  Properties > XYZ display the coordinates of selected object at a 
particular Frame (also sometimes referred to as time).  A Keyframe is a selected frame on the Canvas where 
an object attribute(s) can be edited. 

You do not have to set up a Keyframe for every frame of an animation.  For a simple move, such as sliding 
an object from the upper left corner of the screen to the lower right corner of the Canvas, only two Keyframes 
need to be assigned: the Start Keyframe and the End Keyframe. 

Lyric can also animate a variety of Attributes for almost any object that can be placed on the Canvas. 

Object Type Attribute(s) that may be animated 

Global Light Intensity, Color (RGBA Diffuse). 

Flood Light Intensity, Color (RGBA Diffuse), XYZ Position. 

Spot Light Intensity, Color (RGBA Diffuse), XYZ Position, XYZ 
Rotation, Angle (Focus), Shine. 

2D Characters XYZ Position,  XYZ Rotation, XYZ Scale, XYZ Center of 
Rotation. 

2D Text 
Windows 

XYZ Position,  XYZ Rotation, XYZ Scale, XYZ Center of 
Rotation, Transparency (including the Background). 

Transparency does not appear on the Timeline until it is set in 
the Properties > Surface tab.  To do so: 

 Set starting, keyframe (if appropriate) and ending 
Transparencies of the 2D Text Window, using the 
Transparency spin box or slider in the Properties > 
Surface tab.  When Transparency is set at two 
different points in an animation, it becomes an element 
which can be manipulated on the Timeline and the 
Keyframe Graph.  When the Transparency of 2D Text 
Window is animated, the animated Transparency is 
applied to the entire 2D Text Window, including the 
Background. 

2D Bitmaps XYZ Position,  XYZ Rotation, XYZ Scale, XYZ Center of 
Rotation, Transparency, Shininess. 

Camera  Camera Lens (Zoom effect). 

3D Text XYZ Position,  XYZ Rotation, XYZ Scale, XYZ Center of 
Rotation. 



Lyric User Guide 

 20-2 

Object Type Attribute(s) that may be animated 

3D Objects XYZ Position,  XYZ Rotation, XYZ Scale, XYZ Center of 
Rotation, Transparency. 

The transparency of 3D characters can be animated.  For each 
character: 

1. In the Properties > Surface tab, set Apply To to All. 

Note that even though the animation transparency is 
applied to All (Face, Sides and Bevels), 
Transparency that is already applied to the face, sides 
or bevels will still be applied in conjunction with the 
animated Transparency, although the separately 
applied transparencies will not animate.  For example, if 
the face is set at 50%, the sides and bevels are set to 
0%, and the animation is set from 100% to 0%, the 
result is an animation that transitions from 100% of 50% 
(completely transparent) on the face to 0% of 50% 
("half" transparent) on the face. 

2. Set starting, keyframe (if appropriate) and ending 
transparencies using the Transparency spin box or 
slider.  When Transparency is set at two different 
points in an animation, it becomes an element which 
can be set on the Timeline and the Keyframe Graph. 

Transparency Attribute is visible only when Transparency is applied at two 
different points for the same object in an animation.  See 
specifics above in this table for details. 

Setting Up a Simple Animation 
Let's set up a simple animation. 

1. Open a new Canvas, then type the 3D character W in the upper left corner. 

2. A new object W is added to the Scene Graph.  If the Scene Graph is not displayed, select Scene 
Graph from the View menu.  Note that there are three other objects on the Scene Graph:  Light 1; 
Global Light and Camera.  These objects are present in every Lyric composition.  They can be 
turned on/off by selecting/deselecting their checkboxes, but they cannot be deleted.  They can also 
be animated like any other object. 

 Light 1 acts as a virtual light whose position, diffusion, color and other attributes can be set.  
Additionally, five additional controllable lights can be added to a Lyric scene.  Default 
Intensity is 85; color is gray; beam type is Flood.  Refer to Properties > Lighting for 
additional details.   

 Global Light is washes the entire scene.  Intensity and color can be set.  Default Intensity 
is 85; color is gray.  Refer to Properties > Lighting for additional details. 

 Camera determines where the viewer is positioned, focal length of the lens and what type of 
projection is used to render the scene.  Default Projection is Perspective; Camera Lens 
focal length is 65.000.  Refer to Properties > Camera for additional details. 
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Scene Graph - New Object "W" Added 

3. A new object W is also added to the Scene Graph.  If the Timeline is not displayed, select Timeline 
from the View menu.  Note the small red square that is positioned at the 00:00:00:00 on the Timeline 
for W.  This is a Keyframe that is automatically added to any Object or Attribute Timeline when the 
object is added to the Canvas. 

 

Timeline at 00:00:00:00 Seconds 

4. Use one of the following methods to move the Time Indicator to 00:00:05:00: 

 Click and drag the green Time Indicator on the Timeline or the Keyframe Graph (see 
below) to 00:00:05:00. 

 

Timeline at 00:00:05:00 Seconds 
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 Enter the time in the Frame Counter Display. 

 

Frame Counter Display 

 Click the on the Go to End button  on the Transport Controls.  This moves the Time 
Indicator to the last Frame in the animation. 

5. On the Canvas, click and drag the W down to the lower right corner.  The following will now have 
occurred: 

 A Keyframe has been added to the Timeline at 00:00:05:00.  The presence of two 
Keyframes on a Timeline indicate that the scene has become an animation. 

 The Transport Controls, which normally appear black, have turned blue, indicating that 
there is an animation that is ready to play. 

6. Click the Play  button on the Transport Controls to execute the animation.  The W should move 
smoothly in a straight line from the upper left corner to the lower right corner.  Note that the Frame 
Counter updates as the animation plays, but the Time Indicators on the Timeline and the 
Keyframe Graph (see below) do not.  They do, however, update when the animation is stopped, 
either in midstream or at the end.  

 

Animation Showing Two Keyframes 
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Lyric automatically interpolates the Frames positioned between the two Keyframe to produce the 
animation.  The duration of an animation has no bearing on the number of assigned Keyframes 
necessary to perform the effect.  The simple slide described above requires only two assigned 
Keyframes for a five-second effect. 

7. The motion of an animation is reflected in the Keyframe Graph, which graphically displays the 
change in each of the attributes of an object over time.  If the Keyframe Graph is not displayed, 
select Keyframe Graph from the View menu.  The default view of the Keyframe Graph is the 
XPosition.  Keyframes appear as small red dots at the ends of the Keyframe Graph.  Notice how 
the X value increases in value over time, as the W moves from left to right on the Canvas. 

 

Keyframe Graph - XPosition Displayed 
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8. Next, right-click on the Keyframe Graph, but not on a Keyframe, then select YPosition from the 
context menu to view the Y attribute.  Notice how the Y value decreases in value over time, as the W 
moves from top to bottom on the Canvas. 

 

Keyframe Graph - YPosition Displayed 

9. Experiment with clicking and dragging the Keyframe Graph or an individual Keyframe, and note the 
effect on the animation.  Try also left-clicking on the Keyframe Graph of an attribute at a midpoint, 
then select Add Keyframe from the context menu.  Drag the Keyframe to a new position.  Play the 
animation.  What happens?  How has the Timeline changed? 
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10. Examine the Properties > XYZ tab.  If the Properties Window is not visible, select Properties from 
the View menu to display, then select the XYZ tab.  The Position X, Position Y, Position Z, and 
other coordinates reflect the position and orientation of the object at the Frame indicated by the Time 
Indicator or Frame Counter.  Note that Position, Rotation, Scale and Center of Rotation can be 
adjusted from this tab, or via the Transform Tools.  Experiment with changing the settings and note 
how the effect on the animation and the settings in the Timeline and the Keyframe Graph. 

 

XYZ Properties 

11. Try adding Loops and Pauses to the animation.  Refer to Loops/Pauses Properties and Animation 
Properties  for details. 

Any change to the Timeline, Keyframe Graph, Scene Graph, Properties, etc., updates all such settings 
throughout the Lyric interface. 

Refer to the sections on Timeline, Keyframe Graph, XYZ Properties and Transform Tools for additional 
information on animation. 
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Saving an Animation 
An animation can easily be saved by using the Address Keypad or to record it as a Lyric message with a 
numeric file name.  The message can then be played back in Read Next and Read Previous sequences.  
Messages recorded in this manner are automatically saved in the Default Message Directory as determined 
by the Config Menu > Preferences > Defaults Paths settings. To record: 

1. Using the Address Keypad, enter a Message ID.  If a Message ID is not entered, the animation is 
saved to the currently displayed Message ID. 

2. Press Record on the Duet keyboard, or the minus (-) key on the Address Keypad of the PC 
keyboard.  The animation is recorded to the Message ID number in the *.lyr format. 

A Lyric animation can also be saved under its current name using the File Save function. 

1. In the Windows Toolbar, click the Save icon , press Ctrl + S or select Save from the File menu.  
A prompt is displayed asking for overwrite permission.  If the file has not yet been named, it is 
assumed by Lyric that the name is Untitled. 

 

Overwrite Confirm 

2. Click OK to save the animation, or Cancel to cancel the save. 

It may be desirable to save the animation as a named file, set specialized parameters or to save the file in a 
different format, such as *.avi. 

1. From the File menu, select Save As.  The Save Animation dialog box opens. 

 

Save Animation Dialog Box 

2. Select a file format from the Save as Type drop-down list box.  In the preceding figure, the *.lyr 
format is selected. 
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3. In the Start Frame and End Frame fields, set the Start and End Frames of the animation.  The 
default values are set to record the entire animation.  These are the only settable parameters 
available for *.lyr animations. 

4. Optional - Available for some non-Lyric animation formats, as well as some static graphics formats:  
Adjust values for Image Width and Image Height. 

5. Save RGB is always active.  RGB information is always saved. 

6. If an animation is saved with Interlaced enabled (checked), the odd and even fields of the TGA (or 
other bitmap format file) are rendered offset in time by 1/60 second (NTSC) or 1/50 second (PAL) on 
playback.  Interlaced should be enabled if the animation is to be saved to an animation format such 
as AVI, and then played back through a Matrox clip player.  Otherwise,  Interlaced can be disabled. 

7. Optional - Available for some non-Lyric animation formats, as well as some static graphics formats:  
Select (check) Clip to Safe Title.  If Clip to Safe Title is not selected, the contents of the entire 
Canvas is recorded as the graphic.  If Clip to Safe Title is selected, only the contents within the Safe 
Title Area are recorded as the graphic.  The Safe Title Area can be adjusted in the Safe Title 
Adjust dialog box, accessed from Config Menu > Safe Title Adjust.  

8. Optional - Available for some non-Lyric animation formats, as well as static graphics formats:  Select 
(check) Save Alpha.  Alpha information is always saved with *.lyr animations.  The Alpha setting is 
also available for those file formats where the Alpha (transparency) information can be saved as part 
of the graphics file (such as Adobe® Photoshop® *.psd).  If Save Alpha is not selected, the Alpha 
information is not saved with the file.  If Save Alpha is selected, the Alpha information is saved with 
the file. 

9. Enter a File Name. 

10. Click Save.  The animation is saved to the selected file format. 
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Animation Settings Preferences 
Config Menu > Preferences > Animation Settings 
Animation length, execution, memory allocation, and other animation parameters are set in the Animation 
Settings Preferences.  The Animation Settings Preferences for the Duet SD, HD and LE/LEX/PCI/PCI+ 
are almost identical to each other. 

To access Animation Settings Preferences, pull down the Config menu, then select Preferences.  The 
Preferences window opens.  Click the Animation Settings tab.  

 

Animation Settings Tab 

Note that the Frame Counter at the top of the middle column is labeled Default Stream Size when the 
system is a Duet SD/HD, and is labeled Duet LEX Streaming in Duet LE/LEX/PCI/PCI+ systems, although it 
is grayed out (inactive) on Duet LE/PCI systems. 

The Duet LE(X)PCI(+) Settings in the third column are only active on Duet LE/LEX/PCI/PCI+ systems. 

Animation Length, Stream Size and Streaming 
 Default Animation Length defines the duration for animations when Lyric is first launched.  Unless 

changed by the user, the Default Animation length is five seconds (150 frames).  Animation length 
can be changed in a number of ways during composition, including Modify Animation Length 
(accessed by right-clicking on the Timeline) and Animation Properties, accessed from the 
Properties window.. 

 Default Stream Size (Duet SD/HD) determines the speed with which information is processed by 
Duet's video engine.  The video information is processed in segments determined by the Default 
Stream Size, as opposed to in a continuous stream (as on the Duet LEX/PCI+).  It is recommended 
that this adjustment be left at the default setting.  Experimentation with Default Stream Size, 
however, can smooth the playback of Rolls, Crawls, and other animations.  The Default Stream 
Size cannot be set to a higher value than the Default Animation Length. 

 Duet LEX Streaming (Duet LEX/PCI+) determines the length of the video that is preloaded.  The 
video is processed in a continuing stream.  As video is rendered, new video preloaded to replace it.  
This allows for the rendering of animations that exceed the 6-second limit for Load-and-Play 
animations.  Refer to Streaming Animation for additional information. 
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Default Interpolation 
Interpolation determines how the transition is made from one keyframe to the next in an animation. 

 

Keyframe Graph Showing Linear and Spline Interpolation 

The following types of interpolation can set in Animation Settings Preferences. 

 Linear Interpolation moves an object in an animation at constant speed from Keyframe to 
Keyframe. 

 Spline Interpolation provides the ability to vary the speed and path the object follows during the 
animation. 

 None Interpolation causes the animation to shift between Keyframes instantaneously, without 
following a continuous path from one Keyframe to the next.  This is also known as Jump 
interpolation. 

Interpolation for individual keyframes can also be set from the Timeline, Keyframe Graph and the Motion 
Path.  In addition, a fourth type, Ease, can be set for individual keyframes in the Timeline and the Keyframe 
Graph. 

Refer to the section on Preferences:  Animation Settings for detailed information on the different types of 
Interpolation, including Ease. 

Options 
The following options determine what occurs when the animation is read and how the animation is executed. 

Show Preview Frame 
Typically when animations are read, the first or frame is displayed on the Canvas.  If working primarily with 
animations that start off-screen, it may be advantageous to have a different frame, known as a Preview 
Frame, display on the Canvas when they are read.  The Preview Frame is set when the message is 
recorded. 

 If Show Preview Frame is selected (checked), the frame saved as the Preview Frame in the 
animation is displayed on the Canvas when the animation is read.  If a frame had not been specified 
as a Preview Frame when the message was saved, then the last frame is displayed. 

 If Show Preview Frame is not selected (unchecked), then the first frame of the animation is 
displayed on the Canvas when the animation is read. 

Show Preview Frame does not affect animation execution.  The animation still executes from the 
first frame. 

Refer to Reading and Recording Messages:  Selective Recording - Message, with Options for details on 
setting a Preview Frame in a message. 
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Prompt to Play on Duet 
When an animation message is read to the Canvas, Lyric can request confirmation before executing the 
animation. 

 If Prompt to Play on Duet is selected (checked), Lyric requests confirmation before executing the 
animation to the Duet output. 

 If Prompt to Play on Duet is not selected (not checked), Lyric executes the animation to the Duet 
output without confirmation.  When Prompt to Play on Duet not active, playback on the video output 

occurs regardless of whether the Duet Live button  is active or not. 

On Duet LE/LEX/PCI/PCI+ systems, the Prompt to Play on Duet setting pertains Load-and-Play Mode, not 
Streaming Animation. 

AutoPlay On Read 
Auto Play on Read causes animation playout to begin automatically when a message is called up, without 
awaiting a Play command. Note: On Duet LE and LEX systems, the load method is set by the default Frame 
Based Load setting (see later in this section). 

True 3D Ordering (Duet SD/HD Only) 
NOTE 

On Duet LE/LEX/PCI/PCI+ systems, 3D Ordering can be controlled by setting Internal 
Properties Depth Test and Depth Write for each object. 

Grouped 3D objects that are rotated in an animation, not only rotate as a group, but also rotate individually 
within the group.  This may at times be desirable.  To rotate the group objects as a group without each object 
rotating individually, True 3D Ordering should be selected (checked). 

The following figure shows a grouped set of unrotated 3D characters. 

 

Unrotated 
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The following figure shows two groups of 3D characters: the top group rotating counter-clockwise; the bottom 
group rotating clockwise.  True 3D Ordering is not enabled.  Note that the characters in both groups are also 
rotating individually within their own groups. 

Because of this individual rotation, the order in which the characters were typed (N-E-W-S, which places each 
subsequently typed character on the one preceding it), and the direction of the rotation, the characters in the 
top group appear to be overlapping in the wrong order.  The grouped characters in the bottom row are 
behaving in the same manner, but the overlap does not appear to be incorrect because of the direction of the 
rotation. 

 

Rotated 

The following figure shows the same two groups of 3D characters: as before, the top group is rotating 
counter-clockwise; the bottom group is rotating clockwise.  In this example, True 3D Ordering is enabled, 
and therefore the characters in both groups are not rotating individually within their own groups. 

Both the top and bottom groups now have the correct appearance, regardless of the direction of rotation.  

 

Rotated -  3D Ordering Enabled 

Note that enabling True 3D Ordering requires additional processing time per field of animation.  It may be 
necessary to disable True 3D Ordering in order to play back the animation in real time. 

New messages should be composed with True 3D Ordering turned on.  However, leaving this option on 
while playing back animations created with earlier versions of Lyric may cause improper reproduction of the 
original message.  It is therefore suggested that the animation is previewed in order to determine the proper 
setting. 

Full Scene Antialiasing (Duet LE/LEX/PCI/PCI+ Only) 
The edges of 3D objects and 3D characters can sometimes appear jagged.  Full Scene Antialiasing can be 
enabled to smooth out the rough edges of these objects. 
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Rendering Mode 
The type and complexity of an animation may require that it be rendered in a specific manner in order to play 
back correctly.  In addition, depending on the system and the graphic boards, one Rendering Mode may be 
more suitable than another for playback.  Lyric has a variety of Rendering Modes to provide the highest-
quality playback. 

 Fast Rendering allows some animations that may not play back properly in real time to play back 
smoothly.  There may be an infrequent trade-off when Fast Rendering is enabled, in that the 
compositing of overlapped transparent pixels and the antialiasing of characters may not display 
properly.  Preview the animation before sending to air. 

 Normal Rendering plays back animations using Duet's normal rendering process.  

 Depth (2 Pass) corrects the rendering of 2D objects, that have transparency, and that either intersect 
in 3D space or overlap.  While rendering in this mode is slightly slower, it usually unnoticeable, due to 
the high rendering speed of current graphics cards. 

 Fast/Fix Key (Duet LE/LEX/PCI/PCI+ Only) corrects the rendering of the Key Out signal.  
Rendering in this mode is necessary only if the rendered Key signal is to be used downstream of the 
Duet system.  While rendering in this mode is slightly slower, it usually unnoticeable, due to the high 
rendering speed of current graphics cards.  Using this mode also requires the presence of specific 
graphics cards.  Contact Chyron Customer Service (631-845-2132) for additional information.  Note 
that on Duet SD/HD systems, using this mode is not necessary, as the Key signal is rendered 
properly. 

Rendering Mode can also be set for an individual message, overriding the default Rendering Mode set in 
Animation Settings.  Refer to Internal Properties for additional information. 

Duet LE(X)/PCI(+) Settings 
Frame Based Load (Quick Load) 
Frame Based Load (Duet LE/LEX/PCI/PCI+ only) provides the choice of choosing frame-by-frame (Quick 
Load) or field-by-field loading as the default load method.  Using Frame Based Load cuts memory 
requirements, as well as speeds the load process.  It can, however, result in less smooth playback, therefore, 
animations should be previewed before playing to air. 

 If Frame Based Load (Quick Load) is selected (checked), animations load frame-by-frame.  This is 

the same type of load performed when the Quick Load icon is clicked. 

 If Frame Based Load (Quick Load) option is not checked, animations load field-by-field. This is the 

same type of load performed when the icon is clicked. 

 Using either the Load function or the Quick Load function to load an animation 
overrides the default Frame Based Load setting after it is loaded. 

Enable SD Transfer Compatibility (Duet LE/LEX/PCI/PCI+ Only) 
Normally, executing an Xfer on LE/LEX/PCI/PCI+ systems causes any Roll, Crawl or Flipbook in the current 
composition to immediately play when it appears on the video output.  In contrast, when Xfer is executed on 
Duet SD systems, Rolls, Crawls and Flipbooks do not begin playing until triggered.  Selecting the Enable 
SD Transfer Compatibility checkbox gives this Duet SD-type behavior to Duet LE/LEX/PCI/PCI+ messages, 
causing Rolls, Crawls and Flipbooks not to start playout immediately upon transfer to video output.  Note 
that holding down the Shift key while executing Xfer always causes these types of animation to play 
immediately upon transfer to the video output, and may be used to override Enable SD Transfer 
Compatibility. 

Stream Intelligent Interface Default (Duet LEX/PCI+ Only) 
When animation executions are triggered by Intelligent Interface, enabling Stream Intelligent Interface 
Default streams animations on the Duet LE/LEX/PCI/PCI+ by default, as opposed to using Load-and-Play to 
execute the animations. 
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Refer also to Duet LE/LEX/PCI/PCI+ Streaming Animation. 

Animation Playback - Transport Controls, Reverse Animation 

Transport Controls 
The Transport Controls provide easy navigation and playback control of the current animation.  They are 
usually located at the bottom edge of the Canvas, and are organized as familiar Play, Stop, Rewind and 
Fast Forward buttons.  Intermediate buttons advance or reverse the animation by one frame or one second 
of video, or to the next/previous keyframe. The buttons at each end advance or reverse animation to the end 
or beginning of the sequence. 

 

 

Transport Controls 

Changes made with the Transport Controls buttons are reflected by the Frame Counter display, and by the 
Current Frame indicator on the Timeline and on the Keyframe Graph. 

The speed of the Advanced Image Effect can be changed during execution: 

 Press the up  cursor key to speed up the animation, or the down  cursor key to slow down the 
animation. 

Note the following with regard to changing speed: 
 A change of speed affects all animated components of a Lyric composition that are currently in 

progress.  Test speed changes before performing them on air.  It is recommended not to perform a 
speed change while an Advanced Text Effect is currently executing. 

 Clicking on the Timeline during execution may display new Keyframes that are generated when 
pressing the cursor keys to change speed.  These Keyframes are temporary and disappear once the 
execution is over and the mouse is clicked or a key is pressed. 

Reverse Animation 
Tools Menu > Reverse Animation 

Reverse Animation reverses the direction of the animation currently on the Canvas, causing the animation 
to run in reverse.  To apply Reverse animation: 

1. Click on the Canvas to make it active. 

2. Select Reverse Animation from the Tools menu. 

Once Reverse Animation has been applied, the reversed animation becomes the new forward animation 
state, which is why a checkmark does not appear next to the Reverse Animation item on the Tools menu. 

While Reverse Animation cannot be applied to selected objects, reverse and forward animations can be 
mixed on a Canvas: 

1. First create the animated objects that are to be reversed, then apply Reverse Animation.  
Remember that this now creates a new forward state. 

2. Now, create the animated objects that are to remain in the forward direction. 
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When executed, the objects to which the Reverse Animation was applied will still appear to animate in 
reverse, while the other objects will animate in the forward direction. 

Copy/Paste Animation State 
Copy Animation State:  Edit Menu > Copy Animation State;  2D Text Window/2D Object/3D Object 
Right-Click Menu > Copy Animation State  
Paste Animation State:  Edit Menu > Paste Animation State;  2D Text Window/2D Object/3D Object 
Right-Click Menu > Paste Animation State  
Animation attributes such as Position, Rotation, Scaling, etc., can be copied from one object and pasted to 
another. 

To copy animation attributes of an object: 
1. Click on the object on the Canvas or select it in the Scene Graph. 

2. Select Copy Animation State from the Edit Menu. 

OR 

Right-click on the object or its listing in the Scene Graph, then select Copy Animation State. 

The animation attributes have now been stored. 

To paste the copied animation attributes to an object: 
1. Click on the object on the Canvas or select it in the Scene Graph. 

2. Select Paste Animation State from the Edit Menu. 

OR 

Right-click on the object or its listing in the Scene Graph, then select Paste Animation State. 

The animation attributes have now been pasted to the new object. 

The same attributes can be pasted to other objects until a new Copy Animation Attributes operation 
overwrites the stored attributes. 
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Scene Graph 
The Scene Graph provides a listing of all objects in a composition, as seen below. Visible objects in the 
Scene Graph are listed in order of visual display-priority.  

If the Scene Graph is not visible: 
 Select Scene Graph from the View menu.  The Scene Graph is then displayed.  

 

Scene Graph  

The  checkbox next to each element determines that element’s visibility (and accessibility for editing) on the 
Canvas. When working on a complex composition, you may find it helpful to turn individual elements “on” and 
“off” for a better view of what you're doing.  The Global Light and Camera cannot be turned off (unchecked) 
or deleted from the scene. 

Object names can be changed in the Scene Graph.  Note that the names Camera and Global Light cannot 
be changed. 

1. Highlight the object name in the Scene Graph, then click the object name. 

2. Type the new name, then press Enter. 

The creation of a new scene is automatically accompanied by the creation of a Scene Graph, containing by 
default, a Camera, a Global Light source, and one movable Light Source (of the six individual lights that a 
composition may contain). Depending on Lyric's Preferences settings, a 2D Text window can also open by 
default with the creation of a new scene. 

Animated elements generated from Unicode characters are named U+<code>, as is indicated as such in the 
Status Bar and the Scene Graph.  A Unicode character(s) is brought into Lyric by first copying the 
character(s) either from existing text or from the Windows® Character Map.  The character(s) is then pasted 
into a 2D Text Window, using the Paste Unicode Text function, accessed either from the Edit menu, or by 
pressing Ctrl + Alt + V.  A Unicode character can be animated in the same manner as any other character. 
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The Scene Graph context menu is virtually the same as the Tools menu and the Canvas context menu.  To 
display the Scene Graph context menu: 

 Right-click on an empty area of the Scene Graph, i.e., not on an object listing. 

Color-Coding an Object Listing 
Object listings in the Scene Graph can be color-coded for easy identification.  When an item is color-coded, 
The listing is displayed in the selected color.  To color code a listing: 

1. Select (click) the object listing in the Scene Graph, and then right-click to display the object's context 
menu. 

2. Select Color-Code Object.  The Color dialog box opens. 

 
Color Dialog Box 

3. This is the same dialog box from which color is set for 3D characters, 3D objects and light sources.  
Select a color, and then click OK.  The color of the listing changes to the selected color. 

 
Color-Coding an Object Listing 

The following figure shows a Scene Graph with multiple color-coded object listings. 

 
Color-Coded Object Listings 

Refer to Color, Transparency, Background, Lighting and Texture - Color Selection for Light Sources 
and 3D Characters/Objects for additional information. 
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Selecting Canvas Objects via the Scene Graph  
If you select an object for movement on the Canvas (using the mouse), it is highlighted  for editing on the 
Scene Graph (and the Timeline).  Likewise, if you select an object on the Scene Graph, it is selected for 
movement via the mouse pointer on the Canvas. Selected object(s) may be positioned, scaled, and otherwise 
manipulated via the Properties menu, Toolbar, etc.   

Multiple-object selection follows Windows conventions. To select multiple objects whose entries are adjacent 
on the Scene Graph, select the first or last item and hold SHIFT while clicking the object at the other end of 
the range of entries.  To select multiple non-adjacent objects, hold the CTRL key while you clicking the 
desired elements. 

Selecting Overlapping Objects on the Canvas (ALT + Click)  
When Canvas objects overlap, it can be difficult to select the one you wish to work with. Position your cursor 
over the overlapping objects and hold down the ALT key while clicking with the mouse. Repeat this action 
until the Scene Graph (and Timeline) show that the desired object has been selected. 

Display Priority 
Display priority determines the overlapping of one object over another on the Lyric Canvas.  It is determined 
by the location of the objects along the Z-axis.  The higher the Z-axis value, the closer to the front the object 
appears. 

Additionally, when objects are introduced to the Canvas, they are automatically placed at the same Z-
position.  Each new object that is added to the Canvas has a higher Display Priority than the object that was 
previously placed on the Canvas.  This is reflected in the Scene Graph, as each new object is added to the 
top of the listing.  The higher the position of the listing in the Scene Graph, the closer to the front the object 
appears. 

Display priority, i.e., the layering of the objects on the Canvas, can be changed by dragging-and-dropping an 
object listing to a different position on the Scene Graph.  Additionally, objects within a group can be dragged-
and dropped to new positions within the group.  The group itself can also be dragged-and-dropped to a new 
position. 
To facilitate these changes, a group added to a new message will now dictate display priority of all its 
members of equal Z value.  This is enabled/disabled via Use Group Priority, accessed from the context 
(right-click) menu for the object in the Scene Graph or Canvas, and then selecting Internal Properties. 
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In the following illustration, the 3D objects MICROSCP and BBALL each have a Z-position value of -2.000, 
which defines their positions on the XYZ axes.  The object BBALL, however, occludes the object MICROSCP 
because it has display priority due to its position in the Scene Graph. 

 

On the Scene Graph, drag-and-drop the BBALL object below the MICROSCP object. 

 

Note that the two objects have been transposed on the Canvas, and that the object MICROSCP occludes the 
object BBALL. Note that their Z-position values remain identical. 



 Animation  

 20-21 

Grouping and Ungrouping Objects  
Select multiple objects.  

 

Selecting Multiple Objects 

To group the objects: 

 Click the Group icon . 

The grouped objects are labeled and  rearranged on the Scene Graph as shown: 

 

Grouped Objects - Unexpanded 
 

Grouped Objects - Expanded 

At left, the grouped object is shown in unexpanded view. At right, the  button has been clicked to show 
expanded detail of the group.  

To ungroup the objects: 
 Select the grouped object in the unexpanded view, or select any object in the expanded view, and 

then click the Ungroup icon . 

Renaming/Deleting Objects On the Scene Graph  
To help keep track of Canvas objects, you may rename them (with the exception of 3D characters and 
imported 3D objects).  Double-click on the desired Scene Graph object to rename it. 

An object(s) can be deleted from the Scene.  The only objects that cannot be deleted are the Global Light 
and the Camera.  To delete an object from the Scene: 

 Select the object(s) on the Scene Graph, then press Ctrl + Delete, select the Delete icon  from 
the Windows toolbar, or select Delete from the Edit menu. 
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Shortcuts for Navigating the Scene Graph and the Timeline 
 An item on the Scene Graph can be selected as follows: 

 Type the first letter of the object name. 

 Use the Up and Down arrow keys and the Home and End keys to select entries. 

An object on the Scene Graph can be made visible or not visible on the Canvas or output.  When the object's 
checkbox is selected, the object is visible on the Canvas or output.  When the object's checkbox is 
deselected, the object is not visible on the Canvas or output. 

 Press the keyboard's Space bar or click the checkbox to select (check) or deselect (uncheck) a 
selected Scene Graph object. 



 Animation  

 20-23 

Timelines 
View Menu > Timeline 

Introduction 
The Timeline and Keyframe Graph each provide a method for displaying the animation state of a 
composition and its constituent elements on the Canvas at any given time.  The Timeline is composed of 
Object Timelines and Attribute Timelines, which can be modified by changing length and position; and 
Keyframes can be added and modified so that the attributes (Position, Rotation, etc.) of an object can be 
precisely controlled. 

Viewing a Timeline 
If the Timeline is not visible: 

 Select Timeline from the View menu.  The Timeline is then displayed. 

When a blank Canvas is opened, the Timeline contains Object Timelines for the default objects that are 
always part of a Lyric composition:  Light 1; Global Light and Camera.  The length of the animation is 
determined by the Default Animation Length set in the Config Menu > Preferences > Animation Settings.  
Note that the highlighted object name in the Object Timeline is the same as the highlighted object name in 
the Scene Graph.  When an object is highlighted, it is the active object on the Canvas.  Any modification is 
applied to that object. 

 

Timeline for a Blank Canvas 

Adding an Object 
Each time a new object is added to the Canvas, an Object Timeline displaying the object name and a set of 
Attribute Timelines for the object are added to the Timeline.  The object name is also added to the Scene 
Graph. 

Deleting an Object 
An Object Timeline(s), and therefore its object, can be deleted.  The only objects that cannot be deleted are 
the Global Light and the Camera.  To delete an Object Timeline: 

 Highlight the Object Timeline, then press Ctrl + Delete, select the Delete icon  from the 
Windows toolbar, or select Delete from the Edit menu. 
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Expanding/Contracting an Object Timeline to View/Hide Its Attributes Timelines 
To expand an Object Timeline to view its Attributes Timelines: 

 Click the + symbol to the left of the Object Timeline.  For this example, expand the Light 1 object.  
The Attribute Timelines for the Light 1 object are displayed.  Note that the Object Timelines are 
dark gray in color; the Attribute Timelines are light gray. 

The number of Attribute Timelines varies depending on the type of object.  While Light objects have 
only four Attribute Timelines, other types of objects, such as bitmap graphics, have many more. 

 

Expanded Timeline 

To contract an Object Timeline, i.e. view only the Object Timeline and hide the Attributes Timelines: 

 Click the - symbol to the left of the Object Timeline. 

Selecting an Object or Attribute Timeline 
To select an Object or Attribute Timeline, use one of the following methods: 

 Click on the Object or Attribute Timeline. 

 Scroll to the Object or Attribute Timeline by clicking in the Timeline area (the area below the 
Timeline Scale), then press  or . 

 Click on or scroll to the object name in the Scene Graph. 

The Time Indicator 
A small slider, the Time Indicator  that moves along the top of the Timeline Scale, indicates the time of 
currently displayed frame in the animation.    The Timeline Scale on the Timeline corresponds to the 
Timeline Scale on the Keyframe Graph.  The Time Indicator can be moved using any of the following 
methods to show any frame in the animation. 

 Click and drag the Time Indicator to the new position. 

 Press  to advance the Time Indicator, or  to move the Time Indicator back through the 
animation. 

 Click the Timeline Scale, then press  or  to advance the Time Indicator, or  or  to move the 
Time Indicator back through the animation. 

 Press Alt +  to advance the Time Indicator in 1-second intervals, or Alt +  to move the Time 
Indicator in 1-second intervals back through the animation. 

 Use the Transport Controls, except for the Play button to advance the Time Indicator, or to move 
the Time Indicator back through the animation. 

 Enter a new value into the Frame Counter to display the frame at the specified time. 
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Zooming In and Out of the Timeline 
For additional precision, the Timeline can be magnified: 

 Right-click on the Timeline Scale, then select one of the four zoom options from the context menu:  
Zoom Timeline 2x; Zoom Timeline 4x; Zoom Timeline 8x; Reset Zoom. 

 

Adjusting Zoom on the Timeline Scale 

Modifying the Duration of an Animation 
Modify Animation Length is accessed by right-clicking the Timeline Scale and selecting Modify Animation 
Length from the context menu shown directly above, then setting the parameters in the Modify Animation 
Length dialog box.  Refer to Modify Animation Length for details. 

The length of the Timelines of individual objects can also be changed.  See Changing the Length of a 
Timeline below. 

Adding a Keyframe 
A Keyframe is a point where the an object and its attributes, and therefore its Object/Attribute Timelines, 
can be modified.  These attributes can include XPosition, YPosition, ZRotation, XScale and many others.  
For example, a Keyframe would be added at the point where an animated object would change direction or 
start to rotate. 

The figure below shows Keyframes at the beginning of the animation for all objects, and Keyframes in the 
middle and at the end for the object named 3D element x.  There are two ways in which a Keyframe is 
marked on a Object or Attribute Timeline. 

  indicates a Keyframe positioned between the beginning and the end of an Object or Attribute 
Timeline. 

  indicates a Keyframe positioned at the exact beginning or end of an  Object or Attribute 
Timeline. 

A Keyframe can be added to an Object Timeline or Timeline. 
 When a Keyframe is added to an Object Timeline, corresponding Keyframes are added to all 

Attribute Timelines. 

 When a Keyframe is added to an Attribute Timeline, a corresponding Keyframe is added to its 
Object Timeline. 
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To add a Keyframe to an Object or Attribute Timeline: 
1. Move the Time Indicator to the desired frame. 

2. Right-click on the Object or Attribute Timeline to which the Keyframe is to be added. 

3. Select Add Keyframe from the context menu.  A Keyframe appears at the specified position on the 
Object or Attribute Timeline. 

 

Timeline 

Keyframe Selected Objects 
Edit Menu > Keyframe Selected Objects 
Keyframe Selected Objects adds a Keyframe to all selected objects and their attributes at the current time 
on the Timeline.  Remember that elements on the Timeline are also represented on the Keyframe Graph 
and on the Scene Graph.  The addition of a Keyframe to an object does not in itself modify the object's 
movement.  The object's element on the Timeline must be expanded to reveal its Position, Rotation, Scale 
and Center values on the X, Y and Z axes.  The Keyframe for the selected property of the object can then be 
moved on the Keyframe Graph. 
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To Keyframe Selected Objects: 
1. Press and hold the Ctrl key and click on all Timelines of objects to which the Keyframes are to be 

added.  You can also press and hold the Shift key and click on two Timelines to select the two 
Timelines and all of Timelines between them. 

2. Use the mouse to drag the time indicator on the Timeline to the time at which the objects should be 
Keyframed.  In the figure below, it is at 3 seconds. 

 

Timeline - Objects Selected for Keyframing 

3. Select Keyframe Selected Objects from the Edit menu.  Keyframe indicators are placed on the 
Timelines of the selected visible and non-visible objects.  The Timeline that remains highlighted is 
the one that was selected last before the objects were Keyframed. 

 

Timeline - Selected Objects Keyframed at Three Seconds 
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Keyframe All Objects 
Edit Menu > Keyframe All Objects 
Keyframe All Objects adds a Keyframe to all objects and their attributes at the current time on the Timeline 
and Keyframe Graph.  The addition of a Keyframe to an object does not in itself modify the object's 
movement.  Change to an attribute(s) of an object do modify movement.  The Object Timeline can be 
expanded to reveal its Position, Rotation, Scale and Center values on the X, Y and Z axes.  These values 
can be adjusted.  The Keyframe for the selected property of the object can then be moved on the Keyframe 
Graph. 

To Keyframe All Objects: 

1. Use the mouse to drag the time indicator on the Timeline to the time at which the objects should be 
Keyframed.  In the figure below, it is at 3 seconds. 

 

Timeline - No Keyframes Added 

2. Select Keyframe All Objects from the Edit menu.  Keyframe indicators are placed on the Timelines 
of all visible and non-visible objects. 

 

Timeline - All Objects Keyframed at Three Seconds 
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Timeline Entries 
Right-click on the Timeline Entry to display a context menu with information about the object: 

 

Timeline and Object-Specific Context Menu 

Adjusting  and Aligning Timelines 
You may move and adjust Timeline elements individually or in groups, using the mouse. 

Selecting Timeline(s) 
Left-click a Timeline element to select it for adjustment; selected Timeline elements are titled in white. 

 

Timeline 

To select multiple Timeline elements, hold the Shift key while clicking additional timeline elements.  Please 
Note: You may also select Timeline(s) via the Scene Graph. 
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Changing the Position of a Timeline Element 
An individual Timeline element may be moved within the duration of the animation without changing the 
length of that element.  To move a Timeline element, drag it with the mouse. A Move cursor is displayed, as 
shown:  

 

Changing a Position of a Timeline 

You may also select an individual Timeline element and move it forward or back one frame with the key 
combination Ctrl ; +  keys. Ctrl + Shift +  moves the selected timeline ten frames forward or back. 

Changing the Length of a Timeline Element  
You may change the length of a Timeline element (it's "lifetime" within the animation) by clicking and 
dragging at either end. A horizontal resize cursor is displayed, as shown: 

 

Changing the Length of a Timeline 

The end keyframe on the main Timeline can be moved as well. 
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Aligning Timeline Elements 

The Alignment buttons  are most often used on 2D Text Templates, but you may also 
use them to align selected Timeline elements. Note that only the Align Left, Align Right and Make Same 
Width buttons are available when Timeline elements (as opposed to text Templates) are selected. 

The alignment "anchor" is determined by which Timeline element was selected last.  

 

Aligning Timelines: Selecting an Anchor 

 

Aligning Timelines to the Same Side 
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Clicking Make Same Width will adjust the selected Timelines to both the length and start/end time of the 
Timeline element selected last. 

 

Making Timelines the Same Length 
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Scaling the Timeline 
Timeline > Click-and-Drag (Proportional) ; Ctrl Click-and-Drag (Non-Proportional) 
Timeline > Right-Click > Modify Animation Length 

 

Proportional and Non-Proportional Scaling 
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Proportional Scaling is also available from the Modify Animation Length dialog box, accessible by right-
clicking on the Timeline.  Accessing the feature from that dialog offers an additional option: 

If Proportional Scaling is not selected, a prompt is displayed asking if will ask it the final keyframe(s) of the 
selected element(s) should be extended to match the animation's overall duration. 

 

Extend End Keyframe Query 

 Extending the final keyframe(s) to the end of the animation has the effect of scaling the duration of all 
of the selected element's properties. 

 Not extending the final keyframes extends the "lifetime" of an element on the Timeline and the 
Canvas.  Its final keyframe, however, remains unchanged.  The element reaches the end of its 
programmed movement and move no further until the animation is over. 

The option of extending the end keyframe to match the new animation length is NOT available from the 
Animation Control Properties tab. 

Saving the Timeline - Scene, Object 

Saving the Scene Timeline 
The animation settings of the entire composition can be saved and applied to a different set of objects.  To 
save the Scene settings: 

1. From the File menu., select Save As.  The Save Animation dialog box opens. 

2. Optional:  Reset the Start Frame and/or End Frame. 

3. Navigate to the directory to which the file is to be saved.  It is recommended that it be saved to the 
Default Effects Directory, making it accessible for Read Effects execution. 

4. In the Save as Type field, select Lyric Effects (*.efx). 

5. In the File Name field, enter a Name. 

6. Click Save.  Only the animation settings are saved, not the objects themselves.  

A quick method for performing the same operation is as follows: 
1. Press Ctrl + Record.  The Record Only: dialog box opens. 

2. Select Scene (.efx). 

3. Click Record.  The scene animation settings are saved to the current Message Number in the 
Default Effects Directory. 

A Hotkey combination can also be used to record the Scene settings: 

 Press Ctrl + Record S Enter.  The scene animation settings are saved to the current Message 
Number in the Default Effects Directory. 
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Saving the Object Timeline 
The animation settings from an individual object can be saved and applied to a different object.  To save 
Object settings: 

1. On the Timeline or the Scene Graph, select the object. 

2. Right-click on the Timeline for that object. 

3. From the context menu, select Save Keyframe File.  The Select a Keyframe file to save dialog box 
opens. 

4. The Save In: field should have the Default Effects Directory selected.  The Save as Type field, 
select Keyframe File (.kyf).  In the File Name field, enter a file name. 

5. Click Record.  The Keyframe file is saved. 

A quick method for performing the same operation is as follows: 
1. Press Ctrl + Record.  The Record Only: dialog box opens. 

2. Select Object (.kyf). 

3. Click Record.  The object animation settings are saved to the current Message Number in the 
Default Effects Directory. 

A Hotkey combination can also be used to record the Scene settings: 

 Press Ctrl + Record O Enter.  The object animation settings are saved to the current Message 
Number in the Default Effects Directory. 

Additional Notes Regarding Specific Objects and Timelines 
 A Clip with a Start Time of 0, 1 or 2 frames always starts at Frame 0 when the animation is 

executed.  A Clip with a Start Time of 0 or higher executes at the specified frame. 

 Pauses can reside within Mix objects on Duet SD.  This requires Duet Drivers Version 3.2 Build 137. 

 Timeout pauses can now reside within Squeezeback objects on Duet SD.  This requires Duet 
Drivers Version 3.2 Build 137 or later. 

 Lyric supports frame-accurate synchronization of VGE animations, Mix objects, and Squeezeback 
objects on Duet SD, both at the beginning of the animation and after every Paused for 
Keypress/GPI Pause. This requires Duet Drivers Version 3.2 Build 137 or later. 
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Modifying the Duration of an Animation from the Timeline or 
Keyframe Graph 
The Animation Length of selected objects or an that of an entire animation can be modified from the Default 
Animation Length as set in Config Menu > Preferences > Animation Settings.  Animation Length can be 
modified from either the Timeline or the Keyframe Graph. 

1. From the Timeline, right-click anywhere in the Timeline window, except on an individual Timeline. 

OR 

From the Keyframe Graph, right-click on the Timeline Scale, then select Modify Animation Length 
from the context menu shown below. 

 

Selecting Modify Animation Length from the Keyframe Graph 

2. The Modify Animation Length dialog box is displayed. 

 

Modify Animation Length Dialog Box 
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Modify parameters as described in the following table, and then select OK to execute the animation 
length change. 

Parameter Description 

Animation 
Length 

Adjust Animation Length to the desired value. 

Proportional 
Scaling 

Enable or disable Proportional Scaling to scale the Keyframe 
positions to the new animation length, or to leave them unmodified. 

 If Proportional Scaling is enabled (checked), the Keyframe 
position(s) of the object(s) is scaled proportionately to fit the 
new Animation Length. 

 If Proportional Scaling is disabled (unchecked), the 
Keyframe position(s) of the object(s) remain the same.  
Time is just added to or subtracted from the  Animation 
Length  of the selected objects.  If, when changing 
Animation Length, Proportional Scaling is disabled, the 
following is displayed when OK is selected in the Modify 
Animation Length dialog box: 

 

Extend End Keyframe to Match Animation Length? 

If Yes is selected, the end point of the animation is set to the 
modified length.  In the instance of shortening the animation, 
Keyframes can be lost. 

Scale 
Selected 

Scale Selected Objects:  Scale Selected Objects applies the 
Timeline length change to only the selected objects. 

Scale All 
Objects 

Scale All Objects:  Scale All Objects applies the Timeline length 
change to the entire animation. 

Example: 
A 5-second animation contains two objects, where object A starts at 01:00s and ends at 02:00s, and object B 
starts at 02:00s and ends at 04:00s.  Proportional Scaling is enabled, and Scale All Objects is selected.  If 
the animation length is doubled from 5 seconds to 10 seconds, object A's Start time is now 01:00s and end 
time is 03:00s; its duration doubles from 1 second to 2 seconds, and object B starts at 02:00s and ends at 
06:00s; its duration is also doubled. 
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Keyframe Graphs 
View Menu > Keyframe Graph 
The Keyframe Graph provides a detailed display of changes in the state of the selected Timeline object(s) 
over time.  In addition, the Keyframe Graph provides the ability to add, delete, and accurately edit 
Keyframes. 

Basic Operation 
The Keyframe Graph displays information for one or more parameters of the selected object's Timeline 
element.  The example below demonstrates the relationship between the animation on the Canvas and its 
representation on the Keyframe Graph. 

Example 
The object in this composition is a 3D character W.  At time 00:00:00:00 it is at the upper-left corner of the 
Canvas; at time 00:00:02:15 (2.5 seconds) it is at the lower-right corner of the Canvas, and then at 
00:00:05:00 (5 seconds) it is back at its starting place: 

 

Basic Animation - Same Start and End Positions 
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The expanded Timeline for this object appears as shown below.  If only the main Timeline is displayed, click 
on the + symbol to the left of the Timeline to expand the Timeline and display the Timelines of the object's 
individual attributes.  To display just the main Timeline for the object, click the - symbol to the left of the main 
Timeline. 

 

Timeline 

Note that since the animation is changing only two attributes, i.e. XPosition and YPosition, only the main 
Timeline for the object and the XPosition and YPosition Timelines display Keyframes.  A change in 
another attribute adds a Keyframe(s) to that attribute and, depending upon the attribute that was modified, 
can add a Keyframe(s) to related attributes as well. 

Now, select the X position attribute by clicking on it. 

  

Selecting a Timeline Attribute 
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Finally, from the View menu, select Keyframe Graph.  

 

Selecting View > Keyframe Graph 

Lyric displays a graph with X position as the vertical axis, and time as the horizontal axis; the change of the 
selected Object’s X position is indicated with a white line, and keyframes (points of change) are shown as red 
boxes: 

 

Keyframe Graph Showing XPosition 
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Now, switch back to the Timeline and select the Y position timeline. Switch back to the Keyframe Graph; the 
display changes to show how the object’s Y position changes over time: 

 

Keyframe Graph Showing YPosition 

Navigating the Keyframe Graph 
To step through an animation in forward or reverse, use one of the following methods: 

 Click the left or right arrow button at either end of the Timeline Scale. 

 Press the  or  cursor keys. 

 Click and drag the green time indicator. 

To step through an animation in 1-second intervals: 
 Click on the Timeline Scale running along the bottom of the Keyframe Graph, then press Page 

Down to go forward, or Page Up to go in reverse.  The Timeline Scale on the Keyframe Graph 
corresponds to the Timeline Scale on the Timeline. 

To navigate up the vertical scale of the Keyframe Graph, use one of the following methods: 
 Click the up arrow at the top of the Keyframe Graph. 

 Click anywhere on the Keyframe Graph area (where the graphs are displayed) or on the vertical 
scale at the left of the Keyframe Graph, then press the Page Up key. 

To navigate down the vertical scale of the Keyframe Graph: 
 Click anywhere on the Keyframe Graph area or on the vertical scale at the left of the Keyframe 

Graph, then press the Page Down key. 

To page up or down through the Keyframe Graph: 
 Click anywhere on the Keyframe Graph area or on the vertical scale at the left of the Keyframe 

Graph, then press Ctrl + Page Up or Ctrl + Page Down. 
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To zoom in or out of the Timeline Scale: 
 Right-click on the Timeline Scale, then select one of the four zoom options from the context menu:  

Zoom Timeline 2x; Zoom Timeline 4x; Zoom Timeline 8x; Reset Zoom. 

 

Adjusting Zoom on the Keyframe Graph Timeline Scale 

Modify Animation Length 
Modify Animation Length is accessed by right-clicking the Timeline Scale and selecting Modify Animation 
Length from the context menu shown directly above, then setting the parameters in the Modify Animation 
Length dialog box.  Refer to Modify Animation Length for details. 

Simultaneously Viewing More Than One Attribute 
On the Timeline in its expanded state, select the first attribute you wish to display, and then press Ctrl while 
clicking the other attributes to be displayed.  When the Keyframe Graph is viewed, all selected Timeline 
attributes are displayed.  Note that the Keyframe Graph can only display attributes of the same type 
simultaneously!  In other words, you may compare several Position attributes, but not a Position attribute 
and a Rotation attribute on the same Keyframe Graph display. 
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Example 
In the following example, the object moves along the X and Y axes during a 5-second animation. 

 

Basic Animation - Different Start and End Positions 



Lyric User Guide 

 20-44 

To view the Keyframe Graphs for both X and Y, first select the X attribute on the Timeline, press and hold 
Ctrl, then select (click) the Y attribute.  The text identifying the attributes turns white.  Note that the text on the 
main Timeline for the object is also white. 

 

Timeline 
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The Keyframe Graphs of both the X and Y attributes are now displayed. 

 

Simultaneous Display of X- and Y-Positions 

Using the Keyframe Graph to Edit Animations 

The Keyframe Graph is a powerful editing tool for animation, enabling you to precisely adjust, add, and 
delete Keyframes. 
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Changing Keyframe Graph Attributes 
The Keyframe Graph display can be customized for comfortable viewing: 

 Right-click on the Keyframe Graph to display a context menu enabling you to change the 
Background Color, or to show/hide the Keyframe Graph's grid lines.  Note that the Palette used to 
set the Background is the same as that used for setting the colors of light sources and 3D characters 
and objects. 

 

Keyframe Graph 

Adjusting Keyframes 
A Keyframe Graph display shows how one component of an animated object changes over time. Therefore, 
a display has at least two Keyframes – one indicates the beginning condition, and the second indicates the 
ending condition. These Keyframes cannot be deleted!  

To adjust a Keyframe on a Keyframe Graph: 
 Click and drag it with the mouse.  

 

Adjusting a Keyframe Position 
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To display information about the Keyframe 

 Right-click on the Keyframe.  Lyric displays a context menu which lists a variety of options: 

 

Displaying Keyframe Information 
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Adding a Keyframe 
In this example, the Keyframe Graph is displaying the Y position component of the current object Timeline.  
To add a new Keyframe to the current Keyframe Graph: 

1. Right-click on the Keyframe Graph where the new Keyframe is to be positioned.  Lyric displays a 
context menu: 

 

Adding a Keyframe 

2. Select Add Keyframe.  A new Keyframe, indicated by a red box  appears on the Keyframe Graph, 
which may be adjusted  as described above. 

Interpolation Modes 
Lyric provides a choice of Interpolation Mode settings which determine how an animation transitions through 
each Keyframe.  Refer to Interpolation Modes for details. 

Deleting a Keyframe 
To delete a Keyframe: 

 Right-click on the Keyframe, then select Delete Keyframe from the context menu. 

Deleting an Object 
The Keyframe Graph(s) of an object, and therefore the object itself, can be deleted from the Scene.  The 
only objects that cannot be deleted are the Global Light and the Camera.  To delete an the Keyframe 
Graph of an object: 

 Display the Keyframe Graph for the object(s), then press Ctrl + Delete, select the Delete icon  
from the Windows toolbar, or select Delete from the Edit menu. 
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Motion Paths 
Object Context Menu > Motion Path > Show Path 
Keyframe, Control Point or Accelerator Control Context Menus > Show Path 

Overview 
A Motion Path is a visual representation of the path through XYZ space that an object follows as it 
progresses through an animation.  A Motion Path can be displayed for any 2D bitmap (including a Flipbook), 
3D character or 3D object that contains more than one keyframe.  A Motion Path can be edited, keyframes 
added/deleted, and an Interpolation Mode can be applied to the entire Motion Path or individual segments 
of the Motion Path. 

To demonstrate how a Motion Path works, create an animation where an object moves from one position on 
the Canvas to another.  The following example shows a 3D character moving from the upper left corner to the 
lower right corner of the Canvas.  Execute the animation to the end. 

 

Simple Animation 
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Select the object, in this example, a 3D character E.  Right-click to display the object context menu. 

 

Object Context Menu 

Select Motion Path to display the Motion Path menu, and then select Show Path. 

.   

Motion Path Menu 
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The menus close, and the Motion Path of the object is displayed on the Canvas.  The Motion Path tracks 
the path of the object through the animation.  It is represented by a line made up of individual dots, each of 
which represent one frame of the animation.  In the following figure, the dots are so close together that they 
appear to run into each other.  Figures later in this section show them more distinctly.  The darker-blue-
colored dots mark five-frame increments, and are a visual aid to help in locating specific frames on the 
Motion Path. 

 

Motion Path 
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Execute the animation.  Observe how the object follows the Motion Path. 

 

Animation Progression 

The Motion Path is marked by an orange dot, representing the Start Keyframe, and a red dot, representing 
the End Keyframe.  Additional Intermediate Keyframes that are added to the Motion Path are represented 
by red dots.  When a frame or other component of the Motion Path is selected, its dot turns white.  Using the 
mouse, any keyframe can be dragged to modify the shape of the Motion Path.  Adding and deleting 
keyframes are covered later in this section. 

The Motion Path tracks the movement of an object from the following point: 
 The center of a 2D bitmap or Flipbook. 

 The baseline of a 3D character, at the left edge. 

 The center of a 3D object. 

A Motion Path cannot be created for a 2D Text Window, an Individual or Global Light, the Camera. or an 
Lyric object such as that resulting from the creation of an Advanced Text Effect or Advanced Image Effect. 
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Turning On/Off Motion Paths 
The Motion Path display can be turned on and off for an object.  Turning the display off does not remove the 
Motion Path from the object; it only turns off the display of the Motion Path.  To completely remove a Motion 
Path, it must be cleared.  Additionally: 

 When a Motion Path has been generated for an object, the Keyframe Graph can no longer be used 
to make adjustments to the keyframes and attributes of the object.  To enable Keyframe Graph 
functionality for the object, the Motion Path must be cleared from the object.  Clearing a Motion 
Path is covered at the end of this section. 

 The Timeline should not be used to add a keyframe to a Motion Path.  Keyframes should be added 
only from the Motion Path. 

 The Undo function is not supported when working with a Motion Path. 

The display of the Motion Path can also be also be toggled on and off by selecting/deselecting Show Path 
from the Frame, Keyframe, Control Point and Acceleration Control context menus.  Accessing these 
menus is covered throughout this section. 

Displaying Multiple and Grouped Object Motion Paths 
Motion Paths can be displayed for more than one object at a time, and can be displayed and manipulated in 
all Canvas Views. 

 

Displaying Multiple Objects in Multiple Canvas Views 



Lyric User Guide 

 20-54 

When objects are grouped, the Motion Path is displayed as follows: 
 If an object outside of the group is currently selected, only the Motion Path for the object that was 

currently selected when the Motion Path was generated is displayed. 

 If an object in the group is currently selected, only the Motion Path for the selected object is 
displayed. 

 

Individual and Group Motion Paths 
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Adding a Keyframe to a Motion Path 
Additional keyframes can be added to a Motion Path.  If the added keyframe is neither the first nor the last 
keyframe in an animation, it is referred to as an Intermediate Keyframe.  To add a keyframe, click the point 
on the Motion Path where the keyframe is to be added.  A white dot appears.  Right-click on the white dot.  
The Motion Path context menu is displayed.  Select Insert Keyframe.  The menu closes and the white dot 
turns red. 

 

Adding a Keyframe 

The keyframe can be dragged to a new position to change the shape of the Motion Path.  Additionally, 
Interpolation can be individually set for a keyframe.  Applying an Interpolation to an Individual Keyframe 
is covered later in this section. 

Selecting a Frame or Keyframe in a Motion Path 
A frame or keyframe can be selected simply by clicking on it.  If, however, the frames are close together and 
are overlapping, a keyframe can still be selected: 

1. Click (select) a frame on a Motion Path that is behind the keyframe. 

2. Hold the Alt key down, and then click the keyframe as many times as necessary to advance to the 
keyframe. 
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Interpolation 
Overview 
The transition of the animation as it progresses through a keyframe is controlled by the Interpolation setting.  
The Motion Path in the previous figure is set to Linear Interpolation, which is the default setting. 

To access the Interpolation settings, select the object, and then right-click to display the context menu.  
Right-click to display the object context menu, select Motion Path > Interpolation Mode and then select 
Linear, Jump or Spline. 

 

Interpolation Mode Menu 

The Interpolation set for the object applies to all keyframes in its Motion Path. 

NOTE 
If working with a Motion Path that contains multiple Interpolations, be cautious about 
applying an Interpolation from the object context menu, as it will reset all keyframes to 
the selected Interpolation.  Refer to Applying an Interpolation to an Individual Keyframe, 
covered later in this section, for information on applying an Interpolation to an individual 
segment of a Motion Path. 
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Linear Interpolation 
When Linear Interpolation is specified for a Motion Path, the object moves at a constant speed in a straight 
line from keyframe to keyframe.  The speed can vary in different keyframe-to-keyframe segments of the 
Motion Path, depending on the length of the segment and frame location of the keyframes, but is always 
constant between keyframes. 

 

Linear Interpolation Showing Constant Speeds Between Keyframes 
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Jump Interpolation 
When Jump is specified for the Motion Path, the object jumps to the next keyframe without following any 
path in between the two keyframes.  The object remains in the same position until the animation reaches the 
next keyframe, at which point the object jumps to its new position. 

 

Jump Interpolation 
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Spline Interpolation 
When Spline Interpolation is specified, the Motion Path is mapped to a spline curve that is programmed in 
the Lyric software. 

 

Spline Interpolation 

Keyframes that have Spline Interpolation applied, have Control Point and Acceleration adjustment 
controls not present in Linear and Jump Interpolation. 

 The Start Keyframe of a Spline Motion Path can be modified by adjusting its Leading Control 
Point.  A Leading Control Point affects the Motion Path in the forward direction from the keyframe.  
The Leading Control Point also has an Acceleration Control which controls the velocity of the 
animation as it progresses from the keyframe to the next keyframe.  The Start Keyframe has no 
Following Control Point, as it marks the first frame of the animation and there is no animation 
preceding it. 

 The End Keyframe of a Spline Motion Path can be modified by adjusting its Following Control 
Point.  A Following Control Point affects the Motion Path that precedes the keyframe.  The End 
Keyframe has no Leading Control Point or Acceleration Control, as it marks the last frame of the 
animation and there is no animation succeeding it. 

 An Intermediate Keyframe of a Spline Motion Path can be modified by adjusting its Leading and/or 
Following Control Points.  The Leading Control Point also has an Acceleration Control which 
controls the velocity of the animation following the keyframe.  Note that the Leading Control Point, 
the Keyframe and the Following Control Point lie on the same line, and that this line is tangent to 
the Spline curve.  The Control Points can be set to move independently by breaking the tangent.  
Breaking the Tangent is covered later in this section. 
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Experiment with modifying the Spline curve.  Use the mouse to move the Acceleration Control on the Start 
keyframe up and down.  Observe how the Motion Path following the selected keyframe changes.  The 
Motion Path is composed of dots representing individual frames.  Changing the Acceleration Control 
position changes the density of the dots at different points along the Motion Path following the keyframe, 
although it does not change the shape of the curve itself. 

 As the Acceleration Control is moved closer to the Keyframe, the density of the dots increases as it 
moves forward in the animation, away from the keyframe. 

 As the Acceleration Control is moved away from the Keyframe, the density of the dots decreases 
as it moves forward in the animation, away from the keyframe. 

When an animation executes, it progresses from one dot to the next in the same length of time.  As a result, 
the physical distances between the dots affects the speed of the object through the animation.  Setting the 
acceleration is similar to setting Ease.  

 The closer together the dots, the more slowly the object moves through the Motion Path. 

 The further apart the dots, the more quickly the object moves through the Motion Path. 

 

Motion Path Acceleration and Deceleration 
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Execute the animation with the Acceleration Control set in different positions.  Observe how the object 
accelerates where the dots are farther apart, and decelerates where they are closer together. 

The acceleration can be reset to a point half-way between the keyframe and the Leading Control Point.  
Select the Acceleration Control so that it turns white.  Right-click to display the Acceleration Control 
context menu, and then select Reset Acceleration.  The acceleration is now reset. 

 

Accelerator Context Menu 

The shape and angle of the Spline Motion Path can be modified.  Using the mouse, a Control Point or a 
keyframe can be dragged to a new position. 

 

Modifying a Spline Motion Path 
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Applying an Interpolation to an Individual Keyframe 
When a Motion Path Interpolation is set from the object context menu, the Interpolation is applied to the 
entire Motion Path.  Interpolation can be individually applied to each segment of a Motion Path that lies 
between two keyframes.  To do so: 

1. Select a keyframe, its Acceleration Control or a frame on the Motion Path so that it turns white, and 
then right-click to display the respective context menu. 

2. Select Interpolation, and then select the desired Interpolation.  The selected Interpolation is 
applied to the keyframe and the segment of the Motion Path that it controls as follows: 

o If the selected element is either the Start keyframe, an Intermediate keyframe, or an 
Acceleration Control, the Interpolation is applied to the segment of the Motion Path 
following the keyframe or Accelerator Control through to the next keyframe on the Motion 
Path. 

o If the keyframe is the End keyframe, the Interpolation is applied to the segment of the 
Motion Path preceding the keyframe backwards to the next-to-last keyframe on the Motion 
Path.  The Interpolation for the last segment of a Motion Path can be set from either the 
next-to-last or last keyframe in the Motion Path. 

o If a frame that is not a keyframe is selected, the Interpolation is applied to the segment of 
the Motion Path from the keyframe preceding the selected frame through to the keyframe 
following the selected frame. 

The following figure shows how mixing Interpolations affects the presence of Control Points in the Spline 
segments. 

 

Mixed Interpolations 
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To reapply a single Interpolation to an entire Motion Path: 
1. Select the object, and then right-click to display the object context menu. 

2. Select Motion Path > Interpolation, and then select the desired Interpolation.  

Modifying/Deleting/Copying/Pasting a Keyframe 
The Interpolation for a keyframe can be set individually from the Keyframe context menu.  Additionally, 
attributes of the keyframe can be copied and pasted to other keyframes from this menu.  To display the 
Keyframe context menu, select (click) the keyframe so that it turns white, and then right-click. 

 

Keyframe Context Menu 

This menu is almost the same as the Control Point context menu opened by right-clicking on a Control 
Point of a Spline Motion Path.  The Control Point context menu does not offer the Delete and 
Interpolation Mode functions, but does offer the Break Tangent function, which is covered later in this 
section. 

The following functions are available from this menu.  Note that each Paste item is grayed out until its 
respective Copy operation is performed. 

 Delete:  Removes the selected keyframe from the Motion Path. 

 Interpolation Mode:  Opens the Interpolation Mode menu, from which Linear, Jump or Spline 
Interpolation can be selected and applied to the selected keyframe. 

 Copy X State:  Copies the X-position of the currently selected keyframe, which can then be pasted to 
a different keyframe in the same or a different Motion Path. 

 Copy Y State:  Copies the Y-position of the currently selected keyframe, which can then be pasted to 
a different keyframe in the same or a different Motion Path. 

 Copy Z State:  Copies the Z-position of the currently selected keyframe, which can then be pasted to 
a different keyframe in the same or a different Motion Path. 

 Copy All:  Copies the X-, Y-, and Z-positions of the currently selected keyframe, which can then be 
pasted to a different keyframe in the same or a different Motion Path. 

 Copy Path:  Copies the Motion Path on which the currently selected keyframe is situated, which can 
then be pasted to a different object.  Refer to Copying and Pasting a Motion Path later in this 
section for additional information. 
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 Paste X State:  Pastes the copied X-position to the currently selected keyframe.  The Motion Path 
updates to reflect the change. 

 Paste Y State:  Pastes the copied Y-position to the currently selected keyframe.  The Motion Path 
updates to reflect the change. 

 Paste Z State:  Pastes the copied Z-position to the currently selected keyframe.  The Motion Path 
updates to reflect the change. 

 Paste All:  Pastes the copied X-, Y-, and Z-positions to the currently selected keyframe.  The Motion 
Path updates to reflect the change. 

 Paste Path:   Pastes the copied Motion Path to the currently selected object.  Refer to Copying and 
Pasting a Motion Path later in this section for additional information. 

 Show Path:  Toggles the Motion Path display on and off. 

Copying and Pasting a Motion Path 
A Motion Path can be copied from one object and pasted to another. 

To copy a Motion Path from an object, use one of the following methods: 
 Right-click on the object, and then select Motion Path > Copy Path. 

 On a Motion Path, select any frame, keyframe, Control Point or Acceleration Control so that it 
turns white. Right-click to display its context menu.  Select Copy Path. 

To paste a Motion Path to an object use one of the following methods: 
 Right-click on the object to which the Motion Path is to be pasted, and then select Motion Path from 

the object context menu.  The Motion Path menu is displayed.  Select Paste Path. 

 On a Motion Path, select any frame, keyframe, Control Point or Acceleration Control so that it 
turns white.  Right-click to display its context menu.  Select Paste Path.  The following prompt is 
displayed: 

 

Discard Path Prompt 

Click Yes to apply the copied Motion Path, or No to cancel the Paste operation. 
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When a Motion Path is pasted to an object, it then follows exactly the same path as the object from which the 
Motion Path was copied.  To offset the path of an object, so that follows the same path shape, but at a 
different location: 

1. Select the object. 

2. Open the Lyric Properties window, and then click the XYZ tab to display XYZ Properties. 

 

XYZ Properties 

3. Located at the bottom of the Properties tab is either the Single or Global Keyframe Adjust icon.  
Clicking the icon toggles the between the two icons. 

 

Single Keyframe Adjust 
 

Global Keyframe Adjust 
 When the Single Keyframe Adjust icon is active, any change to the XYZ attributes are 

applied only to the selected keyframe for the object. 

 When the Global Keyframe Adjust icon is active, any change to the XYZ attributes are 
applied to all keyframes for the object. 

If necessary, click the icon so that the Global Keyframe Adjust icon  is displayed. 
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4. Adjust the X, Y and/or Z attributes to reposition the object.  Note that the Motion Path is transported 
as well. 

5. Execute the animation.  The object follows the same-shaped Motion Path, but now starts and ends in 
a different position. 

Breaking/Unbreaking the Tangent - Spline Interpolation Only 
When Spline Interpolation is set, the animation normally proceeds through keyframes following a smooth 
curve.  When adjusted, the Leading Control Point, the keyframe and the Following Control Point remain in 
a straight line with each other, and the line remains tangent to the Motion Path.  It may, however, be 
desirable to abruptly change the direction of the animation. 

To do so, click either the Following or the Leading Control Point of a keyframe.  Right-click to display the 
Control Point context menu, and then select Break Tangent.  The menu closes and the selected Control 
Point turns white.  If the menu is opened again, a check appears next to the Break Tangent item. 

 

Breaking the Tangent 
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Move the selected Control Point to another position.  Note that its partner Control Point does not 
automatically adjust, and that the Motion Path has taken an abrupt change of direction.  Each Control Point 
vector is still tangent to the portion of the curve it controls, but the two vectors no longer lie on the same line.  
Because this example shows a change in the Following Control Point, the animation preceding the 
keyframe is modified.  The animation following the keyframe remains unchanged. 

 

Broken Tangent 

The Control Point vectors can be locked together again.  Click the Control Point to which the broken 
tangent has been applied.  Right-click to display the Control Point context menu.  Select Break Tangent 
from the menu.  The menu closes.  The Motion Path does not change until the Control Point is selected and 
modified again.  When the Control Point is modified after restoring the tangent, the tangents of the partner 
Control Points again lie on the same line and move is equal, opposite directions when repositioned. 

Clearing a Motion Path 
A Motion Path can be cleared from an object.  When a Clear operation is executed, the Motion Path is 
removed from the object.  To clear the Motion Path: 

1. Click on the object, and then right-click to display the object context menu. 

2. Select Clear.  The following prompt is displayed. 

 

Destroy Motion Path Prompt 

3. Click OK to remove the Motion Path from the object, or Cancel to cancel the operation. 

When a Motion Path is cleared, it disappears from the Canvas.  If the animation is then executed, the object 
still follows the same path.  Keyframes are not removed. 

If the message is recorded, and then read, the path of the object reverts to the Default Interpolation. at 
which it was recorded.  The frame locations of the keyframes are kept intact, but their Interpolations may 
have changed. 
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Ease 
Ease is an attribute that can soften the entrance into or exit from an Object, Attribute or Pause Keyframe, a 
Default Effect, Advanced Image Effect, Duet SD Multi FX or Playlist Effect.  Ease can be applied to either 
the beginning or end of the event, or both.  The length of the Ease can be set as well. 

 Keyframe Set on an Object or Attribute Timeline:  Ease can control the rate of change of an 
object's motion or other attributes through a Keyframe.  Refer to Timelines and Keyframe Graphs 
for information on Object and Attribute Timelines.  

 Animation:  Ease can slow down an animation into a Keyframe Pause, or speed it up out of a 
Keyframe Pause.  Refer to Properties:  Loops and Pauses for information on setting Keyframe 
Pauses. 

 Default Effect, Advanced Image Effect, Duet SD Multi FX, Playlist Effect:  Ease can smooth out 
the start and/or end of an effect. 

The Ease dialog box is accessed from a variety of areas in Lyric.  Refer to the sections mentioned above for 
details. 

 

Ease Options 

There are four Ease Types: 
 No Ease:  Ease is not applied. 

 Ease In:  Ease is applied to the beginning of the change in an attribute, effect, etc. 

 Ease Out:  Ease is applied to the end of the change in an attribute, effect, etc. 

 Ease In/Out:  Ease is applied to both the beginning and end of the change in an attribute, effect, etc.  

Ease Time indicates the duration of the Ease effect in frames.  An Ease does not add time to the overall 
duration of the effect or animation, but rather is incorporated into the duration. 

Ease Time is applied separately to the In and Out points.  An Ease Time of 15 frames results in a 15-frame 
Ease applied to the beginning of the effect, animation or transition, and a 15-frame Ease applied to the end of 
a the effect, animation or transition.  Frame rate is based on the currently active video standard. 

To apply an Ease: 
1. Select an Ease Type from the Ease Type drop-down list box. 

2. Set a duration for the Ease in the Ease Time frame counter. 

3. Click OK to apply the Ease, or Cancel to cancel the application/modification of the Ease settings. 
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Interpolation Modes 
Timeline > Right-Click on Keyframe > Modify Keyframe Attributes 
Keyframe Graph > Right-Click on Keyframe > Interpolation Mode 
Default Interpolation:  Config Menu > Preferences > Animation Settings 
Interpolation Mode determines how an animation transitions from one Keyframe to the next.  There are four 
Interpolation Modes:  Linear (the most commonly used), Spline, Jump (also known as None) and Ease.  
One of these Interpolation Modes always serves as a Default Interpolation, i.e. an Interpolation that is 
applied to every Keyframe in the animation unless otherwise changed individually in the Timeline or 
Keyframe Graph.  The Default Interpolation is determined by the Default Interpolation setting in the 
Config Menu > Preferences > Animation Settings.  Setting Interpolation Mode for an individual Keyframe 
via the Timeline or the Keyframe Graph allows for precision control of the animation path and speed through 
a Keyframe. 

A Timeline or Keyframe Graph can contain a mix of individually set Interpolation Modes.  A new keyframe 
added to the Keyframe Graph assumes the same Interpolation Mode as the previous Keyframe.  Once a 
new Keyframe is added, its Interpolation Mode can be changed as described below. 
Detailed descriptions of the Interpolation Modes and their specific settings follow Setting the Interpolation 
Mode. 

Setting Interpolation Mode 
To set or change the Interpolation Mode for a Keyframe: 

 On the Timeline:  Right-click on the Keyframe on the Timeline.  The Keyframes are marked by 
inverted triangles on the Timeline.  This example uses the Keyframe at 02:00 on the Timeline for 
the 3D character N in an animation.  Select Modify Keyframe Attributes from the context menu.  
The Modify Keyframe Attributes dialog box is displayed.  Both Keyframe Frame (i.e. position on 
the Timeline) and Interpolation can be set. 

 

Setting Interpolation Mode from the Timeline 
Note that in this example, the Interpolation Mode is applied to all attributes of the Keyframe at 
02:00.  If the Timeline for N is expanded to show the Timelines for each of the attributes of N, the 
Interpolation can be set separately for each attribute at Keyframe 02:00.  To view the Timelines for 
the individual attributes of an object, click the + symbol to the left of the Timeline for that object. 

 On the Keyframe Graph:  Right-click on the Keyframe on the Keyframe Graph.  This example uses 
the Keyframe at 02:00 on the Keyframe Graph for the X-position of the 3D character N in an 
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animation.  Select Interpolation Mode from the context menu, then select the Interpolation choice 
from the submenu. 

 

Setting Interpolation Mode from the Keyframe Graph 
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Interpolation Modes 
The following examples are based on an animation in which the letter N starts at the lower left corner of the 
screen, traveling clockwise from corner to corner.  The Keyframe Graph shown is that of the X (horizontal 
dimension) attribute.  Keyframes are positioned at 1-second intervals up to 04:00 seconds, and appear as 
red dots on the Keyframe Graphs. 

 Linear is the most commonly used type of interpolation.  It progresses an object in an animation at 
constant speed from keyframe to keyframe.  As shown in the Keyframe Graph below, when N is 
moving straight up from 00:00 seconds to 01:00 second, the X-position does not change.  From 
01:00 second to 02:00 seconds, N travels from left to right across the screen.  This is reflected in the 
increasing X-value. on the Keyframe Graph.  When N drops straight down, there is no change in X, 
and when it travels left to its starting point, the X-value decreases.  All changes in the X value 
between two keyframes occur at a constant rate (no acceleration/deceleration). 

 

Linear Interpolation Mode 
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 Spline provides the ability to vary the speed and path the object follows during the animation.  When 
a Spline Interpolation is specified, preset Spline attributes are automatically applied to the speed 
and path of the animation.  From each Keyframe on the Keyframe Graph, extends a vector that can 
be adjusted for both angle and length.  The two Keyframes that define a segment of a curve are 
used as control points from which the vectors can be adjusted.  The illustration below shows the 
same animation as above, with a Spline Interpolation applied. 
Note that the rate of change in X-position between two keyframes is no longer constant.  A steeper 
slope in the curve results in a faster rate of change in X-position; a gentler slope in the curve results 
in a slower rate of change in X-position. 

When applied to the EffectPct attribute in a Roll, Crawl or Type On, Spline adjustment can be used 
to vary the speed or even reverse the direction during execution. 

If a Spline keyframe is positioned between two other Spline keyframes, the center keyframe will 
have two vectors: one that controls the transition from the preceding Keyframe, and one that controls 
the transition to the following Keyframe.  Normally, the two vectors extending from a Keyframe form 
a straight line which is tangent to the curve.  A change in angle and magnitude of one vector results in 
an equal, but opposite change in the other vector.  Each vector can be individually set, however, by 
right-clicking either vector, then selecting Break Tangent from the context menu.  The vectors can be 
realigned by right-clicking either vector, then selecting Lock Tangent from the context menu.  The 
illustration below right shows a broken tangent.  

 

Spline Interpolation Mode 
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 Jump causes the animation to shift between Keyframes instantaneously, without following a 
continuous path from one Keyframe to the next.  Jump is the same as None, which is a Default 
Interpolation setting found in the Config Menu > Preferences > Animation Settings. 

 

Jump (None) Interpolation Mode 
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 Ease Interpolation smooths out the motion through the point of the Keyframe.  The illustration below 
shows a one-second In/Out Ease applied to the same animation as pictured above.  The path is 
essentially the same as that in a Linear Interpolation, but the change from one direction to the next 
is softened.  Note that the Ease option is not available as a Default Interpolation. 

When a Keyframe is assigned an Ease Interpolation, the Ease Options dialog box shown below is 
displayed.  An Ease Type (No Ease, Ease In, Ease Out, Ease In/Out) can be selected from the 
drop-down list box.  An Ease Time, which determines the duration of the Ease, can be set as well.  
To modify Ease Options at any time, right-click on the Keyframe, select Interpolation Mode > Ease 
then enter the modifications in the Ease Options dialog box. 

   

Ease Interpolation Mode 

Refer to Animation: Ease for additional information on Ease settings. 
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Loops/Pauses Properties 
Properties > Loops/Pauses 

Overview 
A Lyric animation can contain Pause points which temporarily stop the animation, Loops, which are 
segments of the animation that can repeat a specified or indefinite number of times.  This can provide instant 
control over the animation while it is executing to air, especially crucial for live broadcasts in which timing is 
not always precise.  Parameters specifying how the Loops and Pauses execute are set in the Properties > 
Loops/Pauses tabs. 

To access Loops/Pauses Properties, select the Loops/Pauses tab in the Properties window.  When the 
tab is first selected, the Pause Options and Ease Options dialog boxes shown below to the right of the 
Loops/Pauses tab is not displayed.  They are displayed as described later in this section when the Pauses 
Enabled checkbox in the Loops/Pauses tab is selected. 

 

Loops/Pauses Properties 
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Loops Properties 
When setting up a Loop, the Time Indicator can be at any position on the Timeline, although the Frame at 
which the Time Indicator is positioned becomes the default Start Frame for the Loop.  This can be changed 
in the Start Frame field. 

The following Loops parameters can be set:  

Loops 
Properties 

Description 

Enabled  Select (check) the Enabled checkbox to enable Looping.  A new 
Loops object is added to the Timeline, the Keyframe Graph and the 
Scene Graph. 

Each subsequent Loop that is added to the animation results in a new 
Keyframe added to the existing Loop Object Timeline/Keyframe 
Graph.  There is only one Loop Object in any animation. 

Start 
Frame 

Start Frame defines the Start Time of the loop. 

End Frame  End Frame defines the End Time of the loop. 

Loops Number of Loops to be executed.  Range is 0 to 50.  Loops is 
disabled if Infinite is selected (see below). 

Infinite Selecting (checking) Infinite continually executes the Loop until 
stopped from Lyric. 

To set up a Loop: 
1. Set a Start Frame and an End Frame in the respective fields. 

2. Enter the number of Loops in the Loops field, or select Infinite. 

3. Select (check) Enabled.  The Loop is now ready to execute.  If this is the first Loop set in the 
animation, a new Loops object is added to the Timeline, the Keyframe Graph and the Scene 
Graph.  A Keyframe is also added to the Loops Timeline at the Start Frame of the Loop.  Each 
subsequent Loop added to the animation adds another Keyframe to the Loops Timeline. 

To view and/or modify and existing Loop: 
 Move the Timeline indicator to the Start Frame of the Loop.  The Loop attributes are displayed in 

the Properties > Loops/Pauses tab, and can be modified. 

To escape a Loop in progress and stop animation (all systems): 

 Press Esc or click the  button on the Transport Controls. 

To escape a Loop in progress and play out the animation to its conclusion (Duet LE/LEX/PCI/PCI+ only): 

 Press Esc. 

The following conditions apply to Loops: 
 Loops cannot overlap or nest.  For example, if there is a Loop from 00:00:01:00 to 00:00:03:00, 

there cannot be a Loop starting at 00:00:02:15.  The Loop must start and end before 00:00:01:00, or 
it must start and end after 00:00:03:00. 

 On a Duet LE/LEX/PCI/PCI+, there is a limit of one Loop in an animation.  Additionally, Loops can 
only be executed using Load-and-Play mode, not Transfer (Xfer) or Streaming Animation mode. 
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Pauses Properties 
When a Pause is set in an animation, the animation stops temporarily at the Frame or event specified for the 
Pause, then restarts when manually or automatically triggered, as determined by the Pauses setup.  Multiple 
Pauses can be set in an animation.  There are two types of Pauses, both of which can be set in the same 
animation: 

 A Keyframe Pause occurs at a set Keyframe in an animation.  This type of Pause is set up from the 
Properties > Loops/Pauses tab (see figure above).  Keyframe Pause setup is described below. 

 An Event Pause is applied to an object that has a self-contained animation, such as a Roll, Crawl or 
Type On (Slow Reveal).  The Event Pause occurs at a point where a certain event has occurred.  
For example, a Roll can be set to Pause after each Row is executed, or after a Roll window is full.  
Event Pause setup is described in the section on Properties > Animation. 

To set up a Keyframe Pause: 
1. Move the Time indicator on the Timeline to the position at which the Pause should occur.  For 

example, use the time 00:00:03:03. 

2. Select Enabled in the Properties > Loops/Pauses tab.  The Pause Information window (see figure 
above) now displays: 

Pause for Keystroke (default Pause For setting) 

After 00:00:03:03 

3. Set Pauses Parameters as follows:  

Description Description 

Enabled Select (check) the Enabled checkbox to enable the creation of a 
Pause at the current position of the Time Indicator on the Timeline 
of an animation.  When the first Pause is set in an animation, a 
Pause object is added to the Timeline, the Keyframe Graph and the 
Scene Graph.  A Keyframe is also added to the Pause object at the 
specified Frame in the animation. 

Each subsequent Pause that is added to the animation results in a 
new Keyframe added to the existing Pause Object 
Timeline/Keyframe Graph.  There is only one Pause Object in any 
animation. 

Pause 
Information 

Describes whether the Keyframe Pause at that Frame in the 
animation is programmed to be triggered by a keystroke, after a 
predetermined Timeout, or by a GPI.  The Pause Information 
reflects the settings in the Pause Options dialog box. 

Modify 
Pause 

Selecting Modify Pause displays the Pause Options dialog box (see 
figure above). 
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Pause Options 
Pause Options specify precisely how the Pause is to be applied and how the animation is to be triggered 
after the Pause.  Set parameters, then select OK to apply, or Cancel to cancel the changes.. 

Parameter Description 

Pause At indicates which frame number at which the Pause Keyframe is positioned, 
and how the Pause is to be executed with regard to that Keyframe. 

Keyframe 
In 

Keyframe In:  Pause for Keyframe In renders the animation through 
the Keyframe directly preceding the Pause Keyframe.  When 
triggered, the animation continues at the start of the Keyframe.  The 
Pause Information window would display: 

Pause for Keystroke (or Timeout, GPI or 
Replay) 

Before 00:00:03:03 

Keyframe 
Out 

Keyframe Out:  Pause for Keyframe Out renders the animation 
through the Pause Keyframe.  When triggered, the animation 
continues at the start of the frame directly following the Pause 
Keyframe.    The Pause Information window would display: 

Pause for Keystroke (or Timeout, GPI or 
Replay) 

After 00:00:03:03 

Pause 
Type 

The Pause Type field (which is unlabeled) describes what defines the 
Pause, i.e. a Keyframe, a Row (as in a Roll), etc.  In the Properties 
> Loops/Pauses tab, this is always set to Keyframe. 

Pause 
Applied To 

The Pause Applied To field (not labeled) specifies when the Pause is 
applied.  In the Properties > Loops/Pauses tab, this is always set to 
Current.  This indicates that the Pause applies only to the Keyframe 
at which it was set. 

Ease Selecting Ease displays the Ease Options dialog box (shown at right 
in the figure above).  Four types of Ease are available:  No Ease, 
Ease In, Ease Out and Ease In/Out.  The Ease Time, which is the 
duration of time over which the Ease is applied, can also be set.  
Refer to Ease, found in the section on animation, for additional 
information. 

Pause For indicates what type of trigger is to be used to resume the animation after a 
Pause Keyframe. 

Keystroke The animation pauses at the specified Pause, then continues when 
triggered by a any keystroke except Esc. 

Timeout The animation pauses at the specified Pause, then continues after the 
specified Timeout. 

GPI The animation pauses at the specified Pause, then continues when 
triggered by the specified GPI. 
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Parameter Description 

Replay Replay is a trigger type that is used for Multi FX execution.  A Replay 
Pause point inserted into message divides the message into two 
segments.  The first segment becomes the In Effect of the Multi FX 
execution; the second segment becomes the Out Effect of the Multi 
FX execution.  Both segments are triggered by clicking the Play 
button in the Multi FX dialog box.  Note that when using a Replay 
Pause, the In and Out Effects in the Multi FX Control dialog box 
should be set to Use Message. 

To reset the settings in the Pauses Options dialog box: 
 Select Reset. 
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Animation Properties 
Properties > Animation 
Various animation parameters of an object can be set in the Animation tab in the Properties window.  These 
settings are used to adjust Start Frame, End Frame, Duration and other parameters of an object's 
animation.  In the instances of Rolls, Crawls and Type Ons (Slow Reveals),  Speed Number and Rate can 
be set as well.  The Animation tab is shown here in four different states to show the dropdown menu which 
lists the animated elements on the Canvas, as well as the special options that are available for Roll, Crawl 
and Type On. 

 

Animation Properties for 2D Text Animations 
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Parameter Description 

Object The Object drop-down list box lists all of the objects in the 
animation.  From this dropdown menu, the user can select an object 
(2D Text window, bitmaps, 3D text, individual light sources, 
Camera, etc.) and view and/or edit its Object Timeline parameters. 

Modify Timeline:  When an Object Timeline parameter (Start Frame, End Frame, 
Duration, Speed Number, Rate)  is set, fields for the object's other Object Timeline 
parameters are updated to reflect the change. 

Start Frame Sets the Start Frame for the animation.  When Start Frame is 
modified, the Duration and Rate are updated.  Speed Number 
defaults to 0 unless the updated Rate matches a Rate assigned to 
a Speed Number (see below). 

End Frame Sets the End Frame for the animation.  When End Frame is 
modified, the Duration and Rate are updated.  Speed Number 
defaults to 0 unless the updated Rate matches a Rate assigned to 
a Speed Number (see below). 

Duration Sets the duration of an Object Timeline.  When Duration is 
modified, the End Frame and Rate are updated.  Speed Number 
defaults to 0 unless the updated Rate matches a Rate assigned to 
a Speed Number (see below). 

Speed 
Number 

Sets execution speed for Rolls, Crawls and Type Ons (Slow 
Reveals) only.  Click the Speed Number radio button, then enter a 
whole number between 1 (slowest) and 9 (fastest) into the spin box 
or use the up/down arrows.  0 is a special case as described below.  
The Speed Numbers correspond to the following preset Rates.  
Units are Scanlines/Field for Rolls, Pixels/Field for Crawls and 
Characters/Second for Type Ons (Slow Reveals). 

0:  This is the default setting for any Rate value that does not 
match a Speed Number Rate.  When the Rate matches one of 
the preset Speed Number Rates, the Speed Number field 
updates to the corresponding Speed Number. 

1:  
0.125 

3:  
0.500 

5:  
2.000 

7:  
6.000 

9:  10.000 

2:  
0.250 

4:  
1.000 

6:  
4.000 

8:  
8.000 

10:  12.000 

When Speed Number is modified, End Frame, Duration and Rate 
are updated. 

Rate Sets execution speed for Rolls, Crawls and Type Ons (Slow 
Reveals) only.  Click the Rate radio button, then input a Rate value.  
Units are Scanlines/Field for Rolls, Pixels/Field for Crawls and 
Characters/Second for Type Ons (Slow Reveals).  Range is 
0.000000 - 50.000000. 

When Rate is modified, End Frame and Duration are updated.  
Speed Number defaults to 0 unless the updated Rate matches a 
Rate assigned to a Speed Number (see above). 
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Parameter Description 

Proportional 
Scaling 

Proportional Scaling determines how or if the Keyframes are 
redistributed when Start Frame, End Frame and/or Duration of an 
Object Timeline are changed. 

 When Proportional Scaling is enabled (checked), 
Keyframes are redistributed when the Start Frame, End 
Frame and/or Duration are changed, to retain their original 
relationship to the duration of the Object Timeline. 

 When Proportional Scaling is disabled (unchecked), 
Keyframes retain their positions when Start Frame, End 
Frame and/or Duration are changed. 

Refer to the chapter on Timelines for information on scaling. 

Options Options specifies precisely how an animation is to be applied.  
Options includes Pause Options, which determines how a Pause 
is applied and how the animation is to be triggered after the Pause.  
Options are available only to Rolls, Crawls and Type Ons (Slow 
Reveals).  See Options below for details. 

Apply Applies the parameters to the selected object in the animation. 

Apply All Applies the parameters globally to all objects in the animation. 

Reset Resets the parameters to system defaults. 
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Options 
Options specifies precisely how an animation is to be applied.  Options includes Pause Options, which 
determines how a Pause is applied and how the animation is to be triggered after the Pause.  Options are 
available only to Rolls, Crawls and Type Ons (Slow Reveals).  The Pauses set in this tab are Event 
Pauses, and can be applied only to Rolls, Crawls and Type Ons (Slow Reveals). 

If the object is a Roll Window, a Crawl Window, or a Type On (Slow Reveal) Window, the Options area is 
labeled Roll Options, Crawl Options or Type On Options respectively.  Conditions specific to each are 
noted. 

Parameter Description 

Pause 
Options 

Pauses can be programmed into an animation.  When a Pause is set 
in an animation, the animation stops temporarily at the Frame or 
event specified for the Pause, then restarts when manually or 
automatically triggered, as determined by the Pauses setup.  See 
Pause Options below for details. 

Soft The Soft setting determines how a Roll, Crawl or Type On (Slow 
Reveal) enters and leaves its respective window. 

 When Soft is enabled (checked), a Roll, Crawl or Type On 
(Slow Reveal) fades in as it enters its respective window and 
fades off as it leaves its respective window. 

 When Soft is disabled (unchecked), a Roll, Crawl or Type 
On (Slow Reveal) displays at full video as it both enters and 
leaves its respective window.  

Random The Random setting determines how the characters in a Type On 
(Slow Reveal) enter the Type On window. 

 When Random is enabled (checked), the characters are 
displayed on the screen in random order, row by row. 

 When Random is disabled (unchecked), the characters are 
displayed from left to right, starting from the top row, and 
progressing through each subsequent row. 

Pause Options 
When a Pause is set in an animation, the animation stops temporarily at the Frame or event specified for the 
Pause, then restarts when manually or automatically triggered, as determined by the Pauses setup.  Multiple 
Pauses can be set in an animation.  There are two types of Pauses, both of which can be set in the same 
animation: 

 A Keyframe Pause occurs at a set Keyframe in an animation.  This type of Pause is set up from the 
Properties > Loops/Pauses tab.  See Properties > Loops/Pauses for details. 

 An Event Pause is applied to an 2D Text object that has a self-contained animation; a Roll, Crawl or 
Type On (Slow Reveal).  The Event Pause occurs at a point where a certain event has occurred.  
For example, a Roll can be set to Pause after each Row is executed, or after a Roll window is full.  
This type of Pause is set up from the Properties > Animation tab (shown above). 
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To set up an Event Pause: 
1. In the Object drop-down list box in the Animation tab shown above, select the object to which to 

apply the Pause.  To see how this works, create a Roll window, then select 2D Roll 1 as the object.  
The Information window (unlabeled) in the Roll Options area indicates that the object does not have 
a Pause applied.  The Options button is grayed out. 

 

Pause Setup - 2D Roll 1 Selected 
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2. In the Roll Options area, select (check) Pause.  The Information window displays the default setting 
for a Roll Pause.  The Options button becomes available. 

 

Default Roll Pause Options 

3. Select the Options button.  The Pause Options dialog box is displayed. 

 

Pause Options Dialog Box Showing Roll Settings 
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4. The parameters for all types of Event Pauses are listed below.  Set parameters, and then select 
Apply or  Apply All (described above). 

Parameter Description 

Pause At indicates which frame number at which the Pause Keyframe is positioned, 
and how the Pause is to be executed with regard to that Keyframe. 

Keyframe 
In 

Keyframe In is not applicable to Event Pauses. 

Keyframe 
Out 

Keyframe Out is not applicable to Event Pauses. 

Pause 
Type 

The Pause Type field (which is unlabeled) describes what defines the 
Pause, i.e. a Keyframe, a Row (as in a Roll), etc.  In the Properties 
> Animation tab, they can be set as follows.  <Trigger> specifies the 
Pause For selection, i.e. Keystroke, Timeout, GPI or Replay. 

Roll 

 Row:  The Roll pauses before each row, including the first, is 
executed.  When the last few rows of the Roll fill the window, 
and no rows remain below the bottom of the Roll Window, 
the Roll then continues execution without pausing until the 
end.  The Information Window would then display Pause 
for <Trigger> At Row Begin. 

 Window:  The Roll pauses after the Roll Window is full.  
The Information Window would then display Pause for 
<Trigger> At Window Full. 

Crawl 

 Word:  The Crawl pauses before each word, including the 
first, is executed.  When the last few words of the Crawl fill 
the window, and no complete words remain beyond the right 
boundary of the Crawl Window, the Crawl then continues 
execution without pausing until the end.  The Information 
Window would then display Pause for <Trigger> At Word 
Begin.  Caution is advised when applying this type of Pause 
to a multi-row Crawl. 

 Window:  The Crawl pauses after the Crawl Window is full.  
The Information Window would then display Pause for 
<Trigger> At Window Full. 

Type On 

 Row:  The Type On pauses before each row, including the 
first, is executed.  The Information Window would then 
display Pause for <Trigger> At Row Begin. 

Pause 
Applied 
To 

The Pause Applied To field (not labeled) specifies when the Pause 
is applied.  In the Properties > Animation tab, this is always set to 
Every.  This indicates that the Pause applies every row or window as 
specified in Pause Type. 

Ease Ease is not applicable to Event Pauses. 
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Parameter Description 

Pause For indicates what type of trigger is to be used to resume the animation after a 
Pause Keyframe. 

Keystroke The animation pauses at the specified Pause, then continues when 
triggered by a any keystroke except Esc. 

Timeout The animation pauses at the specified Pause, then continues after 
the specified Timeout. 

GPI The animation pauses at the specified Pause, then continues when 
triggered by the specified GPI. 

Replay Note:  Caution should be taken if specifying a Replay trigger with a 
Roll, Crawl or Type On (Slow Reveal). 

Replay is a trigger type that is used for Multi FX execution.  A 
Replay Pause point inserted into message divides the message into 
two segments.  The first segment becomes the In Effect of the Multi 
FX execution; the second segment becomes the Out Effect of the 
Multi FX execution.  Both segments are triggered by clicking the Play 
button in the Multi FX dialog box.  Note that when using a Replay 
Pause, the In and Out Effects in the Multi FX Control dialog box 
should be set to Use Message. 

To reset the settings in the Pauses Options dialog box: 
 Select Reset. 
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Read Effects 
Read Effects provides a quick method for applying animation settings to objects currently on the Canvas or 
to objects in a file or series of files as they are read.  The key feature of Read Effects is the ability to save an 
animation as an .efx message, allowing the animation data from that message to be applied to a new set of 
objects. 

Refer to Read Effects - Duet SD/HD or Read Effects - Duet LE/LEX/PCI/PCI+ for setup information. 

Read Effects - Duet SD/HD 
Read Effects provides a quick method for applying animation settings to objects currently on the Canvas or 
to objects in a file or series of files as they are read.  The key feature of Read Effects is the ability to save an 
animation as an .efx message, allowing the animation data from that message to be applied to a new set of 
objects. 

Here's a quick exercise to demonstrate Read FX: 

Before you do anything else, set the default path where Lyric will store the new file type you'll be creating.  
Pull down Lyric's Config menu, select Preferences and click on the Default Paths tab. 

 

Preferences:  Default Paths 

Take note of the path specified for Effects; as with all of the other default paths, you may change the Effects 
file path here.  You will see why this location is important in a moment. 

1. Create a simple animation with any two objects.  You may use imported graphics, 2D Text Windows, 
3D characters or 3D objects. 

2. Pull down the File menu and select Save As.  You may have to navigate manually to the desired file 
path where you wish to store .efx files; see the next step. 
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3. Instead of selecting the default format ( ".lyr" for complete Lyric messages), use the drop-down to 
select the ".efx" format. Name the file, then click Save. 

 

Selecting Lyric Effects File Type 

4. Erase the Canvas. 

5. Import any other two objects and place them anywhere on the Canvas. 

6. Next, right-click anywhere on the Canvas Toolbar, which consists of the Transport Controls, the 
Frame Counter Display, the Message Number Display and the Reset Scroll Position button. 

 

Canvas Toolbar 
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The Read FX Toolbar appears. 

 

Read FX Toolbar 

7. Click the dropdown menu in the Read FX Toolbar and you will see the name of the .efx file you 
saved in Step 3.  Select the file so that it appears in the window.  

8. Press the  button. 

9. The objects in your new Canvas move to the starting position of each object in the previous animation 
and the animation properties (Rotation, Position, Scale, etc.) are immediately applied to the new 
objects. The animation plays out for the same duration as in the previous Canvas. 

10. To play the animation again, press  again. To go to the beginning of the animation, click the 

Transport Controls Rewind button. You may also press , but the animation will run only on your 

system’s VGA monitor and not on the video output, unless the  button on the Lyric interface is 
pressed. 

11. To demonstrate another important characteristic of the Read FX feature, repeat the exercise 
described above, but in Step 5, import or create 3 or more objects in a blank Canvas.  While you're 
adding objects to the Canvas, remember the order in which you do so. 

12. Now, press    button again, to apply the first animation you created, which contained two 
objects. Note that only two objects are now in the scene, regardless of how many you've just added.  
If you examine the Scene Graph, you will see that only these first two objects are 'checked'.  The 
others are now 'unchecked'.  

Rather than leave static objects in your scene when an .efx file contains no animation data for them, Lyric is 
designed not to render them.  Note that these unchecked objects are still on the Scene Graph in case you 
wish to edit the current animation file or create a new one.  You may also activate (check) them on the Scene 
Graph, in order to see them rendered. 

Some things to remember about the Read Effects feature: 

 Read FX is designed for on-air use, so when you are working on a Duet SD/HD, the  button 
always supersedes the Live, Xfer, Swap and Frame Buffer/Channel buttons.  In other words, the 
current Canvas and Read FX animation plays to the active Frame Buffer. 

 When an .efx file is selected in the Read FX Toolbar, it is automatically applied to any message 
subsequently recalled.  Clear the entry in the Read FX Toolbar to apply the animation originally 
contained in the current message. 

 If the Read FX Toolbar is hidden when Lyric is launched, right-click on the Canvas Toolbar to 
access it. This is a preference that will be saved when Lyric is closed, and in the next session, the 
Read FX Toolbar will be hidden or displayed as you select at this time. 

 The dropdown menu in the Read FX Toolbar only 'sees' .efx files that have been saved in the default 
directory. 



 Animation  

 20-91 

Read Effects - Duet LE/LEX/PCI/PCI+ 
Read Effects provides a quick method for applying animation settings to objects currently on the Canvas or 
to objects in a file or series of files as they are read.  The key feature of Read Effects is the ability to save an 
animation as an .efx message, allowing the animation data from that message to be applied to a new set of 
objects. 

To record an .efx file: 

1. Create an animation. 

2. Execute a Save As to an .efx file.  Make sure that the file is saved to the default Effects directory as 
set in the Config>Preferences>Default tab, or it will not be available to apply to other objects or 
messages. 

To  apply animation data to a new set of objects: 

1. Place a new set of objects on the Canvas. 

2. Select an .efx file from the Read FX drop-down list box (as seen below).  This links an effects file with 
the objects on the screen. 

 
To preview the animation: 

 Make sure that the  button on the Duet LE/LEX/PCI/PCI+ toolbar is off, then click the Read 

Effects  button or the  button on the Transport Controls.  The animation executes on the 
Canvas only. 

To play the animation to air: 

 Click , then  on the Duet LE/LEX/PCI/PCI+ toolbar.  Note that there is a time restriction of 
six seconds on a Duet LE system. 

OR 

 Press the  button on the Duet LE/LEX/PCI/PCI+ toolbar, then the Play  button on the 
Transport Controls. 

NOTE: 

Using the  button to play the Read Effect to air is not supported in this version of 
Lyric. 
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21. Advanced Image Effects 

Advanced Image Effects 
2D Text Window Context (Right-Click) Menu > Advanced Image Effects 
2D Object Context (Right-Click) Menu > Advanced Image Effects 
Movie Object Context (Right-Click) Menu > Advanced Image Effects 

Accessing and Applying Advanced Image Effects 
IMPORTANT! 

When applied to bitmaps on Duet HD, these effects should be previewed CAREFULLY 
before Air/Production!  Advanced Image Effects applied to 2D Text Windows are not 
supported on Duet HD.  

Lyric's Advanced Image Effects feature provides dynamic, customizable effects that can be applied to 2D 
bitmap objects, entire 2D Text Windows or Movie objects.  Note that on Duet SD systems, Advanced Image 
Effects which apply an effect to an entire page, are also available via Multi FX.  The Multi FX feature is 
accessed from the Tools and Canvas/Scene Graph Context Menus. 

To access Advanced Image Effects setup: 
1. Click on the 2D Text Window, 2D bitmap object or Movie object to which the effect is to be applied, 

or on its listing in the Scene Graph, and then right-click.  The object's context menu is displayed. 

2. Select Advanced Image Effects from the menu.  The Advanced Image Effects menu is displayed.  
This menu lists the effects available to the system.  Bulge and Globe are available to Duet 
LE/LEX/PCI/PCI+ systems, but not Duet SD/HD systems.  Select an effect from the menu.  As shown 
in the following figure, the configuration dialog box for the effect is displayed.  

 

Accessing Advanced Image Effects 
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3. Set the desired parameters.  Drag the Preview slider to preview the effect.  Adjust effect settings and 
preview the effect as many times as necessary. 

4. Click OK.  The dialog box closes.  The effect is applied to the object for the duration specified in the 
configuration dialog box. 

For effects in the forward direction: 
 If the effect duration is shorter than the object duration on the Timeline, the effect begins at the frame 

calculated as follows:  End Frame - Effect Duration.  For example, if the object duration is 3 
seconds, and the effect duration is 1 second, the effect begins 2 seconds into the object's duration.  
The only exceptions are Assemble, Bulge and Zoom, which begin at the Start Frame of the object's 
duration and end at the effect's End Frame.  The object remains on-screen until the End Frame of 
the object's duration on the Timeline. 

 If the effect duration is longer than the object duration on the object's Timeline lengthens to 
accommodate the Effect Duration. 

For effects in the reverse direction: 
 If the effect duration is shorter than the object duration on the Timeline, the effect begins at the Start 

Frame of the object's duration and ends at the effect's End Frame.  The object remains on-screen 
until the End Frame of the object's duration on the Timeline.  The only exceptions are Assemble, 
Bulge and Zoom, where the effect begins at the frame calculated as follows:  End Frame - Effect 
Duration.  For example, if the object duration is 3 seconds, and the effect duration is 1 second, the 
effect begins 2 seconds into the object's duration.  For example, if the object duration is 3 seconds, 
and the effect duration is 1 second, the effect begins 2 seconds into the object's duration. 

 If the effect duration is longer than the object duration on the object's Timeline lengthens to 
accommodate the Effect Duration. 

The effect parameters can be edited by reopening the effect's configuration dialog box.  Applying a different 
effect to the same object replaces the existing effect. 

About Applying an Advanced Image Effect to a 2D Bitmap Object or Movie Object 
An Advanced Image Effect applied to a 2D bitmap object or a Movie object effect can travel about the 
screen during an animation by repositioning the object the same as with an object that does not have an 
effect applied.  Static and animated Transparencies (from Properties > Surface), however, must be applied 
after the Advanced Image Effect is applied. 

About Applying an Advanced Image Effect to a 2D Text Window 
When an Advanced Image Effect is applied to a 2D Text Window, a new object, ImgEffect.<2D Text 
Window Name>, is added to the Scene Graph. 

 

Scene Graph Showing New Advanced Image Effect Object 

The original 2D Text Window still remains in the scene, although it is automatically set not to display.  
ImgEffect.2D Text 1 cannot be used as a Mask Object.  On the Duet LE/LEX/PCI/PCI+ it cannot be 
assigned to a Mask Layer, act as a Mask Inside element or an Alpha Trim Mask. 

The Transparency of a 2D Text Window can be adjusted in Properties > Surface before an Advanced 
Image Effect is applied, and can vary from keyframe to keyframe.  If the text in the 2D Text Window must be 
edited, the Advanced Image Effect must be reapplied.  An Advanced Image Effect applied to a 2D Text 
Window can travel about the screen during an animation by repositioning the 2D Text Window's  ImgEffect 
object. 
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NOTE 
If applying both an Advanced Image Effect and Advanced Text Effect to a 2D Text 
window, the two resulting animations are not combined with each other and applied to 
one object.  Each of the effects creates a separate animated object that is rendered and 
executed separately.  Execution of the two effects can, however, be simultaneous. 

Effect Parameters Common to All Effect Types 
All Advanced Image Effects have a number of parameters in common, as well as parameters specific to the 
individual effect.  The common parameters are as follows: 

 Enable:  On occasion, it may be advantageous to set up an effect, but not enable it to execute at a 
particular time.  Enabling (checking) Enable allows the effect to execute; disabling (unchecking) 
Enable preserves the setup parameters, but does not allow the effect to execute. 

 Fade:  Enabling (checking) Fade fades the effect out; disabling (unchecking) Fade executes the 
effect at full video throughout the duration of the effect. 

 Reverse Play:  Enabling (checking) Reverse Play plays the effect in reverse; disabling Reverse 
Play executes the effect in the forward direction. 

 Ease softens the transition into and/or out of an effect.  When Ease is selected, the Ease Options 
dialog box opens, allowing the selection of Ease Type:  No Ease, Ease In, Ease Out Ease In/Out.  
Additionally, the Ease can be executed over the time specified in the Ease Time.  This dialog box can 
be accessed either by clicking the Ease checkbox to enable Ease, or by clicking the Options button 
once Ease is enabled. 

 

Ease Options 

 Effect Length determines the duration of effect execution.  If the Effect Length is shorter than the 
duration of the object on the Timeline, the effect executes to the specified Effect Length, but the 
object remains on screen for the duration specified by its Timeline. 

 Preview Slider:  The effect can be previewed by dragging the Preview slider. 

 Full Scene:  The Full Scene setting allows the user to preview only the effect or the entire animation, 
including the effect. 

o If Full Scene is enabled (checked), the entire animation is previewed. 

o If Full Scene is disabled, only the effect is previewed. 

Advanced Image Effects can be executed in the same manner as other Lyric animations by using the 
Transport Controls.  These animations can be jumped ahead to the next or previous Keyframe, or 
advanced or rewound to the beginning or end of their duration.  Refer to Animation Playback - Transport 
Controls for additional information. 
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Effect Types 
The graphics shown in the following examples are based on effects applied to a Chyron logo: 

None 
Selecting None removes the effect from the object. 

 

No Effect Applied 
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Assemble (and Disassemble) 
The Assemble effect reassembles an image from rectangular fragments.  Enabling Reverse Play creates a 
Disassemble effect.  Fade is not available to this effect. 

 

Assemble Effect Configuration - Default Settings 

Specialized attributes include: 
 Effect Resolution:  Specifies the number of fragments from which the object is reassembled, as 

determined by multiplying the Row value by the Column value. 

 Method:  Specifies on which axis or axes and from which direction(s) the object is reassembled.  
Method - On X Axis, Method - On Y Axis and/or Method - On Z Axis cannot be applied in 
conjunction with Alpha Build. 

 Alpha Build:  When Alpha Build is enabled (checked), the fragments of the object do not move 
through 3D space to reassemble.  The object, instead, starts the effect fully transparent, and the 
fragments fade in at different times.  Fragment Rotation can be applied in conjunction with Alpha 
Build.  Alpha Build cannot be applied in conjunction with Method - On X Axis, Method - On Y Axis 
and/or Method - On Z Axis enabled. 
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Alpha Build - No Fragment Rotation 

To disable Alpha Build, click Method - On X Axis, Method - On Y Axis or Method - On Z Axis. 

 Synchronized:  When Synchronized is enabled (checked), the assembly occurs equally from both 
the negative and positive ends of each axis.  When Synchronized is not enabled (unchecked), the 
assembly occurs randomly.  When Alpha Build and Synchronized are enabled, the fragments fade 
in, in a more even distribution than if Synchronized is not enabled.  

 Fragment Rotation:  Specifies if and how the fragments rotate about their own axes. 
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The following figures show an 20-Row, 20-Column, Assemble effect.  The Assemble executes along all 
axes and from all directions.  The fragments rotate about all axes as well. 

 

Assemble Effect 
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Bulge - Duet LE/LEX/PCI/PCI+ Only 
The Bulge effect employs a spherical wireframe to travel across the image, bulging it out or in. 

 

Bulge - Default Configuration with Wireframe 

Specialized attributes include: 
 Set Attributes For:  Select First Frame to set attributes for the first frame of the effect.  Select Last 

Frame to set attributes for the last frame of the effect.  When the effect executes, the object 
transformation progresses from the settings for the first frame to the settings for the last frame.  

 Radius:  Specifies the radius of the wireframe, which determines the size of the bulge. 

 Position:  Specifies the Start and End positions of the bulge.   

 Bulge Inward:  Specifies if the object bulges inward or outward. 

 Embed Effect Data on Save:  Specifies that the rendering information is saved with the effect. 
Enabling Embed Effect Data on Save eliminates the time needed to rebuild the effect each time the 
message containing the effect is read.  Enabling Embed Effect Data on Save, however, can add 
approximately 2MB per effect to the message size. 
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When the Bulge effect is selected, the wireframe sphere is displayed on the Canvas.  A separate set of First 
Frame and Last Frame attributes for the sphere can be set.  

The following figures show a 2-second Bulge Effect Preview with the First Frame Radius at 20, Position 
Center, and the Last Frame Radius at 100, Position Center.   

 

Frame 25 

 

Frame 43 

 

Frame 60 
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When the Bulge effect executes from outside of the Bulge Effect Configuration dialog box, the wireframe is 
no longer visible. 

 

Bulge Execution 

Crumble 
Applying the Crumble effect to an object causes it to fall apart into rectangular pieces either all at one time or 
progressively. 

 

Crumble Effect Configuration 
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Specialized attributes include: 
 Effect Resolution:  Specifies the number of fragments into which the object crumbles, as determined 

by multiplying the Row value by the Column value. 

 Progressive Crumble, Crumble Control:  When a Crumble effect executes, the entire object 
normally falls apart at one time.  When Progressive Crumble is selected (checked), the Crumble 
can progress through the object, starting from a specified point.  The start point settings become 
active only when Progressive Crumble is selected. 

The following figures show a 60-Row, 60-Column, Progressive Crumble originating from the center of the 
object. 

 

Crumble Execution 
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Curtain 
When a Curtain effect is applied, the object appears to be drawn to the top, bottom, left, right or center, as in 
opening a curtain. 

 

Curtain Effect Configuration 

Specialized attributes include the following: 
 Effect Resolution:  Specifies the number of Row (horizontal) ripples and Column (vertical) ripples 

are applied to the object. 

 Curtain Ripple Size - Cycles:  Increasing/decreasing the Cycles value increases/decreases the 
number of peaks and valleys in the curtain. 

 Curtain Ripple Size - Amplitude:  Specifies the depth of the ripples. 

 Curtain Ripple Speed:  Specifies the speed at which the ripples travel. 

 Curtain Moving To:  Specifies the location to which the object is drawn. 
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The following figure shows a 12-Row, 12-Column Curtain Effect with Curtain Ripple Size Cycles set to 9, 
Amplitude set to 8, Ripple Speed Fast and Curtain Moving to Top. 

 

Curtain Effect 
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Detonate 
When the Detonate effect is applied, the object flies apart, with rectangular fragments rotating along their 
axes. 

 

Detonate Effect Configuration 

Its specialized attribute is as follows: 
 Effect Resolution:  Specifies the number of fragments into which the object breaks, as determined 

by multiplying the Row value by the Column value. 

The following figure shows a 10-Row, 10-Column Detonate Effect. 

 

Detonate Effect 
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Explosion 
When the Explosion effect is applied, the object flies apart, in concentric layers, into triangular fragments.  
Additionally, the fragments rotate within the layers as the effect progresses. 

 

Explosion Effect Configuration 

Specialized attributes include: 
 Explosion Polygons - Layers:  Specifies the number of concentric rings of fragments. 

 Explosion Polygons - Sections:  Specifies the number of sections into which each layer is broken. 

 Translation Speed:  Not currently implemented. 

 Rotation Speed:  Specifies the speed at which the layers rotate. 



Lyric User Guide 

 21-16 

The following figure shows a 9-Layer, 20-Section-per-layer Explosion, with Translation Speed Fast and 
Rotation Speed Medium.  

 

Explosion Effect 
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Flag 
Applying a Flag effect gives an object the appearance of waving like a flag in the wind. 

 

Flag Effect Configuration 

Specialized attributes include: 
 Wind Speed:  Specifies the speed at which the wind blows. 

 Wind Direction:  Specifies the direction of the wind. 

 Flag Control:  Specifies the axis or axes on which the flag waves. 
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The following figure shows a Flag effect with a Calm Wind Speed, Horizontal Wind Direction and waving 
on the Y-Axis and Z-Axis. 

 

Flag Effect 
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Flipboard 
The Flipboard effect splits the image into columns and/or columns, and flips the pieces over.  The image can 
flip and disappear, or it can flip to another image. 

 

Flipboard Effect Configuration 

Specialized attributes include: 
 Effect Resolution:  Specifies the number of pieces into which the image is split, as determined by 

multiplying the Row value by the Column value. 

o Note that if Horizontal, Synchronized Orientation and Flip from Left, Flip from Right or 
All at Once are selected, Rows are not visible when the effect is executed. 

o If Vertical, Synchronized Orientation and Flip from Top, Flip from Bottom or All at Once 
are selected, Columns are not visible when the effect is executed. 
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 Back Image:  Specifies the image that is applied to the back of the flipped image.  It becomes visible 
as the image flips over.  The following are available: 

o None:  The image disappears as it flips. 

o Graphic:  The image flips to a new image.  To apply a graphic, click the Image Chip or 
select the Graphic radio button.  The Select a Texture Source dialog box opens.  Navigate 
to and select a 2D graphic file, and then click Open.  The selected image is displayed in the 
Image Chip.  When the Flipboard effect executes, the image flips to the selected Object 
Texture.  If the selected Object Texture is the same as the image to which it is applied, then 
the image flips to itself.  Note that any texture that is applied is resized to the dimensions of 
the flipping image, which may include transparent areas. 

o Object:  The image flips to the image of an object that is on the current Canvas.  The object 
can be placed out of the visible boundaries of the Canvas, but must be set to visible 
(checked) in the Scene Graph in order to be applied to the flipping image.  To apply an 
object: 

a. Select the Object radio button.  The Select Object Texture dialog box is 
displayed. 

 

Select an Object Texture 

b. All available objects in the Lyric scene are listed.  3D characters/objects do 
not appear in this list.  Click the name of the object which is to be applied to 
the image, and then click OK.  When the Flipboard effect executes, the 
image flips to the selected Object Texture.  If the selected Object Texture is 
the same as the image to which it is applied, then the image flips to itself.  
Note that the texture that is applied is resized to the dimensions of the 
flipping image, which may include transparent areas. 

 Flip From:  Specifies point from which the Flip starts.  The Flip can also start from all points. 

 Orientation:  Specifies if the flip progresses horizontally, vertically or randomly.  The pieces of the 
image can flip synchronously or asynchronously. 
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The following figure shows a Flipboard effect Synchronized Horizontally, Flipping from the Left, and with 
a graphic of an arrow applied to the back. 

 

Flipboard Effect 
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Frames 34, 43 and 49 of the effect show how the flip progresses through the effect. 

 

34 Frames 

 

43 Frames 

 

49 Frames 
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Focus 
When a Focus effect is applied, the camera appears to zoom in and object goes out of focus as the effect 
progresses.  If Reverse Play is enabled, the object starts the effect out of focus, and becomes focused as the 
effect progresses. 

 

Focus Effect Configuration 

Specialized attributes include: 

 Focus Aspect - Length:  A shorter Focus Aspect Length results in a shorter zoom and less 
defocusing.  A longer Focus Aspect Length results in a longer zoom and more defocusing.  

 Focus From:  Specifies the point from where the camera is zooming and focusing. 
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The following figure shows a Zoom effect with a Focal Aspect Length of 40 and originating from the Center. 

 

Focus Effect 
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Globe - Duet LE/LEX/PCI/PCI+ Only 
The Globe effect applies the selected object to a globe.  The globe can be set to rotate about the X-, Y-, or Z-
axis. 

 

Globe Effect Configuration 

Specialized attributes include the following: 
 Globe Size:  The radius of the globe can be increased or decreased. 

 Rotation - Speed:  The speed of the rotation can be adjusted. 

 Rotation - Clockwise:  If Clockwise is selected (checked), the rotation executes in the clockwise 
direction.  If Clockwise is not selected (not checked), the rotation executes in the counter-clockwise 
direction. 

 Rotation - About Axis:  The globe can rotate about the X-, Y-, or Z-axis. 

 Formation/Deformation - Enable Culling:  When the object is applied to the globe, it is, in effect, 
"wrapped" around the globe, much as an orange would be wrapped in cellophane.  Depending on the 
shape, size and orientation of the object that is "wrapped" around the globe, there may be 
overlapping.  If Enable Culling is selected (checked), overlapping portions of the graphic are 
removed (culled).  If Enable Culling is not selected (not checked), overlapping portions of the graphic 
are not removed.  The following figure shows an unculled and a culled globe. 
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Unculled and Culled Globes 

The following figure shows a bitmap applied to a globe, with a Radius of 8, Rotation of 1, counter-clockwise 
direction, rotating about the Z-axis and culled. 

 

Globe Effect 
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Leaf 
The Leaf effect splits the image into four segments which are peeled back as the effect progresses. 

 

Leaf Effect Configuration 

Leaf Coverage determines to what degree the four leaves overlap each other before peeling open.  Leaf 
Coverage can be set to a value that ranges from None to Full. 

The following figure shows a Leaf effect set between Partial and Full Coverage. 

 

Leaf Effect 
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Matrix 
The Matrix effect splits the image as determined by number of Rows and Columns in the Matrix. 

 

Matrix Effect Configuration 

Specialized attributes include the following: 
 Matrix Motion - Add Rotation:  Not currently implemented. 

 Matrix Motion - Random:  Not currently implemented. 

 Matrix Size:   Specifies the number of pieces into which the image is split, as determined by 
multiplying the Row value by the Column value. 

 Effect Speed:  Specifies how quickly the effect executes within the set Effect Length. 
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The following shows a Matrix effect set to split into 20 Rows and 20 Columns. 

 

Matrix Effect 
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PageRoll 
The PageRoll effect rolls an image as if to uncover an image lying below it. 

 

PageRoll Effect Configuration 

Specialized attributes include the following: 

 Roll Page from Side:  Specifies the side from which the image rolls. 

 Roll Size:  Specifies the size of the roll. 
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The following shows a PageRoll set to at a Radius of 10, and rolling up from the bottom. 

 

PageRoll Effect 
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PageTurn 
The PageTurn effect peels an image off the screen, as if turning a page. 

 

PageTurn Effect Configuration 

Specialized attributes include the following: 

 Lift Corner of Page:  Specifies the corner of the image that is lifted to execute the PageTurn. 

 Turn Orientation:  Specifies whether the corner of the image is lifted over (outside) or under (inside) 
the image. 
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The following shows a PageTurn, lifting from the bottom left corner of the image, over (outside) the image. 

 

PageTurn Effect 
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Ripple 
The Ripple effect ripples the image as if it is reflected in water. 

 

Ripple Effect Configuration 

Specialized attributes include the following: 

 Effect Resolution:  Specifies the number of Row (horizontal) ripples and Column (vertical) ripples 
are applied to the object. 

 Ripple Size - Cycles:  Increasing/decreasing the Cycles value increases/decreases the number of 
peaks and valleys in the curtain. 

 Ripple Size - Amplitude:  Specifies the depth of the ripples. 

 Ripple Speed:  Specifies the speed at which the ripples travel. 
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The following shows a Ripple effect set at 8 Rows, 8 Columns, 10 Cycles, 10 Amplitude and Medium 
Speed. 

 

Ripple Effect 
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Slide 
The Slide effect slides the image off of the screen. 

 

Slide Effect Configuration 

The image can be slid to a side or corner of the screen. 
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The following shows a Slide set to slide the image off the screen at the upper right corner. 

 

Slide Effect 
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Venetian 
The Venetian effect applies a "Venetian blinds" effect to the image. 

 

Venetian Effect Configuration 

Specialized attributes include the following: 

 Orientation of Fields:  Specifies whether the blinds are vertical or horizontal. 

 Number of Folds:  Specifies the number of blinds into which the image is split. 



 Advanced Image Effects  

 21-39 

The following shows a horizontal, 6-fold Venetian effect. 

 

Venetian Effect 
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Wipe 
The Wipe effect wipes the image from the screen. 

 

Wipe Effect Configuration 

Specialized attributes include the following: 

 Wipe from Side:  Specifies the side from which the wipe starts. 

 Softness:  Specifies the softness of the edge of the Wipe. 
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The following shows a Wipe, originating from the Right, with an edge Softness of 14. 

 

Wipe Effect 



Lyric User Guide 

 21-42 

Zoom 
The Zoom effect emulates a camera zoom out from an object. 

 

Zoom Effect Configuration 

Zoom out from specifies which from point the Zoom originates. 
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The following shows a Zoom originating from the upper right corner. 

 

Zoom Effect 
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22. Transition Effects 

Default Effect Configuration 
Config Menu > Default Effect 
The Default Effect is the effect used to transition from one message to the next when executing messages to 
output.  Cut and Wipe are just two of a wide variety effects available to Default Effect.  Playlists executed 
on Duet SD and LE/LEX/PCI/PCI+ systems can also use the effects available to Default Effect to transition 
from one message to the next.  The effects available to Default Effect are also available to Advanced Image 
Effects, although they are applied directly to graphics or text, rather than transitions between messages.  
Default Effect setup varies among systems. 

Default Effect Configuration - Duet SD 
Config Menu > Default Effect 

Default Effect Setup 
An effect such as a Wipe, Push, Fade, Dissolve, etc. can be set up as a Default Effect, which is then 
automatically applied to transitions in and out of graphics displays.  These effects can be used on all system 
configurations, with or without a mixer board.  To access Default Effect setup: 

 From the Config menu, select Default Effect.  The Default Effect dialog box is displayed. 

 

Default Effect Dialog Box 

Default Effects include Cut, Dissolve, Slide Wipe/Reverse Slide Wipe (Right, Left, Bottom, Top), Split 
Wipe/Reverse Split Wipe (Vertical, Horizontal), Box Wipe/Reverse Box Wipe (Center, Top Left, Top 
Right, Bottom Right, Bottom Left), Blind Wipe/Reverse Blind Wipe (Vertical, Horizontal), Pixel Wipe.  
Note that in order to use Pixel Wipe as a Default Effect, Duet Drivers Build 138 or later is required. 

Mixer Mode can be set to None or Composite. 

A Default Effect can be used on a single VGE within a Duet containing multiple VGEs and the SD Video 
Mixer board required by multiple VGEs.  Such a situation might arise where the Duet was required to execute 
manually-controlled Lyric message effects on one output, while the other VGEs performed CAL-driven tasks 
on another output. 
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The controls, however, work a little differently when the system includes a Video Mixer; these differences are 
called out where appropriate. 

 Standard Definition Duet systems offer two separate outputs, each fed by dedicated Frame Buffer 
portions of the Video Graphics Engine (VGE) hardware. The Swap function switches channels 
between Duet outputs; three Default Effects are available for such transitions. 

 On single-VGE Duets, the effect is executed on the inactive channel when the Swap  button 
is clicked. 

 On Duets with multiple VGEs and a Mixer, the effect is executed when the Transfer  button is 
clicked. On these systems, the effect is also executed when Lyric receives a Read command with the 

Duet "Render"  button active. 

Several of the Default Effect menu's settings are shown in the following figures. 

 

Default Effect Settings 

The Default Effect menu's Mixer Mode (not to be confused with the presence of a separate video mixer 
board) enables an SD Duet to route the contents of both internal Frame Buffers on a single VGE to a single 
output channel. This feature allows for the display of compositions that demand more processing power than 
a single Frame Buffer can provide. 

Item    Description 

Effect  Selects from a choice of Cut, Dissolve, Slide Wipe/Reverse Slide 
Wipe (Right, Left, Bottom, Top), Split Wipe/Reverse Split Wipe 
(Vertical, Horizontal), Box Wipe/Reverse Box Wipe (Center, Top 
Left, Top Right, Bottom Right, Bottom Left), Blind Wipe/Reverse 
Blind Wipe (Vertical, Horizontal), Pixel Wipe.  Note that in order to 
use Pixel Wipe as a Default Effect, Duet Drivers Build 138 or later 
is required. 

Direction  Choose one of four: Left to Right, Right to Left, Top to Bottom, Bottom 
to Top. 

Speed  Sets the Speed (in Frames) of Wipe or Dissolve effects. 
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Item    Description 

Mixer 
Mode 

None. In this mode, Frame Buffer 1 is routed to Duet's Video Out 1 
and Frame Buffer 2 is routed to Duet's Video Out 2.  

Composite combines the Frame Buffers for Channel 1 and Channel 2, 
routing the contents of both Frame Buffers to Duet's Video Out 1. In 
this mode, Channel 2 remains routed to Video Out 2. The routing for 
each mode is illustrated below. 

 

Note that the Composite setting has no effect in Duet systems with a 
Video Mixer. 

For example, with different compositions in each of the two Frame Buffers available on one VGE, you might 
wish to combine the compositions on one of Duet's outputs. 

 

2D Text in Frame Buffer 1 
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2D Text in Frame Buffer 2 

A Composite output, seen on Duet's Video Out 1, would look like this: 

 

Composite Output of Frame Buffers 1 and 2 

Using Default Effects in a Playlist 
Default Effects can be used in a Playlist on Duet SD systems containing a mixer board.  Default Effects in 
the Playlist include Cut, Dissolve, Wipe Right, Wipe Left, Wipe Down, Wipe Up, HSplit, VSplit, HBlind, 
VBlind, Box, BoxNW, BoxNE, BoxSE, BoxSW, Pixel, Rev HSplit, Rev VSplit, Rev HBlind, RevVBlind, 
Rev Box, Rev BoxNW, RevBoxNE, Rev BoxSE and Rev BoxSW.  Note that in order to use Pixel Wipe as 
a Default Effect, Duet Drivers Build 138 or later is required. 

Default Effect Configuration - Duet HD 
Config Menu > Default Effect 
The following Default Effects are available to Duet HD: 

None, Cut, Dissolve, Slide Wipe, Split Wipe, Box Wipe, Blind Wipe, Pixel Wipe 

To access Default Effect setup: 

 Select Default Effect from the Config menu, then refer to Advanced Image Effects for specifics on 
setting up each type of effect.  
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Message Effects Configuration - Duet LE/LEX/PCI/PCI+ 
Config Menu > Default Effect 
From Playlist:  Select Effect, then press X 

NOTE 
As of Lyric 4.0, Duet LE(x) Message FX has been moved from the Tools menu to the 
Config menu, and has been renamed Default Effect. 

An effect such as a Wipe, Push, Fade, Dissolve, etc. can be set up as a Default Effect, which is then 
automatically applied to transitions in and out of graphics displays.  A Default Effect can also be saved as a 
Message Effects file, which can be applied to a single Lyric message or a series of messages.  Because a 
Message Effects message is stored as a .lyr message, a number of them can be placed in a sequence of 
Lyric messages in Read Next or Read-Xfer operations.  A Message Effects message is applied to the 
subsequent Lyric message(s) that is read, until a new Message Effects message is loaded. 

NOTE 
Message Effect messages are not recognized by Playlists.  The effects set in the Playlist 
override the effects set in the Message Effects messages, as well as overriding the 
Default Effect.  Refer to the section on Playlists for additional details. 

Comparing Default Effects on Various Duet Systems 
An important difference between Lyric for Duet LE/LEX/PCI/PCI+ and other versions of Lyric is that this 
version does not save effects settings in the message files containing on-screen content.  Rather, effects 
settings are saved in separate message files, which also use the .lyr extension. 

The effects available to Duet LE/PCI are also available to Duet LEX/PCI+.  There is also an additional set of 
effects available to Duet LEX/PCI+ only. Only the effects shown in the Primary Message Effect Setup and 
Secondary Message Effect Setup dialog boxes (described below) are available for Duet LE/PCI.  Other 
effects exclusive to Duet LEX/PCI+ execute as Cuts on a Duet LE/PCI. 

Message Effect Setup and Execution 
Selecting Default Effect in the Config menu opens the Default Effect dialog box, in which effects can be set 

for transitions into and out of a Lyric message on a Duet LE/LEX/PCI/PCI+.  The  buttons for the IN or 
OUT effects open the Primary Message Effect Setup and Secondary Message Effect Setup dialog boxes 
respectively, in which parameters specific to a selected effect can be set.  The figure below shows the 
Default Effect dialog box, as it appears on opening, and also with the IN effect drop-down list displayed. 

 

Default Effect Dialog Box Showing IN Drop-Down Effect List 

A single Duet LE/LEX/PCI/PCI+ VPB or PCI-Squeezeback board is capable of producing transition effects.  
Transition effects for single as well as multi-board systems can be set: 

 When executing the effect on a single VPB or PCI-Squeezeback board that is not linked to another 
board, set the OUT effect to No Effect to transition directly from the current graphic using the 
selected IN effect. 

If in this configuration, and the OUT effect is set to an effect other than No Effect, the current graphic 
transitions out using the selected OUT effect, followed by the new graphic appearing using the IN 
effect. 
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 To transition the OUT effect and IN effect simultaneously, two VPBs/PCI-Squeezeback boards must 
be linked to the single channel on which the effects will execute. 

The Primary Message Effect Setup dialog box shows the available effects for setting up an IN effect. 

 

Primary Message Effect Setup Dialog Box 

The Secondary Message Effect Setup dialog box shows the available effects for setting up an OUT effect.  
The Primary and Secondary Message Effect Setup dialog boxes are identical, except for the presence of 
NONE as an effect choice in the Secondary Message Effect Setup dialog box.  Note that although Pour is 
available, it executes as a Cut when used as an OUT effect. 

 

Secondary Message Effect Setup Dialog Box 
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When an effect is selected via one of the radio buttons in the Effect area of the menu, available parameters 
for that effect, such as Speed, Effect Direction and Ease options become active.  Set Speed or Frames 
values in the upper right corner of this dialog box using the numbers on the alphabetical keyboard of the Duet 
LE/LEX/PCI/PCI+.  Note that depending on the effect, the units for Speed may be specified in the dialog box 
as a percentage of the rendering time, or in frames.  A lower percentage setting results in a slower transition.  
The table below lists the effects and the parameters that can be applied to them. 

N indicates that the variation is not applicable to an effect.  Y indicates that the variation is applicable to an 
effect.  Up, Down, Left and Right indicate which directions are available for the movement of an effect. 

Effect Ease  Effect 
Direction 

Speed - % of Maximum Duration 
(except Dissolve) 

Cover Y Up & Down Speed 

Dissolve N  N  Frames 

Hide Y  Up & Down Speed 

Peel Y Up & Down  Speed 

Push Y Up, Down, 
Left, Right  

Speed 

Split Y  Up & Down  Speed 

Cut N N  N 

Fade N N Speed 

Matrix 
Wipe 

N N N. Matrix X-size set in pixels, Matrix Y-
size set in scanlines.  See below for 
Matrix Wipe pattern options. 

Pour N N Speed 

Reveal Y Up & Down  Speed 

Weave Y  Left & Right  Speed; also Weave Size, set in 
scanlines; see below 

Matrix Wipe:  Selecting the Matrix Wipe effect activates a dropdown list of 30 patterns that may be applied 
to the effect.  Larger Matrix X-size and Matrix Y-size values generate larger blocks, which speed the 
execution of the effect. 
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The available Matrix Wipe pattern selections are pictured below.  The drop-down menu that you see in Lyric 
has been expanded here so that you can see all of the available choices in one view without scrolling.  

 

Message Effect Matrix Drop-Down List 

Executing a Message Effect 
To execute a Message Effect: 

1. Make sure that the button is turned off. 

2. Use the Read Next function to read a Lyric Message Effects message, then use Read Next to read 
the graphics files. 

OR 

Set up a Message Effect, then use Xfer to transfer the graphic to the output screen.  The IN and 
OUT effects are applied to the transition. 

3. Repeat Step 2 to display each subsequent available message in ascending Message ID number 
order. 
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NOTE 
Do not use Read Previous if the message sequence contains one or more Effects 
Messages, as the system automatically increments, rather than decrements, the Message 
ID number when it encounters an Effects message. 

Functions Specific to Duet LEX/PCI+ 
Message Effects Specific to Duet LEX/PCI+ 
There is a set of Message Effects available only to Duet LEX/PCI+.  These effects, which can be applied 
only to IN transitions, can be selected from the Default Effect IN drop-down menu.  Clicking on an effect 
name opens an effect-specific dialog box for setting the effect.  Enable, Fade, Reverse Play, Ease and 
Effect Length are available to all of these effects.   Effect-specific parameters, listed below, can also be set 
for each effect. 

Effect Effect-Specific Parameters 

Explosion Explosion Polygon, Translation and Rotation Speeds 

Leaf Enable, Leaf Coverage 

Matrix Effect Speed, Matrix Size 

Ripple  Effect Resolution, Ripple Size, Ripple Speed 

PageRoll  Roll Page from Side, Roll Size 

PageTurn  Lift Corner of Page, Turn Orientation 

Venetian  Orientation of Folds, Number of Folds 

Zoom  Zoom From 

Focus  Focus Aspect, Focus From 

Slide  Slide From 

Curtain  Effect Resolution, Curtain Ripple Size, Curtain Ripple Speed, 
Curtain Moving From 

To execute a Message Effect specific to Duet LEX/PCI+:  

1. Make sure that the button is turned off. 

2. Use the Read Next function to cue up and execute each effect. 

  NOTES 
 Effects specific to Duet LEX/PCI+ are only executed using Read Next.  Pressing 

Xfer or activating the Live button and pressing the Read key  will execute the 
effect as a Cut. 

 Do not use Read Previous if the message sequence contains one or more Effects 
Messages, as the system automatically increments, rather than decrements, the 
Message ID number when it encounters an Effects message. 
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Saving a Message Effect on Duet LEX/PCI+ to Apply to a Lyric Message 
Once IN and OUT effects are set, the effects may be saved and then applied to specific Lyric messages or a 
sequence of Lyric messages in Read Next or Read-Xfer operations on Duet LEX/PCI+ systems.  To save a 
Message Effects message: 

1. Set the effect Message Effect parameters in the Primary Message Effect Setup dialog box.  Click 
OK.  Lyric returns to the Default Effect dialog box. 

2. Using the numeric keypad, enter a Message ID number.  This number appears in the Message 
Number display customarily found at the bottom of the Canvas. 

3. Click the Save button.  The message is saved, in a message file with the .lyr extension, to the 
specified Message ID number.  The Message Number display advances. 

Multi FX - Duet SD 
Tools Menu > Multi FX;  Alt + X 

Multi FX Setup 
Lyric's Multi FX capability allows Duet SD's frame buffers to perform transitions between Lyric messages 
using Advanced Image Effects.  On Duet SD systems outfitted with multiple VGEs and a Video Mixer 
board, effects occur simultaneously by default.  In this situation, it may be helpful to remember that although 
the effects are being executed simultaneously, only the "newer" of two pages is being called up at a given 
time.  Using the Multi FX menu's Offset controls allows overlapping effects to be moved apart in time, so that 
the "out" effect of a given message is in progress before the "in" effect of the next message begins. 

Note that a Multi FX transition can be set up on just a single VGE board, but that there can be no 
simultaneous execution of In and Out effects. 

Multi FX include Curtain, Explosion, Focus, Leaf, Matrix, PageRoll, PageTurn, Ripple, Slide, Venetian, 
Zoom and Wipe.  These are the same types of Advanced Image Effects which can also be applied to 
bitmaps and 2D Text windows. 

Take note that all of the settings on this menu may be saved and recalled (more about that later), but the 
combination of effects you select will be repeated for each transition unless changed manually.  Different 
combinations of effects are not available for each transition between any two messages. 
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For the following exercise, the Duet SD should be equipped with 2 VGEs and a Video Mixer board. 

1. First, Duet's Video Mixer must be set up appropriately. Use Lyric's Tools menu to access the mixer. 

NOTE 
It is essential that Output 1 be set to Mix in the Output Router area of the menu at 
bottom left. 

 

Multi FX Setup - SD Mixer Control 
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2. Next, use the Tools menu again to access Multi FX.  By default, what appears initially is the Multi FX 
'setup' mode.  When composition and programming are complete, you may switch to this menu's 
Playback Mode by clicking Exit Setup in the lower left corner. 

 

Multi FX Control - Default Settings 

All of the In and Out effects come up Use Message by default when this menu is opened.  This 
option means that Multi FX will not execute any of its own effects between messages; Lyric simply 
calls up the message and plays out whatever animations (Rolls, Crawls, three-dimensional 
movement, etc.) were originally recorded in that message before displaying the next message. 

The easiest way to begin using Multi FX is to manually enter a message into each frame buffer.  This is a 
good time to note that the Multi FX menu draws from messages with numerical file names stored in the 
default message directory (See Default Paths in Online Help). 

1. In FB1, enter the numeric file name of a Lyric message that you know is present in the default 
message directory.  

2. Press Read to call up the message and then Play to send it to the frame buffer's output.  Note that in 
all Multi FX operations, you will not be clicking the Live button on the Lyric interface to send images 
from the Canvas to the video outputs. 
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3. In FB2, enter the numeric file name of a Lyric message that you know is present in the default 
message directory. 

 

Multi FX Control - Multi FX Setup 

4. Again, press Read to call up the message.  Now, when you press Play, the second message is sent 
to the video output. 
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At any time in Multi FX operation, it's a good idea to keep an eye on the arrowheads that indicate which 
frame buffer (and its message) are currently on air, as in the illustration below.  We've added the white arrow 
to the illustration to emphasize that Message Number 1 is currently on-air in Frame Buffer 2.  Frame Buffer 
2's message number field is grayed out because it is currently on-air and any action taken next will be in the 
other frame buffer.  Note also that the Transport Controls have turned red, indicating that a Multi FX 
operation is in progress. 

 

Multi FX -  Execution 

Again, Frame Buffer 2, as marked by the green tally arrow is on air.  The frame buffer indicated by the red 
arrowhead is next.  
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Multi FX Types 
All of Lyric's Advanced Image Effects types are available for use with Multi FX. There are two additional 
effects, Static and Use Message, as shown below.  These effects are covered later in this section. 

 

Multi FX Control - Advanced Image Effects Menu 

Static and Use Message are described following the bulleted items. 

Right-click on any effect that has been selected (except for Use Message), and this context menu appears: 

 

Multi FX Effects Context-Sensitive Menu 

 Parameters opens each individual effect's dialog for controlling speed, duration, geometry and other 
variables.  Refer to the section on Advanced Image Effects view effect-specific dialog boxes and 
illustrations of the same types of effects applied to bitmaps. 

 Effect On Top places the selected effect "in front of" another effect when any two effects are 
occurring at the same time. 

 Use First Frame causes Lyric to ignore any animation recorded into a message called up by the 
Multi FX facility. Only the first frame of the message is shown.  To show only the last frame of a 
message, uncheck this option. 
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Static 
Static allows the user to display only the first or last frame of an animated message that is displayed during a 
Multi FX operation. 

 

Multi FX Control Showing Static Effect Setup 
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Use Message 
There is no context (right-click) menu for the Use Message option. This option does not use any VGE-
originated transition effects between Lyric messages. Any animation in a message called up in this mode is 
allowed to play out before Lyric displays the next message. 

 

Message FX Control Showing Use Message 
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Message Sequences 
Another means of handling message files is to assemble a sequence of messages and set the effects that will 
transition between them. 

1. Enter a message number into the field next to the Add button, and then click the Add button. That 
message number is moved to the larger window in the Message List area.  Alternately, you may 
press either Enter key on the keyboard instead of clicking the Add button. 

 

Multi FX Control - Assembling a Message Sequence 

2. Repeat this action with the desired message numbers until the sequence of messages is complete. 

 Use the Remove button to delete a highlighted item from the Message List. 

 Use the Clear button to delete all entries from the Message List. 

3. Next, click the Use List checkbox.  If no entry is highlighted in the large Message List window, the 
number 1 appears in the FB1 message number field.  If another number is highlighted in the 
Message List at the time Use List is checked, that number appears in the FB1 message number 
field. 

Take note that using the Message List feature eliminates the need to manually designate the next 
message in the other frame buffer. 
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Now is also a good time to experiment with the Auto Load option.  Auto Load eliminates the need to 
press the Read button before playing a message to Duet's video outputs.  

4. Next, set the transition effects as discussed above. 

Test and Scrub 
Whichever method you use to load messages into Duet's frame buffers, Lyric offers two ways to preview your 
transitions before sending them to Duet's video outputs. 

 Use the Test button to play a preview of the transition in real time on Duet's VGA monitor. 

 Scrub allows you to move through a preview of the transition (also on the VGA monitor) by dragging 
the slider back and forth through the effect's duration. 

Editing In Multi FX 
Lyric offers a convenient means to escape from Multi FX mode for last-minute edits that may become 
necessary in the course of a production or live broadcast.  Multi FX is a little different than other modes of 
Lyric operation, and doesn't allow direct editing of a message on the Canvas that is ready for playout in Multi 
FX mode.  Follow the example below to see that last-minute edits are however, easy, and that the process 
incorporates a sensible safeguard. 

1. A pre-programmed sequence of messages is loaded just before the first of the messages is needed 
on air.  A mistake is discovered in message #2. 

 

Message Showing a Mistake 

2. Press the Esc key on the Duet keyboard (upper left corner, below the Mode Select key) to enable 
editing.  Click the 2D text region or other object to select it for editing.  In the case of 2D text regions, 
the title bar turns light gray. 
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3. Perform the needed edits. 

 

Message with Changes 

4. Click the Play button on the Multi FX Control dialog box.  The following Lyric prompt appears: 

 

Prompt to Reload Current Scene 

This prompt confirms that the amended scene is what you intend to use. 

5. Press Enter on the keyboard or click OK to load the amended message (Canvas contents) for 
playout.  

To return to the message as it was originally read from disk: 

 Click the Cancel button in this dialog, or press Esc on the keyboard. 

Saving a Multi FX Message 
Any information entered into the Multi FX menu can be saved for quick recall; such messages are saved with 
the familiar .lyr extension. The usefulness of this option is not limited to message sequences. Since a saved 
Multi FX message includes everything on the menu at the time of saving, it can be used to put a desired 
combination of effects in place for use with messages that are called up manually rather than originating from 
a list.  

Also, when a Multi FX message is saved, it records the status of the Video Mixer; remember the importance 
of setting the mixer properly for use of Multi FX, as mentioned at the beginning of this topic. The Save and 
Recall buttons open standard Windows dialog boxes for locating Multi FX message files. Default Paths are 
used for Multi FX message files. 
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A quick method for recording a Multi FX file is as follows: 
1. Press Ctrl + Record.  The Record Only: dialog box opens. 

2. Select Multi FX. 

3. Click Record.  The Multi FX settings are saved to the current Message Number in the Default 
Message Directory. 

A Hotkey combination can also be used to record the Multi FX settings: 

 Press Ctrl + Record F Enter.  The Multi FX settings are saved to the current Message Number in 
the Default Message Directory. 
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23. Masks 
Overview 
The term Mask has a number of uses in Lyric.  Each of the Mask terms are described below along with their 
availability in various systems.  

Mask Objects 
Mask Objects are supported by Duet systems, as well as for offline graphics creation.  There are differences 
between how Mask Objects operate in Duet SD/HD/offline systems versus how they operate on Duet 
LE/LEX/PCI/PCI+ systems.  Mask Objects can be animated. 

 Duet SD/HD/Offline:  An image specified as a Mask Object displays at 100% video, and cuts 
through the elements over which it is positioned and the background.  Built-in transparent areas of a 
Mask Object allow video input to show through. 

 Duet LE/LEX/PCI/PCI+:  An image specified as a Mask Object displays at the transparency set in 
Properties > Surface combined with built-in transparency, and covers the object over which it is 
positioned.  Mask Layers, Mask Inside and Alpha Trim Mask are supported on Duet 
LE/LEX/PCI/PCI+ systems.  Transparent areas of a Mask Object allow video input to show through. 
Mask Layers:  A Mask Object assigned to a layer interacts only with the other elements assigned to 
the same layer.  A Mask Object can mask other graphic elements, including other Mask Objects, 
that are assigned to the same layer and over which it is positioned.  A Mask Object behaves as a 
normal graphic element with regard to graphic elements not assigned to the same layer.  Layer 
number has no bearing on display priority.  It simply identifies the how Mask Objects and elements 
are grouped to interact with each other.  Mask Layers are not supported on Duet SD/HD/Offline 
systems. 
Mask Inside:  When an element is designated Mask Inside, it causes the Mask Object in the same 
layer to act as a reverse Mask.  Instead of covering the element over which it is positioned, it reveals 
it.  Any time the Mask Object is not positioned on top of the element, the element is not visible.  
Mask Inside is not supported on Duet SD/HD/Offline systems. 
Alpha Trim Mask:  Some Mask Objects may display a transparent narrow border that you may wish 
to remove.  Alpha Trim Mask removes this border.  Alpha Trim Mask  can be applied only to Mask 
Objects.  Alpha Trim Mask is not supported on Duet SD/HD/Offline systems. 
Soft Mask:  A Soft Mask provides a soft-edged border into which a static or moving element (such 
as a Crawl) can fade.  Soft Mask can only be applied to Mask Objects.  Alpha Trim Mask is not 
supported on Duet SD/HD/Offline systems. 

Mask Characters 
Mask Characters are RGB font characters that function in a similar fashion as Mask Objects.  Where a 
Mask Object cannot be present in a 2D Text Window, an RGB font character acting as a Mask Character 
must be typed into a 2D Text Window.  An image specified as a Mask Character displays at 100% video, 
and cuts through the elements over which it is positioned and the background.  Built-in transparent areas on a 
Mask Character allow video input to show through.  Mask Characters are not supported on Duet 
LE/LEX/PCI/PCI+ systems. 

Mask Scene 
Mask Scene masks the entire screen.  The Key component(s) of a character(s) and/or image(s) placed on 
the Canvas before the Scene Mask is created cuts a hole(s) in the input video after the Scene Mask is 
created, revealing the video that is underneath the Scene Mask.  Characters and/or images in a Scene Mask 
cannot be animated.  Other characters/and/or images on the screen, however, can be animated.  A Scene 
Mask differs from a Mask Object, in that a Mask Object itself masks the video under it.  Mask Scene is 
accessed from Tools>Masks>Mask Scene.  Mask Scene is not supported on Duet LE/LEX/PCI/PCI+ 
systems. 

Masked 
The term Masked is used to describe a bitmap, live video or texture which can be revealed by the Surface, 
Bevels and/or Sides of 3D characters.  This function is found in the Properties > Surface tab.  Masked is 
available on all systems. 
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Mask Scene - Duet SD 
Tools Menu > Mask Scene 

There are several Lyric function names that contain the word "Mask."  Refer to Masks:  An Introduction for an 
overview of the different types of  Masks. 

The Mask Scene function provides the ability to create "cut-outs," which form a Scene Mask.  A Scene Mask 
can reveal background, video input or other static or animated Lyric images.  A Scene Mask takes its shape 
from the combination of any 2D text, 2D bitmaps, 3D characters and/or 3D objects that are on the Canvas 
when the Scene Mask is created.  The position, edge hardness/softness and transparency of the cut-outs 
depends on the attributes of the objects.  A Scene Mask cannot be animated.  

To create a Scene Mask: 
1. Create a simple 2D text message, using a large font. 

 

Scene Mask Creation 

2. From the Tools menu, select Mask Scene.  The Mask Scene menu opens. 

 

Mask Scene Menu 

3. From the Mask Scene menu, select Create Mask.  The Canvas and the Scene Graph are cleared of 
all objects, and the alpha information from the object(s) is moved into the Mask Buffer.  The Mask 

icon  on the Chyron toolbar becomes active (selected). 

4. Use the Background  tool to apply a colored or graphic background. 
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5. Click the Live icon, and the Scene Mask appears on the VGE output.  Note that the Scene Mask is 
not visible on the Canvas as seen on the VGA output. 

 

Scene Mask Viewed on VGE Output 

Once the Mask is on the VGE output, it may be toggled on and off by clicking the Mask icon , located 
on the Chyron toolbar. 

In the preceding example, the Scene Mask was created from 2D text, and the image behind the mask was a 
static background.  Scene Masks, however, can be created from a combination of 2D text, 2D bitmaps, 3D 
characters and/or 3D objects, and may be placed over animated Lyric objects and/or input video.  A Lyric 
message can be read and executed behind a Scene Mask. 

A background can be used to create a Scene Mask as well.  For example, background with ramped 
transparency can be placed on the Canvas, and other objects can be positioned to cut soft-edged holes into 
the background.  A Lyric animation can then be executed behind the transparent Scene Mask. 

Other Mask functions in the Mask Scene menu include the following: 
 Selecting/deselecting Use Mask toggles the Mask on and off, and performs the same function as 

clicking the Mask icon .  When Use Mask is not selected (unchecked), only the non-mask 
image(s) is visible on the VGE output. 

 Delete Mask removes the Mask from the scene.  This is not a toggle function.  The Mask is deleted, 
not turned off.  If the Mask is to be used again, use the Save Mask function to save the Mask before 
deletion. 

 Edit Mask restores to the Canvas the original image(s) from which the cutout(s) was made, so that it 
may be edited. 

 Save Mask saves the Scene Mask to a *.lyr file.  Any objects, as well as any the background, that 
are on the Canvas are included as part of the Scene Mask when it is saved.  If there are objects or 
background that are on the Lyric Canvas that should not be included in the Scene Mask when it is 
saved, then turn them off (deselect) in the Scene Graph or delete them before saving.  Note that the 
objects are not saved along with the Scene Mask and cannot be turned back on when the Scene 
Mask is recalled. 

 Recall Mask opens the Open File dialog box.  When a Lyric file is selected and then opened, the 
Scene Mask is automatically enabled for the message.  In addition, any Lyric message that is 
opened using the Recall Mask function is displayed as a Scene Mask. 
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Mask Character (Duet SD/HD/Offline) 

There are several Lyric function names that contain the word "Mask."  Refer to Mask Overview for an overview of 
the different types of  Masks. 

An RGB font character typed in a 2D Text Window can act as a Mask Character on a Duet SD/HD/Offline 
system, masking any elements, including the background, that are rendered below it.  Note that a 2D bitmap 
that is placed in a 2D Text Window using a method other than typing cannot act as a Mask Character.  
Mask Characters are not supported on Duet LE/LEX/PCI/PCI+. 

For a Mask Character to work, it is necessary to place the 2D Text Window containing the Mask Character 
on top of the element(s) that it is masking, or the Mask Character will not work properly.  Display priority is 
set using the Scene Graph or by adjusting the Z position in Properties>XYZ. 

An image specified as a Mask Character displays at 100% video, although built-in transparent areas of the 
Mask Character allow video input to show through.  If transparency of a Mask Object is desired to allow 
video input to show through, the transparency must be set during graphic creation, before it is introduced to 
the Canvas.   Adjusting the Transparency setting in the Properties>Surface tab has no effect on the 
transparency of the Mask Character. 

Transparent areas of a RGB font character display as transparent on the Canvas, until the RGB font 
character is designated a Mask Character.  When a transparent RGB font character is designated a Mask 
Character, the transparent areas display as opaque on the Canvas.  On the output monitor however, you will 
see that the Mask Character cuts a rectangular area through all graphic layers so that video input is visible 
wherever there is transparency. 

To set up a Mask Character: 
1. Open a 2D Text Window and type the RGB font character that is to be used as the Mask Character. 

For information on creating RGB fonts and RGB font characters, refer to RGB Fonts. 

2. Use Shift +  or  to highlight the RGB font character, or check the Status Bar to make sure that 
the cursor is positioned on the RGB font character.  Do not use the mouse to highlight. 

3. Right-click the RGB font character to display the context-sensitive menu, then select Mask 
Character. 

The character now masks, or completely covers, any image that is positioned under it, and also cuts through 
the background.  On the output, the Mask Character allows video input to be displayed wherever there is 
transparency.  Additionally, the Mask Character item on the context-sensitive menu is now checked. 

To remove Mask Character functionality from an RGB character: 
 Repeat Steps 2 and 3.  The RGB character is no longer a Mask Character, and the Mask Character 

item on the context-sensitive menu is now unchecked. 

For details on using a 2D bitmap outside of a 2D Text Window as a similarly-behaving Mask Object, refer to 
either the Mask Objects on Duet SD/HD/Offline or Mask Objects on Duet LE/LEX/PCI/PCI+. 
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Mask Objects - Duet SD/HD/Offline 

There are several Lyric function names that contain the word "Mask."  Refer to Masks:  An Introduction for an 
overview of the different types of  Masks. 

Mask Objects are supported by Duet SD and HD systems, as well as for offline graphics creation.  Any 
bitmap object including a Flipbook, that is placed outside of a 2D Text Window, can be designated a Mask 
Object, masking any elements, including the background, that are rendered below it.  3D objects, 3D 
characters and any graphics, including 2D text, inside of a 2D Text Window cannot act as Mask Objects.  
Since a Mask Object is generally used to allow live video to show through, only 32-bit TIFF files or 32-bit 
TARGA files should be used as Mask Objects.  

For details on using an RGB Font character inside of a 2D Text Window as a similarly-behaving Mask 
Character, refer to Mask Characters.  For an overview of the different types of Masks, refer to Mask 
Terminology. 

For a Mask Object to work, it is necessary to place the Mask Object on top of the element(s) that it is 
masking, or the Mask will not work properly.  Display priority is set using the Scene Graph or by adjusting the 
Z position in Properties > XYZ. 

An image specified as a Mask Object displays at 100% video, although built-in transparent areas of the Mask 
Object allow video input to show through.  If transparency of a Mask Object is desired to allow video input to 
show through, the transparency must be set during graphic creation, before it is introduced to the 
Canvas.   Adjusting the Transparency setting in the Properties > Surface tab has no effect on the 
transparency of the Mask Object. 

Transparent areas of a bitmap on a Duet SD/HD/Off-line system display as transparent on the Canvas, until 
the bitmap is designated a Mask Object.  When a transparent bitmap is designated a Mask Object, the 
transparent areas display as opaque on the Canvas.  On the output monitor however, you will see that the 
Mask Object cuts a rectangular area through all graphic layers so that video input is visible wherever there is 
transparency. 

To set up a Mask Object: 

1. On the Scene Graph, select (highlight) the object that will act as the Mask Object. 

2. Right-click on the Scene Graph or the Canvas to display the context-sensitive menu. 

3. Select Mask Object.  The menu closes.   A check mark indicate that the object is now a Mask Object. 

NOTE 
In order for an object to be used as a Mask, it must be selected as a Mask Object.  If the 
selected element is not appropriate for use as a Mask, the Mask Object selection on the 
context-sensitive menu will not be available. 
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Mask Objects - Duet LE/LEX/PCI/PCI+ 

Introduction 

There are several Lyric function names that contain the word "Mask."  Refer to Masks:  An Introduction for an 
overview of the different types of  Masks. 

Mask Objects are supported by Duet LE/LEX/PCI/PCI+ systems.  Any 2D map object including a Flipbook, 
that is placed outside of a 2D Text Window, can be designated a Mask Object and therefore mask any 
elements rendered below it.  Since a Mask Object is often used to allow live video to show through, it is 
recommended that 32-bit TIFF files or 32-bit TARGA files be used as Mask Objects.  Transparency of a 
Mask Object can be set in Properties > Surface, but results in the changing the Transparency of the entire 
Mask Object (see NOTE in the section on Mask Inside, below, for additional information on transparency).  
3D objects, 3D characters and any graphics, including 2D text, inside a 2D Text Window cannot act as Mask 
Objects. 

Duet LE/LEX/PCI/PCI+ support multi-layer masking.  Mask Objects can be assigned to mask certain objects, 
but not others.  Objects that are to interact with each other with regard to this type of masking must be 
assigned to the same layer.  This layer has no significance with regard to display priority, i.e., which image 
displays on top of another.  It is simply a way to group images which are affected by a Mask Object.  
Remember, however, that it is necessary to place the Mask object on top of the object(s) that it is masking, or 
the Mask will not work properly.  Display priority is set using the Scene Graph or by adjusting the Z position 
in Properties > XYZ. 

Elements not assigned to the same layer as a Mask Object are not affected by the Mask Object.   

For details on using an RGB font character inside of a 2D Text Window as a similarly-behaving Mask 
Character, refer to Mask Characters.  For an overview of the different types of Masks, refer to Masks: An 
Introduction. 
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Mask Object Setup 
To set up a Mask Object: 

1. On the Scene Graph or Canvas, select the object that will act as the Mask Object.  Note that it is 
generally easier and sometimes necessary to select objects or elements from the Scene Graph, 
especially when they are already positioned one on top of the other on the Canvas.  

2. Right-click on the object on the Scene Graph or Canvas to display the context-sensitive menu.  The 
illustration below shows this procedure performed from the Scene Graph. 

 

Setting a Mask Object 

3. Select Mask Object.  The menu closes.  A check mark indicates that the object is now a Mask 
Object. 

NOTE 
If the selected element is not appropriate for use as a Mask Object, the Mask Object 
selection on the context-sensitive menu will not be available. 

Assigning a Mask Object or Element to a Layer 
A Mask Object not assigned to a layer will cut through the background if the Mask Object has the lowest 
display priority on the Canvas, i.e., it is at the bottom of the element list (except for Lights, Global Light and 
Camera) on the Scene Graph, or if the Z position set in Properties>XYZ places it behind the other graphic 
elements.  The background cannot be assigned to a layer. 

A Mask Object assigned to a layer does not cut through the background, but interacts only with the other 
elements assigned to its layer.  A Mask Object can mask other graphic elements, including other Mask 
Objects, that are assigned to the same layer and over which it is positioned.  A Mask Object behaves as a 
normal graphic element with regard to graphic elements not assigned to the same layer.  
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To assign a Mask Object or other element to a layer: 

1. On the Scene Graph or Canvas, select the element that will be masked. This element can be 2D or 
3D text, or another type of object. 

2. Right-click on the Scene Graph or Canvas to display the context-sensitive menu.  The illustration 
below shows this procedure performed from the Scene Graph. 

 

Assigning a Mask Object or Element to a Layer 
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3. Cursor or scroll to Mask-To Layer to display the list of layers. 

4. Select a layer.  Keep in mind that if you do not want this Mask Object or element to interact with 
other Mask Objects or elements already assigned to the layer, select an unused layer.  Once a layer 
is selected, the menu closes.  A check mark now indicates which layer has been selected.  
Remember that layer number has no effect on display priority, i.e. elements assigned to layer 1 do 
not automatically display on top of Mask Objects/elements assigned to layer 7, or vice versa.  

Mask Inside 
In addition to using the Mask Object to simply cover another image, a Mask Object can be used instead to 
reveal another image. 

When an element is designated Mask Inside, it causes the Mask Object in the same layer to reveal the 
element over which it passes instead of covering it.  Any time the Mask Object is not positioned on top of the 
element, the element is not visible. A Mask Object can also be designated Mask Inside.  When another 
Mask Object in the same layer passes over it, the Mask Object behaves in the same manner as an Mask 
Inside element, as well as acting as a Mask Object for elements in the same layer that are below it. 

To set up a Mask Inside: 
1. Set up a Mask Object as described above. 

NOTE 
When applying Mask Inside to 2D text (including RGB font characters or bitmaps, the 
Mask Object must have either built-in transparency or transparency as applied in 
Properties > Surface > Transparency, or the element(s) designated as Mask Inside will 
not be revealed as the Mask object passes over it.  

2. On the Scene Graph or Canvas, select the element that will revealed by the Mask Object.  This 
element can be 2D text (including RGB font characters), a 3D character, a bitmap, a 3D object or 
Flipbook. 

3. Right-click on the Scene Graph or Canvas to display the context-sensitive menu. 

4. Cursor or scroll to Mask-To Layer to display the list of layers, then select a layer.  Once a layer is 
selected, the menu closes.  A check mark now indicates which layer has been selected. 

5. Right-click again on the Scene Graph or Canvas to redisplay the context-sensitive menu. 

6. Cursor or scroll to Mask Inside (see above figure), then select.  The menu closes.  A check mark 
indicates that Mask Inside has been activated. 

Mask Inside setup is now complete. The element designated as Mask Inside remains invisible until a Mask 
Object assigned to the same layer passes over it. 

NOTE 
To work with a Mask object that is completely transparent or contains completely 
transparent areas, for example, to reveal a Mask Inside element, it is recommended that 
the Mask Object be created with transparency in whichever graphics creation program 
you are using.  Remember also to create and save the alpha information with the graphic.  
The saved graphic format should be 32-bit TIFF or 32-bit TARGA. 

If, however, the graphic does not contain alpha information, set the Transparency in the 
Surface tab of the Properties dialog box to 100.  Note that this makes the entire graphic 
completely transparent.  If some type of a graphic frame is needed to enclose this 
transparent area, it can be created separately and animated in lockstep with the 
transparent graphic. 
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Alpha Trim Mask 
Some Mask Objects may display a transparent narrow border that you may wish to remove.  Alpha Trim 
Mask removes this border.  Alpha Trim Mask can be applied only to Mask Objects.  To apply an Alpha 
Trim Mask: 

1. On the Scene Graph or Canvas, select the Mask Object. 

2. Right-click on the Scene Graph or Canvas to display the context-sensitive menu. 

3. Cursor or scroll to Alpha Trim Mask (see above figure), then select. The menu closes.  A check mark 
indicates that the Mask is an Alpha Trim Mask.  Note that this feature can be selected in conjunction 
with Mask Inside. 

NOTE 
While Alpha Trim Mask can remove the unwanted transparent border of a Mask, it may 
also affect other transparent regions of the Mask. 

Mask Object Tutorial 
Many interesting effects can be created using Masks.  The following simple example demonstrates how to 
use an animated window to highlight text in a contrasting color as it moves over it. 

1. Create a completely transparent, rectangular bitmap image. 

2. On a new Lyric Canvas, open a 2D Text Window.  An element named 2D Text 1 appears in the 
Scene Graph list.  Type a line of white text in the 2D Text Window. 

 
3. Select 2D Text 1 on the Scene Graph, and assign it to Layer 1. 
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4. Select (highlight) all of the text in the 2D Text Window, then perform a Copy (Edit>Copy or Ctrl + C) 
operation. 

5. While the text in 2D Text 1 is still selected, apply a color other than white. 

6. Create a second 2D Text Window.  It appears in the Scene Graph as 2D Text 2. 

7. Perform a Paste in Place (Edit>Paste in Place or Ctrl + I) operation.  This pastes the white text into 
2D Text 2 directly on top of the newly colored text in 2D Text 1.  

8. Assign 2D Text 2 to Layer 1, then select Mask Inside.  The white text now disappears. The colored 
text from 2D Text 1 is displayed from behind the now-invisible text from 2D Text 2. 

 
9. Place the transparent rectangle bitmap onto the Canvas.  Set the bitmap as a Mask Object, and 

assign it to Layer 1.  Make sure it has higher display priority than the text elements. 

NOTE 
In order to see the transparent bitmap, click the Set Default Background Color button 

 in the toolbar to change the background color of the Canvas to gray.  This affects 
only the Canvas, and not the output.  To change the color back to black, click the Set 
Default Background Color button again. 
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10. Create an animation to move the rectangle over the text. 

11. Execute the animation.  As the “invisible” rectangle (outlined in the above illustration using a gray 
box) travels over the text, the white text inside of the rectangle is revealed (Mask Inside) and masked 
outside; and the colored text is masked inside of the rectangle, but is visible outside. 
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Soft Mask 
A Soft Mask provides a soft-edged border into which a static or moving element (such as a Crawl) can fade.  
For information on Soft Mask creation and use, refer to the section in this chapter covering Soft Masks. 

Removing Mask or Layer Functionality 
To remove Mask Object, Mask Inside, Alpha Trim Mask or layer assignment from any Mask Object or 
element: 

1. Select the object on the Canvas or the Scene Graph, then right-click to display the context-sensitive 
menu. 

2. Select whichever attribute that is to be removed.  The menu closes.  The item is now unchecked, and 
the functionality has been removed. 
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Soft Masks - Duet LE/LEX/PCI/PCI+ Only 
2D Bitmap Object Context (Right-Click) Menu > Select Mask Object, then Soft Mask 
Mask Objects are hard-edged regions which mask objects which lie under them and can allow input video to 
show through.  A Soft Mask provides a soft-edged border into which a static or moving element (such as a 
Crawl) can fade.  To understand how a Soft Mask works, the following example will demonstrate the creation 
of a simple Soft Mask Object in Adobe® Photoshop®, and its importation and use in Lyric. 

Refer to Mask Objects - Duet LE/LEX/PCI/PCI+ for additional information on Mask Objects. 

Creating a Graphic to Use as a Soft Mask 
To create the graphic: 

1. In Photoshop, set the size of the Canvas to slightly larger than 400 pixels wide by 150 pixels high if 
working in 4:3 aspect ratio, or to slightly larger that the pixel dimensions of the screen if working in a 
different aspect ratio. 

2. Set Image Menu > Mode to RGB Color. 

3. Fill the entire image completely with black. 

 

Image Filled with Black 

4. Click the Channels tab to display the channels that comprise the graphic. 

 

Channel Display for Black Graphic 
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5. Click the Create new channel icon. 

 

Create New Channel 

6. A new channel is Alpha channel is created.  Click the eye icons to turn off the RGB, R, G and B 
channels.  

 

New Alpha Channel Created 

7. In the Channels tab, make sure that only the Alpha channel is selected.  This ensures that only 
Alpha is modified. 

8. Select the Rectangular Marquee tool. Set it to feather at about 15 pixels. 
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9. On the Canvas, use the Rectangular Marquee tool to outline an area on the right side of the 
graphic.  This is the area through which a Roll is to run.  Use the Paint Bucket tool to fill the outlined 
area with white. 

 

Alpha Channel Modified 

The Alpha channel should appear as follows: 

 

Alpha Channel Modified - Reflects Change on Canvas 

10. Save the graphic as a Photoshop (*.PSD) file, and then perform a Save As to the Targa (*.TGA) 
format.  When prompted, select 32-bits/pixel, or the Alpha information will not be saved.  The graphic 
is now ready to use as a Soft Mask Object. 
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Using a Soft Mask Object in Lyric 
The goal in this exercise is to set up a 2D Roll up the right side of the screen, which fades in at the bottom 
and out at the top. 

1. Click the Set the Default Background Color icon  so that the Canvas turns gray for easier 
viewing.  This does not affect output. 

2. Import the graphic that was just created.  Note that the outer edges should lie beyond the boundaries 
of the screen.  It appears as follows. 

 

Placing the Mask Graphic on the Canvas 

3. Right-click to display the context menu for the graphic, and then select Mask Object.  The graphic 
changes appearance to reflect its function as a Mask Object. 

 

Mask Object Specified 
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4. Right-click to display the context menu for the graphic, and then select Mask Object.  The graphic 
again changes appearance to reflect that a Soft Mask has been applied. 

 

Soft Mask Applied 

5. Add a 2D Roll Window so that it lies underneath the cutout of the Mask Object.  The left and right 
margins of the 2D Roll Window should not extend to the edges of the Mask Object.  Add text to the 
Roll.  In this instance, a weather forecast was created.  Note that the 2D Roll Window frame is still 
displayed on top of the Mask Object, even though the text that makes up the Roll is positioned below 
it. 

6. If desired, add a graphic as the top layer, positioned outside of the cutout. 
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7. Add a Clip to the Timeline.  For this example, a clip of flowers is used.  It is not visible on the 
Canvas.  From top to bottom, the graphic elements should be listed in the Scene Graph as follows:  
Graphic element (forecast bar); Soft Mask Object; and then 2D Roll Window.  The clip can be 
placed anywhere.  The Lyric composition should appear as follows: 

 

Lyric Composition with Soft Mask 

8. Save the composition as a Lyric message.  Read and play back the message.  The mask should 
apply a soft edge to both the top and bottom edges of the roll. 

 

Soft Mask on Output 

Note that a separate opaque or transparent background and/or graphics can also be applied to the 2D Roll 
Window and/or to the Canvas. 
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Hints on Creating Soft Masks 
A 2D bitmap is always rectangular.  2D bitmaps which appear to be circles, ovals or other shapes are 
rectangular even though they do not appear to be.  The portions that cannot be seen are still present as 
transparent pixels.  When a 2D bitmap object is specified as a Mask Object, the entire rectangle becomes 
the mask.  As a result, when a Soft Mask is applied, the hard edges of the transparent portions of the 
rectangle can still be visible.  

The trick to getting around this is to size the graphic so that the hard edges lie off-screen, as demonstrated 
with the Soft Mask that was just created.  The Soft Mask "cutout" can be any shape, with any transition in 
opacity, and there can be more than one cutout in the same Mask Object. 
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24. Duet Tools - Playout to Output 

Duet Tools 
Duet Tools and Duet LE/LEX/PCI/PCI+ Tools control playback and display of Lyric messages.  There are 
operations common to both Duet SD/HD Tools and  Duet LE/LEX/PCI/PCI+ Tools, but there are functional 
differences as well.  Duet LE/LEX/PCI/PCI+ Tools also provides additional animation playback tools.  Duet 
Tools are available only when Lyric is running on a Duet system.  They are grayed out in an offline 
environment.  Additionally, a grayed out FB icon (Duet SD/HD)s, as shown below, or a Frame Buffer number 
icon (Duet LE/LEX/PCI/PCI+) indicates an unavailable or uninstalled VPB (all systems) or PCI-Squeezeback 
board (Duet LE/LEX/PCI/PCI+ only).  There are also a number of Duet Tools that do not have icons.  They 
are covered in the sections specific to Duet SD/HD Tools or Duet LE/LEX/PCI/PCI+ Tools. 

 

Duet SD/HD Tools 

 

Duet LE/LEX/PCI/PCI+ Tools 

Duet SD/HD Tools 
Duet SD/HD Tools provide a variety of animation playback and static graphic display methods. They also 
provide information on active/inactive buffer status.  Duet SD/HD Tools are often used in conjunction with 
Transport Controls, the Play key on the Duet keyboard and Read operations. 

 

Duet SD/HD Tools 

Duet Tools are grayed out if Lyric is running on a PC. 

Refer to Preferences:  Animation Settings for information on how animation execution settings can be 
tailored for specific playout situations. 

Outputs 
Each VGE installed in a Duet SD not containing an SD Video Mixer board provides two frame buffers.  The 
contents of the frame buffer, displayed on the Canvas, can be sent to one or both of Duet’s video outputs, via 
the Video I/O Board or the Video Mixer.  Most commonly, Duet SD systems are outfitted with two or more 
VGEs and a Video Mixer.  In this instance, the processing power within each VGE is summed to offer one 
Frame Buffer. Each VGE and its frame buffer can then be routed to the Video Mixer, the Video I/O board, or 
both. 
Each VGE installed in a Duet HD provides one frame buffer, regardless of the presence of an HD Video 
Mixer board.  The contents of the frame buffer, displayed on the Canvas, can be sent to one or both of Duet’s 
video outputs, via the Video I/O Board or the HD Mixer. 

Note that the grayed-out icon is reserved for a third frame buffer. 

The FB icons  display the active/inactive status for each frame buffer in the system.  Clicking 
an FB icon selects a VGE or MPx output for composition/editing and display on Duet’s VGA monitor.  An 
additional Frame Buffer icon appears for each Frame Buffer available on a Duet SD system that does not 
contain a Video Mixer. 

 A blue FB icon indicates that the frame buffer is active. 

 A gray FB icon indicates that the frame buffer is inactive. 
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By default, FB 1 (VGE 1) is selected upon Lyric startup.  Other frame buffers may be selected (made active) 
for editing by clicking the appropriate FB icon.  Icons representing VGEs that are installed, but not available to 
Lyric are grayed out. 

Each time an FB icon is clicked, the graphics on the Canvas are replaced with the contents of the newly-
active frame buffer.  If there are no graphics in the frame buffer, the Canvas is blank, with only the default 
Camera, Global Light and one Individual Light present in the scene.  Note that changes to the composition 

in the active frame buffer are not immediately reflected on output unless the  icon is active. 

Lyric can be set to display the active frame buffer only or all frame buffers on the VGA monitor. 
1. From the Config menu, select Preferences, then click the Windows tab. 

2. In the Canvas area, select (check) the Display All Frame Buffers check box to show all frame 
buffers on the VGA monitor, or leave the check box blank (unchecked) to display only the active 
frame buffer. 

3. Click OK.  In both instances, a full-sized Canvas for displays the contents of the active frame buffer.  
When Display All Frame Buffers is selected (checked), the smaller Canvases display the contents 
of the inactive frame buffers. 

One or two clip players can be installed in a Duet system.  When Frame Buffer 1 in a Duet system is 
selected as active, the Clip Control Panel automatically displays the settings for Internal Clip Player 1.  
When Frame Buffer 2 in a Duet system is selected as active, the Clip Control Panel automatically displays 
the settings for Internal Clip Player 2.  This occurs regardless of how the clip players are connected to the 
various boards in the Duet system. 

Live 
NOTE 

As of Lyric Version 4.0, the Duet icon  was replaced by the Live icon .  
Functionality was not changed. 

Live activates Lyric’s Duet Render Mode.  Clicking the  icon places the contents of the 
currently active frame buffer on the Duet's video output(s).  Any text/objects placed on the active Canvas are 
rendered simultaneously on the video output(s) in real time.  In this manner, composition and editing may be 
previewed in true WYSIWYG fashion. 

 When the Live icon is active , performing a Read displays the last or Preview frame of the 
animation on the VGE (output), with the current Default Effect applied to it.  Refer to Preferences:  
Animation Settings for information on message Read options, and Config Menu:  Default Effect 
(Duet SD) or Config Menu:  Default Effect (Duet HD)for additional information on Default Effect 
setup. 

 When the Live icon is inactive , performing a Read displays the last or Preview frame of the 
animation on the VGA (Canvas).  The contents of the Canvas can be transferred to the selected 

Duet video output by clicking the Xfer (Transfer) icon . 

The active or inactive status of the Live icon determines which methods can be used to play the animation to 
air or to the Canvas. 

To toggle the Live icon on and off: 
 Click the live icon, or press Ctrl + Fn + F6 (Duet keyboard) or Ctrl + F11 (PC keyboard). 

Xfer to Frame Buffer 
To transfer the contents of the current Frame Buffer to the currently inactive channel.  This operation 
transfers Output 1 to Output 2 using the Mixer effect defined in the SD Mixer Control Panel. 

 Press Alt + Xfer (Duet keyboard) or the Alt + / key on the numeric keypad (PC keyboard). 

The current Frame Buffer remains active, and its contents remain intact. 
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Swap 
The Swap function exchanges the contents of Duet’s two video outputs.  This operation can be used as a 
change between Preview and Air signals.  NOTE: As this exchange of signals occurs, Duet executes a 
transition between the video outputs!  The video output channel designated as active displays the 
transition.  The type of transition is specified by the Default Effect set from the Config menu.  The inactive 
video output channel simply switches one image for the other.  Note that Swap is disabled when playout of an 
animation is in progress. 

To perform a Swap: 

 Click , or press Swap (Duet keyboard) or Ctrl + / on the numeric keyboard (PC keyboard). 

Change 
There is no icon for this frame buffer function.  To select (make active) the next available frame buffer: 

 Press Change (Duet keyboard) or the * (PC keyboard). 

Xfer 
The Xfer function plays transfers the contents of the Canvas.  If an animation is present, it is executed to air.  

This function works only if the live icon is inactive .  To execute Xfer: 
 Press Xfer (Duet keyboard) / on the numeric keypad (PC keyboard). 

Two Xfer modes are available: 
 Basic:  Once a composition has been transferred to the video output, it can no longer be modified in 

real time.  Further changes must be made on the Canvas, and then rendered to the video output 

executing an Xfer again, or by clicking the Live icon . 

 Swap VGE with VGA:  This option allows the Xfer operation to be executed repeatedly, in order to 
switch the composition on the Canvas (VGA) with the signal on the output.  This may be used as a 
type of Air/Preview operation. 

To set Xfer mode: 
1. From the Config menu, select Preferences.  It opens to the CG tab. 

2. In the Xfer Mode area, click either the Basic or Swap VGE with VGA radio button.  Click OK to 
close Preferences. 

Refer to the section on Preferences:  CG for additional information on setting Preferences. 

Changing the Speed of an Animation During Execution 
The speed of an animation can be changed during execution: 

 Press the up cursor key  to speed up the animation, or the down cursor key  to slow down the 
animation. 

This operation can be performed regardless of the method used to trigger the animation. 
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Duet LE/LEX/PCI/PCI+ Tools 
Duet LE/LEX/PCI/PCI+ Tools provide a variety of animation playback and static graphic display methods. 
They also provide information on active/inactive buffer status and the nature of each available buffer (VPB or 
PCI-Squeezeback board). Duet LE/LEX/PCI/PCI+ Tools are often used in conjunction with Transport 
Controls, the Play key on the Duet keyboard and Read operations. 

 

Duet LE/LEX/PCI/PCI+ Tools 

NOTE 

As of Lyric v5.0, the Load , Quick Load , Stop  and Play  icons have 
been removed from the Duet Toolbar.  Their functions are still accessible by using the 
following keystroke combinations: 

 Load:  Alt + L 

 Quick Load:  Alt + Q 

 Play:  Alt + Y 

 Stop:  Esc 

The Save  and Load Save  functions have been removed from Lyric. 

Duet Tools are grayed out if Lyric is running on a PC. 

Refer to Preferences:  Animation Settings for information on how animation execution settings can be 
tailored for specific playout situations. 

Outputs 

        

Each VGE installed in a Duet LE/LEX/PCI/PCI+ provides one frame buffer.  The contents of the active frame 
buffer, displayed on the Canvas, appears at the output of the specified frame buffer. 

The Output icons represent the VPBs and PCI-Squeezeback boards assigned to Air or Preview in the 
Configuration dialog box. There can be up to four Output icons displayed in the Duet LE/LEX/PCI/PCI+ 
Toolbar. Only those VPBs and PCI-Squeezeback boards assigned to Air or Preview are displayed. When an 
icon is selected, that VPB or PCI-Squeezeback board is available for composition/editing, and its Canvas is 
displayed on the VGA monitor.  Each VPB or PCI-Squeezeback board contains one frame buffer for graphics 
editing.  Refer to VPB/PCI Setup - Configure Board Use for additional information. 

 An Output icon that is not selected is black/gray, and indicates that the corresponding board is a VPB 
assigned to Preview or Air, but not active for editing. 

 An Output icon that is blue/gray indicates that the corresponding board is a VPB active for editing. 

 An Output icon that is green/gray indicates that the corresponding board is a PCI-Squeezeback 
board, enabling Squeezeback effect setup and execution. When the icon is highlighted, its graphics 
plane is also active for editing. Note that the icon need not be selected in order to set up a 
Squeezeback effect. See Duet LE/LEX/PCI/PCI+ Squeezeback for more details. 

 A linked board(s) that is upstream to the last board in the link chain does not display a corresponding 
Output icon. Only the last board in the link chain displays an Output icon. 

By default, Frame Buffer 1 is selected upon Lyric startup.  Other frame buffers may be selected (made 
active) for editing by clicking the appropriate output icon.  Icons representing VGEs that are installed, but not 
available to Lyric are grayed out. 
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Each time an output icon is clicked, the graphics on the Canvas are replaced with the contents of the newly-
active frame buffer.  If there are no graphics in the frame buffer, the Canvas is blank, with only the default 
Camera, Global Light and one Individual Light present in the scene.  Note that changes to the composition 

in the active frame buffer are not immediately reflected on output unless the  icon is active. 

Lyric can be set to display the active frame buffer only or all frame buffers on the VGA monitor. 
1. From the Config menu, select Preferences, then click the Windows tab. 

2. In the Canvas area, select (check) the Display All Frame Buffers check box to show all frame 
buffers on the VGA monitor, or leave the check box blank (unchecked) to display only the active 
frame buffer. 

3. Click OK.  In both instances, a full-sized Canvas for displays the contents of the active frame buffer.  
When Display All Frame Buffers is selected (checked), the smaller Canvases display the contents 
of the inactive frame buffers. 

One or two clip players can be installed in a Duet system.  When Frame Buffer 1 in a Duet system is 
selected as active, the Clip Control Panel automatically displays the settings for Internal Clip Player 1.  
When Frame Buffer 2 in a Duet system is selected as active, the Clip Control Panel automatically displays 
the settings for Internal Clip Player 2.  This occurs regardless of how the clip players are connected to the 
various boards in the Duet system. 

Live 
NOTE 

As of Lyric Version 4.0, the LE icon was replaced by the Live icon .  
Functionality has not changed. 

Live activates Lyric’s Duet Render Mode.  Clicking the  icon places the contents of the currently 
active frame buffer on the Duet's video output(s).  Any text/objects placed on the active Canvas are rendered 
simultaneously on the video output(s) in real time.  In this manner, composition and editing may be previewed 
in true WYSIWYG fashion. 

 When the Live icon is active , performing a Read displays the last or Preview frame of the 
animation on the VGE (output), with the current LE/LEX/PCI/PCI+ Message Effect applied to it.  
Refer to Preferences:  Animation Settings for information on message Read options, and Config 
Menu:  Default Effects (Duet LE/LEX/PCI/PCI+ Message Effects) for additional information on 
Message Effect setup. 

 When the Live icon is inactive , performing a Read displays the last or Preview frame of the 
animation on the VGA (Canvas).  The contents of the Canvas can be transferred to the selected 

Duet video output by clicking the Xfer (Transfer) icon . 

The active or inactive status of the Live icon determines which methods can be used to play the animation to 
air or to the Canvas.  Refer to Play later in this section for details on animation playback. 

To toggle the Live icon on and off: 
 Click the live icon, or press Ctrl + Fn + F6 (Duet keyboard) or Ctrl + F11 (PC keyboard). 

Xfer to Frame Buffer 
To transfer the contents of the current Frame Buffer to the next available Frame Buffer: 

 Press Alt + Xfer (Duet keyboard) or the Alt + / key on the numeric keypad (PC keyboard). 

The current Frame Buffer remains active, and its contents remain intact. 
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Swap 
The Swap function exchanges the contents of the active graphics buffer with that of any other available board 
in the system.  To perform a Swap: 

1. Click  or press Swap or Ctrl + Xfer (Duet keyboard) or Ctrl + / on the numeric keypad (PC 
keyboard).  In a system with two available boards (i.e., not designated as Unused or Linked in the 

Config > Duet Hardware > Configure Board Use tab), clicking immediately performs the 
swap operation.  If the system has more than two active boards, continue to the following step. 

2. The following is displayed: 

 

Choose Destination Buttons 

Click a Destination button to swap the contents of the active buffer and the selected buffer. 

The contents of the selected buffers are swapped. The active video output channel displays the transition 
using the OUT setting specified in the Duet LE/LEX/PCI/PCI+ Message Effects dialog, available from the 
Tools drop-down menu. The OUT transition is applied to both the exiting and entering graphic. 

Remember that each VPB and PCI-Squeezeback board has its own output connector to external devices 
such as keyers and switchers. A board output can also be connected to another board in the Duet system. 
How the system is configured affects where the swapped graphics display. 

Swap does not trigger execution of a swapped animation or a Video Squeezeback effect. Additionally, Video 
Squeezeback execution is independent of Swap operations, although the contents of the graphics buffer of a 
PCI-Squeezeback board can be swapped with that of another board. 

NOTES 
 Unlike Duet SD/HD, Swap exchanges the contents of the graphics buffers of the 

two VPBs or PCI-Squeezeback boards involved. After the swap, the active VPB or 
PCI-Squeezeback board does not change as it would on Duet SD/HD. 

 Swap is not accessible to upstream linked boards. It can only execute on the last 
board, i.e. the output board, in a link chain. 

 When CMix software is installed, the normal Duet Tools Swap function is 
disabled, whether or not a CMix system is connected, and/or whether or not the 
CMix Control dialog box is open.  To restore normal Swap function, move the 
CMix.ocx file from the Lyric Plugins directory to another location.  To restore 
CMix functionality, move the CMix.ocx back to the Lyric Plugins directory. 

To execute an animation after a swap, make sure that the buffer containing the animation is active, then use 
the appropriate playout method. 

Change (Change) 
There is no icon for this frame buffer function.  To select (make active) the next available frame buffer: 

 Press Chng (Duet keyboard) or the * (PC keyboard).  For example, if there are three frame buffers in 
the Duet system, and Frame Buffer 2 is active, performing a Change operation makes Frame Buffer 
3 active. 
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Xfer to Output 
In Transfer Mode, the VPB or PCI-Squeezeback board processes and executes the animation, freeing up 
system resources for other Lyric operations. The six-second limitation on animation duration does not apply in 
Xfer Mode, as it does in Render (Load and Play) Mode on Duet LE/PCI systems. Animation length is limited 
only by the memory available on the VPB or PCI-Squeezeback board. 

Transfer Mode is most appropriate for playout of animations such as Rolls, Crawls, Clocks, Timers and 
Flipbooks.  A VPB or PCI Squeezeback board operating in Transfer Mode allows display and accurate 
update of a continuous Clock or Timer, such as a time-of-day display.  Certain other animations may only 
execute using Load-and-Play or Streaming Animation Mode. 

Note that Rolls, Crawls, Flipbooks and Clocks/Timers may be displayed on each of the outputs in a multi-
VPB system.  However, messages requiring Streaming Animation or Load-and-Play execution can be 
displayed on only one VPB or PCI-Squeezeback board at a time.   

The following conditions apply to Transfer Mode execution: 
 The Roll function accommodates a maximum of 1000 rows of text. 

 Only one Roll or Crawl may be used in a page. 

 On single-channel systems, Flipbooks or Clocks/Timers may not be used in the same page as a 
Roll or Crawl.  This type of composition is only supported by two-channel systems. 

 On single-channel systems, Flipbooks and Clocks/Timers may not be used in the same page. 

 Crawl windows greater than 280 scanlines in height should be previewed before on-air use.  

 If a message containing a Flipbook animation is loaded into the video processor board by executing 
a Xfer, the total size of the Flipbook is limited to 15MB for the Lantern 32 board and PCI-
Squeezeback boards.  Lantern 64 boards are limited to no more than 45MB. Total Flipbook size is 
the animated image’s Height x Width x Total Number of Frames x 4. 

NOTES 

 The Live icon must be inactive  when executing Xfer. 

 Pressing the Xfer key (Duet keyboard) or the / key on the numeric keypad (PC 

keyboard) performs the same function as clicking  on the Duet Toolbar. 

Using the Xfer function, the contents of the active frame buffer are transferred to Duet LE/LEX/PCI/PCI+’s 
output.  The active video output channel displays the transition using the settings specified in the Duet 
LE/LEX/PCI/PCI+ Message Effects dialog, available from the Tools drop-down menu. The OUT and IN 
transitions are applied to the exiting and entering graphics respectively.  Refer to Default Effect for additional 
information on setting up Message Effects. 

Once a composition has been transferred to the video output, it can no longer be modified in real time. 

Further changes must be made on the Canvas, then rendered to the video output by clicking  or 
pressing the Xfer key. 

To execute an animation in Transfer Mode: 

 Click , or press Xfer (Duet keyboard) or the / key on the numeric keypad (PC keyboard).  The 
animation executes. If, however, Config > Preferences > Animation Settings > Prompt to play on 
Duet is selected (checked), a prompt requesting an OK to trigger the animation is displayed after 
loading. 

Refer to Play - Animation Playback, covered later in this section for information on additional playback 
methods. 
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Load, Quick Load 
To execute an animation using Load-and-Play Mode, the animation must first be loaded into system memory 
before execution. The process is field-based, playing back two fields per frame. 

Quick Load loads an animation more quickly than Load.  This process is frame-based as opposed to field-
based, yielding playback that is somewhat less smooth than the Load playback. To quick-load an animation 
for playback: 

1. Read the animation message 

2. Press Alt + L (Load) or Alt + Q (Quick Load) to load the animation into memory. 

3. Click Xfer or press Xfer (Duet keyboard) or the / key on the numeric keypad (PC keyboard) to 
transfer the animation to output and execute it. 

 If Prompt to Play on Duet is enabled in the Animation Settings Preferences tab, then the 
Preview Frame of the animation (as set in the Show Preview Frame setting in Animation 
Settings Preferences) appears on the output, and the system displays a prompt requesting 
the OK to play the animation.  When the user clicks OK, the animation executes to output 
using the Default Effect. 

 If Prompt to Play is not enabled in the Animation Settings Preferences tab, then the 
animation executes to output using the Default Effect. 

Free 
Free removes a loaded animation from system memory. The Free function can be used to release system 
resources for other background activities.  This function is available only when an animation is already loaded 
into memory. To free system memory resources: 

 Click . 

Play - Animation Playback 
There are a variety of ways to execute an animation. 

NOTE 
The following actions have the same function: 

 Pressing Play on the Duet keyboard 

 Pressing Alt + Page Up on a PC keyboard. 

 Clicking  on the Transport Controls. 

 Xfer Mode:  Refer to Xfer to Output, covered earlier in this section, for details. 

Play to Output 
To play the animation to the VGE (output): 

 With the Live icon  active, press Play (Duet keyboard), Alt + Page Up or click the Play icon 

 on the Transport Controls.  On a Duet LE/PCI, this loads and plays the animation to output.  On 
a Duet LEX/PCI+, the animation streams to output (refer to Streaming Animation later in this 
section). 

 With the Live icon either active  or inactive , press Ctrl + Play (Duet keyboard), Ctrl + Alt 

+ Page Up or hold Ctrl and click the Play icon  on the Transport Controls.  On a Duet LE/PCI, 
this loads and plays the animation to output.  On a Duet LEX/PCI+, the animation streams to output. 
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CAUTION - DUET LEX/PCI+ SYSTEMS! 
If an animation is already loaded into the Load-and-Play buffer using the Load or Quick 
Load function (Alt + L or Alt + Q), and another animation is read for streaming, do not 
press Alt + Y to execute the new animation.  The animation that is currently stored in the 
Load-and-Play buffer will execute instead!  If the currently displayed animation is to be 
executed instead using Load-and-Play mode, make sure that the animation is first loaded 
into the Load-and-Play buffer using Load or Quick Load (Alt + L or Alt + Q)!  To erase a 

loaded animation from system memory, click the Free icon . 

Load-and-Play 
Refer to the paragraphs on Load, Quick Load earlier in this section. 

Play to the Canvas 
To play the animation to the VGA (Canvas) only: 

 With the  icon inactive, press Play (Duet keyboard), Alt + Page Up or click the Play icon on the 
Transport Controls. 

Stop 
The Stop function is used to escape a Loop in progress, and continue the execution of any remaining 
keyframes in the Lyric message containing the Loop. To execute Stop: 

 Press Esc. 

Changing the Speed of an Animation During Execution 
The speed of an animation can be changed during execution: 

 Press the up cursor key  to speed up the animation, or the down cursor key  to slow down the 
animation. 

This operation can be performed regardless of the method used to trigger the animation. 
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Streaming Animation - Duet LEX/PCI+ 

Setup and Playout 
In Duet LE/PCI, an animation must be loaded (pre-rendered) and stored in RAM before playout can begin.  
The Duet LE/PCI hardware’s resources limit the duration of an animation to six seconds, although this 
limitation does not apply to Rolls, Crawls and Type Ons (Slow Reveals) that execute in Transfer Mode. 

The Duet LEX/PCI+’s larger memory and faster processes allow playout to occur while an animation is still 
rendering, hence the term Streaming Animation.  Some amount of ‘head start’ on the loading/rendering 
process is always necessary before playout begins.  The Duet LEX/PCI+ calculates the Streaming Preload 
necessary for proper execution.  Animations containing Loops cannot be executed using Streaming 
Animation; they must be executed using Load-and-Play. 

When a Load-and-Play animation executes, the entire animation first loads, then executes.  Streaming 
Animation enables an animation to continuously preload and execute, allowing longer animations.  The Duet 
LEX Streaming setting defines the default length of preload time allocated to streaming operations.  If the 
animation is not executing properly, then lengthen the Duet LEX Streaming time.  Note that the Duet LEX 
Streaming time cannot be longer than the Default Animation Length. 

Message-Specific Preload Setting 
The Duet LEX/PCI+ automatically calculates a preload for Streaming Animations.  If, however, the 
animation does not execute properly because of a short preload, a higher preload value can be stored with 
the specific message. 

If too short a preload time is set either by the system or in the Set Message Preload Value dialog box (see 
below), one of the following can occur: 

 When the animation is played on the VPB or PCI Squeezeback Air output, the image disappears 
before playout is complete. 

 During VPB or PCI-Squeezeback playout, a portion of a previously-used animation appears abruptly 
at the end of the current animation. 

From Tools > Set Message Preload Time, the operator can select a preload value to be applied to an 
individual Lyric message.  This value, set in the Set Message Preload Value dialog box, is saved as a 
component of the Lyric message, and activated on playout of the message. 

The advantage of customizing a Message Preload Value is that if a message requires a longer preload, the 
larger required system resources will be dedicated only for playout of the individual message, and would not 
be tied up when other functions are performed. 

 

Set Message Preload Value 

It is suggested that you experiment with individual messages prior to air/production to determine the minimum 
time required for the preload operation, and then set this variable appropriately. 

The point at which a Message Preload is set affects whether or not the Message Preload information is 
saved with the message: 

 When the Message Preload is set for a message that is open on the Canvas, it becomes an attribute 
that is retained when the message is saved. 

 If Message Preload is not set on a given individual message, the system attempts to load the 
message based on a preload calculated by the system. 
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Streaming Animation Execution 
There are a variety of methods available to play a streaming animation. Read the animation, then: 

 With the Live icon active , press Alt + Page Up to stream the animation to the output. 

 With the Live icon either active  or inactive , press Ctrl + Alt + Page Up to stream the 
animation to the output. 

 With the Live icon either active  or inactive , press Ctrl, then click on the Transport 
Control or press the Play key on the Duet keyboard to stream the animation to output. 

CAUTION! 
If an animation is already loaded into the Load-and-Play buffer using the Load or Quick 
Load function (Alt + L or Alt + Q), and another animation is read for streaming, do not 
press Alt + Y to execute the new animation.  The animation that is currently stored in the 
Load-and-Play buffer will execute instead!  If the currently displayed animation is to be 
executed instead using Load-and-Play mode, make sure that the animation is first loaded 
into the Load-and-Play buffer using Load or Quick Load (Alt + L or Alt + Q)!  To erase a 

loaded animation from system memory, click the Free icon . 

To play the animation only to the VGA (Canvas): 

 With the icon inactive , press Alt + Page Up to execute the animation to the Canvas (VGA). 
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25. Playlists 

Playlists 
Tools Menu > Playlist;  File Menu > New > Playlist 
File Menu > Open > Files of Type > Playlists (*.ply) 

NOTES 
 It is strongly recommended that all Playlists be previewed prior to air. 

 As of Lyric Version 4.0, the  button (formerly the Duet  or  
button, depending upon the system) is now disabled during Playlist execution.  
This prevents the message that is cueing up from prematurely displaying on the 
output. 

Creating and Opening a Playlist 
The Playlist feature allows multiple Lyric messages to be compiled into an automated list and played out 
sequentially using preset transition effects.  For example, a Playlist could be used to automatically play a 
dissolving sequence of graphics displaying sports statistics. 

A Playlist can consist of up to 500 preset events which are numbered from 0 - 499.  Each event specifies the 
playout parameters of a Lyric message, including file name and transition effect.  When a message completes 
playout, the Playlist proceeds to the next specified message.  Simultaneous In and Out transition effects can 
be executed on Duet SD systems with multiple VGEs and a Duet SD Video Mixer installed. 

When used in conjunction with the powerful Chyron MOS newsroom application, a Playlist can be remotely 
built and edited.  Messages can be created on remote PCs and sent to the Duet system, where they are 
added to a Playlist for execution. 

If necessary, Playlist execution can be manually overridden. 

To create a new Playlist: 

 Pull down the File menu and select New > Playlist. 

 

Creating a New Playlist 
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A blank Playlist is displayed. 

 

New Playlist 

Playlist files have the extension .ply.  To open an existing Playlist, use one of the following two methods: 
 From the Tools menu, select Playlist.  A file Open dialog box is displayed.  The Files of Type field 

specifies Playlist Files (*.ply) and displays the available Playlist files in the current directory.  Select 
the file from that directory or browse to the file in another directory, then click Open.  The Playlist is 
displayed. 

 

Open Dialog Box   

 Select Open from the File menu or click  on the Windows Toolbar.  Select Playlist Files (*.ply) 
from the Files of Type dropdown list box, then browse for the file.  Select the file, then click Open.  
The Playlist is displayed. 
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Playlist Layout 
The Playlist is composed of a list of messages to be played out, and parameters that control the playout of 
each of them.  To the right of the list are execution controls, as well as Timecode setup.  Playlists can be 
composed on a PC for later use on a Duet system.  The Playlist can be resized by dragging any corner or 
edge, and an individual column can also be resized by dragging the column separator in the heading. 

 

Sample Playlist 

Navigating the Playlist 
Use the following methods to navigate through the Playlist: 

 Press the cursor keys  to navigate up, down, left and right.  Note that when using the  
keys to navigate, that when cursor reaches a field that accepts text entry, the cursor steps through 
the text first before proceeding to the next field. 

 When the cursor is in a Line, Control, Effect or Channel field, press Page Up or Page Down to 
navigate up or down in five-line increments.  If the cursor is in the Line column, the entire line is 
highlighted. 

 In the Scroll Bar, click above or below the scroll box to page backwards or forwards, respectively, 
through the Playlist. 

 In the Scroll Bar, click the up or down arrow to scroll the Playlist one line up or one line down, 
respectively. 

 Press End to move the cursor to the next instance of End or to the final line of the Playlist that 
contains an entry. 

The Playlist scrolls based on a fixed number of lines or a percentage.  This value is set in the Playlist 
Configuration dialog box. 

Current Message on Output Indicator 
The currently displayed message in the Playlist is indicated by the green square  located at the left side of 
the Playlist.  During playout, the indicator proceeds line-by-line through the Playlist. 

During Playlist execution, the Playlist automatically scrolls to display upcoming events. 

Current Take Line Indicator 
The Current Take Line Indicator  identifies the Playlist line that will be executed next.  When a step is 
executed, the Current Message on Output Indicator moves to the same line as the Current Take Line 
Indicator, and the two indicators are briefly positioned on the same line .  The Current Take Line 
Indicator then moves to the following line. 
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In the event that non-sequential execution of the Playlist is necessary, the Current Take Line Indicator can 
be moved to a different step using one of the following methods: 

 Click to the left of a line to move the Current Take Line Indicator to the line. 

 Press Ctrl +  or Ctrl +  to move the Current Take Line Indicator up or down in one-line 
increments. 

 Press Ctrl + Page Up or Ctrl + Page Down to move the Current Take Line Indicator up or down in 
five-line increments. 

 Press Ctrl + Home to move the Current Take Line Indicator to the first line of the Playlist. 

 Press Ctrl + End to move the Current Take Line Indicator to the next instance of End or to the final 
line of the Playlist that contains an entry. 

 Trigger a GPI to move the Current Take Line Indicator up or down in one-line increments.  The GPI 
is set up in the Playlist Configuration dialog box.  A GPI can also be used to execute a Take. 

Line 
The number in the Line column identifies the Line number for each event or Step on the Playlist.  The terms 
Line and Step are used interchangeably in reference to Playlists in this documentation.  A Playlist can 
contain up to 500 steps, numbered from 0 - 499.  

Control 
Control determines how the step is triggered.  This field cannot be set until a File Name field is entered.  
Once a file name is entered, the Control field displays the default setting, Delay, with Parameter 
00:00:00:00.  To select a Control, use one of the following methods: 

 Click the Control field for the event to toggle through the Control choices. 

 Press the first letter of the name of the Control.  If there is more than one Control starting with the 
same letter, press the same key to scroll through the additional Control names. 

Parameter/ 
Function 

Description 

Wait for 
Key 

When a Wait for Key is encountered in a Playlist, execution pauses 
until the user presses any key except Esc on the system keyboard.  
The Status Bar displays the prompt, Waiting for Keypress, until a 
key is pressed to execute the message.  Wait for Key does not use 
a Parameter setting.  Note that pressing the Esc key stops Playlist 
execution! 
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Parameter/ 
Function 

Description 

Delay When the Delay control is encountered in the Playlist, list execution 
pauses after the completion of the execution of the previous Line.  
The current step is executed after specified Delay duration.  The 
Delay duration is entered in the Parameter field. 

 

Setting a Delay 

The system reads the message during the delay and the message 
may appear on the system's VGA monitor, depending on the system 
and its configuration.  The message, however, does not play on the 
Duet output until after the specified Delay has elapsed.  In the figure 
above, Line 0 executes, then a delay of 2 seconds occurs after the 
completion of the execution of Line 0, then, the message on Line 1 
executes. 

Loop A Loop causes the Playlist to return to a step specified in the 
Parameters field, for a specified number of iterations.  Two values 
are entered in the Parameters field.  The format of the field is 
000,000.  Values are entered to the left of to the right of the comma. 

 The Step (Line) number to which the Loop should return is 
entered in the three-digit area to the left of the comma. 

 The iterations, or number of times the message should loop, 
is entered in the three-digit area to the right of the comma. 

In the following figure, Step 8 loops to Step 6, and repeats the loop 3 
times, as specified by the Parameter setting 002,003. 

 

Setting a Loop 

List execution resumes after the specified number of iterations has 
occurred. 

Timecode The Timecode control specifies a Timecode at which to trigger the 
execution of the step. See Using Timecode in a Playlist below for 
details on setup. 
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Parameter/ 
Function 

Description 

Skip A Skip control causes the Playlist to skip the Line/event on which it 
appears and move to the next Step.  Skip does not use a Parameter 
setting.  Skip can be a useful tool when assembling and testing 
Playlists. 

End An End control causes the Playlist to halt, and the Current Step 
indicator to return to Step 0.  A line containing the End control is 
automatically added after the last valid line in the Playlist.  End does 
not use a Parameter setting.  Do not enter a File Name.  Any 
Message listed in the File Name field on the same line as an End 
control is not played to output. 

GoTo A GoTo control specifies a skip to a specified step in the Playlist.  
The Step number is entered in the Parameter field.  Do not enter a 
File Name. 

 Do not set a Goto control to its own line number! 

 Any Message listed in the File Name field on the same line 
as a Goto control is not played to output. 

After a Skip is executed, Playlist execution continues from the new 
position of the Step Indicator. 



 Playlists  

 25-7 

Parameter/ 
Function 

Description 

GPI The Playlist can trigger output of a GPI to an external system, or 
cause the system to await input of a GPI signal before continuing 
with subsequent events, much like the Wait For Key control.  As 
shown below, Step 5 is set to be triggered by input from GPI 4.  It is 
recommended that a GPI that is already assigned as a Global GPI 
not be assigned to trigger a Playlist event, as it could cause a 
potential conflict.  Set the GPI number in the Parameter field. 

 

Setting a GPI 

 Duet SD/HD:  When composing a Playlist on a Duet SD/HD 
system configured with a GPI/O board, the Parameter field 
will display either Input or Output, depending on the 
Direction setting on the GPI tab of Configuration > Duet 
Hardware.  The numeric range of GPIs that may be selected 
is determined by the number of GPI/O boards installed in the 
Duet SD/HD system.  The presence of a single board in the 
system makes eight GPIs available, numbered 1 - 8.  A 
second board in the system makes available another eight 
GPIs, numbered 9 - 16 and so on. 

 Duet LE/LEX/PCI/PCI+:  Duet LE/LEX/PCI/PCI+ systems 
have sixteen GPIs available for each VPB.    The presence 
of a single VPB in the system makes sixteen GPIs available, 
numbered 1 - 16.  A second board in the system makes 
available another sixteen GPIs, numbered 17 - 32 and so on.  
Note that PCI-Squeezeback boards do not have GPI 
capability on their own, but can access the GPIs of VPBs in 
the same system.  The GPI Out setting is not available on 
Duet LE/LEX/PCI/PCI+ systems. 

Care must be taken when setting up a Playlist containing 
GPI triggers for playout on a different system, or when composing 
the Playlist on a PC.  Be sure that the GPI numbers and 
Input/Output selections in the Playlist Parameter field are 
appropriate for the available hardware and configuration of the Duet 
that will be used!  Make sure also that the GPI is not the same 
number as a Global GPI that has been set on the system.  Refer to 
the appropriate chapter on Duet Hardware Configuration for your 
system for additional information on GPIs, and the chapter on the 
Config menu for information on setting Global GPIs. 

Cue Clip As of Lyric v5.0, Cue Clip was relocated to the Playlist 
Configuration dialog box.  Refer to Playlist Configuration later in 
this section for details. 
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Parameter 
 A number of the Control functions require additional Parameters, such as number of Loops, Delay 
duration, Timecode times, etc.  A Parameter specific to particular Control are described in the preceding 
table.  

Effect 
Effect sets the transition effect that Duet executes at the beginning of the message named on the numbered 
line of the Playlist. To select an Effect, use one of the following methods: 

 Click the Effect field for the event to toggle through the Effect choices. 

 Press the first letter of the name of the Effect.  If there is more than one Effect starting with the same 
letter, press the same key to scroll through the additional Effect names. 

Toggling to a blank field is equivalent to selecting Cut. 

NOTES 
 Playlist Effect settings override Default Effect settings specified in the Config 

menu.  Refer to the chapter on Transitional Effects for information on Default 
Effects. 

 Playlist Effects are not supported on the Duet HD.  All transitions execute as 
Cuts. 

 If setting up a Playlist offline on a PC, the Lyric software must match that of the 
system on which the Playlist is to be executed.  Duet SD Effects are not available 
to Lyric for Duet LE/LEX/PCI/PCI+ and vice versa. 

The effects available for Duet SD and when composing a Lyric message offline on a PC are as follows: 
 Cut, Dissolve, Wipe Right, Wipe Left, Wipe Down, Wipe Up, HSplit, VSplit, HBlind, VBlind, Box, 

BoxNW, BoxNE, BoxSE, BoxSW, Pixel, Rev HSplit, Rev VSplit, Rev HBlind, RevVBlind, Rev 
Box, Rev BoxNW, RevBoxNE, Rev BoxSE, Rev BoxSW. 

The effects available for Duet LE/LEX/PCI/PCI+  and when composing a Lyric message offline on a PC are 
as follows are as follows: 

 Cover, Cut, Dissolve, Fade, Hide, Matrix, Peel, Pour, Push, Reveal, Split, Weave, Sqz-In, Sqz-
Out.  Refer to Setting Up a Squeezeback Effect in a Playlist later in this section for information on 
Sqz-In and Sqz-Out setup. 

IMPORTANT!!  Effect parameters such as Speed, Effect Direction, etc., for Duet LE/LEX/PCI/PCI+ 
Playlists must be set within the Primary Message Effects dialog box, accessed by either 
highlighting an effect on the Playlist, then pressing X, or by right-clicking on the Playlist, then 
selecting Effect Properties from the context menu. 

NOTES 
 If an attempt is made to execute an effect that is not supported by the assigned 

board, such as a Squeezeback effect on a VPB, the transition defaults to a Cut. 

 Chyron does not recommend the cross-platform creation and execution of 
Playlists  For example, it would be inadvisable to write a Playlist on a Duet LE 
using Duet LE/LEX/PCI/PCI+ effects, and then attempt to execute the Playlist on a 
Duet SD.  In this instance, the SD system would execute the Effect transitions as 
simple Cuts.  The same caution is advised for creating a Playlist on a Duet SD, 
then executing on a Duet LE/LEX/PCI/PCI+.  If it is necessary to attempt cross-
platform Playlist execution, preview the Playlist before executing to air. 
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Speed 
Speed is interpreted differently by the various Duet systems: 

 Duet SD:  A duration, in video fields, can be set in the Speed field.  The field accepts a value of up to 
999. 

 Duet HD:  Since Duet HD does not support Playlist Effects, the Speed setting has no bearing on 
Playlist execution. 

 Duet LE/LEX/PCI/PCI+:  The Speed field is not enabled for Playlists created and executed on the 
Duet LE/LEX/PCI/PCI+, with the exception of the Video Squeezeback effects Sqz-In and Sqz-Out, 
where the Speed field is used to identify a Squeezeback Effect number.  Refer to Triggering a 
Squeezeback Effect from a Playlist below for information on Sqz-In and Sqz-Out setup. 

On a Duet LE/LEX/PCI/PCI+ system, effect Speed in a Playlist must be set instead within the 
Primary Message Effects dialog box, accessed by either highlighting an effect on the Playlist, 
and then pressing X, or by right-clicking on the Playlist, and then selecting Effect Properties 
from the context menu.  Note that the Speed set in the Primary Message Effects dialog box is 
not reflected in the Playlist, although the Playlist executes at the Speed specified in the 
Primary Message Effects dialog box. 

File Name 
File Name specifies the file to be recalled.  File types that may be entered in this field are as follows:  

 Lyric messages with numeric file names, as seen in the Message Number Display.  If recalling a 
message that is stored in the Default Message Directory, only the Message Number itself must be 
entered in the field.  Otherwise, the full file path is necessary.  If entering only a Message Number, 
do not enter the .lyr extension. 

 Macros that have been saved with the .lyr file extension.  Note that a Macro file used in a Playlist 
must be autoexecuteable, as the Playlist will not attempt to "play" it.  Macro files with the .lmx 
extension may not be used in the Playlist. 

 Mixer Settings Files, which use the extension .lyr (Duet SD only). 

Note that files other than graphics and Macros files that have the .lyr extension, such as Message FX files 
(Duet LE/LEX/PCI/PCI+ Default Effects), Multi FX files (Duet SD) and Video Settings files (Duet SD) should 
not be used in a Playlist 

The following should be noted when entering a File Name of a file stored in the Default Message Directory: 
 If the File Name is completely numeric (no decimals or other symbols or letters) only the Message 

Number need be entered, not the entire filepath.  The leading zeros and the extension may be 
omitted.  Example:  35849 

 If the File Name is alphanumeric, (contains numbers and/or symbols and/or letters), only the File 
Name and the extension must be entered, not the entire filepath.  Example:  2003_Sports_Intro.lyr 

The following should be noted when entering a File Name of a file stored outside of the Default Message 
Directory: 

 If the File Name is completely numeric (no decimals or other symbols or letters), the entire filepath, 
including leading zeroes, must be entered.  Example:  C:\News_Graphics\000358490.lyr 

 If the File Name is alphanumeric, (contains numbers and/or symbols and/or letters), the entire 
filepath must be entered.  Example:  C:\News_Graphics\Election_Coverage_Opening.lyr 

To enter a File Name, choose one of the following methods: 
 Type the File Name, including, if necessary, the full filepath. 

 Drag-and-drop the file from the Browser or from a Windows Explorer-type window.  The full filepath 
is automatically entered in the File Name field. 

After the File Name is entered, Enter can be pressed to advance the cursor to the File Name field for the 
next Step. 
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Channel 
Channel specifies the output channel on which the effect will execute.  The type of Duet system and the 
presence of a Video Mixer determine how channel settings affect execution. 

IMPORTANT! 
If a Channel is not assigned to a Playlist step, the step does not execute to output! 

Duet SD/HD without a mixer board:  Available settings are None, 1, 2, 1>2 or 2>1. 
 When Channel is set to None, the step is skipped. 

 When Channel is set to 1 or 2, Playlist messages do not preview on the Canvas.  Effects are not 
available.  The Effects column becomes unavailable when Channel 1 or 2 is selected.  These 
settings are best used when you need both outputs to act as AIR outputs and the message cannot be 
previewed. 

 When Channel is set to 1>2 or 2>1, settings preview on both the Canvas and the first assigned 
output. (1 in the case of 1>2 or 2 in the case of 2>1).  On Duet SD, all Playlist Effects are available.  
Remember that Duet HD does not currently support Playlist Effects. 

Duet SD/HD with a mixer board:  Available settings are 1 or 2.  The effect previews on the Canvas, and 
executes to the specified channel. 

Duet LE/LEX/PCI/PCI+:  Available settings are None, 1, 2, 3 or 4.  As of Lyric 4.0, this is a new feature for 
these systems.  Previously, the entire Playlist was executed on the currently active frame buffer.  Now, each 
step of the Playlist can execute on a specified frame buffer. 

 Playlist operation is limited to one VPB or PCI-Squeezeback output.  Air and Preview designations 
do not apply. 

 Whichever VPB or PCI-Squeezeback board is active when Playlist execution is started becomes the 
output on which the entire Playlist is executed.  The exception is that a Sqz-In or Sqz-Out effect 
executes on the PCI-Squeezeback board on which the on which the effect was originally 
programmed, which may not be the currently active board. 

 Keep in mind that when executing a Sqz-In or Sqz-Out effect that has an associated graphic, it 
should be still be executed in the same frame buffer in which it was created.  When Channel is set to 
None, the effect executes to the Canvas. 

 Using the Playlist function while in Link mode is not recommended. 

If the message is a static graphic, it displays on the Canvas, then the specified Effect is triggered by the 
specified Control and executes to the specified Channel.  If the message is an animation, it loads, then the 
first frame displays on the Canvas.  The specified Effect is triggered by the specified Control, then the effect 
and animation execute on the specified Channel. 

Timecode Display 

 

Timecode Display 

The Timecode Display, located at the top right of the Playlist, displays the current Timecode.  The 
Timecode is by default, System time from the Duet or PC's clock, unless the Duet system is connected to an 
external source of Timecode.  To use an external Timecode source, Duet must be properly configured.  
Refer to the appropriate chapter on Duet Hardware Configuration for your system for additional information 
on Timecode.  Using Timecode in a Playlist is covered later in this section. 
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Execution Controls 
The following buttons and key control execution of the Playlist. 

Control Description 

 
Play:  Click Play to begin or resume execution at the location of 
the Current Take Line Indicator . 

 

 

 

Take:  The Take button is similar in function to the Read Next 
function.  Clicking Take preloads the next message in the 
Playlist.  Clicking Take again plays the message to air as 
programmed in the Playlist, and simultaneously preloads the 
following message. 

Generally when using Take  to execute a Playlist, the Control 
specified in a Playlist step should be Delay, which should be set 
to 00:00:00:00.  With this setting, the message executes to air 
immediately when Take is clicked. 

In addition, pressing the Take button on a Duet LE/LEX/PCI/PCI+ 
system also executes an Xfer to Preview, so that the preloaded 
message is displayed in the Preview Channel.  This necessitates 
the dedication of one Frame Buffer to the Preview channel.  If 
more than one Frame Buffer is dedicated to the Preview 
channel, Take preloads into the first available Preview buffer.  
Refer to the chapter on Duet LE/LEX/PCI/PCI+ Hardware 
Configuration:  Configure Board Use for additional information. 

 The Take button appears red until clicked the first time to 
start Playlist execution. 

 If the Take button is not clicked to start execution, it 
cannot be used later in the execution unless Playlist 
execution is first stopped by pressing the Stop key.  
When the Take button is unavailable, it is grayed out. 

 The Take button is also grayed out when a Playlist step 
is in progress, or the system is waiting for a Keypress. 

 The Take button appears green when it becomes 
available for use. 

 The Take button appears yellow when Cue Clip is 
enabled, and a Clip programmed into the Playlist is 
ready to play. 

The Take button can be assigned a GPI Shortcut or a Keyboard 
Shortcut, eliminating the need to use the mouse to execute a 
Take during execution.  Refer to Setup Take later in this section 
for details on setup. 

 
Stop:  Click Stop to halt Playlist execution.  Playlist execution 
can be resumed at the current Step by pressing Play or Take.  
The Stop button is available only when execution of a Playlist 
step is in progress.  It otherwise appears grayed out. 

A Playlist can also be stopped in order to read messages that are 
not in the Playlist.  Playlist execution can be resumed as just 
described. 

Esc Esc Key:  Press Esc to halt execution and exit from the Playlist. 



Lyric User Guide 

 25-12 

TC Relative To 
See Using Timecode in a Playlist below for details. 

Configuration 
Refer to the following section for details. 

Playlist Configuration 
Playlist parameters such as GPIs, Take hotkey, default settings and other options are set in the Playlist 
Configuration dialog box, accessed by clicking the Configuration button. 

 

Playlist Configuration 

After all values are set, click OK to apply the values, or Cancel to cancel the settings. 

Playlist GPIs 
GPIs can be used to move the Current Take line up or down, and to execute a Take.  Before a GPI can be 
specified in the Playlist Configuration dialog box, it must be configured in Duet Hardware Configuration.  
Refer to Duet SD/HD Hardware Configuration - GPI or Duet LE/LEX/PCI/PCI+ Hardware Configuration - 
Setup GPI for information on GPI configuration.    Refer to the appropriate chapter on Duet Hardware 
Configuration for your system for additional information on GPIs, and the chapter on the Config menu for 
information on setting Global GPIs. 

Once the GPIs have been configured in Duet Hardware Configuration, it can be specified in the Playlist 
Configuration dialog box. 

 The Line Up GPI moves the Current Take Line Indicator up one line. 

 The Line Down GPI moves the Current Take Line Indicator up one line. 

 The Take GPI executes a Take at the line at which the Current Take Line Indicator is positioned. 
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Perform the following procedure for the Line Up GPI, the Line Down GPI and he Take GPI: 

 From the Line Up/Line Down/Take GPI drop-down list box, select the GPI that is to be used to 
trigger the Line Up, Line Down or Take.  The selected GPI number is displayed in the drop-down, 
and its description (as set in Duet Hardware Configuration) is displayed in the Description field 
(unlabeled).  The description is not editable from this dialog box. 

In the following example, GPI 1 is set to trigger Line Up; GPI 2 is set to trigger Line Down; and GPI 3 is set 
to trigger a Take. 

 

GPI Setup 

Take Keyboard Shortcut 
A keyboard shortcut can be set to execute a Take. 

 In the Take Keyboard Shortcut area, enter a key in the Key field.  F5 is the default setting.  If 
desired, select (click) the Ctrl, Alt and/or Shift checkboxes.  For example, if T is entered in the Key 
field, and Ctrl, Alt and Shift are selected, the resulting Keyboard Shortcut would be Ctrl + Alt + 
Shift + T.  Pressing Ctrl + Alt + Shift + T during Playlist execution would execute a Take. 

 

Setting a Keyboard Shortcut 

The Esc key cannot be specified as a keyboard shortcut for Take. 

To clear the keyboard shortcut: 
 Click the Clear button. 

Clip Player Options 
If Cue Clip is enabled:  As the current step is executing, a clip that is part of the following step is cued up.  
The Take button turns yellow.  The step is executed when the Take button is clicked or triggered. 

If Cue Clip is disabled:  The step containing a clip executes without cueing. 
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Default Playlist Line 
To facilitate the setup of Playlist entries, default values can be set for Control, Parameter, Speed, Effect 
and Channel.  A default setting can be set or modified for one, more than one or all parameters.  The Default 
Playlist Line area in the Playlist Configuration dialog box is composed of display-only fields that cannot be 
edited from within the dialog box. 

The following figure shows default values set at Control = Delay; Delay Parameter = 15 frames; Effect = 
Reveal; Speed (Duration) of Reveal = 15 frames; and playout Channel = 1.  Note that on a Duet 
LE/LEX/PCI/PCI+ system, effect Speed in a Playlist must be set instead within the Primary Message 
Effects dialog box, accessed by either highlighting an effect on the Playlist, and then pressing X, or by right-
clicking on the Playlist, and then selecting Effect Properties from the context menu.  Note that the Speed 
set in the Primary Message Effects dialog box is not reflected in the Playlist, although the Playlist executes 
at the Speed specified in the Primary Message Effects dialog box.  The Duet LE/LEX/PCI/PCI+ does, 
however, use the Speed field to enter an Effect Number of a Squeezeback effect. 

 

Default Playlist Line 

To set default values for the Playlist, first close the dialog box, and then perform the following steps: 
1. In the Playlist, enter a file name in the File Name field.  The File Name can be typed, or dragged 

from the Browser or a Windows Explorer-type window.  A file name must be in the File Name field in 
order for the default setting to be saved. 

2. Set the Control, Parameter, Speed, Effect and Channel parameters are desired. 

3. Perform one of the following operations: 

 If setting or modifying all parameters, click the Line Number of the line from which the 
parameters are to be saved.  The entire line should be highlighted. 

 If setting or modifying more than one, but not all parameters, hold down the Ctrl key while 
clicking the Control, Parameter, Speed, Effect or Channel columns in the line from which 
the parameters are to be saved.  If the parameters are contiguous, holding down the Shift 
key while clicking the Control, Parameter, Speed, Effect or Channel columns works as 
well.  All selected fields should be highlighted. 

 If setting or modifying only one parameter, click the Control, Parameter, Speed, Effect or 
Channel column in the line from which the parameter is to be saved.  The selected field 
should be highlighted.  Note that if setting the Control and Parameter settings, both fields 
must be selected (highlighted). 

4. Right-click to display the Playlist context menu.  Select Set as Default.  The menu closes.  
Whenever a new file is added to the Playlist, the default settings automatically populate the fields. 

To view the default settings: 
 In the Playlist window, click the Configuration button.  The settings are displayed in the Default 

Playlist Line area in the Playlist Configuration dialog box.   
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Scroll Offset 
When the Playlist executes, the Current Message on Output Indicator and the Current Take Line 
Indicator progress through the Playlist.  The view of the Current Take Line, i.e., the line that is to be 
executed next, can be set to display a set number of lines from the top of the Playlist, or as a set percentage 
of total lines from the top of the Playlist. 

For example: 
 If the Scroll Offset is set to 4 lines, then the Current Take Line Indicator always displays at the 

fourth line from the top of the Playlist.  

 If nine lines are currently displayed in the Playlist, and Scroll Offset is set to 30%, then the Current 
Take Line Indicator displays at third line down from the top of the Playlist.  

To set the Scroll Offset: 
1. In the Scroll Offset area, select (click) either the Lines or Percent radio button. 

2. Adjust the slider to the desired value.  The value is reflected in the Scroll Offset field (unlabeled).  
Note that a value cannot be directly entered into this field. 

The following examples show a Line and a Percent Scroll Offset. 

 

Lines Offset 
 

Percentage Offset 

Preview Options 
A frame of a message that is loaded, but not yet executed to air, can be previewed on the VGA monitor 
(Canvas).  This display frame is determined as follows: 

 If the Preview Frame setting in Config Menu > Preferences > Animation Settings is disabled, the 
first frame is displayed, regardless of whether or not a Preview Frame was specified in the Record 
Only dialog box when the message was recorded.   

 If the Preview Frame setting in Config > Preferences > Animation Settings is enabled, but a 
Preview Frame was not specified when the message was recorded, the last frame of the animation is 
displayed. 

 If the Preview Frame setting in Config > Preferences > Animation Settings is enabled, and a 
Preview Frame was specified in the Record Only dialog box when the message was recorded, the 
specified Preview Frame is displayed. 

Refer to the chapter on Animation for information on Animation Preferences, and the chapter on Getting 
Started, in the section on Reading and Recording Messages, for information on Selective Recording 
(Record Only dialog box). 

Enable Preview: 

 When Enable Preview is active (checked), the Playlist transfers the display frame of the message to 
the Preview Channel when the message is read to the VGA monitor (Canvas). 

 When Enable Preview is not active (unchecked), the Playlist does not transfer the display frame of 
the message to the Preview Channel when the message is read to the VGA monitor. 

Auto Preview: 
 When Auto Preview is enabled (checked), the Preview Channel updates whenever the Current 

Take Line Indicator changes position. 

 When Auto Preview is disabled (unchecked), the Preview Channel does not update whenever the 
Current Take Line Indicator changes position. 
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Setting Up a Squeezeback Effect in a Playlist - Duet LE/LEX/PCI/PCI+ 
A Squeezeback effect (Duet LE/LEX/PCI/PCI+ Only) can be triggered from the Lyric Playlist.  Note that the 
Duet system must contain a PCI Squeezeback board in order to execute a Squeezeback effect.  The Playlist 
Effects column contains two Squeezeback-specific effects:  Sqz-In and Sqz-Out. 

1. In the first available Playlist Line (in this instance, Line 0), select enter a File Name  (in this 
instance, 5002), a Control, a Parameter (if necessary) and an Effect. 

 

Playlist - Squeezeback Effect Setup 

2. On the next available Line (Line 1), select Sqz-In or Sqz-Out, a Control and a Parameter (if 
necessary).  In the Speed field on the same Line, enter the Squeezeback Effect Number from the 
Lyric Squeezeback message specified in the previous Line.  In this example, it is Effect Number 4 
(from File ID 5002). 

When executed, the graphic associated with the Squeezeback effect displays, then the Sqz-In effect 
executes immediately. The Sqz-Out effect executes when a key is pressed.  Both Sqz-In and Sqz-Out 
execute at the duration set in the Squeezeback Panel. 

NOTES 
 When executing a Playlist that contains Squeezeback effects that have 

associated graphics, it is necessary to execute the Playlist in the buffer from 
which the graphics were stored to the Squeezeback effect. If the graphics were 
stored to effects on SQZ board 1, which was assigned to Buffer 2, then the 
Playlist must be executed on Buffer 2. If there are no graphics associated with the 
effects, then the Squeezeback effect can be executed from any available buffer. 

 It is possible to use a Playlist Effect to transition a graphic associated with a 
Squeezeback effect. It is advisable, however, to preview the Playlist before airing. 

Refer to Video Squeezeback for information on Squeezeback effect setup. 

Using Timecode in a Playlist 
Timecode can be referenced by the Playlist in three different manners: 

 System Timecode:  The Playlist step executes when the System Timecode matches the 
Timecode specified in the Control Parameter.  To execute Playlists in this manner, TC Relative To 
should be disabled (unchecked). 

 Relative to Play:  The Playlist sets its own starting timecode as 00:00:00:00 for each execution.  All 
Timecode Control Parameter settings within the Playlist are calculated from the 00:00:00:00 
starting timecode. 

 Relative to Start Time:  The Playlist adds the Start Time set in the Timecodes Relative To dialog 
box to all of the Timecode Control Parameter settings in the Playlist.  The Playlist waits for the 
System Timecode to match the recalculated Timecode in each Playlist step that has a Timecode 
Control before executing the step. 
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To set Timecodes Relative To to either Start Time or Play: 
1. Click the TC Relative To checkbox to enable relative Timecode and display the Timecodes 

Relative To dialog box, as shown at right in the following figure. 

The figure below shows the three possible states of the Timecode setting.  Only one displays at any 
time.  When the TC Relative To checkbox is not selected (unchecked), the Timecode is the same as 
System Timecode.  The Timecodes Relative To dialog box settings show how the appearance of 
the Playlist's TC Relative To information can be affected when TC Relative To is selected 
(checked). 

 

Timecode Reference Settings 

2. Click the Play radio button to select Relative to Play. 

OR 

Click the Start Time radio button to select timecode relative to Start Time, then enter a start time. 

3. Click OK.  Notice in the figure above how the setting is displayed to the user in the Playlist TC 
Relative To area. 

To set a Timecode Control for a Playlist step: 
1. At the desired step, select Timecode in the Control field. 

2. In the Parameter field, enter the Timecode at which the step should execute. 

 When the Playlist is executed, the step executes at the point where the System Timecode 
matches Timecode as set in the Control field, or it reaches a specified relative Timecode as 
set in the TC Relative To area at the right of the Playlist. 

 If Timecode is set 5 minutes or less ahead of the current System Timecode or specified 
relative Timecode, the step executes immediately when it is reached. 

 If Timecode is set earlier than 5 minutes ahead of  the current System Timecode or 
specified relative Timecode, the step delays execution until the System Timecode matches 
the set or relative Timecode. 

Refer to the appropriate chapter on Duet Hardware Configuration for your system for additional information 
on Timecode.   
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Saving and Recalling Playlists 

 

Opening a Playlist 

Playlists have their own folder in Lyric's Default Directory. 

A quick method for recording a Playlist file is as follows: 
1. Press Ctrl + Record.  The Record Only: dialog box opens. 

2. Select Playlist (.ply). 

3. Click Record.  The Playlist is saved to the current Message Number in the Default Playlist 
Directory. 

A Hotkey combination can also be used to record the Playlist: 
 Press Ctrl + Record P Enter.  The Playlist is saved to the current Message Number in the Default 

Playlist Directory. 



 

 26-1 

26. Internal Clip Player and Clip Control Panel 

Internal Clip Player - Hardware and Connections 
Tools Menu > Clip Control Panel > Internal Clip Player 

IMPORTANT!!! 
The Internal Clip Player offers a variety of input/output and encoding/decoding options.  
Ensure that the Matrox DigiSuite utility, accessed from Start > Settings > Control Panel, 
has been properly configured for production requirements, and that video/audio sources 
and outputs are properly cabled to the clip player, the Digital LE Module (if applicable), 
and to the system.  Refer to Matrox documentation for detailed information on hardware 
and configuration. 

Overview 
Duet SD/LE/PCI/LEX/PCI+ systems support single and dual Internal Clip Players, which provide encoding 
and decoding of video and audio inputs and outputs. 

Two types of Internal Clip Players are supported: 
 The Matrox® DigiSuite LE Internal Clip Player supports the M-JPEG codec.  The DigiSuite LE clip 

player processes analog video and audio.  Analog video output from the DigiSuite LE clip player, that 
is to be otherwise processed by the Duet system, must be input to an Lantern 64 (analog) board.  
Analog Lantern 64-A boards are supported by Duet LE/LEX/PCI/PCI+ systems, and are not 
supported by Duet SD systems. 

To process digital input and to use digital output of the DigiSuite LE clip player as input to digital video 
boards in a Duet system, the digital signals must be input to or output from the Digital LE Module of 
the DigiSuite clip LE player. 

If outputting digital video, the Analog Video Out and Analog Audio Out on the clip player can be 
used for monitoring purposes.  

 The Matrox DigiServer Internal Clip Player supports the DV and MPEG-2 codecs.  The DigiServer 
clip player processes digital video and audio.  Conversion from or to analog audio must be done 
externally.  Only one codec type can be processed at a time.  When the clip player is set to DV, it 
cannot read/play MPEG-2 files, and vice versa.  DigiServer clip players are supported by Duet 
LE/LEX/PCI/PCI+ systems, and are not supported by Duet SD systems. 

The Internal Clip Player can record video/audio from an external source and save to *.avi (video) and/or *.wav 
(audio) format files.  For proper playback in broadcast applications, files should be stored on a SCSI hard 
drive within the Duet system. 

If two Internal Clip Players are installed in a system, they must be of the same type; either two DigiSuite LE 
clip players or two DigiServer clip players.  The two types cannot be mixed in the same system.  Dual Internal 
Clip Players can access the same SCSI drive in a system. 

NOTE 
A distinction should be made between a video/audio file recorded from Internal Clip 
Player input, and a Clip file.  A Clip file (*.ccf) format stores data such as In and Out 
points and other playback instructions.  The original source video/audio must be 
available on a playback device in order to play it back from the Clip Control Panel. 

Video and/or audio that is input to the Internal Clip Player can be recorded and saved as 
a file in the *.avi and *.wav formats. respectively.  The file is self-contained, and can be 
played via the Clip Control Panel without the presence of the device that originally fed 
the Internal Clip Player. 

For example, a video file could be recorded as an *.avi file using the Internal Clip Player.  
A *.ccf file could be created in the Clip Control Panel to control the playback of a selected 
portion of the file. 
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Using output from the Internal Clip Player is similar to using an external VTR, DDR or live feed as a source 
of video to be keyed under Lyric/Duet graphics.  Like other external video, the Internal Clip Player video 
output is not a typical object in a Lyric composition, and is not visible on the Lyric Canvas as seen on the 
Duet VGA monitor. 

Digital video output of the clip player may be input to Duet's Video I/O board or to a graphics board as a 
source for keying or background.  On a Duet SD system, digital video can also be input to Duet's optional SD 
Mixer for layering. 

The following table outlines the standards supported by the Internal Clip Players: 

 DigiSuite LE DigiServer 

 Input Output Input Output 

SDI Video Yes, with Digital 
Module* 

Yes, with Digital 
Module* 

Yes Yes 

Analog Video Yes Yes - On a Duet 
system, analog 
video from the 

DigiSuite LE clip 
player can be 

input only to an 
Lantern 64-A 

(analog) board 
(Duet 

LE/LEX/PCI/PCI+ 
only) 

No No 

Digital Audio Yes, with Digital 
Module* 

Yes, with Digital 
Module* 

Yes Yes 

Analog Audio Yes Yes No No 

*Required for outputting digital video from DigiSuite LE clip player into a digital board in a Duet 
system.  This applies to any board on a Duet SD, and any board on a Duet LE/LEX/PCI/PCI+ except a 
Lantern 64-A (analog) board. 

Internal Clip Player Connections 
The Internal Clip Player option is factory-installed or retrofitted by Chyron or the dealer, but the user must 
complete the appropriate cabling as part of installing or reinstalling the Duet system.  The connections on the 
DigiSuite LE and DigiServer clip players differ somewhat from each other, and are outlined in the following 
sections. 

Refer to Cabling Options - Duet LE/LEX/PCI/PCI+ for additional cabling options if the Internal Clip Player is 
installed in a Duet LE/LEX/PCI/PCI+ system. 

DigiSuite LE Clip Player Connections 
NOTE 

Digital video output from the DigiSuite LE clip player/Digital LE Module to the Duet 
system is supported by the Video I/O board, PCI graphics boards and the SD Mix Effects 
board on Duet SD systems, and the Video I/O board, PCI-Squeezeback boards and 
Lantern 32/64 boards on Duet LE/LEX/PCI/PCI+ systems. 

Analog video output from the DigiSuite LE clip player to the Duet system is supported by 
Lantern 64-A (analog) boards on Duet LE/LEX/PCI/PCI+ systems. 

Ensure that the Matrox DigiSuite utility, accessed from Start > Settings > Control Panel > 
DigiSuite, is accurately configured for digital/analog video/audio.  
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The DigiSuite LE clip player and its Digital Module are most likely located at the left side of the Duet SD 
chassis (rear view), or at the right side of the Duet LE/LEX/PCI/PCI+ chassis.  Two PCI slot spaces are 
required for each DigiSuite LE clip player/Digital LE Module pair.  Although two PCI slot spaces are required, 
the DigiSuite LE clip player/Digital LE Module unit plug into only one PCI receptacle. The following figure 
shows the back panel of a single DigiSuite LE clip player (left) fitted with a Digital Module (right). 

 

Internal Clip Player Connectors 

There are four multi-cable connectors to the Internal Clip Player/Digital Module unit.  An Analog Audio 
Connector and an Analog Video connector are on the DigiSuite LE Internal Clip Player.  A Digital Audio 
connector and a Digital Video connector are on the Digital Module. 
The analog connectors can be used to input analog video and audio for recording to *.avi and *.wav files via 
the Internal Clip Record Panel. Analog video can input to a Lantern 64-A (analog) board on a Duet 
LE/LEX/PCI/PCI+.   Analog video and audio be also used for external purposes such as monitoring or feeding 
output to external analog devices.  Analog video output cannot be used as an input to the Duet SD 
Mix/Effects board, any Duet Video I/O board or any Duet digital graphics board. 
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ANALOG CONNECTIONS 

Each analog video connector which is a component of the analog video multi-cable is individually labeled, and 
some cables are colored other than black.  Colors and labeling may vary.  Attach the large, multi-pin analog 
video connector on the cable to the video connector on the DigiSuite LE clip player, as shown in the following 
figure: 

 

DigiSuite LE Analog Video Connections 

The inputs/outputs, connector types and colors are as follows: 
 IN C1/B-Y (BNC - Black) 

 IN Y1/COMPS1 (BNC - Red) 

 IN Y/C2 (S-Video - Black) 

 IN C2/R-Y  (BNC - Black) - Grouped with Y/C2 S-Video cable 

 IN Y2/Y/COMPS2 (BNC - Black) - Grouped with Y/C2 S-Video cable 

 PREVIEW COMPS (Composite) (BNC - Orange) 

 PREVIEW Y/C (S-Video - Black double cable) 

 PROGRAM B-Y (BNC - Green) 

 PROGRAM COMPS (BNC - Brown) 

 PROGRAM Y/C (S-Video - Black) 
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 PROGRAM Y (BNC - Black) - Grouped with PROGRAM Y/C S-Video Cable 

 PROGRAM R-Y/C (BNC - Black) - Grouped with PROGRAM Y/C S-Video Cable 

 KEY OUT (BNC - Blue) 

 REF IN (BNC - Yellow) 

When using the Internal Clip Player to record video input to an *.avi file, a variety of video source types are 
available:  Composite 1, Composite 2, Y/C (S-Video 1), Y/C (S-Video 2), Analog Component and 4:2:2 
SDI.  A source type can be selected from the Video Source drop-down list box in the Internal Clip Record 
Panel. 

The following figure shows each analog Video Source choice, and how it must be fed to the DigiSuite LE clip 
player analog video inputs.  The slashes in the cable designations indicate that there is a choice of signal type 
that can be accepted by the clip player from that connector.  Ensure that the correct signal type is used as an 
input, and that the Matrox DigiSuite utility is properly configured to recognize the signal type.   

 

Analog Video Input Cabling - DigiSuite LE Clip Player 

WARNING!!! 
Simultaneous Y/C (S-Video) and analog component input connections and/or 
Simultaneous Y/C (S-Video) and analog component output connections are not 
supported by the DigiSuite LE clip player.  IN Y/C 2 should never be connected at the 
same time as IN Y2/Y/COMPS2 and/or IN C2/R-Y, as this will short-circuit your hardware 
and damage your equipment. 

Additionally, do not attempt to connect PROGRAM Y/C at the same time as PROGRAM Y 
and/or PROGRAM R-Y/C, as this will result in double termination of the video signals. 

In order to use Y/C and analog component equipment simultaneously, the Y/C connector 
must be disconnected before connecting the BNC connectors, and vice versa.  
Remember that the Matrox DigiSuite utility must be configured to accommodate the 
change. 
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Each analog audio connector, which is a component of the analog audio multi-cable, is individually labeled.  
Labeling may vary.  Attach the large, multi-pin analog audio connector on the cable to the audio connector on 
the DigiSuite LE clip player, as shown in the following figure: 

 

DigiSuite LE Analog Audio Connections 

The inputs/outputs and connector types are as follows: 
 IN 1 (XLR) - Used as Left Channel input 

 IN 2 (XLR) - Used as Right Channel input 

 IN 3 (XLR) - Not used 

 IN 4 (XLR) - Not used 

 OUT 1 (XLR) - Used as Left Channel output 

 OUT 2 (XLR) - Used as Left Channel output 

 OUT 3 (XLR) - Not used 

 OUT 4 (XLR) - Not used 
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DIGITAL CONNECTIONS 

All digital input connections to the Duet system must be from the Digital LE Module.  Labeling may vary.  
Attach the large, multi-pin digital video connector on the cable to the video connection on the Digital LE 
Module, as shown in the following figure: 

 

Digital LE Module Digital Video Connections 

 The inputs/outputs and connector types are as follows: 
 SDI IN (BNC) - This is the Video Source that is recorded when SDI 4:2:2 is selected in the 

Internal Clip Recorder Panel for recording a video file. 

 REF IN (BNC) - Analog 

 SDI OUT (BNC) 

 SDI KEY OUT (BNC) 

 REF LOOP OUT (BNC) - Analog 
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Each digital audio connector which is a component of the digital audio multi-cable is individually labeled.  
Labeling may vary.  Attach the large, multi-pin digital audio connector on the cable to the audio connector on 
the Digital LE Module, as shown in the following figure: 

 

Digital LE Module Digital Audio Connections 

The inputs/outputs and connector types are as follows: 
 IN 1/2 (XLR) 

 IN 3/4 (XLR) - Not used 

 OUT 1/2 (XLR) 

 OUT 3/4 (XLR) - Not used. 
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DigiServer Clip Player Connections 
The DigiServer clip player offers digital video and audio inputs and outputs, and therefore does not need a 
Digital Module.  The DigiServer clip player is most likely located at the right side of the Duet LE/LEX/PCI/PCI+ 
chassis.  The following figure shows the back panels of single and dual DigiServer clip players. 

The one connector on the single clip player back panel handles both digital video and digital audio input and 
output. 

The dual back panel has Primary Codec and Secondary Codec connectors, each of which inputs and 
outputs digital video and audio to/from a separate DigiServer clip player.  The two clip players are mounted to 
the same back panel.  Each DigiServer clip player can be individually configured in the Matrox DigiSuite 
utility, accessed from Start > Settings > Control Panel > DigiSuite. 

 

Single DigiServer 
Back Panel 

 

Dual DigiServer 
Back Panel 

The inputs and outputs to and from the DigiServer clip player are incorporated into a multi-cable that connects 
to the Primary Codec connector on a single- or dual-clip player board.  An additional multi-cable connects to 
the Secondary Codec connector on a dual-clip player unit.  If using only one board of a dual-board clip 
player system, wither the Primary or Secondary codec can be connected, i.e., either board can be used. 
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DigiServer Cable Connections 

Each connector is labeled.  The inputs/outputs and connector types are as follows: 
 Digital Audio (AES/EBU) In 1/2 (XLR - black) - Used as stereo pair 

 Digital Audio (AES/EBU) In 3/4 (XLR - black) - Not used 

 Digital Audio (AES/EBU) Out 1/2 (XLR - black) - Used as stereo pair 

 Digital Audio Out (AES/EBU) 3/4 (XLR - black) - Not used 

 Audio Monitor Out (3/4" - black) 

 Digital Ref In (AES/EBU) (XLR - black) 

 Analog Ref In (BNC - yellow) 

 Ref Loop Out (BNC - gray) - Analog 

 SDI/SDTI Video In (BNC - red) - This is the Video Source used when SDI 4:2:2 is selected in the 
Internal Clip Recorder Panel for recording a video file. 

 SDI/SDTI Video In Loop Out (BNC) - Reclocked 

 SDI/SDTI Video Channel A Out (BNC - blue) 

 SDI/SDTI Video Channel B Out (BNC - black) 

 Analog Composite Video Out (BNC - white) - for monitoring 
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Connecting the ICP to the Duet Video I/O Board 
Connection of the Internal Clip Player to the Video I/O board of any Duet system is essentially the same.  The 
following figure shows connection of a DigiSuite LE Digital Module to the Video In of a Duet SD.  Remember 
that only digital video can be input to a Duet Video I/O board.  

 

Connecting the Internal Clip Player to Duet Video I/O Board 

NOTE 
To use analog sync, the same analog sync signal must be connected to the Internal Clip 
Player Ref In connector. 

Audio Configuration 
The DigiSuite LE and DigiServer clip players can record and play back audio.  Refer to Audio and the 
Internal Clip Player for information on audio processing in the DigiSuite LE and DigiServer clip players. 
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Audio and the Internal Clip Player 
The Internal Clip Player can record and play back *.wav audio files.  The DigiSuite LE clip player has analog 
audio processing capability.  With the addition of the Digital LE Module, it has digital audio processing 
capability as well.  The DigiServer clip player has digital audio processing capability only. 

DigiSuite Configuration 
Analog/Digital preference is set in the Matrox® DigiSuite® Configuration dialog box, accessed from Start 
> Settings > Control Panel > DigiSuite.  The appropriate format for Output 1 and Output 2 becomes 
available when Digital Output is selected. 

 

DigiSuite Configuration - Digital Audio Capability 

DigiServer Audio Considerations 
The DigiServer clip player can input/output only digital AES/EBU audio.  If the audio source is analog, it must 
be converted to digital before it is input to the DigiServer clip player.  If analog audio is required on output, it 
must be converted to analog after it is output from the DigiServer clip player. 
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Clip Control Panel 
Tools Menu > Clip Control Panel 

Overview 
The Clip Control Panel provides the ability to play back video and/or audio clips either independently or as 
part of a Lyric animation.  A video clip plays behind Lyric graphics on output, and is not visible on the Canvas 
during clip editing, preview or playback.  An audio clip can be monitored through a headset or speakers 
connected to the Duet system. 

Information about how the clip is to be played back is recorded to a Lyric clip file (*.ccf).  The clip file defines 
the start frame and end frame of the clip, duration, and loop and other data.  When recording a clip file, Lyric 
does not perform actual edits on the recorded content of the source material.  In order to play back the 
video/audio, the original material and the playback device must be available. 

Clip files can be created from sources such as the following: 
 Duet's Internal Clip Player. 

 Audio files processed through integrated audio hardware in Duet. 

 Chyron Aprisa DDR. 

 VTR or DDR (Digital Disk Recorder) via BVW-75 serial protocol.  To control these external devices, 
an RS-422 Serial I/O and GPI/O board must be installed in the Duet system.  

Video clips are not supported on Duet HD systems.  The Clip Control Panel can be used, however, to play 
back audio clips if there is audio hardware in the Duet HD system. 

DigiSuite LE and DigiServer Clip Players 
The following Internal Clip Players are available for playback of video files: 

 The DigiSuite LE Internal Clip Player records and plays Motion JPEG (M-JPEG) files.  The board 
provides support for both analog and digital video/audio I/O. 

 The DigiServer Internal Clip Player records and plays Digital Video (DV, DV-25, DV-50) and MPEG-
2 files.  It supports only digital video/audio I/O.  It is available as a single-channel or dual-channel unit.  
There are two versions of the DigiServer Internal Clip Player, one that supports DV/DV-25/MPEG-2 
and one that supports DV-50/MPEG-2.  The DigiServer Internal Clip Player is not available for Duet 
SD/HD, and requires Lyric v4.14 or later. 

NOTE 
M-JPEG, DV and MPEG-2 files all share the *.avi extension.  They do not, however, share 
the same compression codec.  M-JPEG files must be recorded and played back on a 
DigiSuite LE clip player, and DV, DV-25, DV-50 and MPEG-2 files must be played back on 
the appropriate DigiServer clip player.  

 Recording and playing back an M-JPEG *.avi file requires a DigiSuite LE clip 
player. 

 Recording a DV or DV-25 *.avi file requires a DigiServer DV-25 clip player, "DV" 
must be selected in the Internal Clip Recorder Panel, and "DV" or "DV-25," 
respectively, must be selected in the DV Capture Settings dialog box.    Playback 
of the recorded file requires a DigiServer DV-25 clip player, and "DV" must be 
selected in the AVI Properties dialog box (accessed from the Clip Control Panel). 

 Recording a DV-50 *.avi file requires a DigiServer DV-50 clip player, "DV" must be 
selected in the Internal Clip Recorder Panel, and "DV-50" must be selected in the 
DV Capture Settings dialog box.  Playback of the recorded file requires a 
DigiServer DV-50 clip player, and "DV" must be selected in the AVI Properties 
dialog box (accessed from the Clip Control Panel). 
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 Recording an MPEG-2 *.avi file requires either a DigiServer DV-25 or DV-50 clip 
player, and "MPEG-2" must be selected in Internal Clip Recorder Panel.  Playback 
of the recorded file requires a DigiServer DV-25 or DV-50 clip player, and "MPEG" 
must be selected in the AVI Properties dialog box (accessed from the Clip Control 
Panel). 

AVI Properties are covered later in this section. 

There are a number of MPEG codecs.  The DigiServer clip player plays back and records 
only MPEG-2 AVI files.  Any mention of "MPEG" with regard to DigiServer clip player 
operation  refers to "MPEG-2." 

Dual Clip Player Use 
As of Lyric v4.14, Lyric supports the installation and simultaneous use of two Internal Clip Players. 

NOTE 
DigiSuite LE and DigiServer clip players cannot be mixed within a system.  If two clip 
players are to be installed in a system, they must be either two DigiSuite LE or two 
DigiServer clip players.  When two clip players are installed, they both can draw video 
and audio data from the same SCSI drive. 

Configuration for Display of Video Clips 
Depending on the video/audio source and the system, special configuration may be necessary.  Refer to 
Matrox documentation for information. 

NOTE 
If using the Clip Control Panel to play back audio (*.wav) files only, Video configuration 
for clip playout is not necessary.  If using the Internal Clip Player or other device such as 
an Aprisa DDR or a VTR to play back video clips, specific Duet Hardware Configuration 
settings are required.  Refer to Configuration for Display of Video Source - Duet SD, 
Configuration for Display of Video Source - Duet HD or Configuration for Display of Video 
Source - Duet LE/LEX/PCI/PCI+ for information. 

The Internal Clip Player can also be used to record external video or audio to an *.avi or *.wav file, 
respectively, eliminating the need for an external playback device 

Accessing the Clip Control Panel 
To access the Clip Control Panel: 

 Select Clip Control Panel from the Tools menu.  A new menu heading, Clip, is added to the menu 
bar between Tools and Window. 

 

Clip Menu 
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The Clip Control Panel is also displayed.  The Playback Device drop-down list box (unlabeled) at the top of 
the Clip Control Panel displays the default device for the system.  If there is no Internal Clip Player installed, 
or an Aprisa DDR or other video playback device is not connected, the Playback Device field specifies 
Audio Hardware, if available.  If there is an Internal Clip Player installed, the Playback Device field specifies 
Internal Clip Player. 

The following figures show Internal Clip Player and Audio Hardware selected. 

 

Internal Clip Player 
 

Audio Hardware 
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The following figures show Aprisa DDR, SONY PVW-2800 and Sierra DDR selected. 

 

Aprisa DDR 
 

External VTR 
 

External DDR 

Most of the controls on the Clip Control Panel are duplicated as commands in the Clip menu. 
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Clip Control Panel and Clip Menu Controls and Parameters 
Parameters and controls on the Clip Control Panel and in the Clip menu provide settings for a variety of clip-
related operations.  The following table specifies which parameters in the Clip Control Panel are available to 
each type of video/audio source. 

Clip Control 
Panel Parameter 

Internal Clip 
Player: 

AVI Files 

Audio 
Hardware: 
WAV Files 

Aprisa DDR: 
Aprisa Clips 

Video/Audio 
from External 

VTR/DDR 

Playback Device Yes Yes Yes Yes 

Goto Yes No Yes Yes 

Record 
(from External 
Video/Audio) 

Yes No No No 

Transport 
Controls 

Only Stop and 
Play, until Scrub 

Mode is made 
active. 

Play, Stop and 
Rewind Only 

Yes Yes 

Scrub Mode Yes No No No 

Slide Box 
(Jog/Shuttle) 

Yes, when 
Scrub is 
enabled. 

No Yes Yes 

Source Type AVI File Wave Event # None 

AVI Properties Yes No No No 

     Key Delay Yes No No No 

     Audio Delay Yes No No No 

     Loop Frame Yes No No No 

     CODEC: 
MPEG, DV 

DigiServer Clip 
Player Only 

No No No 

     CODEC: 
Latency 

Yes No No No 

Load Yes Yes Yes No 

Browse Yes Yes No, but Aprisa 
Clips can be 

browsed from 
the Lyric 
Browser 

No 

Clear Yes No Yes No 

In/Out Points Yes No Yes Yes 

     Mark Yes No Yes Yes 

     Go To Yes No Yes Yes 

     Play To End Yes No Yes Yes 

     Loop Yes No No No 
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Clip Control 
Panel Parameter 

Internal Clip 
Player: 

AVI Files 

Audio 
Hardware: 
WAV Files 

Aprisa DDR: 
Aprisa Clips 

Video/Audio 
from External 

VTR/DDR 

Save Yes Yes Yes Yes 

Recall Yes Yes Yes Yes 

TLine Add Yes Yes Yes Yes 

TLine Update Yes Yes Yes Yes 

Play Clip Yes Yes Yes Yes 

OK Yes Yes Yes Yes 

The following table specifies which parameters in the Clip menu are available to each type of video/audio 
source. 

Clip Menu 
Parameter 

Internal Clip 
Player: 

AVI Files 

Audio 
Hardware: 
WAV Files 

Aprisa DDR: 
Aprisa Clips 

Video/Audio 
from External 

VTR, DDR 

Play 
Stop 
Rewind 
Fast Forward 
Next Frame   > 
Previous 
Frame   < 

Only Stop and 
Play, until Scrub 

Mode is made 
active. 

Play, Stop and 
Rewind Only 

Yes Yes 

Mark In 
Mark Out 

Yes No Yes Yes 

Go to: 
Beginning 
End 
Timecode 

Yes, but only 
when Scrub 

Mode is active. 

Go to Beginning 
Only 

Yes Yes 

Play Clip Yes Yes Yes Yes 

Add Timeline 
Clip 

Yes Yes Yes Yes 

Playback Device 
The Playback Device drop-down list box (unlabeled), located at the top of the Clip Control Panel, specifies 
the selected playback device.  Only playback devices that are available to the system can be selected from 
the drop-down list box.  Examples of playback devices are:  Audio Hardware, Internal Clip Player, Aprisa 
DDR, Sony PVW-2800 and Sierra DDR.  Depending upon which device is selected, specific controls or 
parameters may or may not be available. 

In order to communicate with an external BVW-75-protocol playback device, such as a VTR or DDR, the 
device must be connected to an RS-422 port on the Duet's RS-422 Serial I/O and GPI/O board.  It must then 
be properly configured in the Device Control Configuration dialog box, accessed from Config Menu > Duet 
Hardware > Device Control.  When the external playback device is selected in the Clip Control Panel, the 
name displayed in the Playback Device field reflects the name as set in the Description field in the Device 
Control Configuration dialog box. 
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Output Channel 
One or two clip players can be installed in a system, and are identified as 1 and 2 in Output Channel drop-
down list box.  When a clip player is selected, the settings for that clip player are displayed in the Clip 
Control Panel. 

When Frame Buffer 1 in a Duet system is selected as active, the Clip Control Panel automatically displays 
the settings for Internal Clip Player 1.  When Frame Buffer 2 in a Duet system is selected as active, the Clip 
Control Panel automatically displays the settings for Internal Clip Player 2.  This occurs regardless of how 
the clip players are connected to the various boards in the Duet system. 

GoTo 
Entering a frame number in the Goto frame counter moves the source video to that frame.  GoTo is available 
as follows: 

 When Internal Clip Player is selected to play *.avi files, but only when Scrub Mode is active.  Scrub 
Mode is covered later in this section. 

 When Aprisa DDR is selected to play back Aprisa Clips, or an RS-422 protocol external VTR or 
DDR is selected to play back video. 

 Not available when Audio Hardware is selected to play back *.wav files. 

The Clip menu also offers three Go To choices: 
 Go to Beginning:  Moves the source video to the beginning. 

 Go to End:  Moves the source video to the end. 

 Go to Timecode:  Moves the source video to the specified frame or Timecode (e.g., from an 
external VTR). 

Record 

The Record function, accessed from the Record icon  located to the right of the Goto frame counter, 
enables video or key from an external source such as an Aprisa DDR or a VTR to be recorded and saved in 
an *.avi  format.  Audio from an external source can also be recorded to a *.wav format file.    Recording a 
video or audio file in this manner eliminates the need for the external playback device.  The Record function 
records only to Duet system via the Internal Clip Player, and not to external devices such as DDRs or VTRs. 

Clip Transport Controls 
The Clip Transport Controls are similar to the Transport Controls found on the Lyric interface.  Clicking a 
Transport Control icon moves the video or audio source as specified in the following figure. 

 

Clip Transport Controls 

The Clip Transport Controls are also available from the Clip menu.  Additionally, pressing > or < moves the 
video or audio source to the next or previous frame, respectively.  Using these controls does not play a clip as 
set in the In Point and Out Point areas (described later in this section), but instead allows preview of the 
entire source video/audio. 

When Internal Clip Player is selected in order to play *.avi files, only Play and Stop are available until Scrub 
Mode is made active. 
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Scrub Mode and Scrub Slide Box 
When Internal Clip Player is selected, Scrub Mode allows *.avi file to be easily previewed, and provides 
quick access to any frame.  The slide box is similar in operation to the Jog/Shuttle control found on VTRs 
and DDRs. 

 

Scrub Slide Box and Scrub Mode Button 

To enable Scrub Mode: 

1. Click the Scrub button.  The Scrub name on the button turns blue . 

2. Use the mouse to drag the Scrub slide box to play through the video or audio. 

Scrub Mode should be active only when previewing and editing video.  Scrub Mode should be disabled 
before playing video to air in order to avoid video artifacts at the beginning of playout.  To disable Scrub 
Mode: 

 Click the Scrub button.  The Scrub name on the button turns black .  Note that the slide box 
cannot be moved when Scrub Mode is disabled. 

The following points also apply to Scrub Mode: 
 When Scrub Mode is disabled (not active), only Play and Stop in the Transport Controls are 

available.  GoTo and In Point/Out Point Go To are not available. 

 When Scrub Mode is enabled, all Transport Controls, GoTo and In Point/Out Point Go To 
become available.  In addition, Scrub Mode Enabled is displayed on a red Status Bar.  

 Scrub Mode is automatically disabled when the Play Clip function in the Clip Control Panel is 
executed. 

Scrub Mode does not apply to Audio Hardware, Aprisa DDR or external playback devices.  The Scrub slide 
box, however, can be used to preview Aprisa Clips or material from external playback devices.  

 If Previewing an Aprisa Clip:  After moving the Aprisa Clip to a new position, the slide box returns 
to the center position. 

 If Previewing Material from an External Playback Device:  After moving the source material to a 
different frame, click the Stop icon or select Stop from the Clip menu.  The slide box returns to the 
center position. 

Source Type, Load, Browse 
The procedure for selecting video/audio to play back from the Clip Control Panel depends on the playback 
device that has been selected: 

 If Internal Clip Player is Selected:  In the AVI File field, enter a file path and name of a video file.  
Click the Load button to open and load the file. 

An *.avi file can also be selected and loaded using the Browse feature, described ahead in this 
section. 

 If Audio Hardware is Selected:  In the Wave field, enter a file path and name of an audio file.  Click 
the Load button to open and load the file.  Note that Audio Hardware refers to the onboard audio 
card currently in use in the Duet system. 

A *.wav file can also be selected and loaded using the Browse feature, described ahead in this 
section. 
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The following should be considered when playing audio files through the Clip Control Panel. 

o All Windows® alarms, system beeps and other system sounds should be disabled in 
whichever utilities and other applications that might trigger them.  If they are not disabled, the 
sounds could be included in the production's sound mix! 

o Lyric cannot stretch or contract audio clips on the Timeline.  Audio clips can only be moved 
to a different position along the Timeline. 

o Beware of programming a Lyric composition to play two audio clips in rapid succession, or to 
repeat the same audio clip too quickly.  The characteristics of the Duet's sound card and its 
drivers determine how quickly a *.wav file can be loaded and played following the playout of 
another *.wav file. 

 If Aprisa DDR is Selected:  In the Event # field, enter a number of a video event that is available 
from the Aprisa DDR.  Note that the Aprisa DDR application must be open on the Aprisa DDR to 
enable playback. 

The Browse feature available in the Clip Control Panel is not available to navigate to and select 
Aprisa clips.  Thumbnails and information about Aprisa clips, however, can be viewed in the Lyric 
Browser, although they cannot be loaded into the Clip Control Panel from the Browser. 

Refer to Aprisa Interface Configuration, Aprisa Systems, Browser Overview, Aprisa Clip Asset 
Operations and Aprisa documentation for comprehensive information on Aprisa operations. 

 If a VTR or DDR Controlled by BVW-75 Serial Protocol is Selected:  Use the transport controls to 
cue the tape to the beginning of the material.  Refer to External VTR and DDR Systems, RS-422 
Serial I/O & GPI/O Board, Configuration for External Device Control and the documentation for 
the playback device for additional information on these systems. 

An *.avi or *.wav file can also be selected and loaded using the Browse feature, which provides the ability to 
navigate to and select a file for loading. 

1. Click the Browse button.  The dialog box that is displayed when Browse is clicked depends on the 
selected playback device.  For example: 

o If Internal Clip Player is selected, the Select AVI File dialog box is displayed. 

o If Audio Hardware is selected, the Select Audio File dialog box is displayed. 

2. Navigate to and select a file. 

3. Once the file is selected, click OK.  The file is loaded into the clip player. 

To reload the previously loaded clip: 
 Click the Load button. 

AVI Properties 
When an clip file containing playback information for an *.avi file is loaded, then the *.avi file, the associated 
file containing the *.avi file's alpha (key) component and any associated audio files are loaded as well.  For 
the Internal Clip Player to recognize the files as associated, they must share the same name and reside in the 
same directory.  For example, the following files are associated:  Sports_Intro.avi, Sports_Intro.matte.avi, 
Sports_Intro.a1.wav and Sports_Intro.a2.wav.  They correspond to the video, key, left audio and right audio 
files.  The *.avi file and the associated key file must be of the same duration.  If not, Lyric adjusts the duration 
of the shorter file accordingly. 

When using the Internal Clip Player to play back AVI files, configuration parameters must be set.  The AVI 
Properties configuration differs slightly between a DigiSuite LE and a DigiServer clip player.  To access AVI 
Properties: 

 Click the radio button directly to the right of the AVI field. 

 

Accessing AVI Properties 
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The AVI Properties dialog box opens. 

 

AVI Properties 

Key Delay, Audio Delay and Loop Frame are available to both types of clip players.  The MPEG and DV 
radio buttons are available to only the DigiServer board. 

To apply AVI Properties settings: 
 Click the OK button. 

Key Delay, Audio Delay, Loop Frame - AVI Files Only 

A file can be composed of a number of separate components: 
 Video:  This is the file that contains the video information.  The format is *.avi file. 

 Matte:  This is the file that contains the Key information.  The format is *.matte.avi. 

 Audio:  There can be one or two audio files, depending on if the audio is mono or stereo.  The 
formats are *.wav, *.a1.wav and/or *.a2.wav. 

Note that the Video and Alpha components of a Key signal originating from the Internal Clip Player are likely 
to have been created separately.  Video and Alpha components are always separate files playing back 
simultaneously from the Internal Clip Player.  It may be desirable to delay or advance playout of one or both 
files to compensate for slight differences between their start times and durations. 

In the AVI Properties dialog box, the following playback parameters can be set: 
 Key Delay:  If the Key Delay is set to a positive number, the Matte file starts playing the specified 

number of frames later than the Video file starts to play.  If the Key Delay is set to a negative 
number, the Matte file starts playing the specified number of frames before the Video file starts to 
play.  Default value is 0, which specifies that the Matte file starts playing simultaneously with the 
Video file. 

 Audio Delay:  If the Audio Delay is set to a positive number, the Audio file(s) starts playing the 
specified number of frames later than the Video file starts to play.  If the Audio Delay is set to a 
negative number, the Audio file(s) starts playing the specified number of frames before the Video file 
starts to play.  Default value is 0, which specifies that the Audio file(s) starts playing simultaneously 
with the Video file. 
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 Loop Frame:  When Loop is enabled (checked) on the Clip Control Panel, the Loop Frame 
specifies the frame to which the playback loops after it reaches the end of the animation.  The default 
value is 0, which specifies that playback loops back to the beginning of the animation.  The minimum 
number of frames that can be looped to from the end of a clip is 15.  Output is unpredictable if the 
loop frame is set to fewer than 15 frames from the end of the clip. 

CODEC Type - DigiServer Clip Player Only 

Two compression codecs are available to the DigiServer clip player for playback and recording:  Digital 
Video (DV) or Motion (MPEG-2).  To select a codec: 

 Click the MPEG or DV radio button. 

Note that only the files formatted in the selected codec can be played on the DigiServer clip player. 
 If MPEG is selected, DV files and M-JPEG files cannot be played. 

 If DV is selected, MPEG-2 files and M-JPEG files cannot be played.  In addition, files recorded using 
DV or DV-25 compression must be played back on a DigiServer DV-25 clip player.  Files recorded 
using DV-50 compression must be played back on a DigiServer DV-50 clip player. 

 The codec set in the Clip Control Panel is independent of the format set in the Internal Clip 
Recorder Panel. 

The MPEG and DV radio buttons are unavailable (grayed out) for DigiSuite LE clip players, as they support 
only M-JPEG video files. 

Latency 

Since the exact load time for a clip depends on a variety of factors, it may be necessary to slightly delay the 
start of an animation so that the animation and the clip are in sync.  To set this delay: 

 In the Latency spin control box, set the number of milliseconds that the animation is to be delayed. 

It may take experimentation to arrive at the optimal Latency value, as clip load time can depend a variety of 
factors including the type of CPU and the type of clip player. 

 The default Latency for DigiSuite LE clip players is 200ms. 

 The default Latency for DigiServer clip players is dependent on a registry key indicating how fast the 
Matrox Switcher switches.  If this value has not been set by the user, the Latency defaults to 
1000ms. 

Range:  0 - 2000ms 

Clear 
The Clear function allows the output of the currently selected clip player to be quickly purged of images 
remaining from previously loaded clip files.  To clear the clip player output: 

 Click the Clear button. 

To clear the clip player output channel and the Duet output channel: 
 Press Alt + Erase (Duet keyboard) or Ctrl + Alt + Q (PC keyboard). 
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In and Out Points, Play to End, Loop 
As mentioned earlier in this section, recording a clip file saves information about how to play back the clip, but 
not the video file itself.  Included in the information are the In and Out Points, and instructions on when to 
stop the clip.  These parameters are set in the In Point and Out Point areas of the Clip Control Panel. 

 

Setting In and Out Points 

In Point, Out Point, Play to End and Loop are available as follows: 
 When Internal Clip Player is selected to play *.avi files, but only when Scrub Mode is active. 

 When Aprisa DDR is selected to play back Aprisa Clips, or an RS-422 protocol external VTR or 
DDR is selected to play back video.  Loop is not available for either the Aprisa DDR or other external 
systems. 

 In Point, Out Point and their related parameters are not available when Audio Hardware is selected 
to play back *.wav files.  An audio file saved as a clip is always played back at its full length. 

To set In Point, Out Point, Play to End and Loop: 
1. In the In Point area, use one of the following methods to move the video source to the desired In 

Point: 

 Use Scrub Mode. 

 Use the Transport Controls to move the video to the desired frame.  Remember that when 
Internal Clip Player is selected as the playback device, Scrub Mode must be active in order 
to have complete access to the Transport Controls and to the In Point and Out Point 
parameters. 

 Enter a frame number in the frame counter, and then click Go To or select Go to Timecode 
from the Clip menu. 

Note that on Duet LE/PCI systems, video clips must begin playback at Frame number 0 of the 
animation.  This restriction does not apply to Duet SD/LEX/PCI+ systems. 

2. Click Mark or select Mark In from the Clip menu. 

3. In the Out Point area, use one of the methods just described to move the video source to the desired 
Out Point.  Remember to click Go To, or the Out Point will revert to the previously selected Go To 
frame. 

4. Click Mark or select Mark Out from the Clip menu. 

5. Optional:  Select (check) Play to End to override the Out Point setting.  The loaded file or other 
video source plays from the Mark In frame to the end. 
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6. Optional (Internal Clip Player playout only):  Select (check) Loop to enable looping.  After the clip 
plays to the specified Out Point or the end, it loops back to the frame set as the Loop Frame in the 
AVI Properties dialog box.  If no loop frame is set, the clip loops back to the beginning of the clip.  
When Loop is enabled, the clip plays indefinitely until stopped, unless it has been added to a 
Timeline.  In this instance, it plays for the duration set on the Timeline.  Adding a clip to a Timeline 
is covered later in this section.  Loop is available only to *avi files played on the Internal Clip Player. 

Play Clip 
The clip can be previewed by using the Play Clip function, which plays only the clip as set by the marked In 
Point and Out Point, as opposed to the entire length of the file or video source.  The clip file (*.ccf) need not 
be saved first to preview a clip using the Play Clip function.  To play back a clip: 

 Click the Play Clip button. 

o On Duet LE/PCI systems, clips must begin playback at Frame number 0 of the animation.  
This restriction does not apply to Duet SD/LEX/PCI+ systems. 

o When Play Clip is used to play an audio file, it always plays the entire file. 

o Scrub Mode is automatically disabled when the Play Clip function in the Clip Control Panel 
is executed. 
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Previewing, Creating and Playing a Clip 

Overview 
Clip Control Panel operation is similar for each device that is selected.  The following examples demonstrate 
the slight differences in clip playback and marking the In Point/Out Point.  Once a video/audio has been 
marked as a clip, the clip information can be saved as a separate file, and/or it can be added to the Timeline 
of a Lyric composition and saved as a component of a Lyric message.  Refer to Clip Control Panel for 
details.  

Internal Clip Player - AVI File 
To play back and mark an *.avi file: 

1. Select Internal Clip Player from the Device drop-down list box at the top of the Clip Control Panel.  

2. Use the Browse function to locate and select the file, and then click Open.  The filename appears in 
the AVI File field. 

OR 

Enter the filepath and filename directly into the AVI File field, and then click Load. 

3. Click the Scrub button to enable Scrub Mode, and then experiment with the Transport Controls:  
Play, Stop, Rewind, Fast Forward, Next Frame and Previous Frame.  Also experiment with the 
Clip menu controls:  Play, Stop, Rewind, Fast Forward, Next Frame, Previous Frame, Go To 
Beginning, Go to End and Go to Timecode.  Press the > or < keys to advance or move back the 
animation one frame at a time. 

4. In the In Point area, enter a frame number, click Go To and then click Mark, or select Mark In from 
the Clip menu. 

5. In the Out Point area, enter a frame number, click Go To and then click Mark, or select Mark Out 
from the Clip menu. 

6. To experiment with the Loop function, click the Loop checkbox.  Click Play Clip or select Play Clip 
from the Clip menu, and the clip material repeats indefinitely. 

7. The clip can loop back to a different frame.  Click the AVI radio button, set a Loop Frame and then 
click OK.  Click Play Clip or select Play Clip from the Clip menu, and observe the change in 
playback. 

Video (*.avi) files that are to be used as source material for clips can be previewed outside of Lyric by using 
media player software that is available from within Windows. 

 From Windows Explorer or My Computer, navigate to the video file, and then double-click the file.  
Depending on the available software, the file might play immediately, or if a player interface is 
displayed, from which the file can then be played. 

Note that even though the media player can display the video, the Internal Clip Player will not be able to play 
back the file if the codec is incompatible. 

From within Lyric, an *.avi file can be previewed using the Transport Controls available to that playback 
device type (Internal Clip Player or Audio Hardware).  If, however, an Internal Clip Player is installed in the 
system, but an output monitor is not available, the video file can be viewed from within Lyric if a Windows-type 
media player is available. 

1. Select Internal Clip Player as the Playback Device. 

2. Enter the name of a video file in the AVI File field and then click Load, or use Browse to navigate to 
and select the video file. 

3. Select Audio Hardware as the Playback Device. 

4. Click Play or select Play from the Clip menu.  A Windows-type media player should open, from which 
the file can then be played. 
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Note that the media player is external of Lyric, and a clip cannot be set up by using the Transport Controls 
on the media player.  In addition, even if the media player can display the video, the Internal Clip Player will 
not be able to play back the file if the codec is incompatible. 

Audio Hardware - WAV File 
To play back a *.wav file from the Clip Control Panel: 

1. Select Audio Hardware from the Device drop-down list box at the top of the Clip Control Panel.  

2. Use the Browse function to locate and select the file, and then click Open.  The filename appears in 
the Wave field. 

OR 

Enter the filepath and filename directly into the Wave field, and then click Load. 

3. Experiment with the Transport Controls:  Play, Stop, Rewind.  Also experiment with the Clip menu 
controls:  Play, Stop and Rewind. 

There is no need to mark an audio clip, as the entire audio file is always played back when Play Clip is 
executed. 

Audio files that are to be used as source material for clips can be previewed outside of Lyric by using media 
player software that is available from within Windows. 

 From Windows Explorer or My Computer, navigate to the audio file, and then double-click the file.  
Depending on the available software, the file might play immediately, or a player interface is 
displayed, from which the file can then be played. 

Aprisa DDR - Aprisa Clip 
To play back and mark an Aprisa Clip: 

1. Make sure that the Aprisa application is open on the Aprisa system, and then select Aprisa DDR 
from the Device drop-down list box at the top of the Clip Control Panel.  

2. Enter an Aprisa Clip ID Number in the Event # field., and then click Load.  Remember that the 
Lyric Browser can be used to view thumbnails and information about the available Aprisa Clips, 
although it cannot be used to load a clip. 

3. Experiment with the Transport Controls:  Play, Stop, Rewind, Fast Forward, Next Frame, 
Previous Frame.  Also experiment with the Clip menu controls:  Play, Stop, Rewind, Fast Forward, 
Next Frame, Previous Frame, Go To Beginning, Go to End and Go to Timecode.  Press the > or 
< keys to advance or move back the animation one frame at a time. 

4. Experiment with the Scrub slide box to move the advance or back up the video.  The slide box is 
similar in operation to the Jog/Shuttle control found on VTRs and DDRs.  After moving the Aprisa 
Clip to a new position, the slide box returns to the center position. 

5. In the In Point area, enter a frame number, click Go To and then click Mark, or select Mark In from 
the Clip menu. 

6. In the Out Point area, enter a frame number, click Go To and then click Mark, or select Mark Out 
from the Clip menu. 

7. Click the Play Clip button or select Play Clip from the Clip menu to play the marked clip. 
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External Playback System 
To play back and mark a clip from an external source: 

1. Select  the external device from the Device drop-down list box at the top of the Clip Control Panel.  

2. Experiment with the Transport Controls:  Play, Stop, Rewind, Fast Forward, Next Frame, 
Previous Frame.  Also experiment with the Clip menu controls:  Play, Stop, Rewind, Fast Forward, 
Next Frame, Previous Frame, Go To Beginning, Go to End and Go to Timecode.  Press the > or 
< keys to advance or move back the animation one frame at a time. 

3. Experiment with the Scrub slide box to move the advance or back up the video/audio.  The slide box 
is similar in operation to the Jog/Shuttle control found on VTRs and DDRs.  After moving the 
video/audio to a new position, click the Stop button or select Stop from the Clip menu.  The slide box 
returns to the center position. 

4. Experiment with the Go to Timecode function on the Clip menu.  Enter a frame number in any of the 
frame counters, and then select Go to Timecode from the Clip menu.   

5. In the In Point area, enter a frame number, click Go To and then click Mark, or select Mark In from 
the Clip menu. 

6. In the Out Point area, enter a frame number, click Go To and then click Mark, or select Mark Out 
from the Clip menu. 

7. Click the Play Clip button or select Play Clip from the Clip menu to play the marked clip. 
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Saving/Recalling a Clip File, Clip Behavior in Lyric 
Tools Menu > Clip Control Panel > Save, Recall 
The parameters that govern playback of the clip, such as the Start/End Points, are saved in a Clip file and 
recalled for future use.  A Clip (*.ccf) file is independent of the Lyric composition that was currently open 
which it was created. 

Saving a clip as a *.ccf file is necessary only when it is to be used in more than one Lyric message.  A clip 
can also be saved as a component of a Lyric composition when the message is saved in the *.lyr format.  
When the Lyric message is read, the Clip settings are displayed in the Clip Control Panel. 

The source video and/or audio itself is not saved.  In order to play back the clip, the source video and/or audio 
and the playback device must be available, whether it is external, from a DDR or VTR, or internal, from Duet's 
Internal Clip Player or audio hardware. 

Saving a Clip File 
To set and save a clip: 

1. Set In Point, Out Point and other parameters for the clip.  

2. Click Save.  The Save As dialog box is displayed. 

 

Saving a Clip File 

3. Navigate to the desired directory in the Save In drop-down list box, and then select Clip Files (*.ccf) 
from the Save as Type drop-down list box.  Enter a file name in the File Name field, and then click 
OK. 

All clip files are saved in the *.ccf format, without regard to the type of source material or the type of playback 
device.  If the clips in the selected directory play back material from different devices or are saved in more 
than one codec, it is recommended that the device type, and if applicable, codec type, be included in the file 
name. 

To quickly record a Clip file: 
1. Press Ctrl + Record.  The Record Only: dialog box opens. 

2. Select Clip (.ccf). 

3. Click Record.  The Clip settings are saved to the current Message Number in the Default Clip Files 
Directory. 



Lyric User Guide 

 26-30 

A Hotkey combination can also be used to record the Clip settings: 
 Press Ctrl + Record C Enter.  The Clip settings are saved to the current Message Number in the 

Default Clip Files Directory. 

To record a clip as part of a Lyric message: 
 Record the Lyric message in the normal manner.  Saving the Lyric message retains all information 

necessary for the clip to run with the animation. 

Recalling a Clip 
A clip saved to the Duet can be recalled and played back from the Clip Control Panel.  Make sure that the 
source video/audio and the playback device are available. 

When a clip that controls playback of an *.avi file is recalled, the *.avi file is loaded, and the associated matte 
and audio files are loaded for simultaneous playback.  For example, the following files would also be loaded 
when Basketball.avi is loaded:  Basketball.matte.avi, Basketball.a1.wav and Basketball.a2.wav.  For these 
files to be loaded, they must reside in the same directory as the *.avi file. 

When a clip that controls playback of an Aprisa DDR or an external device is recalled, no files are loaded.  If 
the source material happens to contain audio, it can be fed to an audio mixer or other audio device. 

1. Click the Recall button on the Clip Control Panel.  The Open dialog box is displayed. 

 

Recalling a Clip File 

2. Navigate to the desired directory in the Look In drop-down list box, and then select Clip Files (*.ccf) 
from the Files of Type drop-down list box.  Enter a file name in the File Name field, and then click 
OK.  The source material is loaded or cued up, and the clip settings are displayed in the Clip Control 
Panel. 

Opening/loading a clip file that loads a video (*.avi) file, also loads the associated Matte (Key) and audio 
file(s) if they are available.  If the *.avi file and the associated Matte file are not of the same duration, Lyric 
adjusts the duration of the shorter file accordingly.  When the clip file is played, the associated files play 
simultaneously. 
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Clip Behavior in Lyric 
As of Lyric v5.0, the first frame of a clip is not displayed in output when a message containing a clip is loaded.  
When the message is executed, the clip starts playing and is then visible on output. 

To change default behavior so that the first frame of the clip is displayed on output when the message is read: 
1. Navigate to file in which Lyric is installed. 

2. Double-click on the file DisableMatroxSourceSwitcher.reg. 

Displaying the first frame of the clip was the default behavior of messages read in versions of Lyric predating 
Lyric v5.0.  Note that clips contained in messages created in these earlier versions behave according to the 
current default setting in Lyric v5.0 when read. 

To revert back to the default behavior for Lyric v5.0: 
1. Navigate to file in which Lyric is installed. 

2. Double-click on the file EnableMatroxSourceSwitcher.reg. 
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Clip Timeline Operations 

Adding a Clip to the Timeline 
A clip can be added to a Lyric Timeline and executed as a component of a Lyric animation.  A clip is not a 
typical Lyric object, in that it does not appear on the Canvas, nor can it be animated as an object.  Unlike 
external-source video such as that which is fed to a Lyric Video Region (Duet SD), the clip cannot change 
scale, position, etc.  To add a clip to a Timeline: 

 If not already loaded, load the clip from the Clip Control Panel.  Click the TLine Add button or select 
Add Timeline Clip from the Clip menu.  An Object Timeline for the clip appears on the Timeline.  
The object is also added to the Scene Graph.  A clip from an AVI file, WAV file, Aprisa DDR or 
external BVW-75-protocol playback device can be added to the Timeline.  Remember that the 
playback device must be available to the Duet system when the message is played back!!!  

 

Adding a Clip to a Timeline 

A Clip with a Start Time of 0, 1 or 2 frames always starts at Frame 0 when the animation is executed.  A Clip 
with a Start Time of 3 or higher executes at the specified frame. 
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Editing and Updating the Clip on the Timeline 
Clip parameters can be modified in the Clip Control Panel and then updated on the Timeline.  To update the 
Timeline for the clip: 

1. Select (highlight) the clip on the Timeline or in the Scene Graph. 

2. Make the modifications to the clip. 

3. Click the TLine Update button.  The Clip Timeline is updated with the new information. 

To discard the modifications: 
 Recall the unmodified clip and execute TLine Update again.  The Timeline is updated with the 

earlier version of the clip information. 
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Recording Video/Audio to Video/Audio Files 
Tools Menu > Clip Control Panel > Record 

IMPORTANT!!! 
The Internal Clip Player offers a variety of input/output and encoding/decoding options.  
Ensure that Matrox DigiUtils, accessed from Start > Settings > Control Panel, has been 
properly configured for your requirements, and that video/audio sources and outputs are 
properly cabled to the clip player and to the system.  Refer to Matrox documentation for 
detailed information on hardware setup and configuration. 

Overview 
The Internal Clip Recorder enables the Internal Clip Player to record input Video, Key and/or Audio files to 
standard animation and audio file formats.  The Internal Clip Recorder does not record embedded audio.  
The audio file(s) are instead recorded to a separate file(s). 

NOTE 
If a DigiSuite LE internal clip player is installed in a system, and digital video/key/audio 
are to be recorded, then the source must be connected to the Digital LE Module of the 
DigiSuite LE clip player.  If analog video/key/audio are to be recorded, then the source 
must be connected to the inputs of the DigiSuite LE clip player.  Note, however, that on a 
Duet system, only a Lantern-64-A (analog) board can input analog video and analog key.  
Only Duet LE/LEX/PCI/PCI+ systems support Lantern 64-A boards. 

The DigiServer clip player supports only digital video/key/audio input and output. 

The files recorded using the procedures described in this section are not the same types of files that are 
recorded from the Clip Control Panel (*.ccf).  The files recorded from the Internal Clip Recorder are 
standalone files that can be played through Lyric or other software. 

Files recorded directly from the Clip Control Panel contain only information about how the clip should be 
played back, and not the source files themselves. 

From the Clip Control Panel, the Internal Clip Player can simultaneously play back a video file, a Matte file 
and one stereo or two monaural audio files.  If recording these files for simultaneous playback, they must all 
be given the same names and reside in the same directory.  If audio files are to be played back, the name of 
the directory in which they are stored cannot contain a period ".", or else the audio file will not play back. 

When a clip that controls playback of an *.avi file is recalled, the *.avi file and the associated Matte and audio 
files are loaded for simultaneous playback.  For example, the following files would be loaded when 
Basketball.avi is loaded:  Basketball.matte.avi, Basketball.a1.wav and Basketball.a2.wav. 

Refer to Clip Control Panel for details on recording Clip (*.ccf) files. 

NOTE 
Files recorded through the Internal Clip Player should be recorded to SCSI drives to 
ensure proper playback. 
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About Video, Key and Audio Sources 
Video - Insert Video vs. Key (Alpha)  
A full video signal is comprised of two components:  Insert Video and Key.  Both must be recorded to Video 
and Key (also known as Matte) files, respectively, in order to reconstitute Video and Key for use in Lyric.  
The figure below represents the relationship between Video (i.e., Insert Video) and its Key (Alpha) 
component. 

 

Insert Video Component 

 

Key Component 

Analog Video and Key can be recorded from a number of source types:  Composite 1, Composite 2, Y/C 
(S-Video) 1, Y/C (S-Video) 2 and Component sources.  Recording analog Video and Key is supported by a 
DigiSuite LE clip player.  It is not supported by a DigiServer clip player.  To record analog Video and Key, the 
Composite, S-Video or Component signal(s) must be input to the appropriate connectors on the DigiSuite 
LE clip player multi-cable Analog Video connector.  In addition, the Matrox DigiSuite utility, accessed from 
Start > Settings > Control Panel > DigiSuite, must be properly configured. 
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To record digital Video and Key, an SDI Video source must be connected to the digital video input of the 
Digital LE Module of the DigiSuite LE clip player, or to the digital video input on the DigiServer clip player.  In 
addition, the Matrox DigiSuite utility, accessed from Start > Settings > Control Panel > DigiSuite, must be 
properly configured. 

Refer to Internal Clip Player - Hardware and Connections for information on proper cabling, and to Matrox 
documentation for information on proper input/output configuration. 

NOTE 
Video and key (matte) files are recorded in two separate operations.  The type of 
video/key (matte) AVI file that is recorded is determined by the type of clip player from 
which it was recorded, and, on the DigiServer clip player, the codec that is currently 
selected. 

 If the video/key file is recorded from a DigiSuite LE clip player, then the resulting 
file is an M-JPEG AVI file. 

 If the video/key file is recorded from a DigiServer clip player, and DV is the 
currently selected codec in the Clip Control Panel, then the resulting file is a DV 
AVI file.  The codec can also be changed to MPEG-2 in the Internal Clip Recorder 
Panel. 

 If the video/key file is recorded from a DigiServer clip player, and MPEG is the 
currently selected codec in the Clip Control Panel, then the resulting file is an 
MPEG-2 AVI file.  The codec can also be changed to DV in the Internal Clip 
Recorder Panel.  IMPORTANT!  DV and DV-25 *.avi files can be recorded and 
played back using only a DigiServer DV-25 clip player.    DV-50 *.avi files can be 
recorded and played back using only a DigiServer DV-50 clip player. 

Audio 
The Internal Clip Player can record and play back audio.  The DigiSuite LE clip player has analog and digital 
audio processing capability.  The DigiServer clip player has digital audio processing capability only.  Refer to 
Audio and the Internal Clip Player for details on audio configuration and operations. 

 To record analog audio using the DigiSuite LE clip player, an analog audio source must be connected 
to the audio input(s) of the DigiSuite LE clip player.  The DigiServer clip player does not support 
analog audio.  In order to record analog audio using a DigiServer clip player, the analog audio source 
must converted to digital prior to connection to the audio input of the DigiServer clip player. 

 To record digital audio, the audio source must be connected to the digital audio input of the Digital LE 
Module of the DigiSuite LE clip player, or to the digital audio input of the DigiServer clip player.  In 
order to record analog video using a DigiServer clip player, the analog video source must converted 
to digital prior to connection to the video input of the DigiServer clip player. 

For additional information on audio operations, refer to Audio and the Internal Clip Player. 

Internal Clip Recorder Parameters and Controls 
Overview 
Before recording, ensure that the external video/audio source(s) is producing a signal(s).  If the VPB or PCI-
Squeezeback board is correctly configured for display of external video, the video source should be visible on 
the Duet video output.  Refer to Configuration for Display of Video Source - Duet SD or Configuration for 
Display of Video Source - Duet LE/LEX/PCI/PCI+ for information on displaying external video. 
Composite analog output from the DigiSuite LE clip player or the DigiServer clip player can be displayed on 
an additional monitor.  Audio can be monitored from a speaker or headphone plugged into the 3/4" output 
from the DigiServer clip player, or from an XLR output from either clip player. 

To access the Internal Clip Recorder Panel: 
1. From the Tools menu, select Clip Control Panel.  The Clip Control Panel opens. 

2. Select Internal Clip Player from the drop-down list box at the top of the Clip Control Panel. 

3. Click the Record icon  located towards the top right of the Clip Control Panel. 
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Accessing the Internal Clip Recorder 

The Internal Clip Recorder Panel opens.  The following figure shows the appearance of the Internal 
Clip Recorder Panels for the DigiSuite LE (left) and DigiServer (right) clip players 

 

Internal Clip Recorder - DigiSuite and DigiServer 

There are slight differences between the two Internal Clip Recorder Panels., which are explained in the 
following paragraphs.  Both panels are shown with video and audio recording enabled. 
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Format/Video Standard 
The file format to which a video or key file is to be recorded is indicated at the top right corner of the Internal 
Clip Recorder Panel.  The format is determined by the following: 

 If recording  using a DigiSuite LE clip player, then the file format is always set to M-JPEG. 

 If recording using a DigiServer clip player, then the file format reflects last format selected in the 
Select Format area in the Internal Clip Recorder Panel.  This setting is independent of the codec 
that is set for playback in the Clip Control Panel. 

The Video Standard is also displayed at the top right corner of the Internal Clip Recorder Panel.  In the 
preceding figure, the Video Standard is NTSC.  The Video Standard cannot be changed in this dialog box.  
It is determined by the Video Standard that is set in the Matrox software for the clip player. 

Each format offers various compression options for recording, which are covered later in this section. 

Control 
There are three Transport Controls:  Play, Stop and Record.  As the source is recording, the Frame 
Number and the total number of frames in the material to be captured are displayed in the Frame Counter 
fields.  The total number of frames is determined by the Capture Duration, also set in the Internal Clip 
Player dialog box. 

Video 
Video (Key) Source type and video (key) file name are set in the Video area.  Video and key are recorded 
separately.  Generally, video would be fed to an input and recorded, and then key would be fed to the same 
input, and then recorded. 

 The Video (Key) source types that can be recorded depend on the type of Internal Clip Player that is 
installed in the system. 

o If a DigiSuite LE clip player is installed, the following Video (Key) sources are available:  
Composite 1, Composite 2, Y/C (S-Video) 1, Y/C (S-Video) 2, Analog Component, and 
4:2:2 SDI. 

o If a DigiServer clip player is installed, the Video (Key) Source is already set to Digital SDI 1 
Digital Input, as it is the only video that is accepted for recording.  The Video Source drop-
down list box is grayed out,  

Refer to Internal Clip Player - Hardware and Connections for information on proper cabling for 
each type of Video Source.  Refer to Matrox documentation for information on proper input 
configuration. 

 The name of the video (key) file to which the video (key) is to be recorded is entered in the Video 
Filename field.  If overwriting or adding to an existing file, the file can be located using the Browse 
function.  If video assets from both types of clip players and/or multiple codecs are stored together, it 
is recommended that the file name include identifying information.  For example a file saved in an 
MPEG-2 codec could be named News_Intro_MPEG2.avi or News_Intro_MPEG2.matte.avi.  This 
name would identify it as a file that could be played back only from a DigiServer clip player. 

Files should be recorded to a SCSI drive to ensure proper playback from the clip player. 
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Audio 
Audio can be recorded in the *.wav format from the Internal Clip Player.  Note that the audio is not embedded 
in a video file, but rather, recorded to audio-only files. 

 The (48 kHz) indicates the digital audio type supported by clip recording.  This value cannot be 
changed. 

A DigiSuite LE clip player can simultaneously record left and a right monaural *.wav files from an analog 
source input to the clip player. There are two file name fields displayed in the Internal Clip Recorder Panel 
when a DigiSuite LE clip player is installed and the clip player is configured for analog audio input: 

 The left analog audio file is recorded from the IN 1 XLR input of the DigiSuite LE clip player.  The 
name of the left channel audio file to which the left channel audio is to be recorded is entered in the 
Left Filename field.  If overwriting or adding to an existing file, the file can be located using the 
Browse function.  The resulting recorded file is a monaural *.wav file. 

 The right analog audio file is recorded from the IN 2 XLR input of the DigiSuite LE clip player.  The 
name of the right channel audio file to which the right channel audio is to be recorded is entered in 
the Right Filename field.  If overwriting or adding to an existing file, the file can be located using the 
Browse function.  The resulting recorded file is a monaural *.wav file. 

Refer to Audio and the Internal Clip Player for information on audio configuration. 

A DigiServer clip player or a DigiSuite LE clip player/Digital LE Module can record one stereo *.wav file at a 
time from a digital source. There is one file name field displayed in the Internal Clip Recorder Panel for a 
DigiServer clip player, or a DigiSuite clip player/Digital LE Module that is configured for digital audio input: 

 The stereo audio file is recorded from the Digital Audio (AES/EBU) In 1/2 XLR input.  The name of 
the audio file to which the stereo audio is to be recorded is entered in the Filename field.  If 
overwriting or adding to an existing file, the file can be located using the Browse function.  The 
resulting recorded file is a stereo *.wav file. 

Files should be recorded to a SCSI drive to ensure proper playback from the clip player.  Refer to Internal 
Clip Player - Hardware and Connections for information about proper cabling for each type of Audio 
Source. 

Options 
 Enable Video:  Select (check) Enable Video to allow recording of external video.  If Enable Video is 

not active, the video parameters in the Internal Clip Recorder Panel are grayed out. 

 Enable Audio:  Select (check) Enable Audio to allow recording of external audio.  If Enable Audio 
is not active, the audio parameters in the Internal Clip Recorder Panel are grayed out. 

 Confirm Overwrite:  Select (check) Confirm Overwrite to display a confirmation before overwriting 
the currently selected Video, Audio, Audio Left and/or Audio Right file(s).  If the following prompt is 
displayed when executing a recording, click Yes to allow the recording to overwrite the file, or No to 
cancel the recording. 

 

Clip Recorder Overwrite Prompt 
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 Add to End:  Select (check) Add to End to append the newly recorded material to the end of the 
currently selected Video, Audio, Audio Left and/or Audio Right file(s). 

If Confirm Overwrite is selected, the following prompt is displayed before adding to the end of the 
file(s).  Select Yes to add the new material to the file, or No to cancel the recording. 

 

Clip Recorder Add to End Prompt 

If Confirm Overwrite is not enabled, the material is added to the file with out a prompt.  

Capture Duration 
The length of recording can be predetermined, or can run until the Stop icon is clicked.  To set a recording 
length: 

 Select (check) Capture Duration, and then enter the length of the recording, in frames, in the 
Frames field. 

I-Frames, B-Frames and P-Frames 
In a motion sequence, individual frames of an animation are grouped together in a GOP (group of pictures) 
and played back so that the viewer sees motion. 

The following video compression methods can be used to record an MPEG-2 animation file: 
 I-Frame (Intraframe):  An I-Frame, also known as a Keyframe, is a single frame of digital content 

that the compressor examines independently of the frames that precede and follow it.  The I-Frame 
contains all of the data necessary to display the frame.  The compressor stores this data and may use 
it to fill in missing data from the preceding and following frames.  Typically, I-Frames are interspersed 
with P-Frames and B-Frames.  The more I-Frames contained in a motion sequence, the higher the 
video quality.  I-Frames contain the highest number of bits as compared to other frames in an 
animation sequence, and therefore take up more storage space. 

 B-Frame (Bidirectional Frame or Bidirectional Predictive Frame):  B-Frames contain only the 
data, such as color or motion, that has changed from the preceding I-Frame, or that is different from 
the data in the succeeding I-Frame.  Information on static elements is not included.  The compressor 
references I-Frames to fill in the remainder of the data for the B-Frames.  Because they track only 
changes, they are also known as Delta Frames.  B-Frames almost always contain less information 
than I-Frames, and therefore require less storage space. 

 P-Frame (Predictive Frame or Predicted Frame):  P-Frames follow I-frames in a motion sequence, 
and contain only the data that has changed from the preceding I-frame, such as in color or motion.  
Information on static elements is not included.  The compressor references I-Frames to fill in the 
remainder of the data for the P-Frames.   Because they track only changes, they are also known as 
Delta Frames.  P-Frames almost always contain less information than I-Frames, and therefore 
require less storage space. 

MPEG-2 Profiles and Luminance/Chrominance Sampling 
When recording video, a variety of options are available, such as format, Data Rate and MPEG-2 Profile.  
The MPEG-2 Profile determines the pixel sampling rate of Luminance (Y) vs. Chrominance (Cr, Cb)  The 
human eye is much more discerning when perceiving Luminance (grayscale) information, than it is with 
Chrominance (color) information; therefore, Chrominance can be sampled less frequently than Luminance, 
with a virtually imperceptible effect on the video. 

Due to the eye's sensitivity to Luminance, all digital formats available for recording within the Internal Clip 
Recorder Panel sample each pixel for Luminance during the recording process. 
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There is, however, leeway with regard to Chrominance sampling.  Depending upon the final use of the 
recorded video, or if storage space is at a premium, Chrominance can be sampled at a rate as low as one 
pixel for every four pixels sampled for Luminance.  Chyron recommends that to record graphics for 
broadcast, the lowest available Chrominance to Luminance ratio be selected. 

There are three MPEG-2 Profiles available to the Internal Clip Recorder.  The figures showing MPEG-2 
Profiles use the following legend:  

 Y, Cr and Cb are sampled. 

 Y only is sampled. 

 Cr and Cb only are sampled. 

 and  each represent a single pixel.   is a special case that is explained in the paragraphs covering 
4:2:0. 

4:1:1 

Luminance (Y) is sampled in every pixel, and Chrominance (Cr and Cb) is sampled in every fourth pixel. 

 

4:1:1 Pixel Sampling 

4:1:1 sampling is applied as follows: 
 DV:  NTSC. 

 DV 25:  NTSC and PAL. 

 MPEG2:  NTSC, when Main is selected as the MPEG-2 Profile. 

4:2:0 

Luminance (Y) is sampled in every pixel, and Chrominance (Cr and Cb) is sampled as an average of every 
other pair of vertical pixels. In effect, 4:2:0 samples every other pixel in every other line. 

 

4:2:0 Sampling 

4:2:0 sampling is applied as follows: 
 DV:  PAL. 

 MPEG2:  PAL, when Main is selected as the MPEG-2 Profile. 
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4:2:2 

Luminance (Y) is sampled in every pixel, and Chrominance (Cr and Cb) is sampled in every other pixel.  4-
2-2 is recommended for recording files for broadcast graphics applications. 

 

4:2:2 Sampling 

4:2:2 sampling is applied as follows: 
 DV 50:  NTSC and PAL. 

 MPEG2:  NTSC and PAL, when 4-2-2 is selected as the MPEG-2 Profile. 

Select Format - MJPEG (DigiSuite LE Clip Player Only) 
If a DigiSuite LE clip player is used to record, the format automatically defaults to MJPEG.  The compression 
settings for the recorded MJPEG video file can be adjusted.  The Compression Ratio dictates how the 
Internal Clip Player trades off picture quality for file size.  This variable can have a significant effect on the 
appearance of the recordings produced by the Internal Clip Player.  If attempting to preserve disk space by 
using higher data compression, experiment carefully! 

When a Data Rate is entered, the Compression Ratio is automatically calculated. 

 

MJPEG Capture Settings 
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The following table shows sample settings for Compression Ratio vs. quality: 

Data Rate Compression Quality 

60 341.0:1 High compression; very low quality 

2000 (Default) 10.2:1 Default setting. 

5105 4.0:1 A lower compression rate, and a good 
starting point.  It may be necessary, 
however, to increase or decrease the 
value based on the type of material to be 
recorded and individual requirements for 
quality.  

15300 1.3:1 Almost no compression; highest possible 
picture quality on the Internal Clip Player. 

To apply settings and exit MJPEG Capture Settings: 

 Click the Close icon . 

Select Format - DV (DigiServer Clip Player Only) 
DV is recorded using the I-Frame Only process.  DV frame size is 720 X 576 for PAL, and 720 X 480 for 
NTSC.  When converting from the CCIR NTSC Video Standard (720 X 486), six lines must be cut; four lines 
from the top and two lines from the bottom.  The lines are added at the same locations when converting back 
to the CCIR NTSC Video Standard. 

If DV is selected as the recording format, the DV Capture Settings dialog box opens. 

 

DV Capture Settings 

The following Data Rates can be selected: 
 DV:  The Data Rate is 25 megabits per second.  In NTSC, the 4-1-1 MPEG-2 Profile is applied.  In 

PAL, the 4-2-0 MPEG-2 Profile is applied.  This Data Rate is supported by a DigiServer DV-25 clip 
player only. 

 DV 25:  The Data Rate is 25 megabits per second.  In NTSC and PAL, the 4-1-1 MPEG-2 Profile is 
applied.  This Data Rate is supported by a DigiServer DV-25 clip player only. 

 DV 50:  The Data Rate is 50 megabits per second.  In NTSC and PAL, the 4-2-2 MPEG-2 Profile is 
applied.  This Data Rate is supported by a DigiServer DV-50 clip player only. 

To apply setting and exit DV Capture Settings: 
 Click OK. 



Lyric User Guide 

 26-44 

Select Format - MPEG2 (DigiServer Clip Player Only) 
MPEG-2 can be recorded using the I-Frame Only or B-P-I recording process.  The MPEG-2 Profile can be 
the main profile normally used for capture, or 4-2-2, which is a higher-quality capture profile.  MPEG-2 
Capture Data Rate is also adjustable, and can be either constant or variable. 

If MPEG2 is selected as the recording format, the MPEG2 Capture Settings dialog box opens. 

 

MPEG2 Capture Settings 

To apply settings and exit MPEG2 Capture Settings: 

 Click the Close icon . 

MPEG2 Process 

The MPEG2 Process setting determines if I-Frames only or a combination of I-Frames, B-Frames and P-
Frames are used to record the file. 

 I-Frame Only:  When I-Frame Only is selected, all data in each frame is recorded.  This results in a 
high-quality, large file.  The quality of recording is determined in part by the Initial Q Factor I settings.  
B and P settings do not apply to I-Frame Only recording.  Using I-Frame Only to record a file is 
highly recommended for broadcast graphics applications. 

 I-B-P:  When I-B-P is selected, the compressor uses a combination of all three types of frames to 
record the file.  The quality of recording is determined in part by the Initial Q Factor I, B and P 
settings.  The additional compression applied when I-B-P is used to record a file is not recommended 
for broadcast graphics applications, as it can cause undesirable artifacts. 

MPEG2 Profile 

The MPEG2 Profile determines the sampling pattern used to record color and luminance information. 
 Main:  In NTSC, 4-1-1 sampling is applied.  In PAL, 4-2-0 sampling is applied. 
 4-2-2:  In NTSC and PAL, 4-2-2 sampling is applied.  4-2-2 is highly recommended for recording files 

for broadcast graphics applications. 

MPEG2 Capture Data Rate 

The type of Data Rate and the Data Rate value determine the amount of data that is recorded per second.  
The higher the Data Rate, the higher the quality of the recorded video. 

 Constant Data Rate:  A constant data rate does not adjust for an increase of data caused due to the 
complexity of the video at a particular frame.  In keeping to a constant data rate, data could be 
discarded, resulting in undesirable artifacts. 

 Variable Data Rate:  A variable data rate allows the recording process to adjust for spikes in amount 
of data that must be processed. 

 MBits/Sec:  The minimum recommended Data Rate value is 50 megabits/per second.  When 
Variable Data Rate is selected, this value becomes a target, as opposed to an absolute setting. 
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Initial Q Factor 

The Q Factor for each of the frame types (I, B, P) determines the quality of the video that is recorded.  
Range:  1 (best) to 112 (poorest).  A setting of 32 or higher generally results in poor video capture.  When I-
Frame Only is selected as the MPEG-2 Process, B and P settings do not apply.  Experiment to determine 
the optimal settings for the type of video and its intended use. 

Caution!  When I is set to 1, and the Data Rate is set to less than 15 megabits per second, there is a 
danger of encoding only half the video frame during I-Frame 4:2:2 capture.  To avoid this situation, set the 
Data Rate at a higher value. 

Recording 
To set up and execute a recording: 

1. Connect the video/audio sources as follows: 

 DigiSuite LE - Analog Video:  Connect source video to the appropriate analog video 
input(s). 

 DigiSuite LE - Analog Audio:  Connect source audio to the IN 1 and IN 2 analog audio 
inputs. 

 Digital LE Module of the DigiSuite LE - Digital Video:  Connect source video to the SDI IN 
digital video input. 

 Digital LE Module of the DigiSuite LE - Digital Audio:  Connect source audio to the IN 1/2 
digital audio input. 

 DigiServer - Digital Video:  Connect source video to the SDI/SDTI digital video input.  The 
DigiServer clip player does not support analog video input. 

 DigiServer - Digital Audio:  Connect source audio to the Digital Audio (AES-EBU) In 1/2 
digital audio input.  The DigiServer clip player does not support analog audio input. 

2. Verify that the video source is producing the desired picture, and/or that the audio source is producing 
the desired sound.  

3. Access the Internal Clip Recorder menu as describer earlier. 

4. If using a DigiSuite LE clip player to record, select a video source from the Video Source drop-down 
list box, if it not already selected.  If using a DigiServer clip player, Digital SDI Video is automatically 
selected as the video source. 

5. In the Options area near the bottom of the menu, select (check) Enable Video and/or Enable 
Audio. 

6. Optional:  Select Confirm Overwrite. 

7. Optional:  Select Add to End. 

8. Enter a file name in the Video Filename field, or browse to the file that is to be added to or 
overwritten.  The filepath should be to a SCSI drive, in order to ensure proper playback through the 
clip player. 

 If recording analog audio using a DigiSuite LE clip player, enter Left and Right Audio 
Filenames, or browse to the file(s) that is to be added to or overwritten. 

 If recording digital audio using a DigiServer clip player or a DigiSuite LE clip player/Digital LE 
Module, enter an Audio Filename, or browse to the file that is to be added to or overwritten. 
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If the audio file(s) is to be played back in conjunction with the video file, the audio file(s) should have 
the same name as the video file and be saved to the same directory as the *.avi file.  The directory 
containing the audio file(s) should not have a period "." in the directory name, as the audio file(s) may 
not play back. 

 It is not necessary to add file extensions.  When recording is completed and the files are 
saved, the system adds file extensions as follows:  *.avi for a video file; *.wav for a digital 
audio recorded on a DigiServer clip player or DigiSuite LE clip player/Digital Module; and/or 
*.a1.wav and *.a2.wav for left and right analog audio recorded on a DigiSuite LE clip player. 

 When establishing filepaths for recording through the clip player, Lyric defaults to the last 
directory used.  If a full filepath is entered on first recording to the Internal Clip Player in a 
Lyric session, then subsequent recordings made during that session are automatically saved 
to the same drive and directory. 

9. Optional:  Select (check) the Capture Duration Fixed At checkbox, and then enter the number of 
Frames to record.  Whether or not Capture Duration is enabled, recording length is limited only by 
the amount of space on the SCSI drive to which the Internal Clip Player is recording. 

 

Parameters Entered 
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10. Select and configure the format. 

11. Once setup is complete, the Record icon becomes available.  Click Record .  The Ready to 
Record prompt is displayed. 

 

Ready to Record Prompt 

12. Click OK.  The Record icon becomes grayed out, and the Frame counter starts to advance, as 
shown in the Control Area Frame field. 

 

Record in Progress 

 If Fixed At has been enabled:  When the recording has captured the designated number of 
frames, the Record operation stops.  The Frame Counter displays 0 of 0, and the Record 
icon again becomes available. 

 If the Fixed At has not been enabled:  The Frame Counter does not advance during 

recording.  Recording continues until the Stop icon  is clicked.  The Frame Counter 
updates to show the total number of fields when the file is played back by clicking the Play 
icon. 

 When new material is added to an existing file, the values shown in the Frame Counter fields 
for the entire file are updated after the new material is added. 

Playback 
Once recording has stopped, the Play icon becomes available. 

 Click Play to play back the clip and check the recording on the Duet Program Out monitor.  
Remember that playback does not appear on the Lyric Canvas as seen on the VGA monitor.  Note 
that the Play icon in this dialog box has limited function.  Any programmed and/or edited playout of 
recorded clips to air should originate from the Clip Control Panel or from within a Lyric animation.  
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Creating a Matte File 
The Matte, or Alpha layer that accompanies Insert Video must be created in a second recording process.  
The procedure for creating a matte file is similar to recording a video file. 

1. Connect the key source to the appropriate video input(s) of the DigiSuite LE clip player, the Digital 
Module of the DigiSuite LE clip player, or to the DigiServer clip player. 

2. Verify that the key source is producing the desired picture. 

3. Access the Internal Clip Recorder Panel as previously described. 

4. Select the appropriate key source from the Video Source drop-down list box. 

5. In the Options area near the bottom of the menu, select (check) Enable Video. 

6. Optional:  Select Confirm Overwrite. 

7. Optional:  Select Add to End. 

8. Enter the same file name in the Video Filename field as was just recorded, or browse to the Matte 
file that has the same file name as the recorded video, and that is to be added to or overwritten.  The 
filepath should be to a SCSI drive, in order to ensure proper playback through the clip player.  The 
Matte file should be in the same directory as the *.avi file to which it is associated.  Add ".matte.avi" 
to the File Name. 

 

Entering a Matte File Name 

9. Optional:  Select (check) the Capture Duration Fixed At checkbox, and then enter the number of 
Frames to record.  Whether or not Capture Duration is enabled, recording length is limited only by 
the amount of space on the SCSI drive to which the Internal Clip Player is recording. 

10. Once setup is complete, the Record button becomes available.  Click the Record button.  The 
Ready to Record prompt is displayed. 

11. Click OK.  The Record button becomes grayed out, and the Frame counter starts to advance.  When 
recording is complete, the video and matte file can be used together to create a clip that can be used 
in a Lyric composition. 

Refer to Clip Control Panel for details on clip editing and incorporation of clips into Lyric compositions. 
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27. Video Mixing 

Video Mixing 
Duet systems provide tremendous flexibility and control over video outputs.  With the addition of a Video 
Mixer board in Duet SD or HD systems, or CMix in any Duet family system, a composition can be richly 
layered with both static and animated Lyric graphics, and internal/external video input. 

Video Mixer - Duet SD/HD 
Tools Menu > Video Mixer 
The optional internal mixer board allows precise routing and layering of video to output.  The boards and 
setup procedures are different for the Video Mixer - Duet SD and the Video Mixer - Duet HD. 

Internal mixer functions are not currently supported on Duet LE/LEX/PCI/PCI+.  Video routing and layering 
can be accomplished by cabling and linking boards or by mixing within the optional Chyron CMix.  Refer to 
Duet Hardware - Configure Board Use and Cabling Options - Duet LE/LEX/PCI/PCI+ for information on 
linking and cabling, respectively, or CMix for information on CMix operations. 

Video Mixer - Duet SD 
Tools Menu > Video Mixer;  Canvas/Scene Graph Right-Click Menu > Video Mixer 
Click here for more information on using Duet HD mixer. 

Overview 
The SD Mixer enables selection, routing and mixing of up to three sources. Inputs may be chosen from any of 
three VGE boards, the "Program" live video input to the video I/O board, or the video input on the SD Mixer. 
Any of these three sources (but only one of the live video inputs) may be selected as the input to three layers 
in the mix being created. 

A Duet configured with the SD Mixer Board supports 2 independent video sources. Video In 1 is the input to 
Duet's Video I/O Board; Video In 2 is an extra video input, connected directly to the Mixer itself for efficient 
use of your facility's routers and other resources. The video source selected at a given time will be the only 
one available for SD Mixer operations. 
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On the Lyric interface, go to the Tools dropdown menu and select SD Mixer. The control panel opens: 

 

Video Mixer Control in Dissolve Mode 
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Video Source 
At the top of the control panel, choose the video source that will be input to the router. This can be either the 
Program Video Input or the Video In port on the SD Mixer board.  Remember, only one input may be 
selected at a time.  

Click the  button to make these adjustments: 

 

Mixer Video Settings 

 Enable Key Input if there is a Key signal with the Program In.  Otherwise, a 100% matte is 
assumed. 

 Enable Video Shaping to attenuate input video to the key signal, so that color components do not 
exceed the key level. 

Layer 1/Layer 2/Layer 3 Sliders 
The next section allows mixing of up to 3 video layers.  Each layer may draw from one video source, 
selectable via the layer's dropdown menu.  VGEs and/or PCI-Squeezeback boards (labeled Frame Buffers) 1, 
2 or 3, or the Video Input selected above may be routed into each layer.  Note that the same source may be 
routed to each of the mixer's three layers. 

Note that Layer 1 receives highest display priority in the mix, Layer 2 next highest and Layer 3, the 
background, lowest priority. 

Use the slide control for each layer to adjust the proportion of that layer's signal in the mix you are creating. 
Layers may be turned off and on without disturbing the level controls by use of the Active checkbox under 
each slider. The numerical display beneath each slider does not change dynamically with its slider's 
movement, but will show an appropriate value when the slider has been set. 

Next, skip down to the Output Router area, because you'll need to understand its controls to work with 
Effects. 
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Output Router 
The SD Mixer board outputs two video channels, represented by the controls Output 1 and Output 2. These 
outputs are connected to the Video Out BNC connectors on the back of Duet. The output of the 3 layer Mixer 
can be directed to Video Output 1, Video Output 2, or to both outputs by selecting Mix in the pull down menu. 
In addition, Video In 2 (the individual live video input to the mixer board) can be directed to one or both of the 
video outputs. Each output's dropdown menu provides these choices: 

 

Output Router 
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Effects 
The Dissolve effect is useful for performing cross-dissolves between two pages. The effect modifies the 
transparency percentages of Layer 1 and Layer 2 without affecting the Frame Buffer fade levels. 

 

Video Mixer Control - Dissolve Setup 

The default duration (shown in frames) is 100, however any value between 1 and 1000 may be entered. A 
simple dissolve can be created as follows: 

1. Click the Dissolve radio button. Note that the vertical slider in the lower half of the control panel is 
now labeled “Layer 1” at one end and “Layer 2” at the other. 

2. Set the frame buffer percentages for Layer 1 and Layer 2 to 100. 

NOTE 
Layer 3 may be turned on or off, depending on the presence of a video background in 
your composition. However, for this exercise, it is left off. Remember that the Dissolve 
effect itself only affects Layers 1 and 2. 

3. Set the router to Mix for Output 1 and Layer 2 for Output 2. These settings configure Output 1 as the 
Program output (“Air”) and Output 2 as Preview. 

Optional: If you wish, you may use the slider to manually preview the effect. 

4. Press the Test button to view the dissolve effect at actual speed. View the dissolve effect in Output 1. 
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The Preview channel will automatically change to the next frame buffer after executing the effect, thus 
allowing you to preview the next message before taking it on the Program output. 

The Fade effect modifies the fade levels of all 3 layers, allowing the user to preset these values at 
programmed Start and End points. 

 

Video Mixer Control - Fade Setup 

1. Click the Fade radio button. Note that the vertical slider in the lower half of the control panel is now 
labeled “Start” at one end and “End” at the other. 

2. Make sure to click the checkbox of each layer with which you will be working. 

3. Set the router to Layer 1 for Output 1 and Layer 2 for Output 2. 

4. With the Start-End slider at Start, set the frame buffer percentages for each layer as you wish them to 
appear at the beginning of the effect. 

5. Move the Start-End slider to End, and set the frame buffer percentages for each layer as you wish 
them to appear at the end of the effect. 

Optional: You may use the slider to manually preview the effect. Note that as the effect progresses, 
the sliders representing Layers 1 and 2 move to the opposite extremes of their programmed values. 

6. Press the Test button to view the fade effect at actual speed. View the fade effect in Output 1. 
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Cut is the default effect. When it is selected, all other controls are inactive.  

Ease Mode controls the interpolation of fade levels between the start and end frames of a dissolve. Choices 
for Ease Mode include: 

 Linear:  Maintains a constant speed during the transition. 
 Ease In: Starts the transition slowly and increases to the default speed for the rest of the transition.  
 Ease Out: Starts the transition at the default speed and slows to zero by the time the effect is 

complete. 
 Ease In/Out: Starts the transition slowly, increases speed to the default and decreases the speed to 

zero by the time the effect is complete.  

Other Controls 
Test 

: Previews the selected effect.  

Timeline Add 

: A mixer effect (dynamic or static) can be added to the current scene by clicking the Timeline 
Add button. The mixer effect appears as an object on the timeline* (as well as on the Scene Graph). By 
default, the length of the new entry will be the duration specified in the Mixer Control Panel. However, this 
value as well as the start time of the effect can be modified using Lyric 's standard Timeline editing tools 
(mouse or keypad controls). You may click "Timeline Add" more than once to add multiple mixer effects to the 
timeline as separate objects; however, the start and stop times must not overlap.   

*The Mix object is not a separate "real" object visible on the Canvas. However, inclusion of the object in the 
Timeline, Scene Graph and Keyframe Graph is how Lyric incorporates the recorded values of the Mixer 
settings into the composition. 
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Save/Recall 

and  : Dynamic effects or static mixer settings can be saved to a file by clicking on the Save 
button. The files thus created are in the customary .lyr format, and can be entered in the Lyric Playlist for 
automated playback based on timecode or other control parameters. These Lyric messages can also be read 
from the Canvas via a Message Number and the Read controls, or by opening a file with an alphanumeric 
name. Settings and effects saved in the file execute immediately when read back. 

Clicking the Save or Recall buttons displays the standard Windows file selector, open to the default Message 
directory set up in Lyric Preferences. Dynamic playback of a dissolve or fade in a Playlist (or when read from 
the Canvas) operates only if the Dissolve checkbox is checked before the file is saved to disk. 

A quick method for recording a Video Mixer file is as follows: 
1. Press Ctrl + Record.  The Record Only: dialog box opens. 

2. Select Video Mixer. 

3. Click Record.  The Video Mixer settings are saved to the current Message Number in the Default 
Message Directory. 

A Hotkey combination can also be used to record the Video Mixer settings: 

 Press Ctrl + Record X Enter.  The Video Mixer settings are saved to the current Message Number 
in the Default Message Directory. 

Timeline Update 

: Click this control to be certain that your most recent changes to Mixer video settings are 
applied to Mix objects on the Timeline. 

Selecting Frame Buffers 
The Duet Toolbar contains these icons for selecting VGEs (Frame Buffers) and controlling the mixer: 

 

Duet Tools 
By default FB 1 is selected upon Lyric startup. The other VGEs may be selected by clicking the appropriate 
FB icon. Buttons representing VGEs that are installed but not available to Lyric will be grayed out. If the Live 
button is pressed, changes made to the Canvas on the VGA monitor are immediately reflected in the active 
VGE's output. If the Live button is not depressed, the Xfer button may be used to transfer the contents of the 
current scene displayed on the VGA Canvas to the VGE output selected. 

Each time an FB button is pressed the contents of the Canvas on the VGA monitor will be replaced with the 
contents of the scene being generated by the active VGE (or a blank screen upon Lyric startup). A new scene 
with the default camera, global light and source light will be created if one has not yet been assigned to this 
frame buffer. Note that the output frame buffer will not be affected by changes on the VGA canvas if the 

button is not depressed. 

The Swap  button will exchange the scenes in the two output channels. Swapping will be disabled if an 
animation is playing in either channel. 

The following hot keys are also supported: 

/ Transfers contents of VGA Canvas display to the selected (VGE) frame buffer. 

* Selects the next Frame Buffer (e.g., if FB 1 is currently selected, FB 2 will be selected next 
when * is clicked)  

Ctrl / Swaps Output 1 and Output 2 

Alt / Transfers Output 1 to Output 2 using the Mixer effect defined in the Video Mixer Control 
Panel. 
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Video Mixer - Duet HD 
Tools Menu > Video Mixer;   Canvas/Scene Graph Right-Click Menu > Video Mixer 
The High Definition Mixer's controls are launched from the Video Mixer item on the Tools menu. The mixer 
may also be set up from the Windows Control Panel without launching Lyric.  The control panel utility is 
installed automatically when the drivers are installed. 

1. From the Windows Start menu, select Settings > Control Panel, then double-click the HD Mixer 
icon to open the Duet Hardware Configuration dialog box, as shown below. 

 

Control Panel - Duet Hardware Configuration 
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2. Expand the Duet Hardware entry, then the driver entries, to view the various devices that may be 
controlled from this utility. 

 

Duet Hardware Configuration - Expanded 

3. Select the HD Mixer Board entry as shown highlighted above, then click Settings.  The High 
Definition Mixer Settings dialog box opens. 

 

High Definition Mixer Settings - Basic 
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The HD Mixer Board contains two compositors and one mixer. The VGEs in Slots S4 and S5 are 
associated with Compositor 1, the VGEs in Slots S6 and S7 with Compositor 2. If a fifth VGE is 
present in the system, it appears in the mixer as the VGE in Slot S3. 

To properly set up the HD mixer, you need to know which slots in the CPCI backplane have VGE 
boards installed.  The current recommendation is that the standard two-board system have the VGE 
boards installed in Slots S5 and S7.  The backplane slots are numbered from the HD Video I/O board 
(Slot S1) to the last CPCI slot (Slot S7).  The CPU board is in Slot S8. 

The additional settings for the HD Mixer may be accessed by clicking the Advanced button in the 
lower right corner of the menu.  The High Definition Mixer Settings dialog box expands: 

 

High Definition Mixer Settings - Advanced     

4. In the Compositor 1 area, enable the VGE in Slot S5 to the background. 

It is possible to assign the same VGE as a compositor’s foreground and background, but the same 
image will simply appear superimposed upon itself. 

5. In the Compositor 2 area, enable the VGE in Slot S7 to the background. 

6. In the Mix Mode area:  The default setting is Composite. 

When a Dissolve is executed on the Duet HD (by pressing Shift-Xfer), the video from Channel 2 
dissolves into the Air Channel.   Lyric automatically changes the Mix Mode settings as this occurs.  
There is normally no need to manually change the Mix Mode setting from Composite. 

7. In the Mixer Inputs area, enable or disable each layer using the checkbox.  For each layer, you may 
choose an input with the dropdown menu; each offers a choice of Compositor 1, Compositor 2 or 
VGE5. 

8. In the Output 1 and Output 2 areas, select the Mixer (output of the mixer) or Bypass. 

9. The Alignment control advances or delays video from the VGEs to compensate for a delay in the 
signal introduced by the HD Mixer.  For 1080 standards, the proper setting is -31.  For 720p 
standards, the proper setting is -45. 

10. Video Standard displays the current video standard settings.  Changing the video standard cannot 
be performed from this panel.  To change the video standard, it is necessary to exit Lyric, then 
perform the adjustment from Start>Control Panel>Duet Hardware. 

NOTE 
As mentioned above, Lyric automatically changes Mixer settings as a Dissolve executes.  
Lyric also automatically changes Mixer settings when a Video Capture is executed.  
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CMix - Duet SD/LE/LEX/PCI/PCI+, Offline 
Tools Menu > CMix 

Overview 
CMix is a 1RU-rack mount device providing two output channels, each displaying an independent mix of up to 
4 Video/Key input layers over an optional Program video input layer, which mix to one Video/Key output.  
CMix is connected to a host machine via the Universal Serial Bus (USB).  Originally designed for use 
with Duet LE/LEX/PCI/PCI+, CMix can also be used to expand the mixing capabilities of Duet SD systems, or 
with conventional PCs equipped with broadcast-quality video sources, for use as a standalone 
router/switcher.  Note that the setup information described applies to the Duet LE/LEX/PCI/PCI+.  

The CMix system contains two independent sets of mixing logic, controlling two Video/Key outputs.  The 
mixers share the same inputs, but the inputs can be assigned to different layers in each mixer.  For 
information on installing and connecting CMix, refer to CMix Installation and Connections. 

Setup 
Genlock Setup 
All components in the system must share a common Genlock source.  The usual configuration routes an 
analog black burst signal to the CMix Reference input and all of the graphics boards in the Duet 
LE/LEX/PCI/PCI+.  Duet LE/LEX/PCI/PCI+ systems have an internal cable that connects the reference inputs 
of all of the boards to a single external BNC.  Connecting the analog black burst to any BNC labeled as REF 
IN should lock all of the boards in the system. 

VPB Setup 
To configure the Video Processing Boards (VPBs) in a Duet LE/LEX/PCI/PCI+: 

1. With Lyric running, select Duet Hardware from the Config menu, then select the Setup Board 
Configuration tab. 

 

CMix Configuration 
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2. Set Key In to On, even if there is no key input to the VPB.  Setting it to Off would set the key output 
from that channel to 100% for the full frame, masking all lower layers in the mixer.  

3. Set Video to Insert.  Setting Video to Only would disable the graphics from the VPB to the output. 

4. Set Video Layer Off.  It is possible to key the VPB graphics over a Program Video input and then 
send this output to the CMix, but the system's video timing would be substantially altered.  See the 
information regarding video timing issues later in this section. 

5. To preserve Closed Caption data on line 284 (the CC line of the second field), set Ancillary Data to 
On.  Setting Ancillary Data to Off would generate VPB video on line 284.  The VPB would never 
generate graphics on line 21.  This action preserves any Closed Caption data that might appear 
there. 

PCI-Squeezeback Board Setup 
Video Layer should be set to Off.  Since the PCI-Squeezeback board has no Key Input, setting Video Layer 
to On would set the Key Output of the board to 100% for the full frame, starting at line 20.  This would block 
any lower layer and the program video in the CMix. 

Video Timing Issues 
Proper mixing of the video sources requires that their timing be matched. There is no time base correction 
inside the CMix unit. 

The Horizontal Video and Vertical Video in the Setup Board Configuration tab (see previous figure) 
should be set to the same values for all of the graphics boards in the Duet LE/LEX/PCI/PCI+ system.  This 
ensures that a graphic read in one frame buffer will appear in the same place on-screen as the same graphic 
read in the other frame buffers. 

Note that it is inadvisable to connect a single video source to both the CMix Program Input and the inputs to 
any of Duet LE/LEX/PCI/PCI+ VPBs.  This is a function of the 1-scanline delay created by the circuitry of the 
VPBs.  If the same signal is fed to both the CMix Program Input and a VPB input, the version of the signal 
passing through the VPB input would appear one line lower on CMix Output.  If it is necessary to use such 
an arrangement, the signal going to CMix Program Input should first be routed through a 1-scanline delay 
device.  

When a PCI-Squeezeback board is used to resize video input, there is a 1--frame delay between the PCI-
Squeezeback board input and its output.  As noted above, if the same Program Input is fed to both a PCI-
Squeezeback board and the Program Input of the CMix, the program video from the PCI-Squeezeback 
board would be one line lower than the Program Video.  This cannot be corrected by adjusting 
Squeezeback Panel settings to change the position of the resized video on the screen.  Again, to correct this, 
a 1-scanline delay must be introduced from the video that is fed to the Resizer In to the Program In of the 
CMix. 

When using the same Program Video Input for both the CMix and the Resizer Input of the PCI-
Squeezeback board, the Resizer Output should be set to full-screen (720 X 486).  The Vertical Delay of the 
PCI-Squeezeback board should be set so that the two video signals align at the output, and then the Vertical 
Delay of the other VPBs and PCI-Squeezeback board graphics planes should be aligned with the graphic 
plane in the PCI-Squeezeback board that is sharing its signal with the CMix. 

Chyron strongly recommends using the PCI Squeezeback board to resize and reposition alternate video 
sources into the Program Video Output, but should not be used to resize Program Video before connection 
to a CMix input. 

To resize Program Video, connect the video output of the CMix to the Resizer input of the PCI-Squeezeback 
board.  This places the PCI-Squeezeback board downstream of the CMix.  In this configuration, the video 
output of the PCI-Squeezeback cannot be connected to the CMix input without causing timing problems at 
the switcher. 
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Internal Clip Player Issues 
When the Lyric application is launched, the Internal Clip Player's DigiSuite hardware may initialize its Key 
Output to a full frame of 100% out.  If the CMix layer assigned to the Clip Player is active, this will block all 
lower layers.  This condition may be corrected by reading a Clip file that starts with no Key Output. 

Unlike the VPB and PCI-Squeezeback boards, the Internal Clip Player generates video on lines 21 and 284.  
If the Internal Clip Player is generating a full frame of video, it will cover lines 21 and 284.  The VPBs and/or 
Squeezeback boards will never cover line 21, and will only cover line 284 if Ancillary Data is set to Off. 

CMix Control 
The CMix assignments and parameters are set within the CMix Control dialog box.  To access: 

 From the Tools menu, select CMix.  The CMix Control dialog box is displayed. 

 

CMix Control 
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Output 1 and Output 2 Settings 
The checkbox at the top of each output section enables the controls within that section.  Deselecting 
(unchecking) a checkbox to disable an Output hides that Output's individual controls.  This allows the user to 
create a mix effect for one channel without affecting the other.  The default labels for the outputs are Output 1 
and Output 2. 

Video Inputs - Layer Settings 
It may be helpful to assign signal sources to inputs with some concern for the easiest arrangement to 
remember, for example, assigning Duet Frame Buffer 1 to CMix Input 1, Frame Buffer 2 to Input 2, etc.  
Additionally, the layers can be color-coded for easy recognition. 

These labels may be changed to indicate which sources are connected to which inputs.  The default labels for 
the Layers are CH1, CH2, CH3 and CH4. 

CMix Setup 
Layer and Output parameters are set in the CMix Setup dialog box.  To access: 

 Click the Setup button  located at the bottom of the CMix Control dialog box.  The CMix 
Setup dialog box opens. 

 

CMix Setup 
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Device 
The Device setting is a USB communication status indicator for the external device, such as a Duet system, 
controlling CMix.  Currently, the Device dropdown is not used, as only a single external system may be 
connected to CMix at a given time. 

 

USB Connection Status Displayed at the Top of the Setup Panel 

Setting Input  and Program Parameters 
To assign user-defined labels to the Layers and PGM, and color codes to the Layers: 

1. Enter new names in the Input Label fields and the PGM Label field.  Note that the PGM Label is 
displayed only when the PGM is not OFF in the CMix Control. 

2. For each layer and the PGM, click on the BG color chip to set the color of the background of the 
Label field, and on the FG color chip to set the color of the text of the Label field.  When a chip is 
clicked, the Color dialog box opens.  Select a color, then click OK to set.  Refer to Color Selection 
for Light Sources and 3D Characters/Objects for information on using the Color dialog box. 

When Shape Video is enabled, the Input Video is attenuated to the Key signal, so that color components do 
not exceed the Key level.  When Shape Video is disabled, the Input Video is not attenuated.  To set: 

 Select (check) the Shape Video checkbox to enable, or deselect (uncheck) the Shape Video 
checkbox to disable. 

Setting Output Parameters 
To assign user-defined labels to the Outputs: 

 Enter new names in the Output Label fields. 

When ANC is enabled, the ancillary data is transmitted along with the rest of the video signal that is output 
from the CMix.  When ANC is disabled, the ancillary data stripped from the video signal that is output from 
the CMix.  To set: 

 Select (check) the ANC checkbox to enable, or deselect (uncheck) the ANC checkbox to disable. 

Setting Sync Gen Parameters 
To set Video Standard: 

 Select NTSC or PAL from the drop-down list box. 

To set Genlock: 
 Select Analog, Digital or Free Run from the drop-down list box. 

To set Horizontal Delay and Vertical Delay: 
 Adjust the respective sliders to match the Horizontal Video and Vertical Video settings in the Setup 

Board Configuration tab in Duet Hardware Configuration. 
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Applying CMix Setup Parameters 
The following is an example of CMix setup. 

 

CMix Setup - Parameters Set 

Once CMix parameters are entered: 

 Click OK to apply.  The CMix Setup dialog box closes. 
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The new settings are reflected in the CMix Control dialog box. 

 

CMix Control with CMix Setup Parameters Applied 
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Layer Assignments and Transparency 
Any CMix input, except for the Program input, can be assigned to any layer.  To do so: 

1. Click the Label field of a Layer.  A drop-down list box displays the available Inputs, as well as an 
OFF setting.  The OFF setting disables the Layer. 

 

Layer Drop-Down 

2. Repeat the layer assignment process for Output 2.  Remember that the inputs can be assigned to 
different layers in Output 2. 

Each Output Layer slider (1 through 4) corresponds to a Video Input/Key Input pair.  The sliders control the 
Transparency of each layer in the mix. 

NOTE 
The Transparency setting is technically an Opacity setting, in that a setting of 0 is 
completely transparent, and a setting of 100 is completely opaque.  It is common 
throughout the industry, however, to use the terms Transparency and Opacity 
interchangeably when referring to level settings. 

Output Level 
The Output Level slider to the right of the Layer sliders controls the overall Transparency of the entire mix. 
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Route 
A separate layer or the mix of all layers can be routed to the output.  To set: 

 Click the Route drop-down list box.  Select Mix, Layer 1, Layer 2, Layer 3 or Layer 4.  If a layer is 
selected, it is sent to the output at 100% video level.  If Mix is selected, the programmed mix is sent 
to the output. 

NOTE 
The Route controls affect all of the CMix Output(s).  Their effect is not confined to the 
Monitoring outputs.   

 

Route Setting 

Program Input 
The Program (PGM) input to the system's mixes can only be turned on and off.  Program video is always at 
100% video, and its level may not be varied.  Clicking the PGM field toggles the input on and off.  If the 
Program source is turned off, CMix inserts black in its place, and all other components of the mix(es) are 
unaffected. 

 

Program On/Off 
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Effects 
A Cut, Dissolve or Fade effect can be executed when the mix is rendered to output.  These effects consist of 
starting and ending mixer states for each of the two CMix outputs, when the output is enabled.  When 
Dissolve or Fade is selected, the user may specify a Duration in video Frames.  The Duration and Frame 
controls are disabled if Cut is selected. 

To set up an effect: 
1. Select (check) the Effect checkbox. 

 

CMix Effect Controls 

2. Select Cut, Fade, or Dissolve from the Effect drop-down list box.  If Cut is selected, Frame and 
Duration settings are not accessible, and setup is complete.  If Fade or Dissolve is selected, 
continue to the next step. 

3. Move the Frame slider to Start, and then set the Layer and Output Level sliders to the desired initial 
values. 

Layer and Output Level sliders can be adjusted only when the Frame slider is at either Start or End.  
Interpolation between Start and End values is always Linear. 

4. Move the Frame slider to End, and then set the Layer and Output Level sliders to the desired final 
values. 

Note that when setting a Dissolve effect, the combined Transparency of Layers 1 and 2 must equal 
100%, and the combined Transparency of Layers 3 and 4 must equal 100%.  If the Layer sliders 
are set to incorrect values, CMix Control automatically corrects the settings. 

5. Set a duration in the Duration field.  Setup is complete. 

To play the effect: 

 Click the Play icon . 

To preview the effect frame-by-frame: 
 Use the mouse to drag the Frame slider through the effect. 

To execute the effect and switch the signal on Output 1 with that on Output 2 and vice-versa. 

 Click the Swap icon .  This is equivalent to executing a Swap  on a Duet LE/LEX/PCI/PCI+. 

NOTE 
When CMix software is installed, the normal Duet Tools Swap function is disabled, 
whether or not a CMix system is connected, and/or whether or not the CMix Control 
dialog box is open. 

 To restore normal Swap function, move the CMix.ocx file from the Lyric Plugins 
directory to another location. 

 To restore CMix functionality, move the CMix.ocx back to the Lyric Plugins 
directory. 
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Timeline Add 
A CMix effect object can be added to the current Lyric scene. 

 Click the Timeline Add button . 

When the CMix effect is added to the Timeline, it appears as an object on the Timeline, as well as on the 
Scene Graph and Keyframe Graph.  By default, the length of the new entry is the effect duration specified in 
the CMix Control dialog box.  This value, however, as well as the Start Time and End Time of the effect, 
can be modified using Lyric 's standard Timeline editing tools. 

 Right-clicking on the CMix Timeline displays a menu which accesses Timeline editing functions. 

 Right-clicking on the CMix item in the Scene Graph displays a context menu which lists one item, 
CMix Properties.  Select CMix Properties to display the CMix Control dialog box. 

 Right-clicking on the CMix Keyframe Graph displays a menu which accesses Keyframe Graph 
editing functions. 

Timeline Add can be executed more than once to add multiple mixer effects to the Timeline as separate 
objects, however, the Start and End Times must not overlap. 

Keep in mind that the CMix element in the Timeline, Scene Graph and Keyframe Graph is not an object 
that is visible on the Canvas.  Creating a CMix object, however, is how Lyric incorporates the CMix settings 
into the Lyric composition. 

 

CMix Effects Objects Displayed on Timeline and Scene Graph 

Timeline Update 
Modifications to an effect can be made in the CMix Control dialog box, and then applied to the Lyric CMix 
Effects object. 

1. On the Timeline or Scene Graph, (select) highlight the effect. 

2. In the CMix Control dialog box, make the modifications. 

3. Click the Timeline Update button . 
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Saving/Recalling CMix Settings 
CMix effects and mixer settings can be recorded without other Lyric information, or they can be stored as a 
component of a complete Lyric composition. 

To record CMix effects/mixer settings only: 
1. Press Ctrl + Record on a Duet keyboard, or Ctrl + the numeric keypad minus sign (-) on a PC 

keyboard.  The Record Only: dialog box is displayed. 

 

Record Only Dialog Box 

2. Select (click) the CMix radio button, then click Record.  The CMix message is recorded in the *.lyr 
file format, to the current number displayed in the Message Number Display, in the Default 
Message Directory. 

A CMix message can easily be recalled (read) by using the Lyric Read function. It can also be programmed 
into a Playlist.  Settings and effects execute immediately when the file is recalled. 

To save CMix settings as a component of a complete Lyric composition: 
1. Add the CMix object to the Timeline using the Timeline Add function as previously described. 

2. Save the Lyric message. 

Saving CMix settings using the File Save As function is not currently supported.  

Exiting the CMix Control Dialog Box 
To close the CMix Control dialog box: 

1. If desired, save the CMix settings.  

2. Click the button  or the Windows Close icon .  Be sure you've saved your work before 
closing the panel. 
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CMix Installation and Connections 

Introduction 
CMix is a 1RU-rack mount device providing two output channels, each displaying an independent mix of up to 
4 input layers over optional Program video.  CMix is connected to a host machine via the Universal Serial Bus 
(USB).  Originally designed for use with  Duet LE/LEX/PCI/PCI+, CMix can also be used to expand the mixing 
capabilities of Duet SD systems, or with conventional PCs equipped with broadcast-quality video sources for 
use as a standalone router/switcher.  For information on operating CMix within Lyric, refer to CMix. 

Software Installation 
CMix’s software control panel is available in two ways: as a standalone application for use outside of Lyric, or 
as a Lyric plugin. The standalone application is available in Chyron’s digital pcCODI Software Developer’s Kit 
and is discussed in the documentation included with the SDK. 

For additional information on Lyric Plugins and the LEIF architecture, consult Lyric Online Help. 

 

CMix Software Installation 

CMix’s plugin software for Lyric is installed by the familiar Install Shield process. Locate the CMix.exe on the 
included CD and double-click it. The install process begins. Follow the instructions in the installation script, 
and click Next as needed. (To uninstall the CMix software, use the Windows Add/Remove Program facility, as 
seen in the lower right corner of the illustration above.) 
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CMix’s software is an ActiveX control with the .ocx extension. As with all Lyric Plugins, the file CMix.ocx must 
be located in the proper directory on your system. It should be in the Plugins folder of the Lyric installation that 
contains the copy of Lyric with which it will be used. If your system includes multiple versions of Lyric, make 
sure the .ocx file is in the correct version’s installation! See the illustrations on the next page. 

 

Installing CMix in Plugins Directory 

The system pictured here contains different versions of Lyric. In the first  illustration below, the installation 
script did not place the file in the appropriate directory. The operator’s intent here is to use CMix with Lyric 
Version 4.1 and later. 

 

Top:  Installation into the Directory for the Incorrect version of Lyric 
Bottom: The CMix.ocx has been moved to the appropriate directory, in this case, 

Lyric Version 4.1. 
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CMix Connections 

 

Rear Panel of CMix Chassis 

USB Port 
The Windows 2000 operating system will detect and configure new USB connections. 

Ethernet Connector 
This connector is not currently in use. 

Video Outputs  
Signal: SMPTE 259M/CCIR-656 SDI Format, except for the analog monitor outputs (next item). 

 Monitor 1 and Monitor 2:  These BNC connectors offer analog video monitoring output for each of 
the system’s two outputs (SDI VIDEO OUTs 1 & 2). Connect to standard NTSC/PAL monitors. These 
video outputs are low-resolution and are not suitable for broadcast. 

 Video Out 1 & Key Out 1:  SDI video and key output from Mixer 1of the CMix. If ANC DATA is 
enabled, ancillary data from the Program In, including Closed Captioning on lines 21 and 284 will 
appear at this output. 

 Video Out 2 & Key Out 2:  Provides video and appropriate key signal from Mixer 2 of CMix. 

Video Inputs 
Signal format: SMPTE 259M/CCIR-656 SDI 

CMix’s four video and key input pairs may be combined in any order by means of compositing and/or blending 
layers. All mixer settings may be controlled as animation elements by Chyron’s Lyric application or other 
programs created with the digital pcCODI Developer’s Kit. Typical inputs to the Mixer are video from a clip 
player or from a character generator. Multiple graphics planes can be combined; for instance, CMix could 
simultaneously composite elements created by CAL and Lyric applications, a bug inserter and an animated 
background originating from clip playout.  

For mixing, a video input must have an associated key input. If there is no Key In for a given Video In, a 
100% matte signal will be assigned, covering all lower layers in the mixer. 

 Program In:  The Program In signal is essentially a fifth video layer, distinct from the four Video and 
Key Input pairs. Program Video is always below Layer 4. All Layers are on top of Program Video. 
Note that Program In is where the system takes in Closed Captioning as well as other Ancillary data. 
This data is passed through CMix and preserved on the Video Out 1 & 2 signals. The Program In 
signal is protected by a bypass relay that automatically routes the signal to Program Out 1 in case of 
system power loss. 

NOTE 
This video input may be used as a digital Genlock source; selection of analog or digital 
Genlock may be set in software (see Ref In for more about analog Genlock). 

 Video In and Key In, Pairs 1 - 4:  These pairs of video and key inputs comprise CMix’s four fully- 
manipulatable layers. Each of these four signals may be routed to either or both of CMix’s output 
channels. The arrangement of output layers defines visual display priority. Layer 1 is on Top and 
layer 4 is on the bottom. Program Video is always below layer 4. All Layers are on top of the Program 
Video. 
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Analog Reference Connections 
CMix may be optionally Genlocked to the SDI Program Video Input or to an analog composite video black 
burst reference signal. Selection of Genlock source is made in software. 

 Ref Loop:  This BNC connector is an output of the black burst signal received at the Ref In 
connector. This provides a means to share analog sync with other devices, such as Chyron’s digital 
pcCODI-type Video Processors, clip players and other mixers and switchers.  

To share black burst among multiple systems using the Ref Loop facility, you must remove 
the shunt at jumper JP24, located on the printed circuit board near the Ref Loop and Ref In 
connectors. 

 

Remove the Shunt at Jumper JP24 to Share Analog Genlock 

 Ref In:  Connect a composite analog black burst signal to this BNC connector. Also note that this 
video input may be used as an analog Genlock source; your selection of analog or digital Genlock 
may be set in software (see Video In for more about digital Genlock and §5 for more about software 
used with CMix). 
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Hardware Topology 
Basic System 

 

CMix Block Diagram 
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Sample Setup 
The diagram below shows CMIX used with a Chyron Duet LEX equipped with optional Internal Clip Player 
and Squeezeback board. Such an arrangement might be used to send a completely produced feed from a 
news network’s regional bureau to its central facility, using the Chyron systems’ resources to minimize 
demand on other assets, such as switchers and keyers at the central facility. 

 

Example of CMix Connected to Duet LEX for USB Control  
and Three Video Sources 

In such an arrangement, Program Video In might be a camera signal showing a news anchorperson. Duet 
LEX’s Video Processor Board could be generating a Lyric-created lower-third, while its Internal Clip Player 
and Squeezeback Board worked together to place footage from a reporter in a movable, shrinkable region 
over the anchorperson’s shoulder. In this way, all compositing and/or keying is done at the remote location. 
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28. Video Capture 

Video Capture 
Tools Menu > Video Capture 
Lyric's optional Video Capture board tool allows the Duet to capture a frame of video, display it as a 
background on the Duet output and save it to a graphics file in one of the supported graphics formats (e.g. 
TIFF, TGA, BMP, JPG, etc.).  The hardware and procedures are different depending on whether the system 
is a Duet SD, Duet HD or Duet LE/LEX/PCI/PCI+. 

Video Capture - Duet SD 
Tools Menu > Video Capture;   Canvas/Scene Graph Right-Click Menu > Video Capture 
Lyric's Video Capture tool allows the user to capture a frame of standard definition video (NTSC or PAL), 
display it as a background on the Duet output and save it to a graphics file in one of the supported graphics 
formats (e.g. TIFF, TGA, BMP, JPG).  Note that each time a video frame is captured, the previously captured 
frame is overwritten. 

Alpha information, if present, is captured and preserved along with the grabbed frame.  However, Alpha 
content cannot be viewed on the Lyric Canvas as seen on the VGA monitor.  The Alpha information can only 
be seen by looking at the output of Duet’s keyer.  

To capture a video frame: 
1. Select Video Capture from the Tools menu to open the Video Frame Capture dialog box.  Note that 

Video Capture is available on the menu only if Lyric is running on a Duet system. 

 

Video Frame Capture Dialog Box - Duet SD 
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2. Select Video I/O or SD Mixer from the Video Source drop-down list box. 

3. Click Video Settings.  The Video Capture Settings dialog box is displayed: 

 

Video Capture Settings Dialog Box - Duet SD 

a. If you have not already selected the source or would like to change it, select Video 
I/O or SD Mixer from the Source drop-down list box. 

b. Select Enable Key Input if you have a valid Key input and wish to save it along with 
the Video input.  The setting on opening the dialog box reflects the Enable Key 
Input setting in the Config Menu > Video tab. 

c. Select Enable Video Shaping if you have a valid Key input and wish to save it along 
with the Video input.  The setting on opening the dialog box reflects the Enable 
Video Shaping setting in the Config Menu > Video tab. 

Enable VGE Shaping is not available in this application. 

d. Click OK to accept settings, or Cancel to cancel.  The Video Capture Settings 
dialog box closes. 

4. In the Crop Image area: 

 Check the Save Full Screen checkbox to save the capture as a full-screen image.  Note that 
Save Full Screen is the default Save mode. 

OR 

 You can use the Crop Box to record a rectangular region of a grabbed frame for use as a 
Lyric object.  Specify values for X, Y, Width, and Height to adjust the size and position of the 
Crop Box.  Note that size and proportions of the Crop Box determine only the size of the 
saved image.  The original captured frame is always full-screen.  Note that Save Full Screen 
is automatically deactivated (unchecked) when the user modifies the Crop Box size or 
position from either the Video Frame Capture dialog box or by using the mouse. 

To use the mouse to move or resize the Crop Box, first make sure that Global Light is 
selected on the Scene Graph.  To move the Crop Box, left-click the center of the Crop Box, 
then drag it to a new Canvas location.  The Crop Box can also be moved by 1-pixel/scanline 
increments by pressing Ctrl + ; or by 10-pixel/scanline increments by pressing Shift 
+ Ctrl + . 
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To resize the Crop Box, left-click an edge, then drag it to a new position.  If a corner is 
selected instead of an edge, the entire Crop Box is resized, and aspect ratio is maintained.  

 

Video Capture Crop Box 

5. Set Offset Image to set desired image offset.  This parameter is set prior to a Video Frame Capture 
operation to ensure that the captured video frame is properly positioned on the Canvas. 

6. Click Grab.  The full-screen image is now captured.  The full-screen image now becomes the 
Background of the Lyric composition.  Caution!  If a background is imported via Tools > 

Background,  or by clicking the    button on the Chyron Toolbar, the captured frame is 
overwritten. 

To cancel the Video Capture before clicking Grab, click Cancel. 

In some instances when live video is captured, visible temporal displacement artifacts may be introduced into 
the captured video frame.  To remove these artifacts: 

 Click the De-Interlace button.  This creates new even scanlines by interpolating between consecutive 
odd scanlines and has the effect of removing flicker between fields. 

To save the Full Screen or Crop Box as a 24-bit Lyric message: 
 Press the Record key (the minus sign on the numeric keyboard) or by select Save or Save As from 

the File menu and enter the appropriate information in the dialog box.  

To save the Full Screen or Crop Box as another type of graphics file: 

 Click the Save button in the Video Frame Capture dialog box.  The Save dialog box opens.  Select a 
file type (TIFF, Targa, BMP, etc.) from the File of Type drop-down list box. 
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View/Hide Live Video 
IMPORTANT!!! 

Do not click the View Live Video button if Duet's outputs are on air!!! 

View Live Video changes the Mixer settings to display the currently selected Video source on Duet Video 
Out 1.  To enable this display: 

 Click the View Live Video button.  Note that the button name changes to Hide Live Video. 

To hide the live video and restore the mixer settings: 
 Click the Hide Live Video button.  Note that the button name changes back to View Live Video. 
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Video Capture - Duet HD 
Tools Menu > Video Capture;   Canvas/Scene Graph Right-Click Menu > Video Capture 
Lyric's Video Capture tool allows the user to capture a frame of high-definition video (1080i only), display it 
as a background on the Duet output and save it to a graphics file in one of the supported graphics formats 
(e.g. TIFF, TGA, BMP, JPG).  In order to perform Video Captures, the Duet HD must be equipped with 
optional HD Video Capture board, which must be installed in the Duet HD's CPCI Slot S3. 

Alpha information, if present, is captured and preserved along with the grabbed frame.  However, Alpha 
content cannot be viewed on the Lyric Canvas as seen on the VGA monitor.  The Alpha information can only 
be seen by looking at the output of Duet’s keyer.  Note that each time a video frame is captured, the 
previously captured frame is overwritten. 

Executing and Saving a Video Capture 
To perform a Video Capture: 

1. Select Video Capture from the Tools menu to open the Video Frame Capture dialog box.  Note that 
Video Capture is available on the menu only if Lyric is running on a Duet system with the optional 
HD Capture Board is installed. 

 

Video Frame Capture Dialog Box - Duet HD 

2. Select HD Capture from the Video Source drop-down list box.  This is the only available choice.  
The Settings button is grayed out.  Settings are fixed, and therefore cannot be changed. 
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3. In the Crop Image area: 

 Check the Save Full Screen checkbox to save the capture as a full-screen image.  Note that 
Save Full Screen is the default Save mode. 

OR 

 You can use the Crop Box to record a rectangular region of a grabbed frame for use as a 
Lyric object.  Specify values for X, Y, Width, and Height to adjust the size and position of the 
Crop Box.  Note that size and proportions of the Crop Box determine only the size of the 
saved image.  The original captured frame is always full-screen.  Note that Save Full Screen 
is automatically deactivated (unchecked) when the user modifies the Crop Box size or 
position from either the Video Frame Capture dialog box or by using the mouse. 

To use the mouse to move or resize the Crop Box, first make sure that Global Light is 
selected on the Scene Graph.  To move the Crop Box, left-click the center of the Crop Box, 
then drag it to a new Canvas location.  The Crop Box can also be moved by 1-pixel/scanline 
increments by pressing Ctrl + ; or by 10-pixel/scanline increments by pressing Shift 
+ Ctrl + . 

To resize the Crop Box, left-click an edge, then drag it to a new position.  If a corner is 
selected instead of an edge, the entire Crop Box is resized, and aspect ratio is maintained.  

 

Video Capture Crop Box 

4. Set Offset Image to set desired image offset.  This parameter is set prior to a Video Frame Capture 
operation to ensure that the captured video frame is properly positioned on the Canvas. 
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5. Click Grab.  The full-screen image is now captured.  The full-screen image now becomes the 
Background of the Lyric composition. 

Caution!  If the button is active when a frame of video is grabbed, it is stored in the VGE and 
becomes the background of the Lyric scene on the canvas.  If a background is imported via Tools > 

Background,  or by clicking the    button on the Chyron Toolbar, the captured frame is 
overwritten. 

To cancel the Video Capture before clicking Grab, click Cancel. 

In some instances when live video is captured, visible temporal displacement artifacts may be introduced into 
the captured video frame.  To remove these artifacts: 

 Click the De-Interlace button.  This creates new even scanlines by interpolating between consecutive 
odd scanlines and has the effect of removing flicker between fields. 

To save the Full Screen or Crop Box as a 24-bit Lyric message: 
 Press the Record key (the minus sign on the numeric keyboard) or by select Save or Save As from 

the File menu and enter the appropriate information in the dialog box.  

To save the Full Screen or Crop Box as another type of graphics file: 

 Click the Save Frame button in the Video Frame Capture dialog box.  The Save dialog box opens.  
Select a file type (TIFF, Targa, BMP, etc.) from the File of Type drop-down list box.  The image 
saved in the file must be 1920 x 1280 pixels. 

View/Hide Live Video 
IMPORTANT!!! 

Do not click the View Live Video button if Duet's outputs are on air!!! 

View Live Video allows the user to preview the live video source; and causes video input to the HD Video 
Capture board to appear on both Duet outputs. 

Caution!  The View Live Video function erases any video previously stored in the Video Frame Capture 
memory.  Any captured video should be saved elsewhere as a file before performing further Video Capture 
operations. 

To do so: 
 Click View Live Video.  When View Live Video is active, Output 1 and Output 2 are set to Bypass, 

and the Bypass is enabled to the VGE in Slot S3, which is the HD Video Capture board.  All Duet 
outputs show whatever is coming from the HD Video Capture board.  The View Live Video button 
now displays as Hide Live Video. 

To hide the live video: 
 Click the Hide Live Video button. 

Load/Clear/Show Buffer 
An existing image can be opened in the HD Video Capture board’s buffer for use as a Background in 
compositions.  To do so: 

 Click Load Buffer.  The image is loaded into the buffer,  but is not displayed until Show Buffer is 
activated (see below).  This video background appears in the mixer as Layer 3, which is the layer to 
which the HD Video Capture board is assigned. 

To display the loaded video as a background: 
 Show Buffer displays the video output from the HD Video Capture on the Duet output(s) that are 

assigned to the Mixer.  When Show Buffer is active (checkbox is checked), Layer 3 is turned on.  It 
will display the current contents of the buffer or current input to the buffer. 

To clear the last captured or loaded image from the buffer: 
 Click Clear Buffer. 
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Video Capture - Duet LE/LEX/PCI/PCI+ 
Tools Menu > Video Capture;   Canvas/Scene Graph Right-Click Menu > Video Capture 
Make sure that there are valid sources of analog or digital sync and digital video connected to Duet LE/LEX’s 
Ref In and Video In connectors, respectively. From the Lyric Tools drop-down menu, select Video Capture 
to open the Video Capture dialog box. 

 

Video Capture Dialog Box 

The Video Capture settings are described in the following paragraphs. 

Frame Delay 
Duet LE/LEX/PCI/PCI+ can capture eight samples in an automated sequence. Set Frame Delay to specify a 
waiting period between each capture in the sequence. 

Capture Channel 
To select which one of the installed VPBs and/or PCI-Squeezeback boards is to be the source of the image to 
be captured, click a radio button in the Capture Channel radio button group. 
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Capture Sample 
Eight different frame grabs can be captured and held. Additionally, any of the eight can be selected for 
replacement by a new frame grab. The 1 - 8 buttons in the Capture Sample button group represent which of 
eight possible positions among thumbnails the capture is to occupy. For example, a capture designated 1 will 
occupy the upper left-most position in the field of eight thumbnails, and 8 the lower right-most. If all eight 
possible captures are being displayed as thumbnails, these designations may be used to selectively replace 
individual captures. Once an anticipated capture is designated, press the Capture Sample button to capture 
the image. The All button captures all eight possible images, separated by the interval specified in the Frame 
Delay control.  Auto Display Thumbnails automatically launches the Display Sample function (see Display 
Sample below) as the specified number of captures is completed. Auto Clean Artifacts is a preset function 
that attempts to remove blurring, tearing, etc. from the captured samples. 

Display Sample 
Display Sample enables the display of the captures specified in the LE Video Capture dialog box. When a 
Display Sample is selected, the associated Capture Sample is displayed full-screen on the video monitor. 
Click All to view all eight captured images as thumbnails over the live picture on the video monitor. 

 

Thumbnails as Seen on Video Monitor 
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Save Display 
The Save Display button saves all of the selected captures (one-eight or All) as a bitmap that can be saved 
to disk for reference. 

 

All Captures Saved as a Bitmap 

Transfer to Air 
The Transfer To Air button transfers the captured image selected by the Display Sample drop-down list to 
the Air output. Note that if the ALL button is clicked under Display Sample, all of the captures will appear as 
thumbnails on Duet LE/LEX’s air output. 

Page Blank 
Page Blank erases all of the captured images and their thumbnails. 

Video Display Preview 
Video Display Preview toggles thumbnails or displayed captures on and off in the Preview Channel. 

Transfer to Canvas 
Transfer To Canvas adds a bitmap model of the displayed sample(s) to the Lyric Canvas. Once transferred 
in this fashion, the bitmap becomes a normal Lyric object, which can be manipulated in the same way as 
other 2D images. 

Like any other Lyric object, the bitmap newly added to the Canvas is also represented by a Scene Graph 
entry named Video Capture.  
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NOTE 
The addition of a new element of this type will replace the previous one! You may wish to 
add multiple Video Captures to your composition. Unwanted replacement of existing 
captures by new ones can be avoided by renaming existing Capture elements before 
adding new ones, as shown below. 

 

Changing Name of a Scene Graph Element 
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29. Video Regions and Squeezeback Objects - Duet SD 

Video Region - Duet SD 
Tools Menu > Video Region;   Canvas/Scene Graph Right-Click Menu > Video Region 
Video Regions are areas of the Canvas that display video from external sources or the Duet Internal Clip 
Player.  Video Regions may be incorporated into Lyric compositions and animated or manipulated like any 
other object on the Canvas.  Video Regions may be scaled with or without locked aspect ratio, but the video 
playing back may not be cropped.  Apparent size may also be altered by increasing distance from the 
Camera along the Z-axis. 

A Video Region object is created when the user selects Video Region in the Tools menu.  Initially, a Video 
Region is shown as a 100 x 100 (pixel) rectangle centered in the Canvas on the VGA screen.  As in Video 
Capture, live video input is not viewable on the VGA screen.  To view the created Video Region on Duet, the 

user must transfer the channel that contains the Video Region to Duet or press the  button on the 
Duet Toolbar. 

A Video Region object is added to the Scene Graph and Timeline windows when a Video Region is first 
created.  Only one Video Region can be included in a scene.  Handling and animation of Video Regions is 
similar to bitmap graphic objects (i.e., Transform Tools can be used to move, scale, and rotate the object on 
a keyframe basis).  In addition, transparency can be modified and keyframed. 

A Video Region's source is the signal connected to Duet's video I/O board.  In order for the video to be 
displayed in a Video Region, Key In must be enabled.  Refer to Configuration for Display of Video Source 
- Duet SD, Configuration for Display of Video Source - Duet HD or Configuration for Display of Video 
Source - Duet LE/LEX/PCI/PCI+ for details. 

In the exercise below, you will simply place a video region on the Canvas as an object. 
1. Make sure there is a video source connected to Duet's Video I/O board, and that it is producing a 

picture.  

2. Pull down Lyric's Config menu and select Duet Hardware.  Click on the Video tab. 

 

Config > Video:  Video Region Setup 
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3. Since you won't be using the Keyer in this exercise, make sure all of the checkboxes on the right are 
unchecked. 

4. Click OK to close the Duet Hardware menus. 

5. Pull down the Lyric Tools menu and select Video Region from the drop-down menu. 

6. A rectangular area opens on the Canvas.  On the VGA monitor's Canvas, the Video Region will 
always show color bars, as pictured below, even with the video source properly configured and 
running.  This is normal.  However, the selected video source will be properly displayed in your 
composition on the video output if the Live or Xfer buttons are pressed. 

 

Creating a Video Region 

7. Try adding other elements to the Canvas and programming an animation that manipulates the Video 
Region.  

Remember that, depending on the complexity of your composition, you may experience trade-offs in video 
processing performance. For instance, Lyric is capable of creating more than one Video Region, but 
rendering may be slowed down or otherwise degraded.  Additionally, multiple Video Regions will necessarily 
all display the same video source. 

Squeezeback Object - Duet SD 
Tools Menu > Squeezeback Object 

 For use on SD Duet only. 

 Updated for Lyric Versions 3.2 and later.  Note that new Squeezeback improvements in Lyric 
Versions 3.2 and later require a Revision H-level Squeezeback Board. Contact Chyron Customer 
Service for more information. 

Overview and Setup 
In contrast with Video Regions, Lyric's Squeezeback Video facility creates regions in a Lyric composition that 
can be displayed full-screen with no loss of video quality. Either of these methods may be better suited for a 
particular application; it is recommended that you experiment with both for the best results. 

Whereas Video Regions are produced by Duet's standard Video Graphics Engines (VGEs), Squeezeback 
effects are created using SD Duet's optional Squeezeback Board. Because Squeezeback video is 
processed in its own hardware, manipulation of Squeezeback video has fewer effects on the behavior of other 
elements in a Lyric composition.  

With Lyric Versions 3.2 and later, the required Revision H Squeezeback Board receives timecode from Duet's 
VGE board(s). The timecode is used to precisely synchronize Squeezeback movement with objects and text 
produced and processed by the VGE itself. 
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The Squeezeback Board is installed in the CPCI slots that accommodate Duet's VGEs. Chyron strongly 
suggests installing this board in Slot #3 and moving other boards if necessary to do so. (CPCI Slot#1 is the 
one nearest the disk drives and the PCI buses; count from there.) Consult the documentation that 
accompanies field upgrade kits for installing the Squeezeback Board, or supplemental documentation 
provided with new Duets shipped with this option. 

 

Squeezeback Board Back Panel 
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Before doing anything else, you must make sure that Duet's Video Mixer is set up properly. Use the Tools 
dropdown menu to gain access to the mixer controls. 

 

SD Mixer Control 

 At upper right, make sure that FB3 is selected for Layer 3. 
 In the Output Router area at lower left, select Mix or Layer 3 and press OK. 
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Next, select Squeezeback Object from the Tools menu again to access the controls for the Squeezeback 
board. 

 

Squeezeback Dialog Box 

The Squeezeback dialog (seen top right in the illustration above) opens. For the moment, click only the 
Region 1 checkbox. Press OK, and on the Canvas, a Squeezeback Region appears (seen bottom right). 

As with Lyric's Video Regions, only the object pictured above appears in the Canvas view on the VGA 
monitor. The image from the video source can only be seen on Duet's air/program output(s) in a region 
defined by the position and boundaries of the object. 

Squeezeback Regions are, in most respects, normal two-dimensional Canvas objects that appear on the 
Scene Graph and Timeline. They can be moved around the Canvas and re-sized over time. 
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Squeezeback Objects on Scene Graph and Timeline 

Note that rotation of the Squeezeback Region is not possible, as with other Canvas objects. Therefore, when 
editing a Squeezeback Region, the Rotation controls of the Properties page will be unavailable: 

 
XYZ Properties Showing Disabled Rotation 
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Also, a note about using Lyric's four movement cursors with Squeezeback Regions. 

     

Transform Tools 

 The Position cursor  may be used without limitation. 

 The Rotation cursor  will be inactive when a Squeezeback Region is selected on the Scene 
Graph. 

 When using the Edit Scale cursor , two cautions should be observed: First, maintaining the 
Squeezeback Region's original aspect ratio may be more difficult than if you are using the Properties 
Menu's Scale controls (with the Lock Aspect Ratio checkbox selected). Second, DO NOT shrink the 
Squeezeback Region to the point of infinity on the Canvas. This may have the effect of imposing 
rotation on the object and cause software problems with the Lyric application.  

 The Edit Center of Rotation Cursor  may be used without limitation. 

Right-clicking a Squeezeback Region on the Canvas makes available the following options:  

 

Squeezeback Options 

 Position Lock On disables the Position controls, as seen below. (Remember that the Rotation 
controls are never present on the XYZ Properties tab for a Squeezeback Region.)  

 

Position Lock On 
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 Enable Bounding Box allows the Squeezeback Region to be scaled uniformly or non-uniformly. 

o Selecting Squeezeback accesses a sub-menu, as seen above.  The Squeezeback Clipping 
Region is anchored to a user-specified position, and is displayed on the Canvas ay all times.  
Smooth scaling is supported when Clipping is enabled. 

o Display Squeezeback Menu gives access to all Squeezeback adjustments (activating each 
region, keying controls, effects, Interpolation mode). 

o Make Full Screen is self-explanatory.  

o Enable Clipping allows the Squeezeback Region to be cropped (as opposed to scaled).  

o Edit Clip Box opens the Clip Box Adjust dialog. Modify the Width and Height of the Clip Box 
as desired, and use the X and Y controls to position the Clip Box on the Squeezeback 
Region. 

 

Setting the Clip Box 

The result of your selection will be immediately apparent on Duet's output(s), but the VGA monitor displaying 
the Canvas will only show the outlines of the selection as a bounding box. The rest of the Canvas object that 
symbolizes the Squeezeback Region will remain visible (as pictured above). 
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As you can see from the initial dialog box, two regions of Squeezeback video can be placed on the Canvas at 
a time. When two Squeezeback regions are on the Canvas at the same time, each is at the same fixed 
distance from the viewer on the Canvas's Z axis. Therefore, you will probably wish to assign display priority 
to one of them. When the two regions overlap, the region you have designated with the Priority radio button 
always appears ‘in front of’ the other one. 

 

Placing Two Video Regions on the Canvas 
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Interpolation Mode 
As of Lyric Version 3.2, a special Interpolation Mode has been added. Usable only with the updated 
Squeezeback Board (Revision H), Squeezeback Interpolation Mode provides processing in sub-pixel and 
sub-scanline increments for smoother movement of Squeezeback Regions.  

NOTE however, that use of the Interpolation mode limits use of the Squeezeback facility to one Squeezeback 
Region at a time.  

To use Interpolation Mode, the same signal must be routed to BOTH inputs of the Squeezeback Board !! 
If using the Keyer with an interpolation-enhanced Squeezeback region, the key signal must be routed to both 
of the board's Key inputs. 

 

Interpolation Mode Cabling 

Lyric detects the presence of an appropriate Squeezeback Board, and if one is found in the system, makes 
this option available, as seen above right.  

Also, note that activating Interpolation Mode makes the dialog's Region 2 controls unavailable, since both 
inputs are dedicated to the production of one interpolation-enhanced Squeezeback Region. 
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Squeezeback Effects 
Another Squeezeback feature new with Lyric 3.2 is Squeezeback Effects.  

 

Setting Screen Size 

These effects offer four pre-defined region sizes: ¼-, ½-, ¾- and full-screen. For each, there are pre-
composed animations which squeeze or expand the region from its beginning size to any of the other sizes. 
Simply select a beginning size and one of the effects, and Lyric automatically arranges the appropriate Scale 
and Position values over the Region's duration on the Timeline. 
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The Anchor dropdown, pictured below, fixes one corner or edge of the Squeezeback Region as the location 
from which scaling will begin, leaving the position of the selected Anchor unchanged. This illustration has 
been altered to show all of the available choices in a single view. 

 

Selecting an Anchor 

To stop a Squeezeback animation in progress: 
 Press Esc. 
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30. Video Squeezeback - Duet LE/LEX/PCI/PCI+ 

Overview 
Tools Menu > Squeezeback Panel 

Introduction 
The PCI-Squeezeback board adds cutting-edge animated video effect creation capability to the Duet 
LE/LEX/PCI/PCI+ system. The Lyric interface provides a set of easy-to-use setup controls for the PCI-
Squeezeback board.  Refer to the topic on Squeezeback Effects Setup. 

Note that the PCI Squeezeback Board for Duet LE/LEX/PCI/PCI+ is a completely different piece of hardware 
from Duet SD's Squeezeback Board. The different versions of Lyric for Duet LE/LEX/PCI/PCI+ and Duet SD 
offer substantially different means of controlling their systems' respective Squeezeback facilities.  

About the PCI-Squeezeback Board 
The PCI-Squeezeback board features four independent video layers, two of which can be resized and 
positioned in real time to create dynamic effects such as compression of a full-screen video image to allow for 
display of additional graphics in the lower third. 

Both Resizer Video layers can be independently set for starting/ending positions and dimensions as well as 
effect duration.  Images from the Resizers can be clipped and layered over one another.  Dissolve, Fade and 
Ease effects can be executed between the Video Resizer layers.  Resizer effects can be played in forward or 
reverse.  Multiple PCI-Squeezeback boards in a system can simultaneously execute Video Squeezeback 
effects. 

The PCI-Squeezeback board's Interpolation mode smooths out jagged motion that may be visible during a 
slow animation. 

An internal Graphics Plane and a Background Video input provide two additional layers to enhance graphic 
depth. The Background Input also doubles as the digital Genlock input.  All layers can be independently 
turned on and off.  The Graphics Plane can also be displayed behind or in front of the Video Resizer layers, 
providing additional flexibility. 

Squeezeback Effects can be triggered from within the Squeezeback Panel in Lyric, from outside the 
Squeezeback Panel using Lyric's Squeezeback Kwik Tool (outside the Squeezeback Panel) in Lyric, from 
a Lyric Playlist, or via Intelligent Interface. 

Analog Genlock In can be routed to the PCI-Squeezeback board from the Analog Genlock panel.  Key and 
Video are output from the PCI-Squeezeback board. 

The PCI-Squeezeback board can operate in conjunction with any combination of three additional PCI-
Squeezeback and/or Chyron digital pcCODI boards. 

Unsupported Functions 
Analog Monitor Out and Key In is not supported on the PCI-Squeezeback board. 

NOTES 
PCI-Squeezeback boards (as well as Video Processing boards) should be configured 
before use.  See the topic VPB/PCI Squeezeback Board Setup for this procedure. 

The display priority (layering order) of the VPBs and Squeezeback boards is dependent 
upon how they are physically cabled in the Duet LE/LEX/PCI/PCI+ system.  See the topic 
Duet LE/LEX/PCI/PCI+ Cabling Options. 
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PCI-Squeezeback Board Hardware Topology 
All external inputs and outputs of the PCI-Squeezeback board are 10-bit SDI (Serial Digital Interface).  Only 
the Analog Genlock In on the Analog Genlock panel can accept an analog signal, which is routed to an 
internal input on the PCI-Squeezeback board. 

The illustration below diagrams the hardware topology of the PCI-Squeezeback board. 

  indicates an external BNC connector 

   indicates an internal Mini SMB connector 

 
NOTE 

If the PCI-Squeezeback board is disabled due to power failure or other cause, a Video 
Bypass Relay routes the SB VID 1 (Primary Video In) path to SB VID OUT (Video Out), 
bypassing the Resizer.  This avoids an interruption of the video signal.  When power is 
restored, the Primary Video is automatically rerouted to the Resizer. 

 

PCI-Squeezeback Board Hardware Topology 
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Duet LE/LEX/PCI/PCI+ Hardware Configuration 
Config Menu > Duet Hardware 

Duet Hardware Configuration is the setup facility for Duet systems.  It encompasses functions such as 
VPB/PCI+ Squeezeback board allocations, GPI, Video Standard, Timecode, and much more.  When Duet 
Hardware Configuration is selected from the Config menu, a set of configuration tabs is displayed for the 
system on which Lyric is installed. 

To access these settings: 
 Select Duet Hardware from the Config menu.  The Duet Hardware Configuration dialog box is 

displayed. 

 

Duet Hardware Configuration Dialog Box 

There are four tabs, plus one optional tab, which contain configuration settings: 
 Configure Board Use:  Specifies how boards are used. 

 Setup Board Configuration:  Specifies parameters such as Video Output Standard, Genlock, etc. 
for the selected board. 

 Setup GPI:  Specifies how the GPI assignments are set up. 

 Timecode:  Specifies Timecode source and other parameters. 

 Device Control:  If the optional RS-422 Serial I/O Board and its driver are installed in the system, a 
Device Control tab, specifying the configuration of the board, is displayed as well.  The RS-422 
Serial I/O Board enables serial control of external devices using the BVW-75 protocol. 
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Genlocking PCI-Squeezeback Boards 
The PCI-Squeezeback board can be Genlocked using either an analog or digital signal. Genlock mode is set 
in the Setup Board Configuration tab located in the Duet Hardware Configuration dialog box which is 
accessible from Config>Duet Hardware. The Genlock setting is retained after the system is turned off, and 
does not need to be reset when the system is powered up. 

Analog Genlock 
Analog Genlock is fed to the Analog Genlock In on the Analog Genlock panel.  A multiple-board Duet 
LE/LEX/PCI/PCI+ system should already be internally wired by Chyron for analog Genlock operation.  In this 
instance, the Genlock signal can be fed to any one Genlock input. 

NOTE 
Feeding separate analog Genlock signals to multiple boards through their respective 
GENLOCK inputs can result in output video that is not in sync and/or unstable. 

Digital Genlock 
To use digital Genlock sync, feed a video source to BACKGND IN of the PCI-Squeezeback board. This 
becomes the digital Genlock source.  The background can also be disabled without disrupting the Genlock 
signal. 

To sync a PCI-Squeezeback board with one or more additional PCI-Squeezeback boards and/or VPBs using 
digital Genlock, designate one of the boards to receive the digital Genlock signal, then route the video output 
of that board to the input (BACKGND if PCI-Squeezeback; VIDEO IN if VPB) of the next board.  Route the 
video output of the receiving board to the appropriate input of the next board, and so on, until all boards are 
connected. 

NOTES 
 While any board can receive the digital Genlock signal and route it to other 

boards, one method of operation is to use the PCI-Squeezeback board to receive 
the digital Genlock signal and pass it to any other PCI-Squeezeback boards 
before routing to VPBs. U sing this configuration allows output from the VPBs to 
display on top of the PCI-Squeezeback video, and not be forced into the 
background. Additionally, Key Out from a PCI-Squeezeback board can be fed to a 
VPB, where the opposite is not possible. 

 Feeding separate digital Genlock signals to multiple boards through their 
respective BACKGND IN or VIDEO IN inputs can result in output video that is not 
in sync. 
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Squeezeback Panel - Getting Started 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 
Duet’s optional PCI-Squeezeback board enables the creation of resizeable video areas which can display 
video from independent sources such as an external video feed or the Internal Clip Player.  The PCI-
Squeezeback board features four independent video layers, two of which can be resized and positioned in 
real time to create dynamic effects such as compression of a full-screen video image to allow for display of 
additional graphics in the lower third.  In addition, the PCI-Squeezeback board contains a graphics layer and 
a background video input to add additional graphic depth.  Squeezeback effects are rendered independently 
by GPI triggers, can be programmed into Playlists using the Sqz-In and Sqz-Out effects and triggered by 
Intelligent Interface. 

NOTE 
Except for SQZ Kwik Tool Squeezeback effect execution, all setup and display options 
for each PCI-Squeezeback board must be set from within the Squeezeback Panel and/or 
the Squeezeback Designer (START/END) dialog boxes. If Video Resizer regions, the 
graphic layer and/or Background video are not displaying, check the appropriate settings 
in these dialog boxes. Note that Video and Graphic layer display options are not set in 
the Duet Hardware Configuration>Setup Board Configuration tab, as they are with VPBs. 
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There are two methods for displaying the Squeezeback Panel: 
 Click on the Canvas displaying the active Frame Buffer (this brings the focus to the Canvas), then 

click Tools > Squeezeback Panel. 

OR 

 Click on the Designer button in the Squeezeback Kwik Tool. 

 

Squeezeback Panel 

This example shows a two-PCI-Squeezeback board system. Note that there may be other VPBs in the 
system as well, but they do not appear in the Squeezeback Panel. The PCI-Squeezeback boards are 
numbered in order of channel assignment. For example, if the system contains two VPBs assigned to 
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channels 1 and 2, and two PCI-Squeezeback boards assigned to channels 3 and 4, the PCI-Squeezeback 
boards are numbered 1 and 2 respectively in the Squeezeback Panel.  The channel to which each is 
assigned is in the parentheses to the right of the respective board number. The display priority (layering 
order) of the VPBs and PCI-Squeezeback boards is dependent upon how they are physically cabled in the 
Duet LE/LEX/PCI/PCI+ system. See Duet LE/LEX/PCI/PCI+ Cabling Options. 

Ten Squeezeback effects can be set up and saved as one Lyric (.lyr) Message and recalled at any time.  If 
more than ten effects are required, then additional pages of ten effects can be set up and saved as .lyr 
messages. 

Each effect can use any number of available PCI-Squeezeback boards, up to four, in the Duet system. Each 
PCI-Squeezeback board has available two resizeable video inputs.  For example, to compose a four-head 
shot effect, use two PCI-Squeezeback boards; for six head shots, use three boards; and for eight, use all four. 

Each PCI-Squeezeback board also has a graphics layer and a background input. Start and end positions, 
start heights and widths of each resizeable video can be set, as well as priority, interpolation and transition 
effect.  GPI triggers are also set in this dialog box.  Multiple PCI-Squeezeback boards in a system can 
simultaneously execute Squeezeback effects. 

The PCI-Squeezeback board has a Video and a Key output. It can be Genlocked using either the Analog 
Genlock Panel or through the Background In BNC connection for digital Genlock. See Analog and Digital 
Genlock for additional information. 

Non-PCI-Squeezeback board control is not accessible from the Squeezeback Panel. 
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Effect Active Board Settings 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 

The Effect Active Board settings (pictured below), located on the left side of the Squeezeback Panel, 
contains the active/inactive board information and the PCI-Squeezeback board assignments for each of the 
10 Effect Messages slots. 

 

Effect Dialog Box 

Slot 
There are ten Squeezeback Effect slots, each of which can hold one Effects Message. Each group of 
Effects Messages on this page can be saved as one Lyric (.lyr) message. 

First, select an effect on which to work. To select a slot, click on its respective radio button. 
  If the slot is already programmed, the settings for the Effects Message assigned to that slot are 

displayed. Additionally, the Active Message Indicator at the left end of the row turns red.  If desired, 
the settings can be edited. 

 If the slot is not already programmed, all values display at 0, and a new Effect Message can be 
programmed at that slot. 

The next step is to select a board on which the effect is to be executed. Continue to the next paragraph for 
information on Active Board. 
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Active Board 
Each PCI-Squeezeback board is assigned a permanent number (1, 2, 3 or 4) by the Duet LE/LEX/PCI/PCI+ 
system. Up to four PCI-Squeezeback boards can be made active for an effect. 

Each PCI-Squeezeback board in the system also displays a SQZ Board tab, located to the right of the Effect 
dialog box, in which the two Video Resizer effects (Video A and Video B) can be set. The illustration above 
shows a system with two PCI-Squeezeback boards. SQZ Board tab setup is described in SQZ Board Tabs. 

 

SQZ Board Tabs 

Select the board(s) on which the effect is to be executed. Click the checkbox(es) corresponding to the board 
number. As pictured above, Effect 1 is assigned to Board 1, and Effect 2 is assigned to Board 1 and Board 
2. 
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SQZ Board Tabs 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 

Each PCI-Squeezeback board in the system displays a SQZ Board tab, located to the right of the Effect 
dialog box, in which the two Video Resizer channels, Video A and Video B, can be set. Each channel has its 
own set of values with which to program an effect. Video A settings are on the left; Video B settings are on 
the right. 

 

SQZ Board Tabs 

A two-PCI-Squeezeback board system is shown above. The boards are numbered 1 and 2 by the system. 
The number in parentheses indicates the LE/LEX/PCI/PCI+ channel to which the board is assigned in the 
Duet Hardware Configuration dialog box accessed from Config > Duet Hardware. 

 To select a board to program, click on the appropriate tab. 

Video A is considered the Primary Video Channel. As such, Primary Video is sent both to Resizer 1 and to 
a frame delay module which bypasses the Resizer, and can be sent, unmodified, to the Video output, 
regardless of Video A settings. 

Additionally, ancillary data such as embedded audio and Line 21 Closed Caption data is carried on the 
frame-delayed Primary Video signal, and can be inserted into the PCI-Squeezeback board mixer Video Out 
stream. Note that resized Primary and Secondary Video streams are always stripped of ancillary data. Refer 
also to Frame Delay and Ancillary Data. Refer to Ancillary Data for details on selecting the PCI-
Squeezeback board mixer video output with ancillary data vs. unmodified Primary Video. 

The procedure for setting the values for Video A and Video B is identical except for the Interpolate function, 
which is described below in Interpolate. 
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Position: Starting/Ending X, Y 
Starting and Ending X, Y values set the starting and ending positions of Video A and Video B. X/Y position 
is measured from the center of the screen. To enter a value, highlight the appropriate field, then type the 
desired number into the field. 

 Starting X/Ending X defines the horizontal entry and exit positions respectively, in pixels, of the 
video image. 
Range: -720 to +720 

 Accepts single-pixel entry which defaults to even number of pixels. 

Starting Y/Ending Y defines the vertical entry and exit positions respectively, in scanlines, of the video 
image. 

 Range - NTSC: -244 to +244 

 Range - PAL: -289 to +289 

 Accepts single-scanline entry which defaults to even number of scanlines. 

Dimensions: Starting/Ending Width, Height 
Starting and Ending Width, Height values set the starting and ending dimensions of Video A and Video B. 
To enter a value, highlight the appropriate field, then type the desired number into the field. 

Starting/Ending Width defines the starting and ending horizontal dimensions, in pixels, of the video image. 
Range: 8 to 720 

Starting/Ending Height defines the starting and ending vertical dimensions, in scanlines, of the video image. 
 Range - NTSC:  2 to 486 

 Range - PAL:  2 to 576 

Clipping: Left, Top, Bottom Right 
The video to be used for the Video Squeezeback effect can be clipped (cropped). Note that the clipping Line 
21 of the video removes Closed Caption information.  This is of no consequence for Primary Video input, as 
this ancillary data is diverted to the Frame Delay module and can subsequently be incorporated into Video 
Out.  Note that Secondary Video (Video B) is always stripped of ancillary data. 

To enter a value, highlight the appropriate field, then type the desired number into the field. 
 Left/Right dimensions can be clipped in 8-pixel increments. 

 Top/Bottom dimensions can be clipped in 1-scanline increments. 

Hold Control for Both Video A and B 
The Hold Control slider bar is used to manually step through and view the effect frame by frame.  Each 
frame can be individually edited. The current frame number is displayed in the display field located between 
the OUT and IN buttons (see below). 

To move the slide box, either click on the slider bar to jump the slide box to the clicked location, or drag the 
slide box to the desired position. 

OUT/IN and Frame Display Field 
The OUT and IN buttons are used to manually step through and view the effect frame by frame. Each frame 
can be individually edited. The current frame number is displayed in the display field located between the 
OUT and IN buttons. 

 Click IN to step the effect in the forward direction. 

 Click OUT to step the effect in the reverse direction. 
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Ease 
Ease applies an Ease effect to the beginning and end of the Video Squeezeback effect. To apply Ease, click 
the Ease checkbox. Note that Ease is applied only to the Video Squeezeback regions, not to the graphic 
associated with the effect.  See Store MSG - Lyric Graphic for information on stored graphics. 

Fade 
Fade provides a number of choices for applying a Fade effect. 

 Click the No Fade radio button if no Fade effect is to be applied to the Video Squeezeback effect. 
This is the default setting. 

 Click the Fade In radio button to fade in the video at the beginning of the Video Squeezeback effect. 

 Click the Fade Out radio button to fade out the video at the end of the Video Squeezeback effect. 

Note that Fade is applied only to the Video Squeezeback regions, not to he graphic associated with the 
effect.  See Store MSG - Lyric Graphic for information on stored graphics. 

Frames 
The duration of the Video Squeezeback effect is set in the Frames field. To enter a value, highlight the field, 
then type the desired number into the field. 

Range: 1 to 300 (10 seconds) 
 To execute a Cut effect, set Frames to 1. 

ON 
The ON control turns the video region on or off. For example: 

 If both Video A ON and Video B ON are checked, both Video A and Video B are displayed. 

 If Video A ON is not checked, and Video B ON is checked, Video A is not displayed and Video B is 
displayed. 

To toggle between on and off: 
 Click the ON checkbox to toggle between On and Off. 

Interpolate 
Interpolate causes sub-scanline and sub-pixel movement to be applied during an animation, smoothing out 
jaggedness that sometimes occurs during slowly-moving animations. 

Applying Interpolate requires that the same video source be fed simultaneously to both Primary and 
Secondary Video inputs. This is necessary to produce the sub-scanline and sub-pixel movements. 

Interpolate can be set only from Video A. When Interpolate is enabled, Video A settings are automatically 
applied to Video B, and the Video B dialog region is grayed out. 

 Click the Interpolate box to toggle between Enabled and Disabled. 
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Mixer Controls 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 

The Mixer Controls determine how the various PCI-Squeezeback video layers display in relation to each 
other. The Mixer Controls are located below the SQZ Board tabs and the STARTING/ENDING SQUEEZE 
values. 

 

Mixer Controls 

A Over B, B Over A 
These settings determine display priority between the two resized video layers. 

 Click the radio button A Over B to display Video A on top of Video B. 

 Click the radio button B Over A to display Video B on top of Video A. 

Background On 
This setting indicates whether or not the Background Video In is turned On or Off. 

 Click the Background On checkbox to toggle Background Video In On or Off. 

Dissolve Effect 
Dissolve programs a Dissolve effect between Video A and Video B. It is recommended that the two video 
images be the same size, and that they are positioned one directly on top of the other. When executed, the 
top layer dissolves into the bottom layer. See A Over B, B Over A above for details on Video A/B layer 
priority. 

Graphic On Top 
Graphic On Top determines the display priority between the Graphic Plane and Video A/B. The Graphic 
Plane can display either on top of Video A and Video B, or behind Video A and Video B. The Graphic 
Plane cannot display between Video A and Video B. 

 Click the Graphic On Top checkbox to toggle Graphic On Top On or Off. 

Graphic Plane On 
Graphic Plane On turns the Graphic Plane display On and Off. 

 Click the Graphic Plane On checkbox to toggle Graphic Plane display On or Off. 

NOTE 
If graphics are not reading, text input is not being accepted or importing or loading into 
the Squeezeback graphics buffer is inoperable, check to see if the Graphic Plane is 
turned off. If so, turn it back on. 
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STARTING/ENDING SQUEEZE VALUES - Squeezeback Designer 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 
The Squeezeback Designer provides the ability to program a Squeezeback effects for Video A and Video B, 
much as it is done in the SQZ Board tab.  The Squeezeback Designer, however, provides sliders and spin 
boxes with which to fine-tune the effects settings. There are also additional Anchor, Lock Aspect and 
Justify settings in the Squeezeback Designer which are not available in the SQZ Board tab. 

To access the Squeezeback Designer, click STARTING SQUEEZE VALUES to program or display the start 
settings of the effect, or click ENDING SQUEEZE VALUES to program or display the end settings of the 
effect. These buttons are located directly below the SQZ Board tabs. 

 

STARTING/ENDING SQUEEZE VALUES Buttons 

 Depending on which button is selected, the Squeezeback Designer (START) or (END) dialog box is 
displayed. 

 Clicking the center button  swaps the settings in the STARTING SQUEEZE VALUES with the 
ENDING SQUEEZE VALUES settings. 

The figure below shows the Squeezeback Designer (START) dialog box. 

 

Squeezeback Designer (START) 

The settings for Video A are on the left; settings for Video B are on the right. These two dialog areas are 
identical except for the Video A ON or Video B ON checkbox and Video A Over B or Video B Over A radio 
button found at the lower left of each dialog area. 
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There is also a row of checkboxes at the bottom of the Squeezeback Designer (START) or (END) dialog box 
where display priority is set. Each of the following procedures for setting the parameters described in the 
following paragraphs are, except where noted, applicable to both Video A and Video B, in both the 
Squeezeback Designer (START) and Squeezeback Designer (END) dialog boxes. 

Position: X, Y 
X and Y values set the starting or ending positions of Video A and Video B. X/Y position is measured from 
the center of the screen. 

 The X POSITION slider is located at the bottom of the Squeezeback Designer Video A and B dialog 
boxes. The X POSITION spin control box is located below and at the right end of the slider. 

 The Y POSITION slider is located at the right of the Squeezeback Designer Video A and B dialog 
boxes. The Y POSITION spin control box is located to the right and at the bottom end of the slider. 

 

Squeezeback Designer X/Y Position 

Starting X/Ending X defines the horizontal entry and exit positions respectively, in pixels, of the video image. 
Range: -720 to +720 

 Accepts single-pixel entry which defaults to even number of pixels. 

Starting Y/Ending Y defines the vertical entry and exit positions respectively, in scanlines, of the video 
image.  

 Range - NTSC: -244 to +244 

 Range - PAL: -289 to +289 

 Accepts single-scanline entry which defaults to even number of scanlines. 
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Dimensions: Starting/Ending Width, Height 
Width and Height values set the starting and ending dimensions of Video A and Video B. 

 The WIDTH slider is located at the top of the Squeezeback Designer Video A and B dialog boxes. 
The WIDTH spin control box is located above and at the left end of the slider. 

 The HEIGHT slider is located at the left of the Squeezeback Designer Video A and B dialog boxes. 
The HEIGHT spin control box is located to the left and at the top end of the slider. 

 

Squeezeback Designer Height/Width 

Starting/Ending Width defines the starting and ending horizontal dimensions, in pixels, of the video image. 
 Range: 8 to 720 

Starting/Ending Height defines the starting and ending vertical dimensions, in scanlines, of the video image. 
 Range - NTSC:  2 to 486 

 Range - PAL:  2 to 576 
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Clipping: Left, Top, Bottom Right 
The video to be used for the Video Squeezeback effect can be clipped (cropped). Note that the clipping Line 
21 of the video removes Closed Caption information. This is of no consequence for Primary Video input, as 
this ancillary data is diverted to the Frame Delay module and can subsequently be incorporated into Video 
Out. Note that Secondary Video (Video B) is always stripped of ancillary data. 

The Clipping spin control boxes are located at the center of the Squeezeback Designer Video A and B 
dialog boxes. 

 

Squeezeback Designer Clipping Settings 

 Left/Right dimensions can be clipped in 8-pixel increments. 

 Top/Bottom dimensions can be clipped in 1-scanline increments. 

Lock Aspect 
Lock Aspect preserves the aspect ratio of the image when setting a new height or width. When Height is 
adjusted, Width automatically adjusts to conform to the aspect ratio. When Width is adjusted, Height 
automatically adjusts to conform to the aspect ratio. 

The Lock Aspect checkbox is located at the top center of the Video A/B dialog box. 

 

Lock Aspect Checkbox 

 Click the Lock Aspect checkbox to toggle Lock Aspect On or Off. 
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Anchor 
Normally in a Squeezeback effect, the image expands from or contracts to a center point. Anchor provides 
additional points from which to expand or contract the image, as shown in the following figure.  Image 
Expands/Contracts To/From: 

 

Anchors 

The Anchor checkboxes are located at the top right of the Video A/B dialog box. 
 Click the appropriate Anchor checkbox to toggle it On or Off. 

 If no checkbox is checked, the image expands from or contracts to the center of the image. 

 

Anchor Checkboxes 

Copy/Paste 
Settings can be copied and pasted from one Squeezeback Designer Video A/B dialog box to another. The 
Copy and Paste buttons are located at the right side of the Squeezeback Designer Video A/B dialog box. 

 

Copy and Paste Buttons 

 To copy the settings of a Squeezeback Designer Video A/B dialog box. The settings are stored in a 
Paste buffer. When there are contents in the Paste buffer, the Paste button is no longer grayed out. 

 To paste settings, display the Squeezeback Designer Video A/B dialog box to which the settings 
are to be applied. Click the Paste button. Note that this can be in either a Squeezeback Designer 
(START) or (END) dialog box. 
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Video A/B Mixer Controls 
The Mixer Controls determine if Video A and/or B are ON, and which one displays on top of the other. The 
Mixer Controls are located in the lower left corner of the Squeezeback Designer Video A/B dialog box. The 
Video A and Video B Mixer Controls differ slightly from each other as shown in the following figure. 

 

Video A and Video B Mixer Controls 

Video A and Video B display can be independently turned on and off. 
 Click the Video A or B ON checkbox to toggle between on and off 

Video A over B and Video B over A are not independent of each other. Only one video image can be set to 
display on top of the other. 

 Click the Video A over B radio button in the Squeezeback Designer Video A dialog box to display 
Video A on top of Video B. 

 Click the Video B over A radio button in the Squeezeback Designer Video B dialog box to display 
Video B on top of Video A. 

Justify 
Justify is a quick way to move a video image to a particular area of the display. The Justify buttons are 
located at the left side of the Squeezeback Designer Video A/B dialog box. 

 

Justify Buttons 

 Click the Justify Top, Left, Center, Right or Bottom button to move the image to the indicated 
location. 
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Graphic Plane/Background Video Mixer Controls 
The Graphic Plane/Background Video Mixer Controls determine whether or not the Graphic Plane and 
Background video display, and if the Graphic Plane displays on top of or behind the video images. These 
controls are located at the bottom center of the Squeezeback Designer dialog box. 

 

Graphic Plane/Background Video Mixer Controls 

Graphic Plane On turns the Graphic Plane display On and Off. 
 Click the Graphic Plane On checkbox to toggle Graphic Plane display On or Off. 

Graphic On Top determines the display priority between the Graphic Plane and Video A/B. The Graphic 
Plane can display either on top of Video A and Video B, or behind Video A and Video B. The Graphic 
Plane cannot display between Video A and Video B. 

 Click the Graphic On Top checkbox to toggle Graphic On Top On or Off. 

NOTE 
If graphics are not reading, typing importing or loading into the Squeezeback graphics 
buffer, check to see if the Graphic Plane is turned off. If so, turn it back on. 

The Background On setting indicates whether or not the Background Video In is turned On or Off. 
 Click the Background On checkbox to toggle Background Video In On or Off. 

Start/End 
Selecting the Start or End radio button displays the Start or End settings, respectively, for the Squeezeback 
Designer.  The selected settings can then be then be edited. 

 

Start/End Radio Buttons 

OK/Cancel 
The OK and Cancel buttons are located at the bottom left corner of the Squeezeback Designer dialog box. 

 

OK and Cancel Buttons 

When finished setting the parameters for both Video A and Video B: 
 Click OK to save settings. The Squeezeback Designer dialog box closes, and the corresponding 

settings in the Squeezeback Panel are updated. 

OR 

 Click Cancel to close the Squeezeback Designer dialog box without saving settings. The settings in 
the Squeezeback Designer dialog box revert to the values that were displayed on opening the dialog 
box. the corresponding settings in the Squeezeback Panel remain unchanged. 
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Additional Settings 
Tools Menu > Squeezeback Panel 
The following settings affect the routing of the video, as well as provide the version of the SDRAM-MIXER. 

Set Primary Video 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 

All resizers, background and graphics turn off, allowing video to pass through the board. It is desirable to 
activate Set Primary Video when displaying full-screen video. When activated, Video A is passed through 
the Frame Delay module, resulting in a seamless transition between display of resized video and the 
unmodified full-screen video. Resized video is 8-bit, where unmodified video is 10-bit, producing superior 
image quality. Set Primary Video also disables Video B (Secondary Video In - Resizer 2 and the Graphics 
Plane. 

 Click the Set Primary Video checkbox, seen below  to activate this function. The indicator to the right 
of the checkbox turns red. 

 

Set Primary Video Checkbox 

 To deactivate, Set Primary Video, click an IN or OUT button on the execution controls row. 

Set Primary Video can also be activated from the SQZ Kwik Tool. 
 To activate Set Primary Video, click the Set Primary Video button. 

 To deactivate Set Primary Video, click an IN or OUT button. 

 

SQZ Kwik Tool 
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Frame Delay and Ancillary Data 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 
Processing video through the Resizers adds a one-frame delay to the signals, putting them out of sync by one 
frame with video that is not processed through the Resizers. 

Video containing ancillary data such as audio, as well as closed captioning data, does not pass through the 
Resizers and must be put in sync with the resized video. To compensate, video from the Primary Video input 
is fed to the Video 1 Resizer and to a Frame Delay processor, which adds a single frame delay to the 
unresized video signal. The output of the Frame Delay processor is then fed to a Background/Frame Delay 
selector and to a Video Out/Ancillary Data selector. 

NOTE 
The Frame Delay function is available only to Primary Video. 

 

PCI-Squeezeback Board Hardware Topology 

Sqz Version SDRAM-MIXER 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 

SQZ Version SDRAM-MIXER indicates the version letter of the firmware used on the PCI-Squeezeback 
board, as shown in the figure below. 

 

SQZ Version SDRAM-MIXER 
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Executing a Squeezeback Effect 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 

Triggering a Squeezeback Effect from the Squeezeback Panel or Squeezeback 
Kwik Tool  
Effect Activation Buttons 
The Effect Activation Buttons/GPI Controls, located directly under the Mixer Controls, set the triggers for 
the transition in and out of each of the ten effects. 

 

Effect Activation Buttons, GPI Controls 

There are two rows of buttons numbered 1 through 10, each number corresponding to an effect slot as 
described in Squeezeback Effect Save Slots. 

 The top row (IN) contains the triggers to activate the selected effect in the forward direction. A red 
indicator light shows that the effect has been executed in the forward (IN) direction, and therefore the 
END of the effect is now displayed. 

 The bottom row (OUT) contains the triggers to activate the selected effect in the reverse direction. A 
green indicator light shows that the effect has been executed in the reverse (OUT) direction, and 
therefore the START of the effect is now displayed. 

To activate an effect: 
 Click the effect number on the IN or OUT row. 

The effect can also be activated using the optional Chyron® KwiKeys keypad: 
 Press the key on the KwiKeys keypad that corresponds to the effect number. The KwiKeys keypad 

must be configured in the Setup GPI tab of the Duet Hardware Configuration dialog box, accessible 
from Config > Duet Hardware. See VPB/PCI Squeezeback Board Setup for Setup GPI procedure. 
Refer to KwiKeys GPI/O Trigger Device for details on KwiKeys.  Call Chyron Customer Service at 
631-845-2133 for information on purchasing KwiKeys. 

GPI Control 
NOTES 

 To use GPI Control, the GPIs must first be configured in the Setup GPI tab of the 
Duet Hardware Configuration dialog box, accessible from Config > Duet 
Hardware. See VPB/PCI Squeezeback Board Setup for Setup GPI procedure.  

 The SQZ Kwik Tool must be enabled (displayed) in order for GPI Control to 
operate properly. See Enable Squeezeback Kwik Tool below for information on 
the Squeezeback Kwik Tool. 
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To set up GPI control of a Squeezeback effect, a GPI must be assigned to the effect IN and/or OUT that 
allows it to be triggered through a GPI interface. The GPI number should be entered in the field located to the 
left of the effect activation button that is to trigger the effect. This number corresponds to the GPI number in 
the GPI field of the Setup GPI tab in the Duet Hardware Configuration dialog box. Enter 0 if the GPI trigger 
is not to be used. 

 

GPI Control/GPI Configuration 

Enable Squeezeback Kwik Tool 
The Squeezeback Kwik Tool provides the ability to execute Squeezeback effects from outside of the 
Squeezeback Panel.  The Squeezeback Kwik Tool is normally displayed (and is therefore enabled) on 
opening Lyric on any system that contains a PCI-Squeezeback board.  If the Squeezeback Kwik Tool is 
closed, it can be enabled as follows: 

 From the Squeezeback Panel, click the Enable Squeezeback Kwik Tool checkbox located at the 
bottom of the Squeezeback Panel. 

 

Enable Squeezeback Kwik Tool Checkbox 

The SQZ Kwik Tool dialog box is displayed. 

 

Squeezeback Kwik Tool 
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The left column displays the name previously set in the Name field for the effect in the Squeezeback Panel. 
 The indicator light next to the active effect is red if the effect has been executed in the IN (forward) 

direction, therefore the END of the effect is now displayed. 

 The indicator light is green if the effect has been executed in the OUT (reverse) direction, therefore 
the START of the effect is now displayed. 

To trigger an effect: 
 Click IN to activate the effect in the forward direction, or OUT to activate the effect in the reverse 

direction. 

Set Primary Video can be activated from the SQZ Kwik Tool. 
 Click the Set Primary Video button to activate.  See Set Primary Video for details on this feature. 

 Click an IN or OUT button on the Squeezeback Kwik Tool dialog box to deactivate Set Primary 
Video. 

The Designer button returns control to the Squeezeback Panel. 
 Click the Designer button to return control to the Squeezeback Panel. 

Triggering a Squeezeback Effect from the Playlist 
A Squeezeback Effect can be triggered from a Playlist.  Refer to the chapter on Playlists for additional 
information. 

Triggering a Squeezeback Effect from Intelligent Interface 
A Squeezeback Effect can be triggered via Intelligent Interface.  Refer to Intelligent Interface V 
Command - Trigger Squeezeback Effect. 

Squeezeback Effect Message Operations 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 

Effect Name 
Each of the ten effects can be given a name to make it more easily identifiable. To name an effect, click on 
the appropriate Name field for the effect slot, then enter the name. The name should be alphanumeric, and 
can be up to 20 characters long. 

 

Effect Name 

When entered, the effect name is reflected in the Squeezeback Kwik Tool. 
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SAVE SQZ MSG - Save Lyric Squeezeback Effect Message 
To save a Lyric Squeezeback Effect message 

 Enter an unused ID number or filename in the Msg field (see below), then click the SAVE SQZ MSG 
button. The message is saved to the default Messages directory in the Lyric folder. 

 

READ and SAVE Buttons 

See the topic Message Number for additional details on file ID numbers. 

READ Lyric Squeezeback Effect Message 
To load a Lyric Squeezeback Effect Message, enter the Message ID number or filename in the Msg field, 
(above) then click the READ button. The effect settings for that message are loaded into the Squeezeback 
Panel. The Squeezeback effect can then be executed. If a graphic message was stored with the effect, it is 
displayed as well. 

Note that while the graphics plane of the PCI-Squeezeback board can be used for 2- and 3-D composition 
and perform Read Effects and Message Effects, animations cannot be performed simultaneously with a 
Squeezeback effect on the same board. 

Clear Effect 
Click the Clear Effect button (below), found towards the bottom right of the Squeezeback Panel to clear all 
settings in the Squeezeback Panel.  Settings are also cleared in the Squeezeback Designer START and 
END dialog boxes. 

 

Clear Effect Button 
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OK/Cancel 
When finished setting parameters for the Lyric message: 

 Click OK as seen below to preserve settings and close the Squeezeback Panel.  The 10 effects that 
are active in the Squeezeback setup can be executed from the SQZ Kwik Tool.  Lyric retains these 
settings even when closed and the Duet system is turned off. 

OR 

 Click Cancel as seen below to close the Squeezeback Panel and revert to the last group of 
Squeezeback settings that were confirmed using the OK button. 

 

OK and Cancel Buttons 

Copy/Paste Operations 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 

Copy and Paste operations are performed using the buttons located at the right side of the Squeezeback 
Panel, pictured below.  Note that when a Copy operation is performed, the PASTE buttons are no longer 
grayed out. 

 

Copy and Paste Buttons 

Settings can be pasted into the message from which it was copied, a different existing message, or a new 
message. 

COPY A/B 
Click the COPY A/B button to copy all SQZ BOARD tab, Squeezeback Designer (START) and (END) dialog 
boxes and Mixer Control settings for the active effect to the Paste buffer. 

COPY START 
Click the COPY START to copy all START settings of the Lyric Squeezeback Effect to the Paste buffer. 

COPY END 
Click COPY END to copy all END settings of the Lyric Squeezeback Effect to the Paste buffer. 

PASTE A/B 
Click PASTE A/B to paste all SQZ BOARD tab, Squeezeback Designer (START) and (END) dialog boxes 
and Mixer Control settings copied to the Paste buffer to the effect slot that is selected. 
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PASTE START 
Click PASTE START to paste the contents of the Paste buffer settings of the Lyric Squeezeback Effect to the 
START settings of the selected effect. 

 If the Paste buffer contains both START and END settings, the START settings are pasted to the 
START settings of the currently selected effect. 

 If the Paste buffer contains only START settings, they are pasted to the START settings of the 
currently selected effect. 

 If the Paste buffer contains only END settings, they are pasted to the START settings of the currently 
selected effect. 

PASTE END 
Click PASTE END to paste the contents of the Paste buffer settings of the Lyric Squeezeback Effect to the 
END settings of the selected effect. 

 If the Paste buffer contains both START and END settings, the END settings are pasted to the END 
settings of the currently selected effect. 

 If the Paste buffer contains only START settings, they are pasted to the END settings of the currently 
selected effect. 

 If the Paste buffer contains only END settings, they are pasted to the END settings of the currently 
selected effect. 
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Lyric Graphic Message Import 
Tools Menu > Squeezeback Panel (Duet LE/LEX/PCI/PCI+ Only) 
When in the Squeezeback Panel, the graphics plane is not available for text editing or other editing functions. 

It is possible, however, to compose text and/or graphics in the graphics plane of the PCI-Squeezeback board 
or on another board while outside the Squeezeback Panel, then use it as a component of the Squeezeback 
effect. 

After creating the graphic, save it as a Lyric message before using it in a Squeezeback effect. The Lyric 
Message can then be read into the PCI-Squeezeback board for use with the Squeezeback effect. 

READ Lyric Graphic for Effect 
NOTE 

Unless the desired graphic is already displayed in the output channel (not just the 
Canvas) of the PCI-Squeezeback board, it is necessary to perform the READ operation 
from within the Squeezeback Panel in order to use the Lyric message as part of a 
Squeezeback effect. 

If the desired graphic is already displayed on the output channel (not just the Canvas), skip to Store MSG - 
Lyric Graphic. 

To load a Lyric message, enter the message number in the Msg field located at the top right of the 
Squeezeback Panel, then click the READ button. The graphic is read from the default Messages directory 
(set in Config > Preferences > Default Paths) into the Graphic Plane and the output channel of the PCI-
Squeezeback board. If the graphic does not appear, be sure that Graphic Plane ON is checked, and that 
Video A and/or B are not completely covering the Graphic Plane. 

 

READ, Msg Field, Store MSG, Clear MSG 

Store MSG - Lyric Graphic 
Store MSG associates a graphic with a Squeezeback effect. When executed, Store MSG converts the 
contents of the PCI-Squeezeback board graphics channel output into a bitmap that is displayed along with the 
Squeezeback effect. 

When the Squeezeback IN effect is executed, the graphic with the effect set in the Squeezeback Panel 
applied. Executing the Squeezeback OUT effect has no effect on the displayed graphic. 

Once converted, the graphic cannot be edited.  Additionally, if the Lyric message contains a Template Field 
tied to Intelligent Interface, the contents do not update each time the graphic is used for the Squeezeback 
effect. The original Lyric message remains untouched and can still be used as before. 
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NOTE 
Only one graphic can be stored per Squeezeback effect.  If, for example, a graphic is 
stored for Effect 3 when PCI-Squeezeback Board 1 is active, then storing a graphic for 
Effect 3 when PCI-Squeezeback Board 2 is active overwrites the stored graphic on Board 
1.  

It is advisable to store the all of the graphics associated with the effects in a Lyric 
message to a single PCI-Squeezeback board. In other words, unless there is an 
overriding creative reason to do so, do not store graphics in a single Lyric message to 
more than one board number. 

Additionally, if a graphic is stored in a an effect where the graphic plane is disabled, it is 
advisable to clear the graphic from the effect to avoid accidental display.  Refer to Clear 
MSG - Lyric Graphic for information on clearing an effect. 

To associate a graphic with a Squeezeback effect: 
1. Make sure that the graphic is loaded into the graphics buffer of the PCI-Squeezeback board using the 

READ operation, or that it is already displayed in the buffer. Store MSG will execute even if another 
board happens to be active for editing. 

 If the graphic was loaded using the READ button, the Message ID number remains displayed 
in the Msg field (illustration above). The graphic can be stored under this number, or a 
different number can be entered. 
 
Note that the Msg number is specific only to the Squeezeback effect setup, and is completely 
independent of the Lyric Message ID number. 

 If the graphic was already loaded, enter a number in the Msg field. 

NOTES 
 Read does not recognize alphanumeric file names.  

 Do not enter an alphanumeric identifier in the Msg field. 

2. Click Store MSG. 

The ID number appears in the MSG field for the effect slot, located at the bottom of the Squeezeback Panel. 

 

Graphic Message MSG ID Fields 

The graphic stays on-screen until another Squeezeback effect with an associated graphic is made active. 

NOTE 
If a stored graphic does not display when an effect is activated, check to see if the 
Graphic Plane is turned off.  If so, turn it back on. 

Clear MSG - Lyric Graphic 
Clear MSG (see top figure) is used to clear a stored graphic from an effect. Additionally, if a graphic is stored 
in a an effect where the graphic plane is disabled, it is advisable to clear the graphic from the effect to avoid 
accidental display.  To remove a graphic from an effect: 

 Click Clear MSG. 
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Erase/Replace a Squeezeback Graphic 
To erase a graphic associated with a Squeezeback effect from an output, or to replace the graphic without 
disturbing the displayed Squeezeback regions, choose one of the following methods: 

From within the Squeezeback Panel 
A blank screen or other graphic message must be stored to an effect on a PCI-Squeezeback board. This 
effect can then be executed when an output erase/graphic replace is needed. For example, a blank screen or 
new graphic message can be stored to Effect 5. Whenever Effect 5 is executed, the graphics buffer and 
output of the board will be erased or replaced. 

To keep the current Squeezeback regions constant on the output when erasing the graphic: 
 Deactivate the PCI-Squeezeback boards in the Effect dialog box for the graphic erase effect. When 

the graphic erase effect is executed, the current Squeezeback regions stay constant. 

OR 

 Copy the ENDING SQUEEZE VALUES of the previous effect to the STARTING SQUEEZE VALUES 
of the graphic erase/replacement effect.  Set the ENDING SQUEEZE VALUES as desired. 

From outside the Squeezeback Panel 
 Activate the Video Squeezeback channel and erase the Graphic Plane buffer or read a new 

message into the buffer in the same manner as with a VPB. 

 Xfer (Transfer) a blank/graphic message or blank/graphic active screen to the appropriate 
Squeezeback buffer. 

Program a blank/graphic screen message to follow the Squeezeback effect in a Playlist. This works only if 
the Playlist is executed on the Squeezeback channel. 
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31. Intelligent Interface 

Intelligent Interface® 

Overview 
Intelligent Interface provides a mechanism for controlling the update and display of graphics and titles 
through an ASCII-based command set transmitted over a serial port connection or via Telnet.  Note that Lyric 
is able to receive Intelligent Interface commands through both of Duet's serial ports, the network or from the 
system running Lyric. 

Many programs, including newsroom automation systems, have been written to support this protocol, and 
many programmers in the television broadcast industry are familiar with the command set and its functionality.  

Duet/Lyric Intelligent Interface is a subset/extension of the Intelligent Interface protocol for Chyron's 
iNFiNiT!® Family graphics products.  For those operators accustomed to the iNFiNiT! operating system, 
please note that the term Tab Messages is replaced here with the term Template Data Messages. 

Intelligent Interface for Lyric provides the same type of functionality as Intelligent Interface for Chyron’s 
iNFiNiT! family of character generators.  Template fields in special Lyric messages can be updated with new 
text.  In addition, commands for changing text properties and running animations may also be exchanged via 
the serial link. 

For serial port connection, there are three steps to enable Intelligent Interface operation: 
1. Connect a serial port on the external computer directly to one of Duet’s serial ports.  Duet's second 

serial port can also be connected to the same computer or to a second computer to provide an 
additional port for Intelligent Interface commands.  Connection procedure follows below. 

2. Configure the ports on both Duet and the external system(s) as described following the connection 
procedure. 

3. Configure Intelligent Interface settings.  Refer to Intelligent Interface Configuration for procedure. 

For Telnet connection, there are two steps to enable Intelligent Interface operation: 
1. If communicating with a remote system, the system running Lyric must be properly networked.  If 

sending commands from the same system that is running Lyric, it is not necessary that the system be 
on a network.  In both instances, the IP Address of the system running Lyric must be available.  
When sending commands locally, however, the name localhost can substitute for an IP Address.  
Generally, an application running remotely sends Intelligent Interface commands to a system 
running Lyric.  Intelligent Interface commands can be easily tested, however,  by opening a local 
Telnet session from the same system that is running Lyric.  Opening a Telnet Session is described 
at the end of this section. 

2. Configure Intelligent Interface settings.  Refer to Intelligent Interface Configuration for procedure. 

In addition to Intelligent Interface, Lyric provides a wide variety of methods to update information displayed 
in a Lyric message.  For an overview, refer to Updating Messages in Lyric.  

Serial Port Connection 
A Duet can be connected one or two host computers in a variety of configurations: 

 A serial port on a Duet can be connected to a serial port on a host computer. 

 Two serial ports on a Duet can be connected to two serial ports on a host computer. 

 One serial port on a Duet can be connected to a serial port on a host computer.  The second serial 
port on the Duet can be connected to a serial port on a second host computer. 

Port COM numbers and computer operating systems do not have to match.  It is crucial, however, that the 
Duet Port settings and the host Port settings match.  Port setup is described following the connection 
information. 
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Refer to the following table and diagram for signal names and pinouts pertaining to the RS-232 protocol.  RS-
232 protocol supports cable runs of 50 feet (15.24 meters) or less.  

The table outlines a typical connection from Duet to an Intelligent Interface host using either a DB-25 
connector or DB-9 connector.  Please check the host computer’s Serial Port pinout documentation to ensure 
proper hookup! 

Note that some interfaces require the RTS signal (Pin 7) to be HIGH.  Because Pin 7 is LOW, use Pin 4 
(DTR) instead.  This may require a modification to your serial interface cable.  The table below specifies 
typical setup for DB-9 to DB 25 and DB-9 to DB-9 configurations. 

Typical RS-232 Interface Cable Pinout:  DB-9 to DB-25 and DB-9 to DB-9 

Duet System (DB-9) To Host Computer (DB-25) To Host Computer (DB-9) 

Pin Signal 
Name 

Pin Signal Name Pin Signal Name 

2 RXD 2 TXD System-Specific TXD 

3 TXD 3 RXD System-Specific RXD 

5 GND 7 GND System-Specific GND 

  Bridge 4 - 5 RTS/CTS Bridge Signals DSR / DTR 

  Bridge  6 - 8 - 
20 

DSR / DCD / DTR Bridge Signals RTS / CTS 

The figure below shows the Serial Connector Pinout of the Duet system.  

 

RS-232 Serial Connector Pinout - Rear View of Connector 
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Serial Port Communications Setup Overview 
To enable serial communications between Duet and an external (host) computer(s), each system’s serial 
Com port(s) must be set up using the same values.  These values may vary with the external computer’s 
operating system and the modem settings being used.  Setup on the Duet differs slightly between Windows 
2000 and Windows NT®.  Procedures from both operating systems are described here.  To configure Port 
settings for an external host running on a different operating system, please consult the user documentation 
for specific instructions.  Note that the operating systems on the Duet and the host computer(s) do not have to 
match.  

Communications Setup - Windows® 2000 
After the connecting the Duet to the host computer, perform the following procedure on both machines.  If 
dedicating two Duet ports to Intelligent Interface, the procedure must be performed for each port, as well as 
the host(s) ports. 

1. Access Windows Start > Settings > Control Panel > System > Hardware > Device Manager > 
Ports (COM & LPT). 

2. Expand the Ports (COM & LPT) listing, then select Communications Port (Com 1) or 
Communications Port (Com 2).  This example shows COM 2.  The Communications Port (COM2) 
Properties dialog box is displayed. 

3. Select the Port Settings tab to display the settings. 

 

COM2 Setup - Windows 2000 

4. Enter the desired values for Baud Rate, Data Bits, Parity, Stop Bits and Flow Control.  Remember 
that the Port settings on Duet and the host system must match.  Click OK. 

5. Launch Lyric.  From the Config menu, select Intelligent Interface.  Refer to Intelligent Interface 
Configuration for details on serial port setup from Lyric. 
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Communications Setup - Windows NT® 
After the connecting the Duet to the host computer, perform the following procedure on both machines.  If 
dedicating two Duet ports to Intelligent Interface, the procedure must be performed for each port, as well as 
the host(s) ports. 

1. After the installation of the ReCall Keys, access Windows Start > Settings > Control Panel > 
Ports.   The Ports dialog box is displayed.  Select Com 1 or Com 2.  This example shows Com 2. 

 

ReCall Keys - Selecting a COM Port 

2.   Click Settings.  The Settings for COM2 (or COM1 if using COM1) dialog box is displayed. 

 

Recall Keys - Settings for COM2 

3. Enter the desired values for Baud Rate, Data Bits, Parity, Stop Bits and Flow Control.  Remember 
that the Port settings on Duet and the host system must match.  Click OK. 

4. Launch Lyric.  From the Config menu, select Intelligent Interface.  Refer to Intelligent Interface 
Configuration for details on serial port setup from Lyric. 

Opening a Serial Port Communication Session 
The presence of serial port TTY emulation software is required on the system sending Intelligent Interface 
commands.  Refer to the emulation software documentation for procedure on opening a communication 
session. 
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Opening a Telnet Session 
Initiating a Telnet session is the virtually same whether connecting from a remote system or to the same 
system that is running Lyric. 

1. On the system that is to send the Intelligent Interface commands, open a Command Prompt 
window.  This is generally available from Start > Programs > Accessories. 

2. Enter telnet open <IP Address> or telnet open <Full Computer Name>, where the IP Address or 
Full Computer Name is that of the system running Lyric.  If the system sending the commands is the 
same as that running Lyric, telnet open localhost can be entered.  Refer to Finding the IP Address 
or Computer Name of a System for additional information on IP Addresses and Full Computer 
Names. 

3. Press Enter.  If a login is requested, proceed to the next step.  If a login is not requested, a welcome 
message is displayed in the Command Prompt window.  The system is now ready to send 
Intelligent Interface commands. 

4. Enter a login, then press Enter.  A welcome message is displayed in the Command Prompt 
window.  The system is now ready to send Intelligent Interface commands. 

To close an Intelligent Interface and Telnet session: 
 Close the Command Prompt window. 

Remember that on the system running Lyric, Intelligent Interface must be configured to accept 
communications via Telnet.  Refer to Intelligent Interface Configuration for information. 

Intelligent Interface® Configuration 
Config Menu > Intelligent Interface 
Intelligent Interface commands can be sent to and from a system running Lyric via one or two serial ports, or 
via Telnet. 

To enable Intelligent Interface operation via serial port(s): 
 Serial port configuration must be performed first from the Windows Control Panel, then from within 

the Lyric Config menu.  The system running Lyric must be connected via serial port(s) to the 
system(s) sending commands.  Refer to Intelligent Interface for details on connection and Control 
Panel setup. 

To enable Intelligent Interface operation via Telnet: 
 The system running Lyric must on a network unless commands are sent from the local system (the 

same system running Lyric).  The system must be configured from within Lyric to communicate via 
Telnet.  Refer to Intelligent Interface for additional overview information. 

This section covers configuration from within Lyric.   
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To configure the connection for Intelligent Interface: 
1. Select Intelligent Interface from the Config menu.  The Intelligent Interface dialog box is 

displayed. 

 

Intelligent Interface Configuration 

2. From the Connection area (unlabeled) at the top left, select one of the following: 

 Option Disabled:  Intelligent Interface function is disabled. 

 Enable Serial Port 1:  Intelligent Interface data can be sent from Serial Port 1. 

 Enable Serial Port 2:  Intelligent Interface data can be sent from Serial Port 2. 

 Enable Both Ports:  Intelligent Interface data can be sent from Serial Ports 1 and 2. 

 Enable Telnet:  Intelligent Interface data can be sent via a Telnet connection.  This allows 
a user to send Intelligent Interface commands from either a remote computer system or 
from the same system that is running Lyric. 

3. From the Recall Keys area at the top right: 

 Enable (check) Recall Keys or disable (uncheck) Recall Keys. 

If Recall Keys is enabled, select one of the following: 

 Com 1 to accept Recall Keys commands through Com 1. 

 Com 2 to accept Recall Keys commands through Com 2. 

4. The Message Directory field reflects the Default Message Directory from which Intelligent 
Interface will read and to which it will write messages.  This directory can be changed via Config 
Menu > Preferences > Default Paths, or via the Intelligent Interface M Command.  The Message 
Directory cannot be changed from the Intelligent Interface dialog box. 

5. You can enable Machine Code when the Intelligent Interface commands are created using lower-
case characters only.  If Machine Code is specified, only those lower-case commands with the 
correct Machine Code are processed.  An error message is returned if the Machine Code is 
incorrect.  Machine Code can be disabled by checking the Ignore Machine Code checkbox, and all 
lower-case commands will be processed regardless of their Machine Code. 
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6. To review the last command received by the system, as well as the last command sent by the 
system, click the Diagnostics checkbox.  The Intelligent Interface dialog box expands as shown 
below. 

 

Intelligent Interface Configuration Diagnostics 

The last command received, as well as the last command sent by your system, are displayed, along 
with the time and date of each. Note that the Diagnostics display reflects the last commands sent 
and received when the Diagnostics display was opened.  To update and view the Diagnostics 
display, click the Diagnostics checkbox twice.  The Diagnostics display closes, then reopens with 
updated information. 

7. Click OK.  Intelligent Interface is now ready to exchange commands and other data with the 
external system. 

Once Intelligent Interface has been enabled, the active connection is indicated on the Lyric Status Bar.  II-1 
is shown for Port 1, II-2 for Port 2, II-D for dual-port or II-T for Telnet. 

 

Status Bar Showing Intelligent Interface Active on Port 1 

Refer to Intelligent Interface for details on commands and use. 
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About Template Description and Template Data Messages 
(See also Graphic Substitution. ) 

Template Description and Template Data Messages 
Template Description and Template Data message references are major components of Intelligent 
Interface update commands.  Understanding Template Description and Template Data messages is key to 
creating Intelligent Interface commands that can not only update existing messages, but that can create new 
messages based on existing messages.   

 A Template Description Message is a Lyric message, which contains both static text/graphic 
elements, and one or more 2D Text Templates which can be updated remotely. 

 A Template Data Message is a message which is created on the fly from the external (host) 
computer sending a W command, or by selectively recording (Ctrl + Record + D) the message from 
Lyric.   This message contains all of the information necessary to insert the desired text into the 
Template Description Message.  The combination of these two messages is displayed on Lyric's 
video output, and appears as one complete message. 

Note that an Intelligent Interface update command (U) may also be sent to a Template Description 
Message, without creating a Template Data Message. 

Template Description Message Setup 
As an example, we will create a Template Description Message containing two 2D Text Templates which 
will be updated with text sent from the external computer. 

1. Create a new Lyric message composed of any combination of text and graphics, including a 2D Text 
Window. 

2. In the 2D Text Window, create two 2D Text Templates, which are to be externally updated. 

 

Sample Template Description Message 
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3. Place the cursor in the first Template that was created.  In the 2D Text Template dialog box, assign 
it the number 0 (see figure below), and enable the Auto Erase and II Update options (see figure 
below).  Assign the number 1 to the second Template and also enable the Auto Erase and II Update 
options. 

 

Assign Template Number 
 

Auto Erase, II Update Enabled 

4. Lyric should automatically number Templates, starting at 0, but you may wish to confirm that the first 
Template is numbered 0 as shown above. 

5. Enter the Message Number 1001, then record the message to the Default Message Directory. 

Template Data Message Setup 
The W command creates a Template Data Message in the same Default Message Directory on the system 
that is running Lyric.  The file is created by the application running on the external computer in an interaction 
that is initiated by the external computer.  Every new set of data generated by the external system’s software 
creates (or updates) a message to Lyric, which can be recalled for display when needed.  

Consult the external application’s documentation for programming it to send Lyric the appropriate commands.  
Whatever the particulars of the application’s operation, it must send properly formatted commands to Lyric in 
order for Intelligent Interface to function. 

It is important to remember that the command described next creates a Template Data Message containing 
the text inserted into the Templates.  The Template Data Message may be recalled just as any standard 
Lyric message, and includes the elements from the Template Description Message combined with the 
externally updated material. 

NOTE:  For the operator’s convenience, it is recommended that the Template Description and Template 
Data Messages be stored under related Message IDs. In this example, the Template Description Message 
is stored at 1001, and the Template Data Message is stored at 2001. 

The syntax for the W command is as follows: 
W\<Template Data Message ID>\<Template Description Message ID>\<Text>\ 
<Text>\<Text>\...\\<CR><LF> 

Parameter Description/Settings 

W Identifies Create Template Data Message command. 

<Template Data Message 
ID> 

ID Number of new Template Data Message. 

<Template Description 
Message ID> 

ID Number of existing Template Description Message 
containing graphics and Templates. 

<Text>\<Text>\<Text>\... Each <Text> parameter contains the data that is to be sent to 
an II Update-enabled Template.  Templates are populated in 
their Template Number order.  Up to 10,000 Template fields 
may exist in a single Template Description Message. 
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The following example updates Template Description Message 1001 with new text and writes the Template 
Data Message to 2001: 

W\2001\1001\W. Fahnstock\H. Pride\\<CR><LF> 

When the W command is sent and successfully processed, Lyric responds by returning an asterisk (*).  
Whether or not this response is visible on the host (external) computer depends on the setup of the system 
and its application. 

Recalling a Combined Message 
Once a Template Data Message has been created, as in the example above, it can be recalled like any other 
Lyric message.  The updated text appears in the Templates that were originally recorded.  In this example, 
recalling Message ID 2001 results in the following display: 

 

Recalled Template Data Message 
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Command Set and Syntax 

Command Set 
The Intelligent Interface command set consists of groups of like commands invoked by an identifying letter 
followed by a set of parameters.  The table below outlines the command groups.  Each command group is 
described below, following the section on Host Acknowledgement. 

Command Description 

C Change color of specified field. 

E Define Macro to read message. 

F Change font of specified field. 

M Set disk drive and message directory. 

Q Resend previous response. 

U Update one field of a Tab Data message. 

V Special Effects and Control. 

W Write to Tab Data message. 

X and R Requests External Update and responds to Update Request. 

Y Assorted. 

Embedded Commands that are embedded in R, U or W commands to change 
the Font, Color, or Background of an Intelligent Interface-
enabled Template. 

Command Syntax 
Commands for Intelligent Interface consist of bidirectional data exchange between the host computer and 
the system.  The protocol consists of a group of single-letter commands, which are followed by various 
modifiers and data as required. 

A command string can contain numerous fields; fields are separated by a backslash (\), known as a 
Command Field Separator.  The command string is always terminated by a double backslash (\\), followed 
by an optional 2-byte checksum, and mandatory Carriage Return and Line Feed characters.  In this 
documentation, they are notated by <checksum>, <CR> and <LF> respectively.  See the end of this section 
for additional information on checksum. 

In this document, program code <xx> refers to an eight-bit decimal or hexadecimal number equal to the xx 
value, and is used to represent non-printable characters such as Carriage Return and Line Feed.  For 
example, to represent a carriage return, the notation <0D> is sometimes used.  An eight-bit number equal to 
0D must be sent.  Do not use the ASCII equivalents of <, 0, D and >.  Carriage Return and Line Feed are 
commonly used characters, and are also represented by <CR> and <LF> respectively, or as CRLF. 

All ranges in the parameter descriptions are inclusive, e.g. 0 - 255 includes both 0 and 255. 

The following must be observed when entering any Intelligent Interface commands. 

 All listed parameters, except those specified as optional, must be entered. 
 Parameters must be entered in the proper order.  
 Lyric® Intelligent Interface® is created as an extension of the iNFiNiT!® Family Intelligent 

Interface® protocol.  Please observe that parameters such as Primary/Secondary User (which have 
no meaning in Lyric) are still observed; in Lyric, any command requiring a Primary or Secondary 
User selection should be set to Primary.  These cases are pointed out where applicable in this 
documentation. 
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Command Examples 
Following are examples of Intelligent Interface commands. 

To update two fields in Template Description Message 1001, write the Template Data to Message 2001, 
and verify command integrity, send the following string: 

W\2001\1001\Indianapolis\Cloudy\\<checksum><CR><LF> 

The W, U, C, and F commands can act on the specific Template Fields, leaving others unchanged.  For 
example, to update Fields 0, 2, and 6, then a W command (Write Tab Data Message) would look like the 
following: 

W\100\10\AAA\ \BBB\ \ \ \CCC\\<CR><LF> 

Note the empty backslashes between AAA and BBB, and between BBB and CCC.  Empty fields are skipped, 
and therefore not updated.  In this example, Fields 1, 3, 4 and 5 are skipped.  Each empty field must contain 
one space character each, or else the two directly adjacent backslashes will be interpreted as the end of the 
command. 

To directly address one Template field, enter the field number.  For example, the U command that updates 
Field 6 would be sent follows: 

U\100\6\DDD\\<CR><LF> 

Checksum Calculation (Optional) 
Checksum is used to verify the integrity of the command that is sent to the system, and appears as 
<checksum> in the commands shown in this manual. 

Checksum is calculated by adding the ASCII value of all characters in the command string, starting at the first 
character and ending at the second backslash.  The total is computed as modulo 256 and displayed as a 2-
byte hex value in ASCII.  A response (from Duet) <0D><0A> indicates that the command has been accepted 
with no checksum error.  

Error Handling 
If a checksum or other error is detected, an 8-byte ASCII error code is transmitted, followed by a Carriage 
Return and Line Feed.  Any errors that occur are also reported in Lyric’s Status Bar.  Refer to the section on 
Intelligent Interface Error Codes for an error code list. 

Host Acknowledgment 
Once the computer has received an acknowledgment of command completion from the Duet system, it can 
send the next command/data stream to the Duet.  The acknowledgment is normally an asterisk (*). 

Double-Byte Character Support 
NOTE 

In order for Lyric to support double-byte characters, the appropriate Chinese and/or 
Korean fonts must be installed in your system! 

The ^ (carat) key serves as both the start and end mark for double-byte characters.  When Lyric encounters 
two ^ characters, it processes the characters between them as double-byte characters. 

All characters not enclosed by a ^ pair, but contained within the field delimiter // are considered single-byte 
characters.  Space characters are also considered single-byte characters. 

This convention is supported in Intelligent Interface’s W, U, V and R commands. 
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Embedded Commands 

Changing Font, Color or Background of a Template 
These commands can be embedded in an R, U, or W command to dynamically change the Font, Color, or 
Background of an Intelligent Interface-enabled Template.  All embedded commands are delimited in the 
Intelligent Interface message by a Tab character (ASCII value 9). 

 <TAB>[fn] => changes the font of the template, where n is the number in the key combination ALT + 
n.  Enter a number from 2 - 20 after the "f" to specify different fonts. 

 <TAB>[cn] => changes the color of the template, where n is the number assigned to each color in 
the palette. 

 <TAB>[bc:\bkg.tif> =] sets the background of the template to c:\bkg.tif. 

 <TAB>[b-] =>\ erases the background in the template. 

For example: 
R\1\<TAB><f1>Duet\\<CR><LF> 

provided as a response to an X command, would update the Template in the message displaying the word 
“Duet” rendered in the font assigned to hotkey Alt + 1 in the active Browser. 

Alternative Method for Changing Font and Color in Embedded Commands 
You may use the embedded Font/Color specification for the Chyron iNFiNiT!® Family's Intelligent Interface, 
as specified in Section 4.6.9 of the iNFiNiT!® Options Handbook (Chyron Pub.No.2A01996); the Intelligent 
Interface section contained within is Chyron Pub. No. 2A01989.  This document is accessible on the internet 
at http://www.chyron.com/support/docs/manuals/Options/Intelintfc.pdf. 

To change the font number or color index inside an R, U or W command: 
 Embed the iNFiNiT! keyboard value for a Color key (<A8> through <AF>) or font key (<A0> through 

<A7>) within the data field. 
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Graphic Update 
A 2D bitmap graphic can be updated via Intelligent Interface, allowing instant substitution of one graphic for 
another.   W, U and X commands can be used much in the same manner as they are used to update 2D Text 
Templates. 

Enabling II Update and Ext. Update 
There are two types of update from a remote computer:  II Update and External Update. 

 II Update enables the update of 2D Text Templates and/or 2D bitmaps at any time from a remote 
computer.  W and U commands issued by the host (remote) computer are used to execute the 
update. 

 Ext. Update enables the automatic update of a Template Description Message or Tab Data 
Message when it is recalled (read).  An X command is issued by the Duet system requesting an 
update from the external computer.  The external system then sends back to the Duet system an R 
command containing the updated data. 

To enable the update of a 2D graphic and record a Template Description Message: 
1. Select the graphic on the Canvas or the Scene Graph. 

2. Right-click on the selected graphic or the Scene Graph listing for the graphic.  The 2D Object 
Template dialog box is displayed. 

 

2D Object Template Dialog Box 

3. Click the II Update checkbox to enable Intelligent Interface Update.  To have Lyric send an 
immediate request (X command) for update when the message is recalled (read), click the Ext. 
Update checkbox as well.  Note that enabling Ext. Update automatically enables II Update. 

4. Record the message. 

 If II Update is enabled, the graphic can be updated at any time via a W command from the 
host computer. 

 If Ext. Update and II Update are enabled, a request for an update is automatically sent to the 
host computer by Lyric when the message is recalled (read).  The graphic can also be 
updated at any time via a W command from the host computer. 
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2D Text Template  and 2D Object Update Order  
2D Object Templates are updated in much the same manner as 2D Text Templates. 

 The topmost 2D Object on the Scene Graph is updated (replaced) first, with each succeeding 2D 
Object under it replaced in descending order. 

 2D Text Templates are then updated, in ascending numeric order. 

Example 
The following screen shot shows two 2D Text Templates and 2D Object Templates.  Note that there is no 
border to define a 2D Object Template.  The object itself is the Template. 

 

Text and Object Templates Before Intelligent Interface Update 

 The 2D Text Window named 2D Text 1 contains a Template numbered 0.  It contains the text string 
News. 

 The 2D Text Window named 2D Text 2 contains a Template numbered 1.  It contains the text string 
Stocks. 

 The bitmap Chyron_logo News is positioned above the bitmap Chyron_logo Stocks in the Scene 
Graph. 
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For this example, assume the message ID is 120.  If Ext. Update is enabled, reading this message would 
trigger the following X command: 

X\1\****\0120\Chyron_Logo News.bmp\Chyron_Logo 
Strocks.bmp\00Template:0\01Template:1\\<CR><LF> 

The host computer would reply with an R command: 
R\1\Chyron_logo Sports.bmp\Chyron_logo 
Elections.bmp\\Sports\Elections\\<CR><LF> 

 

Text and Object Templates After Intelligent Interface Update 

The files referenced, since they are relative filenames, are taken from Lyric's "Images" default path. A relative 
pathname may also be used before the filename, HOWEVER, "front slashes" ( \ )should be used for 
delimiters, as in iNFiNiT!® file and path naming. Use of backslashes should be restricted to field separation 
within an Intelligent Interface command.  Note that the colon (:) can be omitted from a file name of an 
image.  This allows support of the iNFiNiT! file name format. 

Example:  c/filefootage/washington/edole.bmp 

The application running on the external system must send a properly formatted message creating a Template 
Data Message that will be recorded by Lyric. The Template Data Message will have its own page number 
(Chyron recommends making the message numbers similar) and contain the W command.  

Example: The original Lyric message 250 contains the imported bitmap graphic "JackProfile.bmp". You 
wish to be able to replace with it with another graphic (JoeProfile.bmp) during a broadcast. The following W 
command creates Template Data Message 350 using a Bitmap Graphic Template defined in Lyric 
message 250. 

W\350\250\JoeProfile.bmp\\ 

When message 350 is called up in Lyric, the new graphic will have been directly substituted for the original.  
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Take note of the following with regard to Intelligent Interface graphic update. 
 The updated bitmap is scaled to the same size as the original.  Any difference in the aspect ratio 

between the original graphic and the updated graphic will result in a distorted appearance of the 
updated graphic. 

 If a single space character is sent within the Graphic Template command field, the graphic will not 
be changed. 

 If a dash (hyphen) is sent within the field, the graphic will be marked invisible and no longer render. 
This is equivalent to unchecking the graphic on the Scene Graph. 

 If the new image’s file is stored in the location specified in Lyric’s Default Path for images, the W 
command line need not specify a file path, as seen in the example above. The default path for images 
is set in the Preferences window under the Config menu. If the new object is stored outside of 
Lyric’s default image file path, a path must be specified. 

Example: W\350\250\[c:/filefootage/washington/edole.bmp]\\ 

 2D Object Properties settings are updated after an image is updated via Intelligent Interface. 
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C Command - Set Font Color for Template 
The C command is used to specify a new Font Color Index for a Template.  The index specified overrides 
the default font color assignment to a particular Template.  This command can only be used to modify a pre-
existing Template Data Message and therefore the Template Data Message ID must be specified.  Color 
Indexes specified in this command map to the Palette entries defined in the Lyric Message and accessed via 
Lyric hotkeys based on the following table: 

Color 
Index 

 Lyric 
Hotke

y 

Color 
Index 

 Lyric 
Hotke

y 

Color 
Index 

 Lyric 
Hotkey 

Color 
Index 

 Lyric 
Hotkey 

1  Ctrl + 1 5 Ctrl + 5 9 Ctrl + 9 13 Ctrl + Shift + 3 

2 Ctrl + 2 6 Ctrl + 6 10 Ctrl + 0 14 Ctrl + Shift + 4 

3 Ctrl + 3 7 Ctrl + 7 11 Ctrl + Shift + 1 15 Ctrl + Shift + 5 

4 Ctrl + 4 8 Ctrl + 8 12 Ctrl + Shift + 2 16 Ctrl + Shift + 6 

The following C command sets the font color for Template Number 1 in Template Data message 5401 to 
Color Index 5, which is the fifth entry in the Palette for character Face and Edge color: 

C\5401\1\5\\<CR><LF> 
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E Command - Send and Execute Macros 
Any VB Script command that can be executed via Lyric Macros may be contained in an E command.  Each 
command is separated by a "tilde" ( ~ ) character. 

The general syntax is as follows: 
E\<Macro Command>~<Macro Command>~<Macro Command>~...\\<CR><LF> 

For example, the E command to read Lyric Message ID 4 is as follows: 
E\Lyric.Message 4~Lyric.Read\\<CR><LF> 

OR 

E\Message 4~Read\\<CR><LF> 

Note that if no object (in the example above, Lyric) is specified, it is assumed that Lyric is the object. 

The E command can also trigger the execution of a macro.  The syntax is as follows: 
E\<Macro Name>\\<CR><LF> 

For example, to execute a macro with the name Macro1, send the following: 
E\Macro1\\<CR><LF> 

A VB Script subroutine can be built and later referenced by name.  A sample sequence is as follows: 
E\Sub Macro2~Message 15~Read~End Sub\\ 

* 

E\Macro2\\ 

* 

Note the following about building macro subroutines using Intelligent Interface:: 
 The name of the macro subroutine that is built via Intelligent Interface cannot duplicate the name of 

any of the macros currently loaded in the Macros dialog box.  If there is a duplication, Intelligent 
Interface returns a 000041d7 (Duplicate Macro) error code. 

 A macro subroutine that is built via Intelligent Interface is not loaded into the Macros dialog box, 
and therefore does not appear in the dialog box. 

 A macro subroutine that is successfully sent to Lyric can be overwritten, i.e., subsequent macros that 
are sent can have the same name.  The name restriction applies only to macros that are listed in the 
Macro dialog box. 

Additionally, if the macro engine is reset, the script must be resent. 

The E command can also trigger a loaded macro by executing its Hot Key.  Suppose that a macro script in 
Lyric is assigned the hot key trigger Alt + 3, meaning that it executes when Alt + 3 is pressed.  The following 
example uses a VB Script command to set up a shell object that passes commands to the Windows 
command interpreter.  A second VB Script command then sends the key combination Alt + 3, specified in VB 
Script as %3, triggering the macro script. 

E\set WshShell = CreateObject 
("WScript.Shell")~WshShell.SendKeys("%3")\\<CR><LF> 

Refer to Macros for information on macro commands. 
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F Command - Specify Font Index 
The F command is used to specify a new Font Index for a Template.  The index specified overrides the 
default font assignment for a particular Template.  This command can only be used to modify a pre-existing 
Template Data Message and therefore the Template Data Message ID must be specified.  Font Indexes 
specified in this command map to Lyric Font Browser hotkeys used for the Lyric message, based on the 
following table: 

Font 
Inde

x 

 Lyric 
Hotke

y 

Font 
Inde

x 

 Lyric 
Hotke

y 

Font 
Inde

x 

 Lyric 
Hotkey 

Font 
Inde

x 

 Lyric 
Hotkey 

1  Alt + 1 6 Alt + 6 11 Alt + Shift + 1 16 Alt + Shift + 6 

2 Alt + 2 7 Alt + 7 12 Alt + Shift + 2 17 Alt + Shift + 7 

3 Alt + 3 8 Alt + 8 13 Alt + Shift + 3 18 Alt + Shift + 8 

4 Alt + 4 9 Alt + 9 14 Alt + Shift + 4 19 Alt + Shift + 9 

5 Alt + 5 10 Alt + 10 15 Alt + Shift + 5 20 Alt + Shift + 10 

Example:  The following F command sets the Font for Template Number 1 in Template Data Message 
5501 to Font Index 5 (i.e. Lyric hotkey Alt 5):  

F\5501\1\5\\ 
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M Command - Select Message Directory 
The M command is used to change/select the current drive and directory.  All subsequent commands only 
affect messages in this directory.  Note that when only a message number is provided, Lyric, by default, looks 
in the message directory. This behavior can be overridden by providing a full filepath specifying an alternate 
location for the message.  

The general syntax for the Select Message Directory command is as follows: 
M\<Drive Letter>\<Directory Name>\\<checksum><CR><LF> 

Parameter Description/Settings 

M Identifies Select Message Directory command. 

<Drive Letter> Set the drive on which new directory resides.  

<Directory Name> Identifies the new current Message Directory. 

Example: The following command changes the working drive and directory to c:\ELECTION99: 
M\C:\ELECTION99\\<CR><LF> 

The only response to a successful disk drive selection and message directory change is an asterisk (*).  If 
there is an error, the system sends back an error code. 
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Q Command - Resend Last Transmission 
The external computer sends a Q command to Duet to request a resend of the last transmission.  This 
transmission can be an acknowledgment (*), error codes, or the External Update Request response itself. 

The syntax for the Resend Request command is as follows: 

Q\\<CR><LF> 

The computer then resends the last transmission. 
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U Commands - Update Template Data 
The U command updates the data in a single Template. 

Command Description/Settings 

U\ Updates the specified Template in the specified Message. 

U\* Updates the specified Template in the Message currently displayed 
in the active frame buffer.  The message is not reloaded.. 

U Command - Update Template in Specified Message 
The U command is used to update Template data of a single Template in a preexisting Template Data 
Message.  The general syntax is as follows: 

U\<Message Number>\<Template Number>\<Data>\\<CR><LF> 

Parameter Description/Settings 

U Specifies Template Update command. 

<Message 
Number> 

Specifies Message to which the data should be sent. 

<Template 
Number> 

Specifies Template to which the data should be sent. 

<Data> Specifies data that is to be fed to specified Template. 

The following U command updates Field 2 in Template Data message 5501 to "200". 

U\5501\2\200\\<CR><LF> 

Numbering Template Fields:  The U command fills Template fields based on the order in which they were 
created, and/or on their order specified in the 2D Text Template dialog box Number field (below).  Template 
Fields not enabled for Intelligent Interface Update are ignored. 

 

2D Text Template Numbering 

For example, Template Data Message 1088 contains three fields numbered 1, 7, and 9.  Templates 1 and 9 
are disabled (unchecked) for External Update.  The following U command updates Field #7 (the first 
Template encountered with External Update enabled) to display the phrase "Field 7 Text": 

U\1088\1\Field 7 Text\\<CR><LF> 

As illustrated, the U command updates the Template based on the order of the Template fields, starting with 
0.  Since, however, Templates 1 and 9 are not enabled for External Update, Template 7 becomes the first 
Template to be updated.  The Template numbers assigned in Lyric cannot be addressed specifically, but 
only establish the order in which the Templates are populated. 
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U\* Command - Update Template in Current Message 
The U\* command is used to update Template data of a single Template in the currently displayed message 
in the active frame buffer without reloading the message.  The general syntax is as follows: 

U\*\<Template>\<Data>\\<CR><LF> 

Parameter Description/Settings 

U\* Specifies the Template Update command. 

<Template> Indicates the number of the Template to be updated.  

<Data> Indicates the new text to be displayed in the Template. 
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V Commands - Special Effects and Control 
V commands are a series of special effect and control commands in the iNFiNiT!® Family Intelligent 
Interface protocol.  In Lyric, V commands include the following: 

Command Description/Settings 

V\5\3 Reads message to specified target (VGA or frame buffer). 

V\5\13 Reads message and updates all fields in Template Description 
Message marked for Intelligent Interface Update.  Note that: 

 A single-space update within a V command skips a 2D Text 
Template if and only if Auto-Erase is not enabled in the 2D 
Text Template dialog box.  The 2D Text Template dialog 
box is accessed by right-clicking on a 2D Text Template, 
then selecting Template Properties from the context-
sensitive menu. 

 A null update (\\) within a V command skips a 2D Text 
Template, regardless of Auto-Erase setting. 

V\5\14 

 

Reads message and updates only those fields in Template 
Description Message marked for External Update.  Note that: 

 A single-space update within a V command skips a 2D Text 
Template if and only if Auto-Erase is not enabled in the 2D 
Text Template dialog box.  The 2D Text Template dialog 
box is accessed by right-clicking on a 2D Text Template, 
then selecting Template Properties from the context-
sensitive menu. 

 A null update (\\) within a V command skips a 2D Text 
Template, regardless of Auto-Erase setting. 

V\5\15 If an animation is stopped at a Pause point, this command will 
cause the animation to be resumed. Note: If you expect to release a 
Pause, the animation must be played using the Y\<D5><F3> 
command,  which returns immediately. 

V\6 Triggers animation (Play command).  Do not use this method of 
playing an animation if a Pause-Release is required later.  Since 
the V\6\ command does not return an acknowledgment until the 
animation plays out, a subsequent V\5\15\ would not be processed 
during the animation. 

V\6\11-30 Trigger Squeezeback Effect (Duet LE/LEX/PCI/PCI+ equipped 
with PCI-Squeezeback Board only).  Refer to V Commands - 
Trigger Squeezeback Effect for details. 

V\7 Multi FX Setup (Duet SD only).  Refer to V Commands - Multi FX 
Setup for details. 

V\<buffer>\U 

 

The Use Message effect plays the animation in the same manner 
in which it was originally saved in the Lyric message.  Any 
animation in a message called up in this mode is allowed to play out 
before Lyric displays the next message. 
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Command Description/Settings 

Return Codes 

*V\<buffer>\\ Return for V\6 commands. 

*V\5\\ Return for successful V\5 command. 

V\5\<error 
code>\\ 

Return for unsuccessful V\5 command. 

V\5\3\ Command - Read 
The syntax for the Read command is as follows: 

V\5\3\1\<Buffer>\<Message>\<Display Mode>\\<CR><LF> 

Parameter Description/Settings 

V\5\3\ Specifies the Read command. 

1 Legacy parameter from the iNFiNiT!®, which specified the 
User ID when two keyboards controlled one iNFiNiT! system.  
Always keep this parameter set at 1. 

<Buffer> Specifies destination of the message. 

0: Reads the message to the system's VGA monitor. 

1: Displays the message on Frame Buffer 1. 

2: Displays the message on Frame Buffer 2. 
 

<Message> Specifies Lyric Message Number. 

<Display Mode> Specifies mode of display: 

0: Instructs the system to Read Next (in other words, 
prebuild the message without displaying it on 
Duet's output; the message will be shown on the 
system's VGA monitor). 

1: Instructs the system to read and display on output 
 

 

In the following example, Message Number 9876 is displayed in Frame Buffer 1: 

V\5\3\1\1\9876\1\\<CR><LF> 
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V\5\13 Command - Read Message, Update All Intelligent Interface Fields 
The syntax for Miscellaneous Special Effects commands is as follows: 

V\5\13\1\<Buffer>\<Message>\<Display 
Mode>\Data\Data\...\Data\\<checksum><CR><LF> 

Parameter Description/Settings 

V\5\13\1 Specifies read message and update all fields in Template 
Description Message marked for Intelligent Interface 
Update.  Note that: 

 A single-space update within a V command skips a 
2D Text Template if and only if Auto-Erase is not 
enabled in the 2D Text Template dialog box.  The 2D 
Text Template dialog box is accessed by right-
clicking on a 2D Text Template, then selecting 
Template Properties from the context-sensitive 
menu. 

 A null update (\\) within a V command skips a 2D 
Text Template, regardless of Auto-Erase setting. 

1 Legacy parameter from the iNFiNiT!, which specified the 
User ID when two keyboards controlled one iNFiNiT! 
system.  Always keep this parameter set at 1. 

<Buffer> Specifies destination of the message: 

0: Reads the message to the system's VGA monitor. 

1: Displays the message on Frame Buffer 1. 

2: Displays the message on Frame Buffer 2. 
 

<Message> Specifies Lyric Message Number. 

<Display Mode> Specifies mode of display: 

0: Instructs the system to Read Next (in other words, 
prebuild the message without displaying it on 
Duet's output; the message will be shown on the 
system's VGA monitor). 

1: Instructs the system to read and display on output. 
 

<Data> Each <Data> string replaces the data in a Template field.  
Template fields are replaced in order of their numbering.  
Fields not enabled for Intelligent Interface update are 
skipped. 

 

The following example updates Tab Description message #9876 with ABC for the first field, and DEF for the 
second field, displaying the message in Frame Buffer 1: 

V\5\13\1\1\9876\1\ABC\DEF\\<CR><LF> 

V\5\14 Command - Read Message, Update External Update Fields 
This command has the same general syntax and requirements as in V\5\13, but this command updates only 
the fields which are flagged for External Update. 
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V\6 Command - Trigger Animation 
The V\6 command triggers playback of the current Lyric animation in the specified frame buffer.  After 
completion of the animation playback, Lyric sends the V6 response described below in V Commands - 
Completion Status.  The syntax for Trigger Animation command is as follows: 

V\6\<frame buffer>\\<CR><LF> 

Parameter Description/Settings 

V\6 Specifies the Trigger Animation command. 

<Buffer> Specifies destination of the message. 

0: Reads the message to the system's VGA monitor. 

1: Displays the message on Frame Buffer 1. 

2: Displays the message on Frame Buffer 2. 
 

 

V\<buffer>\U Command - Use Message 
In Multi FX Mode (Duet SD only), the Use Message effect plays the animation in the same manner in which 
it was originally saved in the Lyric message.  Any animation in a message called up in this mode is allowed to 
play out before Lyric displays the next message.  The general syntax for a Use Message command is as 
follows: 

V\<Buffer>\U\<Control>\\<CR><LF> 

Parameter Description/Settings 

V Specifies Special Effect command. 

<Buffer> Specifies Frame Buffer in which the effect executes: 

1: Frame 
Buffer 1 

2: Frame Buffer 2 

 
U Specifies Use Message effect. 

<Control> Specifies which In/Out effects are set up: 

1: Effect In 2: Effect Out 3: Both Effect In/Effect 
Out 
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V Commands - Completion Status 
As with all other commands, Lyric responds to V commands with an asterisk upon receipt.  However, the 
program then responds with completion status when the Read or Play operation has been completed as 
follows:  

Response Description 

*V\5\\<checksum><CR><LF> For successful V\5 commands. 

V\5\<error 
code>\\<checksum><CR><LF> 

For failed V\5 commands. 

*V\<buffer>\\<checksum><CR><LF> 

(Where buffer is 01 for Frame 
Buffer 1, 02 for Frame Buffer 2 and 
00 for the VGA monitor) 

For V\6 commands. 

All responses are terminated with a checksum and carriage-return/linefeed pair <checksum><CR><LF>. 
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V Commands - Multi FX Setup Commands (Duet SD) 

Multi FX Setup Commands 
Multi FX can be set up and executed via Intelligent Interface.  Refer to Multi FX for details on Multi FX 
operation. 
An individual message can be replayed starting from any segment.  Pages can update multiple times without 
reloading the message, before starting the Multi FX Out Effect.  Note that as of Lyric v4.0, new versions of 
existing Multi FX "V" commands have also been added.  Existing "V" commands are still properly read and 
executed. 

The Start, Pause and End points of Multi FX message define the segments of the message.  To replay a 
message starting from the beginning of a specific segment, use the following command: 

V\7\T\<Type>\<Value>\\ 

 V identifies that it is a special effect command. 

 7 identifies that it is a Multi FX command. 

 T addresses the Transport Control, which controls playback. 

 <Type> should be set to S, which identifies it as an animation segment. 

 <Value> identifies the segment number at which the Multi FX should be rewound, with 1 being the 
first segment.  Segment <Value> can also be set using the following: 

B = Beginning of Multi FX message 

P = Previous segment of the Multi FX message 

N = Next segment of the Multi FX message 

E = Ending segment of the Multi FX message 

Command Description/Settings 

V\7\B\<Buffer(s)>\\<CR><LF> Configures buffers for Multi FX.  The available 
settings for <Buffer> are as follows: 

0: Hide Multi FX Control dialog box and 
disable Multi FX. 

1: Display Multi FX Control dialog box 
and enable FB1 for Multi FX. 

2: Display Multi FX Control dialog box 
and enable FB2 for Multi FX. 

3: Display Multi FX Control dialog box 
and enable FB1 and FB2 for Multi 
FX. 

This command supercedes V\5\16 command, 
which continues to work. 
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Command Description/Settings 

V\7\E\<Buffer>\...<CR><LF> Configures effect for Multi FX buffer.  The 
available settings for <Buffer> are as follows: 

1: Effect is for FB1. 

2: Effect is for FB2. 

Refer to V\1 and V\2 for any additional effect 
parameters 

V\7\L\<Message>\\<CR><LF> Loads message into Multi FX and prebuild 
animation. 

<Message>: Indicates the name of the 
message to be loaded. 

This command supercedes the Y\<Message 
Number><F8>\\<CR><LF> command, which 
continues to work. 

V\7\M\<Mode>\\<CR><LF> Configures Multi FX Mode.  The available 
settings for <Mode> are as follows: 

0: Transition Mode.  Multi FX is 
disabled and Play commands operate 
on one frame buffer. 

1: Normal Mode.  Multi FX is enabled 
and Play commands operate on all 
frame buffers. 

 
V\7\P\\<CR><LF> Plays Multi FX effect. 

This command supercedes the 
Y\<D5><F3>\\<CR><LF> command, which 
continues to work. 

V\7\T\<Type>\<Value>\\<CR><LF> Jogs Transport Control to a new position.   

The available setting for Type is as follows: 

S: Specifies that the parameters are 
applied to an animation segment.  
Segments are delineated by 
keyframes. 

Value represents the Segment Number to 
which to rewind, with 1 being the first segment 
of the animation. 

Value can also be specified by one of the 
following settings: 

B: Beginning segment of animation. 

P: Previous segment of animation. 

N: Next segment of animation. 

E: Ending segment of animation. 
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Method of Operation 
Since all effects are embedded in Lyric animations, the Use Message effect should be specified as both the 
In and Out effect for both frame buffers in Multi FX. 

The following demonstrates an Intelligent Interface command sequence: 

Command Description 

V\7\B\3\\  Configure Multi FX to use FB1 and FB2.  Use Message for In and 
Out effects by default. 

V\7\L\300\\  Load message 300 into FB1 and prebuild 

V\7\P\\  Play Effect In for message 300. 

V\7\M\0\\  Enter Multi FX Transition Mode. 

Repeat this block as many times as necessary. 

V\7\T\S\2\\  Go to animation segment 2. 

U\*\0\Name 
1\\  

Update Template 0 with new contents (Templates 0 and 1 are on-
screen). 

U\*\1\Name 
2\\  

Update Template 1 with new contents. 

U\*\2\Name 
3\\  

Update Template 2 with new contents (Templates 2 and 3 are off-
screen). 

U\*\3\Name 
4\\  

Update Template 3 with new contents. 

V\7\P\\  Play animation segment 2. 

V\7\T\S\2\\  Go to animation segment 2. 

U\*\0\Name 
3\\  

Update Template 0 with new contents (Ensure that screen contents 
don't change). 

U\*\1\Name 
4\\  

Update Template 1 with new contents (Ensure that screen contents 
don't change). 

U\*\2\Name 
5\\  

Update Template 2 with new contents. 

U\*\3\Name 
6\\  

Update Template 3 with new contents. 

V\7\P\\  Play animation segment 2. 

Use this block to go to the next message. 

V\7\T\S\E\\  Go to last animation segment. 

V\7\M\1\\  Enter Multi FX Normal Mode. 

V\7\L\301\\  Load Message Number 301 into FB2 and prebuild. 

V\7\P\\  Play Effect Out for message 300 and Effect In for Message Number 
301. 
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About Effect Direction 
For all effect setup commands, Direction is specified using the numbers 1 - 9, based on the layout of the 
number/arrow keys of the numeric keypad of the Duet/PC.  Not all Directions are applicable to each effect. 

7: Upper Left 8: Up 9: Upper Right 

4: Left 5: Center 6: Right 

1: Lower Left 2: Down 3: Lower Right 

 

Numeric Keypad 

Direction can indicate direction of movement, or the location at which movement starts, depending upon the 
Effect Type.  Effect Types are described in the following sections. 
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Focus 
NOTE 

As of Lyric v4.0, the V command which configures Multi FX has been replaced by V\7\E.  
Multi FX V commands created for earlier versions of Lyric are still correctly read and 
executed by Lyric v4.0 and later. 

The general syntax for a Focus effect command is as follows: 
V\7\E\<Buffer>\F\<Control>\<Fade>\<Ease Type>\<Ease Duration>\ 
<Effect Start>\<Effect Duration>\<Direction>\<Aspect>\\<CR><LF> 

Parameter Description/Settings 

V\7\E Specifies Special Effect command. 

<Buffer> Specifies Frame Buffer in which the effect executes: 

1: Frame 
Buffer 1 

2: Frame Buffer 2 

 
F Specifies Focus effect. 

<Control> Specifies which In/Out effects are set up: 

1: Effect In 2: Effect Out 3: Both Effect In/Effect 
Out 

 
<Fade> Specifies Automatic Fade settings: 

0: Automatic Fade 
Disabled 

1: Automatic Fade Enabled 

 
<Ease Type> Specifies Ease type: 

0: None 1: Ease In 2: Ease Out 3: Ease In/Out 
 

<Ease Duration> Specifies Duration of Ease:  Range = 0 - 100 Frames 

<Effect Start> Frame Number at which to start effect execution:  Range = 0 - 
1000 Frames 

<Effect Duration> Specifies Duration of Effect: Range = 0 - 1000 Frames 

<Direction> Specifies Direction, also known as Focal Point. 

7: Upper Left 8: Up 9: Upper Right 

4: Left 5: Center 6: Right 

1: Lower Left 2: Down 3: Lower Right 
 

<Aspect> Specifies Aspect, also known as Focal Length. 

Aspect: 1 - 100 
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Slide 
NOTE 

As of Lyric v4.0, the V command which configures Multi FX has been replaced by V\7\E.  
Multi FX V commands created for earlier versions of Lyric are still correctly read and 
executed by Lyric v4.0 and later. 

The general syntax for a Slide effect command is as follows: 
V\7\E\<Buffer>\S\<Control>\<Fade>\<Ease Type>\<Ease Duration>\<Effect 
Start>\<Effect Duration>\<Direction>\\<CR><LF> 

Parameter Description/Settings 

V\7\E Specifies Special Effect command. 

<Buffer> Specifies Frame Buffer in which the effect executes: 

1: Frame 
Buffer 1 

2: Frame Buffer 2 

 
S Specifies Slide effect. 

<Control> Specifies which In/Out effects are set up: 

1: Effect In 2: Effect Out 3: Both Effect In/Effect 
Out 

 
<Fade> Specifies Automatic Fade setting: 

0: Automatic Fade 
Disabled 

1: Automatic Fade Enabled 

 
<Ease Type> Specifies Ease type: 

0: None 1: Ease In 2: Ease Out 3: Ease In/Out 
 

<Ease Duration> Specifies Duration of Ease:  Range = 0 - 100 Frames 

<Effect Start> Frame Number at which to start effect execution:  Range = 0 - 
1000 Frames 

<Effect Duration> Specifies Duration of Effect: Range = 0 - 1000 Frames 

<Direction> Specifies Direction, also known as Focal Point. 

7: Upper Left 8: Up 9: Upper Right 

4: Left 5: Center 6: Right 

1: Lower Left 2: Down 3: Lower Right 
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PageTurn 
NOTE 

As of Lyric v4.0, the V command which configures Multi FX has been replaced by V\7\E.  
Multi FX V commands created for earlier versions of Lyric are still correctly read and 
executed by Lyric v4.0 and later. 

The general syntax for PageTurn effects commands is as follows: 
V\7\E\<Buffer>\T\<Control>\<Fade>\<Ease Type>\<Ease Duration>\<Effect 
Duration>\<Effect Start>\<Direction><Turn Orientation>\\<CR><LF> 

Parameter Description/Settings 

V\7\E Specifies Special Effect command. 

<Buffer> Specifies Frame Buffer in which the effect executes: 

1: Frame 
Buffer 1 

2: Frame Buffer 2 

 
T Specifies PageTurn effect. 

<Control> Specifies which In/Out effects are set up: 

1: Effect In 2: Effect Out 3: Both Effect In/Effect 
Out 

 
<Fade> Specifies Automatic Fade setting: 

0: Automatic Fade 
Disabled 

1: Automatic Fade Enabled 

 
<Ease Type> Specifies Ease type: 

0: None 1: Ease In 2: Ease Out 3: Ease In/Out 
 

<Ease Duration> Specifies Duration of Ease:  Range = 0 - 100 Frames 

<Effect Start> Frame Number at which to start effect execution:  Range = 0 - 
1000 Frames 

<Effect Duration> Specifies Duration of Effect: Range = 0 - 1000 Frames 

<Direction> Specifies Direction, also known as Focal Point. 

7: Upper Left 8: Up 9: Upper Right 

4: Left 5: Center 6: Right 

1: Lower Left 2: Down 3: Lower Right 
 

<Turn 
Orientation> 

Specifies how PageTurn executes - from the Inside or from the 
Outside. 

0: Inside 1: Outside 
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Static (Fade) 
NOTE 

As of Lyric v4.0, the V command which configures Multi FX has been replaced by V\7\E.  
Multi FX V commands created for earlier versions of Lyric are still correctly read and 
executed by Lyric v4.0 and later. 

The Static effect allows the display of only the first or last frame of an animated message that performing a 
Multi FX execution.  The general syntax for a Static effect command is as follows: 

V\7\E\<Buffer>\A\<Control>\<Fade>\<EaseType>\<Ease Duration>\ 
<Effect Start>\<Effect Duration>\\<CR><LF> 

Parameter Description/Settings 

V\7\E Specifies Special Effect command. 

<Buffer> Specifies Frame Buffer in which the effect executes: 

1: Frame 
Buffer 1 

2: Frame Buffer 2 

 
A Specifies Static effect. 

<Control> Specifies which In/Out effects are set up: 

1: Effect In 2: Effect Out 3: Both Effect In/Effect 
Out 

 
<Fade> Specifies Automatic Fade setting: 

0: Automatic Fade 
Disabled 

1: Automatic Fade Enabled 

 
<Ease Type> Specifies Ease type: 

0: None 1: Ease In 2: Ease Out 3: Ease In/Out 
 

<Ease Duration> Specifies Duration of Ease:  Range = 0 - 100 Frames 

<Effect Start> Frame Number at which to start effect execution:  Range = 0 - 
1000 Frames 

<Effect Duration> Specifies Duration of Effect: Range = 0 - 1000 Frames 
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Use Message 
NOTE 

As of Lyric v4.0, the V command which configures Multi FX has been replaced by V\7\E.  
Multi FX V commands created for earlier versions of Lyric are still correctly read and 
executed by Lyric v4.0 and later. 

In Multi FX Mode (Duet SD only), the Use Message effect plays the animation in the same manner in which 
it was originally saved in the Lyric message.  Any animation in a message called up in this mode is allowed to 
play out before Lyric displays the next message.  The general syntax for a Use Message command is as 
follows: 

V\7\E\<Buffer>\U\<Control>\\<CR><LF> 

Parameter Description/Settings 

V\7\E Specifies Special Effect command. 

<Buffer> Specifies Frame Buffer in which the effect executes: 

1: Frame 
Buffer 1 

2: Frame Buffer 2 

 
U Specifies Use Message effect. 

<Control> Specifies which In/Out effects are set up: 

1: Effect In 2: Effect Out 3: Both Effect In/Effect Out 
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Zoom 
NOTE 

As of Lyric v4.0, the V command which configures Multi FX has been replaced by V\7\E.  
Multi FX V commands created for earlier versions of Lyric are still correctly read and 
executed by Lyric v4.0 and later. 

The general syntax for a Zoom effect command is as follows: 
V\7\E\<Buffer>\Z\<Control>\<Fade>\<Ease Type>\<Ease Duration>\ 
<Effect Start>\<Effect Duration>\<Direction>\\<CR><LF> 

Parameter Description/Settings 

V\7\E Specifies Special Effect command. 

<Buffer> Specifies Frame Buffer in which the effect executes: 

1: Frame 
Buffer 1 

2: Frame Buffer 2 

 
Z Specifies Zoom effect. 

<Control> Specifies which In/Out effects are set up: 

1: Effect In 2: Effect Out 3: Both Effect In/Effect 
Out 

 
<Fade> Specifies Automatic Fade setting: 

0: Automatic Fade 
Disabled 

1: Automatic Fade Enabled 

 
<Ease Type> Specifies Ease type: 

0: None 1: Ease In 2: Ease Out 3: Ease In/Out 
 

<Ease Duration> Specifies Duration of Ease:  Range = 0 - 100 Frames 

<Effect Start> Frame Number at which to start effect execution:  Range = 0 - 
1000 Frames 

<Effect Duration> Specifies Duration of Effect: Range = 0 - 1000 Frames 

<Direction> Specifies Direction, also known as Focal Point. 

7: Upper Left 8: Up 9: Upper Right 

4: Left 5: Center 6: Right 

1: Lower Left 2: Down 3: Lower Right 
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V Command - Trigger Squeezeback Effect 
Squeezeback effects can be automated and triggered via Intelligent Interface commands. The general 
syntax is as follows: 

V\6\<IN-OUT Effect Number>\\<CR><LF> 

The IN-OUT Effect Number specifies an Effect Number as determined by the Slot Number to which the 
effect is assigned in the Squeezeback Panel and Effect direction (IN or OUT) as follows: 

 Numbers 11 through 20 trigger Squeezeback IN (forward) effects 1 through 10. 

 Numbers 21 through 30 trigger Squeezeback OUT (reverse) effects 1 through 10. 

Examples: 

 V\6\13\\ triggers Squeezeback IN effect number 3. 

 V\6\28\\ triggers Squeezeback OUT effect number 8. 

Refer to Intelligent Interface for additional details. 
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W Command - Create Template Data Message 
The W command is used to create a Template Data Message on disk.  Remember that the Template 
Description Messages from which the Template Data Messages are built are created within Lyric. 

Example:  The following W command creates Template Data Message 5501 using Templates defined in 
Lyric Message 5500. Template 0 is assigned John Doe.  Template 1 is assigned 100. 

W\5501\5500\John Doe\100\\<CR><LF> 

The following should be noted regarding W commands: 
 A single-space update within a W command skips a 2D Text Template if and only if Auto-Erase is 

not enabled in the 2D Text Template dialog box.  The 2D Text Template dialog box is accessed by 
right-clicking on a 2D Text Template, then selecting Template Properties from the context-sensitive 
menu. 

 A null update (\\) within a W command skips a 2D Text Template, regardless of Auto-Erase setting. 

 If a W command attempts to overwrite a read-only file, an error is returned. 

 When a Template Data Message created using the W command is read, Lyric displays the Message 
Number of the Template Description Message on the Canvas Title Bar. 

A Template Data Message can also be created by selectively recording (Ctrl + Record + D) the message 
from Lyric. 

See also Graphic Substitution. 
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X and R Commands - Request for External Update, Reply 
The X command (Request for External Update) is used to automatically request update of text and/or 
graphics when the message is recalled (read).  When  a message is recalled, the X command is automatically 
sent to the host computer connected to the specified Intelligent Interface port, when a Lyric message 
containing 2D Object (bitmap graphics) and 2D Text Template fields enabled for External Update is recalled 
(read) by the user. 

One or both serial ports may be used.  In dual port operation, both Serial Port 1 and Serial Port 2 can 
receive data simultaneously.  In this configuration, Lyric transmits the X command only through Serial Port 1.  
All other commands are valid for either port. 

After receiving an X command from Lyric, the external computer responds with an R (Reply) command 
carrying the  file names and data to populate the Lyric Template fields. 

The general syntax for the X command is as follows: 
X\<Serial Port Number>\<****> or <Template Data Message Number to 
Read>\<Template Data Message to Which to Write>\<2D Object Template 
Name>\...\<2D Text Template NumberName>\...\\<CR><LF> 

The general syntax for the R command is as follows: 
R\<2D Object File Name>\...\<2D Text Data>\...\\<CR><LF> 

Parameter Description/Settings 

X Queries the external computer for updated data. 

<Serial Port 
Number> 

Identifies the serial port to which the data should be sent. 

<****> 
or 

<Template Data 
Message Number 
to Read> 

The X command sends one of the following pieces of data 
when a message is read: 

 If the message that is recalled (read)  is a Tab 
Description Message, <****> is sent.  It appears as 
\****\ in the command. 

 If the message that is recalled (read) is a Tab Data 
Message, <Template Data Message Number to 
Read> is sent. 

<Template Data 
Message to Which 
to Write> 

Creates new Template Data Message to which to write 
updated data. 

The following fields request update for specific 2D Object and 2D Text Templates.  
There can be any combination of 2D Object and 2D Text fields in the X command.  
The 2D Object fields should be listed first.  

<2D Object 
Template Name> 

Sends Name of the 2D Object Template enabled for Ext. 
Update.  Do not confuse the Template name with the file 
names of the bitmaps themselves.  The Name is set in the 
2D Object Template dialog box, accessible by right-clicking 
on a 2D object on the Canvas or on its listing in the Scene 
Graph,  then selecting Show 2D Object Properties from 
the context menu.  For detailed information on Intelligent 
Interface update of 2D objects (bitmaps), refer to Graphic 
Update.  

<Template 
NumberTemplate 
Name> 

Sends Number and Name of the 2D Text Template 
enabled for Ext. Update.  There is no space entered 
between the Number and the Name, although there can be 
spaces within the Name itself.  The Number and Name are 
set in the 2D Text Template dialog box, accessible by right-
clicking on the Template, then selecting Template 
Properties from the context menu. 
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Parameter Description/Settings 

R Reply command from the external computer. 

2D object and text updates are sent as follows: 

<2D Object File 
Name> 

Updated 2D object files sent to 2D Object Templates 
enabled for Ext. Update. 

<2D Text Data> Updated 2D text sent to 2D Text Templates enabled for 
Ext. Update. 

Examples 
Example 1 - Text Update: 
The following X command requests data for two Template fields in a Template data message.  

1. Create a 2D Text Window containing two empty 2D Text Templates. 

2. In the 2D Text Template dialog box (see figure below), enable (check) Auto Erase and External 
Update for each of the two 2D Text Templates.  Clicking the External Update checkbox also 
automatically activates II Update. 

3. Assign 0 (zero) in the Number window to the first Template that you created, and 1 to the second 
Template. 

4. For the purpose of this exercise, record the message as Message Number 1020. 

 

Templates Saved with External Update Enabled 
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5. Erase the message, then recall (read) it.  A prompt appears on the Lyric Canvas as shown in the 
following figure.  Do not click Cancel. 

 

Waiting for Update Prompt 
Lyric then sends the following string: 

X\1\****\1020\00Template:0\01Template:1\\ 

 X is the command itself.  

 1 identifies the system’s primary user (in Lyric’s command implementation, this is always 1).  

 The four asterisks indicate that only a Tab Description Message and no other commands are being 
sent and no Tab Data message is included. 

 1020 is the number of the Lyric message requesting External Update. 

 00Template:0 and 01Template:1 identify the Templates.  Note that Template:0 and Template:1 
are taken from the Name field in the 2D Text Template dialog box.  Note that when setting up 
templates on Lyric, any name can be entered into this field.  

 

2D Text Template Dialog Box - Template Name 

The application running on the external system must respond with a string formatted in this way: 
R\1\<content of lowest numbered field>\<content of next-highest-numbered field>\\ 

Again, R is the command itself, 1 identifies the primary system user, forward slashes separate parts of the 
message, and the message must end with two forward slashes.  Note that the number of Templates 
addressed by the R command must match the number of Templates marked for update in the Lyric message, 
otherwise, an error message is generated. 

The Lyric page updates automatically. 

Example 2 - Text and Graphics Update: 
The following X command requests data to be routed through Serial Port 1 to six Template fields associated 
with Template Data Message 0300 using Lyric message 0301. 

X\1\0300\0301Team 1 Logo\Team 2 Logo\00Team 1\01Score 1\02Team 2\03Score 
2\\<CR><LF> 

Note that if a Template Description Message is read instead, the syntax is as follows: 
X\1\****\0301\Team 1 Logo\Team 2 Logo\00Team 1\01Score 1\02Team 2\03Score 
2\\<CR><LF> 

A typical R command response to the above is: 
R\1\NY Logo.bmp\LA Logo.bmp\NY\100\LA\98\\<CR><LF> 

Disabling External Update 
Pressing Alt + U disables External Update of all Template fields.  The same function, Disable Interface 
Fields, is also available from the Edit menu. 
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Y Commands - Assorted 

About Y Commands 
Y commands control a number of Lyric functions such as Message Directory and active Frame Buffer 
selection, Erase, displaying/playing to output and clearing Clips. 

Command Description/Settings 

Y\<D5>d<Message 
Directory>\\<CR><LF> 

Sets the current Message Directory to new 
current Message Directory.  For example, to 
change to directory C/NAB, send the following 
command: 

Y\<D5>dC/NAB\\<CR><LF> 

Y\<D5><F3>\\<CR><LF> The Trigger command plays back the 
animation(s) that have been set up in Multi FX 
(Duet SD only).  On a single-VGE configuration, 
either the Animation In or Animation Out plays 
back.  If a sequence of messages is to be played 
back, the external application must send 
appropriate commands for Pre-Building a new 
message after playback of the Animation Out 
(see Pre-Build command below).  On a multiple-
VGE configuration, Lyric initializes Frame Buffer 
1 to Animation In and Frame Buffer 2 to 
Animation Out. 

After the Trigger command is issued, Lyric 
toggles the Animation In and Out for each 
Frame Buffer. 

If the Duet SD is not in Multi FX Mode, or the 
command is sent to a Duet HD or 
LE/LEX/PCI/PCI+, the Duet will execute the 
animation on the active frame buffer, without 
applying Multi FX. 

Y\<D5><F3><Frame 
Buffer>\\<CR><LF>  

Plays the animation on the VGA monitor or any of 
the available Frame Buffers. 

<Buffer> Parameters: 

 0:  Play to VGA monitor 

 1:  Play to Frame Buffer 1 

 2:  Play to Frame Buffer 2 

Note that specifying a Frame Buffer value is 
optional.  Not specifying a Frame Buffer is 
equivalent to specifying" 0", and plays the 
animation to the VGA monitor. 

For example, to play the animation to Frame 
Buffer 1, enter the following command: 

 Y\<D5><F3>1\\<CR><LF> 
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Command Description/Settings 

Y\<D5><F7><buffer>\\ 
<CR><LF> 

This command sets the active frame buffer to the 
buffer value specified. 

<Buffer> Parameters: 

 0:  Frame Buffer 1 

 1:  Frame Buffer 2 

 2:  Frame Buffer 3 

Y\<D5><F9>\\<CR><LF> Transfers contents of the VGA Canvas to Duet 
output. 

Y\keypad#keypad#...<F8>\\ 
<CR><LF> 

Reads a message into the current VGE output.  
For example, to read Message Number 0200, 
send the following command: 

Y\<C0><C2><C0><C0><F8>\\ 
<CR><LF> 

Y\<CD>\\<CR><LF> Erases the Canvas. 

Y\<FE>\\<CR><LF> Erases the Canvas. 

Y\<F9>\\<CR><LF> Swaps Channel 1 and Channel 2 outputs 

Y\<Message Number><F8>\\ Prebuild:  When Duet SD is in Multi FX Mode, 
this command loads the Frame Buffer with the 
specified message in preparation for a trigger (i.e. 
Play) command. For multiple VGEs, Lyric 
automatically builds to alternating Frame Buffers 
each time the Prebuild command is sent.  
Typically, a Prebuild command is issued before 
each trigger command. 

If the Duet SD is not in Multi FX Mode, or the 
command is sent to a Duet HD or 
LE/LEX/PCI/PCI+, the Duet will read the specified 
message without a Prebuild. 

Y\<1B>\\<CR><LF> Aborts the currently playing animation. 

The following "Y" Commands are used exclusively with Duet LE/LEX/PCI/PCI+: 

Y\<D5><CF><FE><Frame 
Buffer>\\<CR><LF> 

Clears the current Clip from the Canvas and 
stops the Internal Clip Player if a clip is present 
on the Canvas of the specified Frame Buffer.  If 
no Frame Buffer is specified, the operation 
occurs by default in the current Frame Buffer. 

This command is the equivalent to the following 
Duet/PC key combination: 

Ctrl + Alt + Esc + # 

where # is the Frame Buffer number. 
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Command Description/Settings 

Y\<D5><FE><Frame 
Buffer>\\<CR><LF> 

Clears the current Clip from the Canvas, erases 
the current Frame Buffer and stops the Internal 
Clip Player if a clip is present on the Canvas of 
the specified Frame Buffer.  If no Frame Buffer 
is specified, the operation occurs by default in the 
current Frame Buffer. 

This command is the equivalent to the following 
Duet/PC key combination: 

Ctrl + Esc + # 

where # is the Frame Buffer number. 

iNFiNiT!® Family Compatibility 
For compatibility with iNFiNiT!® Family Intelligent Interface®, all Y commands may be sent using the 
<01><Data><02> command sequence. For example, to erase the screen, send:  

<01><CD><02> 

To read Message Number 200, send the following command:  
<01><CO><C2><CO><CO><F8><02> 
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iNFiNiT!® Family Keyboard Codes 
The iNFiNiT!® Family Keyboard Codes table provides the hex and decimal equivalents for each of the keys 
found on the iNFiNiT!, and where applicable, the Duet keyboards. 

KEY DECIMAL HEX  KEY DECIMAL HEX 

MODE SLCT 255 FF  SETUP 234 EA 

ESC 254 FE  Keypad 0 192 C0 

FONT 1 160 A0  Keypad 1 193 C1 

FONT 2 161 A1  Keypad 2 194 C2 

FONT 3 162 A2  Keypad 3 195 C3 

FONT 4 163 A3  Keypad 4 196 C4 

FONT 5 164 A4  Keypad 5 197 C5 

FONT 6 165 A5  Keypad 6 198 C6 

FONT 7 166 A6  Keypad 7 199 C7 

FONT 8 167 A7  Keypad 8 200 C8 

RED 168 A8  Keypad 9 201 C9 

MGTA 169 A9  Keypad CLR 202 CA 

BLUE 170 AA  DEL ROW 218 DA 

CYAN 171 AB  INS ROW 219 DB 

YEL 172 AC  CNTR ROW 220 DC 

GRN 173 AD  DEL CHAR 221 DD 

WHT 174 AE  INS CHAR 222 DE 

BLK 175 AF  <(NEWLINE) 206 CE 

CNTR PAGE 223 DF   140 8C 

ALT 207 CF   141 8D 

ERASE 205 CD   142 8E 

DEL MSG 240 F0   143 8F 
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KEY DECIMAL HEX  KEY DECIMAL HEX 

RCD 241 F1  SHIFT CHAR +  136 88 

F1 208 D0  SHIFT CHAR +  137 89 

F2 209 D1  SHIFT CHAR +  138 8A 

F3 210 D2  SHIFT CHAR +  139 8B 

F4 211 D3  SHIFT + SHIFT 
CHAR +  

152 98 

F5 212 D4  SHIFT + SHIFT 
CHAR +  

153 99 

F6 (SHIFT F1) 224 E0  SHIFT + SHIFT 
CHAR +  

154 9A 

F7 (SHIFT F2) 225 E1  SHIFT + SHIFT 
CHAR +  

155 9B 

F8 (SHIFT F3) 226 E2  SHIFT ROW +  128 80 

F9 (SHIFT F4) 227 E3  SHIFT ROW +  129 81 

F10 (SHIFT F5) 228 E4  SHIFT ROW +  130 82 

CNTL 213 D5  SHIFT ROW +  131 83 

CHNG 247 F7  SHIFT + SHIFT 
ROW +  

144 90 

XFER 249 F9  SHIFT + SHIFT 
ROW +  

145 91 

HOME 203 CB  SHIFT + SHIFT 
ROW + 

146 92 

COLOR FONT 204 CC  SHIFT + SHIFT 
ROW + 

147 93 

SHIFT PAGE +  132 84  DO 243 F3 

SHIFT PAGE +  133 85  SLOW REVL 245 F5 

SHIFT PAGE +  134 86  READ NEXT 246 F6 

SHIFT PAGE +  135 87  READ 248 F8 

SHIFT + SHIFT 
PAGE +  

148 94  CRAWL 216 D8 

SHIFT + SHIFT 
PAGE +  

149 95  ROLL 217 D9 
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KEY DECIMAL HEX  KEY DECIMAL HEX 

SHIFT + SHIFT 
PAGE +  

150 96  IMAGESTOR! 

(Key left of SPACE 
BAR.  This 
command is 
available only on an 
iNFiNiT! Family 
system equipped 
with the 
IMAGESTOR! 
option. 

235 EB 

SHIFT + SHIFT 
PAGE +  

151 97  SCSI Express 

(Key right of SPACE 
BAR>  Available 
only on a MAX!> or 
MAXINE! system 
equipped with the 
SCSI Express 
option.) 

236 EC 

CNVRT 214 D6  MAXINE! Preview 

(Key left of 
alphanumeric 1.  
Available only on a 
MAXINE! system 
equipped with 
MAXINE! Preview 
option.) 

231 E7 

MIX 233 E9     
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Error Codes 
If a checksum error or other error is detected, a 4-byte ASCII error code is transmitted, followed by a 
Carriage Return <CR> and Line Feed <LF>.  If no error is detected and the command was processed 
successfully, an asterisk (ASCII 42), followed by a Carriage Return and a Line Feed are transmitted.  

Please note that these error codes are from the complete implementation of iNFiNiT!® Family Intelligent 
Interface, provided to allow for Lyric feature set expansion.  A number of these errors apply to iNFiNiT! 
systems only. 

Error Code Description 

0001  Task timed out. 

0002  Unimplemented system service. 

0003  Illegal service. 

0004  Illegal node. 

0005  Object has been deleted. 

0006  Invalid object ID. 

0007  Incorrect object ID. 

0008  Incorrect object type. 

0009  Object not found. 

0014  Cannot create message - No task control blocks. 

0015  Cannot create message - No stack space available. 

0016  Cannot create the message -The stack space is too small. 

0017  Cannot create the message -Priority out of range. 

0018  Cannot start the process - Already active. 

0019  Cannot restart the process - The process was never started. 

0020  Cannot suspend process - Process is already suspended. 

0021  Cannot resume process - It was never suspended. 
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Error Code Description 

0022  Cannot change priority - Out of range. 

0023  Illegal task register number. 

0024  Cannot delete - File is open. 

0051  Cannot create - No more queue control blocks. 

0052  Cannot create or send - No message buffers. 

0053  Cannot send - The message queue is full. 

0054  Cannot receive - The queue has been deleted. 

0055  Cannot receive - There are no pending messages. 

0056  Informative - There were tasks waiting when the queue was deleted. 

0057  Informative - There were messages waiting when the queue was 
deleted. 

0065  Cannot create - No more SCBs. 

0066  Cannot acquire - Semaphore not available. 

0067  Cannot acquire - Semaphore deleted while waiting. 

0068  Informative - There were tasks waiting when the Semaphore was 
deleted. 

2001  An invalid function number was called. 

2002  pHILE failure was encountered. 

2003  An inconsistent structure was found on the volume. 

2004  No more TCB extensions. 

2005  Init volume parameter error. 

2006  No more volume table entries. 

2007  Alien volume. 
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Error Code Description 

2008  Volume already mounted. 

2009  Cannot unmount - there are files open. 

200A  Device not mounted. 

200B  File not found. 

200C  Illegal filename. 

200D  No Default Directory found. 

200E  Directory file expected. 

200F  Illegal annex size to create. 

2010  Null filename. 

2011  File already exists. 

2012  F list full. 

2013  File open. 

2014  Directory is not empty. 

2015  System or directory file. 

2016  Different devices (MOVE_F). 

2017  MOVE_F would result in non tree structure. 

2018  No more open file entries. 

2019  No more FCBs. 

201A  Invalid FID, too large. 

201B Invalid FID, file closed. 

201C  Indirect block full. 
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Error Code Description 

201D  Volume full. 

201E  Bad position to lseek. 

201F  Seek past end of file. 

2021  Illegal device (exceeded maximum). 

2022  Data is locked. 

2023  Bad fn in OPEN_VOL. 

2024 Illegal flush mode to MOUNT_VOL. 

2025  Illegal device name. 

2026  Bad MS/DOS call. 

2027  Illegal MS disk type. 

2028  More than one type of MS disk type. 

2040  Used Tab page 

2F01  Insufficient data area. 

2F0E  Check sum in pHILE. 

2F0F  Check sum in pVERIFY+. 

400B  Checksum does not match computed checksum. 

40B2  Requested message directory does not exist. 

40B3  Requested message file does not exist. 

412C  Requested description file is not a Tab Description file. 

412D  Requested data file is not a Tab Data file. 

412E  Requested field is not a valid field. 
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Error Code Description 

412F  Requested attribute (Color or Font) is not valid. 

4130  Field contains too much data (limit 64 characters). 

4131  Incorrect number of fields, R command does not match X 
command. 

415E  Description message was created with old Tabs (Templates). 

415F  Number of Tabs (Templates) exceeds limit (99). 

4190  Desired operation is not terminated with "\\". 

4191  The command format is incorrect. 

4192  An invalid operation has been requested. 

4193  An invalid Machine ID has been used. 

4194  An invalid Effects ID has been used. 

41C2  An invalid User ID has been used (either 1 or 2). 

41C3  An invalid Keyboard ID has been used (either 1 or 2). 

41C4  The command to set the active message compose frame buffer 
failed. 

41C5  An invalid Frame Buffer ID was used (either 1, 2, or 3). 

41C6  Error building into a non-displaying buffer; a bad message type was 
used or no Read Next command was issued. 

41C7  Command to set Palette failed. 

41C8  Color Key out of range; must be 1 - 8. 

41C9  Palette Index out of range; must be 1 - 31. 

41CA  Color Index out of range; must be 0 - 255. 

41CB  Key out of range; must be 0 - 1. 
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Error Code Description 

41CC  Attempted to perform a Dual-User operation in Single-User mode. 

41CD  Timed out waiting for response. 

41CE  Error building Message Compose Palette. 

41CF  Error erasing displayed Frame Buffer. 

41D0  Display/Non-Display flag out of range, i.e., 0 - 1. 

41D1  No Intelligent Interface option. 

41D2 Bitmap not created. 

41D3 Bitmap file not found. 

41D4 Invalid Field Number. 

41D5 Missing Macro. 

41D6 Macro Error. 

41D7 Duplicate Macro. 

5000  New Playlist created. 

5001  Invalid Playlist Number. 

5002  No Playlist loaded. 

5003  File not Playlist. 

5004  Old version of Playlist. 

5005  Playlist already exists. 

5006  Playlist finished executing. 

5010  Invalid Playlist Entry Number. 

5011  Error allocating Playlist Entry. 
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Error Code Description 

5012  Error adding Playlist Entry. 

5020  Invalid Channel allocated. 

5021  No Channel allocated. 

5022  No Frame Buffer allocated. 

5030  Invalid Still Message Number. 

5031  Still File not found. 

5050  Invalid IMAGESTOR! command. 

5051 Invalid Effect. 

5052  Invalid Pattern. 

5053  Invalid Speed. 

5054  Invalid Ease parameter. 

5055  Invalid Reverse parameter. 

5056  Invalid Keyboard Lock Status. 

7000  No memory to create outline. 

7004  No Frame Buffer available for graph. 

7008  No memory for the Fill Line Buffer. 

7100  Line segment not between 0 and MAX_LINE_SEG. 

7108  Invalid Pulse parameter specified, i.e., not _PULSE(0) or 
_NON_PULSE(1). 

710C  Invalid display buffer specified, i.e., not _DBUF(0) or _NBUF(1). 

7110  Invalid Trigger type specified, i.e., not _REGULAR_LINE(0), 
_PULSE_LINE(1) or _BOTH(2) 
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Error Code Description 

7114  Invalid Mode specified, i.e., not _ENTIRE_LINE(0) or 
_LAST_SEGMENT(1). 

7118  Specified Pacing value outside of range, i.e., not between -30 and 
30. 

7200  Brush not successfully created. 

7204   Invalid Edge specified, i.e., not _HARD(0), _SOFT(1), 
_SOFT_EDGE(2) or _CLEAR(3). 

7208  Invalid Transparency, i.e., not between 0 and 100. 

720C  Brush diameter out of range. 

7210  Invalid RGBA file name, i.e., RGBA value has more than 8 digits. 

7300  Point not added to outline. 

7304  No outline exists for this line segment.  

8001  Wrong Read Effect task. 

8002  Bad Read Effect command. 

8003  Wrong Read Effect command. 

8004  Bad Read Effect Mode. 

8005  Bad Read Effect Ease. 

8006  Bad Read Effect Speed. 

8007  Bad Read Effect Type. 

8008  Bad Read Effect Reverse. 

8009  Bad Read Effect Row Direction. 

800A  Bad Mix Effect Percent. 

800B  Bad Mix Effect Soft Edge. 
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Error Code Description 

800C  Rows cannot be wiped left and right on old frame buffer. 

800D  Must specify one row Up or Down. 

800E  Invalid Effect type. 

800F  No memory available for row type. 

8010  Frame buffer error occurred. 

8011  Frame buffer in use by another task, e.g., Clock, Flash. 

805001  Bad Transform syntax. 

805002  Bad Transform script. 

805003  Bad Transform directory. 

805004  Bad Transform message.  

805005  Bad Transform value. 

805006  Ignored. 

805007  Bad Transform command. 

805008  Transform not available. 
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32. Macros 

Overview 
View Menu > Macros 

NOTE 
To use Macros, the Duet or PC on which you are running Lyric must have Microsoft 
Internet Explorer 6.0 or later installed. 

Macros are VB Script programs that are can simplify and automate repetitive tasks for easy recall in on-air or 
production situations.  Such tasks include reading messages, keystrokes, menu selections, etc.  They can be 
triggered as needed, and/or a macro can be set to automatically execute at the time when the macro file is 
read. 

This section covers the use of macro scripts as triggered from within Lyric.  Individual macro commands, 
however, can be sent to Lyric via Intelligent Interface®.  Refer to Intelligent Interface:  E Command - Send 
Macro Commands for detailed information. 

Note that not all keystrokes or mouse actions are supported in Lyric macros.  Refer to Specifying 
Characters Using SendKeys Commands for additional information.  Supported Lyric functions are listed at 
the end of this section. 

About VB (Visual Basic) Script 
Lyric macros are founded on the VB Script language, allowing sophisticated, high-level programs to be 
created and assigned to macros.  These include custom user interfaces for data acquisition and display.  The 
use of VB Script also enables the macro user to control custom CAL (Chyron Abstraction Layer) applications.  

The Macros Dialog Box 
For the purpose of the following example, make sure that the Lyric Canvas is empty, and does not contain a 
full-screen 2D Text Window.  The first step in creating a macro is to access the Macros dialog box.  To do 
so:  

 From the View menu, select Macros.  The Macros dialog box is displayed.  

  

Macros Dialog Box 
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The Macros dialog box is split into two panes.  The left pane displays the following information for each 
macro:  

 The name of the macro.  

 The hotkey, if specified, that executes the macro.  

 The file path of the macro once it has been saved. 

The right pane displays three tabs:  
 Description:  Displays a short description of each macro.  This tab is displayed on opening the 

Macros dialog box.  

 Script:  Displays the VB Script, i.e. the program, for the selected macro.  Macro scripts can be input 
in a variety of manners:  Typing a script directly into the Script tab; opening an existing macro file; 
and recording keyboard/mouse activity.  

 Globals:  Displays a list of Global Variables available for use by any of the macros and by macros 
which are subsequently read into the Macros dialog box. 

There are also a set of icons at the bottom left of the dialog box, which execute a variety of functions. 

The left and right panes can be resized by clicking-and-dragging, as can the Macro, Hotkey and File 
columns: 

 

Resized Macros Dialog Box 

Creating and Playing Back a Macro 
The following script that you will create will open a 2D Text Window, change its position twice, and display 
the word "Hello!"  

1. Click the Add icon  to initiate a new macro file.  The default new file name appears in the 
Description tab. along with the time and date.  Additional descriptive text can be typed in at any time.  
Text editing functions are available by right-clicking in the Description pane.  See Right-Pane 
Context Menu later in this section for additional information on this menu. 

 

 

Adding a New Macro 

 

Right-Pane Context 
Menu 

2. Click the Record icon.  The right pane switches to displaying the Script tab.  From this point on, 
almost any action performed on the Canvas is recorded as part of the macro.  Additionally, while the 
macro is recording, the Macro symbol  next to the default filename blinks, and the letter M in the 
Status Bar turns red. 

3. Click on the Canvas to make it the active window. 
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4. Open a 2D Text Window.  Note that the creation of the 2D Text Window has been recorded. 

  

Macros Script Recording the Addition of a 2D Text Window  
5. Click-and-drag the 2D Text Window to a new position, and then click-and-drag it to still a different 

position.  Each change in position is recorded as a pair of commands:  one addressing the X position, 
and one addressing the Y position.  

  

Macros Script Recording 2D Text Window Movement  
Most actions involved in creating a Lyric composition can be recorded as part of a macro.  Actions not 
directly related to the creation of the Lyric composition, for example clicking on a window to make it 
active, are generally ignored.  Refer to the end of this section for a complete list of the actions that 
can be recorded in a macro. 

6. In the 2D Text Window, type the word "Hello!"  Each character that is typed is recorded in the macro. 

  
Macros Script Recording Text Typing  

7. Click the Stop icon. The Macro symbol  does not stop flashing until the current macro is saved 
or abandoned.  Saving macros is covered later in this section. 

8. Press Ctrl + Q to erase the Canvas.  Now that recording has stopped, the Erase command is not 
added to the macros script. 
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9. Click the Play icon  or double-click the macro name.  The window containing the typed "Hello!" 
appears on the Canvas.  Because no timing commands were included in this macros script, the 
repositioning of the 2D Text Window and the typing of the characters may be imperceptible on 
playback.  A macro can also be executed by pressing a Hot Key combination, which is a keyboard 
shortcut.  Setting Hot Keys is covered later in this section. 

Add additional macros and experiment with other Lyric composition tools to see how they are translated into 
VB Script commands. 

Right-Pane Context Menu 
The right-pane context menu accesses text editing functions in the Description, Script and Globals tabs.  To 
display this menu:  

 Right-click the right pane (displaying the Description, Script and Globals tab) of the Macros dialog 
box. 

 

Right-Pane Context Menu 

Standard Windows text editing functions such as Cut, Copy, Paste, Delete and Select All are available from 
this menu.  If certain language packages are installed, three additional items are displayed:  

 Right-to-Left Reading Order:  Right-justifies the text, and specifies that the text should be read from 
right-to-left.  To toggle on/off, click Right-to-Left Reading Order.  When active, a check is displayed 
next to the menu item.  

 Show Unicode Control Characters:  Currently not implemented.  

 Insert Unicode Control Character:  Currently not implemented. 

Left-Pane Context Menu 
The left-pane context menu accesses functions that allow one to edit, delete, save, set a hotkey or rename a 
macro.  To display this menu:  

 Right-click a macro name in the left pane of the Macros dialog box.  The left-pane context menu is 
displayed.  Note that the Script Code item is grayed out.  This item only becomes active if the 
selected macro has been previously saved. 

 

Macros Left-Pane Context Menu 

The context menu items are covered in following order:  Save Macro; Script Code; Hot Key; Rename; 
Delete. 
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Saving Macros 
Macros that are listed in the Macros dialog box can be saved individually or together when a Save is 
executed.  Macros can be saved in two different formats.  

 *.lmx:  The *.lmx format is a file consisting solely of ASCII text, allowing the file to be opened in any 
text editor for editing.  Files of this format can also be used in programs outside of Lyric.  

 *.lyr:  The *.lyr format is executable only from Lyric.  The advantage to this format is that it allows one 
individual macro to automatically execute upon reading the macro file.  The *.lyr format also allows 
the file to be read as a Lyric message by entering the Message Number, then pressing Read.  It 
should not, however, be edited outside of Lyric. 

A macro script or macro name can also be embedded in a Lyric message, and is executed immediately when 
the message is read.  Refer to Selective Recording - Embedded Macro for details. 

To save a macro or group of macros as an *.lmx file:  
1. Select Save Macro from the left-pane context menu to save the selected macro, or click the Save All 

Macros to File icon  or press Ctrl + S to save all macros displayed in the Macros dialog box.  The 
Save As dialog opens.  

 

Save Macros As *.lmx  

2. In the Save In field, navigate to the directory in which the macro file is to be saved.  

3. In the Save as Type drop-down list box, select Lyric Macro Files (*.lmx).  Note that the Auto 
Execute drop-down is grayed out.  

4. Enter a File Name.  

5. Optional:  To save Global Variables, select (check) the Save Globals check box.  Global Variables 
are covered later in this section.  

6. Click Save. 

Note that the when a group of macros is saved as an *.lmx file, the code for each macro is displayed in order 
of its Macros dialog box listing when the .lmx file is opened in a text editor. 
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To save a macro or group of macros as a *.lyr message:  
1. Select Save Macro from the left-pane context menu to save the selected macro, or click the Save All 

Macros to File icon  or press Ctrl + S to save all macros displayed in the Macros dialog box.  The 
Save As dialog opens.  It is shown with the file information already entered.  

  

Save Macros As *.lyr  
2. In the Save In field, navigate to the directory in which the macro message is to be saved.  

3. In the Save as Type drop-down list box, select Lyric Macro Files (*.lmx).  

4. Enter a File Name.  

5. Optional:  In the Auto Execute drop-down list box, select the individual macro that should 
automatically execute when the macro message is read.  This step is necessary for auto-execution 
even if the macro message contains only one macro.  Leave the Auto Execute field blank if 
automatic macro execution should not take place.  

6. Optional:  To save Global Variables, select (check) the Save Globals check box.  Global Variables 
are covered later in this section.  

7. Click Save. 

If a macro was specified in the Auto-Execute field, the macro will execute when the Lyric macro message is 
read. 

Quickly Saving a Macro File (*.lyr) for Easy Recall 
The following procedures save the macro file in the .lyr format to the current Message Number in the Default 
Message Directory.  Using this recording method also makes allows for easy recall of the macro message, 
as described in Opening/Reading a Macro later in this section. 

A quick method for recording a Macro file in the *.lyr format is as follows:  
1. Press Ctrl + Record.  The Record Only: dialog box opens.  

2. Select Macros.  

3. Click Record. 

A shortcut key combination can also be used to record the macro:  
 Press Ctrl + Record M Enter. 

The above methods cannot be used to save Macro files in the .lmx format. 
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Opening/Reading a Macro 
Macro files in both the *.lmx and *.lyr formats can be opened in Lyric from File > Open, then by navigating to 
and selecting the file. 

Macro files in the *.lyr format, that also are identified by numeric names of eight digits or less, and that are 
stored in the Lyric Default Message Directory, can be read in the same manner as other Lyric messages.  

 Enter the Message Number, then press Read. 

Note that opening a macro that has the same Macro Name (not file name) as a macro already listed in the 
window results in the newer macro overwriting the older macro in the Macros dialog box.  This does not affect 
the original macro files that have been previously saved.  It simply affects which macro is currently loaded.  
When a macro in the Macros dialog box has not yet been saved, the overwrite would erase it. 

A macro can be embedded in a Lyric message so that it automatically executes when the message is read.  
Refer to Selective Recording - Embedded Macro for details. 

Script Code Window and Editing Script 
After an individual macro or group of macros is saved, the VB Script code for the entire file can be displayed 
and edited.  The changes can then be saved. 

To view and edit the macro file within Lyric:  
1. Select Script Code from the left-pane context menu.  The Script Code window is displayed.  

  

Script Code Window  

As shown in the previous figure, each individual macro, whether saved individually or as a group, is 
identified as a subroutine in the VB Script.  Script from any of the subroutines can be edited.  
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2. Make edits to the script.  To access available editing functions, right-click in the Script Code window.  

  

Script Code Edit Functions  

3. When editing is complete, click the Windows Close icon.  The following is displayed.  

  

Save Changes to Macro?  

4. Click Yes to save changes, No to exit the Script Code window without saving changes, or Cancel to 
cancel the operation and continue to edit. 

An individual macro can also be edited from within the Script tab of the Macros dialog box.  
1. Select (highlight) the macro name in the Macros dialog box. 

2. Click the Script tab.  The script for the selected macro is displayed. 

  

Editing  a Macro from the Script Tab  

3. Make edits to the script.  To access available editing functions, right-click in the Script Code window, 
as shown in the preceding figure.  

4. When editing is complete, the script can be played back.  Note that when editing in this manner, the 
script is not saved until one of the Save functions is executed. 
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Deleting a Macro/All Macros 
Macros can be deleted either individually or as a group from the Macros dialog box.  Note that Global 
Variables are not deleted by either operation. 

An individual macro can be deleted from the Macros dialog box.  
1. Right-click the macro name in the Macros dialog box.  

2. Select Delete from the context menu or press the Delete key.  The Confirm Delete prompt is 
displayed.  

  

Confirm Delete Prompt  

3. Click OK to delete, or Cancel to cancel the deletion. 

To erase all macros from the Macros dialog box:  

1. Click the Clear All Macros icon .  The Confirm Deletion prompt is displayed.  

  

Confirm Deletion Prompt  

2. Click OK to delete all macros, or Cancel to cancel the deletion. 
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Setting Hot Keys and Macro Symbol Colors 
A Hot Key, or keyboard shortcut, can be assigned to each individual macro, eliminating the need to use the 
mouse to execute the macro.  A color can also be assigned to the Macro symbol for easy recognition.  To set 
a Hot Key and a macro color:  

1. Right-click the macro name in the Macros dialog box.  
2. Select Hot Key from the context menu.  The Macro Short Cuts dialog box opens.  

 
Macro Short Cuts Dialog Box  

3. As shown in the preceding figure, enter a key combination in the Hot Key field, then select a color in 
the Icon color list.  For no color, select <none>.  

4. Click Apply.  The macro can now be executed by pressing the Hot Key combination.  The following 
figure shows Hot Keys and Macro symbol colors applied to all three macros.  

  
Hot Keys and Macro Symbol Colors Applied 

Renaming a Macro 
A individual macro can be renamed.  

1. Right-click the macro name in the Macros dialog box.  
2. Select Rename from the context menu.  The macro name become available for editing.  Type the 

new name of the macro.  Names must be composed of alphanumeric characters and must not 
contain spaces or punctuation characters.  

  
Renaming a Macro  
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3. Press Enter.  The macro displays the new name. 

  

Renamed Macro 

Global Variables 
A Global Variable is a value that is available to all macros.  A Global Variable can be an absolute value, or it 
can be determined by input from another source, i.e., a macro.  For example, a Global Variable such as a 
price, could be input via one macro.  Another macro could then display the Global Variable in a 2D Text 
Template on the Lyric Canvas. 

Global Variables can be defined in the Globals tab of the Macros dialog box.  Each Global Variable must 
be preceded by the word public, which indicates that it is available to all macros. 

Global Variables remain active until deleted or reset (See Resetting the Macro Engine and Global 
Variables following this subsection). 

To demonstrate a simple example, the following procedure will define a Global Variable.  Two macros will 
also be created:  one to take input of a number, and another to display it. 

To define a Global Variable "a", which is to be accessed by the macros:  
1. Click on the Globals tab in the Macros dialog box.  

2. Type the following:  public a 

 

Defining a Global Variable 

Create the input macro that displays a Windows input box.  This value becomes the Global Variable "a" that 
can be accessed by other macros.  

1. Click the Add icon .  This initiates the creation of a new macro.  Rename the macro as Input. 

  

2. Click on the Script tab.  Type the following:  a = InputBox ("Enter Number") 

To create the macro that displays the Global Variable "a" in a Windows message box. 
  

1. Click the Add icon .  This initiates the creation of a new macro.  Rename the macro as Output.  

2. Click on the Script tab.  Type the following:  MsgBox (a) 
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The macros can now be executed.  
1. Select the macro named Input, then double-click it or click the Play icon.  The following is displayed:  

  

Input Box Requesting a Value  

2. Type a number into the field.  For this example, we will use 456.  Click OK.  

3. Select the macro named Input, then double-click it or click the Play icon.  The following is displayed:  

  

Outputting the Global Variable 

Resetting the Macro Engine and Global Variables 
The macro engine can be reset, clearing out the macros and bringing the VB Script processor back to its 
initial state.  This is recommended when work with one set of macros is complete, and a new set is to be 
opened.  In addition, if macros that normally execute properly exhibit unexpected behavior, or newly created 
macros are retaining and executing previously created scripts, resetting the macro engine can restore proper 
function. 

Note that executing a reset also clears macros that have been created and sent via Intelligent Interface.  
These macros do not appear in the Macros dialog box.  After a reset, it is necessary to resend the macros to 
Lyric if they are to be used. 

The Reset Macro Engine and Global Variables can reset only the macros or the macros and Global 
Variables.  Generally, it is desirable not to reset the Global Variables, in order to leave them available for the 
next set of macros. 

To execute a reset:  
1. Specify whether the macros only, or the macros and the Global Variables are to be reset.  

 To Reset Macros Only:  In the right pane of the Macros dialog box, click either the 
Description tab or the Script tab. 

 To Reset Macros and Global Variables:  In the right pane of the Macros dialog box, click 
Globals tab.  
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2. Click the Reset Macro Engine and Globals icon .  The following is displayed.  

 

Confirm Macro Engine and Global Variable Reset Prompt  

3. Click OK to reset or Cancel to cancel the operation. 

Supported Functions For Macros 
The following Lyric operations can be performed using macro commands.  Refer to LEIF Help in Lyric Online 
Help for coding and syntax information. 

Object Maintenance  
 Add 2D window (including Roll, Crawl, Type-On, Clock, Timer)  

 Add 3D object (characters, Wavefront, 3DS model)  

 Add 2D image  

 Selection of object by name  

 Delete selected object(s)  

 Toggle visibility (checkbox on scene graph) 

2D Text Operations  
 Typing 2D characters  

 Cursor movement via arrow keys, home, end  

 Delete, backspace, next line  

 Insert 2D Text Template  

 Tab to previous/next template  

 Make Window Full Screen  

 Select All 2D Text  

 Insert/Delete Row  

 Delete to end of row  

 Pickup color/font  

 Apply color/font, using shortcut keys  

 Renumber templates  

 Shift/Super-Shift row and page  

 Ctrl +Tab  (inserts white space tab)  

 Escape (to exit an active template)  

 Font and Color Hot Keys 
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Animation Operations  
 Set keyframes through Canvas actions or changing values on the XYZ Properties page  

 Go to Next or Previous keyframe  

 Fast Forward    

 Fast Reverse    

 Frame Forward    

 Frame Reverse    

 Go to end of animation  

 Keyframe all objects/selected objects  

 Play or Reverse Play animation  

 Copy Animation State    

 Paste Animation State   

Duet Operations  
 Toggle Duet Live Button  

 Transfer  

 Channel selection/toggle  

 Swap  

 Transfer to next channel 

Scene Operations  
 Setting message number  

 Read  

 Record  

 Alt + Record  

 Open (specified filename)  

 Erase  

 Wait (pause between macro commands for a given timeout) 

Advanced Macro Scripting 

VBScript Built-Ins 
Since Lyric macros are written in VBScript, all VBScript commands are supported. However, these 
commands must be entered into the macro manually through the Macro Control Panel or Script Editor 
windows. LMX-formatted macro files can also be edited in any Windows editor such as Word or Notepad.  

Take note of the following suggestions on editing this type of file: 

Dim statements allow the creation of variables. Variable names must begin with an alphabetic character, 
must not contain dots and must contain fewer than 256 characters. Many languages require identification of 
the data type for each variable. Note that VBScript supports only the variant data type (which can contain all 
types of data). Therefore, it is unnecessary to declare a specific data type for VBScript variables: 

Dim myVariable  
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The Option Explicit statement may be added to the beginning of a script so that explicit declaration of all 
variables is required. Variables are named storage locations containing values that the script can modify. By 
default, scripts automatically create a variable upon first reference to this value. However, this methodology 
can mask minor typographical errors in the script. Using the Option Explicit device can help prevent problems 
of this type. 

After creation of a new variable, the Assignment operator (=) may be used to assign that variable a value. 
The following line assigns the value of 3 to myVariable: 

myVariable = 3 

Math: VBScript provides support for the full range of mathematical expressions. The following line shows how 
to perform simple math calculations and divide the result by the contents of myVariable: 

myVariable = ((5 + 1) * 2)/myVariable 

String Concatenation - A common VBScript technique is the combination of the contents of different strings. 
The Concatenation operator ( & ) may be used to create a new string: 

myVariable = "The value of myVariable is:" & myVariable 

Constants, like variables, are named values that may be used in scripts. However, the value of a constant 
cannot be altered like the content of a variable: 

const myTitle = "VBSample"   

The MsgBox function may be used to display messages to the user. The following example demonstrates 
how to display the message contained in myVariable. The message box’s title bar displays the value in 
myTitle: 

MsgBox myVariable, myTitle 

The InputBox function may be used to prompt the user for simple input values. The function automatically 
assigns the value that the user enters to the variable on the left of the equal sign. Note that the InputBox 
function encloses its argument in parentheses: 

myVariable = InputBox("Enter input here") 

If...Then...Else: The If statement is an important logical-flow control function. Present in virtually all scripts, 
the If statement evaluates a condition, then performs an action based on whether the condition is met: 

If myVariable = 1 Then  

        MsgBox "The value was 1"  

   Else  

        MsgBox "The value was not 1"  

End if 

In addition to message display, the MsgBox function is also capable of displaying buttons and returning the 
value of the button selected. The following example displays a message box that contains Yes, No, and 
Cancel buttons. The script assigns the selected button’s value to nButton. 

nButton = MsgBox("Click a button", vbYesNoCancel) 

The On Error statement lets a script trap runtime errors and continue executing. A test for errors in the script 
can be conducted after each statement has executed. 

On Error Resume Next 

The InStr function allows the user to locate a substring within a string. The function returns the starting 
position of the substring or a 0 if the function does not find the string. In  

nPos = InStr("123345", "33") 

nPos has a value of 3 because "33" begins in the third position of "123345". 
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The Do Loop - This basic mechanism for repeatedly executing a set of statements can take either of two 
forms, a Do Until Loop or a Do While Loop. The most important distinction between the two is that the Do 
Until Loop always executes at least once. 

Do Until myValue > 1   

     myValue = myValue + 1  

Loop 

Use the Select Case statement to compare an expression against several other expressions. 
Select Case nButton   

     Case vbYes MsgBox "Yes"   

     Case vbNo MsgBox "No"   

     Case Else MsgBox "Cancel" 

End Select 

Examples of Macros 
When creating macros of the following types in an .lmx-formatted file, all of the lines shown below should be 
entered, including those beginning with "Sub" and "End".  

However, if the desired end result were an .lyr-formatted file, only the text between the "Sub" and "End" lines 
would be entered. (The lines beginning with "Sub" and "End Sub" would be automatically added internally). 
The lines beginning with a single quote denote comments, which are for informational purposes only; the 
single quote indicates that the macro engine should not execute these lines. 

Types the word "Macros" (in 3D if a 2D Text Window is not active, 2D otherwise) 
Sub TypeMacro 

     ActiveCanvas.Selection = "M" 

     ActiveCanvas.Selection = "a" 

     ActiveCanvas.Selection = "c" 

     ActiveCanvas.Selection = "r" 

     ActiveCanvas.Selection = "o" 

     ActiveCanvas.Selection = "s" 

End Sub 

Adds a window to the scene and makes it full screen  
Sub FullScreenWnd 

     ActiveCanvas.Scene.InsertObject(otText) 

     ActiveCanvas.Selection.Execute("Make FullScreen") 

End Sub 

Reads message 5014 and plays it 
Sub GoOlympics 

     Lyric.Message 5014 

     Lyric.Read 

     ActiveCanvas.Selection.Execute("Play Animation") 

End Sub 
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Adds a 2D window, types the word "delete", then deletes the ‘d’ 
Sub CharDelete 

     ActiveCanvas.Scene.InsertObject(otText) 

     ActiveCanvas.Selection = "d" 

     ActiveCanvas.Selection = "e" 

     ActiveCanvas.Selection = "l" 

     ActiveCanvas.Selection = "e" 

     ActiveCanvas.Selection = "t" 

     ActiveCanvas.Selection = "e" 

     ActiveCanvas.Selection.Home  

     ActiveCanvas.Selection.Right scShift 

     ActiveCanvas.Selection.Delete  

End Sub 

Uses VBScript built-in InputBox command to prompt user for message number to read 
Sub MsgNInput 

     Lyric.Message CInt(InputBox("Enter Message Number")) 

     Lyric.Read 

End Sub 

Using ActiveX Objects In Macros 
In addition to these built-in and Lyric-based macro commands, users can also access third-party controls 
supported in VBScript.  

To use any ActiveX object in a Lyric macro, use the CreateObject statement. 
Set myObj = CreateObject("ActiveXObject.Object1") 

Once the object is created, use dot notation to reference the objects’ properties or methods. 
myObj.Name = "NewName"  

theName = myObj.GetName( ) 

Two of the most useful of these objects are the ActiveX Data Object and the Windows Scripting Host that 
are supported by Microsoft. 

ActiveX Data Object 
Microsoft® ActiveX Data Object , or ADO, can be used to access ODBC-compliant databases in a manner 
similar to Lyric’s DB Link feature. The ADO API reference can be found on the Microsoft® web site.  

This example opens the Lyric Browser Database and displays information about messages 0 - 100 in a 2D 
Roll window. The macro can be easily modified to open any ODBC-compliant database (e.g. Microsoft 
Access Database) and extract needed information for display as part of a Lyric message. 

Dim oConn, oRS, oContent, a 

'Create a roll window in canvas to hold browser database information 

ActiveCanvas.Scene.Erase(EraseScene) 

ActiveCanvas.Scene.InsertObject(otRoll) 

ActiveCanvas.Selection.Execute("Make FullScreen") 
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' Create an ActiveX Data Object 

Set oConn = CreateObject("ADODB.Connection") 

' Open the Browser Database 

oConn.Open "Browser" 

'go thru all messages in Browser database between 0 and 100 and display title, 
author and comments in roll window 

set oRS = oConn.Execute("SELECT Title,Author,PathAndFile from Messages 
WHERE Title >= '00000000' AND Title < '00000100'") 

Do Until oRS.EOF 

oContent = oRS.Fields(0).Value & chr(13) & oRS.Fields(1).Value & chr(13) & 
oRS.Fields(2).Value & chr(13) & chr(13) 

ActiveCanvas.Selection = oContent  

oRS.MoveNext 

Loop 

Windows Scripting Host 
Microsoft® Windows Script Host is a subset of commands that can be used to automate most Windows 
Explorer and Windows Shell functionality through a macro. Further information on the Windows Script Host 
API reference can be found on the Microsoft® web site. 

One of the ActiveX objects within this subset is the Windows Shell ActiveX Object. One of the most important 
features of WshShell is found in the SendKeys function. This technique allows any key sequence to be sent to 
an active application. Therefore, any key sequence, including menu shortcuts, which Lyric supports can be 
executed within a macro using the WshShell Object. The key sequence is provided as a string argument (i.e. 
in quotes) to the SendKeys command. Alphanumeric keys can be provided explicitly; special-function keys 
are represented as follows: 

 Enter key represented as ~  

 Alt key represented as %  

 Shift key represented as +  

 Ctrl key represented as ^  

 Function (and similar) keys should be contained in brackets, e.g. {F1} {BACKSPACE} 

Example 1: 

To open Lyric’s Clip Control Panel via its corresponding menu item on the Tools menu, the use the following 
Macro: 

Sub PopupCCP 

     'Create a Windows Shell object. 

     set WshShell = CreateObject ("WScript.Shell") 

     'F6 sets focus to the Canvas. 

     WshShell.SendKeys("{F6}") 

     'The key sequence Alt + O I, and then Enter (~) drops down the Tools menu, 
     'and then selects and opens the Clip Control Panel. 

     WshShell.SendKeys("%oi~") 

End Sub 
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Example 2: 

To set a frequently-used background color, program the following Macro: 
Sub SetBackgroundBlue 
'DESC:11:10:02  May 03, 2004 
Sub SetBackgroundBlue 
'DESC:Sets Background to a medium light blue with 25% Transparency. 
'DESC:Transparency:  25 
'DESC:Red:  58 
'DESC:Green:  118 
'DESC:Blue:  190 
'ICON:AQUA 
'HKEY:Alt+1 

     'Create a Windows Shell object. 

     set WshShell = CreateObject ("WScript.Shell") 

     'F6 sets focus to the Canvas. 

     WshShell.SendKeys("{F6}") 

     'The key sequence Alt + O B S drops down the Tools menu, 
  'selects Background, and then selects Solid/Ramp Color. 
  'The Color Select dialog box opens. 

     WshShell.SendKeys("%obs") 

  'The key sequence Tab C D 58 Tab 118 Tab 190 
  'moves the cursor to a location in the Select Color dialog box that allows 
  'Solid Color to be selected regardless of initial Ramp or Solid Color setting. 
  'T focuses the cursor on the Transparency field, and then the Macro sets a 
  'value for Transparency.  Tab moves the cursor out of the Transparency field. 
  'D focuses the cursor on the Red field, and then the Macro sets a value for Red. 
  'Tab then moves the cursor to the Green field, and then 
  'the Macro sets a value for Green.   
  'Tab then moves the cursor to the Blue field, and then 
  'the Macro sets a value for Blue. 

     WshShell.SendKeys("{Tab}ct25{Tab}d58{Tab}118{Tab}190") 

  'The Tab keystroke moves the cursor out of the data fields. 
  'This prevents subsequent executions of the macro from producing 
  'unexpected results.  Enter (~) applies the color to the Background.  

     WshShell.SendKeys("{Tab}~") 

End Sub 
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Using SendKeys to Specify Keystrokes in a Macro Script 
Each character is represented by one or more keystrokes.  To specify a single keyboard character, use the 
character itself.  For example, to represent the letter A, specify A in the SendKeys command.  To represent 
more than one character, append each additional character to the one preceding it.  To represent the letters 
A, B, and C, specify ABC in the SendKeys command. 

The plus sign (+), caret (^), percent sign (%), tilde (~), and parentheses (( )) have specialize functions with 
SendKeys.  To specify one of these characters, enclose it in braces ({}). For example, to specify the plus 
sign, use {+}.  Brackets ([ ]) have no specialize function with SendKeys, but they must be enclosed in braces. 
To specify brace characters, use {{} and {}}.  

To specify non-display characters such as Enter or Tab and keys that represent actions rather than 
characters, use the codes shown below. 

Keystroke SendKeys 
Code 

 Keystroke SendKeys 
Code 

Backspace 

 

{backspace}, 
{bs} or {bksp} 

 Ins or Insert {ins} or {insert} 

Break {break}  Left Arrow {left} 

Caps Lock {capslock}  Num Lock {numlock} 

Del or Delete {del} or {delete}  Page Down {pgdn} 

Down Arrow {down}  Page Up {pgup} 

End {end}  Print Screen {prtsc} 

Enter {enter} or ~  Right Arrow {right} 

Esc {esc}  Scroll Lock {scrolllock} 

Help {help}  Tab {tab} 

Home {home}  Up Arrow {up} 

Function keys, F1 through F12, are specified as {F1} through {F12} 

To specify any combination of keys using Shift, Ctrl or Alt, precede the key code with 
one or more of the following codes: 

 Shift:  + 

 Ctrl:  ^ 

 Alt:  % 

To specify that any combination of Shift, Ctrl, and Alt should be held down while 
several other keys are pressed, enclose the code for those keys in parentheses.  For 
example: 

 To hold down the Shift key while E and C are pressed, specify +(EC). 

 To hold down Shift while E is pressed, followed by C without Shift, specify 
+EC. 
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Note that in certain situations, SendKeys may not work properly with certain Windows dialog boxes, such as 
File Save and File Open.  You may circumvent this problem by using a wait (0) command after the dialog 
box is opened.  For example, the following macro opens the Lyric Save As dialog box, and saves the 
composition to a file named test: 

set WshShell=CreateObject ("WScript.Shell") 

WshShell.SendKeys "{F6}" 

WshShell.SendKeys "%FA" 

wait(0) 

WshShell.SendKeys "test" 

WshShell.SendKeys "{enter}" 
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Macro Declarations 

Public Const scCtrl = 1 

Public Const scAlt = 2 

Public Const scCtrlAlt = 3 

Public Const scShift = 4 

Public Const scCtrlShift = 5 

Public Const scAltShift = 6 

Public Const scCtrlAltShift = 7 

Public Const kfXPos = 0 

Public Const kfYPos = 1 

Public Const kfZPos = 2 

Public Const kfXRot = 3 

Public Const kfYRot = 4 

Public Const kfZRot = 5 

Public Const kfXScale = 6 

Public Const kfYScale = 7 

Public Const kfZScale = 8 

Public Const kfXCenter = 9 

Public Const kfYCenter = 10 

Public Const kfZCenter = 11 

Public Const kfRGBADiffuse = 12 

Public Const kfFocus = 13 

Public Const kfShine = 14 
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Public Const kfLoopEnabled = 15 

Public Const kfTransp = 16 

Public Const kfEffectPct = 17 

Public Const kfUnused = 18 

Public Const kfLoopFrames = 19 

Public Const kfLoopIterations = 20 

Public Const kfPauseEnabled = 21 

Public Const kfPauseType = 22 

Public Const kfPauseTimeout = 23 

Public Const kfLinear = 0 

Public Const kfSpline = 1 

Public Const kfJump = 2 

Public Const soAbsolute = 0 

Public Const soRelative = 1 

Public Const otText = 0 

Public Const otCrawl = 1 

Public Const otRoll = 2 

Public Const otTypeOn = 3 

Public Const otClock = 4 

Public Const otTimer = 5 

Public Const otImage = 6 

Public Const otBkgCentered = 7 

Public Const otBkgSizeToFit = 8 
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Public Const otAprisa = 9 

Public Const otInfinitMsg = 10 

Public Const ot3DObj = 11 

Public Const EraseTextActiveWindow = 0 

Public Const EraseAllText = 1 

Public Const EraseScene = 2 

Public Const EraseAllOutput = 3 

Public Const PlayPreview = 0 

Public Const PlayOutput = 1 

Public Const PlayOutputAll = 2 

Public Const PlayImmediate = 0 

Public Const PlayWait = 1 

Public Const Unknown = 0 

Public Const ThreeDCharacter = 1 

Public Const WavefrontObject = 2 

Public Const ThreeDStudioObject = 3 

Public Const ImageObject = 4 

Public Const OrthographicCamera = 5 

Public Const PerspectiveCamera = 6 

Public Const GlobalLight = 7 

Public Const DirectionalLight = 8 

Public Const PositionalLight = 9 

Public Const Spotlight = 10 
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Public Const TextWindow = 11 

Public Const LoopObject = 12 

Public Const PauseObject = 13 

Public Const Clip = 14 

Public Const VideoRegion = 15 

Public Const ClockTimer = 16 

Public Const AnimatedElement = 17 

Public Const Mix = 18 

Public Const Flipbook = 19 

Public Const ITVEvent = 20 

Public Const MultiFXObj = 21 

Public Const SplineWindow = 22 

Public Const SqueezeBackRegion = 23 

Public Const ThreeDTemplate = 24 

Public Const Custom = 25 

Public Const ProxyBased = 26 

Public Const ImageElement = 0 

Public Const TemplateElement = 1 

Public Const WindowElement = 2 

Public Const BrowserBitmapElement = 3 

Public Const BrowserMessageEleme
nt 

= 4 

Public Const StaticElement = 5 
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Function ActiveCanvas    

Set ActiveCanvas = Lyric. 
ActiveCanvas 

 

End Function    

LEIF Help 
LEIF Help is available by opening the LEIF.hlp file from within the directory in which Lyric was installed.
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33. Plugins 

Overview 
NOTE 

Online Help for most plugins is available only through the plugin application's  
button or the F1 key. For questions about individual plugins, contact the application's 
manufacturer. 

The suite of plugins available for Lyric is continually upgraded.  Please contact Chyron 
or visit the Chyron web site at http://www.chyron.com/products/catcd/goodies/ for up-to-
date product information and demo software, and 
http://www.chyron.com/products/gfxsw/ for additional plugin product information. 

Current plugins from Chyron include the following: 
 CMix:  CMix is a 1RU-rack mount device providing two output channels, each displaying an 

independent mix of up to 4 Video/Key input layers over an optional Program video input layer, which 
mix to one Video/Key output.  CMix is connected to a host machine via the Universal Serial Bus 
(USB).  Originally designed for use with Duet LE/LEX/PCI/PCI+, CMix can also be used to expand 
the mixing capabilities of Duet SD systems, or with conventional PCs equipped with broadcast-quality 
video sources, for use as a standalone router/switcher.  Refer to the chapter on Video Mixing for in-
depth information on CMix. 

 Chyron MOS and Chyron XML LEIFLets:  Based on Chyron’s CAMIO architecture, Chyron MOS 
enables remote asset browsing, editing, and playout capabilities within MOS Newsroom Computer 
Systems (NCS) such as AP’s ENPS and Avid’s iNews. Chyron MOS consists of a MOS-compliant 
ActiveX client control interface connected to our various character generation and animation systems. 
Simple to use, yet powerful and flexible, Chyron MOS gives newsroom staff the ability to create and 
schedule template-based text and graphics for playout across our entire graphics product line, all with 
the real-time performance and quality you have come to expect from Chyron.  When using Chyron 
MOS, these plugins enable Lyric to communicate with the Chyron MOS Client application through 
the Chyron CAMIO Server.  They also enable Lyric to save assets that contain metadata necessary 
for MOS system integration.  Please visit http://www.chyron.com/products/mediasolutions/ for 
detailed product information. 

Additionally, the following Chyron products can be used as plugins for outside applications: 

Lyric for Plugin for Avid NLEs:  This plug-in provides powerful integration between Chyron’s Lyric 
graphics/animation software and Avid’s NLE system editors. Lyric Plugin allows Avid operators to dynamically 
create text, graphics and templates from directly within the Avid user interface to produce lower thirds, rolls, 
crawls and animations, which then become components of the Avid timeline. 

Lyric for Grass Valley: 

Lyric for ENPS and iNews:  See Chyron MOS and XML LEIFlets above. 

Current third-party plugins include the following: 
 Harvester Lite - Patrick Graphics Systems:  Harvester Lite is Included with Lyric, and enables a 

Lyric 2D Text Template to be linked to a text field at a remote URL for dynamic update via the 
Internet.  Harvester Lite Help is available through Lyric Online Help or in the Lyric User Guide.  

 Harvester Pro - Patrick Graphics Systems:  Harvester Pro is a data harvesting plugin that enables 
multiple Lyric 2D Text Templates to be linked to a text fields at a remote URL for dynamic update via 
the Internet.  The user has the ability to use VB Script within Harvester Pro to also create Lyric 
messages and Playlists populated with data harvested from the Internet. 

 BizGraph - Patrick Graphics Systems:  BizGraph enables the creation animated line and bar 
graphs using data from Access databases, Excel spread sheets or comma-separated text.  Graphs 
can be dynamically rendered in real time using custom cursors. 
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 Quarterback - Patrick Graphics Systems:  Quarterback provides the user with a Windows® 
Explorer®-style view of Chyron Lyric and iNFiNiT!® family message and image assets. Navigation 
through the file system is accomplished with standard tree views of folders and selected folder 
contents. In addition to these familiar views, Quarterback provides an additional pane that displays 
image thumbnails and unique mini-keyframe animation thumbnails of Lyric messages. Quarterback 
can connect to FTP servers, allowing easy file transfer operations. This facility allows the user to 
connect with any product in the Chyron iNFiNiT! family to easily browse and move files from system 
to system. In addition, Quarterback can be used to preview *.avi files and to preview Duet internal clip 
player clips on systems without a clip player. 

 Twister - Video Design Software:  Twister is a paint, graphics content creation, and I/O application. 

 StylistPro:  StylistPRO is a powerful and easy-to-use 32-bit graphic application, allowing on- or off-
line Lyric users to speedily modify, restyle, edit and process existing graphics from within the Lyric 
application. 

Visit http://www.chyron.com/products/gfxsw/ for information about these and other graphics products. 

Lyric employs Lyric Enhancement Interface Framework (LEIF) architecture, which supports third-party 
plugins.  The purpose of LEIF is to provide a mechanism for adding customized features and enhancements 
into Lyric. LEIF offers a plug-in architecture that enables specialized menu-driven functionality, user-definable 
object properties, and an API for integral control over the internal mechanisms of Lyric.  Using LEIF, 
developers can create applications that perform image processing, import and export to custom file formats, 
automate Template field updates, implement remote application control, access Browser data, and handle 
numerous diverse operations. 

The plugin architecture is based on COM technology and specifies one method that the plugin must have in 
order to be loaded. Plugins can be written using any development environment that is capable of producing 
COM objects.  Examples of popular tools include Visual Basic®, Delphi®, and Visual C++®.  Installing the plugin 
simply requires placing it into Lyric's plugin directory. 

The API consists of a series of components that offer direct manipulation over the internal mechanisms in 
Lyric.  Such control offers flexibility and efficiency for operations and scenarios that require customized user 
controls and automated processes.  The API is built on COM technology and integrates seamlessly with 
components constructed in Visual Basic and Delphi in addition to many other Rapid Application Development 
tools. 

User-definable object properties provide developers with the means to store specialized data with any object 
in a Lyric message.  The data is saved with the message and is readily available upon reloading.  Object 
properties are named and can be presented to the Lyric operator for informational and editing purposes.  
Provisions exist in LEIF to allow the developer to provide custom property editors offering a preferred 
presentation of data to the operator.  A default property editor is also available.  
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Harvester Lite 
2D Text/Template Right-Click Menu > Harvester Properties, then Tools Menu > Harvester Lite 

The Harvester Lite plugin enables a Lyric 2D Text Template to be linked to a text field at a remote URL for 
dynamic update via the Internet. 

1. Place a Template within a 2D Text window, right-click and select Harvester Properties. 

2. The Harvester Properties window opens.  The default URL is the http://www.yahoo.com/.  Navigate 
to the site from which the data is to be drawn for the update. 

 

Harvester Properties Window 

Note the similarity to familiar browsers. In the URL field, enter the location from which you will be 
drawing data.  After entering the URL, press Enter/Return to navigate to the site.  The OK button 
serves another purpose, which we'll get to in a moment. 

3. With the target Web page open, click and drag over any text which you wish to link to the template in 
your Lyric composition. 

 

Harvester Properties Window - Selecting Text 

4. DON'T FORGET to click the Enabled checkbox! 

5. Now, click the OK button. The Harvester window closes. 
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6. Next, select Harvester Lite from the Lyric Tools menu.  The Harvester Lite Control dialog box 
opens. 

 

Harvester Lite Control Dialog Box 

7. The Timeout setting determines the length of time, in seconds, that the system waits before it 
declares a timeout after attempting, but not succeeding, to perform an update.  When the Timeout 
occurs, the system waits for the next period cycle to begin before attempting another update.  To set 
the Timeout: 

 Enter a value, in seconds, in the Timeout field. 

8. The Default URL field, Stats and user preferences are covered at the end of this section. 

 Press the One Shot button to update the display once manually while this dialog is open. 

 Press Run to launch the process of regular updates to the data in the Template field. 
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Running Harvester 

While Harvester is running, you will see the  symbol appear every time Lyric and Harvester check 
the source for new data. 

9. If for any reason you wish to halt the update process, press the Stop button. Click the Windows  
control to close the Harvester Control dialog and leave the update process running. 

10. Save the composition as you would any Lyric message. When the message is recalled, the data last 
harvested will be displayed in the Template. 

NOTE: If you wish messages containing Harvester-linked Templates to update immediately upon read-up, the 
Harvester Control dialog must be open, with the Run control engaged before recalling the message. 

In the Harvester Control dialog box, you may also enter and save preferences for: 
 Default URL:  This field sets the URL automatically opened by the Harvester Properties window.  

Note that the entry in this field does not undo the attributes you defined for the Template in Steps 2 
and 3.  In other words, you may set the Harvester Properties window to open on a specific URL by 
default, but navigate to another URL in that window and set Harvester attributes differently than the 
defaults defined here. 

 Period:  In this field, enter a value (in seconds) to determine the frequency with which Harvester 
retrieves linked information from the selected remote URL and updates the Template accordingly.  A 
minimum cycle of 5 seconds is recommended. 

The Stats area displays the number of times the field has been updated in the current run of the program, as 
well as errors, if any, in navigating to the source page or in finding the desired field.  

The Save button is used to retain the Default URL and Period settings.  These values are saved in the user’s 
registry setting, so different settings can be saved for every login account in the system. 
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Commonly-Used Plugins 

Harvester Pro 
Harvester Pro is a data harvesting plugin from Patrick Graphics Systems.  Please access Harvester Pro 
online Help for operational information or contact PGS at inforequest@patrickgraphicssystems.com. Web 
Site:  http://www.patrickgraphicssystems.com. 

This menu item will not appear unless the Harvester Pro optional plugin is installed. 

BizGraph 
BizGraph is an animated graph display plugin from Patrick Graphics Systems. Please access BizGraph online 
Help for operational information or contact PGS at inforequest@patrickgraphicssystems.com. Web Site:  
http://www.patrickgraphicssystems.com. 

This menu item will not appear unless the BizGraph optional plugin is installed. 

Quarterback 
Quarterback is a Lyric enhanced directory access optional plugin for Lyric from Patrick Graphics Systems.  
Please access Quarterback online Help for operational information or contact PGS at 
inforequest@patrickgraphicssystems.com. Web Site:  http://www.patrickgraphicssystems.com. 

This menu item will not appear unless the Quarterback optional plugin is installed. 

Liberty Twister Paint 
Liberty Twister, a paint plugin, is a product of Video Design Software. Please access Liberty Twister online 
Help for operational information or visit the Video Design Software web site at 
http://www.videodesignsoftware.com.  

This menu item will not appear unless the Liberty Twister optional plugin is installed. 
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34. Aprisa Systems and Lyric 

Aprisa Systems 

Overview 
Chyron provides a wide variety of clip, still and clip/still store systems that complement Duet and other Chyron 
graphics systems.  Still files and clip file information are transmitted between the system running Lyric and the 
Aprisa via Ethernet.  The clips themselves are transmitted via a video connection.  The Aprisa supports both 
Windows® 2000 and Windows NT® operating systems.   

 The Aprisa 100 is a still store system.  Stills can be imported for use in a Lyric composition.  Lyric 
compositions can also be exported to the Aprisa as stills. 

 The Aprisa 200 is a clip store system and DDR.  Clips stored on the Aprisa are played using the 
Internal Clip Player, which is controlled from Lyric's Clip Control Panel. 

 The Aprisa 250 combines still store, clip store and DDR capabilities. 

For information regarding Aprisa features, visit http://www.chyron.com/products/graphics/aprisa/. 

Aprisa 100/250 Still Store 
Still files can be imported from the Aprisa, modified, then exported back to the Aprisa via Lyric's Browser, or 
by accessing the Import from Aprisa and Export to Aprisa tools available from the File menu.  These 
functions are covered later in this chapter. 

The Aprisa 100 Still Store and the still store component of the Aprisa 250 must be configured for 
communication with Lyric.  Still store configuration is covered later in this chapter in the section on Aprisa 
Interface Configuration. 

Aprisa 200/250 DDR 
The Aprisa™ 200 is Chyron's Digital Disk Recorder (DDR), uniquely optimized for video graphics, providing 
unprecedented speed and flexibility in creating, storing, and playing back animated clips.  The Aprisa™ 250 
combines the Aprisa 200 DDR and Aprisa 100 Still Store into one powerful playback unit.  Lyric running on 
Duet can, via Ethernet, control the Aprisa systems. 

The Aprisa 200 and the DDR component of the Aprisa 250 must be configured for communication with Lyric.  
DDRS configuration is covered later in this chapter in the section on Aprisa Interface Configuration. 

The Aprisa 200/250 can be connected to either the Video In connector on Duet's internal keyer (shown 
below) or to the audio and video inputs of the Internal Clip Player. 
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To display a video source such as an Aprisa on Duet output, it requires that Key In be enabled in Duet 
Hardware Configuration.  Refer to Configuration for Display of Video Source - Duet SD, Configuration 
for Display of Video Source - Duet HD or Configuration for Display of Video Source - Duet 
LE/LEX/PCI/PCI+ for details. 

 

Connecting Aprisa 200/250 to Duet's Internal Keyer 

IMPORTANT 
The Aprisa 200/250 software must be running in order for Lyric to establish an Ethernet 
connection. 
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Aprisa Interface Configuration 
Config Menu > Aprisa Interface 

NOTE 
In order for Lyric to access Aprisa stills and clips, the Aprisa application must be 
running, even if Lyric is running on the Aprisa system. 

Configuring the Aprisa Interface 
To enable Lyric access to Aprisa still and/or clip assets, the system running Lyric must be networked to the 
Aprisa system and properly configured. 

 From the Config Menu, select Aprisa Interface.  The Configure Aprisa Interface dialog box is 
displayed.  The figure below shows sample settings. 

 

Configure Aprisa Interface Dialog Box 

The Configure Aprisa Interface dialog box is composed of two areas: 
 Still Store Configuration (unlabeled), in which the Aprisa Still Store is configured.  

 DDR Options, in which the Aprisa DDR (Clip Store) is configured. 

The Still Store Configuration and DDR Options are independent of each other.  For example, Lyric can 
communicate with one Aprisa for stills, and another for clips.  Stills and clips must also both be configured 
even when connecting to an Aprisa 250 Still/Clip Store. 

Additionally, if using only the still or the clip component of the Aprisa 250, only that area in the Configure 
Aprisa Interface dialog box must be configured. 

Still Store Configuration 
Still Store Configuration includes the following settings; 

 Host Name:  Must be set to the Full Computer Name or the IP address of the networked Aprisa 
system.  If Lyric is running on the Aprisa system on which the stills are to be accessed, leave the 
Host Name field blank.  To find the name and/or IP Address of the Aprisa system, refer to the 
chapter on Networking, in the section on Finding the Computer Name and IP Address of a 
System, for procedures for both operating systems. 

 Enable Browser:  Must be selected (checked) to enable Browser access, even if Lyric is running on 
the Aprisa system. 
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DDR Options 
DDR Options includes the following settings: 

 Alternate Host Name:   Must be set to the Full Computer Name or the IP address of the networked 
Aprisa system.  If Lyric is running on the Aprisa system on which the clips are to be accessed, leave 
the Host Name field blank.  To find the name and/or IP Address of the Aprisa system, refer to the 
chapter on Networking, in the section on Finding the Computer Name and IP Address of a 
System, for procedures for both operating systems. 

 Enable DDR:   Must be selected (checked) to enable Browser access and clip playback capability, 
even if Lyric is running on the Aprisa system. 

 Playlist Mode - Event vs. Playlist Mode:  The Aprisa 200 DDR and the Aprisa 250 DDR function 
can be run in one of two modes:  Event Mode or Playlist Mode. 

o Event Mode results in slower load times, but provides complete Clip Control Panel 
functionality.  Ii is best to work in this mode when setting up and previewing clips. 

o Playlist Mode provides quicker loading without degradation of video quality.  Clip Control 
Panel functionality, however, is reduced. Only the Load, Play Clip and Transport Controls 
operate in this mode.  The Jog/Shuttle Slide Box (see below), In Point and Out Point 
functions are disabled.  This mode is best used for playback.  Note that the Aprisa 200/250 
DDR Playlist Mode has no relation to the Lyric Playlist.  

 Use Channel B:  By default, Lyric controls Channel A of a dual-channel Aprisa 200/250.  Use 
Channel B assigns control of a dual-channel Aprisa 200/250 B Channel to the Duet system on which 
you are working.  This option is intended for production situations where a dual-channel Aprisa is 
shared by two Duet systems or by an Aprisa operator and a Duet system.  If a dual-channel Aprisa 
system is being shared by two Duets, be sure not to have the Use Channel B checkbox selected 
on both systems!  The Aprisa DDR will execute the last command received on either of its channels, 
regardless of the source. 
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Configuration Procedure 
To enable Lyric access of the Aprisa 200/250 DDR: 

1. Select Aprisa Interface from the Config menu.  The Configure Aprisa Interface dialog box 
appears. 

 

Enabling Lyric Control of Aprisa DDR 

2. Under DDR Options: 

a. Enter the IP Address or Full Computer Name of the Aprisa 200/250 in the 
Alternate Host Name field.  If necessary, refer to Finding the IP Address and Full 
Computer Name of a System to find out the Full Computer Name or IP Address of 
the Aprisa. 

b. Select (check) the Enable DDR checkbox to enable Lyric access to Aprisa clip 
assets. 

c. For the purpose of trying out the Clip Control features, leave the Playlist Mode 
checkbox blank in order to operate in Event Mode.  Note that is at some point you 
wish to change modes, the Clip Control Panel must first be closed, and then the 
settings changed in the Configure Aprisa Interface dialog box. 

d. Select the Use Channel B checkbox to assigns control of a dual-channel Aprisa 
200/250 B Channel to the Duet system on which you are working, or leave it blank to 
keep control assignment as Channel A.  
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3. Optional:  Click the Test button to display the status of the connection between the Duet and the 
Aprisa.  The Aprisa Test popup (shown above) is displayed.  If the popup indicates that the DDR is 
connected and that at least one channel is available, then setup has been completed.  If there is an 
error message, check the physical hookup, the network settings and the Configure Aprisa Interface 
settings.  Test responses are described in the following section. 

Test Responses 
The connection to from the system running Lyric to the Aprisa(s) can be tested.  Note that this test checks out 
both stills and DDR (Clips) connections.  It can simultaneously test any clip and/or still combination of an 
Aprisa 100, 200 and/or 250. 

 Click Test.  The results of the test are displayed in the Aprisa Test dialog box. 

The figures below show sample Aprisa Test responses. 
 Both the Browser (stills) and DDR connections are successful. 

 

Aprisa Test - Browser and DDR Connected 

 Browser and DDR are not enabled for the Aprisa 100 or Aprisa 250 for stills, and the Aprisa 200 or 
Aprisa 250 for clips.  Depending on desired connection(s), select (check) Enable Browser and/or 
Enable DDR.  Only enable the connection(s) that is to be used. 

 

Aprisa Test - Browser and DDR Not Enabled 

 No host found for the Aprisa 100 or Aprisa 250 stills, due to incorrect or unavailable Full Computer 
Name or IP Address.  DDR connection to Aprisa 200 or Aprisa 250 was successful.  

 

Aprisa Test - No Host Found for Browser, DDR Connected 
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 Aprisa 100 or Aprisa 250 stills connection is successful.  Target Aprisa 200 or Aprisa 250 DDR 
machine refused connection.  The Aprisa DDR (clips) application was not launched on the Aprisa 200 
or Aprisa 250.  Remember that on the Aprisa 250, the stills and DDR (clips) applications are 
separate.  The stills application must be launched to access stills, and the DDR application must be 
launched in order to access clips. 

 

Aprisa Test - Browser Connected, DDR Connection Refused 

OK/Cancel 
After settings are entered: 

 Click OK to apply, or Cancel to cancel without change. 
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Aprisa Still Asset Operations 

Browser > ;  Browser Menu > Show Aprisa Stills 
NOTE 

Before Aprisa Browser operations within Lyric, it is necessary to configure Lyric for 
access to the Aprisa.  Refer to Aprisa Interface for details.  If the system running Lyric is 
properly networked to the Aprisa, and the Aprisa Still Assets are not displaying, make 
sure that Enable Browser has been selected (checked) in the Configure Aprisa Interface 
dialog box, accessed from Configure Menu > Aprisa Interface. 

Additionally, in order for Lyric to access Aprisa stills, the Aprisa application must be 
running, even if Lyric is running on the Aprisa system. 

Aprisa Stills are graphics stored on Chyron Aprisa systems.  When imported into a Lyric Canvas, the still is 
used as any other bitmap graphic.  An image on the Lyric Canvas can also be exported to the Aprisa, and 
added to the stills database. 

The Aprisa Stills Asset Browser enables quick import of Aprisa graphics to the Canvas.  The Aprisa Stills 
Asset Browser supports drag-and-drop of graphics to the Canvas or a 2D Text Window in the Canvas and 
from one Browser window to another Browser window.  The Aprisa Stills Asset Browser also supports 
drag-and-drop of graphics into the background of the Canvas, a 2D Text Window or a 2D Text Template.  
Aprisa Stills assets can also be searched. 

NOTE 
Unlike Browser databases for Lyric TrueType® and RGB Fonts, Messages and bitmaps, 
which are independent of the source files, the Aprisa Stills database and the stills as 
stored on an Aprisa system are one and the same.  Any change to metadata changes the 
metadata for the source file.  Additionally, there is only one Aprisa stills database per 
Aprisa system.  

In order for Lyric to have the ability to access remote Aprisa assets: 
 The Aprisa software must be running on the Aprisa platform. 

 The system on which Lyric is running must be properly networked to the Aprisa.  Refer to Importing 
from Aprisa and for information on establishing a network connection. 

If Lyric is running on the Aprisa platform itself, the Lyric Browser may be used instead of Aprisa’s own 
browser. 

The following should be noted about Aprisa Still Asset view options and file names: 
 Only the Icon View is available.  Text Only and Icon Text Views are inactive.  Metadata is displayed 

in the Aprisa Export dialog box (described below). 

 File Names are always of the format xxxx, where xxxx is a four-digit number.  In the Browser, the 
leading "." is not displayed.  Starting the number with zeroes is permitted.  

 The Sort A-Z/Sort Z-A selection does not have an affect on the order of display.  The stills are 
always displayed in file name, i.e., numerical order. 
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Aprisa Stills Browser  

Loading an Aprisa Still from the Browser 
Loading an Aprisa Still from the Browser to the Canvas or 2D Text Window 
To load an Aprisa Still Asset from the Browser to the Canvas or a 2D Text Window, make the Canvas or 
2D Text Window in the Canvas active, then choose one of the following methods: 

 Double-click the icon/text listing for the still. 

 Select (click or by cursor) the icon for the Aprisa Still Asset, then click  or select Load from 
Database from the Browser menu. 

 Select (click or by cursor) the icon for the Aprisa Still Asset, then press Enter. 

 Drag-and-drop the Aprisa Still Asset to the Canvas or into the 2D Text Window. 

The Aprisa Still Asset loads to the Canvas. 

 If the still is loaded to the Canvas as a 2D bitmap, it can be moved and scaled using Transform 
Tools or from Properties > XYZ. 

 If the still is loaded to a 2D Text Window, it can be scaled using the same functions used to modify 
2D text.  Refer to Selecting and Modifying 2D Text or Keyboard Shortcuts - 2D/3D Text, Text 
Templates and Row Tabs for additional information. 

Note that a still cannot be loaded into a 2D Text Template as an object, but can, as a Background (see 
following). 
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Loading an Aprisa Still as a Background 
To use an Aprisa Still Asset as a background for the Canvas, a 2D Text Window or 2D Text Template: 

1. Hold the Alt key while dragging-and-dropping an Aprisa Still Asset into the Canvas, a 2D Text 
Window or 2D Text Template.  If loading into the Background of a 2D Text Template, make sure 
that the cursor is on a row of the Template, not the 2D Text Window, or the still will load to the 
Background of the 2D Text Window instead of the Template.  The following menu is displayed. 

 

Background Menu 

2. Select one of the two options from the Background menu. 

 Select Stretch to Fit to stretch the still to fill the Canvas, 2D Text Window or 2D Text 
Template.  Note that the aspect ratio of the still may change, distorting its appearance.  

 Select Center to place the still in center of the background of the Canvas, 2D Text Window 
or 2D Text Template.  The size and aspect ratio of the still remain unchanged. 

For additional information on backgrounds, refer to the section on Background. 

Loading an Aprisa Still Using the File Menu 
An Aprisa still can also be loaded from outside of the Browser: 

1. Place the cursor at the location where the still is to be placed: 

 Anywhere in the Canvas outside of a 2D Text Window to place as a 2D bitmap object or 
Background of the entire Canvas. 

 Inside of a 2D Text Window to place in a row-based 2D bitmap object or Background of the 
2D Text Window. 

 Inside of a 2D Text Template to place as the Background of the Template.  Note that the 
still cannot be placed in the Template as a row-based 2D bitmap object.  To do so would 
require that the still is converted into an RGB Font character. 

2. Pull down the Lyric File menu, and then select Import from Aprisa.  The Aprisa Import dialog box 
opens. 

 

Aprisa Import Dialog Box 

3. Select a Source from which the still is to be imported from the Source drop-down list box. 

4. Enter the Still ID of the still. 

5. Select (click) either Insert as Object or Insert as Background. 
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6. Click Import.  The Aprisa still is displayed in the Lyric Canvas as an Object or Background as 
specified, and at the location as specified by the cursor position.  A still imported as a Background 
stretches to fit the Canvas, 2D Text Window or 2D Text Template. 

7. Click the close icon to exit the Aprisa Import dialog box. 

Applying an Aprisa Still Asset as a Texture for a 3D Character or 3D Object 
To apply an Aprisa Still asset as a Texture for a 3D character or 3D object: 

 Drag-and-drop the Aprisa Still asset to the Texture Chip in the Properties > Surface tab.  Refer to 
Surface Properties for additional details. 

 

Dragging-and-Dropping a Texture from the Browser 

The Aprisa Still Asset Context Menu 
Information (metadata) about the Aprisa Still Asset can be edited via the Aprisa Still Asset context menu.  
An Aprisa Still Asset can also be updated or added to the Aprisa database.  To access this menu: 

 Right-click on the Aprisa Still Asset. 

 

Aprisa Still Asset Context Menu 



Lyric User Guide 

 34-12 

Edit 
Edit is not available in this menu.  Editing metadata is performed in the Aprisa Export dialog box, accessed 
from the Update function (described below). 

Delete 
Delete is not available from this menu.  Stills can be deleted from the database via the Aprisa interface on the 
Aprisa system. 

Update 
A still can be updated, its metadata edited, or a new still can be added to the Aprisa still database from this 
Aprisa Export dialog box which is accessed from Update.  These functions are described in more detail later 
in this section. 

Descr, Field 1, Field 2, Field 3, Field 4 
These fields are informational only, and can be edited in the Aprisa Export dialog box. 

The Aprisa Export Dialog Box 
The Aprisa Export dialog box accessed from the Browser is the same in both appearance and function as 
the Aprisa Export dialog box accessed from File Menu > Export to Aprisa.  To open the dialog box from 
the Aprisa Still Assets Browser, right-click on a still, then select Update from the context menu. 

 

Aprisa Export Dialog Box 
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Still ID identifies the File Name of the still.  As mentioned above, File Names are always of the format xxxx, 
where xxxx is a four-digit number.  This field can be edited, which results in the addition of a new still to the 
Aprisa database, or the replacement of an existing still of the same File Name.  Adding a still is described in 
detail later in this section. 

 A Description can be selected for the still. 

 Fields 1 through 8 enable additional descriptive information to be entered. 

 The Destination drop-down list box allows selection of the target for the exported Aprisa still.  There 
is a choice of three Air Channels, three Preview Channels, five Virtual Channels or File.  For the 
purposes of describing Browser operations, File will always be selected. 

Updating a Still 
Unlike Lyric Font, Message and Bitmap Browser databases, where editing metadata is a separate operation 
from updating the file itself, editing and updating Aprisa Still Assets from the Browser are contained in one 
operation. 

CAUTION! 
If editing metadata only, make sure that the graphic on the Lyric Canvas has not 
changed, as the change will be applied to the Aprisa still on the Aprisa system. 

To update the still: 
1. Optional:  Modify the graphic on the Canvas. 

2. Open the Aprisa Export dialog box. 

3. If appropriate, select a Destination from the Destination drop-down list box 

4. Edit the Description and numbered fields as desired.  Do not change the Still ID. 

 

Aprisa Export Dialog Box - Edited 
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5. When editing is complete, click Export.  The dialog box closes. 

6. Click the Refresh Database icon or select Refresh Database from the Browser menu.  The 
changes are reflected in the Browser.  Editing only metadata will not change the appearance of the 
Browser.  The updated edits can be reviewed in the context menu by right-clicking the asset.  If the 
graphic was modified as well, the change is reflected in the Browser icon. 

 

Aprisa Stills Context Menu - Edited 

Adding a Still 
A graphic composition can be created in the Lyric Canvas, and exported to the Aprisa as a new still.  On 
export, the graphics on the Lyric Canvas are converted into a 2D graphic in the Aprisa still format.  When the 
exported graphic is then imported from the Aprisa from the Browser or File Menu > Import from Aprisa, the 
original elements are no longer separate, and 3D characters and objects are converted into 2D images. 

There are two methods for adding a still to the Aprisa database:  From the Browser and from the File menu. 
1. Create the composition in the Lyric Canvas. 

2. Use one of the following methods to open the Aprisa Export dialog box: 

 Right-click on any still in the Browser.  The file name in the Still ID field reflects the currently 
selected still in the Browser. 

 Select Export to Aprisa from the File menu to open the Aprisa Export dialog box.  The file 
name in the Still ID field reflects the currently selected still in the Browser, even if the 
Browser is closed.  

3. Change the Still ID to an unused Still ID.  This is crucially important as the existing still will otherwise 
be overwritten when exported.  The format of the Still ID must be xxxx, where xxxx is a four-digit 
number. 

4. If appropriate, select a Destination from the Destination drop-down list box. 

5. Edit or enter information into the Description and numbered fields. 

6. Click Export.  The Aprisa Export dialog box closes. 

7. Click the Refresh Database icon or select Refresh Database from the Browser menu.  The 
new still appears in the Browser. 

Searching Aprisa Still Assets 
To narrow down the assets in a Browser database, Aprisa Still Assets can be searched, based on a search 
strings (Still IDs, Description, information in Fields 1 through 8), Modification Date, etc.  Refer to 
Searching the Browser for details on the Search tool. 

For additional information on Aprisa operations, refer to the documentation that accompanies the Aprisa 
hardware and software. 
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Import from Aprisa 
File Menu > Import from Aprisa 
An Aprisa still can be imported as an object or a Background from an Aprisa system into Lyric. 

The import and export processes entail complete conversion to and from the Lyric format. Once an Aprisa still 
is imported from into Lyric, it becomes part of a Lyric graphic object or Background.  When it is exported 
back to the Aprisa, the entire Lyric graphic is exported as an Aprisa still. 

Running on Duet or a PC, Lyric can connect to the Aprisa over a network and open stills chosen from the 
Aprisa database.  The image can be titled or otherwise manipulated in Lyric and then networked back to the 
Aprisa system for storage and use as an Aprisa still.  Note that the Aprisa image can also be stored as a 
standard Lyric message on the Duet or PC. 

Before performing import and export operations within Lyric, it is necessary to configure Lyric for access to 
the Aprisa.  Refer to Aprisa Interface Configuration for details. 

NOTE 
A still can also be quickly imported from the Aprisa via the Aprisa Still Assets Browser 
Window.  Refer to Aprisa Still Asset Operations for details. 

To import a still from an Aprisa system: 
1. From the File menu, select Import from Aprisa. The Aprisa Import dialog box opens. 

 

Aprisa Import Dialog Box 
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2. In the Source drop-down list box, specify the source of the file: 

 File:  From Aprisa database.  If the file is to be selected from the database, enter the Still ID.  
Note that all available still files are also displayed in Lyric's Aprisa Still Asset Browser 
Window.  Refer to Aprisa Still Asset Operations for details. 

 

Aprisa Stills Browser  

 Directly from the current image on one of Aprisa’s three Air Channels, three Preview 
Channels or five Virtual Channels. 

3. Select the Insert as Object or Insert as Background radio button. 

 If the image is imported as an Object, the image is placed on the Lyric Canvas as a 2D 
bitmap object that can be repositioned, rotated, scaled, etc. 

 If the image is imported as a Background, it is centered on the Lyric Canvas.   Note that 
there is no Stretch to Fit option when using this import method.  Stretching the image to fit 
the Canvas size is available from the Browser.  Refer to Aprisa Still Asset Operations for 
details.  

4. Click the Import button. The image appears on the Canvas as specified. 

5. Modify the composition by adding text and/or objects, resizing, rotating, scaling, etc. 

6. When composition is complete, it can be saved as a Lyric message and/or exported back to the 
Aprisa.  Refer to File Menu:  Export to Aprisa for information. 

For additional information on Aprisa operations, refer to the documentation that accompanies the Aprisa 
hardware and software. 
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Export to Aprisa 
File Menu > Export to Aprisa 
Graphics created in Lyric can be exported as an Aprisa still to an Aprisa system. 

The import and export processes entail complete conversion to and from the Lyric format. Once an Aprisa still 
is imported from into Lyric, it becomes part of a Lyric graphic object or Background.  When it is exported 
back to the Aprisa, the entire Lyric graphic is exported as an Aprisa still. 

Before performing import and export operations within Lyric, it is necessary to configure Lyric for access to 
the Aprisa.  Refer to Aprisa Interface Configuration for details. 

1. From the File menu, select Export to Aprisa.  The Aprisa Export dialog box is displayed.   The 
following figure shows the Destination drop-down list box expanded. 

 

Aprisa Export 

2. If saving as a File, enter a Still ID number.  File Names are always of the format xxxx, where xxxx is 
a four-digit number. 

3. Optional:  Enter a Description for the still. 

4. Optional:  Enter additional descriptive information in Fields 1 through 8. 
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5. Select a destination for the still from the Destination drop-down list box.  There is a choice of three 
Air Channels, three Preview Channels, five Virtual Channels or File.  If File is selected, the 
composition is saved to the Aprisa database.  The following figure shows parameters entered. 

 

Aprisa Export Dialog Box - Parameters Entered 

6. Click Export.  If the destination of the composition is a channel, the composition appears on the 
channel.  If the destination is a file, the composition is saved as a still to the Aprisa database, and the 
file appears in the Aprisa Still Assets Browser Window.    Refer to Aprisa Still Asset Operations 
for information on the Browser. 

The Export to Aprisa procedure can also be used to update an existing still file.  Refer to Aprisa Still Asset 
Operations for details. 

For additional information on Aprisa operations, refer to the documentation that accompanies the Aprisa 
hardware and software. 
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Aprisa Clip Asset Operations 

Browser > ;  Browser Menu > Show Aprisa Clips 
NOTES 

 Before Aprisa Browser operations within Lyric, it is necessary to configure Lyric 
for access to the Aprisa.  Refer to Aprisa Interface for details.  If the system 
running Lyric is properly networked to the Aprisa, and the Aprisa Clip Assets are 
not displaying, make sure that Enable DDR has been selected (checked) in the 
Configure Aprisa Interface dialog box, accessed from Configure Menu > Aprisa 
Interface. 

 In order for Lyric to access Aprisa Clips, an Internal Clip Player must be present 
in the system, and the Aprisa application must be running, even if Lyric is 
running on the Aprisa system. 

 Duet HD systems, if properly configured in the Configure Aprisa Interface dialog 
box, accessed from Configure Menu > Aprisa Interface, can display Aprisa Clip 
Assets in the Browser.  The Duet HD cannot, however, play them, as the system 
does not have an Internal Clip Payer. 

Aprisa Clips are sets of animations also known as Events, which are stored on Chyron Aprisa systems.  For 
example, an Event can be comprised of a Key animation and a Fill animation that are played concurrently.  
They are played back on the Internal Clip Player, controlled by Lyric's Clip Control Panel. 

The Aprisa Clips Asset Browser is used strictly for viewing and a simple search based on the Description. 

NOTE 
Unlike Browser databases for Lyric TrueType® and RGB Fonts, Messages and bitmaps, 
which are independent of the source files, the Aprisa Clips database and the clips as 
stored on an Aprisa system are one and the same. There is only one Aprisa clips 
database per Aprisa system.  

In order for Lyric to have the ability to access remote Aprisa assets: 
 The Aprisa software must be running on the Aprisa platform. 

 The system on which Lyric is running must be properly networked to the Aprisa.  Refer to Aprisa 
Interface and for information on establishing a network connection. 

The following should be noted about Aprisa Clip Asset view options and file names: 
 Only the Icon View is available.  Text Only and Icon Text Views are inactive.  Metadata is displayed 

in the Aprisa Export dialog box (described below). 

 File Names are always of the format .xxxx, where xxxx is a four-digit number.  Starting the number 
with zeroes is permitted.  

 The Sort A-Z/Sort Z-A selection does not have an affect on the order of display.  The stills are 
always displayed in file name, i.e., numerical order. 
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Aprisa Clip Assets  

Refer to Aprisa 200 DDR and Aprisa 250 Stillstore/DDR for details on clip playback. 

To view an Aprisa Clip Asset's context menu: 

 Right-click on the asset. 

 
Aprisa Clip Asset Context Menu 

The menu items are all descriptive, and can be edited only from within the Aprisa interface on the Aprisa 
system.  There are no Edit or Update functions available from within the Lyric interface. 

 Descr:  Description of the clip. 
 Strm 1:  Specifies a file that is a component of a clip. 
 Strm 2:  Specifies a file that is a component of a clip. 
 Duration:  Length of the clip.  Note that the within the Clip Control Panel in Lyric, Clip files can be 

created which determine where the clip starts and stops, but that has no effect on the Aprisa clip 
itself.  The clip can also be saved as part of a Lyric message.  Again, this has no effect on the Aprisa 
clip.  Refer to Aprisa Systems for additional information. 

Searching Aprisa Clip Assets 
To narrow down the assets in a Browser database, Aprisa Clip Assets can be searched based on 
Description.  Refer to Searching the Browser for details on the Search tool. 

For additional information on Aprisa operations, refer to the documentation that accompanies the Aprisa 
hardware and software. 
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35. External VTR/DDR Systems and Lyric 

External VTR and DDR Systems 
External video from a VTR or DDR can provide be input to Duet to be used in Lyric compositions.  Lyric can 
also control playback from these devices.  Note that an RS-422 Serial I/O & GPI/O Board must be installed 
in the Duet in order that Lyric controls the VTR or DDR.  Refer to the section on the RS-422 Serial I/O & 
GPI/O Board for additional information. 

Setup, Digital vs. Analog Video 
Duet accommodates only 10-bit SDI video inputs.  If you are using an analog VTR, an analog-to-digital 
converter must be used upstream of the Duet.  If you’re using digital VTR, make sure that its output is 
compatible with Duet.  Conventionally, the source machine or an analog-to-digital converter processing its 
output should be connected to the Video In connector on Duet’s Internal Keyer. 

 

Connecting External VTR or DDR to Duet's Internal Keyer 
Connect the DB-25 input connector of Duet’s GPI/O board to the VTR or DDR.  This also serves to test the 
serial connection established in the section on GPIs and Serial Control of External Devices.  For complete 
information on Duet’s GPIO facility and its connections, refer to Section 6 in the Duet Hardware Reference 
Manual.  Also refer to the section covering the RS-422 Serial I/O & GPI/O Board. 

Displaying VTR Video with Duet Output 
In order to display a video source such as a VTR, specific configuration is required.  Refer to Configuration 
for Display of Video Source - Duet SD,  Configuration for Display of Video Source - Duet HD or 
Configuration for Display of Video Source - Duet LE/LEX/PCI/PCI+ for details. 

Refer to Clip Control Panel for information on controlling the external VTR or DDR from Lyric, and on 
recording clip files.  Note that when playing back clip files, the VTR or DDR, as well as the source video, must 
be available to the Duet system.  Refer to Recording Clips to Animation and Audio File Formats for 
information on recording standalone *.avi and *.wav files. 
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36. iNFiNiT! Family Systems and Lyric 

iNFiNiT!® Font Asset Operations 

Browser > ;  Browser Menu > Show iNFiNiT! Fonts 
iNFiNiT! fonts can be used by Lyric to create compositions which can be exported to iNFiNiT! systems.  Lyric 
fonts can also be created in the Custom Font Editor, saved as iNFiNiT! fonts, and then added to the 
iNFiNiT! Fonts Assets in the Browser. 

The following should be noted about iNFiNiT! Font Asset view options, file names and functions: 
 Only the Icon View is available.  Text Only and Icon Text Views are inactive.  Metadata is displayed 

in the Browse for iNFiNiT! Fonts dialog box (described below). 

 iNFiNiT! font names always have the format .xxxx.fnt where xxxx represent numerals.  Only the 
numeric portion of the File Name is displayed in the Browse for iNFiNiT! Fonts dialog box; .fnt does 
not appear in the File Name.  See About iNFiNiT! Font Names at the end of this section for 
additional information. 

 iNFiNiT! fonts can be used only for typing 2D text, not 3D characters.  If an attempt is made to type a 
3D character using an iNFiNiT! font, the following is displayed: 

 

3D Character iNFiNiT! Font Warning 

 The Sort A-Z/Sort Z-A selection does not have an affect on the order of display.  As described below 
in the section on Hotkeys and Font Keys, iNFiNiT! Font Asset positions are absolute, and are 
based on Font Key assignment. 

 The Save to Database function is not available to the iNFiNiT! Font Asset Browser.  

 Search is not currently implemented for iNFiNiT! assets. 

NOTE 
Unlike Browser databases for Lyric TrueType® and RGB Fonts, Messages and bitmaps, 
which are independent of the source files, any change to iNFiNiT! Font metadata changes 
the metadata for the source file. 
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About iNFiNiT! Font Hotkeys and Font Keys 
Hotkey combinations are used to quickly load fonts when a PC keyboard is controlling the Duet, as opposed 
top a Duet keyboard.  Unlike Lyric Font Assets, which encompass both TrueType and RGB Fonts, a 
Hotkey combination is not assigned to the font through its context menu.  Rather, a Hotkey combination is 
assigned based on its position in the iNFiNiT! Font Browser.  Hotkeys are assigned in the following order:  
Alt + 1 through Alt + 8; then Alt + Shift + 1 through Alt + Shift + 8.  In the iNFiNiT! Font Browser, they 
appear from left-to-right, and top-to-bottom.    Alt + 0, Alt + Shift + 0, Alt + 9 and Alt + Shift + 9, which can 
access Lyric font assets, are not used to access iNFiNiT! fonts.  The following table shows the relationship 
between the Hotkeys and the Font Keys on the Duet and iNFiNiT! keyboards.  The Font Number in the 
Lyric Font Tools Font Facename field is described later in this section. 

Hotkey Alt + 
1 

Alt + 
2 

Alt + 
3 

Alt + 
4 

Alt + 
5 

Alt + 
6 

Alt + 
7 

Alt + 
8 

Duet 
Keyboard 

1 2 3 4 5 6 7 8 

iNFiNiT! 
Keyboard 

1 2 3 4 5 6 7 8 

Font 
Number 
in Lyric 

Font 
Tools 
Font 

Facename 
Field 

(0) (1) (2) (3) (4) (5) (6) (7) 

Hotkey Alt + 
Shift 
+ 1 

Alt + 
Shift 
+ 2 

Alt + 
Shift 
+ 3 

Alt + 
Shift 
+ 4 

Alt + 
Shift 
+ 5 

Alt + 
Shift 
+ 6 

Alt + 
Shift 
+ 7 

Alt + 
Shift 
+ 8 

Duet 
Keyboard 

Shift 
+ 1 

Shift 
+ 2 

Shift 
+ 3 

Shift 
+ 4 

Shift 
+ 5 

Shift 
+ 6 

Shift 
+ 7 

Shift 
+ 8 

iNFiNiT! 
Keyboard 

ALT 
1 

ALT 
2 

ALT 
3 

ALT 
4 

ALT  
5 

ALT  
6 

ALT  
7 

ALT  
8 

Font 
Number 
in Lyric 

Font 
Tools 
Font 

Facename 
Field 

(8) (9) (10) (11) (12) (13) (14) (15) 
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The Font Asset positions in the iNFiNiT! Fonts Browser are absolute and correspond to the Font Keys 
found on an iNFiNiT! Family system.  There is a limit of sixteen fonts in an iNFiNiT! Font Browser database. 

 

iNFiNiT! Font Assets 

The figure shows twelve of the sixteen font positions assigned.  Note that font positions can be assigned in 
any order, and do not have to be filled consecutively.  For example, if the rightmost font position in the second 
row is the next font assigned, it would correspond to Shift + Font Key 8 on the Duet keyboard, and ALT Font 
Key 8 on the iNFiNiT! keyboard.  Its Lyric PC Hotkey combination would be Alt + Shift + 8. 

The iNFiNiT! Fonts Context Menu 
There are two context menus available from within the iNFiNiT! Font Assets Browser, depending on the 
cursor position when accessed: 

 iNFiNiT! Font Browser Context Menu:  Accessed by right-clicking a blank iNFiNiT! icon/text listing, 
or on a blank area of the Browser.  Browse for Fonts, Delete iNFiNiT! Font and Custom Font 
Editor are available from this menu.  Refer to Custom Font Editor for information on using this tool. 

 iNFiNiT! Font Context Menu:  Accessed by right-clicking an iNFiNiT! Font Asset in the Browser.  
Browse for Fonts, Delete iNFiNiT! Font, and Custom Font Editor are available from this menu, as 
well as descriptive items Font File, Typeface, Name 1 and Name 2. 

 

iNFiNiT! Font Context Menu 
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Browse for Fonts - Loading iNFiNiT! Fonts 
iNFiNiT! fonts may be loaded directly into the Lyric Browser.  You may load these assets from a local or 
networked Windows directory where iNFiNiT! fonts are stored.  Messages composed in Lyric using iNFiNiT! 
fonts can easily be exported for display on iNFiNiT! systems. 

To load an iNFiNiT! font into the Browser: 

1. Click the iNFiNiT! Fonts icon at the top of the Browser control panel. 

2. In the Browser, right-click on an available blank icon. 

 

Selecting a Blank Font Icon 

3. The Browse for iNFiNiT! Fonts dialog box is displayed.  Navigate to the directory in which the 
iNFiNiT! fonts are stored. 

 

Selecting an iNFiNiT! Font to Load 

4. Double-click the listed font to load it into the Browser.  If the font does not load, it may be improperly 
named.  Refer to About iNFiNiT! Font Names at the end of this section for details on renaming an 
iNFiNiT! font file. 

5. Repeat Steps 2 through 4 to load additional fonts. 

6. Once the all fonts are loaded, click the Close icon to close the Browse for iNFiNiT! Fonts dialog 
box. 
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To use an iNFiNiT! font in Lyric composition: 

 Click on the font icon in the Browser, and then click the Load from Database icon , or double-
click the font icon in the Browser. 

iNFiNiT! fonts can be used only for typing 2D text, not 3D characters.  If an attempt is made to type a 3D 
character using an iNFiNiT! font, the following message is displayed: 

 

3D Character iNFiNiT! Font Warning  

In the figure below, note that the name and size of the font appear in the Font Facename and Font Size 
fields, respectively, of Lyric’s Font Toolbar. The number in parentheses indicates the Font Key position, 
minus 1, on both the Duet and iNFiNiT! keyboards.  The number (2) shown below corresponds to Font Key 3.  
The table at the beginning of this section demonstrates the relationship between the number shown in the 
Font Facename field, and the Font Keys.    

 

Applying an iNFiNiT! Font 

The Font Face Name, Font Variation and Font Sample and other characteristics are also displayed in the 
Font Properties and 2D Font FX Properties tabs.  The Font Variation is specified as iNFiNiT! Machine 
Font.  Refer to Font Properties and 2D Font FX Properties for additional information. 

The Status Bar may display a warning that the iNFiNiT! font does not exist.  It is not of concern.  It just 
indicates that the iNFiNiT! font is not in the system’s TrueType font list.  



Lyric User Guide 

 36-6 

Delete iNFiNiT! Font 
Delete iNFiNiT! Font removes the font from the Browser database, without disturbing the original font file.  
To delete an iNFiNiT! font from the Browser: 

 Right-click on the font in the Browser, then select Delete iNFiNiT! Font from the context menu.  The 
font is deleted without a request for confirmation. 

Custom Font Editor 
About the Custom Font Editor 
The Custom Font Editor provides the ability to edit the characters.  It also enables the ability to edit iNFiNiT! 
font metadata.  Refer to Custom Font Editor for information on this tool.  

Editing iNFiNiT! Font Asset Information (Metadata) 
Unlike Lyric Font Assets, which encompass both TrueType and RGB Fonts, iNFiNiT! font metadata is not 
edited from a context menu-accessed Lyric dialog box.  The metadata is instead, edited from the iNFiNiT! 
system, or from within the Custom Font Editor.  To access the Custom Font Editor: 

1. Right-click on a font icon in the Browser.  During the editing procedure, do not move the cursor to 
another font icon in the Browser. 

2. Select Custom Font Editor from the context menu.  The Custom Font Editor opens. 

3. Pull down the Tools menu, and then select Edit Font Name.  The Edit Font Name dialog box opens. 

 

Custom Font Editor - Edit Font Name 

The following fields can be edited: 

 File Header Name:  Corresponds to Name 1 on the Browse for iNFiNiT! Fonts dialog box. 

 Effect Name:  Corresponds to Name 2 on the Browse for iNFiNiT! Fonts dialog box. 

 Font Header Name:  If the link icon is active , the Font Header Name always reflects 

the File Header Name, and is not editable.  If the link icon is inactive , the Font Header 
Name can be edited.  Note that when the link icon is active (as shown in the previous figure), 
a bracket connects the File Header Name with the Font Header Name. 

4. Click OK to apply edits.  The Edit Font Name dialog box closes. 

5. Optional:  Perform edits to the font characters in the Custom Font Editor. 

6. Pull down the File menu in the Custom Font Editor, then select Save.  The Custom Font Editor 
can be closed at his point, although it is not necessary to do so. 
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7. In the Browse for iNFiNiT! Fonts dialog box, click Refresh List to apply changes to the font. 

8. In the Browse for iNFiNiT! Fonts dialog box, double-click on the font listing to apply the changes to 
the iNFiNiT! Font Asset in the Browser.  There will be no visible change to the font icon in the 
Browser, but the edits will have been applied. 

Refer to Custom Font Editor for additional information on this tool. 

About iNFiNiT! Font Names 
iNFiNiT! font names always have the format .xxxxxxxx.fnt where xxxxxxxx represent numerals.  Only the 
numeric portion of the File Name is displayed in the Browse for iNFiNiT! Fonts dialog box; .fnt does not 
appear in the File Name.  If a font is not loading into the Browser from the Browse for iNFiNiT! Fonts dialog 
box, it could be due to an incorrectly formatted name. 

This may have occurred if saving the iNFiNiT! font under an incorrectly-formatted name in the Custom Font 
Editor.  The font is recognized by and appears in the Browse for iNFiNiT! Fonts dialog box, but does not 
load to the Browser.  If this is the case, the name must be changed. 

Windows does not allow a file to be renamed with "." as the first character in the File Name, so it must be 
renamed using the DOS utility. 

1. Open a DOS window. 

2. Use the cd command the change to the directory in which the font file is located.  The syntax is as 
follows:  cd <New Directory Path>.  Press Enter. 

3. Use the ren command to rename the file.  The syntax is as follows: 

ren "<Original File Name>" .xxxxxxxx 

The quotes enclosing the <Original File Name> are necessary only if the name contains spaces.  
The <> brackets are not typed.  .xxxxxxxx is the New File Name, where xxxxxxxx represents 
numerals.  Note that leading zeroes can be omitted. 

4. Press Enter.  The file is now renamed and should load to the Browser. 

Transferring Fonts to the iNFiNiT! 
Transferring fonts to an iNFiNiT! Family system is accomplished by using FTP.  Chyron recommends using 
CuteFTP to execute the file transfer.  This procedure is described in FTP - Transferring Files to/from an 
iNFiNiT! System. 
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Import from iNFiNiT! 
File Menu > Import from iNFiNiT! 

Copying iNFiNiT!® Files to Windows-Formatted Directories 
Lyric's power and flexibility includes the ability to import and read message created on Chyron® iNFiNiT!® 
Family systems, which include the iNFiNiT!®, MAX>!® and MAXINE!®.  In order for Lyric to read iNFiNiT!-
formatted messages, both the iNFiNiT! messages and the iNFiNiT! fonts associated with the messages must 
be copied to Windows-formatted directories that reside locally on the system running Lyric. 

Once the iNFiNiT! messages and their fonts are copied to Lyric, they can be read in Lyric using the following 
methods: 

 The iNFiNiT!-formatted messages can be read to the Canvas using the Read function accessed from 
the iNFiNiT! Message Import dialog box. 

 The copied iNFiNiT! messages can be converted into Lyric-formatted messages, where they can be 
read to the Canvas in the same manner as other Lyric messages. 

Lyric provides two methods for copying the files from an iNFiNiT! system to the Windows-formatted 
directories: 

 Direct copy from an iNFiNiT!-formatted ZIP® or JAZ® disk inserted in a local ZIP® or JAZ® drive.  Note 
that iNFiNiT!-formatted floppy disks cannot be accessed by Lyric. 

 Copy via FTP. 

Creating Windows-Formatted Message and Font Directories 
Two Windows-formatted directories should be created for the storage of the iNFiNiT! message and font files.  
It is possible to copy both message and font files to a single Windows-formatted directory, but for ease of 
organization, it is recommended that they be stored in separate directories.  In addition, it allows the use of 
the same ID number for both a message and a font, as they reside in different directories. 

1. Before copying files from the iNFiNiT!, create a Windows-formatted directory to accept message files, 
and a Windows-formatted directory to accept font files.  In the following example, the directories used 
are as follows: 

 C:\iNFiNiT\MESSAGE 

 C:\iNFiNiT\FONT 

2. If there are no files in either or both of the directories, place a dummy file in each directory.  It need 
not be an iNFiNiT! message or iNFiNiT! font file.  This is necessary in order to select a directory if 
using the Browse function described below. 
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Copying Files from an iNFiNiT! ZIP® or JAZ® Disk 
iNFiNiT! files that are stored on an iNFiNiT!-formatted ZIP® or JAZ® disk can be imported into Lyric via FTP 
(covered later in this section) if the ZIP or JAZ disk is inserted into an iNFiNiT! Family system SCSI ZIP or 
JAZ drive at the time of import.  If, however, the ZIP or JAZ disk is available, but an iNFiNiT! Family system is 
not available, Lyric provides a procedure for importing these files from a local ZIP or JAZ drive installed on the 
system which is running Lyric. 

WARNING!!! 
If an attempt is made to use Windows Explorer, My Computer or other Windows directory 
viewing utility to view iNFiNiT!-formatted files on a ZIP® or JAZ® disk, the following error 
message is displayed: 

 

Windows Error Message 

DO NOT CLICK "Yes!!!"  If Copy Protection is not set on the ZIP or JAZ disk, it will then 
be reformatted and all file data will be lost!!!  Click "No" to exit the error message.  Use 
the following procedure instead to view and copy files.  

NOTE 
The only type of ZIP drive on which the iNFiNiT! can record is a SCSI ZIP drive.  This 
restriction does not extend to viewing and/or copying iNFiNiT! files from a ZIP drive 
connected to a Windows® 2000 or NT® system running Lyric.  In this instance, the ZIP 
drive can be SCSI, IDE, parallel or USB (Windows® 2000 only).  On a system running a 
different operating system, there may be restrictions as to which ZIP drive types are 
supported for iNFiNiT! file viewing/copy operations.  All JAZ drives are SCSI, and 
iNFiNiT!-formatted files can be accessed from Windows® 2000 and Windows NT® systems 
running Lyric. 
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Additionally, the presence of an older Iomega® ZIP® driver on a system can interfere with 
Lyric's ability to read an iNFiNiT!-formatted ZIP drive.  Either use system drivers if 
possible, or download a newer driver from Iomega instead.  The following table shows 
driver requirements.  

Drive Type Operating 
System 

Requires 
Iomega® 
Driver? 

Windows® 2000 No 
IDE ZIP® 

Windows NT® Yes 

Windows® 2000 Yes 
Parallel ZIP® 

Windows NT® Yes 

Windows® 2000 No 
SCSI ZIP® 

Windows NT® No 

Windows® 2000 Yes 
USB ZIP® 

Windows NT® Not Supported 

Windows® 2000 No 
SCSI JAZ® 

Windows NT® No 

 

To copy the files from an iNFiNiT!-formatted ZIP or JAZ disk to a local, Windows-formatted directory: 
1. From the Lyric File menu, select Import from iNFiNiT!.  The iNFiNiT! Message Import dialog box 

opens. 

 

iNFiNiT! Message Import Dialog Box 
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2. Click the Copy Files from iNFiNiT! Disk button.  The Copy iNFiNiT! Files dialog box opens. 

 

Copy iNFiNiT! Files Dialog Box 

3. The dialog box is divided into two main sections: 

 The Source List (iNFiNiT! Disk):  Specifies the iNFiNiT!-formatted ZIP or JAZ directory from 
which the files are to be imported. 

 Target List (Lyric Drive):  Specifies the Windows-formatted directory into which the files are 
to be copied. 

Select the Source and Target drives as follows: 

 From the Select Drive drop-down list box on the Source List side, select the ZIP or JAZ 
drive from which the file is to be copied. 

 From the Select Drive drop-down list box on the Target List side, select the local, Windows-
formatted drive to which the file is to be copied. 

 

Selecting Source and Target Drives 
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4. Navigate to the Source file(s) that is to be copied to the Windows-formatted file.  When navigating to 
the Source directory, all directory selection must take place in the left panel of the Source side.  Only 
the file(s) is selected on the right side.  Note that multiple files can be selected in a normal Windows 
fashion, or the file names, each separated by a semi-colon ;, can be entered into the File Name field.  
Note that in the figure following the next step, a range of files is selected. 

5. Navigate to the Target Windows-formatted directory to which the iNFiNiT! file is to be copied.  When 
navigating to the Target directory, all directory selection must take place in the left panel of the 
Target side. 

Note that if it is necessary to refresh the view of the directories and files, press F5. 

 

Selecting Files to Copy 

6. Click Copy.  The progress of the copy operation is tracked in normal Windows fashion. 

 

Files Copying from ZIP or JAZ Drive 



 iNFiNiT! Family Systems and Lyric  

 36-13 

When the Copy operation is complete, the Target List shows the newly copied files. 

 

File Copy Complete 

7. If necessary, repeat the Copy operation to copy additional files.  Remember that when copying 
Message files, the accompanying Font files must be copied as well.  When all Copy operations are 
complete, click the Close icon  on the Copy iNFiNiT! Files dialog box.  Copied Message files can 
now be read into Lyric.  See Reading iNFiNiT! Messages without Conversion to Lyric Format 
later in this section.  Copied Font files can now also be loaded into the Browser for use in building 
Lyric and iNFiNiT! compositions.  Refer to Browser:  iNFiNiT! Font Asset Operations for additional 
information. 
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Disk Copy Error Messages 
The following errors and/or warnings may be displayed during a Copy operation: 

Message and Description/Fix 

 

Error Reading from Source Drive 

The disk may not be a valid iNFiNiT!-formatted ZIP or JAZ disk. 

 

Failed to Open Device 

Device may not be supported for this operation.  For example, this error is generated if 
attempting to read an iNFiNiT!-formatted floppy disk. 

Copying Files from an iNFiNiT! Disk via FTP 
Files can be copied from any onboard or connected drive on an iNFiNiT! family system to a local, Windows-
formatted drive.  To copy the files via FTP from an iNFiNiT! drive to a local drive: 

1. From the Lyric File menu, select Import from iNFiNiT!.  The iNFiNiT! Message Import dialog box 
opens. 

 

iNFiNiT! Message Import Dialog Box 
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2. Click the Copy iNFiNiT! files via FTP button.  The Copy iNFiNiT! Files via FTP dialog box opens. 

 

Copy iNFiNiT! Files via FTP Dialog Box 

3. Enter the IP Address or select from the drop-down.  If necessary, enter a Username and a 
Password.  To save this information for future use, select (check) the Save checkbox. 

4. Enter the Local Directory (i.e., the Windows-formatted directory) to which the file is to be copied.  
The directory also may be available from the Local Dir drop-down.  It can, as well, be located by 
clicking the Browse button and navigating to the directory.  In this instance, it is necessary to select a 
file in order to select the directory, which is why there must be a file in the directory.  Note that if a file 
format other than an iNFiNiT! message or iNFiNiT! font file is selected, the directory name is entered 
into the Local Dir field, but the File field remains blank.  This is fine, as a different File ID will be 
entered. 
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5. Enter the Remote Directory (i.e. the iNFiNiT! system directory) from which the file is to be copied.  
Note that a forward slash at the end of Directory name is optional.  The directory also may be 
available from the Local Dir drop-down.  It can, as well, be located by clicking the Browse button and 
navigating to the directory.  In this instance, a File, a range of files, or non-contiguous files to copy 
can be selected as well.  See the next step for details. 

 

Select Server Folder Window 

6. Use one of the following methods to enter a File ID or multiple File IDs: 

 Enter (type) the file names by typing into the File field.  It can be formatted xxxx or .xxxx, 
where x is a numeral.  A range of File IDs can also be entered using the format xxxx-yyyy, 
or .xxxx-.yyyy.  Note that thumbnail files (xxxx.TN) can be copied as well.  The thumbnail 
file can be formatted xxxx.TN or .xxxx.TN.  

 Use the Browse function, as shown in the previous figure, to navigate to the directory that 
contains the file or files that are to be copied.  Select (check) Show Files in order to display 
files.  To select a single file, click a File ID.  To select a range of files, hold the Shift key while 
clicking the first, then the last (or vice versa) file in the range.  To select non-contiguous files, 
press and hold the Ctrl key, then click the File IDs.  When file selection is complete, click 
OK.  If a single file is selected, it is in the displayed in the format .xxxx in the File field.  If a 
range of files or non-contiguous files are selected, SELECTED FILES is displayed in the File 
field. 
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7. There are three options in the Options Area.  Each can be made active by selecting (checking) or 
made inactive by deselecting (unchecking): 

 Skip Warnings:  Select Skip Warnings to prevent the display of overwrite and other 
warnings when the FTP operation is executed.  Note, however, that warnings will be 
displayed regardless of the Skip Warnings setting unless such warnings have been disabled 
in the Preferences menu. 

 Overwrite All:  Select Overwrite All if all files in the local target directory which have 
matching file IDs as the incoming files are automatically overwritten when the FTP operation 
is executed. 

 Passive FTP:  Select Passive FTP to have the data transfer initiated by the File Transfer 
Program client, rather than the FTP server program.  This is recommended where security is 
a concern, as it ensures that all data flow initiation comes from inside, rather than outside, the 
network.  It has no visible effect on the file transfer operation. 

8. A sample Copy iNFiNiT! Files via FTP dialog box is shown in the following figure.  Click FTP 
Execute.  The files are copied from the iNFiNiT! Remote Directory to the target Local Directory. 

 

Copy iNFiNiT! Files via FTP 

9. If necessary, repeat the FTP Execute to copy additional files.  Remember that when copying 
Message files, the accompanying Font files must be copied as well.  When all FTP operations are 
complete, click Close.  Copied Message files can now be read into Lyric.  See Reading iNFiNiT! 
Messages without Conversion to Lyric Format later in this section.  Copied Font files can now 
also be loaded into the Browser for use in building Lyric and iNFiNiT! compositions.  Refer to 
Browser:  iNFiNiT! Font Asset Operations for additional information. 
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FTP Execute Error Messages 
The following errors and/or warnings may be displayed during an FTP Execute: 

Message and Description/Fix 

 

FTP Open Error 

One or more of the FTP parameters, including IP Address, Username, Password or 
Remote Dir may not be correct. 

 

Server Name and Address Not Resolved 

This error message can be generated by a variety of network-related problems, 
including the following: 

 The iNFiNiT! may not be not properly connected to the network. 

 If using a Computer Name instead of an IP Address to identify the iNFiNiT!, 
the name may not be properly mapped to the IP Address. 

 

Remote Directory Not Found 

The iNFiNiT! Remote Directory name is invalid.  
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Message and Description/Fix 

 

Operation Timed Out 

Check that all involved systems are turned on, properly networked and that the IP 
Address and directory names entered in the Copy iNFiNiT! Files via FTP dialog box 
are valid. 

 

Invalid ID Error 

One or more of the iNFiNiT! system File IDs is invalid. 

 

Overwrite Warning 

This warning is displayed if there is a file of the same File ID in the target directory as 
the File ID of an incoming file.  Select Yes to overwrite, No to prohibit the overwrite, or 
Cancel to cancel the FTP Execute operation.  Note that any files that were copied to 
the target Local Directory before an FTP Execute is cancelled are not deleted or 
changed to the pre-overwrite state. 

 

File Used by Another Process 

The file has already been imported and is currently in use.  Close the file in Lyric. 
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Reading iNFiNiT! Messages without Conversion to Lyric Format 
Lyric can read and properly display iNFiNiT! message files as long as the message's accompanying font files 
are available.  To read an iNFiNiT! message in Lyric: 

1. Copy iNFiNiT! message and iNFiNiT! font files to a Local Directory as previously described, and 
then close the Copy iNFiNiT! Files via FTP dialog box.  The iNFiNiT! Message Import dialog box is 
displayed. 

 

iNFiNiT! Message Import Dialog Box 

2. In the Font Dir field, enter the Windows-formatted directory in which the iNFiNiT! fonts were copied.  
Note that a forward slash at the end of Font Directory name is optional.  The directory also may be 
available from the Font Dir drop-down.  It can, as well, be located by clicking the Browse button and 
navigating to the directory, then selecting any file.  This is necessary in order to select the directory.  
Note that if a file format other than an iNFiNiT! message or iNFiNiT! font file is selected, the directory 
name is entered into the Font Dir field, but the Msg ID field remains blank.  This is fine, as a 
Message ID will eventually be entered. 

3. In the Msg Dir field, enter the name of the Windows-formatted directory into which the iNFiNiT! fonts 
were copied.  Note that a forward slash at the end of Message Directory name is optional.  The 
directory also may be available from the Msg Dir drop-down.  It can, as well, be located by clicking 
the Browse button and navigating to the directory.  Select a message file.  Note that for proper 
display of the message file, all associated fonts must be resident in the selected Font Directory. 

4. If the Message ID has not yet been entered, enter a Message ID in the Msg ID field. 

5. Optional:  Select (check) Skip Warnings to prevent the display of warnings when the FTP operation 
is executed.  Note, however, that warnings will be displayed regardless of the Skip Warnings setting 
unless such warnings have been disabled in the Preferences menu. 

6. A sample iNFiNiT! Message Import dialog box is shown in the following figure.  Click Read, press 
the Duet Read key or press Enter on the PC keyboard.  If the selected iNFiNiT! message is a text 
message, the file is read to the Lyric Canvas.  If the selected iNFiNiT! message is an RGB message, 
continue to the next step. 

 

iNFiNiT! Message Import Dialog Box 
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7. If the message is an RGB message, the iNFiNiT! RGBA Import dialog box is displayed.  Select 
Insert as Object to place the file in the Lyric Canvas as an object, or select Insert as Background 
to place the file as a Background.  The message is placed on the Lyric Canvas as specified. 

 

iNFiNiT! RGBA Import Dialog Box 

If the message is a Text message, the message is read to the Lyric Canvas, and the Machine fonts 
are loaded to the Lyric Browser in the iNFiNiT! Font Assets Window. 

Various error and/or warning messages may be displayed during a Read operation.  Refer to iNFiNiT! 
Message Import Read and Batch Convert Errors later in this section for details. 

The following occurs when an iNFiNiT! message is read in Lyric: 
 iNFiNiT! Message Import opens a new 2D Text Window on the Canvas, into which all text from the 

iNFiNiT! message is placed. 

 All available fonts that are associated with the message, and stored in the selected Local Font 
Directory, are loaded into Browser's iNFiNiT! Asset Window.  Hotkeys are automatically assigned 
to the fonts, in order of the Font ID numbers.  Refer to Browser:  iNFiNiT! Asset Operations for 
information on Browsers. 

 The Msg ID in the iNFiNiT! Message Import dialog box increments to the next Message ID found in 
the Local Directory. 

 If the cursor is on text that has been created using an iNFiNiT! font, the name and size of the font are 
displayed in the Font Toolbar. 

NOTE 
Remember that the Canvas Resolution setting, accessed from Lyric's Config menu, 
affects how accurately Lyric reproduces an iNFiNiT! message on the Lyric Canvas, and 
subsequently, on output.  Specifically, most iNFiNiT! messages are composed for display 
in 4:3, therefore import into a 16:9 Lyric Canvas may yield undesirable results.  It is 
recommended that graphics that are to be used for 16:9 output from Lyric, be created on 
the iNFiNiT! in 16:9 format. 

Converting iNFiNiT! Messages to the Lyric Format 
Converting a Single Message 
To convert a single iNFiNiT! message to Lyric format: 

1. Use the iNFiNiT! Message Import Read function to read an iNFiNiT! message to the Canvas. 

2. Use one of the Lyric Save functions to record the message in the Lyric format to the current Lyric 
Default Message Directory.  Refer to File:  Save, File:  Save As, Recording/Reading Messages 
for additional information on Save functions. 

Remember that editing a Lyric message converted from the iNFiNiT! format requires Machine Fonts 
associated with the original iNFiNiT! messages. 
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Converting Multiple Messages - Batch Convert 
To convert multiple iNFiNiT! messages to Lyric format: 

1. Select a Font Dir and a Msg Dir as previously described in Performing an iNFiNiT! Message 
Import Read Operation, but do not enter a Msg File ID.  If a Msg File ID is present, delete it from 
the Msg File field. 

2. Click the Batch Convert button.  The Import Batch Convert dialog box opens. 

 

Import Batch Convert 

3. In the Start ID and End ID fields, enter a range of File IDs for the files that are to be converted. 

4. Optional:  Select (check) Skip Warnings to prevent the display of warnings when the FTP operation 
is executed.  Note, however, that warnings will be displayed regardless of the Skip Warnings setting 
unless such warnings have been disabled in the Preferences menu. 

5. Click OK to convert the selected messages.  The messages are saved to the current Lyric Default 
Message Directory. 
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iNFiNiT! Message Import Read, Save and Batch Convert Errors 
The following errors and/or warnings may be displayed during an iNFiNiT! Message Import Read or Batch 
Convert operation: 

Message and Description/Fix 

 

System Couldn't Find File Specified 

iNFiNiT! message file not found in specified directory. 

 If Displayed During a Read or Save Operation:  Click OK to cancel the 
Read operation. 

 If Displayed During a Batch Convert Operation:  Click OK to skip and 
continue to the next file. 

 

Couldn't Find iNFiNiT! Font File 

The specified iNFiNiT! Machine Font file not found in specified directory. 

 If Displayed During a Read or Save Operation:  Select Yes to browse for 
the file; No to ignore the font and continue the Read or Save operation; or 
Cancel to cancel the Read or Save operation.  If the specified Machine Font 
is not found, the text using the font is not displayed. 

 If Displayed During a Batch Convert Operation:  Select Yes to browse for 
the file; No to ignore the Machine Font and continue the Batch Convert 
operation; or Cancel to cancel the Batch Convert operation.  If the specified 
Machine Font is not found, the text using the font is not displayed when the 
message is read. 
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Message and Description/Fix 

 

Confirm Overwrite 

This warning is displayed if there is a file of the same File ID in the target directory as 
the File ID of an incoming file.  Note that the Title Bar of the warning reflects the 
message File ID number of the message in question. 

If Displayed During a Save Operation:  Select OK to overwrite, or Cancel to skip the 
overwrite. 

If Displayed During a Batch Convert Operation:  Select OK to overwrite, or Cancel 
to skip the overwrite of that file and move to the next file. 

 

iNFiNiT! RGBA Import Dialog Box 

Read, Save or Batch Convert Operation:  The iNFiNiT! message about to be 
converted is an RGBA message.  Select Insert as Object radio button to import into 
the Lyric Canvas as a 2D bitmap graphic, or the Insert as Background radio button to 
insert as a centered Background. 

 

iNFiNiT! Template Data Message Not Supported 

iNFiNiT! Tab Data messages (known as Template Data messages in Lyric) are not 
supported in Lyric unless renamed to Lyric format.  See Using Tab/Template 
Description and Data Messages in Lyric later in this section for information on these 
types of messages. 

 If Displayed During a Read or Save Operation:  Click OK to cancel the 
Read or Save operation. 

 If Displayed During a Batch Convert Operation:  Click OK to skip this 
message and continue to the next file. 
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Message and Description/Fix 

A number of iNFiNiT! additional message types are not supported for conversion to 
Lyric.  Examples are as follows: 

 

iNFiNiT! 'Lyric Text and Graphics Message' Not Supported 

 

iNFiNiT! 'Single Function Key Message' Not Supported 

 

iNFiNiT! 'Multi FX Message' Not Supported 

The specified message type is not supported for conversion to a Lyric message.   

 If Displayed During a Read or Save Operation:  Click OK to cancel the 
Read or Save operation. 

 If Displayed During a Batch Convert Operation:  Click OK to skip this 
message and continue to the next file. 
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Message and Description/Fix 

 

Unknown Error While Accessing Font File 
Read, Save or Batch Convert Operation:  The Machine Font file on the iNFiNiT! 
system may not be valid.  Click OK to continue.  When the message is read, the text 
using the specified Machine Font is not displayed. 

 

Flash Font Unsupported 
Read, Save or Batch Convert Operation:  The iNFiNiT! message contains 
FlashFont characters, which are not supported by this operation.  Click OK to 
continue.  When the message is read, the text using FlashFont characters is not 
displayed. 

Using Tab/Template Description and Data Messages in Lyric 
Before describing the procedure used to import and use iNFiNiT! Tab Description and Tab Data messages 
in Lyric, the following equivalent terms used in iNFiNiT! Message Compose and Duet Lyric operations should 
be reviewed: 

Message Compose Lyric 

Tab Template 

A Message Compose Tab field or Lyric Template field can be individually formatted for 
Font, Color, Justification, etc.  It can also be updated using Intelligent Interface or 
by reading a Tab Data message (iNFiNiT!) or Template Data message (Lyric) based 
on a Tab Description message (iNFiNiT!) or Template Description message (Lyric). 

Tab Description Message Template Description Message 

This type of message contains one or more Tab/Template fields, and can also contain 
graphics and text not contained in Tab/Template fields.  

Tab Data Message Template Data Message 

A Tab/Template Data message contains text data that is used to update a specific 
Tab/Template Description message.  It also contains information referencing it to the 
specific Tab/Template Description message. 

A Tab /Template Data message can be created on the fly via Intelligent Interface or 
from within Lyric using the selective record (Ctrl + Record) function. 
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NOTE 
The term Tab has a different definition with regard to Lyric, and is not to be confused 
with the iNFiNiT! Tab, which is equivalent to a Lyric Template.  In Lyric, a Tab, also 
referred to as a Row Tab, is a column delineator similar to that found on a typewriter.  
Refer to Row Tab Functions for additional information. 

To import a Message Compose Tab Description message into Lyric: 
1. On the iNFiNiT! system, make sure that each Tab field in the Tab Description message contains at 

least one character.  This ensures that the Palette is properly imported into Lyric.  Also set each Tab 
field to Auto-Erase. 

2. Import the message using the FTP or ZIP copy procedure as previously described. 

3. Using the Reading iNFiNiT! Messages without Conversion to Lyric Format procedure described 
above, read the message file to the Canvas. 

New Tab/Template Data messages based on this message can be created via Intelligent Interface. 

An iNFiNiT! Tab Description message can also be saved as a Lyric Template Description message.  To 
save as a Lyric message: 

 Enter a message number, then press Duet Record or the PC numeric keypad minus (-) key.  If using 
the File > Save or File > Save As function, save as a Lyric (*.lyr) file in the format xxxxxxxx.lyr, 
where x represents a numeral.  Note that leading digits must be included in the file name, or the file 
will not be recognized by Intelligent Interface when referencing it to create a Template Data 
message. 

Once the Tab Description message has been recorded in the Lyric format, Template Data messages based 
on the new Template Description message can be created via Intelligent Interface.  When reading Lyric-
formatted Template Description messages or referencing them from an Intelligent Interface command, it is 
not necessary to include the leading zeroes in the file name. 

Remember that unless otherwise changed using the M command, Intelligent Interface records the Template 
Data messages to the Default Message Directory set in Lyric.  Make sure that the Template Description 
message is saved to this directory as well.  Refer to Preferences - Default Paths for details on setting this 
directory.  This directory is also reflected in the Intelligent Interface dialog box, accessed from Config Menu 
> Intelligent Interface.  Refer to Intelligent Interface for additional information. 
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Export To iNFiNiT! 
File Menu > Export to iNFiNiT! 

Lyric compositions may be exported as iNFiNiT! Text or RGB messages using the Export to iNFiNiT! 
function.  Before setting up an export: 

 If there is no file in the Local Save Directory, place a dummy file in the directory.  It need not be an 
iNFiNiT! message file.  This is necessary in order to select a Local Save Directory if using the 
Browse function described below. 

NOTE ON EXPORTING MESSAGES AND FONTS 
An Export operation exports only the message(s), and not its associated fonts.  It is 
crucial that the fonts used to create the message are resident on the iNFiNiT!, or the 
message will not properly display.  iNFiNiT! fonts can be exported using an FTP utility.  
Using FTP to copy files is described in FTP - Transferring Files to/from an iNFiNiT!® 
System. 

About Fonts and 2D Text Windows/Templates 
iNFiNiT! messages can be composed only using Machine Fonts or FlashFonts.  Each Machine Font 
character is a separate bitmap.  When imported, FlashFont characters are ignored.  There is no facility with 
which to create or interpret FlashFonts within Lyric. 

In messages created in Lyric and destined for iNFiNiT! system playback, only iNFiNiT! Machine Fonts may 
be used during composition in Lyric.  When an iNFiNiT! message is imported and edited within Lyric, text 
composed using Machine Fonts is transferred correctly back to the iNFiNiT! when the message is exported.  
If export of a message incorporating TrueType® fonts is attempted, the TrueType characters are ignored. 

iNFiNiT! fonts can be used only for typing 2D text, not 3D characters.  If an attempt is made to type a 3D 
character using an iNFiNiT! font, the following is displayed: 

 

3D Character iNFiNiT! Font Warning 

While Machine Fonts can be resized and otherwise modified within Lyric, the following must be noted: 
 When Machine Font characters are resized within Lyric, they are interpolated, and are therefore not 

of as high a quality as TrueType fonts that have been resized through Font Tools or Font 
Properties. 

 When resized Machine Font characters are contained in a message that is exported to the iNFiNiT!, 
the resizing information is ignored, and the characters are displayed in the original size of the 
Machine Font. 

RGB Fonts can be created in Lyric using the Custom Font Editor and saved as iNFiNiT! RGB Machine 
Fonts.  For information on accessing the Custom Font Editor and creating RGB Fonts, refer to Browser:  
RGB Font Assets and Custom Font Editor. 

There a number of additional considerations which must be noted with regard to iNFiNiT! message export. 
 Only the first eight Face and first eight Edge colors in the Lyric Palette are exported to the iNFiNiT!, 

in correspondence with iNFiNiT!'s eight color keys.  If any of the first eight Face or Edge Palette 
colors are changed after the message has been imported, a warning message is displayed upon 
export, requesting if the user wishes to export the current Palette (as seen in Lyric) or the Palette as 
originally imported. 
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 2D Text Windows created on the Lyric Canvas must be full-screen to maintain the proper positioning 
of text on export to the iNFiNiT!.  Non-full-screen 2D Text Windows are repositioned to the upper left 
corner of the screen upon export to the iNFiNiT! system. 

 It is advisable to avoid using multiple 2D Text Windows on one Canvas, as the results can be 
unpredictable. 

 2D Text Templates shifted vertically off of their row's baselines in Lyric are not supported for iNFiNiT! 
reproduction.  Upon export, the Templates snap vertically to a row baseline. 

 Text that is positioned beyond the boundaries of the Lyric Canvas may not export to the iNFiNiT! file 
format. 

Exporting a Single File 
The currently displayed composition on the Canvas can be exported to an iNFiNiT! family system.  To 
execute an export: 

1. From Lyric's File menu, select Export To iNFiNiT!.  The iNFiNiT! File Save Options dialog box is 
displayed.  

 

iNFiNiT! File Save Options 
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2. Choose the File Type  for the file to be exported by selecting one of the following radio buttons: 

 Text Message:  Text, Palettes and Templates can be edited on iNFiNiT! Family systems 

 RGB Message:  The message is saved as a full-screen image. 

3. In the Description field, enter identifying information to be recorded to the iNFiNiT! database. 

4. Optional:  In the Local Save area, select (check) Enable to save a copy of the message in the 
iNFiNiT! RGB message format to a PC, Duet or Aprisa system.  Enter a Directory Name, or click 
Browse to navigate to a directory.  Note that if using Browse, a file must be selected from the 
directory.  This file name can be changed in the next step. 

5. In the Msg Number field, enter an iNFiNiT! message number, omitting the leading decimal point.  
Note that PC file name dialog boxes do not accept a leading decimal in a file name.  The range is 
from 0 - 9999 inclusive. 

6. Copy Files has not yet been implemented. 

7. To enable transfer of the file to an iNFiNiT! system, in the FTP Save area, select (check) Enable. 

8. Use one of the following methods to select a target directory on the iNFiNiT! 

 In the Directory field, enter a filepath.  Note that a forward slash at the end of Directory 
name is optional.   

 Use the Browse function to navigate to the directory.  Click the Browse button.  The Select 
Server Folder window is displayed.  Select the target directory folder, and then click OK.  

 

Select Server Folder Window 

9. Enter the iNFiNiT! system’s IP Address.  If necessary, enter a Username and a Password.  To save 
this information for future use, select (check) the Save checkbox. 
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10. Optional:  Select Skip Warnings to prevent the display of overwrite and other warnings when the 
Export operation is executed. 

11. All Flash Font has not yet been implemented. 

12. A sample iNFiNiT! File Save Options dialog box is shown in the following figure.  Click OK to close 
dialog box and save settings.  Click Export to export the file to the iNFiNiT!, and if specified, to copy it 
locally.  The message is saved in the iNFiNiT! message format. 

 

iNFiNiT! File Save Options 
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When the message is read on the iNFiNiT! system, the Description entered in Lyric is reflected in the 
Description field at the bottom of the iNFiNiT! interface.  

 

iNFiNiT! Interface 
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Batch Export 
Multiple files can be exported to the iNFiNiT! in one operation, making it unnecessary to read and export each 
file individually.  The files can be a mix of Text Messages and RGB Messages.  To execute a Batch Export: 

1. From Lyric's File menu, select Export To iNFiNiT!.  The iNFiNiT! File Save Options dialog box is 
displayed.  Do not enter File Type, Description or Msg Number information.  Since a File Type is 
always selected, the File Type setting is ignored in a Batch Export operation. 

 

iNFiNiT! File Save Options 

2. Optional:  In the Local Save area, select (check) Enable to save a copy of each message in the 
iNFiNiT! RGB message format to a PC, Duet or Aprisa system.  Enter a Directory Name, or click 
Browse to navigate to a directory.  Note that if using Browse, a file must be selected from the 
directory.  This file name should then be deleted. 

3. Copy Files has not yet been implemented. 

4. To enable transfer of the files to an iNFiNiT! system, in the FTP Save area, select (check) Enable, 
then select an iNFiNiT! target directory as described in the previous procedure. 

5. Enter the iNFiNiT! system’s IP Address.  If necessary, enter a Username and a Password.  To save 
this information for future use, select (check) the Save checkbox. 

6. Optional:  Select Skip Warnings to prevent the display of overwrite and other warnings when the 
Export operation is executed. 

7. All Flash Font has not yet been implemented. 
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8. A sample iNFiNiT! File Save Options dialog box is shown in the following figure.  Click OK to close 
dialog box and save settings.  Click Export to export the file to the iNFiNiT!, and if specified, to copy it 
locally.  The message is saved in the iNFiNiT! message format. 

 

iNFiNiT! File Save Options for Batch Export 

9. Click Batch Export.  The Batch Export dialog box opens. 

 

Batch Export Dialog Box 
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10. Enter a Start ID and End ID. 

 

Start and End Files Entered 

11. Click OK.  The files are copied to the selected local and iNFiNiT! directories.  The status of the 
transfer is shown in at the bottom of the Batch Export dialog box. 

Export Errors 
The following errors/warnings may be displayed when executing a Text message export. 

Message and Description/Fix 

 

FTP Open Error 

One or more of the FTP parameters, including IP Address, Username, Password or 
Directory may not be correct. 

Single Message Only: 

 

Message Number Out of Range 

The entered Message Number (Msg Number) is outside the range of 0 - 9999 
inclusive. 
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Message and Description/Fix 

Text Message Only: 

 

Error on Export - No Text Window Available 

There must be a 2D Text Window on the Canvas, and an iNFiNiT! font loaded into the 
Lyric Canvas.  Click OK to continue.  The following warning is then displayed. 

 

Failure Creating Message as Export File 

Because the above conditions were not met, the Export file could not be created. 
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Message and Description/Fix 

 

Overwrite Warning 

This warning is displayed if there is a file of the same File ID in the target iNFiNiT! 
directory as the File ID of an incoming file.  Select Yes to overwrite, No to Cancel to 
cancel the Export operation. 

Overwrite Warnings are displayed regardless of the Skip Warnings checkbox unless 
such warnings have been disabled in the Preferences menu. 

Text Message Only: 

 

Lyric Palette Does Not Match iNFiNiT! Palette 

Only the first eight Face and first eight Edge colors in the Lyric Palette are exported to 
the iNFiNiT!, in correspondence with iNFiNiT!'s eight color keys. 

If any of the first eight Face or Edge Palette colors are changed after the message 
has been imported, a warning message is displayed upon export, asking if the user 
wishes to export the current Palette (as seen in Lyric) or the Palette as originally 
imported. 

Select Yes to export the modified Palette, or No to preserve the original Palette. 

Text Message Only: 

 

Not All Palette Entries Converted 

One or more Palette entries are not valid.  Invalid character colors default to white.  
Click OK to continue. 
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Message and Description/Fix 

Text Message Only: 

 

TrueType® Characters are Ignored 

TrueType characters in the exported message are not supported by the iNFiNiT! and 
are not recorded with the iNFiNiT! message.  Click OK to continue. 

 

Error During FTP Transfer 

The target disk or directory may be full. 

 If Displayed During a Single Message Export Operation:  Click OK to 
cancel the Export operation. 

 If Displayed During a Batch Export Operation:  Click OK to continue to the 
next message.  If this error message is repeatedly displayed, press ESC to 
cancel the Export operation. 
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iNFiNiT! Import/Export Example 
File Menu > Import from iNFiNiT! 
File Menu > Export to iNFiNiT! 

The following procedures demonstrate common uses of the Import from iNFiNiT! and Export to INFiNiT! 
functions.  An iNFiNiT! message is imported into Lyric, and then edited, and then saved as a Lyric message 
or sent back to the iNFiNiT!.  Before starting, review the sections on Import from iNFiNiT!, Export to 
iNFiNiT! and Browser:  iNFiNiT! Font Asset Operations. 

Importing and Modifying an iNFiNiT! Message 
To import an iNFiNiT! message: 

1. If not already created, set up two Windows-formatted local or network directories.  One should be 
dedicated to storing iNFiNiT! font files, and the other to storing iNFiNiT! message files.  For this 
example, the two directories are C:\iNFiNiT\MESSAGE and C:\iNFiNiT\FONT. 

2. From the File menu, select Import from iNFiNiT!  The iNFiNiT! Message Import dialog box is 
displayed. 

 

iNFiNiT! Message Import Dialog Box 

3. Use either the Copy Files from iNFiNiT! Disk or Copy iNFiNiT! Files via FTP functions  to copy 
both an iNFiNiT! text message containing Tabs, and its associated fonts, to the Windows-formatted 
local or network message and font directories. 

 

iNFiNiT! Message Import Dialog Box 
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4. Click Read.  The selected file is displayed on the Lyric Canvas.  Note that the Title Bar does not 
reflect information about the file that has been read.  The information from the last-read Lyric file 
remains displayed. 

 

iNFiNiT! News Super - Unedited 

5. Click on the "News Super" text.  The cursor is now positioned within a Lyric 2D Text Template that 
corresponds directly to an iNFiNiT! Tab field.  Refer to 2D Text Templates for additional information 
on Lyric 2D Text Templates. 

6. Right-click on the 2D Text Template containing the "News Super" text.  From the context menu, 
select Template Properties.  The 2D Text Template dialog box opens.  The 2D Text Template is 
identified by a Number. 

 

2D Text Template Dialog Box 



 iNFiNiT! Family Systems and Lyric  

 36-41 

7. In the Optional area, select (check) Auto Erase.  This sets the currently selected 2D Text Template 
to erase the current contents any time it is updated, either externally or by typing. 

8. Click the Next arrow icon at the upper left corner of the 2D Text Template dialog box.  This toggles 
to the next-numbered 2D Text Template on the Canvas, which contains the text, "SECOND LINE."  

9. In the Optional area, select (check) Auto Erase. 

10. Optional:  The 2D Text Template dialog box can be closed at this time.  Otherwise, continue to the 
next step.  For additional information on the 2D Text Template dialog box, refer to 2D Text 
Templates. 

11. Click in the 2D Text Template containing the "News Super" text.  Type "Joe Newsguy."  Click in the 
2D Text Template containing the "SECOND LINE" text.  Type "Crisisville, NY."  Both 2D Text 
Templates have now been updated. 

12. To view the modified message without baselines and 2D Text Template frames, click the 

Text/Window Frames Off icon , located on the Chyron Toolbar.  Note that the icon changes to 

. 

 

Modified iNFiNiT! Message 

To return the baselines and 2D Text Template frames to view, click . 

13. The message can now be saved as a Lyric message, or exported back to the iNFiNiT!. 
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Saving the iNFiNiT! Message as a Lyric Message 
To save the modified iNFiNiT! message as a Lyric message: 

1. From the Lyric File menu, select Save As.  The Save Animation dialog box opens. 

 

Save as Lyric Message 

1. Leave Start Frame and End Frame settings as is, as this is a static message.  

2. If not already selected, select Lyric (*.lyr) from the Save as Type drop-down list box. 

3. Enter a File Name.  Note that adding the .lyr extension is optional in the File Name field, as it is 
automatically attached when the .lyr file type is selected. 

4. Click Save.  The iNFiNiT! file is saved as a Lyric file that can be edited and played back on a Duet 
system. 
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Exporting the Modified iNFiNiT! Message 
To export the modified iNFiNiT! message back to the iNFiNiT!: 

1. Once the imported message has been modified as previously described, select Export to iNFiNiT!.  
The iNFiNiT! File Save Options dialog box is displayed.  

 

iNFiNiT! File Save Options 

2. Select (check) the Text Message radio button as the File Type. 

3. In the Description field, enter identifying information to be recorded to the iNFiNiT! database. 

4. Optional:  In the Local Save area, select (check) Enable to save a copy of the message in the 
iNFiNiT! message format to a PC, Duet or Aprisa system.  Enter a Directory Name, or click Browse 
to navigate to a directory.  Note that if using Browse, a file must be selected from the directory.  This 
file name can be changed in the next step. 

5. In the Msg Number field, enter an iNFiNiT! message number, omitting the leading decimal point.  
Note that PC file name dialog boxes do not accept a leading decimal in a file name. 

6. Copy Files has not yet been implemented. 

7. To enable transfer of the file to an iNFiNiT! system, in the FTP Save area, select (check) Enable. 
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8. Use one of the following methods to select a target directory on the iNFiNiT! 

 In the Directory field, enter a filepath.  Note that a forward slash at the end of Directory 
name is optional.   

 Use the Browse function to navigate to the directory.  Click the Browse button.  The Select 
Server Folder window is displayed.  Select the target directory folder, and then click OK.  

 

Select Server Folder Window 

9. Enter the iNFiNiT! system’s IP Address.  If necessary, enter a Username and a Password.  To save 
this information for future use, select (check) the Save checkbox. 

10. Optional:  Select Skip Warnings to prevent the display of overwrite and other warnings when the 
Export operation is executed. 

11. All Flash Font has not yet been implemented. 
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12. The following figure shows the entered information in the iNFiNiT! File Save Options dialog box.  
Click OK to close dialog box and save settings.  Click Export to export the file to the iNFiNiT!, and if 
selected, to copy it locally.  The message is saved in the iNFiNiT! message format. 

 

iNFiNiT! File Save Options 

When the message is read on the iNFiNiT! system, the Description entered in Lyric is reflected in the 
Description field at the bottom of the iNFiNiT! interface.  The modified iNFiNiT! message can be edited 
and/or played back on the iNFiNiT! family system. 
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FTP - Transferring Files to/from an iNFiNiT!® System 

About FTP File Transfer 
FTP (File Transfer Protocol) is one of a number of methods that can be used to transfer files between 
systems.  In this section, transfer of iNFiNiT! family (iNFiNiT!® MAX!>® or MAXINE!®) font files to and from a 
Duet/Aprisa/PC running Lyric is highlighted, as FTP is the required method for copying iNFiNiT! font files 
between an outside system and an iNFiNiT!.  The procedure described below can, however, be adapted to 
file transfers in general. 

Chyron recommends the use of GlobalScape’s CuteFTP (available at http://www.globalscape.com/) software.  
The procedure documented below uses CuteFTP Version 4.2.  Refer to CuteFTP documentation for 
information regarding the Quick Connect and Site Manager functions. 

If CuteFTP is not available, FTP transfer can be accomplished via DOS.  This method is described at the end 
of this section. 

Duet/Aprisa/PC-to-iNFiNiT! Family System File Transfer 
Lyric can create iNFiNiT! RGB Fonts using the Custom Font Editor.  In general, these are the files are most 
likely to be transferred using this method.  To execute a transfer: 

1. Launch CuteFTP. 

2. Open CuteFTP’s “Quick Connect” feature by pulling down the File menu and selecting Quick 
Connect or by pressing Ctrl + F4.  The following parameters appear beneath the toolbar: 

 

Quick Connect Parameters 

3. In the Host field, enter the IP address of the iNFiNiT! Family system to which the files are to be 
transferred.  If necessary, enter a User Name and Password.  Enter a Port number. 

4. Click the Connect  icon.  The connection is made to the iNFiNiT! system, and the root level 
directories of the iNFiNiT! are displayed in the right pane of the CuteFTP interface. 

 

Destination Pane 
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5. Double-click the MACHINE folder icon to open the iNFiNiT! system's Machine Fonts directory.  A list 
of files in the MACHINE directory is displayed. 

 

Machine Directory Contents 

6. In the left pane, which for this operation is the source pane, navigate to the Windows-formatted 
directory from which the file is to be copied.  Click-and-drag the RGB Font file from this directory to 
the target iNFiNiT! system (right pane). 

 

Transferring a File from a Windows Directory to an  iNFiNiT! 

7. The following prompt is displayed.  Click Yes. 

 

FTP Confirm 
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Transfer commences.  CuteFTP displays the progress of the transfer at the bottom of the screen.  
When the transfer is complete, the transferred iNFiNiT! RGB Font may be used as usual on an 
iNFiNiT!® MAX!>® or MAXINE!® system. 

 

FTP Transfer Progress 

Using iNFiNiT! Machine Fonts in Lyric 
An iNFiNiT! Machine Font can be used in Lyric.  First, it must be transferred via FTP from the iNFiNiT! 
system to a local or networked Windows-formatted directory.  In the following example, CuteFTP is used to 
execute the transfer. 

1. Launch CuteFTP and connect to the iNFiNiT! system as described in the previous procedure.  The 
connection is made to the iNFiNiT! system.  The root level directories of the iNFiNiT! are displayed in 
the right pane of the CuteFTP interface. 

2. In the left pane, which for this operation is the destination pane, navigate to the Windows-formatted 
directory to which the file is to be copied. 

3. Click-and-drag the Machine Font file from the iNFiNiT! system directory (right pane) to the Windows-
formatted directory (left pane). 

 

Transferring a File from the iNFiNiT to a Windows Directory 

4. The following prompt is displayed.  Click Yes. 

 

FTP Confirm 
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Transfer commences.  CuteFTP displays the progress of the transfer at the bottom of the screen. 

 

FTP Transfer Progress 

5. If the font is a Text Machine Font, or an RGB Machine Font that is to be used "as is," the font can 
now be accessed from the iNFiNiT! Font Assets Browser.  Refer to Browser:  iNFiNiT! Font Asset 
Operations for additional information.  If the font is an RGB Machine Font that is to be modified 
within the Custom Font Editor, continue to the next step. 

6. When transfer is complete, right-click on the RGB Machine Font File Name, then select Rename 
from the context menu. 

 

Renaming the iNFiNiT! RGB Machine Font File 

7. To make the RGB Machine Font usable within the Custom Font Editor, add the extension .fnt to 
the file name, and then click outside of the File Name field or press Enter.  The file that has just been 
transferred and renamed can be read into the Custom Font Editor and/or saved as a Lyric RGB 
Font for use in Lyric. 

 

Renaming Machine Font File for Use by Custom Font Editor 

NOTES 
To access the transferred Text or RGB Machine Font file from within the iNFiNiT! Font 
Browser Assets, the file name cannot be changed.  Refer to Browser:  iNFiNiT! Font 
Asset Operations for additional information. 
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Using DOS to Execute FTP Operations 
In the absence of CuteFTP, DOS can be used to execute FTP operations.  The following procedures are 
representative of DOS-FTP command sequences for most, if not all applicable Windows operating systems.  
Refer to DOS documentation for additional information on procedures and advanced file operations. 

It is important to note that files transferred using this method should be done so in Binary, as opposed to 
ASCII mode.  The Binary command appears in the following procedures. 

After entering each command, press Return. 

Transferring a File to the iNFiNiT! 
To transfer from a file from a Windows-formatted directory to the iNFiNiT!: 

1. Select Start > Run, and then enter cmd to open a DOS window. 

2. In the Command Line window, change the directory to the one from which the file is to be copied: 

C:\Chyron MOS>cd C:\iNFiNiT\MACHIINE 

3. Connect to the iNFiNiT! Family system: 

C:\iNFiNiT\MACHINE>ftp 55.55.5.555 

4. When prompted, enter a Username, and then press Return. 

5. When prompted, enter a Password, and then press Return. 

6. When connection is successful, enter the following command to specify binary data transfer: 

ftp> binary 

7. Specify the directory on the iNFiNiT! system to which the file is to be copied: 

ftp> cd C/NEWS/MACHINE 

8. Enter the following command to copy the file to the iNFiNiT!: 

ftp> put .9999 

The system displays the progress of the file transfer and prompts when the FTP operation is complete.  The 
following figure demonstrates a typical FTP "put" operation to an iNFiNiT! system. 

 

Typical FTP "Put" Operation to iNFiNiT! System 
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If it is not expedient to change to current directories (cd command) for both the Windows-formatted source 
and iNFiNiT! destination, the put command can be executed using full filepaths for both source and 
destination.  After the binary command has been entered, the following command can be entered, based on 
the filename and directories used above: 

ftp> put C:\iNFiNiT\MACHINE\.9999 C/NEWS/MACHINE 

A put command must name an existing directory on the iNFiNiT! family system as a destination.  If a 
previously non-existing directory is entered as a destination, a new directory is not created, nor is an error 
message generated with regard to the directory name. 

Transferring a File from the iNFiNiT! 
To transfer from a file from a Windows-formatted directory to the iNFiNiT!: 

1. Select Start > Run, and then enter cmd to open a DOS window. 

2. In the Command Line window, change the directory to the one to which the file is to be copied: 

C:\Chyron MOS>cd C:\iNFiNiT\MACHINE 

3. Connect to the iNFiNiT! Family system: 

C:\iNFiNiT\MACHINE>ftp 55.55.5.555 

4. When prompted, enter a Username, then press Return. 

5. When prompted, enter a Password, then press Return. 

6. When connection is successful, enter the following command to specify binary data transfer: 

ftp> binary 

7. Specify the directory on the iNFiNiT! system from which the file is to be copied: 

ftp> cd C/NEWS/MACHINE 

8. Enter the following command to copy the file to the Windows-formatted directory: 

ftp> get .9999 

The system displays the progress of the file transfer and prompts when the FTP operation is complete.  The 
following figure demonstrates a typical FTP "get" operation from an iNFiNiT! system. 

 

Typical FTP "Get" Operation from iNFiNiT! System 



Lyric User Guide 

 36-52 

If it is not expedient to change to current directories (cd command) for both the iNFiNiT! source and the 
Windows-formatted destination, the get command can be executed using full filepaths for both source and 
destination.  After the binary command has been entered, the following command can be entered, based on 
the filename and directories used above: 

ftp> get C/NEWS/MACHINE/.9999 C:\iNFiNiT\MACHINE 

If a previously non-existent Windows-formatted directory is named as the destination, it is created when the 
file is copied. 

Exiting the FTP Session and the Command Prompt 
To exit the FTP session: 

 Enter quit, then press Enter.  The FTP session closes. 

To exit the command prompt: 

 Enter exit, then press Enter, or click the Close icon  for the window.  
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37. Quantel Systems and Lyric 

Quantel® Interface Configuration 
Config Menu > Quantel® Interface 

Lyric can access the assets of Quantel® systems for use in Lyric compositions, as well as export Lyric 
messages back to the Quantel systems.  To enable communications between Lyric and Quantel systems, the 
Quantel Interface must be configured in Lyric.  If there are multiple Quantel systems configured in Lyric, a 
system must be selected in order for its contents to be displayed in the Browser.  Refer to Quantel 
documentation for information on Quantel system operation. 

 From the Config Menu, select Quantel Interface.  The Configure Quantel Interface dialog box 
opens.  If Quantel systems are already configured, they are listed in the Host Table (unlabeled).  
Editbox is the default Host Name and IP Address when, as shown below, no systems are listed. 

 

Configure Quantel® Interface Dialog Box 
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If the there are already Quantel systems available to Lyric, the dialog box could appear as follows: 

 

Configure Quantel® Interface - System List 

This is the same list that is displayed in the Host Name drop-down list box in the Quantel Import dialog box.  
Refer to File:  Import from Quantel for additional information. 

Adding/Deleting a Quantel System 
To add a Quantel system to this list: 

1. Enter the name of the Quantel system in the Host Name field. 

2. Enter the IP address of the Quantel system in the IP Address field. 

3. Click Add.  The name of the new system now appears in the Host Table. 

To delete a Quantel system from the list: 
1. Click on the name of the Quantel system in the Host Table. 

2. Click Delete.  The Quantel system is removed from the Host Table and is no longer available to 
Lyric. 

Enabling/Disabling the Browser 
To enable Lyric to access the Quantel images, the Browser must be enabled: 

 Select (check) the Enable Browser checkbox.  The Quantel asset icon  in the Browser 
becomes active.  

To disable Lyric to access the Quantel images, the Browser must be disabled: 

 Select (check) the Enable Browser checkbox.  The Quantel asset icon  becomes grayed out. 
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Selecting a Quantel System for Lyric Operations 
When a Quantel system is selected, its contents can be accessed from the Browser.  The selected system 
also becomes the default system for File Menu > Import from Quantel/Export to Quantel operations.  Note 
that a system can also be selected from within the Import from Quantel dialog box.   

To select a Quantel system for Browser access and File Menu > Import/Export operations: 
  Click on a system name in the Host Table.  The system name appears in the Host Name and IP 

Address fields. 

NOTE 
Configure Quantel Interface does not perform a check on the validity of the Quantel Host 
Name and/or IP Address.  The connection is validated when Browsing or performing 
import/export operations.  If a warning message is displayed, confirm that the system is 
available and that the Host Name and IP Address are correctly entered.  An error 
message may be displayed when: 

 Accessing Quantel Assets in a Browser or refreshing the Browser to display the 
contents of a different system. 

 

Cannot Query Quantel 

 Accessing Quantel Assets in a Browser, when displayed assets are no longer 

available.  Refresh  the Browser.  If an error message is still displayed, then 
confirm that the system is available and that the Host Name and IP Address are 
correctly entered. 

 

Could Not Create Object 

 Performing a connection from within the Import from Quantel Import dialog box, 
accessed from File Menu > Import from Quantel. 

 

Connect Failed 
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 Performing a connection or attempting to import an unavailable file from within 
the Quantel Import dialog box, accessed from File Menu > Import from Quantel. 

 

Connect Failed 

 Performing an export to a Quantel system from the Quantel Export dialog box, 

accessed from File Menu > Export to Quantel or a Save to Database  from the 
Browser. 

 

FTP Connect Failed 

Click OK, then the 
following is displayed. 

 
 

Export to Quantel Failed 

 

Applying/Canceling Configuration Settings 
To apply configuration all settings: 

 Click OK. 

To cancel configuration settings: 

 Click Cancel. 
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Quantel® Asset Operations 

Browser > ;  Browser Menu > Show Quantel Images 
Lyric's Browser can import graphics from Quantel® systems, as well as export Lyric messages to Quantel 
systems.  To access a Quantel system from the Browser, it must be first configured and selected in the 
Configure Quantel Interface dialog box.  Refer to Quantel® Interface Configuration for details on 
configuration, and to Quantel documentation for information on Quantel system operation. 

NOTE 
Configure Quantel Interface does not perform a check on the validity of the Quantel Host 
Name and/or IP Address.  The connection is validated when Browsing or performing 
import/export operations.  If a warning message is displayed, refresh the Browser.  If 
error messages are still generated, confirm that the system is available and that the Host 
Name and IP Address are correctly entered.  Refer to Quantel® Interface Configuration 
for additional details on interpreting error messages. 

The following describes terms that are specific to Quantel operations: 
 Volume:  Quantel’s equivalent of a directory within a Windows PC. 

 FID:  File or Message ID. 

 List Max:  Limits the number of results per page that may be returned by a search operation. 

 Image Type:  Quantel systems store three image types: 

o Pictures, which are YUV images. 

o Stencils, which are Alpha channel-only images. 

o Cuts or Cutouts, which are complete YUV-A or RGB-A images. 
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Quantel Browser Assets 

About Viewing and Updating Quantel Assets 
The following should be noted about the Quantel Asset Browser options: 

 Only the Icon View is available.  Text Only and Icon Text Views are inactive. 

 The Sort A-Z/Sort Z-A selection does not have an affect on the order of display.  The order of display 
is determined by the Quantel system. 

 The icons always display at Medium icon size. 

 A Quantel Asset cannot be dragged-and-dropped into the Lyric Canvas.  See below for import 
procedures. 

 Quantel Assets are always imported at output pixel size, regardless of the Use 1:1 Pixel Aspect for 
Graphic Import setting, accessed from Config Menu > Canvas Resolution.  This results in the 
aspect ratio of the image always being correct. 

NOTE 
Settings within the Quantel Import dialog box, accessed from File Menu > Import from 
Quantel directly affect the number and types of files displayed in the Browser.  The 
Search parameters present in the fields in the Search By dialog box both from the 
Quantel Import dialog box and from the Browser are always applied when generating the 
list of files that are displayed in the Browser.  If it seems that files are missing, or that the 
wrong type of file is displayed, open the Quantel Import dialog box.  If necessary, reset 
parameters, including those in the Search By dialog box, then click List Next.  A list of 
files based on the modified parameters is displayed.  Refer to File Menu:  Import from 
Quantel for additional information. 
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After any change or Search is performed in the Quantel Import dialog box, the Browser 

does not automatically update, even when it is refreshed ( or Browser Menu > 
Refresh). 

1. Close the Browser, then open a new Browser from either File > New > Browser 
or View > Browsers. 

2. Open the Quantel Assets within the Browser.  The Browser display should be 
updated. 

The Quantel Assets Context Menu 
Information about a Quantel Asset can be viewed, but not edited in the Browser.  This information can be 
edited only from the Quantel system. 

Left-click the asset to display the context menu: 

 

Quantel Asset Context Menu 

The context menu displays the following: 
 File ID:  The ID number of the Quantel graphic.  This number is automatically assigned when a 

graphic is created on the Quantel system.  This occurs when a graphic is exported to the Quantel 
either from the Quantel Export dialog box (accessed from File Menu > Export to Quantel), or from 
the Browser Save to Database function. 

 Volume:  The directory on the Quantel in which the file is stored. 

 Size:  The Width-by-Height dimensions in pixels. 

 Owner:  The author of the graphic. 

 Description:  The description of the graphic. 

 Updated:  Date of last update to the file. 

Importing a Quantel Graphic  
To import a graphic from the Browser to the Canvas, select one of the following methods: 

 Double-click on the icon for the file. 

 Click on the icon for the file, then click the Load from Database  icon. 

A Quantel graphic can also be imported to the Canvas from File Menu > Import from Quantel.  Refer to File 
Menu:  Import from Quantel for details. 
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Exporting a Lyric Message to Quantel 
To save the current contents of the Canvas to the Quantel system: 

 Click  or select Save to Database.  Lyric compositions are exported to a Quantel system as full-
screen-sized 32-bit images, and are saved to the Quantel system as Cuts, also known as Cutouts. 

Searching Quantel Assets in the Browser 
Quantel Assets displayed in the Browser can be searched based on a variety of parameters.  The Browser 
Search function differs from the Search function is available in the Quantel Import dialog box in that the 
Browser Search function searches only the Quantel files already displayed in the Browser, whereas the 
Quantel Import Search function searches the selected directory on the Quantel system.  Refer to File Menu:  
Import from Quantel for additional information on the Quantel Import Search function.  To execute a 
Browser Search: 

1. Display the Quantel® Asset  database in the Browser, then click the Search Database icon 

 or select Search Browser from the Browser menu.  The Search By dialog box is displayed: 

 

Search by Dialog Box 

2. A Quantel Asset can be searched by Author, Title, Category, and Date.  Specify all or part of an 
Author, Title and or Category in their respective fields. 

3. The Date field reflects the current date.  A different date can be selected from the drop-down 
calendar as shown above. To disable the Date as a search condition, deselect (uncheck) the 
checkbox located within the Date field. 

4. Click OK.  The Search By dialog box closes. 

5. Click , or select Refresh Database from the Browser menu.  The results of the search are 
displayed in the Browser. 
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To clear the search fields in the Search By dialog box and return the Browser display to its original state on 
opening the Browser: 

1. Click Clear.  The Search By dialog box closes. 

2. Click  or select Refresh Database from the Browser menu. 

To cancel the search: 
 Click Cancel in the Search By dialog box. 

Import from Quantel® 
File Menu > Import from Quantel 

Also:  Browser >  > ; Browser Menu > Show Quantel Assets > Load from Database  
Images produced on Quantel® systems can be imported to the Lyric Canvas.  Graphic compositions created 
in Lyric can also be exported back to the Quantel system.  The Duet or PC running Lyric and the Quantel 
system must be networked so that Lyric can access the Quantel directories.  Refer to Quantel Interface 
Configuration for details on Quantel interface configuration, and to Quantel documentation for information on 
Quantel system operation. 

A Quantel graphic can also be imported to the Lyric Canvas and a Lyric graphic can be exported to a Quantel 
system from the Lyric Browser.  Refer to Browser:  Quantel® Asset Operations for details.  

The following describes terms that are specific to Quantel operations: 
 Volume:  Quantel’s equivalent of a directory within a Windows PC. 

 FID:  File or Message ID. 

 List Max:  Limits the number of results per page that may be returned by a search operation. 

 Image Type:  Quantel systems store three image types: 

o Pictures, which are YUV images. 

o Stencils, which are Alpha channel-only images. 

o Cuts or Cutouts, which are complete YUV-A or RGB-A images. 
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Connecting to a Quantel System 
A connection to a Quantel system must be opened before importing a graphic. 

1. From the Lyric File menu, select Import from Quantel.  The Quantel Import dialog box opens. 

 

Quantel Import Dialog Box 

2. From the System Information Host Name drop-down list box, select the networked Quantel system 
from which files are to be imported, then click Connect.  Note that Username always defaults to ftp, 
and entering a Password is not necessary.  Both fields are always grayed out.  Refer to Quantel 
Interface Configuration for details on setting up a host table to add systems to the Host Name list. 

NOTE 
Configure Quantel Interface does not perform a check on the validity of the Quantel 
Host Name and/or IP Address.  If an error message is displayed when attempting to 
connect to the selected system, confirm that the system is available and that the Host 
Name and IP Address are correctly entered.  Refer to Quantel Interface Configuration for 
details on error messages. 

A connection can also be established by clicking List Next Set or List Prev Set.  This will also result in the 
display in the FID list of the available files in the selected volume (directory), with the selected parameters 
applied.  Volume selection and parameters are described below. 
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Displaying Quantel Files and Viewing Thumbnails 
To display a list of available files in a Quantel system: 

1. Set up a connection to a Quantel system as described above. 

2. In the Options area, select the Image Location (Volume or Directory) that is to be viewed. 

3. In the Options area, select the Image Type:  Quantel Pictures, Quantel Cutouts or Quantel 
Stencils. 

4. In the List Max field, enter the maximum number of files to be displayed.  This setting determines 
how many files are to be listed in the FID List at one time.  For example, if List Max is set at 20, and 
there are 45 files that fit the import criteria, three pages would be generated.  There would be 20 files 
on each of the first two pages, and 5 files on the third. 

5. Optional:  Click Search to set additional parameters.  The Search By dialog box is described at the 
end of this section.  After setting parameters, close the Search By dialog box. 

6. In the area below the FID List (unlabeled), click List Next Set.  The files of the selected type, in the 
selected system and volume (directory) are displayed.  If the number of files found exceeds the List 
Max setting, the first page of files is displayed.  To view a following page, click List Next Set.  To 
view a preceding page, click List Prev Set. 

 

Quantel Import Dialog Box - Selecting a File 
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NOTE 
If a List Next or List Prev is executed, and either files are not displayed or far fewer than 
expected are displayed, check the Search By dialog box shown below to make sure that 
there are no leftover parameters that may unwittingly be affecting the results. 

To view a thumbnail of a graphic: 
1. Select (check) the Show Thumbnail checkbox. 

2. Click a file ID in the FID list.  Note that clicking in the Title column does not select a file. 

To save settings for future use: 
 Select (click) the Save Settings on Exit checkbox.  Image Type, Volume and Search settings are 

preserved.  List Max is not.  These settings also determine the Quantel Assets that are displayed in 
the Browser. 

Importing a Quantel Graphic to the Lyric Canvas 
To import a Quantel graphic to the Canvas: 

1. Click on a file in the FID List to highlight it.  If Show Thumbnail is selected, the thumbnail is 
displayed. 

2. Click Import.  The image appears on the Lyric Canvas. 

Quantel Assets are always imported at output pixel size, regardless of the Use 1:1 Pixel Aspect for 
Graphic Import setting, accessed from Config Menu > Canvas Resolution.  This results in the aspect ratio 
of the image always being correct. 

The FID Context Menu 
Information about a Quantel file can be viewed, but not edited in the Quantel Import dialog box.  This 
information can be edited only on the Quantel system. 

 Left-click the FID for a file to display the context menu: 

 

FID Context Menu 

The context menu displays the following: 
 File ID:  The ID number of the Quantel graphic.    This number is automatically assigned when a 

graphic is created on the Quantel system.  This occurs when a graphic is exported to the Quantel 
either from the Quantel Export dialog box (accessed from File Menu > Export to Quantel), or from 
the Browser Save to Database function. 

 Volume:  The directory on the Quantel in which the file is stored. 

 Size:  The Width-by-Height dimensions in pixels. 

 Owner:  The author of the graphic. 

 Description:  The description of the graphic. 

 Updated:  Date of last update to the file. 
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Searching Quantel Assets 
Quantel files can be searched based on a variety of parameters.  The Quantel Import Search function 
differs from the Browser Search function in that the Quantel Import Search function searches the selected 
directory on the Quantel system, whereas the Browser Search function searches only the Quantel files 
already displayed in the Browser.    Refer to Browser:  Quantel® Asset Operations for details on the 
Browser Search function. To execute a search: 

1. From the Lyric File menu, select Import from Quantel.  In the Quantel Import dialog box, connect to 
a system, then display a set of files.  In the Options area, click Search.  Refer to File Menu:  Import 
from Quantel for details. 

 

Search by Dialog Box 

2. A Quantel Asset can be searched by Author, Title, Category, and Date.  Specify all or part of an 
Author, Title and or Category in their respective fields. 

3. The Date field reflects the current date.  A different date can be selected from the drop-down 
calendar as shown above. To disable the Date as a search condition, deselect (uncheck) the 
checkbox located within the Date field. 

4. Click OK.  The Search By dialog box closes. 

5. Click List Next Set.  The results of the search are displayed in the FID List. 

To clear the search fields in the Search By dialog box: 
 Click Clear.  The Search By dialog box closes. 

To cancel the search: 
 Click Cancel in the Search By dialog box. 
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Export to Quantel® 
File Menu > Export to Quantel 

Also:  Browser >  > ; Browser Menu > Show Quantel Assets > Save to Database  

Images produced on Quantel® systems can be imported to the Lyric Canvas.  Graphic compositions created 
in Lyric can also be exported back to the Quantel system.  The Duet or PC running Lyric and the Quantel 
system must be networked so that Lyric can access the Quantel directories.  Refer to Quantel Interface 
Configuration for details on Quantel interface configuration, and to Quantel documentation for information on 
Quantel system operation. 

A Quantel graphic can also be imported to the Lyric Canvas and a Lyric graphic can be exported to a Quantel 
system from the Lyric Browser.  Refer to Quantel® Asset Operations for details. 

The following describes terms that are specific to Quantel operations: 
 Volume:  Quantel’s equivalent of a directory within a Windows PC. 

 FID:  File or Message ID. 

 List Max:  Limits the number of results per page that may be returned by a search operation. 

 Image Type:  Quantel systems store three image types: 

o Pictures, which are YUV images. 

o Stencils, which are Alpha channel-only images. 

o Cuts or Cutouts, which are complete YUV-A or RGB-A images. 

NOTE 
Lyric compositions are exported to a Quantel system as 32-bit images, and are saved to 
the Quantel system as Cuts, also known as Cutouts. 
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To export a message from Lyric to a Quantel system:  
1. From the File Menu, select Export to Quantel.  The Quantel Export dialog box is displayed.  It is 

shown with parameters entered. 

 

Quantel® Export Dialog Box 

2. Optional:  Enter a Description. 

3. To also save the file locally on the system running Lyric, select (check) the Local Save Enable 
checkbox, then in the File field, enter a filepath to the directory in which the file is to be saved. 

4. Click the FTP Save Enable checkbox. 

5. In the Filename field, enter the Filename under which the file will be saved in the Quantel system. 

6. In the IP Address field, enter the Quantel system IP Address or Hostname. 

7. If required to access the Quantel system, enter a Username in the Username field. 

8. In the Location field, enter a destination Volume or directory. 

9. Click OK to execute the export and, if enabled, the save to the local disk. 

NOTE 
Configure Quantel Interface does not perform a check on the validity of the Quantel Host 
Name and/or IP Address.  If an error message is displayed when attempting to export to 
the selected system, confirm that the system is available and that the Host Name and IP 
Address are correctly entered.  Refer to Quantel Interface Configuration for details on 
error messages. 
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38. iTV 

iTV 
Lyric's iTV composition features require a special license.  Contact Chyron Customer Service at 631 - 845 - 
2000 for information. 

iTV Composition 
This feature is not yet fully implemented. 

Insert TV Object - iTV Composition 
Tools Menu > Insert TV Object 

A TV Object is a place-holder that designates the location of a “squeezed-back” (not to be confused with 
Lyric/Duet Squeezeback operations) TV picture in an interactive television composition, when activated on the 
viewer’s set-top box. To insert a TV Object, right-click on the Canvas and select Insert TV Object. 

 

TV Object 

Position the TV Object by dragging it to the desired location on the Canvas. You may also use the XYZ 
controls in Lyric’s Properties menu to position and scale the object. 

Note: Lyric for iTV composition requires a special license and this tool may be unavailable in your version of 
the software. 
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Insert iTV Hotspot 
Tools Menu > iTV Hotspot 

An iTV Hotspot is a user-definable area that may be assigned a link such as a URL or a JavaScript call in 
Lyric's iTV Properties menu.  To insert an iTV Hot Spot: 

 From the Tools menu, select iTV Hot Spot.  A rectangular frame appears on the screen.  The frame 
can be resized and repositioned. 

 

Inserting an ITV Hot Spot 

NOTE 
Lyric for iTV composition requires a special license and this tool may be unavailable in 
your version of the software. Also, the menu(s) shown may differ in your version of Lyric. 

Export to iTV 
File Menu > Export to iTV 
Lyric iTV requires a special license.  Contact Chyron Customer Service at 631-845-2132 for additional 
information.  This menu item appears only if iTV is installed on the system. 
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39. Networking and File Transfer 

Finding the IP Address or Computer Name of a System 
When a system on which Lyric is running is networked to another system such as a Chyron Aprisa, it is 
necessary to know either the Full Computer Name or the IP Address of the remote system. 

 The Full Computer Name is a name given to a system to make it easily identifiable. 

 The IP Address is the actual network address of the system. 

The Full Computer Name and IP Address are stored as part of a system's network configuration. 

NOTE 
If the IP Address of the system is dynamically assigned, i.e. a new one is assigned each 
time the system is started up, then always enter the Full Computer Name when a Host 
Name or Alternate Host Name is requested.  If in doubt about whether or not the IP 
Address is fixed or dynamic, then always use the Computer Name as the Host Name or 
Alternate Host Name. 

Procedures for finding the Computer Name and IP Address are shown for both the Windows® 2000 and 
Windows NT® operating systems.  Note that depending on the version of the Windows® operating system 
and the system's configuration, the procedures may deviate from those described below.  

Windows® 2000 
To find the Computer Name of a system: 

 On the system, access Start > Settings > Control Panel > System > Network Identification.  The 
Full Computer Name is displayed on the Network Identification tab. 

To find the IP Address of a system: 
1. On the system, access Start > Settings > Control Panel > Network and Dial-up Connections > 

Local Area Connection > General. 

2. Click Properties, then select Internet Protocol (TCP/IP).  If Use the Following IP Address is 
specified, the IP Address is displayed in the IP Address field.  If Obtain an IP Address 
Automatically is specified, use the Full Computer Name as the Host Name or Alternate Host 
Name, as the IP Address can change with each network session. 

Windows NT® 
To find the Computer Name of a system: 

 On the system, access Start > Settings > Control Panel > Network > Identification.  The 
Computer Name is displayed on the Identification tab. 

To find the IP Address of a system: 
1. On the system, access Start > Settings > Control Panel > Network > Protocols.   

2. Select Internet Protocol (TCP/IP).  If Specify an IP Address is specified, the IP Address is 
displayed in the IP Address field.  If Obtain an IP Address from a DHCP Server is specified, use 
the Computer Name as the Host Name or Alternate Host Name, as the IP Address can change 
with each network session. 

FTP 
Files can be transferred between systems using File Transfer Protocol, also known as FTP.  While files of 
all formats can be transferred between systems, FTP is necessary for transferring files to and from an 
iNFiNiT! system.  For information on how to execute an FTP transfer, refer to the chapter on iNFiNiT! 
Systems and Lyric. 
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40. Keyboard/Mouse Shortcuts 

Keyboard/Mouse Shortcuts Overview 
Lyric offers a variety of keyboard/mouse shortcuts to help speed your work.  Many of the keyboard shortcuts 
work on both Duet keyboards and conventional PC keyboards.  Differences between the two keyboards are 
noted.  The keystrokes are specified as follows: 

 If a keystroke combination contains a +, it indicates that the key specified to the left of the + should be 
pressed, then held, while the key to the right is pressed.  For example, Ctrl + N indicates that the Ctrl 
key should be pressed, then held, while the N key is pressed.  Ctrl + Alt +  indicates that the Ctrl 
and the Alt key should be pressed and held while pressing the  key as many times as necessary to 
shift the page on the Canvas. 

  If the keystroke combination does not contain a +, then press, but do not hold the keys, in the order 
in which they are indicated.  For example, to record a message at a specific Message Number, 
<Message Number> Record indicates that the Message Number should be entered on the numeric 
keypad, and then Record is pressed.  No keys are held while others are pressed. 

 If the + key is used as a keystroke instead of used to specify a held key, it is indicated as such. 

The Keyboard/Mouse Shortcuts are grouped as follows: 
 2D/3D Text, Text Templates and Row Tabs 

 All Other Shortcuts  

Keyboard/Mouse Shortcuts - 2D/3D Text, Text Templates and Row 
Tabs 

NOTE 
For sake of clarity in this section, references to 2D Text Windows in the tables below also 
encompass 2D Roll, Crawl and Type On Windows.  

There are two ways that text in a 2D Text Window is accessed for editing/manipulation: 
 Selection:  The text is surrounded by a Bounding Box 

 Cursor Position:  The cursor position determines which text is affected by an operation. 

A few points regarding selection: 
 A row in a 2D Text Window or 2D Text Template is considered selected for editing when the cursor 

is positioned on it. 

 A 2D Text Window is considered selected when the Title Bar of the window is light gray.  A cursor is 
visible in the 2D Text Window when it is active.  

 Text inside of a 2D Text Template cannot be selected for text shifting operations, although it can be 
selected for other editing operations.  Cursor position can also affect which text is affected by an 
operation. 
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Typing 2D/3D Text and RGB Fonts 

TYPING CHARACTERS (2D/3D TEXT and RGB FONTS) 

Duet Keystroke(s) PC Keystroke(s) Description 

Caps Lock Caps Lock Toggles Caps Lock Mode on and off.  
When Caps Lock Mode is active, all 
characters are typed in upper case.  
Equivalent to a typewriter Caps Lock key. 

When Caps Lock is active, CAP in the 
Status Bar is not grayed out. 

Caps Lock Mode remains active until 
turned off. 

Fn + Num Lock 
(same keycap as 
Ctrl on the 
numeric keypad) 

Num Lock Toggles Num Lock Mode on and off: 

 When active, the numeric keypad 
at the right of the keyboard types 
numbers. 

 When inactive, pressing the 
numeric keypad keys shifts cursor 
position, activates/inactivates 
Insert Mode, or deletes the 
selected 2D text character. 

When Num Lock is active, NUM in the 
Status Bar is not grayed out. 

Num Lock Mode remains active until 
turned off. 

Fn + Insert (same 
keycap as Delete 
Row) 

OR 

With Num Lock 
inactive, press Ins 
(0) on numeric 
keypad 

Insert (located 
above the Delete 
key on the PC) 

OR 

With Num Lock 
inactive, press Ins 
(0) on numeric 
keypad 

Toggles between Overwrite Mode and 
Insert Mode: 

 When Overwrite Mode is active, a 
newly-typed character replaces the 
existing character. 

 When Insert Mode is active, the 
newly-typed character is inserted 
at the cursor position without 
replacing a character.  All 
characters to the right of the new 
character are moved to the right to 
accommodate the new character. 

When Overwrite Mode is active, OVR in 
the Status Bar is not grayed out. 

When Insert Mode is active, OVR in the 
Status Bar is grayed out. 

Insert or Overwrite Mode remains active 
until turned changed. 



 Keyboard/Mouse Shortcuts  

 40-3 

TYPING CHARACTERS (2D/3D TEXT and RGB FONTS) 

Duet Keystroke(s) PC Keystroke(s) Description 

Ctrl + - (minus 
sign) 

Ctrl + - (minus 
sign) 

Toggles Locked Translation Mode on and 
off.  Locked Translation Mode enables 
typing of Alt and Alt + Shift characters 
(including RGB Font). 

When Locked Translation Mode is active, 
TRNS in the Status Bar is not grayed out. 

Locked Translation Mode remains active 
until turned off. 

Ctrl + = (equal 
sign) 

Ctrl + = (equal 
sign) 

Toggles Single-Stroke Translation Mode 
on and off.    Single-Stroke Translation 
Mode enables typing of Alt and Alt + Shift 
characters (including RGB Fonts). 

When Single-Stroke Translation Mode is 
active, TRNS in the Status Bar is not 
grayed out. 

Single-Stroke Translation Mode is active 
for typing only one character.  After the 
character is types, Single-Stroke 
Translation Mode turns off. 

2D Text/Template Selection and Navigation 

2D TEXT WINDOW/TEMPLATE SELECTION AND NAVIGATION 

Duet/PC 
Keystroke(s) 

Description 

Selecting a 2D Text Window 

Ctrl + W Toggles among 2D Text Windows in the order of their creation. 

Shift + Ctrl + W Toggles among 2D Text Windows in opposite order of their 
creation. 

Selecting/Repositioning/Resizing a 2D Text Template 

Tab Toggles through all open 2D Text Templates in 2D Text 
Windows in order of their creation (oldest to newest), regardless 
of the 2D Text Window in which they are situated. 

Shift + Tab Toggles through all open 2D Text Templates in 2D Text 
Windows in reverse order of their creation (newest to oldest), 
regardless of the 2D Text Window in which they are situated. 

Ctrl + Left-Click Toggles 2D Text Template selection on and off. 

Ctrl + Left-Click, 
then Ctrl + 
 or click-
and-drag Template 

Ctrl + Left-Click selects 2D Text Template, then Ctrl +  
or click-and-drag Template is used to reposition the 2D Text 
Template. 
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2D TEXT WINDOW/TEMPLATE SELECTION AND NAVIGATION 

Duet/PC 
Keystroke(s) 

Description 

Ctrl + Left-Click, 
then  or 
click-and-drag 
handles 

Ctrl + Left-Click selects 2D Text Template, then  or 
click-and-drag handles is used to resize the 2D Text Template.  
Aspect ratio of the 2D Text Template always remains constant 
when resized from the corner handles. 

2D/3D Color/Font Selection 

2D/3D COLOR/FONT SELECTION 

Duet/Keystroke(s) PC Keystroke(s) Description 

Color Keys 1 - 8 Ctrl + 1 through 
Ctrl + 8 
  

Selects entries 1 - 8 in pull-down Color 
Palette on the Font Toolbar (2D or 3D 
text) and in the Color Select dialog box. 

No corresponding 
keystrokes. 

Ctrl + 9 
Ctrl + 10 

Selects Palette Positions 9 and 10 
respectively in pull-down Color Palette on 
the Font Toolbar (2D or 3D text) and in the 
Color Select dialog box.  Do not have 
corresponding dedicated Duet keyboard 
keystrokes. 

Color Keys 9 - 14 
(Shift + Color Keys 
1 - 6) 

Note:  Color Keys 
15 and 16 are not 
operational. 

Ctrl + Shift +1 
through Ctrl + 
Shift + 6 

Selects entries 11 - 16 in pull-down Color 
Palette on the Font Toolbar (2D or 3D 
text) and in the Color Select dialog box. 

Font Keys 1 - 8 Alt + 1 through Alt 
+ 8 

Selects fonts 1 - 8 as assigned to Duet 
Font Keys (2D or 3D text).  

Font Keys 9 - 16 
(Shift + Font Keys 
1 - 8)  

Alt + Shift + 1 
through Alt + Shift 
+ 8 

Selects fonts 9 - 16 as assigned to Duet 
Font Keys (2D or 3D text). 

No corresponding 
keystrokes. 

Alt + 0 
Alt + 9 
Alt + Shift + 0 
Alt + Shift + 9 

Hotkeys for four additional fonts.  Do not 
have corresponding dedicated Duet 
keyboard keystrokes.  

Color Font Key Alt + F12 Picks up color and font of the currently 
selected 2D character. 

 Place cursor on text, then press 
the Color Font key or Alt + F12.  

Subsequent typing reflects the new color 
and font attributes until changed (2D Text 
Windows only). 
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Cursor Positioning, Text Editing Functions 

2D TEXT CURSOR POSITIONING AND TEXT EDITING FUNCTIONS 

Duet/PC 
Keystroke(s) 

Description 

Cursor Positioning 

Home Moves cursor to beginning of selected row in 2D Text Window or 
2D Text Template. 

End Moves cursor to end of selected row in 2D Text Window or 2D 
Text Template. 

Ctrl + Home Moves cursor to beginning of active 2D Text Window or selected 
2D Text Template. 

Ctrl + End Moves cursor to end of last row of active 2D Text Window or 
selected 2D Text Template. 

2D Text Editing - Cut, Copy, Paste, Delete, Erase, Insert, Etc. 

Ctrl + Z Undo:  Undoes last edit.  Can back through an edit sequence, 
one edit at a time. 

Ctrl + Y Redo:  Redoes last undone edit.  Can redo an edit sequence, 
one edit at a time. 

Ctrl + A Selects all in 2D Text Window.  Selected text in enclosed in a 
bounding box which can be repositioned, scaled, etc.  Ctrl + A 
also selects all text in a 2D Text Template, but manipulation 
cannot be applied to the 2D Text Template using this method of 
selection. 

Delete Deletes selected text in 2D Text Window or 2D Text Template.  
Selected text not stored in Clipboard. 

Ctrl + C 

Ctrl + Insert 

Copies selected text in 2D Text Window or 2D Text Template.  
Selected text stored in Clipboard. 

Ctrl + X 

Shift + Delete 

Cuts selected text in 2D Text Window or 2D Text Template.  
Selected text stored in Clipboard. 

Ctrl + V 

Shift + Insert 

Pastes selected text in 2D Text Window or 2D Text Template at 
cursor position. 

Ctrl + Alt + V Paste Unicode Text:  Pastes Unicode text that was previously 
cut or copied form another document. 

Ctrl + I Paste in Place:  Pastes contents of Clipboard on top of and 
exactly in the same position as cut/copied text (2D Text 
Windows only). 

Alt + F3 Inserts Space at cursor position in 2D Text Window or 2D Text 
Template. 
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2D TEXT CURSOR POSITIONING AND TEXT EDITING FUNCTIONS 

Duet/PC 
Keystroke(s) 

Description 

F2 Deletes all characters and spaces from the cursor to the end of 
row in active 2D Text Window or Template.  

Shift + Backspace Erase All (2D Text Templates only):  To erase all text from the 
selected 2D Text Template: 

 Place the cursor in the 2D Text Template, and then 
press Shift + Backspace. 

Row Edit Functions 

Ctrl + L Lock Mode:  Allows locking of 2D Text rows so that they shift as 
one group.  To toggle on and off: 

 Press Ctrl + L or select Row Shift Locked from the Edit 
menu to toggle on and off. 

When Lock Mode is active, LOCK is not grayed out on the 
Status Bar. 

Enter Add Row:  Adds new row below current row in 2D Text Window 
or 2D Text Template. 

Alt + Insert Inserts row above cursor position in 2D Text Window or 2D 
Text Template. 

Alt + Delete Deletes selected row in 2D Text Window or 2D Text Template.  

Shift + Enter Moves the portion of a 2D Text Window or 2D Text Template 
row located to the right of the cursor to the next row. 

Cursor at end of 
Row, then press 
Delete 

Pull up Word (2D Text Template Only):  Pulls up a word from 
the following row to the row on which the cursor is positioned. 

 Place the cursor at the end of a row, and then press Del.  
If there is room on the current row, the first word from the 
next row is moved up to the current row. 

NOTE:  Word Wrap must be enabled in the 2D Text Template 
dialog box for this to work in a 2D Text Template. 

Ctrl + B Swap Row Up:  Swaps row up in a multi-row 2D Text Window 
or 2D Text Template.  Equivalent to selecting 2D Text Window 
or 2D Text Template Context (Right-Click) Menu > Swap Row 
Up. 

Ctrl + F Swap Row Down:  Swaps row down in a multi-row 2D Text 
Window or 2D Text Template.  Equivalent to selecting 2D Text 
Window or 2D Text Template Context (Right-Click) Menu > 
Swap Row Down. 

Alt + P Swap Row Priority Up:  Swaps priority with the 2D Text 
Window  or 2D Text Template row behind the row on which the 
cursor is positioned. 
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2D TEXT CURSOR POSITIONING AND TEXT EDITING FUNCTIONS 

Duet/PC 
Keystroke(s) 

Description 

Alt + N Swap Row Priority Down:  Swaps priority with the 2D Text 
Window or 2D Text Template row on top of the row on which the 
cursor is positioned. 

Tab Function 

Ctrl + Tab Duplicates the function of the Tab key in a conventional word 
processor.  Works in a 2D Text Window or 2D Text Template.  
Tab Width is set in Config > Preferences > CG Preferences. 

Find/Replace, Spell Check 

Ctrl + H Find/Replace:  Searches 2D Text Windows and 2D Text 
Templates. 

F7 Spell Check:  Checks 2D Text Windows and 2D Text 
Templates. 

Row Tab Functions 

ROW TAB FUNCTIONS 

Duet/PC 
Keystroke(s) 

Description 

Ctrl + T Add Row Tab Marker 

Alt + J Select Next Tab 

Alt + M Tab Column Mode 

2D Text Template Update Functions 

2D TEXT TEMPLATE UPDATE FUNCTIONS 

Duet/PC 
Keystroke(s) 

Description 

Alt + T Template Update:  Displays Template Update dialog box, from 
which instant updates can be executed. 

Alt + U Disables interface fields (for use with Intelligent Interface). 
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2D Text Shift/Squeeze/Expand Functions 

2D TEXT SHIFT/SQUEEZE/EXPAND FUNCTIONS 

Shifts execute in 1-scanline (up/down) or one-pixel (left-right) increments. 

Super Shifts execute in 10-scanline (up/down) or one-pixel (left-right) increments. 

When text is selected, that indicates that is enclosed by a Bounding Box.  Performing 
a shift operation on selected text can differ in behavior than performing a shift on text 
that is marked by the cursor position. 

Text can be selected in a 2D Text Template for operations such as changing font color.  
When a shift operation is applied to selected text in a 2D Text Template, however, the 
bounding box disappears, and the cursor reappears.  The shift executes based on 
cursor position, not text selection.  

Super Shift 

Super Shift:  2D Text shifts are performed in one-scanline (horizontally) or one-pixel 
(vertically) increments at a time.  To move characters/rows 10 scanlines/pixels at a time 
instead of by single scanlines/pixels: 

 Hold the Shift key while performing the Character or Row Shift.  

Duet/PC 
Keystroke(s) 

Description 

Shift Character Operations 

Alt + F3 Insert space. 

Ctrl +   Shift Character Up/Down: 

 2D Text Window:  Shifts selected character(s) up/down. 

 2D Text Window/2D Text Template:  Shifts character at 
cursor position. 

Shift + Ctrl +   Super Shift Character Up/Down in 10-scanline increments (see 
above). 

Ctrl +  Shift Character Left/Right: 

 2D Text Window:  Shifts selected character(s) 
Left/Right. 

 2D Text Window/2D Text Template:  Shifts character 
and all characters on the same row to the right of the 
character Left/Right. 

Shift + Ctrl +  Super Shift Character Left/Right in 10-pixel increments (see 
above). 
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2D TEXT SHIFT/SQUEEZE/EXPAND FUNCTIONS 

Shift Row Operations 

Alt + F1 Center 2D Text Window Row:  Cursor can be positioned inside 
or outside of a Template.  This function is applied to the 2D Text 
Window row, not the 2D Text Template row. 

Click/Drag Row 
Handle 

Shift Single Row in 2D Text Window/2D Text Template. 

Alt +  Shift Row(s) Up/Down: 

 2D Text Windows:  Shifts the selected row (Row Shift 
Unlock Mode) or the selected row and the rows below it 
(Row Shift Lock Mode). 

 2D Text Templates:  Shifts the selected row and the 
rows below it, regardless of the Row Shift Lock/Unlock 
setting. 

Shift + Alt +  Super Shift 2D Text Window/2D Text Template row(s) up/down 
in 10-scanline increments (see above). 

Ctrl + L Row Shift Unlock:  When a row of 2D Text Window text is 
shifted using the (Alt +  or Shift + Alt +  functions, only 
the selected row selected shifts.  This is known as Unlocked 
Mode.  The rows beneath the shifted row are not affected. 

Row Shift Lock:  Locked Mode enables the row and the rows 
below it to shift as a block. 

2D Text Template rows are always in Locked Mode, regardless 
of the Row Shift Lock/Unlock setting. 

Alt +  Shift 2D Text Window or 2D Text Template Row Left/Right. 

Shift + ALT +  Super Shift 2D Text Window/2D Text Template row left/right in 
10-pixel increments (see above). 

Shift Page Operations 

Alt + F2 Center Page:  Centers entire Lyric screen. 

Ctrl + Alt + 
 

Shift page up/down/left/right:  Shifts entire Lyric screen 
up/down/left/right. 

Shift + Ctrl + Alt + 
 

Super shift page up/down/left/right:  Shifts entire Lyric screen 
up/down/left/right in 10-scanline/pixel increments. 
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2D TEXT SHIFT/SQUEEZE/EXPAND FUNCTIONS 

2D Text Squeeze/Expand Functions 

Ctrl + 4 on numeric 
keypad  

Word Squeeze: 

 2D Text Windows:  Draws together the word on which 
the cursor is positioned, or on selected text, reducing the 
space (kerning) between the characters.  The leftmost 
character in the word stays stationary. 

 2D Text Templates:  Draws together the word on which 
the cursor is positioned, as well as any words on the 
same row to the right of the cursor position, reducing the 
space (kerning) between the characters.  The leftmost 
character in the word stays stationary. 

This operation can also be accessed from 2D Text/Template 
Context (right-click Menu > Squeeze/Expand. 

Ctrl + 6 on numeric 
keypad  

Word Expand: 

 2D Text Windows:  Expands word on which the cursor is 
positioned, or selected text, out towards the right, 
expanding the space (kerning) between the characters.  
The leftmost character in the word stays stationary. 

 2D Text Templates:  Expands word on which the cursor 
is positioned, as well as any words on the same row to 
the right of the cursor position, out towards the right, 
expanding the space (kerning) between the characters.  
The leftmost character in the word stays stationary. 

This operation can also be accessed from 2D Text/Template 
Context (right-click Menu > Squeeze/Expand. 

Ctrl + 8 on numeric 
keypad  

Row Squeeze (2D Text Windows/2D Text Templates):  Draws 
rows below the row on which the cursor is positioned (cursor row) 
up, towards the cursor row, reducing the space between the 
rows.  The row on which the cursor is positioned remains 
stationary. 

This operation can also be accessed from 2D Text/Template 
Context (right-click Menu > Squeeze/Expand. 

Ctrl + 2 on numeric 
keypad  

Row Expand (2D Text Windows/2D Text Templates):  Pushes 
rows below the row on which the cursor is positioned (cursor row) 
down, away from the cursor row, expanding the space between 
the rows.  The on which the cursor is positioned remains 
stationary. 

This operation can also be accessed from 2D Text/Template 
Context (right-click Menu > Squeeze/Expand. 
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2D Text Record Options 

LYRIC MESSAGE FILES - RECORD 2D TEXT 

Duet Keystroke(s) PC Keystroke(s) Description 

The Message ID Number can be entered before any of the following commands to 
specify a message other than that which is currently displayed. 

Selective Recording - 2D Text:  Ctrl + Record displays the Record Only: dialog box, 
which enables the recording of specific 2D Text elements of a Lyric composition.  A 
message recorded in this manner can be read into a 2D Text/Roll/Crawl/Type On 
Window of another message as a Pop-On message, which replaces text in the 
message into which it is read.  All messages are recorded in the *.lyr format to the 
Default Message Directory. 

Note that the Ctrl + Alt + Record (Duet keyboard) and Ctrl + Alt + Minus key (-) on 
the numeric keypad (PC keyboard) combinations can be used to overwrite the 
currently loaded message.  

Ctrl + Record T 
Enter 

Ctrl + Minus key T 
Enter 

Records All Text in selected 2D Text 
Window. 

Ctrl + Record E 
Enter 

Ctrl + Record E 
Enter 

Records Cursor to End of text in selected 
2D Text Window. 

Ctrl + Record R 
Enter 

Ctrl + Record R 
Enter 

Records Current Row of text in selected 
2D Text Window. 

Ctrl + Record D 
Enter 

Ctrl + Record D 
Enter 

Records Template Description Message. 
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Keyboard/Mouse Shortcuts - Except 2D Text/Templates 

General 

GENERAL 

Duet/PC 
Keystroke(s) 

Description 

Help 

F1 Help 

Shift + F1 Context Help:  Press Shift + F1.  The  cursor appears.  Drag 
it to any element on the Lyric interface with which you need help, 
then left-click to display the associated Help topic. 

File Operations 

Ctrl + N If a Canvas is displayed, prompts user with a choice to clear the 
Canvas.  If user selects Yes, then new Canvas is displayed.  
Note that additional options are available by selecting New from 
the File menu. 

Ctrl + O Open File. 

Ctrl + S Save File. 

Alt + F4 Exits Lyric, first requesting confirmation. 

Window Operations 

F3 Shifts focus to the Scene Graph. 

F4 Shifts focus to the topmost Browser Window. 

F6 Shifts focus to the Canvas. 

Ctrl + F6 Selects next window (for example, moves from the Canvas to the 
Properties page to the Timeline). 

Ctrl + Shift + F6 Selects the previous window. 

Ctrl + F4 Close window. 

Page Shift 

Alt + F2 Center page:  Centers entire Lyric screen. 

Ctrl + Alt + 
 

Shift page up/down/left/right:  Shifts entire Lyric screen 
up/down/left/right. 

Shift + Ctrl + Alt + 
 

Super shift page up/down/left/right:  Shifts entire Lyric screen 
up/down/left/right in 10-scanline/pixel increments. 
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GENERAL 

Duet/PC 
Keystroke(s) 

Description 

Erase Operations 

Ctrl + E Erase:  Prompts the user to choose from among several options. 

Equivalent to clicking the  button. 

Ctrl + Q Erase Screen:  Erases the Canvas.  If Lyric is running on a Duet, 
this also erases the contents of the currently selected Frame 
Buffer. 

Canvas Viewing 

Spin the mouse 
wheel up/down. 

Zooms into/out from the Canvas. 

Hold the Shift key 
down.  Spin the 
mouse wheel 
up/down. 

Zooms into/out from the Canvas more quickly. 

Hold the Shift key 
down and the 
mouse wheel 
down.  Spin the 
mouse wheel 
up/down. 

Zooms into/out from the Canvas more slowly. 

Hold the mouse 
wheel down. Move 
the mouse around 
the Canvas. 

Looks around the scene. 

Hold the Shift key 
down and the 
mouse wheel 
down. Move the 
mouse around the 
Canvas. 

Rotates the scene. 
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Manipulating and Editing Objects on the Canvas 

MANIPULATING AND EDITING OBJECTS ON THE CANVAS 

Duet/PC 
Keystroke(s) 

Description 

Ctrl + Z 

Alt + Backspace 

Undo 

Ctrl + Y Redo 

Ctrl + left click Selects multiple items on the Scene Graph or on the Timeline 
for editing.  

Shift + left click Selects adjacent items on the Scene Graph or on the Timeline 
for editing.  

Alt + Click Clicking the mouse while the Alt key is held cycles through 
selecting each object on the Canvas. 

Ctrl + Delete Deletes the object (any type) that is active on the Scene Graph 
and Canvas. 

Shift + Delete Deletes the object (any type) that is active on the Scene Graph 
and Canvas. 

Ctrl + E Erase:  Prompts the user to choose from among several options. 

Equivalent to clicking the  button. 

Ctrl + Q Erase:  Erases all Canvas contents with no request for 
confirmation. 

Ctrl + G Group (usable for any and all types of Canvas objects). 

Ctrl + U Ungroup. 

Ctrl + C 

Ctrl + Insert 

Copy (any object) 

Ctrl + X 

Shift + Delete 

Cuts selected text in 2D Text Window or 2D Text Template.  
Selected text stored in Clipboard. 

Ctrl + V 

Shift + Insert 

Paste (any object) 

 

Ctrl + I Paste in Place (any object) 
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Browser 

Mouse/Keyboard 
Action 

BROWSER 

F4 Switches focus in Lyric to the topmost Browser Window. 

Click-and-Drag Bitmap, Lyric Message, Aprisa and Quantel assets from the 
Browser window to the Lyric Canvas or into a 2D Text Window 
in the Canvas. 

Click-and-Drag Bitmap and Aprisa 100 (Still) assets from the Browser Window 
to Texture Chip in Properties > Surface. 

Click-and-Drag Lyric Message Assets from the Browser window to the File 
Name field in the Playlist. 

Click-and-Drag Assets from one Browser window to another Browser window. 

Click-and-Drag Font Assets from the Browser window into Properties > Fonts 
or Properties > 2D Font FX. 

Click-and-Drag Lyric messages and graphics from Windows® Explorer®-type 
windows into Lyric Browser Message Asset and Bitmap Asset 
Browser windows, respectively. 

Click-and-Drag Alt + drag-and-drop a Bitmap Asset or Aprisa 100 (Still) asset 
to create a background for a Canvas, 2D Text Window or 2D 
Text Template. 

 Moves the Browser cursor from item to item in the Browser 
Window. 

Home Selects the first item in the Browser Window. 

End Press End to select the last item in the Browser Window. 

Enter or  
Double-Click 

When a Browser item is highlighted, press either Enter key to 
open the selected item.  Double-clicking the item also opens the 
item. 

First letter or 
number of file 
name 

Typing any character key finds the next Browser entry with a title 
that starts with that character.  For example, in a Browser 
Window containing images titled Red, Rose and Yellow, typing r 
selects Red and scrolls it into view.  Typing r again selects Rose, 
and typing y selects Yellow. 

Key Combination 
for RGB Font 
Character 

In the Font Browser, typing a character selects and scrolls to the 
image mapped to that character. 

Alt + Keys 0 
through 9 

Alt + Shift + Keys 0 
through 9 

 

Accesses user-defined fonts in the Font Asset Browser.  
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File Operations 

LYRIC MESSAGE FILES - CLEAR AND DELETE 

Duet Keystroke(s) PC Keystroke(s) Description 

Del . (Decimal/Del) key 
on the numeric 
keypad  

Clears the Message Number display 

The Message ID Number can be entered before the following command to specify a 
message other than that which is currently displayed. 

Alt + F5 Alt + F5 Deletes file where current message is 
stored; requests confirmation from 
operator. 

 

LYRIC MESSAGE FILES - RECORD 

Duet Keystroke(s) PC Keystroke(s) Description 

The Message ID Number can be entered before any of the following commands to 
specify a message other than that which is currently displayed. 

Record Minus key (-) on 
the numeric 
keypad 

Records message at displayed message 
number. 

Alt + Record Alt + Minus key (-) 
on the numeric 
keypad 

Overwrites the current message 

Selective Recording - 2D Text:  Ctrl + Record displays the Record Only dialog box, 
which enables the recording of specific 2D text elements of a Lyric composition.  A 
message recorded in this manner can be read into a 2D Text/Roll/Crawl/Type On 
Window of another message as a Pop-On message, which replaces text in the 
message into which it is read.  All messages are recorded in the *.lyr format to the 
Default Message Directory. 

Note that the Ctrl + Alt + Record (Duet keyboard) and Ctrl + Alt + Minus key (-) on 
the numeric keypad (PC keyboard) combinations can be used to overwrite the 
currently loaded message, without prompting for an overwrite confirmation.  After the 
message is recorded, the Message Number display does not increment.  If the 
message was not originally read from an existing message, then the composition is 
saved at the current Message ID.  If a message with that Message ID already exists, 
then the overwrite prompt is displayed. 

Ctrl + Record T 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad T Enter 

Records All Text in selected 2D Text 
Window. 

Ctrl + Record E 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad E Enter 

Records Cursor to End of text in selected 
2D Text Window. 
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LYRIC MESSAGE FILES - RECORD 

Duet Keystroke(s) PC Keystroke(s) Description 

Ctrl + Record R 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad R Enter 

Records Current Row of text in selected 
2D Text Window. 

Ctrl + Record D 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad D Enter 

Records Template Data Message. 

Selective Recording - Timeline:  Ctrl + Record displays the Record Only dialog box, 
which enables the recording of specific Timeline elements.  Records files to the 
Default Effects Directory. 

Ctrl + Record S 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad S Enter 

Records the Keyframe information for all 
objects on the Canvas (Scene) in the .efx 
format, where it becomes available for use 
by the Read Effects tool.  The file format is 
the same as that recorded from File > 
Save As, where Lyric Effect (*.efx) is 
selected as the file format. 

Ctrl + Record O 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad O Enter 

Records all of the Keyframe information for 
a selected Object on the Canvas in the 
.kyf format.  The file format is the same as 
that recorded from Right-Click Object 
Timeline > Save Keyframe File. 

Selective Recording - Panel:  Ctrl + Record displays the Record Only: dialog box, 
which enables the recording of tool-specific files. 

Ctrl + Record C 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad C Enter 

Records only Clip information in the .ccf 
format to the Default Clip File Directory.  
The file format is the same as that recorded 
from Clip Control Panel > Save. 

Ctrl + Record K 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad K Enter 

Records only Clock and Timer information 
in the .lyr format to the Default Message 
Directory.  All Clocks and Timers in the 
composition are recorded.  The file format 
is the same as that recorded from 
Properties > Clocks/Timers > Save. 

Ctrl + Record M 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad M Enter 

Records only Macro information in the .lyr 
format to the Default Message Directory.  
The file format is the same as that recorded 
from Macros >  > Save, when the 
Macro is saved in the .lyr format. 

Ctrl + Record F 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad F Enter 

Records only Multi FX information in the 
.lyr format to the Default Message 
Directory.  The file format is the same as 
that recorded from Tools Menu > Multi FX 
> Save. 



Lyric User Guide 

 40-18 

LYRIC MESSAGE FILES - RECORD 

Duet Keystroke(s) PC Keystroke(s) Description 

Ctrl + Record P 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad P Enter 

Records the only the Playlist information in 
the .ply format to the Default Playlist 
Directory.  The file format is the same as 
that recorded from File Menu > Save As, 
where Playlist Files (*.ply) is selected as 
the file format. 

Ctrl + Record X 
Enter 

Ctrl + Minus key (-) 
on the numeric 
keypad X Enter 

Records only Video Mixer information in 
the .lyr format to the Default Message 
Directory.  The file format is the same as 
that recorded from Tools Menu > Video 
Mixer > Save. 

 

LYRIC MESSAGE FILES - READ 

Duet Keystroke(s) PC Keystroke(s) Description 

The Message ID Number can be entered before any of the following commands to 
specify a message other than that which is currently displayed. 

Read Enter on the 
numeric keypad  

Read message to Canvas. 

Ctrl + Read Ctrl + Enter on the 
numeric keypad 

Read Next. 

Alt + Read Alt + Enter on 
numeric keypad 

Read Previous. 

 

Buffer and Output Operations 

OUTPUTS 

Duet Keystroke(s) PC Keystroke(s) Description 

Ctrl + Fn + F6 Ctrl + F11 
Toggles  button on and off. 

Xfer / key on the 
numeric keypad 

Transfers active Frame Buffer content to 
VGE (output). 

Swap Ctrl +  / Swaps Channels. 

Alt + Xfer Alt +  / Transfers the contents of the current 
Canvas to the next available Frame Buffer 
without changing the active Frame Buffer.  
Leaves contents of active Channel intact. 

Chng * key on the 
numeric keypad  

Switches to next available frame buffer, 
making it active. 
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OUTPUTS 

Duet Keystroke(s) PC Keystroke(s) Description 

Play Alt + Page Up 
If is active: 

 Plays animation on VGE (output). 

If  is inactive: 

 Plays animation on VGA. 

Ctrl + Play 
 

Ctrl + Alt + Page 
Up 

Plays animation on VGE (output) 

regardless of whether is active or 

inactive .  

Esc Esc Stops the animation. 

Ctrl + Q Ctrl + Q Erases the Canvas.  If Lyric is running on a 
Duet, also erases the contents of the 
currently selected Frame Buffer. 

Alt + Erase Ctrl + Alt + Q Erases the outputs of both the selected 
Internal Clip Player and the Duet output. 

Animation Playback (for Testing) 

ANIMATION PLAYBACK (FOR TESTING) 

Keystroke(s) Description 

Alt + Next  icon  
on Canvas 
Transport Controls 

Advance to next keyframe of selected object.  

Alt + Previous  
icon  on Canvas 
Transport Controls 

Return to previous keyframe of selected object. 

Alt + Home Go to beginning of animation. 

Alt + End Go to end of animation. 

 Reverses animation one frame. 

 Advances animation one frame. 

Alt +  Reverses animation one second. 

Alt +  Advances animation one second. 
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TIMELINE 

Duet/PC 
Keystroke(s) 

Description 

Ctrl +  Moves selected timeline element forward one frame 

Ctrl +  Moves selected timeline element backward one frame 

Left Mouse Button Click and drag to extend or shorten selected timeline element(s); 
moves existing keyframes proportionately 

Ctrl + Left Mouse 
Button 

Click and drag to extend or shorten selected timeline element(s) 
without moving existing keyframes. 

Playlists 

PLAYLIST OPERATIONS 

Duet/PC 
Keystroke(s) 

Description 

Playlist Navigation 

 Press the cursor keys  to navigate up, down, left and 
right.  Note that when using the  keys to navigate, that when 
cursor reaches a field that accepts text entry, the cursor steps 
through the text first before proceeding to the next field. 

Page Up 

Page Down 

When the cursor is in a Line, Control, Effect or Channel field, 
press Page Up or Page Down to navigate up or down in five-line 
increments.  If the cursor is in the Line column, the entire line is 
highlighted. 

Click Scroll Bar 
Track 

In the Scroll Bar, click above or below the scroll box to page 
backwards or forwards, respectively, through the Playlist. 

Click Scroll Bar 
Arrow 

In the Scroll Bar, click the up or down arrow to scroll the Playlist 
one line up or one line down, respectively. 

End Press End to move the cursor to the next instance of End or to 
the final line of the Playlist that contains an entry. 

Current Take Line Indicator Placement :  In the event that non-sequential 
execution of the Playlist is necessary, the Current Take Line Indicator can be 
moved to a different step using a variety of methods. 

Click Click to the left of a Playlist line to move the Current Take Line 
Indicator to the line. 

Ctrl +  Press Ctrl +  or Ctrl +  to move the Current Take Line 
Indicator up or down in one-line increments. 

Ctrl + Page Up 

Ctrl + Page Down 

Press Ctrl + Page Up or Ctrl + Page Down to move the Current 
Take Line Indicator up or down in five-line increments. 

Ctrl + Home Press Ctrl + Home to move the Current Take Line Indicator to 
the first line of the Playlist. 
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PLAYLIST OPERATIONS 

Duet/PC 
Keystroke(s) 

Description 

Ctrl + End Press Ctrl + End to move the Current Take Line Indicator to 
the next instance of End or to the final line of the Playlist that 
contains an entry. 

GPI Triggers a GPI to move the Current Take Line Indicator up or 
down in one-line increments.  The GPI is set up in the Playlist 
Configuration dialog box.  A GPI can also be used to execute a 
Take. 

Playlist Editing 

Ctrl + C Copies selected fields to the paste buffer. 

Ctrl + X If the Speed or File Name field(s) is highlighted, cuts the 
contents of the field(s) to the paste buffer. 

If the entire line is highlighted, cuts the contents of the line to the 
paste buffer. 

Ctrl + V Pastes contents of the paste buffer to the Playlist in the line in 
which the cursor is positioned. 

Insert Inserts a blank line directly above the line in which the cursor is 
positioned. 

Delete If the Speed or File Name field is highlighted, deletes the 
contents of the field. 

If the entire line is highlighted, deletes the line. 

Ctrl + W Swaps the contents of the line on which the cursor is positioned 
with the line directly following.  Note that the cursor must be in the 
Line field and the entire line must be highlighted for the Swap to 
execute. 

Ctrl + G Playlist Group. 

Ctrl + U Playlist Ungroup. 

Ctrl + Z Cancels the last edit applied in the Playlist.  Reverts the Playlist 
to the state directly previous to when the edit was applied. 

File Operations 

Ctrl + O Displays the Open dialog box from which a file can be selected to 
open.  Files of Type is automatically set to Playlist Files (*.ply) 
if the Playlist window is active. 

If the Playlist window is not active, then Playlist Files (*.ply) 
should be selected in the Files of Type field before selecting a 
file to open. 

Ctrl + S Displays the Save As dialog box from which the currently 
displayed Playlist can be saved.  The Playlist window must be 
active for Ctrl + S to save to a Playlist. 
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PLAYLIST OPERATIONS 

Duet/PC 
Keystroke(s) 

Description 

Playlist Execution 

Esc Stops Playlist execution. 

GPI Executes a Take. 

Internal Clip Player 

INTERNAL CLIP PLAYER 

Duet Keystroke(s) PC Keystroke(s) Description 

> < > < Moves a clip to the next or previous frame, 
respectively. 

Alt + Erase Ctrl + Alt + Q Erases the outputs of both the selected 
Internal Clip Player and the Duet output. 
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41. Support 

Support and License Agreement 
Chyron provides a number of support methods for Lyric software. Please review these methods and select 
the ones that best suit your facility's needs. 

To insure access to customer service and to product upgrades, Lyric software must be registered. The 
registration card included in the manual must be returned by FAX or mail to Chyron. 

Internet Support 
Visit the support area of our web site, at: http://www.chyron.com/support/index.html. You may find the User 
Forums particularly useful. 

Email Support 
If you’re unable to find the answers to your questions on our web site, feel free to email us! We make every 
effort to answer questions promptly. You can reach us at:  

support@chyron.com  

Telephone Support 
Chyron Customer Service can be reached at 888-4-CHYRON or 631-845-2132.  

Customer Service can furnish complete information about your support options. 

Microsoft Data Access Components 2.0 
End-User License Agreement (EULA) for Microsoft Software 
IMPORTANT-READ CAREFULLY:  

This Microsoft End-User License Agreement (“EULA”) is a legal agreement between you (either an individual 
or a single entity) and Microsoft Corporation for the Microsoft software identified above, which includes 
computer software components and may include associated media, printed materials, and “on-line” or 
electronic documentation (“SOFTWARE”). By installing, copying, or otherwise using the SOFTWARE, you 
agree to be bound by the terms of this EULA. If you do not agree to the terms of this EULA, do not install or 
use the SOFTWARE. 

SOFTWARE LICENSE 

The SOFTWARE is protected by copyright laws and international copyright treaties, as well as other 
intellectual property laws and treaties. The SOFTWARE is licensed, not sold. 

1. GRANT OF LICENSE. This EULA grants you the following rights: 

(a) Use with existing Microsoft products for which you have previously acquired a licensed copy (“MS 
Product”). Subject to the terms of this EULA, Microsoft grants to you as an individual, a personal, 
nonexclusive license to make and use one copy of the SOFTWARE in conjunction with any 
commercially-released MS Product. You have the additional right to make and use up to that number 
of copies of the SOFTWARE equal to the number of copies of such MS Product(s) that you have 
previously licensed.  

(b) Developing applications using Microsoft Visual C++, Microsoft FoxPro, Visual Basic, Visual 
Studio, Visual Interdev, Visual J++, or Office Developers Edition (each a “Microsoft Development 
Tool”). If you have a valid license for any commercially released MS Product, Microsoft also grants to 
you as an individual, a personal, nonexclusive license to install and use copies of the SOFTWARE 
for the sole purposes of designing, developing, and testing your software products. You may install 
copies of the SOFTWARE on an unlimited number of computers provided that you are the only 
individual using the SOFTWARE. If you are an entity, Microsoft grants you the right to designate one 
individual within your organization to have the right to use the SOFTWARE in the manner provided 
above. In addition, if you have acquired more than one valid license for Microsoft Development 
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Tools, you may designate additional individuals within your organization to use the SOFTWARE in 
the manner described above, provided that the total number of all such designated individuals shall 
not exceed the number of valid licenses that you have previously acquired for Microsoft 
Development Tools. You may make an unlimited number of copies (either in hard copy or electronic 
form) of any electronic documents included with the SOFTWARE, provided that such copies shall be 
used for internal purposes and are not republished or distributed beyond your premises.  

(i) Redistributable Components. In addition to the rights granted in Section 1 (b), Microsoft 
grants you a nonexclusive, royalty-free right to reproduce and distribute all the component 
files of the SOFTWARE (“Redistributables”), provided that you comply with the following: 

(ii) Redistribution Requirements. If you redistribute the Redistributables, you agree to (a) 
distribute the Redistributables in object code only in conjunction with and as a part of a 
software application product developed by you with a Microsoft Development Tool that adds 
significant and primary functionality to the Redistributables (“Application”); (b) not use 
Microsoft's name, logo, or trademarks to market your Application;  

(c) include a valid copyright notice with your Application; (d) include all copyright and trademark 
notices contained in the Redistributables; (e) include a copy of this EULA with any Redistributables 
you distribute; (f) indemnify, hold harmless, and defend Microsoft from and against any claims or 
lawsuits, including attorneys' fees, that arise or result from the use or distribution of your Application, 
and (g) not permit further distribution of the Redistributables by your end user. The following 
exception applies: you may permit further redistribution of the Redistributables by your distributors to 
your end-user customers if your distributors only distribute the Redistributables in conjunction with, 
and as part of, your Application.  

If you redistribute the “ADO Files” or “OLE DB Files” (as defined below) all of the foregoing requirements 
apply to you except that you do not have to develop the Application with a Microsoft Development Tool. For 
purposes of the foregoing “ADO Files” shall mean the following files: msader15.dll, msado15.dll, 
msador15.dll, msadrh15.dll, adovbs.inc and adojavas.inc; “OLE DB Files” shall mean the following files: 
msdadc.dll, msdaenum.dll, msdaer.dll, msdaerr.dll, msdaps.dll, msdasql.dll, msdasqlr.dll, msdatl.dll and 
msdatt.dll. 

If you redistribute the “Jet Files” (as defined below) you agree to the following additional requirements: (a) that 
your Application does not substantially duplicate the capabilities of Microsoft Access or, in the reasonable 
opinion of Microsoft, compete with same; and (b) unless your Application requires your customers to license 
Microsoft Access in order to operate, you may not reproduce or use any of the Jet Files for commercial 
distribution in conjunction with a general purpose word processing, spreadsheet or database management 
software product, or an integrated work or product suite whose components include a general purpose word 
processing, spreadsheet, or database management software product except for the exclusive use of 
importing data to the various formats supported by Microsoft Access. Note: A product that includes limited 
word processing, spreadsheet or database components along with other components which provide 
significant and primary value, such as an accounting product with limited spreadsheet capability, is not 
considered to be a “general purpose” product. For purposes of the foregoing the “Jet Files” shall mean the 
following files: expsrv.dll, vbajet32.dll, msexcl35.dll, msjet35.dll, msjint35.dll, msjter35.dll, msltus35.dll, 
mspdox35.dll, msrd2x35.dll, msrepl35.dll, mstext35.dll, msxbse35.dll, msexch35.dll. 

2. DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS.  

Limitations on Reverse Engineering, Decompilation, and Disassembly. You may not reverse engineer, 
decompile, or disassemble the SOFTWARE, except and only to the extent that such activity is expressly 
permitted by applicable law notwithstanding this limitation. 

Separation of Components. The component parts of the SOFTWARE may not be separated for use on more 
than one computer.  

Rental. You may not rent, lease, or lend the SOFTWARE.  

Support Services. Microsoft may provide you with support services related to the SOFTWARE (“Support 
Services”). Use of Support Services is governed by the Microsoft polices and programs described in the user 
manual, in “online” documentation, and/or in other Microsoft-provided materials. Any supplemental software 
code provided to you as part of the Support Services shall be considered part of the SOFTWARE and subject 
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to the terms and conditions of this EULA. With respect to technical information you provide to Microsoft as 
part of the Support Services, Microsoft may use such information for its business purposes, including for 
product support and development. Microsoft will not utilize such technical information in a form that personally 
identifies you. 

Software Transfer. You may permanently transfer all of your rights under this EULA, provided you retain no 
copies, you transfer all of the SOFTWARE (including all component parts, the media and printed materials, 
any upgrades, this EULA, and, if applicable, the Certificate of Authenticity), and the recipient agrees to the 
terms of this EULA. If the SOFTWARE is an upgrade, any transfer must include all prior versions of the 
SOFTWARE. 

Performance or Benchmark Testing. You may not disclose the results of any benchmark test using the 
SOFTWARE to any third party without Microsoft's prior written approval. 

Termination. Without prejudice to any other rights, Microsoft may terminate this EULA if you fail to comply 
with the terms and conditions of this EULA. In such event, you must destroy all copies of the SOFTWARE and 
all of its component parts. 

3. UPGRADES. If the SOFTWARE is labeled as an upgrade, you must be properly licensed to use software 
identified by Microsoft as being eligible for the upgrade in order to use the SOFTWARE. SOFTWARE labeled 
as an upgrade replaces and/or supplements the software that formed the basis for your eligibility for the 
upgrade. You may use the resulting upgraded software only in accordance with the terms of this EULA. If the 
SOFTWARE is an upgrade of a component of a package of software programs that you licensed as a single 
product, the SOFTWARE may be used and transferred only as part of that single product package and may 
not be separated for use on more than one computer.  

4. COPYRIGHT. All title and copyrights in and to the SOFTWARE (including but not limited to any images, 
photographs, animations, video, audio, music, text, and “applets” incorporated into the SOFTWARE), the 
accompanying printed materials, and any copies of the SOFTWARE are owned by Microsoft or its suppliers. 
The SOFTWARE is protected by copyright laws and international treaty provisions. Therefore, you must treat 
the SOFTWARE like any other copyrighted material except that you may install the SOFTWARE on a single 
computer provided you keep the original solely for backup or archival purposes. You may not copy the printed 
materials accompanying the SOFTWARE. 

5. DUAL-MEDIA SOFTWARE. You may receive the SOFTWARE in more than one medium. Regardless of 
the type or size of medium you receive, you may use only one medium that is appropriate for your single 
computer. You may not use or install the other medium on another computer. You may not loan, rent, lease, 
or otherwise transfer the other medium to another user, except as part of the permanent transfer (as provided 
above) of the SOFTWARE. 

6. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE and documentation are provided with 
RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to restrictions as set 
forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software-Restricted Rights at 48 
CFR 52.227-19, as applicable. Manufacturer is Microsoft Corporation/One Microsoft Way/Redmond, WA 
98052-6399. 

7. EXPORT RESTRICTIONS. You acknowledge that the SOFTWARE and documentation licensed hereunder 
are subject to the export control laws and regulations of the U.S.A., and any amendments thereof. You 
confirm that with respect to the SOFTWARE and Documentation, you will not export or re-export them, 
directly or indirectly, to any country that is subject to U.S.A. export restrictions. You further acknowledge that 
the SOFTWARE may include technical data subject to export and re-export restrictions imposed by U.S.A. 
law. 

MISCELLANEOUS 

If you acquired this SOFTWARE in the United States, this EULA is governed by the laws of the State of 
Washington.  

If you acquired this SOFTWARE in Canada, this EULA is governed by the laws of the Province of Ontario, 
Canada. Each of the parties hereto irrevocably attorns to the jurisdiction of the courts of the Province of 
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Ontario and further agrees to commence any litigation which may arise hereunder in the courts located in the 
Judicial District of York, Province of Ontario.  

If this SOFTWARE was acquired outside the United States, then local law may apply. 

Should you have any questions concerning this EULA, or if you desire to contact Microsoft for any reason, 
please contact the Microsoft subsidiary serving your country, or write: Microsoft Sales Information Center/One 
Microsoft Way/Redmond, WA 98052-6399. 

LIMITED WARRANTY 
NO WARRANTIES. Microsoft expressly disclaims any warranty for the SOFTWARE. The SOFTWARE and 
any related documentation is provided “as is” without warranty of any kind, either express or implied, 
including, without limitation, the implied warranties or merchantability, fitness for a particular purpose, or 
noninfringement. The entire risk arising out of use or performance of the SOFTWARE remains with you. 

NO LIABILITY FOR DAMAGES. In no event shall Microsoft or its suppliers be liable for any damages 
whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of 
business information, or any other pecuniary loss) arising out of the use of or inability to use this Microsoft 
SOFTWARE, even if Microsoft has been advised of the possibility of such damages. Because some 
states/jurisdictions do not allow the exclusion or limitation of liability for consequential or incidental damages, 
the above limitation may not apply to you. 

 

Si vous avez acquis votre produit Microsoft au CANADA, la garantie limitée suivante vous concerne: 

GARANTIE LIMITÉE 
EXCLUSION DE GARANTIES. Microsoft renonce entièrement à toute garantie pour le LOGICIEL. Le 
LOGICIEL et toute autre documentation s'y rapportant sont fournis « comme tels » sans aucune garantie 
quelle qu'elle soit, expresse ou implicite, y compris, mais ne se limitant pas aux garanties implicites de la 
qualité marchande, d'adaptation à un usage particulier ou d'absence de violation des droits des tiers. Le 
risque total découlant de l'utilisation ou de la performance du LOGICIEL est entre vos mains. 

ABSENCE DE RESPONSABILITÉ POUR LES DOMMAGES. Microsoft ou ses fournisseurs ne pourront être 
tenus responsables en aucune circonstance de tout dommage quel qu'il soit (y compris mais non de façon 
limitative les dommages directs ou indirects causés par la perte de bénéfices commerciaux, l'interruption des 
affaires, la perte d'information commerciale ou toute autre perte pécuniaire) résultant de l'utilisation ou de 
l'impossibilité d'utilisation de ce produit, et ce, même si la société Microsoft a été avisée de l'éventualité de 
tels dommages. Parce que ertains états/juridictions ne permettent pas l'exclusion ou la limitation de 
responsabilité relative aux dommages indirects ou consécutifs, la limitation ci-dessus peut ne pas s'appliquer 
à votre égard. 

La présente Convention est régie par les lois de la province d'Ontario, Canada. Chacune des parties à la 
présente reconnaît irrévocablement la compétence des tribunaux de la province d'Ontario et consent à 
instituer tout litige qui pourrait découler de la présente auprès des tribunaux situés dans le district judiciaire de 
York, province d'Ontario. 

AU CAS OÙ VOUS AURIEZ DES QUESTIONS CONCERNANT CETTE LICENCE OU QUE VOUS 
DÉSIRIEZ VOUS METTRE EN RAPPORT AVEC MICROSOFT POUR QUELQUE RAISON QUE CE SOIT, 
VEUILLEZ CONTACTER LA SUCCURSALE MICROSOFT DESSERVANT VOTRE PAYS, DONT 
L'ADRESSE EST FOURNIE DANS CE PRODUIT, OU ÉCRIVEZ À : MICROSOFT SALES INFORMATION 
CENTER, ONE MICROSOFT WAY, REDMOND, WASHINGTON 98052-6399. 
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